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1  Safety and regulatory information
The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following chapters.

Intended use

The product is intended for the development, production and verification of electronic
components and devices in industrial, administrative, and laboratory environments.
Use the product only for its designated purpose. Observe the operating conditions and
performance limits stated in the data sheet.

Where do I find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:
● In Chapter 1.1, "Safety instructions", on page 19. The same information is provi-

ded in many languages as printed "Safety Instructions". The printed "Safety
Instructions" are delivered with the product.

● Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

1.1  Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the data sheet,
manuals and the printed "Safety Instructions". If you are unsure about the appropriate
use, contact Rohde & Schwarz customer service.

Using the product requires specialists or specially trained personnel. These users also
need sound knowledge of at least one of the languages in which the user interfaces
and the product documentation are available.

Never open the casing of the product. Only service personnel authorized by
Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer service at
http://www.customersupport.rohde-schwarz.com.

Lifting and carrying the product

The product is heavy. Do not move or carry the product by yourself. A single person
can only carry a maximum of 18 kg safely depending on age, gender and physical con-
dition. Look up the maximum weight in the data sheet. Use the product handles to

Safety instructions
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move or carry the product. Do not lift by the accessories mounted on the product.
Accessories are not designed to carry the weight of the product.

To move the product safely, you can use lifting or transporting equipment such as lift
trucks and forklifts. Follow the instructions provided by the equipment manufacturer.

Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing with live parts, which can lead to electric shock,
serious personal injury or death if you touch the casing. If Rohde & Schwarz provides
accessories designed for your product, e.g. a carrying bag, you can use the product
outdoors.

Unless otherwise specified, you can operate the product up to an altitude of 2000 m
above sea level. The product is suitable for pollution degree 2 environments where
nonconductive contamination can occur. For more information on environmental condi-
tions such as ambient temperature and humidity, see the data sheet.

Setting up the product

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

If the product has foldable feet, always fold the feet completely in or out to ensure sta-
bility. The feet can collapse if they are not folded out completely or if the product is
moved without lifting it. The foldable feet are designed to carry the weight of the prod-
uct, but not an extra load.

If stacking is possible, keep in mind that a stack of products can fall over and cause
injury.

If you mount products in a rack, ensure that the rack has sufficient load capacity and
stability. Observe the specifications of the rack manufacturer. Always install the prod-
ucts from the bottom shelf to the top shelf so that the rack stands securely. Secure the
product so that it cannot fall off the rack.

Connecting to power

The product is an overvoltage category II product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such
as electric shock, fire, personal injury or even death.

Take the following measures for your safety:
● Before switching on the product, ensure that the voltage and frequency indicated

on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

● Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

Safety instructions
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● Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.

● If the product needs an external power supply, use the power supply that is deliv-
ered with the product or that is recommended in the product documentation or a
power supply that conforms to the country-specific regulations.

● Only connect the product to a power source with a fuse protection of maximum
20 A.

● Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the
casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product warn against potential hazards.

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Heavy product

Be careful when lifting, moving or carrying the product. Carrying the product requires a suffi-
cient number of persons or transport equipment.

Electrical hazard

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

Hot surface

Do not touch. Risk of skin burns. Risk of fire.

Protective conductor terminal

Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

1.2  Labels on R&S SMA100B

Labels on the casing inform about:
● Personal safety, see "Connecting to power" on page 20.
● Product and environment safety, see Table 1-1.
● Identification of the product, see the serial number on the rear panel.

Labels on R&S SMA100B
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Table 1-1: Labels regarding R&S SMA100B and environment safety

Labeling in line with EN 50419 for disposal of electrical and electronic equipment after the prod-
uct has come to the end of its service life. For more information, see Chapter 17.4, "Disposal",
on page 772.

1.3  Warning messages in the documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

CAUTION

Potentially hazardous situation. Could result in minor or moderate injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

1.4  Korea certification class A

이 기기는 업무용(A급) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시기
바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.

Korea certification class A
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2  Welcome
The R&S SMA100B is a new high-performance signal generator developed to meet
demanding customer requirements. Offering excellent signal characteristic and
straightforward and intuitive operation, the signal generator makes signal generation
fast and easy.

2.1  Key features

Outstanding key features of the R&S SMA100B are:
● Frequency range from 8 kHz to up to 20 GHz (overrange 72 GHz)
● Excellent signal quality
● Excellent single sideband (SSB) phase noise
● Nearly no wideband noise
● Very high output power
● Low harmonics
● Unique pulse train generation
● High-stability reference oscillator
● Intuitive operation via touchscreen with the tile diagram as key element

For more information, see data sheet.

2.2  What's new

This manual describes firmware version FW 5.00.122.xx and later of the
R&S®SMA100B.

Compared to the previous version, it provides the new features listed below:
● Phase continuous mode for generating a phase continuous RF signal over a cer-

tain frequency range, see Chapter 4.3, "Phase continuous frequency",
on page 67.

● Additional information on R&S NRP power sensors in the "Sensor Mapping dialog"
dialog, see Chapter 8.4.2, "NRP sensor mapping", on page 234.

● Minimum power rating of RF output termination for internal adjustments, see Chap-
ter 17.3.1, "Internal adjustments", on page 761.

2.3  Documentation overview

This section provides an overview of the R&S SMA100B user documentation. Unless
specified otherwise, you find the documents on the R&S SMA100B product page at:

Documentation overview
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www.rohde-schwarz.com/manual/sma100b

2.3.1  Getting started manual

Introduces the R&S SMA100B and describes how to set up and start working with the
product. Includes basic operations, typical measurement examples, and general infor-
mation, e.g. safety instructions, etc. A printed version is delivered with the instrument.

2.3.2  User manuals and help

Contains the description of all instrument modes and functions. It also provides an
introduction to remote control, a complete description of the remote control commands
with programming examples, and information on maintenance, instrument interfaces
and error messages. Includes the contents of the getting started manual.

The contents of the user manuals are available as help in the R&S SMA100B. The
help offers quick, context-sensitive access to the complete information.

All user manuals are also available for download or for immediate display on the Inter-
net.

2.3.3  Service manual

Describes the performance test for checking compliance with rated specifications, firm-
ware update, troubleshooting, adjustments, installing options and maintenance.

The service manual is available for registered users on the global Rohde & Schwarz
information system (GLORIS):

https://gloris.rohde-schwarz.com

2.3.4  Instrument security procedures

Deals with security issues when working with the R&S SMA100B in secure areas. It is
available for download on the Internet.

2.3.5  Printed safety instructions

Provides safety information in many languages. The printed document is delivered with
the product.

2.3.6  Data sheets and brochures

The data sheet contains the technical specifications of the R&S SMA100B. It also lists
the options and their order numbers and optional accessories.

Documentation overview
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The brochure provides an overview of the instrument and deals with the specific char-
acteristics.

See www.rohde-schwarz.com/brochure-datasheet/sma100b

2.3.7  Release notes and open source acknowledgment (OSA)

The release notes list new features, improvements and known issues of the current
firmware version, and describe the firmware installation.

The open-source acknowledgment document provides verbatim license texts of the
used open source software.

See www.rohde-schwarz.com/firmware/sma100b

2.3.8  Application notes, application cards, white papers, etc.

These documents deal with special applications or background information on particu-
lar topics.

See www.rohde-schwarz.com/application/sma100b

Documentation overview
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3  Getting started

3.1  Preparing for use

Here, you can find basic information about setting up the product for the first time.

3.1.1  Lifting and carrying

► WARNING! The R&S SMA100B can be heavy, e.g., if fully equipped. Use a lifting
equipment, see also "Lifting and carrying the product" on page 19.
Use the carrying handles at the side for lifting and carrying the R&S SMA100B.
The handles at the front are only for pushing and pulling the instrument when
mounting in a rack, see Chapter 3.1.4.2, "Mounting the R&S SMA100B in a rack",
on page 28.

3.1.2  Unpacking and checking

1. Unpack the R&S SMA100B carefully.

2. Retain the original packing material. Use it to protect the control elements and con-
nectors when transporting or shipping the R&S SMA100B later.
See also Chapter 16, "Transporting", on page 760.

3. Using the delivery notes, check the equipment for completeness.

4. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

3.1.3  Choosing the operating site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the data sheet.

See also "Choosing the operating site" on page 20.

Electromagnetic compatibility classes

The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the data sheet.
● Class B equipment is suitable for use in:

– Residential environments

Preparing for use
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– Environments that are directly connected to a low-voltage supply network that
supplies residential buildings

● Class A equipment is intended for use in industrial environments. It can cause
radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

3.1.4  Setting up the R&S SMA100B

See also:
● "Setting up the product" on page 20
● "Intended use" on page 19

3.1.4.1  Placing the R&S SMA100B on a bench top

To place the product on a bench top

1. Place the product on a stable, flat and level surface. Ensure that the surface can
support the weight of the product. For information on the weight, see the data
sheet.

2. CAUTION! Foldable feet can collapse. See "Setting up the product" on page 20.
Always fold the feet completely in or out. With folded-out feet, do not place any-
thing on top or underneath the product.

3. WARNING! A stack of products can fall over and cause injury. Never stack more
than three products on top of each other. Instead, mount them in a rack.
Stack as follows:

● If the products have foldable feet, fold them in completely.
● It is best if all products have the same dimensions (width and length). If the

products have different dimensions, stack according to size and place the
smallest product on top.

● Do not exceed the permissible total load placed on the product at the bottom of
the stack:
– 50 kg when stacking products of identical dimensions (left figure).
– 25 kg when stacking smaller products on top (middle figure).

Preparing for use
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Left = Stacked correctly, same dimensions
Middle = Stacked correctly, different dimensions
Right = Stacked incorrectly, too many products

4. NOTICE! Overheating can damage the product.
Prevent overheating as follows:

● Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity.

● Do not place the product next to heat-generating equipment such as radiators
or other products.

3.1.4.2  Mounting the R&S SMA100B in a rack

To prepare the rack

1. Observe the requirements and instructions in "Setting up the product" on page 20.

2. NOTICE! Insufficient airflow can cause overheating and damage the product.
Design and implement an efficient ventilation concept for the rack.

To mount the R&S SMA100B in a rack

1. Use an adapter kit that fits the dimensions of the R&S SMA100B to prepare the
instrument for rack mounting.

a) Order the rack adapter kit designed for the R&S SMA100B. For the order num-
ber, see data sheet.

b) Mount the adapter kit. Follow the assembly instructions provided with the
adapter kit.

2. WARNING! The R&S SMA100B can be heavy, e.g., if fully equipped. Use a lifting
equipment, see also "Lifting and carrying the product" on page 19.
Lift the R&S SMA100B to shelf height.

3. Grab the handles at the front and push the R&S SMA100B onto the shelf until the
rack brackets fit closely to the rack.

Preparing for use
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4. Tighten all screws at the rack brackets with a tightening torque of 1.2 Nm to secure
the R&S SMA100B in the rack.

To unmount the R&S SMA100B from a rack

1. Loosen the screws at the rack brackets.

2. WARNING! The R&S SMA100B can be heavy, e.g., if fully equipped. Use a lifting
equipment, see also "Lifting and carrying the product" on page 19.
Bring the lifting equipment to shelf height.

3. Remove the R&S SMA100B from the rack.

4. If placing the R&S SMA100B on a bench top again, unmount the adapter kit from
the R&S SMA100B. Follow the instructions provided with the adapter kit.

3.1.5  Considerations for test setup

Cable selection and electromagnetic interference (EMI)

Electromagnetic interference (EMI) can affect the measurement results.

To suppress electromagnetic radiation during operation:
● Use high-quality shielded cables, especially for the following connector types:

– BNC
Double-shielded BNC cables.

– SMA
Double-shielded SMA cables.
How to: "To connect to Ref In/Ref Out (reference = 1 GHz)" on page 33

– USB
Double-shielded USB cables.
How to: Chapter 3.1.8, "Connecting USB devices", on page 31.
See also Chapter 15.6, "Measuring USB cable quality", on page 752.

– LAN
At least CAT6 STP cables.
How to: Chapter 3.1.7, "Connecting to LAN", on page 30

● Always terminate open cable ends.
● Ensure that connected external devices comply with EMC regulations.

Signal input and output levels

Information on signal levels is provided in the data sheet. Keep the signal levels within
the specified ranges to avoid damage to the R&S SMA100B and connected devices.

Preventing electrostatic discharge (ESD)

Electrostatic discharge is most likely to occur when you connect or disconnect a DUT.

Preparing for use



Getting startedR&S®SMA100B

30User Manual 1178.3834.02 ─ 09

► NOTICE! Electrostatic discharge can damage the electronic components of the
product and the device under test (DUT).
Ground yourself to prevent electrostatic discharge damage:

a) Use a wrist strap and cord to connect yourself to ground.
b) Use a conductive floor mat and heel strap combination.

3.1.6  Connecting to power

For safety information, see "Connecting to power" on page 20.

1. Plug the AC power cable into the AC power connector on the rear panel of the
instrument. Only use the AC power cable delivered with the R&S SMA100B.

2. Plug the AC power cable into a power outlet with ground contact.

The required ratings are listed next to the AC power connector and in the data
sheet.

3.1.7  Connecting to LAN

Network environment

Before connecting the product to a local area network (LAN), consider the following:
● Install the latest firmware to reduce security risks.
● For internet or remote access, use secured connections if applicable.
● Ensure that the network settings comply with the security policies of your company.

Contact your local system administrator or IT department before connecting your
product to your company LAN.

● When connected to the LAN, the product may potentially be accessed from the
internet, which may be a security risk. For example, attackers might misuse or
damage the product.

To connect to LAN

The connector is located on the rear panel.

► Connect the LAN socket via an RJ-45 cable to the LAN.

By default, the R&S SMA100B is configured to use DHCP (dynamic host configuration
protocol) and no static IP address is configured.

If switched on and connected to the LAN, the R&S SMA100B displays the address
information on the screen.

Preparing for use
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Figure 3-1: IP address indication on the screen (example)

See also Chapter 13.7, "Connecting the instrument to the network (LAN)",
on page 414.

3.1.8  Connecting USB devices

You can connect or disconnect all USB devices from the R&S SMA100B during opera-
tion.

To connect USB storage devices

USB storage devices, such as memory sticks, allow data transfer from or to the
R&S SMA100B. You can also use them for firmware updates.

► Connect the USB storage device to any of the USB connectors.

To connect USB devices with external power supply

1. NOTICE! Connected devices with external power supply can feed back current into
the 5 V power supply of the USB interface and thus damage the R&S SMA100B.
Ensure that there is no connection between the positive pole of the power supply
and the +5 V power pin of the USB interface (VBUS).

2. Connect the USB storage device to any of the USB connectors.

To connect a keyboard

► Connect the keyboard to any of the USB connectors.

When connected, the R&S SMA100B detects the keyboard automatically. A detected
keyboard has the default layout English – US.

To connect a mouse

► Connect the mouse to any of the USB connectors.

When connected, the R&S SMA100B detects the mouse automatically.

To connect power sensors

You can connect power sensors of the R&S NRP families to any of the USB connec-
tors.

See Chapter 8.4, "Using power sensors", on page 233.

Preparing for use
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3.1.9  Connecting to RF

The connector is located on the front panel.

If you have the instrument equipped with an option for rear panel connectors, the RF
output connector is on the rear panel.

To prepare for connecting to RF

1. NOTICE! Damaged or not clean connections can lead to RF insertion loss and mis-
match, and even premature wear of the connectors.
Before connecting to the port, inspect the RF connector visually to check that it is
clean, undamaged and mechanically compatible.
See the application note 1MA99 for information on how to handle and maintain the
RF port, to minimize measurement deviations and ensure its longevity.

2. NOTICE! Risk of instrument damage. Excessive reverse power or DC voltage at
the RF connector can damage the instrument.
Make sure that signal power and DC limits as given in the data sheet.

3. If the R&S SMA100B is switched on, deactivate the RF output, before connecting
an RF cable to the RF connector.
In the home screen, select the block "Level" > "RF ON > Off".

4. Use a high-quality RF cable that matches the RF connector type.
See "Cable selection and electromagnetic interference (EMI)" on page 29.

To connect to screwable connectors

1. Use a high-quality cable that matches the connector type.
See "Cable selection and electromagnetic interference (EMI)" on page 29.

2. NOTICE! Risk of instrument damage and connector damage. Excessive tightening
can damage the cables and the connectors. However, if you do not tighten the con-
nectors enough, the measurement results can be inaccurate.
To connect the cable with the connector, proceed as follows:

a) Carefully align the connector of the cable and the connector along a common
axis.

b) Mate the connectors along the common axis until the male pin of the inner con-
nector engages with the female socket of the outer connector.

c) Turn the nut of the outer connector until the connectors are firmly coupled.
d) Torque the nut to the specified limit using a calibrated torque wrench. Hold the

opposite connector part stationary with a spanner.
For torque limits of the most relevant connector types, see Table 3-1.

For more information, see chapter "Handling" of the application note 1MA99.

If your instrument is equipped with a test port adapter, see the application note
1MA100.

Preparing for use
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The connector types listed in this table represent the common connectors provided by
Rohde & Schwarz. It is considered as general information and therefore can contain
connector types that do not apply to your instrument.

See Chapter 3.2.1.11, "RF 50 Ω", on page 41.

Table 3-1: Connector types and torque limits

Type Torque limit Nut opening

 lb-Inch Nm Inch mm

N 13.3 1.5 3/4 20

SMA 5 0.56 5/16 8

3.5 mm 8 0.9 5/16 8

2.92 mm 8 0.9 5/16 8

2.4 mm 8 0.9 5/16 8

1.85 mm 8 0.9 5/16 8

1.0 mm 3 0.34 0.236 6

To prevent RF output switch-off

► NOTICE! If you set a too high output level without a load connected to the instru-
ment, the reverse power can exceed a limit forcing the R&S SMA100B to switch off
the RF output.
Connect a load with sufficient return loss as given in the data sheet.

3.1.10  Connecting to Ref In/Ref Out

The connector is located on the rear panel.

To connect to Ref In/Ref Out (reference < 1 GHz)

For connection, the R&S SMA100B provides BNC connectors.

► To connect the cable with the "Ref In"/"Ref Out" connector, proceed as follows:

a) Carefully align the connector of the cable and the "Ref In"/"Ref Out" connector
along a common axis.

b) Mate the connectors along the common axis until the male pin of the connector
of the cable engages with the female socket of the "Ref In"/"Ref Out" connec-
tor.

To connect to Ref In/Ref Out (reference = 1 GHz)

For connection, the R&S SMA100B provides SMA connectors.

1. Use a high-quality cable that matches the connector type.
See "Cable selection and electromagnetic interference (EMI)" on page 29.

Preparing for use
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2. NOTICE! Risk of instrument damage and connector damage. Excessive tightening
can damage the cables and the connectors. However, if you do not tighten the con-
nectors enough, the measurement results can be inaccurate.
To connect the cable with the connector, proceed as follows:

a) Carefully align the connector of the cable and the connector along a common
axis.

b) Mate the connectors along the common axis until the male pin of the inner con-
nector engages with the female socket of the outer connector.

c) Turn the nut of the outer connector until the connectors are firmly coupled.
d) Torque the nut to the specified limit using a calibrated torque wrench. Hold the

opposite connector part stationary with a spanner.
For torque limits of the most relevant connector types, see Table 3-1.

For more information, see chapter "Handling" of the application note 1MA99.
Table 3-2: Connector types and torque limits

Type Torque limit Nut opening

 lb-Inch Nm Inch mm

N 13.3 1.5 3/4 20

SMA 5 0.56 5/16 8

3.5 mm 8 0.9 5/16 8

2.92 mm 8 0.9 5/16 8

2.4 mm 8 0.9 5/16 8

1.85 mm 8 0.9 5/16 8

1.0 mm 3 0.34 0.236 6

3.1.11  Switching on or off

The following table provides an overview of power states, LEDs and power switch posi-
tions.
Table 3-3: Overview of power states

State LED Position of power switch

Off  gray [0]

Standby  orange [I]

Ready  green [I]

To switch on the R&S SMA100B

The R&S SMA100B is off but connected to power. See Chapter 3.1.6, "Connecting to
power", on page 30.

1. Set the switch on the power supply to position [I].

Preparing for use
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The switch is located on the rear panel.

The LED of the [On/Standby] key is orange.

2. Press the [On/Standby] key.
Key and LED are located on the front panel.

The LED changes to green. The R&S SMA100B boots.

When starting for the first time, the R&S SMA100B starts with the default settings.
When restarting the instrument, the settings depend on the instrument configura-
tion before shut-down.
See Chapter 11.4, "Saving and recalling instrument settings", on page 317.

When the instrument is switched on, it automatically monitors main functions. You can
query erroneous functions. In addition to automatic monitoring, you can perform main-
tenance tasks.

See:
● Chapter 15.4, "Querying notifications", on page 749
● Chapter 17.3, "Performing maintenance tasks", on page 761

To shut down the product

The product is in the ready state.

► Press the [On/Standby] key.

The operating system shuts down. The LED changes to orange.

In the standby state, the power switch circuits are active. To deactivate them, discon-
nect the instrument from the power supply.

To disconnect from power

The R&S SMA100B is in the standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.
Set the toggle switch on the power supply to position [0].

The LED of the [On/Standby] key is switched off.

2. Disconnect the R&S SMA100B from the power source.

3.2  Instrument tour

This chapter explains the control elements and the connectors of the R&S SMA100B.
The views of the front panel and the rear panel help you to get familiar with the instru-
ment and to perform first steps. For specifications of the interfaces, see the data sheet.

The meanings of the labels on the R&S SMA100B are described in Chapter 1.2,
"Labels on R&S SMA100B", on page 21.

Instrument tour
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3.2.1  Front panel tour

This section provides an overview of the control elements at the front panel of the
R&S SMA100B. Most of the connectors are at the rear panel and are described in
Chapter 3.2.2, "Rear panel tour", on page 43.

1 2 3 4 5 6 7

891011

Figure 3-2: Front panel view of the R&S SMA100B RF Signal Generator with height unit 2HU (option
R&S SMAB-B92)

1 = Utility keys, page 38
2 = Touchscreen, page 37
3 = Function keys, page 38
4 = Navigation controls, page 39
5 = Display keys, page 40
6 = SD card slot, page 40
7 = USB connector, page 40
8 = RF 50 Ω, page 41
9 = Sensor, page 41
10 = Keypad, page 38
11 = On/Standby, page 38

15 14 13 12 11

8 1097654321

Figure 3-3: Front panel view of the R&S SMA100B RF Signal Generator with height unit 3HU (option
R&S SMAB-B93)

Instrument tour
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1 = On/Standby, page 38
2 = Utility keys, page 38
3 = Touchscreen, page 37
4 = Keypad, page 38
5 = Function keys, page 38
6 = Navigation controls, page 39
7 = Display keys, page 40
8 = SD card slot, page 40
9 = USB connector, page 40
10 = Sensor, page 41
11 = RF 50 Ω, page 41
12 = Pulse signal connectors, page 42
13 = LF, page 42
14 = Ext 1/2, page 46
15 = Clock synthesizer connectors, page 42

3.2.1.1  Touchscreen

The screen at the front panel is the graphical user interface. It shows the settings dia-
logs and parameters, and the current configuration at a glance, see Chapter 3.4.3,
"Understanding the display information", on page 55.

Figure 3-4: Touchscreen

The touch-sensitive panel provides an alternative means of user interaction for quick
and easy handling of the instrument, see Chapter 3.4.2, "Means of manual interaction",
on page 54.

See also:
● Chapter 3.4, "Instrument control", on page 53, for operating the touchscreen.
● Chapter 17.1, "Cleaning", on page 761, for instructions on cleaning the screen.

Instrument tour
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3.2.1.2  Utility keys

The utility keys set the R&S SMA100B to a defined state, and provide access to basic
settings and information on assistance.
Table 3-4: Utility keys

Utility Key Assigned functions

[Preset] Sets the instrument to a defined state

[Local] Switches from remote control to local (manual) control

[Setup] Accesses the general instrument settings

[Help] Displays context-sensitive help text

3.2.1.3  On/Standby

The [On/Standby] key switches the instrument from the standby to the ready state or
vice versa.

The LED above the [On/Standby] key indicates the instrument state, see Chap-
ter 3.1.11, "Switching on or off", on page 34.

3.2.1.4  Function keys

Function keys provide access to the most common generator settings and functions.
You can find a detailed description of the corresponding functions in the user manual.
Table 3-5: Function keys

Function key Assigned functions

[Freq] Activates frequency entry.

[Level] Activates level entry.

[Mod on/off] Switches the modulation on and off.

[RF on/off] Switches the RF output on and off.

3.2.1.5  Keypad

The keypad enables you to enter alphanumeric parameters, including the correspond-
ing units. It contains the following keys:
Table 3-6: Keys on the keypad

Type of key Description

Alphanumeric keys Enter numbers and (special) characters in edit dialog boxes.

Decimal point Inserts a decimal point "." at the cursor position.

Instrument tour
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Type of key Description

Sign key Changes the sign of a numeric parameter. In the case of an alphanu-
meric parameter, inserts a "-" at the cursor position.

Unit keys

(G/n dBμV, M/μ μV, k/m mV and
x1 dB(m))

These keys add the selected unit to the entered numeric value and com-
plete the entry.

In the case of level entries (e.g. in dB) or dimensionless values, all units
have the value "1" as multiplying factor. Thus, they have the same func-
tion as an [Enter] key.

3.2.1.6  Navigation controls

The navigation controls include a rotary knob, navigation keys, and the display keys.
They allow you to navigate within the display or within dialog boxes.

Rotary knob

The rotary knob has several functions:

● Increments (clockwise direction) or decrements (counterclockwise direction) the
instrument parameter at a defined step width in the case of a numeric entry.

● Moves the selection, e.g. to a function block in the block diagram
● Shifts the selection bar within focused areas (e.g. lists).
● Acts like the [Enter] key, when it is pressed.
● Opens a context-sensitive menu, when it is pressed and held.

editing keys

Editing keys enable you to confirm an entry, delete individual characters, or exit the
current operation.
Table 3-7: Editing keys

Type of key Description

[Esc] key Closes all kinds of dialog boxes, if the edit mode is not active. Quits the
edit mode, if the edit mode is active. In dialog boxes that contain a "Can-
cel" button it activates that button.

For "Edit" dialog boxes the following mechanism is used:
● If data entry has been started, it retains the original value and

closes the dialog box.
● If data entry has not been started or has been completed, it closes

the dialog box.

[Enter] key Has the same effect as pressing the rotary knob
● Concludes the entry of dimensionless entries. The new value is

accepted.
● With other entries, this key can be used instead of the default unit

key.
● In a dialog box, selects the default or focused element.
● Calls the next dialog level.
● Confirms and closes open input windows.

[Backspace] key Deletes the character to the left of the cursor in editing mode.

Instrument tour
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Navigation keys

As an alternative to the rotary knob or the touchscreen, you can use the navigation
keys to navigate through dialog boxes, diagrams, or tables.
Table 3-8: Navigation keys

Type of key Description

[Up/Down] Key The [Up] and the [Down] key does the following:
● In a numeric edit dialog box, increase or decrease the instrument

parameter.
● In a list, scroll forward and backward through the list entries.
● In a table, move the selection bar vertically.
● In windows or dialog boxes with vertical scrollbar, move the scroll-

bar.

[Left/Right] Key The [Left] and the [Right] key does the following:
● In an alphanumeric edit dialog box, move the cursor.
● In a list, scroll forward and backward through the list entries.
● In a table, move the selection bar horizontally.
● In windows or dialog boxes with horizontal scrollbar, move the

scrollbar.

3.2.1.7  Display keys

The display keys arrange different windows on the display.
Table 3-9: Display keys

Display key Assigned functions

[Home] Returns to the initial feature screen.

[Next window] Toggles between the entry fields in the taskbar.

[On/Off] ● Switches highlighted elements or a function block on and off.
● Switches between two or more settings, e.g. items of selection lists.

At the end of a list, the cursor is set on the first entry again.

[Undo] Reverts the last operation.

[★ (User)] Adds a parameter to the user menu for quick access.

3.2.1.8  SD card slot

Option: R&S SMAB-B85

Slot for removable mass storage.

To prevent from unauthorized removal, the SD card holder includes wholes that pro-
vide the opportunity of sealing the SD card. We recommend that you seal the SD card
crosswise.

3.2.1.9  USB connector

Female USB type A connector, to connect devices like a keyboard, a mouse, a mem-
ory stick, or the R&S NRP-Z3/Z4 cable for the R&S NRP power sensors.

Instrument tour
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How to: Chapter 3.1.8, "Connecting USB devices", on page 31

3.2.1.10  Sensor

Connector for R&S NRP sensors.

A power sensor is connected to the R&S SMA100B by inserting the male connector. To
disconnect, pull the connector by its sleeve. You cannot disconnect the sensor simply
by pulling at the cable or the rear part of the connector.

The R&S SMA100B supports the use of R&S NRP power sensors in various ways
including the use as a power viewer.

The female connector allows the mechanical connection of 6-pole and 8-pole male
connectors.
It mates with the interface cables R&S NRP-ZK8 and R&S NRP-ZK6, used for con-
necting R&S NRPxx power sensors, and also with the six-pole push-pull plugs of the
R&S NRP-Zxx series.
However, the signal pair of the common time base clock assigned to the two pins in the
center of the male connectors is not available. These pins are used by
Rohde & Schwarz power meters to synchronize several power sensors.

Further information on connecting and using power sensors, see Chapter 8.4.1, "Con-
necting R&S NRP power sensors to the R&S SMA100B", on page 233, Chapter 8.4.4,
"NRP-Z power analysis", on page 245, Chapter 8.4.2, "NRP sensor mapping",
on page 234, Chapter 8.4.4, "NRP-Z power analysis", on page 245 and Chapter 8.3,
"User correction", on page 221.

3.2.1.11  RF 50 Ω

Output of the RF signal.

The connector type depends on the installed frequency option.
Table 3-10: RF connector types of the frequency options

Installed RF frequency
option

Connector type Frequnecy range

R&S SMAB-B103 N female fmax ≤ 6 GHz

R&S SMAB-B106

R&S SMAB-B112 PC 2.92 mm female

Instrument equipped with interchangeable
PC 2.92 mm test port adapter.

fmax ≤ 40 GHz

R&S SMAB-B120

R&S SMAB-B131

R&S SMAB-B140(N)

R&S SMAB-B150(N) PC 1.85 mm female

Instrument equipped with PC 1.85 mm inter-
changeable female/female wear and tear adapter.

fmax ≤ 67 GHz

R&S SMAB-B167(N)

Instrument tour
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The PC 1.85 mm male connector for up to 67 GHz comes with a protective 1.85 mm
female adapter to prevent the sensitive connector from damage.
It is available as a spare part, and can be replaced if damaged. Contact your
Rohde & Schwarz support center or www.rohde-schwarz.com/support for information.

How to: Chapter 3.1.9, "Connecting to RF", on page 32

3.2.1.12  Pulse signal connectors

Pulse Sync
Output signal for synchronizing the pulse generator signal. The synchronization signal
is generated at the beginning of each pulse. For double-pulse generation, the synchro-
nization signal is generated at the beginning of the first pulse.

Pulse Video
Output of the internal pulse generator signal or the looped through pulse signal from
Pulse Ext connector (video signal).
See Chapter 5.4.1, "Pulse modulation settings", on page 84.

Pulse Ext
Input for an external pulse modulation signal or an external trigger/gate signal for the
pulse generator.

3.2.1.13  LF modulation connectors

LF
Output for internal LF generator signal.
See the data sheet and in the user manual, section Chapter 5, "Analog modulations",
on page 81.

Ext
Input for external analog modulation signals.
See Chapter 5, "Analog modulations", on page 81.

3.2.1.14  Clock synthesizer connectors

Clk Syn/Clk Syn N
Connectors for output of the clock synthesizer signal, or the inverted signal.

Instrument tour
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3.2.2  Rear panel tour

This section provides an overview of the connectors at the rear panel of the instrument.
For technical data of the connectors, refer to the data sheet.

1 2 3 4 5 6 7 8 9 10 11 12 13

141516171819

Figure 3-5: R&S SMA100B rear panel with height unit 2HU (option R&S SMAB-B92)

1 = Serial number (six digits in the string 1419.8888.02-<serial number>-<checksum>)
2 = IEC 625/IEEE 488, page 44
3, 5 = USB/USB In, page 44
4 = LAN, page 44
6, 7 = Ref In/Ref Out, page 45
8 = V/GHz X-Axis, page 44 and Z-Axis, page 44
9 = Stop, page 45
10 = EFC, page 45
11 = Marker User1, page 45
12 = Inst Trig, page 45
13 = Signal Valid, page 45
14 = Clk Syn/Clk Syn N, page 42
15 = Pulse Sync, page 45, Pulse Video, page 42 and Pulse Ext, page 42
16 = LF, page 42
17 = Ext 1/2, page 46
18 = AC power supply connector and switch, page 46
19 = RF, page 46

1
2

1 2 3 4 5 7 8 9 10 131211

141516171819

6

Figure 3-6: Rear panel view of the R&S SMA100B RF Signal Generator with height unit 3HU (option
R&S SMAB-B93)

1 = Serial number (six digits in the string 1419.8888.02-<serial number>-<checksum>)
2 = IEC 625/IEEE 488, page 44
3, 5 = USB/USB In, page 44
4 = LAN, page 44
6, 7 = Ref In/Ref Out, page 45

Instrument tour
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8 = V/GHz X-Axis, page 44 and Z-Axis, page 44
9 = Stop, page 45
10 = EFC, page 45
11 = Marker User1, page 45
12 = Inst Trig, page 45
13 = Signal Valid, page 45
14 = Clk Syn/Clk Syn N, page 42
15 = Pulse Sync, page 45, Pulse Video, page 42 and Pulse Ext, page 42
16 = LF, page 42
17 = Ext 1/2, page 46
18 = AC power supply connector and switch, page 46
19 = RF, page 46

3.2.2.1  Connectors

IEC 625/IEEE 488
Option: R&S SMAB-B86
General purpose interface bus (GPIB) interface for remote control of the instrument.
The interface is in compliance with the standards IEC 625, IEEE 488 and SCPI.
Use this interface to connect a computer for remote control of the R&S SMA100B. To
set up the connection, use high-quality shielded cables. See "Cable selection and elec-
tromagnetic interference (EMI)" on page 29.
See also Chapter A.2.1, "GPIB-Bus interface", on page 779 and Chapter 13, "Network
operation and remote control", on page 378.

USB/USB In
● Female USB (universal serial bus) 2.0 connector of type A (host USB), to connect

devices like a keyboard, a mouse, a memory stick, or the R&S NRP-Z3/Z4 cable
for the R&S NRP power sensors

● Option: R&S SMAB-B86
Female USB 3.0 connector of type Micro-B (USB In), for example, for remote con-
trol.

How to: Chapter 3.1.8, "Connecting USB devices", on page 31

LAN
RJ-45 connector to connect the R&S SMA100B to a LAN for remote control, remote
operation, and data transfer.
How to: Chapter 3.1.7, "Connecting to LAN", on page 30

V/GHz X-Axis
Output of a voltage ramp:
● "V / GHz": the voltage is proportional to the frequency.
● "X-Axis": output of a voltage ramp for the X deflection of an oscilloscope or an XY

recorder.

Z-Axis
Output of a voltage pulse, e.g. for the combined blanking and marker generation of net-
work analyzers.

Instrument tour
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Stop
Input and output for stopping the sweep in all modes.
This connector is bidirectional. Used as:
● "Input": enables you to stop a sweep triggered by an external network analyzer.
● "Output": enables the R&S SMA100B to stop the sweep of an external network

analyzer.

Marker User1
Output signal for marker or trigger signal.

Signal Valid
Output signal that determines the valid signal times (valid level and frequency) for all
analog modulations.

Inst Trig
BNC connector for input of external trigger signals. The signals trigger sweeps and list
mode.
See Chapter 7.1, "Signal generation and triggering in the sweep and list modes",
on page 173.

EFC
BNC connector for input of an EFC (external frequency control) signal for electronic
tuning of the internal reference frequency.
See Chapter 9, "Reference oscillator", on page 294.

Ref In/Ref Out
Input/output for external reference signal.
BNC connectors for reference signals from 1 MHz to 100 MHz.
SMA connectors for 1 GHz reference signals.
How to: Chapter 3.1.10, "Connecting to Ref In/Ref Out", on page 33

Clk Syn/Clk Syn N
Connectors for output of the clock synthesizer signal, or the inverted signal.

Pulse Ext
Input for an external pulse modulation signal or an external trigger/gate signal for the
pulse generator.

Pulse Video
Output of the internal pulse generator signal or the looped through pulse signal from
Pulse Ext connector (video signal).
See Chapter 5.4.1, "Pulse modulation settings", on page 84.

Pulse Sync
Output signal for synchronizing the pulse generator signal. The synchronization signal
is generated at the beginning of each pulse. For double-pulse generation, the synchro-
nization signal is generated at the beginning of the first pulse.

Instrument tour
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LF
Output for internal LF generator signal.
See the data sheet and in the user manual, section Chapter 5, "Analog modulations",
on page 81.

Ext 1/2
Inputs for external analog modulation signal.
See Chapter 5, "Analog modulations", on page 81.

AC power supply connector and switch
Mains power switch for performing the following tasks:
● Connecting the internal power supply to the power source
● Disconnecting the internal power supply from the power source
How to: Chapter 3.1.6, "Connecting to power", on page 30.

RF
Rear panel connector for the RF signal. This connector is for use of the instrument in a
19" rack.
How to:
● Chapter 3.1.4.2, "Mounting the R&S SMA100B in a rack", on page 28
● Chapter 3.1.9, "Connecting to RF", on page 32

3.3  Trying out the instrument

This chapter introduces the first steps with the R&S SMA100B. It shows how to oper-
ate and configure the instrument using simple examples. The complete description of
the functionality and its usage is given in the R&S SMA100B user manual. Basic instru-
ment operation is described in Chapter 3.4, "Instrument control", on page 53.

Prerequisites

The instrument is set up, connected to the power supply, and started up as described
in Chapter 3.1, "Preparing for use", on page 26.

The first signal generation tasks explain how to generate an unmodulated signal, to
configure the RF signal output, and how you can vary the RF frequency and level in
sweep mode.

The instrument is manually operated via the touchscreen. Try out the following:

● Generating an unmodulated carrier........................................................................ 46
● Generating an RF frequency sweep signal.............................................................49
● Saving and recalling settings.................................................................................. 51

3.3.1  Generating an unmodulated carrier

We start to generate a simple unmodulated signal. In this example, the R&S SMA100B
can be in its minimal configuration.

Trying out the instrument
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1. On the R&S SMA100B front panel, press the [Preset] key to set a defined initial
instrument state.

2. Set the frequency:

a) In the "Status Bar", tap the "Frequency" field.
b) On the on-screen keypad, enter "6" and press the "GHz" key.

The on-screen key pad closes and the frequency value is displayed.

3. To set the signal level, tap the "Level" field and enter the level in the same way.

4. To activate RF signal output, select "Level" > "RF On" in the tile diagram.

Trying out the instrument
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The blue colored "RF On" icon indicates that the RF output is activated.

The R&S SMA100B provides the 6 GHz signal at the RF A connector at the front
panel.

Figure 3-7: Generating an unmodulated signal

Alternative ways to access the instrument functions

To fulfill the same task, you can also use the front panel keys or the setting parameters
provided in the frequency and level dialogs.

Try out the settings dialogs

1. In the "Frequency" tile, select "Frequency...".

a) In the "RF Frequency" tab, tap the "Frequency" field.
b) Set the frequency via the on-screen keypad.

2. Access the "RF Level" dialog via the "Level" tile.

a) In the "RF Level" tab, select "Amplitude".
b) Set the amplitude (level) via the on-screen keypad.

3. Select "RF State > On" to activate the RF signal generation.

See Chapter 4, "RF signal configuration", on page 64.

Try out the front panel keys

► Use the [Freq], [Level], and [RF on/off] key on the front panel.

Trying out the instrument
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Connect RF of the R&S SMA100B to a signal analyzer, for example R&S®FSW, to dis-
play the generated signal.
For the required settings of the signal analyzer, refer to its user manual or its online
help.

3.3.2  Generating an RF frequency sweep signal

The "Sweep" operating mode allows you to generate an RF signal with periodically
varying frequencies or amplitudes.

This example deals with an RF signal with varying frequency and constant level. To
configure the sweep, you need to determine a defined start and end frequency with
constant time intervals between the frequency steps.

The sweep function does not require specific options.

1. On the front panel, press the [Preset] key to set a defined initial instrument state.

2. Set the signal output level, if required, e.g. set "Level > -25 dBm".

3. In the tile diagram, select "Sweep" > "Frequency Sweep".

4. In the "General" tab:

a) Select "Mode > Auto" to run the sweep continuously.
b) Select "Shape > Sawtooth" to set the waveform shape of the sweep signal.
c) Select "Spacing > Linear", to determine the calculation method for the fre-

quency shift of a step.
d) Set "Dwell Time > 15.0 ms", to determine the time interval of the sweep steps.

5. Select the "Frequency Range" tab.

Trying out the instrument
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a) Set "Start Freq > 200 MHz" and "Stop Freq > 600 MHz" to determine the fre-
quency sweep range.

b) Set the step width "Step Lin > 10.0 MHz" to determine the width for a frequency
step.

6. In the "General" tab, activate the frequency sweep with "State > On".

7. Close the sweep dialog.
(Alternatively, tap the "Home" button to minimize the dialog. The R&S SMA100B
indicates the "Sweep" dialog as active dialog in the task bar.)

8. To activate the RF signal output, select "Level" > "RF On".

Figure 3-8: Generating a frequency sweep signal

The frequency field in the status bar indicates the continuously changing frequency,
i.e. the running sweep.

Trying out the instrument
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3.3.3  Saving and recalling settings

To restore the results of our measurements later, we save the instrument settings in a
file.

To save the instrument settings in a file

We assume, a test configuration as described in Chapter 3.3.2, "Generating an RF fre-
quency sweep signal", on page 49.

1. Press the [Setup] key on the front panel.

2. In the "Setup" menu, select "Settings > Save/Recall".

3. In the "Save/Recall" dialog, select "Operation Mode > Save".

4. Tap the "Filename", use the on-screen keyboard, and enter MyTestSignal.

5. Tap the "Save" button.

The file MyTestSignal.savrcltxt is stored in the default direc-
tory /var/user/.

To load saved instrument settings

You can restore the settings to the instrument at any time using the settings file.

1. Press the [Preset] button to restore the default instrument settings so you can
check that the stored user settings are restored afterwards.

2. Press the [Setup] key on the front panel.

3. In the "Setup" menu, select "Settings > Save/Recall".

Trying out the instrument
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4. In the "Save/Recall" dialog, select "Operation Mode > Recall".
Navigate to the directory the file is saved in and select the MyTestSignal file.

5. Tap the "Recall" button.

All instrument settings are restored and the display resembles Chapter 3.3.2, "Gen-
erating an RF frequency sweep signal", on page 49, which shows the instrument
display right before the settings were saved.

How to display all parameters with values different to their preset values
When you load a file to your instrument, you do not have enough information on the
changed settings. In such case, it is useful to visualize all parameters that have been
changed from their default state.

Try out the following:
● Touch and hold a spot in the tile diagram for at least 1 second to access the con-

text-sensitive menu.
● Select "Mark All Parameters Changed from Preset".

Trying out the instrument
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● All changed parameters are highlighted.

See also Chapter 11, "File and data management", on page 308.

3.4  Instrument control

This chapter provides an overview on how to work with the R&S SMA100B.

It covers the following topics:

● Possible ways to operate the instrument................................................................ 54
● Means of manual interaction...................................................................................54
● Understanding the display information....................................................................55
● Accessing the functionality......................................................................................58
● Entering data...........................................................................................................59

Instrument control
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● Getting information and help...................................................................................61
● Remote control........................................................................................................62
● Remote operation over VNC...................................................................................63

3.4.1  Possible ways to operate the instrument

There are three ways to operate the R&S SMA100B:
● Manual operation:

Use the touchscreen, hard keys and rotary knob, or an optional mouse and/or key-
board.
The description under Chapter 3.4, "Instrument control", on page 53 shows how to
operate the instrument manually.

● Remote control:
Create programs to automatize repeating settings, tests and measurements. The
instrument is connected to a computer running the program.
This way of operation is described in Chapter 13, "Network operation and remote
control", on page 378.

● Remote operation from a computer:
Remote monitoring and control of the instrument from a connected computer is
based on the common cross-platform technology VNC (Virtual Network Comput-
ing). On the remote computer, any standard web browser (supporting Java) or a
dedicated VNC client (like Ultr@VNC) can be used. See also Chapter 3.4.8,
"Remote operation over VNC", on page 63.

3.4.2  Means of manual interaction

For the manual interaction with the R&S SMA100B, you have several methods that you
can use as an alternative to perform a task:
● Touchscreen:

Touchscreen operation is the most direct way to interact. Almost all control ele-
ments and actions on the screen are based on the standard operating system con-
cept. You can tap any user interface element to set parameters in dialog boxes,
enter data, scroll within a dialog etc., as if you work with a mouse pointer.
Tapping the screen works like clicking mouse buttons:
– Touch quickly = click: Selects a parameter or provokes an action.
– Touch and hold = right-click: Opens a context-sensitive menu.
– Touch and swipe = drag: Scrolls through the contents of a display element

larger than the screen, e.g. a list or a table.
● Function keys and rotary knob:

The front panel provides nearly all functions and controls to operate the instrument
in the classic way, without touchscreen.

● Optional mouse and/or keyboard:
These devices work like known from PCs. The navigation keys on the front panel
correspond to the keys on the keyboard.

Instrument control
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This manual describes the manual interaction with the instrument via the touchscreen.
It mentions the alternative methods using the keys on the instrument or the on-screen
keypads if it deviates from the standard operating procedures. The usage of the touch-
screen and navigation keys is described in Chapter 3.4.4, "Accessing the functionality",
on page 58.

Throughout the manual, the term "select" refers to any of the following methods:
● Using a finger on the touchscreen
● Using a mouse pointer in the display
● Using a key on the instrument or on a keyboard

3.4.3  Understanding the display information

The home screen of the R&S SMA100B displays all main settings and generator
states, divided into three main operation areas.

1 2

3

Figure 3-9: Home screen

1 = Taskbar/softkey bar with "Home" and "System Config" key
2 = Status bar
3 = Tile diagram

● Status bar................................................................................................................56
● Tile diagram............................................................................................................ 56
● Taskbar....................................................................................................................56
● Additional display characteristics............................................................................ 57

Instrument control
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3.4.3.1  Status bar

The status bar at the top of the screen indicates the RF frequency and the level of the
output signal provided to the DUT. You can set both parameters directly here.

3.4.3.2  Tile diagram

The tile diagram is the main entry to the settings of the R&S SMA100B.

Tile Access to:

"Modulation" ● Analog and stereo1), and pulse1) modulation settings
● Built in LF generator

"System Config" ● "Save/Recall": settings for saving and loading instrument configurations
● "Remote access": Network and emulation settings.
● "Setup": general system configuration

"Sweep" ● Frequency and level sweeps
● List mode

"Frequency" ● RF frequency and phase
● Reference frequency

"Level" ● RF level
● Attenuator
● Automatic level control
● User correction

"Clk Syn / Pow Sens" ● Clock synthesis1)

● Power sensors

1) requires additional options

3.4.3.3  Taskbar

The "Taskbar" shows a home and an info button, and assigns a labeled button when-
ever you open a dialog. If more dialogs are open than the taskbar can display, touch
and swipe the taskbar to scroll up and down.

The buttons shown in the following example represent the variants.
Table 3-11: Example of buttons in the taskbar

"Home" button

Returns to the home screen.

 

"Busy" indicator

Indicates a running process.

 

"User Menu"

Lists parameters that can be defined for quick access.

Instrument control
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Shows the current remote access connections when the instrument is remotely con-
trolled.

Tip: An indicator in the "System Config" tile shows the current remote control status.

R&S NRP power sensors

Shows a connected external power sensor. The button displays the current readings
when the sensor is active.

Active dialogs

Indicates the dialog name of each active dialog in a separate button.

"Info" key

Provides access to status and error messages.

Note: The warning symbol signifies a permanent error message.

3.4.3.4  Additional display characteristics

The following section provides a short insight on the indication of the screen in general,
and significant elements that you see under specific operating modes, in dialogs or set-
tings.

● Appearance of active elements
– Active elements like On/Off switches, state buttons have a blue background.
– Selected elements are framed or highlighted orange.
– Inactive elements are gray.

● On-Screen keypads
As additional means of interacting with the instrument without having to connect an
external keyboard, either a numerical or alphanumerical on-screen keypad appears
when you activate an entry field (see Chapter 3.4.5, "Entering data", on page 59).

● Info line
The "Info line" shows brief status information and error messages. It appears when
an event generates a message. If selected, the R&S SMA100B shows information
on static errors and the error history.

● Key parameters indicated in tab labels
Most dialogs are divided into tabs with logically grouped parameters. The tab label
expresses the content and can also contain status indicators or the set value of a
key parameter.

● Scroll bar handle
An arrow icon that appears when you touch a scroll bar helps you to scroll in a dia-
log or list.
If no scrollbar handle appears, you can touch and swipe an element to scroll up
and down.

Instrument control
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● Progress indicators
A busy icon indicates a currently running process. If a process takes some time, a
progress bar shows the current state.

● Context-sensitive menus
Within the entire screen display, including single parameters, you can access con-
text-sensitive menus that provide some additional functions.

3.4.4  Accessing the functionality

All functionalities are provided in dialog boxes as known from computer programs. You
can control the instrument intuitively with the touchscreen. This section provides an
overview of the accessing methods.

The instrument's functions and settings can be accessed by selecting one of the follow-
ing elements:
● System and function keys on the front panel of the instrument
● Taskbar/softkeys on the touchscreen
● Context-sensitive menus for specific elements on the touchscreen, or with the

rotary knob (press and hold).
● Elements on the status bar in the touchscreen
● Displayed setting on the touchscreen, that means block diagram and all settings

available in dialogs.

To open a dialog box

► Perform one of the following actions:

Instrument control
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● Tap the required tile, and then the menu entry.
● Tap the minimized view (button) on the taskbar.

Some of the utility keys access a dedicated dialog, too.

To minimize a dialog box

1. To return to the home screen, tap the "Home" button.

2. To switch to another dialog, press the [Next Window] button.

To close a dialog box

To close a dialog box, you have the same controls as you know from computers or
devices with touchscreen.

► Perform one of the following actions:

● Tap the "Close" icon in the upper right corner.
● Press the [Esc] key on the front panel.
● Drag and drop a minimized dialog from the taskbar to the tile diagram.

To select an option in a dialog box

► Tap the required option.

3.4.5  Entering data

Some parameters have their own key on the front panel.

For data input in dialog boxes, the instrument provides on-screen keypads for entering
numeric and alphanumeric values. Thus, you can always set the parameters via the
touchscreen, the front panel, or an external keyboard.

To correct an entry

1. Using the arrow keys, move the cursor to the right of the entry you want to delete.

2. Press the [Backspace] key.

3. Deletes the entry to the left of the cursor.

4. Enter your correction.

To complete the entry

► Press the [Enter] key or the rotary knob.

To abort the entry

► Press the [Esc] key.
The dialog box closes without changing the settings.

Instrument control
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3.4.5.1  Entering numeric parameters

To enter values with the on-screen keypad

For numeric settings, the instrument displays the numeric keypad. The units specified
correspond to the units of the parameter.

1. Enter the numeric value.

Tip: For quick entry, you can enter a value in exponential representation, e.g. 1e7
for 10000000.

2. Tap the unit button to complete the entry.

The unit is added to the entry.

Tip: For quick unit change, you can enter shortcuts, e.g. for a frequency value
1e8h for 100 MHz.
For an overview of shortcuts supported by the R&S SMA100B, see Chapter C,
"Unit shortcuts", on page 782.

3. If the parameter does not require a unit, confirm the entered value by pressing
"Enter".

To enter values by using the front panel controls

1. Change the currently used parameter value by using the rotary knob or the [Up/
Down] keys.

2. If the parameter does not require a unit, confirm the entered value by pressing the
[Enter] key or any of the unit keys.
The instrument highlights the editing line to confirm the entry.

If you edit numeric data in tables, the entry field must be in edit mode: Press [Enter], or
the rotary knob to activate the edit mode.

3.4.5.2  Entering alphanumeric parameters

If a field requires alphanumeric input, you can use the on-screen keyboard to enter let-
ters and (special) characters.

3.4.5.3  Undo and redo actions

Accessed via the context-sensitive menus, "Undo" allows you to restore one or more
actions on the instrument. Depending on the available memory, the "Undo" steps can
restore all actions.

Instrument control
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"Redo" restores a previously undone action.

3.4.6  Getting information and help

In some dialog boxes, graphics are included to explain the way a setting works.

For further information, you can use the following sources:
● Tooltips give the value range of the parameter.
● The context help provides functional description on a setting.
● The general help explains a dialog box, provides instructions, and general informa-

tion.

To display context help

► To access a help topic, perform one of the following:

a) Tap and hold the parameter for which you need information and tap "Help" in
the context menu.

b) Tap the parameter and press the [Help] key.

The "Help" dialog opens. You can browse the help for further information.

Contents of the help dialog box

The help dialog box covers two main areas:
● "Contents" - contains a table of help contents
● "Topic" - contains a specific help topic

The help system also provides an "Index" and a "Find" area, and "Zoom" functions that
are accessed via the corresponding buttons.

Instrument control
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To open general help

► Press the yellow [Help] key on the front panel.

If a dialog box is opened, the help topic for the current tab is shown. Otherwise the
"Contents" page appears.

Navigating in the table of contents and in the help topics

1. To move through the displayed contents entries, tap on an entry and scroll or use a
connected mouse or the [Up/Down] keys.
Entries with a plus sign contain further entries.

2. To display a help topic, tap on the topic name or double-click the topic name or
press the [Enter] key.

3. To follow a cross-reference, tap on the link text.

4. To return to the previous page, select "Back".
This function scrolls back all steps you have performed before.

5. Use the "scroll bars" to shift the visible section of content shown.

6. To maximize the "Topics" area, tap the "Hide Contents Tree" button to hide the con-
tents tree.

Using the index

1. Select the "Index" button.

2. Enter the first characters of the topic you are interested in.

The entries starting with these characters are displayed.

3. Tap on the index entry.

The corresponding help topic is displayed.

3.4.7  Remote control

In addition to working with the R&S SMA100B interactively, located directly at the
instrument, it is also possible to operate and control it from a remote PC.

The R&S SMA100B supports various methods for remote control:
● Connecting the instrument to a LAN (see Chapter 3.1.7, "Connecting to LAN",

on page 30)
● Using the LXI browser interface in a LAN
● Connecting a PC via the IEC-bus (IEEE 488) interface
● Remote control via the USB interface

For remote control over LAN or USB, you can use the R&S VISA (Virtual Instrument
Software Architecture) library provided for download at the Rohde & Schwarz website
http://www.rohde-schwarz.com/rsvisa.

Instrument control
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How to configure the remote control interfaces is described in Chapter 13, "Network
operation and remote control", on page 378.

3.4.8  Remote operation over VNC

The VNC is an application which can be used to access and control the instrument
from a remote computer through a LAN connection. While the instrument is in opera-
tion, the instrument screen contents are displayed on the remote computer, and VNC
provides access to all applications, files, and network resources of the instrument.
Thus, remote operation of the instrument is possible.

Instrument control from a remote computer
To access the basic utility functions of the R&S SMA100B, perform a right mouse click
the block diagram and select "Key Emulation".
A key panel to the right of the block diagram gives access to the utility functions provi-
ded by the front panel keys.

The VNC is an add-on program, included in operating system Linux/Unix, and available
as a free-of-charge download on the internet.

For more information, refer to Chapter 13.10, "Operating the R&S SMA100B remotely
using VNC", on page 439.

Instrument control
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4  RF signal configuration
The R&S SMA100B signal generator generates RF signals with outstanding spectral
purity within the frequency range from 8 kHz up to 20 GHz and with adjustable signal
level over a wide range.

In addition to these real-time CW signals, you can generate RF signals from predefined
lists and sweep signals that vary according to the frequency or amplitude curves.

You can also apply versatile analog modulation types with definable characteristics.

The variably adjustable output level due to the built-in attenuator, allows you to vary the
RF signal level over the full level range. Several methods enable you to improve the
signal performance and to optimize the signal quality for the particular application, or to
increase the accuracy and reliability of the generated RF signal.

The R&S SMA100B supports R&S NRP power sensors, e.g. to monitor the output level
of the generator or to determine the level correction values for user correction lists.

Signal modes and characteristics

The R&S SMA100B generates unmodulated or analog modulated RF signals. You can
output the signal in fixed mode or as a signal with periodically varying frequencies or
amplitudes.

Signal modes for RF signal generation:
● Unmodulated signal

Generates an unmodulated continuous wave (CW) of constant frequency and
amplitude.
For information on the signal frequency and level settings and an example on how
to configure a simple CW signal, see:
– Chapter 4.5, "RF frequency settings", on page 71
– Chapter 4.6, "RF level settings", on page 74
– Chapter 3.3.1, "Generating an unmodulated carrier", on page 46

● Analog modulated signal
Modulates the signal with an analog signal and generates amplitude, phase, fre-
quency and pulse modulation.
See Chapter 5, "Analog modulations", on page 81.

The R&S SMA100B allows you to provide the RF signal with constant or varying fre-
quencies and/or amplitudes at the output:
● Constant frequency and level (CW/Fixed mode)

The RF output signal has the set frequency and level.
● Varying frequency and/or level

– Sweep mode
An RF or LF frequency and RF level sweep signal, processed continuously,
step-by-step or individually and with selectable trigger modes. You can only run
one sweep at a time.

– List mode



RF signal configurationR&S®SMA100B

65User Manual 1178.3834.02 ─ 09

The RF signal is based on a list of predefined frequency and level values pairs
and step widths.

See Chapter 7, "List and sweep mode", on page 171.

4.1  Activating RF signal output

By default, the RF output signal is deactivated.

To activate the RF output signal

1. Configure the RF signal as required.
Set, for example, the frequency and level values.

2. Activate the RF output in one of the following ways:

a) Select "Level" > "RF ON" > "On"
b) Press the [RF on/off] key at the front panel.

When activated, the "RF On" icon in the "Level" tile turns blue.

RF State/RF ON............................................................................................................65
RF output impedance....................................................................................................65

RF State/RF ON
Activates or deactivates the RF output.
Acts as the [RF on/off] key.
Remote command: 
:OUTPut<hw>[:STATe] on page 490

RF output impedance
You can query the impedance of the RF output.
Remote command: 
:OUTPut<hw>:IMPedance? on page 491

4.2  How to set the frequency and level

The simplest form of the RF signal is a continuous wave (CW) of constant frequency
and amplitude. The RF signal is defined by its frequency, level and phase.

To configure the RF signal.

1. Use one of the following:

How to set the frequency and level
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a) In the home screen select:

● "Frequency" and "Level" in the status bar
● "Frequency" in the "Frequency" tile
● "Level" in the "Level" tile
● "Phase" in the "Frequency" tile

b) On the front panel:

● Press the [Freq] key
● Press the [Level] key

2. Enter the values as required.

The R&S SMA100B indicates the frequency and level settings in the status bar of the
home screen, and shows active functions and parameters of the RF signal in the "Fre-
quency" and "Level" tiles.

See "RF frequency and level display with a downstream instrument" on page 66.

RF frequency and level display with a downstream instrument

If your test setup includes a downstream instrument, you can enter the parameter of
the downstream instrument in the frequency or level settings dialog of the
R&S SMA100B. Examples of downstream instruments are mixers, frequency multipli-
ers, amplifiers or attenuators and of their corresponding major parameters offset, multi-
plier, amplitude. The R&S SMA100B generates the signal without the downstream
parameters, but considers all additional parameters concerning the frequency and
level.

Example parameters that affect the frequency and level:
● Frequency offset
● Multiplication factor
● User correction

Any of these cases are indicated by a dedicated icon, displayed in the "Frequency" or
"Level" tile, depending on the affected parameter.

Figure 4-1 illustrates the calculation of the "Frequency" and "Level" values, displayed
in the status bar.

Figure 4-1: Frequency and Level display vs frequency and level at the RF output

How to set the frequency and level
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fRF, LevelRF = Frequency and level ("Status bar > Frequency and Level") at the output of the downstream
instrument, see also Calculation of fRF and LevelRF)

fRF Out, LevelRF

Out

= Frequency and level at the output connector [RF] ("RF > RF Frequency > Frequency" and
"RF > RF Level > Amplitude")

n*f = Multiplication factor ("RF > RF Frequency > Multiplier")
Δf = Frequency offset ("RF > RF Frequency > Offset")
ΔLevel = Power offset ("RF > RF Level > Offset")

Calculation of fRF and LevelRF

● fRF =n*fRF Out + Δf
● LevelRF = LevelRF Out + ΔLevel

4.3  Phase continuous frequency

The R&S SMA100B enables you to generate a phase continuous RF signal over a cer-
tain frequency range. In this mode, the output sine wave signal shows no phase dis-
continuity or glitch when changing the frequency, e.g in sweep mode.

At frequency changes, the switching transitions (intermediate frequencies) cause
spurs. The spurs are due to adjustments in the synthesizer, e.g. adjusting the settings
of dividers, filters, phase detectors can lead to phase discontinuities.

The phase continuous mode freezes the settings of the synthesizer components which
can generate phase discontinuities when adjusted. The R&S SMA100B performs the
frequency changes with the fine resolution synthesizer. The result is a phase continu-
ous change from one frequency to another without transients.

The available frequency range for continuous-phase signal generation is determined
by the fine resolution synthesizer used. The frequency range varies according to the
RF frequency set at the time you activate phase continuous mode.

Equipped with the ultra low phase noise option (R&S SMAB-B711), the R&S SMA100B
enables you to select between two frequency ranges, either to achieve a higher signal
quality or an especially wide frequency range.

4.3.1  How to generate a phase continuous RF signal

To achieve an output sine wave signal with no phase discontinuity or glitch when
changing the frequency, e.g. in RF frequency sweep mode, you can use the phase
continuous mode provided by the instrument.

Activating frequency or phase modulation deactivates phase continuous mode and
vice versa.

To select the phase continuous frequency mode

The folowing example requires, that the instument is equipped with the option
R&S SMAB-B711.

Phase continuous frequency
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Before setting the parameters and activating the phase continuous mode, turn off aci-
tive sweeps.

1. If the "RF Frequency Sweep" is running, select "Sweep" > "RF Frequency Sweep".

2. Turn off "State".

3. On the home screen, select "Frequency" > "Phase".

4. Turn off "Phase Continuous Active", if enabled.

5. Select "Frequency Range" > "Narrow".

6. Check if the range displayed in "Frequency Range From" and "To", corresponds to
your range selection.

7. IF the displayed frequency range does not correspond to the selection, select "Fre-
quency Range > Wide" (requires option R&S SMAB-B711).

8. If the dipslayed range corresponds to the selection, enable "Phase Continuous
Active".

9. In the "RF Frequency Sweep" dialog

a) Modify the "Start Freq" and "Stop Freq" or "Center Frequency" and "Span" as
needed.

b) Set the RF frequency sweep state to “ON”.

To set a phase continuous frequency sweep

1. On the home screen, select "Sweep" > "RF Frequency Sweep" > "Frequency
Range".

2. Set the "Start Frequency" and "Stop Frequency" or "Center Frequency" and "Span"
for the sweep range.

3. In the "General" tab, configure the sweep parameters as required.

4. Turn on "State" to start the sweep signal generation.

4.4  RF connector settings

Access:

1. Select "Frequency" > "RF Connectors".

RF connector settings
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The "RF Connectors" dialog shows the assignment of the logical signals to the con-
nectors. The connectors displayed depend on the options installed.

2. Select a "Signal" to access the corresponding settings dialog or directly set signal
characteristics.

3. Use the built-in Show Connector function to display the physical location of the
selected connector.

The eye icon  in the tab header indicates the panel (front, rear or both) the
selected connector is at.

RF connector settings
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Settings:

Signal............................................................................................................................ 70
Connector......................................................................................................................71
Show Connector............................................................................................................71

Signal
Displays the signal that is assigned to the connector.
Selecting a signal accesses the settings dialog for configuring the signal, or setting sig-
nal characteristics directly.
For additional information on the connectors, see:
● Chapter 3.2.2.1, "Connectors", on page 44
● "Signal output" on page 82 for the assignment of the input and output connectors

used for analog modulation signals.
"Instr. Trigger" Input of an external trigger signal for sweep and list modes, see

Chapter 7.1, "Signal generation and triggering in the sweep and list
modes", on page 173.

"External
Mod..."

Input of an external modulation signal, see "Signal sources"
on page 81.

"LF Output"
Output of the internal LF gennerator signal, Chapter 5.4.8, "LF signal
output settings", on page 120.

"Ref. Freq.
Input"

Input of an external reference signal, see Chapter 9.2, "Reference
frequency settings", on page 294 .

RF connector settings
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"Ref. Freq. Output"
Output of the internal reference signal, see Chapter 9.3, "Reference
output settings", on page 298 .

"Signal Valid" / "Signal Valid Neg."
Automatically generated output signal that identifies a valid signal
time (level and frequency) for all analog modulation signals.
For "Signal Valid Neg." (inverted), the output signal is low during the
valid signal time.

"Pulse In" Input of an external pulse signal or input of external trigger/gate sig-
nal for the internal pulse generator (see Chapter 5.4.4, "Pulse gener-
ator", on page 98).

"Pulse Video" Output of the internal pulse generator signal or the looped through
"Pulse Ext" pulse signal (video signal), see Chapter 5.4.1, "Pulse
modulation settings", on page 84.

Connector
Displays the assigned connector.

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

4.5  RF frequency settings

Access:

1. Select "Frequency" > "RF Frequency".

2. Observe the information on the home screen, "Frequency" tile.

RF frequency settings
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The "Frequency" tile indicates the reference frequency, current frequency offset
and multiplier values, and phase offset value.

In the "RF Frequency" dialog, you can configure:
● RF frequency, incl. an offset or multiplication factor of a downstream instrument
● The step size for varying the frequency with the rotary knob.
The remote commands required to define the settings are described in Chap-
ter 14.16.4, "SOURce:FREQuency subsystem", on page 642.

Settings

Frequency..................................................................................................................... 72
Main PLL Bandwidth..................................................................................................... 73
Offset.............................................................................................................................73
Multiplier........................................................................................................................73
User Variation................................................................................................................73

└ Variation Active............................................................................................... 73
└ Variation Step..................................................................................................73

Frequency
Sets the RF frequency.
This frequency is output at the RF connector. It does not consider an Offset or multipli-
cation factor (Multiplier).
See "RF frequency and level display with a downstream instrument" on page 66.
Note: Suppressed values in the status bar
For security concerns or certain operating modes, you can hide the frequency and
level display in the status bar.
●

The display has been disabled for security reasons.
See:
– Annotation Frequency
– Annotation Amplitude

●

The display is disabled when list mode is running, see Chapter 7, "List and sweep
mode", on page 171.

Remote command: 
[:SOURce<hw>]:FREQuency[:CW|FIXed] on page 644

RF frequency settings
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Main PLL Bandwidth
Selects the PLL (Phase Locked Loop) bandwidth of the main synthesizer.
"Normal" Default main PLL bandwidth.

The instrument provides the maximum modulation bandwidth and
FM/PhiM deviation.

"Narrow"
Sets the narrow PLL bandwidth.

Remote command: 
[:SOURce<hw>]:FREQuency:PLL:MODE on page 649

Offset
Sets the frequency offset.
This value represents the frequency shift of a downstream instrument, like for example
a mixer.
The "Frequency" value displayed in the status bar is the resulting frequency, as it is at
the output of the downstream instrument. The frequency at the R&S SMA100B RF out-
put is not changed.
See "RF frequency and level display with a downstream instrument" on page 66.
Remote command: 
[:SOURce<hw>]:FREQuency:OFFSet on page 646

Multiplier
Sets the multiplication factor for the RF frequency.
This value represents the multiplication factor of a downstream instrument, as for
example a multiplier. You can also assign a negative multiplication factor, for example
-1.0 to support frequency converters working in the reverse frequency position.
The "Frequency" value displayed in the status bar is the resulting frequency, as it is at
the output of the downstream instrument. The frequency at the R&S SMA100B RF out-
put is not changed.
See "RF frequency and level display with a downstream instrument" on page 66.
Remote command: 
[:SOURce<hw>]:FREQuency:MULTiplier on page 646

User Variation
Defines and activates a user-defined step width for varying the RF frequency or RF
level with the rotary knob.
If disabled, the step width varies in steps of one unit at the cursor position.

Variation Active ← User Variation
Activates the set user-defined step width.
Remote command: 
[:SOURce<hw>]:FREQuency:STEP:MODE on page 648
[:SOURce<hw>]:POWer:STEP:MODE on page 688

Variation Step ← User Variation
Sets the user-defined step width.
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Remote command: 
[:SOURce<hw>]:FREQuency:STEP[:INCRement] on page 648
[:SOURce<hw>]:POWer:STEP[:INCRement] on page 688

4.6  RF level settings

Access:

1. Select "Level" > "RF Level".

In the "RF Level" dialog, you can configure the offset-free level, the level limit, and
the step width for varying the level with the rotary knob.

2. Select "User Variation" to set the step width to be used when .setting the RF level
using the rotary knob.

3. Observe the information on the home screen, "Level" tile.
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The "Level" tile indicates the level limit, the user correction status and current cor-
rection value, current setting characteristics incl. mode.

The remote commands required to define the settings are described in Chap-
ter 14.16.11, "SOURce:POWer subsystem", on page 681.

Settings

RF State/RF ON............................................................................................................75
Amplitude...................................................................................................................... 75
Limit...............................................................................................................................76
Offset.............................................................................................................................76
Setting Characteristics.................................................................................................. 76
Harmonic Filter..............................................................................................................77
Level Range.................................................................................................................. 77
Readjust........................................................................................................................ 78
User Variation................................................................................................................78

└ Variation Active............................................................................................... 78
└ Variation Step..................................................................................................78

RF State/RF ON
Activates or deactivates the RF output.
Acts as the [RF on/off] key.
Remote command: 
:OUTPut<hw>[:STATe] on page 490

Amplitude
Sets the level of the RF signal.
The value is offset-free and corresponds to the level at the RF connector.
See "RF frequency and level display with a downstream instrument" on page 66.
Note: Suppressed values in the status bar
For security concerns or certain operating modes, you can hide the frequency and
level display in the status bar.
●

The display has been disabled for security reasons.
See:
– Annotation Frequency
– Annotation Amplitude
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●

The display is disabled when list mode is running, see Chapter 7, "List and sweep
mode", on page 171.

Remote command: 
[:SOURce<hw>]:POWer:POWer on page 687
Note: The SCPI command [:SOURce<hw>]:POWer[:LEVel][:IMMediate][:
AMPLitude] sets the level of the "Level" display.
This means, the level containing offset.

Limit
Sets an upper limit for the RF output power.
You can use this value to protect your DUT from damage due to high input power. If
you enter an RF level above this value, the instrument limits the output power to this
specified value, and generates the warning message:
"Pep value greater than the defined limit." However, the level indication in the status
bar is not affected.
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.
Remote command: 
[:SOURce<hw>]:POWer:LIMit[:AMPLitude] on page 686

Offset
Sets a level offset.
This value represents the level shift of a downstream instrument, like, for example, an
attenuator or an amplifier.
The "Level" value displayed in the status bar is the resulting level, as it is at the output
of the downstream instrument. The level at the R&S SMA100B RF output is not
changed.
See "RF frequency and level display with a downstream instrument" on page 66.
Remote command: 
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet on page 689

Setting Characteristics
Selects additional quality characteristics to optimize the behavior of the RF signal level
for the specific application.
"Auto" Sets the RF output level automatically according to the selected

mode.
In this mode, the instrument provides the highest dynamic range and
fastest setting times, as specified in the data sheet.
The RF signal is shortly blanked when the step attenuator is switch-
ing.
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"Uninterrupted"
Suppresses blanking at level transitions. Frequency transitions can
lead to an RF level blanking due to hardware specific switching
points.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

"Strictly Monotone"
Executes signal level changes monotonically increasing or decreas-
ing.
The setting makes sure that increasing the level value exclusively
results in an increased output level, and vice versa.
All electronic switches, which might affect the monotonicity are fixed.
The operation mode is useful for applications using level searching
algorithms which rely on a strictly monotonous behavior.

"Constant-VSWR"
Suppresses output impedance variations at the RF output connector,
due to changed level settings.

"High Dyn. Uninterrupted"
R&S SMAB-K724
Provides a linear output power that is uninterrupted over a wide
dynamic range.
Note: The R&S SMA100B supports this characteristic at frequencies
above 52 MHz. If you select the setting at lower frequencies
(≤52 MHz), the instrument reports a settings conflict.

"User" Indicates that a setting has been modified in the expert mode. The
expert mode is a protected function, that requires protection level 2
password.

Remote command: 
[:SOURce<hw>]:POWer:LBEHaviour on page 686

Harmonic Filter
Activates low harmonic filter or enables its automatic switching.
"On" Ensures best low harmonics performance but decreases the level

range.
"Auto" Applies an automatically selected harmonic filter that fits to the cur-

rent level setting.
Remote command: 
:OUTPut<hw>:FILTer:MODE on page 491

Level Range
Shows the interruption-free range of the level that you can use in the currently selected
mode.
Remote command: 
[:SOURce<hw>]:POWer:RANGe:LOWer? on page 690
[:SOURce<hw>]:POWer:RANGe:UPPer? on page 690
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Readjust
Recalculates and adjusts the internal switch positions of the RF chain according to the
current level.
In "External ALC" mode, "Readjust" triggers the detector offset zeroing, seeChap-
ter 8.2.2, "How to set up an external ALC", on page 220.
Remote command: 
[:SOURce<hw>]:POWer:ALC:SONCe on page 684

User Variation
Defines and activates a user-defined step width for varying the RF frequency or RF
level with the rotary knob.
If disabled, the step width varies in steps of one unit at the cursor position.

Variation Active ← User Variation
Activates the set user-defined step width.
Remote command: 
[:SOURce<hw>]:FREQuency:STEP:MODE on page 648
[:SOURce<hw>]:POWer:STEP:MODE on page 688

Variation Step ← User Variation
Sets the user-defined step width.
Remote command: 
[:SOURce<hw>]:FREQuency:STEP[:INCRement] on page 648
[:SOURce<hw>]:POWer:STEP[:INCRement] on page 688

4.7  RF phase settings

The phase in sinusoidal signals defines the initial angle at its origin.

Access:

1. Select "Frequency" > "Phase".
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In the "Phase" tab, you can activate the phase continuous mode, set the delta
phase parameter and reset the phase to this reference.

2. Switch to the home screen, "Frequency" tile.

The R&S SMA100B indicates the configured settings.

The remote commands required to define the settings are described in Chap-
ter 14.16.10, "SOURce:PHASe subsystem", on page 681.

Settings

Phase Continuous Active.............................................................................................. 79
Frequency Range..........................................................................................................80
Frequency Range From / To......................................................................................... 80
Delta Phase...................................................................................................................80
Reset Delta Phase Display........................................................................................... 80

Phase Continuous Active
Activates generation of a phase continuous frequency signal.
The R&S SMA100B generates a phase continuous output sinewave, i.e. without phase
discontinuity or glitch when changing the frequency.
For a given RF frequency, the frequency range is limited.
Remote command: 
[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:STATe on page 650
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Frequency Range
Selects the mode that determines the frequency range for the phase continuity of the
RF signal.
The available frequency range depends on the selected mode and is limited by the res-
olution of the used synthesizer. It varies depending on the frequency, and is set when
you activate the phase continuous settings.
"Narrow" Sets a small frequency range, asymmetrically around the RF fre-

quency.
"Wide" Option: R&S SMAB-B711

Sets a large frequency range, symmetrically around the RF fre-
quency.

Remote command: 
[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:MODE on page 650

Frequency Range From / To
Displays the frequency range for phase continuous settings.
The value range depends on the mode selected with Frequency Range.
Remote command: 
[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:LOW? on page 649
[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:HIGH? on page 649

Delta Phase
Sets the phase of the RF signal.
The current phase of the signal is used as the reference.
Remote command: 
[:SOURce<hw>]:PHASe on page 681

Reset Delta Phase Display
Adopts the selected "Delta Phase" value as the current value, and resets delta phase
to 0 degrees.
Remote command: 
[:SOURce<hw>]:PHASe:REFerence on page 681
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5  Analog modulations
The R&S SMA100B supports AM (amplitude modulation), FM (frequency modulation),
ΦM (phase modulation (PhiM)), and also PULM (pulse modulation). It generates low
frequency signals (LF) as sine, triangle, trapezoidal or square (pulse) waveform, that
can be output and further processed by a downstream instrument.

Option: R&S SMAB-K22, enables generation of chirp modulated RF signals.

5.1  Required options

R&S SMA100B base unit equipped with the following options:
● Option frequency (R&S SMAB-B10x)
● Option pulse modulator (R&S SMAB-K22)
● Option pulse generator (R&S SMAB-K23)

(supports generation of single and double pulse signals)
● Option multi-function generator (R&S SMAB-K24)
● Option pulse train generator (R&S SMAB-K27)

(requires R&S SMAB-K23)
● Option AM/FM/PhiM (R&S SMAB-K720)
● Option Scan AM (R&S SMAB-K720 and R&S SMAB-K721)
● Option Chirp Signal Generation (R&S SMAB-K725

(requires R&S SMAB-K22
R&S SMAB-K23, providing extended ranges for resolution, pulse width and pulse
period
R&S SMAB-K720)

For more information, see data sheet.

5.2  Modulation types and signal sources

Radio transmitters do not transmit an audio signal directly. Instead, they modulate the
audio signal onto a continuous wave (CW) carrier with much higher frequency.

A CW carrier has a sinusoidal waveform with constant amplitude and constant fre-
quency. Modulating a signal onto the carrier means varying a property of the carrier
according to the modulating signal. The three basic modulation types FM, AM and
PhiM for example, vary one property of the carrier proportional to the instantaneous
amplitude of the modulating signal.

Signal sources

If fully equipped, the R&S SMA100B modulates signals from the following sources:
● Internal modulation source

Modulation types and signal sources
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– Two LF generators
Each of the LF generators provides a modulation signal with sine, pulse, trian-
gle or trapezoid shape.

– Noise generator
The noise generator supplies white noise with selectable bandwidth and distri-
bution.

– High-performance pulse generator
Generates single and double pulse, or pulse train signals.

● External modulation source
– Amplitude, frequency or phase modulation signals are input at the Ext connec-

tor.
– Pulse modulation signals, at the Pulse Ext connector.

Signal output

You can perform AM, FM and PhiM with the signal of any of the provided sources.
Moreover, you can combine two modulation signals and generate a two-tone signal.
Regardless of the signal source, the generated signal can be output for further pro-
cessing in a downstream instrument.

Current configuration is indicated in the "Analog Modulations > Overview" dialog; the
output signal routing can be changed, too.

Input and output connectors

Direction Modulation Connector Required option

Output Pulse modulation from internal signal

Loop through of pulse signal from Pulse Ext

Pulse Video R&S SMAB-K22/-K23

  

All analog modulations

Marks the valid level and frequency

Inverted version; the output signal is low dur-
ing the valid signal times.

Signal Valid

Signal Valid Neg.

 

 Chirp Modulation Pulse Video

Pulse Sync

R&S SMAB-K22/-K23

 Pulse generator Pulse Sync  

 LF generator LF  

Input AM, FM, PhiM Ext **) R&S SMAB-K720

 Pulse modulation from external source*)

Or

External trigger or gate signal*)

Pulse Ext**) R&S SMAB-K22

● *) External trigger signal and external signal for the pulse modulation cannot be
used simultaneously, because these signals are expected at the same connector
Pulse Ext. Signal polarity and impedance are the same for both signals.

Modulation types and signal sources
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● **) The external modulation signal must have a voltage of US = 1 V (UEFF = 0.707
V) to achieve the displayed modulation depth and range.
Note that the input voltage does not exceed 1 V, otherwise modulation distortions
can occur.

For more information, see data sheet.

Interactions and characteristics

● FM and PhiM modulations exclude each other and cannot be performed simultane-
ously.

● In sweep mode, LF frequency sweep is possible.
● The settings of the modulation signal affect all analog modulations that use an

internal modulation source.
● You can feed an external LF signal in each of the two paths.
● Considerations to AM when using an external modulation signal:

If external modulation is enabled, the RFoutput amplitude follows the external mod-
ulation signal with a scaling factor defined by the modulation sensitivity setting.
With Coupling (AC/DC) > DC, the RF output signal behaves according to:
– input signal = 0 V: the RF output amplitude corresponds to the level value set in

the R&S SMA100B
– input signal = +1 V: the output level increases up to the maximum value given

by the set modulation sensitivity
– input signal = -1 V: the output level decreases down to the minimum value

given by the set modulation sensitivity
With Coupling (AC/DC) > AC, the modulation input signal is internally highpass fil-
tered. Therefore, the DC content of the input signal is removed before it reaches
the amplitude modulator.

● Using exponential amplitude modulation with an external source, sets the coupling
of the corresponding input automatically to DC.
See also Chapter 5.4.7.2, "Source > external settings", on page 117.

● Scan AM
– Scan AM provides the scan mode, i.e. an amplitude modulation depth with an

extended dynamic range that automatically uses the exponential amplitude
modulation type.

– If you use Scan AM with an external modulation input signal, the voltage range
is adjusted to +/- 6 V (usually +/-1 V). Therefore, we recommend that you do
not use the external modulation signal for FM or PhiM in parallel, since the volt-
age affects the modulations.

● The amplitude modulation types linear and exponential derive the carrier signal
either linear in percent / volt, or as complex exponential in dB / volt.

● For pulse modulated signals, you can select between fast or smoothed transitions,
see "Transition Type" on page 86.
This setting is available over the entire frequency range for all instruments with fre-
quency options up to 6 GHz. For higher frequency options, the frequency range for
the smoothed setting is limited.

● Chirp modulation

Modulation types and signal sources
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– excludes PhiM, avionics and pulse modulation
– disables automatic level control (ALC)
– can not be operated with an external modulation signal

For more information, see data sheet.

5.3  Activating analog modulations

► Use one of the following:

● Select "Modulation > Amplitude Modulation/Frequency Modulation/Phase Mod-
ulation > State > ON".

● Select "Modulation > MOD ON".
● Press the [Mod on/off] key.

[Mod on/off]
Activate one or more analog modulations and press the [Mod on/off] key to toggle the
state of them all.
Pressing the key again restores the status that was active before the last switch-off.
Remote command: 
[:SOURce<hw>]:MODulation[:ALL][:STATe] on page 561

5.4  Modulation settings

Access:

► Select "Modulation" > "Modulation Sources".

The "Modulation" dialog contains all functions and settings to configure the analog
modulations, the LF signal sources for performing a modulation, and the LF signal
output.
The remote commands required to define these settings are described in:
● Chapter 14.16.1.2, "SOURce:AM subsystem", on page 562
● Chapter 14.16.1.4, "SOURce:FM subsystem", on page 572
● Chapter 14.16.1.5, "SOURce:PM subsystem", on page 577
● Chapter 14.16.1.6, "SOURce:PULM subsystem", on page 581
● Chapter 14.16.1.3, "SOURce:CHIRp subsystem", on page 568
● Chapter 14.16.6, "SOURce:LFOutput subsystem", on page 652

5.4.1  Pulse modulation settings

Option: see Chapter 5.1, "Required options", on page 81.

Modulation settings
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Access:

► Select "Modulation" > "Pulse Modulation".

The "Pulse Modulation" dialog contains all parameters required to configure the
pulse modulator and the pulse generator.
It also displays the pulse signal graphically.

For an overview of the supported signals sources and related connectors, see Chap-
ter 5.2, "Modulation types and signal sources", on page 81.

The remote commands required to define these settings are described in Chap-
ter 14.16.1.6, "SOURce:PULM subsystem", on page 581.

Settings:

State..............................................................................................................................85
Source...........................................................................................................................85
Transition Type..............................................................................................................86

State
Activates pulse modulation and triggers the following automatic settings:
● Pulse generator is activated.

The signal is output at the Pulse Video connector.
To deactivate the signal output, set "Pulse Generator" > Pulse Output State > "Off".

Remote command: 
[:SOURce<hw>]:PULM:STATe on page 585

Source
Selects between the internal "Pulse Generator" or an "External" pulse signal for the
modulation.
"Pulse Generator"

Selects the internal generator.
See Pulse generator.

"External" Modulation source is fed to the input connector.
See "Signal sources" on page 81.

Modulation settings



Analog modulationsR&S®SMA100B

86User Manual 1178.3834.02 ─ 09

Remote command: 
[:SOURce<hw>]:PULM:SOURce on page 585

Transition Type
Selects between "Fast" or "Smoothed" slew rate (slope).
"Fast" Enables fast transitions with shortest rise and fall times.
"Smoothed" Flattens the slew rate, resulting in longer rise / fall times. Use this

mode if you are working with devices that are sensitive to steep
slopes.
Note: The R&S SMA100B supports this functionality up to a certain
frequency, depending on the installed frequency options, see also
"Interactions and characteristics" on page 83.
For more information, see data sheet.

Remote command: 
[:SOURce<hw>]:PULM:TTYPe on page 585

5.4.2  FM, PhiM and AM modulation settings

Option: R&S SMAB-K720

Access:

► Select "Modulation" > "Amplitude Modulation/Frequency Modulation/Phase Modu-
lation".

The "FM", "ΦM" and "AM" tabs contain the parameters per modulation type.

Modulation settings
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Source

State..............................................................................................................................87
Source...........................................................................................................................87
FM settings....................................................................................................................88

└ Deviation.........................................................................................................88
└ Deviation Mode...............................................................................................88
└ Total Deviation................................................................................................ 88
└ Ratio Path2/Path1...........................................................................................88
└ Mode...............................................................................................................89

PhiM settings.................................................................................................................89
└ Deviation.........................................................................................................89
└ Deviation Mode...............................................................................................89
└ Total Deviation................................................................................................ 90
└ Ratio Path2/Path1...........................................................................................90
└ Mode...............................................................................................................90

AM settings................................................................................................................... 90
└ Mode...............................................................................................................91
└ Type................................................................................................................ 91
└ Depth.............................................................................................................. 92
└ Sensitivity........................................................................................................92
└ Deviation Mode...............................................................................................92
└ Total Depth......................................................................................................92
└ Ratio Path2/Path1...........................................................................................93

State
Activates a modulation.
Note: Some modulations exclude each other and cannot be performed simultaneously.
For more information, see data sheet.
Remote command: 
[:SOURce<hw>]:AM<ch>:STATe on page 564
[:SOURce<hw>]:FM<ch>:STATe on page 574
[:SOURce<hw>]:PM<ch>:STATe on page 578

Source
Selects the LF signal source.
You can vary the signal sources for each of the modulations.
"LF Generator 1/2"

Selects one or both of the internally generated LF signals.
See Chapter 5.4.7.1, "Source > LF generator settings", on page 113.

"External 1/2" Selects an externally supplied LF signal.
"Noise Generator"

Selects the internally generated noise signal.
See Chapter 5.4.7.3, "Source > noise generator settings",
on page 119.

Modulation settings
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Remote command: 
[:SOURce<hw>]:AM<ch>:SOURce on page 565
[:SOURce<hw>]:FM<ch>:SOURce on page 574
[:SOURce<hw>]:PM<ch>:SOURce on page 579

FM settings
The following settings are dedicated to FM.

Deviation ← FM settings
Sets the frequency modulation deviation in Hz.
The maximal deviation depends on the RF frequency and the selected modulation
mode (see data sheet).
Maximal possible deviation is selected automatically, if one of the following applies:
● The selected deviation is too high for the particular frequency
● The selected frequency is outside of the range where deviation is possible.
A warning message indicates this situation, too.
Remote command: 
[:SOURce<hw>]:FM<ch>[:DEViation] on page 574

Deviation Mode ← FM settings
Enables you to couple the LF signal of both paths and determines the mode for fixing
the total deviation.
The total deviation is the sum of both paths. When the sum is exceeded, the
R&S SMA100B reports a settings conflict, but does not change the settings.

"Uncoupled" Enables you to adjust the deviation for each path independently.
"Fixed Total" Couples the deviation of both paths in per Hz. If you change the devi-

ation of any path, the R&S SMA100B automatically adjusts the value
of the other path. The sum always results in the set Total Deviation.

"Fixed Ratio" Couples the deviation ratio of both paths. If you change the deviation
of any path, the R&S SMA100B adjusts the value of the other path.

Remote command: 
[:SOURce<hw>]:FM:DEViation:MODE on page 575

Total Deviation ← FM settings
Sets the sum of the signal deviation for path 1 and path 2 in Hz when using combined
sources in Deviation Mode > Fixed Total.
Deviation of both paths always sum up to the value of the total deviation.
Behavior when changing any depth settings:
● Changing the total deviation adjusts the deviation of both paths proportionally.
● Changing the deviation of one path adjusts the deviation of the other path. The

sum always results in the set total deviation.
Remote command: 
[:SOURce<hw>]:FM:DEViation:SUM on page 575

Ratio Path2/Path1 ← FM settings
Sets the deviation ratio (path2 to path1) in percent.

Modulation settings
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Example: 
If the deviation in path1 is 10 kHz and the ratio is 50%, the deviation in path 2 is auto-
matically set to 5 kHz.

Remote command: 
[:SOURce<hw>]:FM:RATio on page 576

Mode ← FM settings
Selects the mode of the frequency modulation.
"High Bandwidth"

The maximum range for modulation bandwidth is available.
"Low Noise" Phase modulation with phase noise and spurious characteristics

close to CW mode. The range for modulation bandwidth and FM devi-
ation is reduced (see data sheet).
To reduce the phase noise further, set the Main PLL Bandwidth =
"Narrow"

Remote command: 
[:SOURce<hw>]:FM:MODE on page 576

PhiM settings
The following settings are dedicated to PhiM.

Deviation ← PhiM settings
Sets the phase modulation deviation in radians or degrees.
The maximal deviation depends on the RF frequency and the selected modulation
mode (see data sheet).
Maximal possible deviation is selected automatically, if one of the following applies:
● The selected deviation is too high for the particular frequency
● The selected frequency is outside of the range where deviation is possible.
A warning message indicates this situation, too.
Remote command: 
[:SOURce]:PM<ch>[:DEViation] on page 581

Deviation Mode ← PhiM settings
Enables you to couple the LF signal of both paths and determines the mode for fixing
the total deviation.
The deviation sum 2 rad at a maximum. When the sum is exceeded, the
R&S SMA100B adjusts the settings automatically.

"Uncoupled" Enables you to adjust the deviation for each path independently.
"Fixed Total" Couples the deviation of both paths. If you change the deviation of

any path, the R&S SMA100B automatically adjusts the value of the
other path. The sum always results in the set Total Deviation.

"Fixed Ratio" Couples the deviation ratio of both paths. If you change the deviation
of any path, the R&S SMA100B adjusts the value of the other path.

Remote command: 
[:SOURce<hw>]:PM:DEViation:MODE on page 580
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Total Deviation ← PhiM settings
In Deviation Mode = Fixed Total, sets the sum of the signal deviation for path 1 and
path 2.
Deviation of both paths always sum up to the value of the total deviation.
Behavior when changing any depth settings:
● Changing the total deviation adjusts the deviations of both paths proportionally.
● Changing the deviation of one path adjusts the deviation of the other path. The

sum always results in the set total deviation.
Remote command: 
[:SOURce<hw>]:PM:DEViation:SUM on page 580

Ratio Path2/Path1 ← PhiM settings
Sets the deviation ratio (path2 to path1) in per cent.

Example: 
If the deviation in path1 is 10 rad and the ratio is 50%, the deviation in path 2 is auto-
matically set to 5 rad.

Remote command: 
[:SOURce<hw>]:PM:RATio on page 580

Mode ← PhiM settings
Selects the mode of the phase modulation.
"High Bandwidth"

The maximum range for modulation bandwidth and PhiM deviation is
available.
However, phase noise increases at low frequencies, and the range of
PhiM deviation is limited. This mode is suitable if you process high
frequencies.

"High Deviation"
The maximum range for PhiM deviation is available.
Phase noise is improved for low frequencies compared to the default
mode. The range for modulation frequency is limited (see data sheet).
This mode is suitable for low modulation frequencies and/or high
PhiM deviation.

"Low Noise" Frequency modulation with phase noise and spurious characteristics
close to CW mode. The range for modulation bandwidth and FM devi-
ation is reduced (see data sheet).

Remote command: 
[:SOURce<hw>]:PM:MODE on page 579

AM settings
The following settings are dedicated to AM.

Modulation settings
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Mode ← AM settings
Selects the mode to derive the carrier signal for amplitude modulation.
"Normal" Performs the standard amplitude modulation with a single sinusoidal

carrier signal.
"Scan" (Option: R&S SMAB-K721)

Performs amplitude modulation with a higher dynamic range.
The R&S SMA100B provides a special exponential amplitude modu-
lation system optimized for highest dynamic range. You can use the
scan mode to emulate level behaviors of transmitter/receiver systems
with rotating antennas. Selecting "Mode > Scan" sets the modulation
type to "Exponential".
Note: Using exponential AM with an external source affects other
operating modes as described in "Interactions and characteristics"
on page 83.

Remote command: 
[:SOURce<hw>]:AM:MODE on page 566

Type ← AM settings
Selects the type of the amplitude modulation for both paths.
Using exponential AM with an external source affects the coupling mode and the exter-
nal modulation input, see "Interactions and characteristics" on page 83.
"Linear" Sets linear amplitude modulation with depths specified in per-

cent / volt.

"Exponential" Sets ethe exponential AM type with depths in dB / volt.
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Remote command: 
[:SOURce<hw>]:AM:TYPE on page 568

Depth ← AM settings
Determines the depth of the modulation signal in percent.
For "Type = Exponential", the unit of "AM Depth" changes to dB.
The depth is limited by the maximum peak envelope power (PEP).
Remote command: 
[:SOURce<hw>]:AM<ch>:DEPTh:LINear on page 565
[:SOURce<hw>]:AM<ch>:DEPTh:EXPonential on page 566

Sensitivity ← AM settings
Sets the input sensitivity of the external modulation signal.
Remote command: 
[:SOURce<hw>]:AM<ch>:SENSitivity[:LINear] on page 568
[:SOURce<hw>]:AM<ch>:SENSitivity:EXPonential on page 567

Deviation Mode ← AM settings
Enables you to couple the LF signal of both paths and determines the mode for fixing
the total deviation.
The deviation sum of both paths is 100% in total. When the sum is exceeded, the
R&S SMA100B reports a settings conflict, but does not change the settings.

"Uncoupled" Enables you to adjust the deviation depth for each path independ-
ently.

"Fixed Total" Couples the deviation depth of both paths in per cent. If you change
the depth of any path, the R&S SMA100B automatically adjusts the
value of the other path. The sum always results in the set Total
Depth.

"Fixed Ratio" Couples the deviation ratio of both paths. If you change the depth of
any path, the R&S SMA100B adjusts the value of the other path.

Remote command: 
[:SOURce<hw>]:AM:DEViation:MODE on page 567

Total Depth ← AM settings
Sets the sum of the signal Depth for path 1 and path 2 in per cent when using com-
bined sources and Deviation Mode > Fixed Total.
Using external LF signals, the R&S SMA100B indicates the Sensitivity per Volts for the
input signal.
Provided both signal paths are turned on, the depth of both paths always sum up to the
value of the total depth.
Behavior when changing any depth settings:
● Changing the total depth adjusts the depths of both paths proportionally.
● Changing the depth of one path adjusts the depth of the other path. The sum

always results in the set total depth.
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Remote command: 
[:SOURce<hw>]:AM:DEPTh:SUM on page 566

Ratio Path2/Path1 ← AM settings
Sets the deviaton ratio of the signal depth for path 2 to path 1 in per cent when using
combined sources.
Using external LF signals, the R&S SMA100B indicates the Sensitivity per Volts for the
input signal.
In conjunction with the deviation mode, you can set the depth of both paths independ-
ently or coupled.
● Deviation Mode > Uncoupled

Enables you to set the Depth or Sensitivity of both paths independently.
● Deviation Mode > Fixed Ratio

Couples the ratio of the two paths as follows.
– Changing the ratio path2/path1 adjusts the depth of both path2. The depth of

path1 remains the same
– Changing the depth of one path adjusts the depth of the other accordingly. The

ratio path2/path1 remains the same.
Remote command: 
[:SOURce<hw>]:AM:RATio on page 567

5.4.3  Chirp modulation

Option: see Chapter 5.1, "Required options", on page 81.

About chirp modulation

Chirp modulation is used in radar technique to achieve pulse compression. Pulse com-
pression increases the sensitivity and resolution of radar systems by modifying trans-
mitted pulses to improve their auto-correlation properties. To chirp the radar signal is
one way of accomplishing pulse compression. A chirp is a signal with increasing or
decreasing frequency over time.

The R&S SMA100B always couples the chirp modulation with the pulse modulation. It
generates the modulation signals for FM and pulse modulator, and synchronizes the
signals internally. The internal pulse generator signal is the modulation source for the
pulse modulator, and the internal LF generator signal is the signal source for the fre-
quency modulation. Normal FM mode is used. Using an external modulation signals is
not possible for chirp modulation.

The following graph shows the FM demodulated signal of chirped pulses with a chirp
bandwidth of 80 MHz and a pulse width of 80 µs. Chirp direction is up.
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The nominal level is used for typically 3 ms to 5 ms after level or frequency setting, if:
● No attenuator is fitted.
● "High Power" mode is enabled.
● "Auto" mode is enabled, and if the level is in the range of the high power, i.e. the

mechanical relay bypass is switched.

For more information, see data sheet.

5.4.3.1  Chirp modulation settings

Option: see Chapter 5.1, "Required options", on page 81.

● Chirp modulation.....................................................................................................95
● Pulse external / trigger............................................................................................ 97
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Chirp modulation

Access:

► Select "Modulation" > "Chirp Modulation".

The "Chirp Modulation" dialog contains the parameters for configuring the modula-
tion and trigger settings.

State..............................................................................................................................95
Direction........................................................................................................................ 95
Pulse Period..................................................................................................................96
Bandwidth..................................................................................................................... 96
Trigger Mode.................................................................................................................97
Pulse Width................................................................................................................... 97
Compression Ratio........................................................................................................97
Show Connector............................................................................................................97
Execute Single Trigger..................................................................................................97

State
Activates chirp modulation.
Note: Some modulations exclude each other and cannot be performed simultaneously.
For more information, see data sheet.
Remote command: 
[:SOURce<hw>]:CHIRp:STATe on page 571

Direction
Selects the direction of the chirp modulation.
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"Up" The chirp starts with the lower frequency.

"Down" The chirp starts with the higher frequency.

Remote command: 
[:SOURce<hw>]:CHIRp:DIRection on page 570

Pulse Period
Sets the period of the generated chirp. Option: R&S SMAB-K23 provides higher resolu-
tion.
For more information, see data sheet.
Remote command: 
[:SOURce<hw>]:CHIRp:PULSe:PERiod on page 570

Bandwidth
Sets the modulation bandwidth in Hz.
The modulation bandwidth is the difference between the maximum and minimum fre-
quency. E.g. a bandwidth of 10 MHz at a center frequency of 1 GHz leads to a fre-
quency modulation between 995 MHz and 1005 MHz.
The maximum bandwidth depends on the installed frequency option and the RF fre-
quency. If the bandwidth exceeds the RF frequency, or the frequency is out of the
bandwidth range, the R&S SMA100B sets the maximum bandwidth and generates an
error message.
For more information, see data sheet.
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Remote command: 
[:SOURce<hw>]:CHIRp:BANDwidth on page 570

Trigger Mode
Selects the trigger mode for chirp modulation signals.
To supply the external trigger signal, use the Pulse Ext connector.
"Auto" Generates the chirp modulation signal continuously.
"Single" Generates the chirp modulation signal once, triggered internally with

"Execute Single Trigger" on page 97.
"Ext Single" Generates a single chirp pulse, triggered by an external signal.
"Ext Triggered"

Generates the chirp pulse each time an external trigger event occurs.
"Extern Gated" Generates the chirp pulse signal triggered by an external gate signal.
Remote command: 
[:SOURce<hw>]:CHIRp:TRIGger:MODE on page 571

Pulse Width
Sets the width of the generated pulse. The pulse width must be at least 1 us less than
the set pulse period. Option R&S SMA100B-K23 provides a higher resolution.
For more information, see data sheet.
Remote command: 
[:SOURce<hw>]:CHIRp:PULSe:WIDTh on page 571

Compression Ratio
Indicates the pulse compression ratio, i.e. the product of the pulse width in (s) and the
bandwidth (Hz). Pulse compression increases the range resolution and the signal to
noise ratio of pulsed signals.
Remote command: 
[:SOURce<hw>]:CHIRp:COMPression:RATio? on page 570

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Execute Single Trigger
If[:SOURce<hw>]:CHIRp:TRIGger:MODE > SINGle "Trigger Mode = Single", ini-
tiates a single pulse sequence manually.
Remote command: 
[:SOURce<hw>]:CHIRp:TRIGger:IMMediate on page 571

Pulse external / trigger

Access:

1. Select "Modulation" > "Chirp Modulation".
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2. Select "Pulse External / Trigger".

The "Pulse External / Trigger" dialog contains the parameters for configuring the
externally applied pulse and trigger signals.

Show Connector............................................................................................................98

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

5.4.4  Pulse generator

Option: see Chapter 5.1, "Required options", on page 81.

Access:

► Select "Modulation" > "Pulse Modulation > Pulse Generator".
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The "Pulse Generator" tab contains the settings for creating the pulse modulation
signal internally.

● Pulse generator > general settings......................................................................... 99
● Pulse generator > pulse train settings...................................................................104
● Import/export list files............................................................................................ 108

5.4.4.1  Pulse generator > general settings

Access:

► Select "Modulation" > "Pulse Modulation > Pulse Generator".

Settings

Pulse Mode................................................................................................................. 100
Trigger Mode...............................................................................................................101
Pulse Period................................................................................................................103
Pulse Width................................................................................................................. 103
Double Pulse Width.....................................................................................................104
Pulse Delay................................................................................................................. 104
Double Pulse Delay.....................................................................................................104
Pulse Repetition Frequency........................................................................................ 104
Pulse Output State...................................................................................................... 104
Show Connector..........................................................................................................104
Pulse Output Polarity.................................................................................................. 104
Execute Single Trigger................................................................................................104
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Pulse Mode
Sets the operating mode of the pulse generator. Depending on the selection, the instru-
ment displays the associated parameters.
"Single" Generates a single pulse in one pulse period.

1 = Pulse delay
2 = Pulse width
3 = Pulse period

"Double" Generates two pulses in one pulse period.

1 = Pulse width
2 = Double pulse delay
3 = Double pulse width
4 = Pulse period
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"Train" Option: R&S SMAB-K27
Generates a user-defined pulse train.

1 = 1st pulse: On-time
2 = 1st pulse: Off-time
3 = 1st pulse: pulse period
4 = 2nd pulse: repeated 3 times
5 = 3rd pulse
6 = 4th pulse

See Chapter 5.4.4.2, "Pulse generator > pulse train settings",
on page 104.

Remote command: 
[:SOURce<hw>]:PULM:MODE on page 583

Trigger Mode
Selects between continuous triggering or triggering initiated by a trigger event from an
external signal.
See also "Input and output connectors" on page 82.
"Auto" Generates the internal modulation signal continuously.
"Single" The pulse generator is triggered by an internal trigger event, initiated

with Execute Single Trigger.
The pulse signal is generated once.

"Ext Single" Generates a single pulse signal, triggered by an external signal.
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"Ext Triggered" Generates the pulse signal each time an external trigger event
occurs.

Example: Generation of single pulse signal ("Pulse Mode = Sin-
gle") using "Trigger Mode = Ext Triggered"

1 = External trigger signal input with "Trigger Input Polarity = Normal" (the positive
slope is active)

2 = Sync signal
3 = Pulse signal
Δt = Trigger delay between the trigger and the sync signal start; see data sheet
delay = "Pulse Delay = 100 ns"
PW = "Pulse Width = 100 ns"

Example: Generation of double pulse signal ("Pulse Mode = Dou-
ble") using "Trigger Mode = Ext Triggered"

1 = External trigger signal input with "Trigger Input Polarity = Normal" (the positive
slope is active)

2 = Sync signal
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3 = Pulse signal
a = Trigger signal during double pulse generation is without effect
Δt = Trigger delay between the trigger and the sync signal start; see data sheet
delay = "Double Pulse Delay = 200 ns"; the first pulse starts without a delay
PW = "Double Pulse Width = 100 ns"

"Ext Gated" Generates the signal triggered by an external gate signal.

Example: Generation of single pulse signal ("Pulse Mode = Sin-
gle") using "Trigger Mode = Ext Gated"

1 = External trigger signal input with "Trigger Input Polarity = Normal" (the positive
slope is active)

2 = Sync signal
3 = Pulse signal
Δt = Trigger delay between the trigger and the sync signal start; see data sheet
delay = "Pulse Delay = 100 ns"
PW = "Pulse Width = 100 ns"
period = "Pulse Period = 300 ns" (time between the pulse start of two consecutive pul-

ses)
a = Gate active duration (pulses are generated during the gate active part)

Remote command: 
[:SOURce<hw>]:PULM:TRIGger:MODE on page 583

Pulse Period
Sets the repetition rate of the generated pulse signal.
Remote command: 
[:SOURce<hw>]:PULM:PERiod on page 583

Pulse Width
Sets the pulse duration of the generated pulse signal.
Note: The pulse width must be at least 20 ns less than the set pulse period.
Remote command: 
[:SOURce<hw>]:PULM:WIDTh on page 584
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Double Pulse Width
Sets the width of the second pulse.
Remote command: 
[:SOURce<hw>]:PULM:DOUBle:WIDTh on page 585

Pulse Delay
Sets the pulse delay. The pulse delay determines the time that elapses after a trigger
event before pulse modulation starts. The pulse delay is not effective for double pulse
generation.
Remote command: 
[:SOURce<hw>]:PULM:DELay on page 584

Double Pulse Delay
Sets the delay from the start of the first pulse to the start of the second pulse.
Remote command: 
[:SOURce<hw>]:PULM:DOUBle:DELay on page 584

Pulse Repetition Frequency
Indicates the number of pulses of the repeating signal in a specific time unit.
The parameter is commonly expressed in Hz or in pulses per second (pps).
Remote command: 
n.a.

Pulse Output State
Activates the output of the pulse modulation signal.
Remote command: 
[:SOURce<hw>]:PGENerator:OUTPut[:STATe] on page 680

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Pulse Output Polarity
Sets the polarity of the pulse output signal.
Remote command: 
[:SOURce<hw>]:PGENerator:OUTPut:POLarity on page 680

Execute Single Trigger
If "Trigger Mode = Single", initiates a single pulse sequence manually.
Remote command: 
[:SOURce]:PULM[:INTernal][:TRAin]:TRIGger:IMMediate on page 583

5.4.4.2  Pulse generator > pulse train settings

Option: see Chapter 5.1, "Required options", on page 81.
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Access:

1. Select "Modulation" > "Pulse Modulation > Pulse Generator" > "Pulse Mode =
Train".

2. Select "Pulse Train Data".

3. Select an existing file or select "New" to create one.

4. Define the filename.
Select "Edit Pulse Train Data", if the file is empty or to control and change the val-
ues.

5. In the "Edit Pulse Train Data" dialog, enter the pulse on/off times and pulse repeti-
tion values.

6. Select "Save".

A pulse train is a sequence of pulses with user-defined repetition, and pulse on and
off times. Once defined, pulse train settings can be saved in a file. The filename is
user-definable; the file extension (*.pulstrn) is assigned automatically.
When a file is selected, the filename is indicated.

Possible ways to configure a pulse train

You can configure a pulse train in the following ways:
● Internally

– Use the built-in editor table editor, see in the "Pulse Generator > Pulse Train"
dialog.
Once defined, pulse train settings can be saved in a file. For example, to
exchange configuration between instruments or to modify the file content with
an external program and reload them again.
The filename is user-definable; the file extension is *.pulstrn.

– Using the corresponding remote-control commands.
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Note that you have to create a pulse train file first.
● Externally

Create a pulse train sequence as a CSV file with Microsoft Excel, with a Notepad
or a similar tool, save it with the predefined extension. Transfer the file to and load
it into the instrument.

Pulse train ASCII file format

Files describing pulse trains are simple files in text or comma-separated value (CSV)
file format. The filename is user-definable; the file extension is *.csv or *.txt.

The file contains a list of pulse definition values, one row per pulse; a new line indicator
separates the pulses. Pulses are defined with their pulse on time, pulse off time given
in us and number of repetitions.

Example: Pulse train file content (*.txt file)
0.0001,0.0005,2
0.00025,0.0005,1
0.0001,0.0003,3

For file handling, use the standard functions in the "File Manager", see Chapter 11.8,
"Using the file manager", on page 324.

Settings

Pulse Train Data..........................................................................................................106
Edit Pulse Train Data.................................................................................................. 107
Data handling keys......................................................................................................107

└ Go To............................................................................................................ 107
└ Edit................................................................................................................107
└ Save As/Save............................................................................................... 107

Fill................................................................................................................................107

Pulse Train Data
Accesses the standard "File Select" function of the instrument. The provided navigation
possibilities in the dialog are self-explanatory.
Pulse train files are files with predefined file extension *.pulstrn. When a file is
selected, the dialog indicates the filename.
You can create the file internally in the table editor or externally.
● To select an existing file, select "Select List > navigate to the file *.pulstrn > Select"
● Use the general editor function to create internally new file or to edit an existing

one.
● Use the standard file manager function to load externally created files to the instru-

ment.
Remote command: 
[:SOURce<hw>]:PULM:TRAin:CATalog? on page 588
[:SOURce<hw>]:PULM:TRAin:SELect on page 589
[:SOURce<hw>]:PULM:TRAin:DELete on page 588
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Edit Pulse Train Data
Accesses the build-in table editor to define a new pulse train file or edit an existing one.
"On-Time, µs/Off-Time,µs"

Sets the pulse on and pulse off time.
"Count" Sets the number of repetitions of an "On-/ Off-Time" value pair.

Pulses with "Count = 0" are ignored.
Use this method to skip value pairs temporarily, without deleting them
from the table.

Remote command: 
[:SOURce<hw>]:PULM:TRAin:ONTime on page 588
[:SOURce<hw>]:PULM:TRAin:OFFTime on page 588
[:SOURce<hw>]:PULM:TRAin:REPetition on page 589
[:SOURce<hw>]:PULM:TRAin:DELete on page 588

Data handling keys
Standard functions for file and data handling.

Note: Save a list only after filling both columns (frequency and level), otherwise the
entries are lost.

Go To ← Data handling keys
Selects a row for editing.

Edit ← Data handling keys
Enables you to insert, or delete a row or ranges within a list, and provides access to a
dialog for automatic filling.
See "Fill..." on page 107.

Save As/Save ← Data handling keys
Saves the list in a file with user-defined name and predefined file extension. To save a
copy or create a file, use the "Save as" function.

Fill...
Provides parameters for filling a table automatically with user-defined values.
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To fill the table, select "Fill".
Note: Once you enter a value or fill a column, the editor automatically adds preset val-
ues in the other columns. This functionality protects against data loss, otherwise
incomplete rows will be lost when saving. You can simply override these values.
"From / Range"

Defines the start line and number of lines to be filled.
"Column To Fill"

Selects, if the column is filled up with frequencies in Hz, levels in dBm
or dwell times in s.

"Start Value / End Value"
Sets the start value for frequency, level or dwell time. The end value
is read only and depends on the increment value and the range.

"Increment Value"
Determines the step size.

"Fill" Fills the column specified in "Column To fill".

5.4.4.3  Import/export list files

Access:

1. Select one of the following:

● "Sweep" > "List mode".
● "Level" > "User Correction".
● "Modulation > Pulse Modulation > Pulse Generator > Pulse Mode = Train".
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2. Select "Import/Export".

Figure 5-1: Im-/Export dialog (example with UCOR settings)

The "Import/Export" dialog contains all functions and settings to import externally
created list data or to export it accordingly. You can process and store a list in the
formats *.txt (ASCII), or *.csv (plain text with identical sequence of fields). The
table separators and the decimal floating point numbers are customizable.

Settings

Mode........................................................................................................................... 109
ASCII File Settings...................................................................................................... 109
Select (ASCII) Source/Select (ASCII) Destination.......................................................110
Select Source/Select ASCII Destination......................................................................110
Import / Export.............................................................................................................110

Mode
Selects import or export of a data list file. The provided parameters vary according to
the selected mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:MODE on page 677
[:SOURce<hw>]:CORRection:DEXChange:MODE on page 642
[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE on page 590

ASCII File Settings
Defines the format and the separators of the associated data file.
"Extension" Selects *.csv or *.txt format.

"Decimal
Point"

Sets "Point" (dot) or "Comma" as the decimal separator used in the
ASCII data with floating-point numerals.

"Column Separator"
Sets the separator between the columns in an ASCII table.
Available are: "Tab", "Semicolon", "Comma" or "Space".

Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension on page 676
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal on page 676
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[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn on page 676
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension on page 640
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal
on page 641
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn
on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension on page 590
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal
on page 591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn
on page 591

Select (ASCII) Source/Select (ASCII) Destination
In "Mode > Import", access the file select dialog that provides standard file handling
functions.
Where:
● "Select ASCII Source": defines the file to be loaded (imported)
● "Select ASCII Destination": selects the filename under that the loaded file is saved
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog? on page 675
[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect on page 676
[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog? on page 640
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog? on page 591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect on page 591

Select Source/Select ASCII Destination
In "Mode > Export", access the file select dialog that provides standard file handling
functions.
Where:
● "Select Source": selects the file to be exported
● "Select ASCII Destination": defines the filename and the file path for the exported

file
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:SELect on page 677
[:SOURce<hw>]:CORRection:DEXChange:SELect on page 642
[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect on page 592

Import / Export
Imports or exports the selected data list file, depending on the current mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:EXECute on page 675
[:SOURce<hw>]:CORRection:DEXChange:EXECute on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute on page 592
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5.4.5  Pulse graph

Option: see Chapter 5.1, "Required options", on page 81.

Access:

► Select "Modulation" > "Pulse Modulation > Pulse Graph".

The pulse graph is the graphical representation of the current pulse signal.

The height of the bars corresponds to the selected amplitude of the pulse signal.

File Name
Indicates the name of the pulse train data file.
To create or select a file, see "Pulse Train Data" on page 106.
Remote command: 
[:SOURce<hw>]:PULM:TRAin:SELect on page 589

Zooming
You can zoom into the diagram to visualize the graph in more detail:
● "Zoom Position": Sets the focus on the time axis where to enlarge the graph.
● "Zoom In": Enlarges the graph at the selected position.
● "Zoom Out" for the reverse operation.
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5.4.6  Pulse external / trigger settings

Access:

► Select "Modulation" > "Pulse Modulation > Pulse External / Trigger".

The dialog specifies some characteristics of the Pulse Ext connector.
This connector is common for the pulse generator and the pulse modulator. For an
overview, see "Input and output connectors" on page 82.

Settings

Polarity.........................................................................................................................112
Impedance...................................................................................................................112
Threshold.....................................................................................................................112
Show Connector..........................................................................................................113

Polarity
Sets the polarity of the active slope of a pulse input signal, that is the external pulse
modulation signal.
Remote command: 
[:SOURce<hw>]:PULM:POLarity on page 586

Impedance
Sets the input impedance.
Remote command: 
[:SOURce<hw>]:PULM:IMPedance on page 586

Threshold
Sets the high/low threshold in volts for the signal at the [Pulse Ext] connector.
Remote command: 
[:SOURce<hw>]:PULM:THReshold on page 586
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Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

5.4.7  FM, PhiM and AM modulation sources

Access:

► Select "Modulation > Modulation Sources".

In the "Sources" tab, you can configure an LF modulation signal for performing
analog modulations. It includes the setting parameters of the internal LF-and multi-
function generators, the noise generator, and an external signal source.

● Source > LF generator settings.............................................................................113
● Source > external settings.....................................................................................117
● Source > noise generator settings........................................................................ 119

5.4.7.1  Source > LF generator settings

Access:

► Select "Modulation" > "Modulation Sources > LF Generator".

Modulation settings
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The internal LF signal can the modulation signal source for any of the analog mod-
ulations. The LF signal applies to all modulations which use the internal modulation
signal. Therefore, any modification of the LF signal immediately affects all currently
active modulations.

Settings

State (LF frequency sweep)........................................................................................ 114
Shape.......................................................................................................................... 114
Frequency....................................................................................................................116
Period.......................................................................................................................... 116
Pulse Width................................................................................................................. 116
Pulse Duty Cycle......................................................................................................... 116
Triangle Rise............................................................................................................... 117
Trapezoid Rise / Fall....................................................................................................117
Trapezoid High............................................................................................................ 117

State (LF frequency sweep)
Status of the LF frequency sweep signal.
You find this parameter in two dialogs:
● "LF Frequency Sweep" turns on/off the signal generation.

See Sweep mode settings for access.
● "Analog Modulation Sources" displays the current state (read-only). If it is turned

on, this dialog provides the varying sweep frequency, see Current Frequency.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:LFOutput:FREQuency:MODE on page 656

Shape
Selects the waveform shape of the LF generator signal.
The "Triangle" and "Trapezoid" waveforms require option R&S SMAB-K24.

"Sine"

1 = Period

Modulation settings
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"Square"

1 = Period

"Pulse"

1 = Pulse width
2 = Pulse period

"Triangle"

1 = Triangle rise
2 = Triangle period

Modulation settings
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"Trapezoid"

1 = Trapezoid rise
2 = Trapezoid high
3 = Trapezoid period
4 = Trapezoid fall

Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe on page 658

Frequency
Sets the frequency of the LF generator for sine signals.
Set the signal shape with the parameter Shape.
Remote command: 
[:SOURce]:LFOutput<ch>:FREQuency on page 655

Period
Sets the repetition rate of the generated LF signal for triangle, trapezoid or pulse
shapes, see Shape.
The period of sine signals is calculated from the selected Frequency
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:PERiod on page 660
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:PERiod on page 661
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:PERiod on page 659

Pulse Width
Sets the pulse duration of the generated pulse signal.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:WIDTh on page 659

Pulse Duty Cycle
Sets the ratio between the pulse duration and the pulse period in percent.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:DCYCle on page 659
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Triangle Rise
Sets the time required for the triangle signal to change from low level to high level.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:RISE on page 661

Trapezoid Rise / Fall
Sets the time required for the trapezoid signal to change from low level to high level,
and vice versa.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:RISE on page 660
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:FALL on page 660

Trapezoid High
Sets how long the trapezoid signal is at high level.
Remote command: 
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:HIGH on page 660

5.4.7.2  Source > external settings

Access:

► Select "Modulation" > "Modulation Sources > External".

The "External" settings section contains all parameters required to configure the
signal of an externally supplied LF signal.

Modulation settings
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Settings

Coupling (AC/DC)........................................................................................................118
Impedance...................................................................................................................118
Bandwidth....................................................................................................................118
Show Connector..........................................................................................................118

Coupling (AC/DC)
Selects the coupling mode (AC or DC) for the external signal.
"AC" Disconnects the DC voltage component and uses only the AC com-

ponent of the modulation signal.
"DC" Uses the modulation signal with both components, AC and DC.

For active external exponential AM, sets the coupling of the corre-
sponding input automatically to DC.

Remote command: 
[:SOURce<hw>]:INPut:MODext:COUPling<ch> on page 651

Impedance
Sets the impedance for the externally supplied signal.
Remote command: 
[:SOURce<hw>]:INPut:MODext:IMPedance<ch> on page 651

Bandwidth
Displays the maximum bandwidth of the external LF signal.
Remote command: 
[:SOURce]:LFOutput<ch>:BANDwidth? on page 654

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Modulation settings
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5.4.7.3  Source > noise generator settings

Access:

► Select "Modulation" > "Modulation Sources > Noise Generator".

The "Noise Generator" settings contain all parameters to configure the signal of the
internal noise generator.

Settings

Distribution...................................................................................................................119
Bandwidth....................................................................................................................119

Distribution
Selects the distribution of the noise power density.
"Gauss" Generates the noise power according to a Gaussian distribution.
"Equal" Generates an evenly distributed noise.
Remote command: 
[:SOURce<hw>]:NOISe:DISTribution on page 678

Bandwidth
Sets the noise bandwidth as distinct value.
You can set the bandwidth between 100 kHz and 10 MHz in 100 KHz steps.
Remote command: 
[:SOURce<hw>]:NOISe:BANDwidth|BWIDth on page 678
[:SOURce<hw>]:NOISe:BWIDth:STATe on page 678

Modulation settings
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5.4.8  LF signal output settings

Access:

► Select "Modulation" > "LF Output".

In the "LF Output" tab, you can configure the signal at the LF outputs, determine
the output voltage or add a DC offset. Activate both paths to output the sum signal
of the two sources.

Settings:

State............................................................................................................................120
Source.........................................................................................................................121
Show Connector..........................................................................................................121
Output Voltage............................................................................................................ 121
DC-Offset.................................................................................................................... 121
Load Impedance......................................................................................................... 121
Noise Level................................................................................................................. 122

└ Noise Density................................................................................................122
└ Noise Level................................................................................................... 122

State
Activates the output of the LF signal.
Remote command: 
[:SOURce]:LFOutput<ch>[:STATe] on page 657

Modulation settings
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Source
Select the sources for the signal output at the LF connector. If you activate path 1 and
2, those sources are added.
Use the "Show Connector" function to find out where this connector is located.
"LF Generator 1/2"

Selects one of internally generated LF signals.
"AM" Option: R&S SMAB-K720

Selects the AM signal.
"FM/PhiM" Option: R&S SMAB-K720

Selects the signal also used by the frequency or phase modulations.
"Noise Generator"

Selects the internally generated noise signal.
"External 1/2" Selects one of the externally supplied LF signals.
Remote command: 
[:SOURce]:LFOutput<ch>:SOURce on page 658

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Output Voltage
Sets the peak to peak voltage of the selected LF output source.
This value, e.g. +1 V to -1 V refers to 50 Ohm at the RF output with high termination
impedance at the LF output.
Remote command: 
[:SOURce]:LFOutput<ch>:INTernal:VOLTage on page 657

DC-Offset
Adds a DC offset to the LF output signal.
Remote command: 
[:SOURce]:LFOutput:OFFSet on page 657

Load Impedance
Sets the specification of the load impedance interconnected to the LF generator output.
This parameter is available in case of activated R&S SML0x emulations only, see
"Remote Access Settings" > "Instrument Emulations" > "Language" on page 404.
These signal generators come with an LF generator source impedance of 10 Ohm
which is not available with the R&S SMA100B.
The set LF generator load impedance enables the R&S SMA100B to emulate the
10 Ohm LF generator source impedance of these generators by a corresponding
increase of the open circuit LF generator output voltage.
The load impedance setting is not affected by an instrument preset ([Preset] key or
*RST), restart or the "Save/Recall" function. It is reset to the default value of 1 MOhm
by a factory preset only.
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Remote command: 
n.a.

Noise Level
Access:
● Select "Modulation" > "Output > Noise Level".

Noise Density ← Noise Level
Indicates the level of the noise signal for a bandwidth of 1 Hz (relative).
Remote command: 
[:SOURce<hw>]:NOISe:LEVel:RELative? on page 678

Noise Level ← Noise Level
Indicates the level of the noise signal per Hz within the total bandwidth (absolute).
Remote command: 
[:SOURce<hw>]:NOISe:LEVel[:ABSolute]? on page 679

5.4.9  Overview

Option: AM and FM/PM require R&S SMAB-K720

Modulation settings
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Access:

► Select "Modulation" > "Modulation Sources > Overview".

Blue color = Active output signal (AM and FM)
Gray color = Inactive output signal (LF Out)
Miniature graph = Indicates an active source
Connectors = Indicate a connector (e.g. external signal) is involved in the path of the signal

The "Overview" tab is an interactive diagram that indicates the active modulations
and the signal being output.
Here you can:
● Select the output signal ("LF Out") in one or two paths; the setting acts as the

parameter "LF Output Source"
● Select the source for each modulation and modulation path; the setting acts as

the parameter "Source"
● Activate modulation in one or two paths; the setting acts as the parameter

"State"
To generate a two-tone signal composed from the two paths of the same modu-
lation type, activate both paths.

● The "FM" box allows switching to "PhiM", but those modulations are mutually
exclusive.

LFOut
Label for the LF output settings in the overview.
Remote command: 
n.a.

Modulation settings
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AM
Label for the amplitude modulation settings in the overview.
Remote command: 
n.a.

FM/PhiM
Selects the modulation signal to be assigned to the output. You can assign the fre-
quency or phase modulated signal.
Remote command: 
n.a.

5.5  How to generate an amplitude modulated signal

The following examples use the internal LF generator.

To set the frequency and level of the RF signal

1. Press [Preset] to start from a defined state.

2. In the status bar, set "Frequency = 2 GHz".

3. Set "Level = -20 dBm".

To configure the modulation signal (LF generator)

1. Select "Modulation" > "Modulation Source".

2. In the "Sources" tab, select "Shape > Sine".

3. Set "Frequency = 20 kHz".

The period is calculated automatically and indicates "Period = 50.00 µs".

To configure the amplitude modulation settings

1. In "Modulation" dialog, select the "AM" tab.

2. Set "Source = LF Generator1"

3. Set "Depth = 30%"

4. Select "State = I" to activate the modulation.

5. Set "Level > RF ON" to enable signal output.

5.6  How to generate a pulse modulated signal

The following example uses the internal pulse generator.

How to generate a pulse modulated signal
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To set the frequency and level of the RF signal

1. Press [Preset].

2. In the status bar, set "Frequency = 4 GHz".

3. Set "Level = -25 dBm".

To configure the pulse generator

1. Select "Modulation" > "Pulse Generator".

2. Select "Pulse Mode = Double".

3. Set "Pulse Period = 10 us".

4. Set "Pulse Width = 2 us".

5. Set "Double Pulse Width = 1.2 us".

6. Set "Double Pulse Delay = 4.5 us".

7. Activate "Pulse Output State".

8. Set "Trigger Mode = Auto".

In the "Pulse Graph" tab, you can view the generated pulse signal graphically.

To enable pulse modulation

1. Select the "Pulse Modulation" tab.

2. Set "State = I" to activate pulse modulation.

3. Set "Level > RF ON" to enable signal output.

5.7  How to generate a pulse train modulated signal

The following example uses the internal pulse generator.

To set the frequency and level of the RF signal

1. Press [Preset].

2. In the status bar, set "Frequency = 6 GHz".

3. Set "Level = -25 dBm".

To configure the pulse generator

1. Select "Modulation" > "Pulse Generator".

2. Select "Pulse Mode = Train".

3. Select "Pulse Train Data".
Accesses the standard function for file handling.

How to generate a pulse train modulated signal
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4. Select an existing file or select "New" to create one.

5. Define the filename.
Select "Edit Pulse Train Data", if the file is empty or to control and change the val-
ues.

6. In the "Edit Pulse Train Data" dialog, enter the pulse on/off times and pulse repeti-
tion values.

For example:
● "On-Time = 500 us", "OFF-Time = 2 ms", "Count = 2"
● "On-Time = 100 us", "OFF-Time = 2.5 ms", "Count = 1"
● "On-Time = 10 us", "OFF-Time = 50 us", "Count = 10"

7. "Save" the file and close the dialog.
The instrument returns to the /var/user/ where it has saved the file.

8. Select the file in the directory.

9. Confirm with "Select".

10. In the "Pulse Generator" dialog, select "Pulse Output State = On".

11. Set "Trigger Mode = Auto".

In the "Pulse Graph" tab, you can view the generated pulse signal graphically.

To enable pulse train modulation

1. Select the "Pulse Modulation" tab.

2. Set "State = I".

3. Set "Level > RF ON" to enable signal output.

How to generate a pulse train modulated signal
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6  Avionic standards
The R&S SMA100B supports avionic standards VOR, ILS and ADF.

Contents

● Required options...................................................................................................127
● About the Avionics options....................................................................................127
● VOR configuration and settings............................................................................ 133
● ILS configuration and settings...............................................................................142
● ADF configuration and settings.............................................................................165

6.1  Required options

The R&S SMA100B base unit equipped with the following options:
● Option frequency (R&S SMAB-B10x)
● Option signal generation for VOR, ILS and ADF (R&S SMAB-K25)

6.2  About the Avionics options

The following topics summarize some background information on the related avionics
standards. The provided overview information is intended as explanation of the used
terms and does not aim to be comprehensive.

Brief overview of the avionics standards

● Landing systems: ILS (Instrument Landing System), MLS (Microwave Landing
System)
Landing systems are ground-based approach systems that provide precision guid-
ance to an aircraft approaching and (blind) landing on a runway.

● Radio/Flight navigation systems: VOR (VHF Omnidirectional Radio), DME (Dis-
tance measuring equipment), TACAN (Tactical Air Navigation), ADF (Automatic
Direction Finder)
The radio navigation systems are aircraft systems that support the pilots to deter-
mine the aircraft positions and stay on course. These systems are more and more
obsolete. However, due to security reasons, these flight navigation systems are still
in use.

● Radar systems: RSR (En Route Surveillance Radar), ASR (Airport Surveillance
Radar), PAR (Precision Approach Radar), ASDE (Airport Surface Detection Equip-
ment), SSR (Secondary Surveillance Radar)
Radar systems are divided into two groups, primary (RSR, ASR, PAR and ASDE)
and secondary (SSR). The radar systems are used in air traffic control to mainly
detects and measures the position of aircraft, i.e. its range and bearing.

About the Avionics options
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6.2.1  Required options

The basic equipment layout for generating avionics standards signals includes the
options:
● Base unit
● Baseband real-time extension (R&S SMAB-K520)
● Digital standard ILS (R&S SMAB-K151)
● Digital standard VOR (R&S SMAB-K152)
● Digital standard DME (R&S SMAB-K153)

For more information, see data sheet.

6.2.2  VHF omni directional radio range (VOR)

Very high frequency (VHF) omnidirectional radio range (VOR) is used for radio naviga-
tion and helps aircraft to determine their position and stay on course.

A VOR system consists of a ground transmission station and a VOR receiver on the
board of the aircraft.

The transmitter stations operate at VHF frequencies of 108 MHz to 118 MHz (see
Table 6-1), with the code identification (COM/ID) transmitting on a modulation tone of
1.020 kHz. It emits two types of signals:

● An omnidirectional reference signal (REF) that can consist of two parts:
– 30 Hz frequency modulated (FM) sine wave on subcarrier 9.96 kHz from ampli-

tude modulation (AM) carrier
– 1020 Hz AM modulated sine wave morse code

● A directional positioning signal, variable (VAR): 30 Hz AM modulated sine waves
with variable phase shift

The position of the aircraft is determined by measuring azimuth as the difference in
phase of those two signals. The magnetic north is defined as the reference point, for
which both signals are exactly in phase.

VOR ICAO Frequencies

The individual values in the table below are:
● Chan. = ICAO channel number
● VOR Freq. = VOR Interrogation frequency (MHz)

Table 6-1: VOR ICAO standard frequencies (MHz) and channels

Chan. VOR Freq.  Chan. VOR Freq.  Chan. VOR Freq.  Chan. VOR Freq.  Chan. VOR Freq.  Chan. VOR Freq.

17X

17Y

108.00

108.05

 45X

45Y

110.80

110.85

 75X

75Y

112.80

112.85

 89X

89Y

114.20

114.25

 103X

103Y

115.60

115.65

 117X

117Y

117.00

117.05

19X

19Y

108.20

108.25

 47X

47Y

111.00

111.05

 76X

76Y

112.90

112.95

 90X

90Y

114.30

114.35

 104X

104Y

115.70

115.75

 118X

118Y

117.10

117.15
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Chan. VOR Freq.  Chan. VOR Freq.  Chan. VOR Freq.  Chan. VOR Freq.  Chan. VOR Freq.  Chan. VOR Freq.

21X

21Y

108.40

108.45

 49X

49Y

111.20

111.25

 77X

77Y

113.00

113.05

 91X

91Y

114.40

114.45

 105X

105Y

115.80

115.85

 119X

119Y

117.20

117.25

23X

23Y

108.60

108.65

 51X

51Y

111.40

111.45

 78X

78Y

113.10

113.15

 92X

92Y

114.50

114.55

 106X

106Y

115.90

115.95

 120X

120Y

117.30

117.35

25X

25Y

108.80

108.85

 53X

53Y

111.60

111.65

 79X

79Y

113.20

113.25

 93X

93Y

114.60

114.65

 107X

107Y

116.00

116.05

 121X

121Y

117.40

117.45

27X

27Y

109.00

109.05

 55X

55Y

111.80

111.85

 80X

80Y

113.30

113.35

 94X

94Y

114.70

114.75

 108X

108Y

116.10

116.15

 122X

122Y

117.50

117.55

29X

29Y

109.20

109.25

 57X

57Y

112.00

112.05

 81X

81Y

113.40

113.45

 95X

95Y

114.80

114.85

 109X

109Y

116.20

116.25

 123X

123Y

117.60

117.65

31X

31Y

109.40

109.45

 58X

58Y

112.10

112.15

 82X

82Y

113.50

113.55

 96X

96Y

114.90

114.95

 110X

110Y

116.30

116.35

 124X

124Y

117.70

117.75

33X

33Y

109.60

109.65

 59X

59Y

112.20

112.25

 83X

83Y

113.60

113.65

 97X

97Y

115.00

115.05

 111X

111Y

116.40

116.45

 125X

125Y

117.80

117.85

35X

35Y

109.80

109.85

 70X

70Y

112.30

112.35

 84X

84Y

113.70

113.75

 98X

98Y

115.10

115.15

 112X

112Y

116.50

116.55

 126X

126Y

117.90

117.95

37X

37Y

110.00

110.05

 71X

71Y

112.40

112.45

 85X

85Y

113.80

113.85

 99X

99Y

115.20

115.25

 113X

113Y

116.60

116.65

   

39X

39Y

110.20

110.25

 72X

72Y

112.50

112.55

 86X

86Y

113.90

113.95

 100X

100Y

115.30

115.35

 114X

114Y

116.75

116.75

   

41X

41Y

110.40

110.45

 73X

73Y

112.60

112.65

 87Y

87Y

114.00

114.05

 101X

101Y

115.40

115.45

 115X

115Y

116.80

116.85

   

43X

43Y

110.60

110.65

 74X

74Y

112.70

112.75

 88X

88Y

114.10

114.15

 102X

102Y

115.50

115.55

 116X

116Y

116.90

116.95

   

Related Settings

For VOR settings at the R&S SMA100B, see Chapter 6.3, "VOR configuration and set-
tings", on page 133.

6.2.3  Instrument landing system (ILS)

The instrument landing system is used during the landing approach and monitors the
correct approach path to the runway.

About the Avionics options
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Figure 6-1: Approach navigation using instrument landing system (ILS) [1MA193]

An ILS system consists of three independent subsystems:

● A glide slope for vertical guidance.
● A localizer for horizontal guidance.
● (optional) marker beacons

Glide Slope

The glide slope transmitter is located near the end of the runway (nearest to the start of
the aircraft approach).

Typically, vertically aligned antennas transmit two intersecting main beams on top of
one another at carrier frequencies between 329 MHz and 335 MHz (see Table 6-2).
The top beam is usually modulated at 90 Hz and the beam below at 150 Hz [1MA193].

The information on position is provided after demodulation of the beam signals by eval-
uating the difference in depth of modulation (DDM). The following scenarios are possi-
ble:

● Predominance of the 90 Hz beam: the aircraft is too high and must descend
● Predominance of the 150 Hz beam: the aircraft is too low and needs to climb
● The signal strength from both beams is equal: the aircraft is in the center, on the

right course.

If there is a predominance of the 90 Hz beam, then the aircraft is too high and must
descend. A predominant 150 Hz means that the aircraft is too low and needs to climb.
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Localizer

The localizer transmitter is located near the end of the runway (nearest to the start of
the aircraft approach). Typically, horizontally aligned antennas transmit two intersecting
main beams beside one another at carrier frequencies between 108 MHz and 112 MHz
(see Table 6-2). As seen from the approaching aircraft coming in for a landing, the left
beam is usually modulated at 90 Hz and the right beam at 150 Hz [1MA193].

The information on position is provided after demodulation of the beam signals by eval-
uating the difference in depth of modulation (DDM). The following scenarios are possi-
ble:

● Predominance of the 90 Hz beam: the aircraft is too far to the left and must turn to
the right

● Predominance of the 150 Hz beam: the aircraft is too far to the right and must turn
to the left

● The signal strength from both beams is equal: the aircraft is in the center, on the
right course.

ILS ICAO Frequencies

The individual values in the table below are:
● Chan. = ICAO channel number
● LOC Freq. = ILS localizer frequency (MHz)
● GS Freq. = ILS glide slope frequency (MHz)
Table 6-2: ILS glide slope and localizer ICAO standard frequencies (MHz) and channels

Chan. LOC Freq. GS Freq.  Chan. LOC Freq. GS Freq.  Chan. LOC Freq. GS Freq.

18X

18Y

108.10

108.15

334.70

334.55

 32X

32Y

109.50

109.55

332.60

332.45

 46X

46Y

110.90

110.95

330.80

330.65

20X

20Y

108.30

108.35

334.10

333.95

 34X

34Y

109.70

109.75

333.20

333.05

 48X

48Y

111.10

111.15

331.70

331.55

22X

22Y

108.50

108.55

329.90

329.75

 36X

36Y

109.90

109.95

333.80

333.65

 50X

50Y

111.30

111.35

332.30

332.15

24X

24Y

108.70

108.75

330.50

330.35

 38X

38Y

110.10

110.15

334.40

334.25

 52X

52Y

111.50

111.55

332.90

332.75

26X

26Y

108.90

108.95

329.30

329.15

 40X

40Y

110.30

110.35

335.00

334.85

 54X

54Y

111.70

111.75

333.50

333.35
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Chan. LOC Freq. GS Freq.  Chan. LOC Freq. GS Freq.  Chan. LOC Freq. GS Freq.

28X

28Y

109.10

109.15

331.40

331.25

 42X

42Y

110.50

110.55

329.60

329.45

 56X

56Y

111.90

111.95

331.10

330.95

30X

30Y

109.30

109.35

332.00

331.85

 44X

44Y

110.70

110.75

330.20

330.05

    

Marker Beacons

Marker beacon receivers are used for a rough distance measurement. They are availa-
ble only for some ILS installations [1MA193].

Figure 6-2: Marker beacon placement and distance to runway

Marker beacon receivers decode audio and provide signaling output to identify one of
three marker beacons installed near the runway. They transmit a narrow beam width at
75 MHz carrier frequency in a vertical direction. Each of them has a different distinct
modulation code to allow the receiver to identify which one it is flying over [1MA193].

Both visual (color of the marker beacon) and audio tone identification is supported for
determining which marker has been flown over. The audio/visual pairing of marker bea-
cons is as follows:

● Outer marker flashes BLUE in the cockpit at 400 Hz (“relaxed” tone).
● Middle marker flashes AMBER in the cockpit at 1300 Hz (“hurried” tone).
● Inner marker flashes WHITE in the cockpit at 3000 Hz (“urgent” tone).

Related Settings

For ILS settings at the R&S SMA100B, see the following sections:
● Chapter 6.4.2, "ILS glide slope settings", on page 145
● Chapter 6.4.3, "ILS localizer settings", on page 151
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● Chapter 6.4.4, "ILS marker beacons settings", on page 160

6.2.4  Automatic direction finder (ADF)

ADF receivers provide the relative bearing of a basic ground-based Non-Directional
Beacon (NDB) to the fore/aft axis of the aircraft. The beacon signal is generated by a
directional antenna assembly in the aircraft.

The ADF determines the direction to the NDB station relative to the aircraft and is used
for instrument approaches (autopilot). It provides additional information to other naviga-
tion equipment, e.g. VOR.

Related Settings

For ADF settings at the R&S SMA100B, see Chapter 6.5, "ADF configuration and set-
tings", on page 165.

6.3  VOR configuration and settings

Option: R&S SMAB-K25

Access:

► Select "Modulation > Avionic Standards > VOR".

The remote commands required to define VOR settings are described in Chap-
ter 14.16.2.5, "SOURce:VOR subsystem", on page 625.

Settings

● General settings....................................................................................................134
● Signal settings.......................................................................................................137
● Position settings....................................................................................................139
● COM/ID settings....................................................................................................140
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6.3.1  General settings

Access:

► Select "VOR > General"

This dialog comprises general settings of the VOR standard, the default and the
"Save/Recall" settings.
By default, a VOR modulation signal is set on an RF carrier with a frequency of 108
MHz or ICAO channel 17X. The 9.96 kHz subcarrier signal is frequency modulated
with a 30.00 Hz reference signal. The COM/ID signal has 1.02 kHz frequency, the
variable phase signal 30.00 Hz frequency.
If enabled, the avionic standard modulation is displayed in the "Modulation" tile as
follows:
● "Avionic: VOR" for enabled VOR modulation
● "Avionic ILS: Glide Slope/Localizer/Marker Bcn" for enabled ILS glide slope/

localizer/marker beacons modulation
● "Avionic: ADF" for enabled ADF modulation

Changing a parameter in the avionic standards causes an instant signal change in the
R&S SMA100B. There is no extra measurement cycle to calculate the RMS value of
the baseband signal to set the correct RF level.

If the avionics standard is activated for the first time, or after every subsequent on/off
sequence, the measurement cycle will take place to determine the correct RF level.
Every subsequent parameter change in the avionic standard is performed without
another measurement cycle to provide a continuous signal output.

Settings

State............................................................................................................................135
Set To Default..............................................................................................................135
Save/Recall................................................................................................................. 135
Carrier Frequency Mode............................................................................................. 135
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Carrier Frequency....................................................................................................... 136
ICAO Channel............................................................................................................. 136
EXT AM.......................................................................................................................136

State
Activates the avionic standard.
Activation of the standard deactivates a previously active avionic standard. The
"VOR/ILS > Carrier Frequency" setting is applied automatically to the RF Frequency
and displayed in the status bar.
Remote command: 
<subsystem>:STATe on page 599

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Standard Parameter Value

VOR/ILS/ADF State Not affected by "Set to default"

VOR Carrier Frequency Mode User Defined

 Carrier Frequency 108.000000 MHz

ILS ILS Component Glide Slope (GS)

 ILS GS > Carrier Frequency Mode User Defined

 ILS GS > Carrier Frequency 334.700000 MHz

ADF Carrier Frequency 190.000 kHz

Remote command: 
<subsystem>:PRESet on page 597

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
Remote command: 
<subsystem>:SETTing:CATalog on page 598
<subsystem>:SETTing:DELete on page 598
<subsystem>:SETTing:LOAD on page 598
<subsystem>:SETTing:STORe on page 599

Carrier Frequency Mode
Sets the mode for the carrier frequency of the signal.
"User Defined" Activates user-defined variation of the carrier frequency.
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"ICAO" Activates variation in predefined steps according to standard VOR
transmitting frequencies (see Table 6-1). The start value can be
selected in the field "ICAO Channel".

Remote command: 
[:SOURce<hw>]:VOR:FREQuency:MODE on page 631

Carrier Frequency
Requires "Carrier Frequency Mode > User Defined".
Sets the carrier frequency of the signal.
Remote command: 
[:SOURce<hw>]:VOR:FREQuency on page 630

ICAO Channel
Requires "Carrier Frequency Mode > ICAO".
Sets the ICAO channel and the corresponding transmitting frequency.
If avionic standard modulation is activated and you change the "RF Frequency", the
frequency value of the closest ICAO channel is applied automatically. The "ICAO
Channel" is also updated.
For an overview of the VOR ICAO channel frequencies, see Table 6-1.
Remote command: 
[:SOURce<hw>]:VOR:ICAO:CHANnel on page 631

EXT AM
Enables/disables additional modulation from an external source. The external signal is
input via the Ext connector.
"Off" Selects the internal modulation source for the avionic standard modu-

lation.
"EXT (MOD AM)"

Selects the external source. The external signal is added to the inter-
nal signal. Switching off the internal source is not possible. The exter-
nal signal is input via the Ext connector. The sensitivity is 10 mV per
percent modulation depth.
Note: There can be an overmodulation as a function of the level of
the external signal without a corresponding caution message being
generated. To avoid an overmodulation, the peak value of the exter-
nal signal is to be delimited corresponding to the sum of the modula-
tion depths of the remaining VOR signal components.

Remote command: 
[:SOURce<hw>]:VOR:SOURce on page 626
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6.3.2  Signal settings

Access:

► Select "VOR > Signal".

This dialog provides access to signal settings of the VOR modulation signal.

Settings

Mode........................................................................................................................... 137
VAR/REF Frequency...................................................................................................138
VAR Depth...................................................................................................................138
Subcarrier Frequency..................................................................................................138
Subcarrier Depth......................................................................................................... 138
REF Deviation............................................................................................................. 138

Mode
Selects the operating mode for the VOR modulation signal.
"Norm" VOR modulation is active.
"Var" Amplitude modulation of the output signal with the VAR signal compo-

nent (30Hz signal content) of the VOR signal. The modulation depth
corresponds to the value set under VAR Depth.

"Subcarrier" Amplitude modulation of the output signal with the unmodulated FM
carrier (9960Hz) of the VOR signal. The modulation depth corre-
sponds to the value set under Subcarrier Depth.

"Subcarrier +
FM"

Amplitude modulation of the output signal with the frequency-modula-
ted FM carrier (9960Hz) of the VOR signal. The frequency deviation
corresponds to the value set under REF Deviation, the modulation
depth corresponds to the value set under "Subcarrier Depth".

Remote command: 
[:SOURce<hw>]:VOR:MODE on page 632
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VAR/REF Frequency
Sets the frequency of the VAR signal and the REF signal. As the two signals must
have the same frequency, the setting is valid for both signals.
Remote command: 
[:SOURce<hw>]:VOR:VAR:FREQuency on page 634

VAR Depth
Sets the AM modulation depth of the 30Hz VAR signal.
Note: The sum of "Subcarrier depth", "VAR depth" and "COM/ID > Depth" must be
smaller than 100 %.
Remote command: 
[:SOURce<hw>]:VOR:VAR[:DEPTh] on page 634

Subcarrier Frequency
Sets the frequency of the FM carrier.
Remote command: 
[:SOURce<hw>]:VOR:SUBCarrier[:FREQuency] on page 633

Subcarrier Depth
Sets the AM modulation depth of the FM carrier.
Note: The sum of "Subcarrier depth", "VAR depth" and "COM/ID > Depth" must be
smaller than 100 %.
Remote command: 
[:SOURce<hw>]:VOR:SUBCarrier:DEPTh on page 633

REF Deviation
Sets the frequency deviation of the reference signal on the FM carrier.
Remote command: 
[:SOURce<hw>]:VOR:REFerence[:DEViation] on page 633
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6.3.3  Position settings

Access:

► Select "VOR > Position".

This dialog provides access to position settings related to the VOR modulation sig-
nal.

Settings

Bearing Angle..............................................................................................................139
Direction...................................................................................................................... 139

Bearing Angle
Sets the phase angle between the 30 Hz VAR signal and the 30 Hz reference signal.
The orientation of the angle depends on the set Direction.
Remote command: 
[:SOURce<hw>]:VOR[:BANGle] on page 626

Direction
Sets the reference position of the phase information.
The angle set under "Bearing Angle" corresponds to the angle between the geographic
north and the connection line from beacon to airplane.
"From" Selection of the beacon as a reference position.
"To" Selection of the airplane position as a reference position.
Remote command: 
[:SOURce<hw>]:VOR[:BANGle]:DIRection on page 627
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6.3.4  COM/ID settings

Access:

► Select "VOR > COM/ID"

This dialog comprises COM/ID signal settings related to the VOR signal.

Settings

COM/ID State..............................................................................................................140
Code............................................................................................................................140
Period..........................................................................................................................141
Frequency................................................................................................................... 141
Depth...........................................................................................................................141
Time Schema.............................................................................................................. 141
Dot Length...................................................................................................................141
Dash Length................................................................................................................141
Symbol Space............................................................................................................. 142
Letter Space................................................................................................................142

COM/ID State
Enables/disables the COM/ID signal.
See also Chapter D, "Morse code settings", on page 784.
Remote command: 
[:SOURce<hw>]:VOR:COMid[:STATe] on page 630

Code
Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).
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The COM/ID tone is sent according to the selected code, see Chapter D, "Morse code
settings", on page 784.
If no coding is set, the COM/ID tone is sent uncoded (key down).
Remote command: 
[:SOURce<hw>]:VOR:COMid:CODE on page 627

Period
Sets the period of the COM/ID signal.
Remote command: 
[:SOURce<hw>]:VOR:COMid:PERiod on page 629

Frequency
Sets the frequency of the COM/ID signal.
Remote command: 
[:SOURce<hw>]:VOR:COMid:FREQuency on page 628

Depth
Sets the AM modulation depth of the COM/ID signal.
Note: The sum of Subcarrier Depth, VAR Depth and COM/ID > Depth must be smaller
than 100 %.
Remote command: 
[:SOURce<hw>]:VOR:COMid:DEPTh on page 628

Time Schema
Sets the time schema of the Morse code for the COM/ID signal.
● "Standard"

The set dot length determines the length of the dash, the symbol space and letter
space of the Morse code.

● "User"
You can set each length value separately.

Remote command: 
[:SOURce<hw>]:VOR:COMid:TSCHema on page 630

Dot Length
Sets the length of a Morse code dot.
If "Time Schema > Standard", the dot length value determines also the length of the
dash (= 3 times the dot length), symbol space (= dot length) and letter space (= 3 times
the dot length).
Remote command: 
[:SOURce<hw>]:VOR:COMid:DOT on page 628

Dash Length
Requires "Time Schema > User".
Sets the length of a Morse code dash.
Remote command: 
[:SOURce<hw>]:VOR:COMid:DASH on page 628
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Symbol Space
Requires "Time Schema > User".
Sets the length of the Morse code symbol space.
Remote command: 
[:SOURce<hw>]:VOR:COMid:SYMBol on page 629

Letter Space
Requires "Time Schema > User".
Sets the length of a Morse code letter space.
Remote command: 
[:SOURce<hw>]:VOR:COMid:LETTer on page 629

6.4  ILS configuration and settings

Option: R&S SMAB-K25

Access:

► Select "Modulation > Avionic Standards > ILS".

The remote commands required to define ILS settings are described in Chap-
ter 14.16.2.4, "SOURce:ILS subsystem", on page 603.

Settings

● General settings....................................................................................................142
● ILS glide slope settings......................................................................................... 145
● ILS localizer settings............................................................................................. 151
● ILS marker beacons settings.................................................................................160

6.4.1  General settings

This chapter comprises general settings, which are common for all ILS components.
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Access:

► Select "ILS > General".

This dialog comprises general settings of the ILS standard, the default and the
"Save/Recall" settings.
By default, an ILS glide slope modulation signal on an RF carrier with a frequency
of 344.7 MHz or ICAO channel 18X. The dual-tone LF signal with frequencies 90
Hz and 150 Hz and a balanced modulation at SDM of 80 %.

If enabled, the avionic standard modulation is displayed in the "Modulation" tile as fol-
lows:
● "Avionic: VOR" for enabled VOR modulation
● "Avionic ILS: Glide Slope/Localizer/Marker Bcn" for enabled ILS glide slope/local-

izer/marker beacons modulation
● "Avionic: ADF" for enabled ADF modulation

Changing a parameter in the avionic standards causes an instant signal change in the
R&S SMA100B. There is no extra measurement cycle to calculate the RMS value of
the baseband signal to set the correct RF level.

If the avionics standard is activated for the first time, or after every subsequent on/off
sequence, the measurement cycle will take place to determine the correct RF level.
Every subsequent parameter change in the avionic standard is performed without
another measurement cycle to provide a continuous signal output.

Settings

State............................................................................................................................144
Set To Default..............................................................................................................144
Save/Recall................................................................................................................. 144
ILS Component........................................................................................................... 144
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State
Activates the avionic standard.
Activation of the standard deactivates a previously active avionic standard. The
"VOR/ILS > Carrier Frequency" setting is applied automatically to the RF Frequency
and displayed in the status bar.
Remote command: 
<subsystem>:STATe on page 599

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Standard Parameter Value

VOR/ILS/ADF State Not affected by "Set to default"

VOR Carrier Frequency Mode User Defined

 Carrier Frequency 108.000000 MHz

ILS ILS Component Glide Slope (GS)

 ILS GS > Carrier Frequency Mode User Defined

 ILS GS > Carrier Frequency 334.700000 MHz

ADF Carrier Frequency 190.000 kHz

Remote command: 
<subsystem>:PRESet on page 597

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
Remote command: 
<subsystem>:SETTing:CATalog on page 598
<subsystem>:SETTing:DELete on page 598
<subsystem>:SETTing:LOAD on page 598
<subsystem>:SETTing:STORe on page 599

ILS Component
Sets the ILS component.
"Glide slope" Enables the glide slope.
"Localizer" Enables the localizer.
"Marker Beacons"

Enables the marker beacons.
Remote command: 
[:SOURce<hw>]:ILS:TYPE on page 604
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6.4.2  ILS glide slope settings

Access:

1. Select "ILS > General".

2. Select "ILS Component > Glide Slope".

Settings

● General settings....................................................................................................145
● Signal settings.......................................................................................................147
● Amplitude settings.................................................................................................149

6.4.2.1  General settings

Access:

1. Select "ILS Component > Glide Slope", see Chapter 6.4.2, "ILS glide slope set-
tings", on page 145.

2. Select "ILS > General".

This dialog comprises carrier frequency settings related to the ILS glide slope com-
ponent of the ILS signal.

Settings

Carrier Frequency Mode............................................................................................. 146
Carrier Frequency....................................................................................................... 146
ICAO Channel............................................................................................................. 146
Sync with Glide Slope/ Sync with Localizer................................................................ 146
EXT AM.......................................................................................................................146
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Carrier Frequency Mode
Sets the mode for the carrier frequency of the signal.
Select "Carrier Frequency Mode > ICAO" to set a standard ILS frequency channel. If
you want to couple carrier frequencies of ILS glide slope and localizer components,
enable Sync with Glide Slope/ Sync with Localizer.
"User Defined" Activates user-defined variation of the carrier frequency.
"ICAO" Activates variation in predefined steps according to standard ILS

transmitting frequencies (see Table 6-2).
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency:MODE on page 608

Carrier Frequency
Requires "Carrier Frequency Mode > User Defined".
Sets the carrier frequency of the signal.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency on page 607

ICAO Channel
Requires "Carrier Frequency Mode > ICAO".
Sets the ICAO channel and the corresponding transmitting frequency.
If avionic standard modulation is activated and you change the "RF Frequency", the
frequency value of the closest ICAO channel is applied automatically. The "ICAO
Channel" is also updated.
For an overview of the ILS ICAO channel frequencies, see Table 6-2.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:ICAO:CHANnel on page 608

Sync with Glide Slope/ Sync with Localizer
Activates synchronization of the ILS glide slope with the ILS localizer carrier frequency
or vice versa.
If "Carrier Frequency Mode > User", the ILS glide slope carrier frequency is applied to
the ILS localizer carrier frequency or vice versa.
If "Carrier Frequency Mode > ICAO", the ILS glide slope ICAO channel is applied to the
ILS localizer ICAO channel or vice versa. The ILS glide slope/localizer frequency of the
ICAO channel (Table 6-2) is set automatically.
Remote command: 
<subsystem>:FREQuency:SYNChronize:STATe on page 599

EXT AM
Enables/disables additional modulation from an external source. The external signal is
input via the Ext connector.
"Off" Selects the internal modulation source for the avionic standard modu-

lation.
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"EXT (MOD AM)"
Selects the external source. The external signal is added to the inter-
nal signal. Switching off the internal source is not possible. The exter-
nal signal is input via the Ext connector. The sensitivity is 10 mV per
percent modulation depth.
Note: There can be an overmodulation as a function of the level of
the external signal without a corresponding caution message being
generated. To avoid an overmodulation, the peak value of the exter-
nal signal is to be delimited corresponding to the sum of the modula-
tion depths of the remaining VOR signal components.

Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:SOURce on page 610

6.4.2.2  Signal settings

Access:

1. Select "ILS Component > Glide Slope", see Chapter 6.4.2, "ILS glide slope set-
tings", on page 145.

2. Select "ILS > Signal".

This dialog comprises modulation signal settings related to the ILS glide slope
component of the ILS signal.

Settings

Operating Mode.......................................................................................................... 147
DDM Polarity............................................................................................................... 148
Up Frequency..............................................................................................................148
Down Frequency......................................................................................................... 148
Up/Down Phase.......................................................................................................... 148

Operating Mode
Selects the operating mode for the ILS glide slope modulation signal.
"Norm" ILS glide slope modulation is active.
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"90 Hz" Amplitude modulation of the output signal with the upper lobe signal
component (90 Hz signal content) of the ILS glide slope signal.
The modulation depth of the 90 Hz signal results from the settings of
the parameters Sum of Depth and DDM Depth according to:
● "Fly > Down"

AM (90 Hz) = 0.5 × (SDM + DDM × 100 %)
● "Fly > Up"

AM (90 Hz) = 0.5 × (SDM - DDM × 100 %)

"150 Hz" Amplitude modulation of the output signal with the lower lobe signal
component (150 Hz signal content) of the ILS glide slope signal.
The modulation depth of the 150 Hz signal results from the settings of
parameters Sum of Depth and DDM Depth according to:
● "Fly > Down"

AM (150 Hz) = 0.5 × (SDM + DDM × 100 %)
● "Fly > Up"

AM (150 Hz) = 0.5 × (SDM - DDM × 100 %)
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:MODE on page 609

DDM Polarity
Defines the polarity for DDM calculation (see "DDM Depth" on page 150).
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:POLarity on page 606

Up Frequency
Sets the modulation frequency of the upper antenna lobe.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:ULOBe[:FREQuency] on page 611

Down Frequency
Sets the modulation frequency of the lower antenna lobe.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:LLOBe[:FREQuency] on page 609

Up/Down Phase
Sets the phase between the modulation signals of the upper and lower antenna lobe.
The zero crossing of the lower lobe (150Hz) signal serves as a reference. The angle
refers to the period of the signal of the lower antenna lobe.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:PHASe on page 609
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6.4.2.3  Amplitude settings

Access:

1. Select "ILS Component > Glide Slope", see Chapter 6.4.2, "ILS glide slope set-
tings", on page 145.

2. Select "ILS > Amplitude".

This dialog comprises amplitude settings related to the ILS glide slope component
of the ILS signal.

Settings

Sum of Depth.............................................................................................................. 149
Fly Mode..................................................................................................................... 150
DDM Step....................................................................................................................150
DDM Current............................................................................................................... 150
DDM Depth................................................................................................................. 150
DDM Logarithmic........................................................................................................ 150
DDM Percent...............................................................................................................151
DDM - SDM Coupling..................................................................................................151

Sum of Depth
Sets the arithmetic sum of the modulation depths of the upper lobe (90 Hz) and lower
lobe (150 Hz) ILS glide slope signal contents.
The RMS modulation depth of the sum signal depends on the phase setting of both
modulation tones.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:SDM on page 610
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Fly Mode
Selects the simulation mode for the ILS glide slope modulation signal. A change of the
setting automatically changes the sign of the DDM value.
This setting simulates the direction in which the pilot has to correct the course.
"Up" The 150 Hz modulation signal is predominant, the DDM value is neg-

ative (the airplane is too low, it must climb).
"Down" The 90 Hz modulation signal is predominant, the DDM value is posi-

tive (the airplane is too high, it must descend).
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:DIRection on page 605

DDM Step
Selects the variation of the DDM values.
"Decimal" Decimal variation according to the current cursor position.
"Predifined" Variation in predefined steps according to the standardized DDM val-

ues.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:STEP on page 607

DDM Current
Sets the current of the ILS indicating the instrument corresponding to the DDM value.
The instrument current is calculated according to:
DDM Current µA = DDM Depth [%] × 857,125 µA
A variation of the instrument current automatically leads to a variation of the DDM
value and the DDM value in dB.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:CURRent on page 605

DDM Depth
Sets the difference in depth of modulation between the upper lobe (90 Hz) and the
lower lobe (150 Hz) tone of the ILS glide slope modulation signal.
The DDM value is calculated with the formula:
● "DDM Polarity > 90 Hz - 150 Hz":

DDM = [ AM (90 Hz) - AM (150 Hz) ] / 100%
● "DDM Polarity > 150 Hz - 90 Hz":

DDM = [ AM (150 Hz) - AM (90 Hz) ] / 100%
A variation of the DDM value automatically leads to a variation of the value of the
instrument current and the DDM value in dB.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM[:DEPTh] on page 607

DDM Logarithmic
Sets the DDM value in dB. The dB value is calculated according to:
DDM dB = 20 × LOG [(SDM+DDM×100%) / (SDM-DDM×100%)]
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A variation of the value automatically leads to a variation of the DDM value and the
instrument current.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:LOGarithmic on page 606

DDM Percent
Sets the difference in depth of modulation between the upper lobe (90 Hz) and the
lower lobe (150 Hz) tone of the ILS glide slope modulation signal.
The DDM value in percent is calculated as follows:
● "DDM Polarity > 90 Hz - 150 Hz":

DDM = [ AM (90 Hz) - AM (150 Hz) ]
● "DDM Polarity > 150 Hz - 90 Hz":

DDM = [ AM (150 Hz) - AM (90 Hz) ]
A variation of the DDM value automatically leads to a variation of the value of the
instrument current and the DDM value in dB.
Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:PCT on page 606

DDM - SDM Coupling
Selects if the DDM value is fixed or is changed with a change of sum of modulation
depths (SDM, see below).
"Fixed DDM" The absolute DDM value stays constant, if the SDM is changed.
"Coupled to SDM"

The absolute DDM value changes, if the SDM is changed. The DDM
value expressed in dB stays constant.

Remote command: 
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:COUPling on page 605

6.4.3  ILS localizer settings

Access:

1. Select "ILS > General".

2. Select "ILS Component > Localizer".

Settings

● General settings....................................................................................................152
● Signal settings.......................................................................................................154
● Amplitude settings.................................................................................................155
● COM/ID settings....................................................................................................158
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6.4.3.1  General settings

Access:

1. Select "ILS Component > Localizer", see Chapter 6.4.3, "ILS localizer settings",
on page 151.

2. Select "ILS > General".

This dialog comprises carrier frequency settings related to the ILS localizer compo-
nent of the ILS signal.

Settings

Carrier Frequency Mode............................................................................................. 152
Carrier Frequency....................................................................................................... 152
ICAO Channel............................................................................................................. 153
Sync with Glide Slope/ Sync with Localizer................................................................ 153
EXT AM.......................................................................................................................153

Carrier Frequency Mode
Sets the mode for the carrier frequency of the signal.
"User Defined" Activates user-defined variation of the carrier frequency.
"ICAO" Activates variation in predefined steps according to standard ILS

transmitting frequencies (see Table 6-2).
Select the ICAO Channel to set a standard ILS frequency channel. If
you want to couple carrier frequencies of ILS glide slope and localizer
components, enable General settings.

Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:FREQuency:MODE on page 617

Carrier Frequency
Requires "Carrier Frequency Mode > User Defined".
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Sets the carrier frequency of the signal.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:FREQuency on page 617

ICAO Channel
Requires "Carrier Frequency Mode > ICAO".
Sets the ICAO channel and the corresponding transmitting frequency.
If avionic standard modulation is activated and you change the "RF Frequency", the
frequency value of the closest ICAO channel is applied automatically. The "ICAO
Channel" is also updated.
For an overview of the ILS ICAO channel frequencies, see Table 6-2.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:ICAO:CHANnel on page 618

Sync with Glide Slope/ Sync with Localizer
Activates synchronization of the ILS glide slope with the ILS localizer carrier frequency
or vice versa.
If "Carrier Frequency Mode > User", the ILS glide slope carrier frequency is applied to
the ILS localizer carrier frequency or vice versa.
If "Carrier Frequency Mode > ICAO", the ILS glide slope ICAO channel is applied to the
ILS localizer ICAO channel or vice versa. The ILS glide slope/localizer frequency of the
ICAO channel (Table 6-2) is set automatically.
Remote command: 
<subsystem>:FREQuency:SYNChronize:STATe on page 599

EXT AM
Enables/disables additional modulation from an external source. The external signal is
input via the Ext connector.
"Off" Selects the internal modulation source for the avionic standard modu-

lation.
"EXT (MOD AM)"

Selects the external source. The external signal is added to the inter-
nal signal. Switching off the internal source is not possible. The exter-
nal signal is input via the Ext connector. The sensitivity is 10 mV per
percent modulation depth.
Note: There can be an overmodulation as a function of the level of
the external signal without a corresponding caution message being
generated. To avoid an overmodulation, the peak value of the exter-
nal signal is to be delimited corresponding to the sum of the modula-
tion depths of the remaining VOR signal components.

Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:SOURce on page 620

ILS configuration and settings



Avionic standardsR&S®SMA100B

154User Manual 1178.3834.02 ─ 09

6.4.3.2  Signal settings

Access:

1. Select "ILS Component > Localizer", see Chapter 6.4.3, "ILS localizer settings",
on page 151.

2. Select "ILS > Signal".

This dialog comprises audio signal and modulation settings related to the ILS local-
izer component of the ILS signal.

Settings

Operating Mode.......................................................................................................... 154
DDM polarity............................................................................................................... 155
Left Frequency............................................................................................................ 155
Right Frequency..........................................................................................................155
Left/Right Phase..........................................................................................................155

Operating Mode
Selects the operating mode for the ILS localizer modulation signal.
"Norm" ILS localizer modulation is active.
"90 Hz" Amplitude modulation of the output signal with the left lobe (90 Hz)

signal component of the ILS localizer signal.
The modulation depth of the 90 Hz signal results from the settings of
parameters Sum of Depth and DDM Depth according to:
● "Fly > Right"

AM (90 Hz) = 0.5 × (SDM + DDM × 100 %)
● "Fly > Left"

AM (90 Hz) = 0.5 × (SDM - DDM × 100 %)
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"150 Hz" Amplitude modulation of the output signal with the right lobe (150 Hz)
signal component of the ILS localizer signal.
The modulation depth of the 150 Hz signal results from the settings of
parameters Sum of Depth and DDM Depth according to:
● "Fly" = "Right"

AM (150 Hz) = 0.5 × (SDM + DDM × 100 %)
● "Fly" = "Left"

AM (150 Hz) = 0.5 × (SDM - DDM × 100 %)
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:MODE on page 619

DDM polarity
Defines the polarity for DDM calculation (see "DDM Depth" on page 157).
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:DDM:POLarity on page 616

Left Frequency
Sets the modulation frequency of the antenna lobe arranged at the left viewed from the
air plane.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:LLOBe[:FREQuency] on page 618

Right Frequency
Sets the modulation frequency of the antenna lobe arranged at the right viewed from
the air plane.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:RLOBe[:FREQuency] on page 620

Left/Right Phase
Sets the phase between the modulation signals of the left and right antenna lobe. The
zero crossing of the right lobe (150 Hz) signal serves as a reference. The angle refers
to the period of the signal of the right antenna lobe.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:PHASe on page 619

6.4.3.3  Amplitude settings

Access:

1. Select "ILS Component > Localizer", see Chapter 6.4.3, "ILS localizer settings",
on page 151.
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2. Select "ILS > Amplitude".

This dialog comprises amplitude settings related to the ILS localizer component of
the ILS signal.

Settings

Fly Mode..................................................................................................................... 156
Sum of Depth.............................................................................................................. 156
DDM - SDM Coupling..................................................................................................157
DDM Step....................................................................................................................157
DDM Current............................................................................................................... 157
DDM Depth................................................................................................................. 157
DDM Logarithmic........................................................................................................ 158
DDM Percent...............................................................................................................158

Fly Mode
Selects the simulation mode for the ILS localizer modulation signal. A change of the
setting automatically changes the sign of the DDM value.
This setting simulates the direction in which the pilot has to correct the course.
"Left" The 150 Hz modulation signal is predominant, the DDM value is neg-

ative (the airplane is too far to the right, it must turn to the left).
"Right" The 90 Hz modulation signal is predominant, the DDM value is posi-

tive (the airplane is too far to the left, it must turn to the right).
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:DDM:DIRection on page 615

Sum of Depth
Sets the arithmetic sum of the modulation depths of the left lobe (90 Hz) and right lobe
(150 Hz) ILS localizer signal contents.
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The RMS modulation depth of the sum signal depends on the phase setting of both
modulation tones.
The "Sum of Depth" and "COM/ID > Depth" must be smaller than 100 %.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:SDM on page 620

DDM - SDM Coupling
Selects if the DDM value is fixed or is changed with a change of sum of modulation
depths (SDM, see below).
"Fixed DDM" The absolute DDM value stays constant, if the SDM is changed.
"Coupled to
SDM"

The absolute DDM value changes, if the SDM is changed. The DDM
value expressed in dB stays constant.

Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:DDM:COUPling on page 614

DDM Step
Selects the variation step of the DDM values.
"Decimal" Decimal variation according to the current cursor position.
"Predifined" Variation in predefined steps according to the standardized DDM val-

ues.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:DDM:STEP on page 616

DDM Current
Sets the current of the ILS indicating instrument corresponding to the DDM value. The
instrument current is calculated according to:
DDM µA = DDM × 967.75 µA
A variation of the instrument current automatically leads to a variation of the DDM
value and the DDM value in dB.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:DDM:CURRent on page 614

DDM Depth
Sets the difference in depth of modulation (DDM) between the signal of the left lobe
(90 Hz) and the right lobe (150 Hz) of the ILS localizer modulation signal.
The DDM value in percent is calculated as follows:
● "DDM Polarity > 90 Hz - 150 Hz" (default setting):

DDM = [ AM (90 Hz) - AM (150 Hz) ] / 100 %
● "DDM Polarity > 150 Hz - 90 Hz":

DDM = [ AM (150 Hz) - AM (90 Hz) ] / 100 %
A variation of the DDM value automatically leads to a variation of the DDM value in dB
and the value of the instrument current.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:DDM[:DEPTh] on page 617
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DDM Logarithmic
Sets the DDM value in dB. The dB value is calculated according to:
DDM dB = 20 × LOG [(SDM + DDM × 100 %) / (SDM - DDM × 100 %)]
A variation of the value automatically leads to a variation of the DDM value and the
instrument current.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:DDM:LOGarithmic on page 615

DDM Percent
Sets the difference in depth of modulation between the signal of the left lobe (90 Hz)
and the right lobe (150 Hz).
The DDM value in percent is calculated by the following formulas:
● "DDM Polarity > 90 Hz - 150 Hz" (default setting):

DDM = [ AM(90 Hz) - AM (150 Hz) ]
● "DDM Polarity > 150 Hz - 90 Hz":

DDM = [ AM(150 Hz) - AM (90 Hz) ]
A variation of the DDM value automatically leads to a variation of the DDM value in dB
and the value of the instrument current.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:DDM:PCT on page 616

6.4.3.4  COM/ID settings

Access:

1. Select "ILS Component > Localizer", see Chapter 6.4.3, "ILS localizer settings",
on page 151.

2. Select "ILS > COM/ID".
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This dialog comprises COM/ID settings related to the ILS localizer component of
the ILS signal.

Settings

COM/ID State..............................................................................................................159
Code............................................................................................................................159
Frequency................................................................................................................... 159
Period..........................................................................................................................159
Depth...........................................................................................................................159
Time Schema.............................................................................................................. 160
Dot Length...................................................................................................................160
Dash Length................................................................................................................160
Symbol Space............................................................................................................. 160
Letter Space................................................................................................................160

COM/ID State
Enables/disables the COM/ID signal.
See also Chapter D, "Morse code settings", on page 784.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid[:STATe] on page 614

Code
Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).
The COM/ID tone is sent according to the selected code, see Chapter D, "Morse code
settings", on page 784.
If no coding is set, the COM/ID tone is sent uncoded (key down).
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:CODE on page 611

Frequency
Sets the frequency of the COM/ID signal.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:FREQuency on page 612

Period
Sets the period of the COM/ID signal.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:PERiod on page 613

Depth
Sets the AM modulation depth of the COM/ID signal.
Note: The sum of Sum of Depth and COM/ID > Depth must be smaller than 100 %.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:DEPTh on page 612
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Time Schema
Sets the time schema of the Morse code for the COM/ID signal.
● "Standard"

The set dot length determines the length of the dash, the symbol space and letter
space of the Morse code.

● "User"
You can set each length value separately.

Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:TSCHema on page 613

Dot Length
Sets the length of a Morse code dot.
If "Time Schema > Standard", the dot length value determines also the length of the
dash (= 3 times the dot length), symbol space (= dot length) and letter space (= 3 times
the dot length).
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:DOT on page 612

Dash Length
Requires "Time Schema > User".
Sets the length of a Morse code dash.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:DASH on page 611

Symbol Space
Requires "Time Schema > User".
Sets the length of the Morse code symbol space.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:SYMBol on page 613

Letter Space
Requires "Time Schema > User".
Sets the length of a Morse code letter space.
Remote command: 
[:SOURce<hw>]:ILS:LOCalizer:COMid:LETTer on page 613

6.4.4  ILS marker beacons settings

Access:

1. Select "ILS > General".

2. Select "ILS Component > Marker Beacons".
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Settings

● General settings....................................................................................................161
● Signal settings.......................................................................................................162
● COM/ID settings....................................................................................................163

6.4.4.1  General settings

Access:

1. Select "ILS Component > Marker Beacons", see Chapter 6.4.4, "ILS marker bea-
cons settings", on page 160.

2. Select "ILS > General".

This dialog comprises carrier frequency and signal settings related to the ILS
marker beacons component of the ILS signal.

Settings

Carrier Frequency Mode............................................................................................. 161
Carrier Frequency....................................................................................................... 161

Carrier Frequency Mode
Sets the mode for the carrier frequency of the signal.
"User Defined" Activates user-defined variation of the carrier frequency.
"Predefined" Activates variation of the carrier frequency by integer 25 kHz steps.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:FREQuency:MODE on page 624

Carrier Frequency
Requires "Carrier Frequency Mode > User Defined".
Sets the carrier frequency of the signal.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:FREQuency on page 624
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6.4.4.2  Signal settings

Access:

1. Select "ILS Component > Marker Beacons", see Chapter 6.4.4, "ILS marker bea-
cons settings", on page 160.

2. Select "ILS > Signal".

This dialog comprises signal settings related to the ILS marker beacons compo-
nent of the ILS signal.

Settings

Marker Frequency....................................................................................................... 162
Marker Depth.............................................................................................................. 162
Pulsed Marker............................................................................................................. 162

Marker Frequency
Sets the modulation frequency of the marker signal.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:MARKer:FREQuency on page 624

Marker Depth
Sets the modulation depth of the marker signal.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon[:MARKer]:DEPTh on page 625

Pulsed Marker
Activates the modulation of a pulsed marker signal (morse coding).
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"On" Modulation of pulsed marker signals (morse coding). The duty cycle,
i.e. the marker on- and off-times, depend on the marker signal fre-
quency (Table 6-3).
Table 6-3: Morse coding for ILS marker beacons marker signals

Marker signal On Off Rate Duty cycle

Outer Marker
(400 Hz)

375 ms 125 ms 2 dots/s 75 %

Middle Marker
(1300 Hz)

First: 375 ms

Second: 83 ms

First: 125 ms

Second: 83 ms

1.5 dots/s 68.8 %

Inner Marker
(3000 Hz)

83 ms 83 ms 6 dots/s 50 %

"Off" Modulation of a continuous non-coded marker signal.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon[:MARKer]:PULSed on page 625

6.4.4.3  COM/ID settings

Access:

1. Select "ILS Component > Marker Beacons", see Chapter 6.4.4, "ILS marker bea-
cons settings", on page 160.

2. Select "ILS > COM/ID".

This dialog provides access to general, signal and COM/ID settings of the marker
beacons component of the ILS signal.
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Settings

COM/ID State..............................................................................................................164
Code............................................................................................................................164
Period..........................................................................................................................164
Frequency................................................................................................................... 164
Depth...........................................................................................................................164
Time Schema.............................................................................................................. 164
Dot Length...................................................................................................................165
Dash Length................................................................................................................165
Symbol Space............................................................................................................. 165
Letter Space................................................................................................................165

COM/ID State
Enables/disables the COM/ID signal.
See also Chapter D, "Morse code settings", on page 784.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid[:STATe] on page 624

Code
Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).
The COM/ID tone is sent according to the selected code, see Chapter D, "Morse code
settings", on page 784.
If no coding is set, the COM/ID tone is sent uncoded (key down).
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:CODE on page 621

Period
Sets the period of the COM/ID signal.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:PERiod on page 623

Frequency
Sets the frequency of the COM/ID signal.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:FREQuency on page 622

Depth
Sets the AM modulation depth of the COM/ID signal.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:DEPTh on page 621

Time Schema
Sets the time schema of the Morse code for the COM/ID signal.
● "Standard"
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The set dot length determines the length of the dash, the symbol space and letter
space of the Morse code.

● "User"
You can set each length value separately.

Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:TSCHema on page 623

Dot Length
Sets the length of a Morse code dot.
If "Time Schema > Standard", the dot length value determines also the length of the
dash (= 3 times the dot length), symbol space (= dot length) and letter space (= 3 times
the dot length).
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:DOT on page 622

Dash Length
Requires "Time Schema > User".
Sets the length of a Morse code dash.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:DASH on page 621

Symbol Space
Requires "Time Schema > User".
Sets the length of the Morse code symbol space.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:SYMBol on page 623

Letter Space
Requires "Time Schema > User".
Sets the length of a Morse code letter space.
Remote command: 
[:SOURce<hw>][:ILS]:MBEacon:COMid:LETTer on page 622

6.5  ADF configuration and settings

Option: R&S SMAB-K25

Access:

► Select "Modulation > Avionic Standards > ADF".

The remote commands required to define ADF settings are described in Chap-
ter 14.16.2.3, "SOURce:ADF subsystem", on page 600.
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Settings

● General settings....................................................................................................166
● COM/ID settings....................................................................................................168

6.5.1  General settings

Access:

► Select "ADF > General".

This dialog comprises general settings of the ADF standard, the default and the
"Save/Recall" settings.
By default, an ADF signal modulation is set on an RF carrier with a frequency of
190 kHz. The COM/ID signal has 1.02 kHz frequency.
If enabled, the avionic standard modulation is displayed in the "Modulation" tile as
follows:
● "Avionic: VOR" for enabled VOR modulation
● "Avionic ILS: Glide Slope/Localizer/Marker Bcn" for enabled ILS glide slope/

localizer/marker beacons modulation
● "Avionic: ADF" for enabled ADF modulation

ADF state and carrier frequency range

If the R&S SMA100B carrier frequency is outside the specified ADF frequency range
from 190 kHz to 1750 kHz, a settings conflict is displayed. Activating ADF is not possi-
ble.

Change the carrier frequency to a value within the specified frequency range.

Changing a parameter in the avionic standards causes an instant signal change in the
R&S SMA100B. There is no extra measurement cycle to calculate the RMS value of
the baseband signal to set the correct RF level.

If the avionics standard is activated for the first time, or after every subsequent on/off
sequence, the measurement cycle will take place to determine the correct RF level.
Every subsequent parameter change in the avionic standard is performed without
another measurement cycle to provide a continuous signal output.
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Settings

State............................................................................................................................167
Set To Default..............................................................................................................167
Save/Recall................................................................................................................. 167

State
Activates the avionic standard.
Activation of the standard deactivates a previously active avionic standard. The
"VOR/ILS > Carrier Frequency" setting is applied automatically to the RF Frequency
and displayed in the status bar.
Remote command: 
<subsystem>:STATe on page 599

Set To Default
Calls the default settings. The values of the main parameters are listed in the following
table.

Standard Parameter Value

VOR/ILS/ADF State Not affected by "Set to default"

VOR Carrier Frequency Mode User Defined

 Carrier Frequency 108.000000 MHz

ILS ILS Component Glide Slope (GS)

 ILS GS > Carrier Frequency Mode User Defined

 ILS GS > Carrier Frequency 334.700000 MHz

ADF Carrier Frequency 190.000 kHz

Remote command: 
<subsystem>:PRESet on page 597

Save/Recall
Accesses the "Save/Recall" dialog, that is the standard instrument function for saving
and recalling the complete dialog-related settings in a file. The provided navigation
possibilities in the dialog are self-explanatory.
The settings are saved in a file with predefined extension. You can define the filename
and the directory, in that you want to save the file.
Remote command: 
<subsystem>:SETTing:CATalog on page 598
<subsystem>:SETTing:DELete on page 598
<subsystem>:SETTing:LOAD on page 598
<subsystem>:SETTing:STORe on page 599
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6.5.2  COM/ID settings

Access:

► Select "ADF > COM/ID".

This dialog comprises COM/ID signal settings related to the ADF signal.

Settings

COM/ID State..............................................................................................................168
Code............................................................................................................................168
Period..........................................................................................................................169
Frequency................................................................................................................... 169
Depth...........................................................................................................................169
Time Schema.............................................................................................................. 169
Dot Length...................................................................................................................169
Dash Length................................................................................................................169
Symbol Space............................................................................................................. 169
Letter Space................................................................................................................170

COM/ID State
Enables/disables the COM/ID signal.
Remote command: 
[:SOURce<hw>]:ADF:COMid[:STATe] on page 603

Code
Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).
The COM/ID tone is sent according to the selected code, see Chapter D, "Morse code
settings", on page 784.
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If no coding is set, the COM/ID tone is sent uncoded (key down).
Remote command: 
[:SOURce<hw>]:ADF:COMid:CODE on page 600

Period
Sets the period of the COM/ID signal.
Remote command: 
[:SOURce<hw>]:ADF:COMid:PERiod on page 602

Frequency
Sets the frequency of the COM/ID signal.
Remote command: 
[:SOURce<hw>]:ADF:COMid:FREQuency on page 601

Depth
Sets the AM modulation depth of the COM/ID signal.
Remote command: 
[:SOURce<hw>]:ADF:COMid:DEPTh on page 601

Time Schema
Sets the time schema of the Morse code for the COM/ID signal.
"Standard" The set dot length determines the length of the dash, the symbol

space and letter space of the Morse code.
"User" You can set each length value separately.
Remote command: 
[:SOURce<hw>]:ADF:COMid:TSCHema on page 602

Dot Length
Sets the length of a Morse code dot.
If "Time Schema > Standard", the dot length value determines also the length of the
dash (= 3 times the dot length), symbol space (= dot length) and letter space (= 3 times
the dot length).
Remote command: 
[:SOURce<hw>]:ADF:COMid:DOT on page 601

Dash Length
Requires "Time Schema > User".
Sets the length of a Morse code dash.
Remote command: 
[:SOURce<hw>]:ADF:COMid:DASH on page 600

Symbol Space
Requires "Time Schema > User".
Sets the length of the Morse code symbol space.
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Remote command: 
[:SOURce<hw>]:ADF:COMid:SYMBol on page 602

Letter Space
Requires "Time Schema > User".
Sets the length of a Morse code letter space.
Remote command: 
[:SOURce<hw>]:ADF:COMid:LETTer on page 601
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7  List and sweep mode
The operating modes "List" and "Sweep" allow you to generate an RF signal having
periodically varying frequencies or amplitudes.

A signal generated with varying parameters scans a certain range of varying values of
a parameter, with defined start and end points, and can be repeated cyclically.

The R&S SMA100B supports two basic methods:
● Sweep mode

The instrument generates an RF signal which varies its frequency or level values in
discrete steps between the start and end values. The values change according to a
specific shape like sawtooth or triangle. The spacing is linear or logarithmmic.

Figure 7-1: Schematic representation of a signal generated in sweep mode

The main application field of the "Sweep" mode is to determine the frequency
response a DUT.

● List mode
The instrument generates a varying output signal, based on a previously saved list
with frequency, amplitude and step width values. While in sweep mode the fre-
quency or the level values change, in list mode you can vary both parameters
simultaneously. The frequency and level values do not need to have ascending or
descending order, they can vary arbitrarily.
You can use a global dwell time, which means that the time interval is constant for
all steps of the list, or different dwell times for each value pair.
Figure 7-2 represents the frequency and power value pairs, in this case with the
dwell time set the same for all steps (global dwell time).
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Figure 7-2: Schematic representation of a signal generated in list mode (global dwell time)

The list mode is especially useful in high-speed measurements with fast changing
frequency and level settings.

Note that the shown diagrams represent the behaviour in theory. In real signal genera-
tion, the instruments usually have a blank time when the frequency or level changes.

Interactions and characteristics of list and sweep mode

● Activating the list mode automatically deactivates all RF and LF sweeps and vice
versa.

● In list processing mode, the frequency and level display in the status bar is dis-
abled.

● The sweep modes only work with a global dwell time, that means the time intervals
are constant during signal generation.

● If you want to hold a running sweep at a specific frequency or level value, enter the
value in the status bar. The sweep stops immediately.

● We recommend that you switch off the display update for optimum sweep perfor-
mance, especially with short dwell times
See Chapter 12.1.2, "Display update settings", on page 344.
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7.1  Signal generation and triggering in the sweep and list
modes

In both operating modes "List" and "Sweep", triggering and signal generation follow the
same principle. The instrument generates the signal continuously (that means trig-
gered automatically) or in individual steps (controlled manually by an internal or exter-
nal trigger signal).

The instrument expects the trigger signal at the Inst Trig connector.

If the dwell time in sweep or list mode is too short or external trigger signals come too
fast, the signal generation delays. As the delay increases, the R&S SMA100B signals
an overrun, or even stops sweep or list mode signal generation, if the delay gets too
long.
The instrument diplays corresponding error messages.

The figures in this section give an overview on the signal generation in the sweep and
list modes and the appropriate triggering. The figures show the signal state after acti-
vating the mode and the generation of the signal when a trigger event occurs. For each
mode, the relevant parameters and settings are briefly explained.

Each "Sweep" and "List" mode dialog provides also a "Reset" function that sets the sig-
nal to the initial value or the beginning of the list. Depending on the selected trigger
mode, the signal generation proceeds accordingly.

The naming of the selection parameters in manual control (GUI) sometimes deviates
from the naming in the remote-control commands. In addition, the value names of the
selection parameters used in the signal generator partly differ from the SCPI syntax.
The instrument accepts all value names.
The correlation between the manual control and the corresponding remote control
commands, including the SCPI conform syntax are explained for each mode (see the
cross-reference tables).
See also the following programming examples on the sweep and list modes in remote
control:
● Example "Setup an RF frequency or power sweep" on page 697
● Example "Setup an LF sweep" on page 652
● Example "Create an RF list and activate the list mode" on page 665

Signal generation and triggering in the sweep and list modes
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Auto mode (Sweep/List)

Figure 7-3: Auto mode (Sweep/List)

● The instrument generates the signal continuously.
● Trigger mode "Auto" is prerequisite (default). It causes the continuous generation

of the sweep signal.
● Starts signal generation immediately with "State = On".
● Switches automatically to the next step when the Dwell time has elapsed.
● Stops signal generation with "State = Off".
Table 7-1: Cross-reference between manual and remote control in Auto mode (Sweep/List)

Manual control mode:
"Auto"

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :TRIGger<hw>:FSWeep:SOURce AUTO [IMMediate]
:SOURce<hw>:SWEep:FREQuency:MODE AUTO

RF level sweep :TRIGger<hw>:PSWeep:SOURce AUTO [IMMediate]
:SOURce<hw>:SWEep:POWer:MODE AUTO

LF frequency sweep :TRIGger<hw>:LFFSweep:SOURce AUTO [IMMediate]
:SOURce<hw>:LFOutput<ch>:SWEep:FREQuency:MODE AUTO

List :SOURce<hw>:LIST:MODE AUTO
:SOURce<hw>:LIST:TRIGger:SOURce AUTO

Signal generation and triggering in the sweep and list modes
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Single / Extern Single mode (Sweep/List)

Figure 7-4: Single / Extern Single mode (sweep / list )

In single mode, you can specify, that the signal returns to the start value when a sweep
cycle has been completed.
See "The Retrace function" on page 180 for details.

● The instrument generates a single sweep cycle.
● Trigger mode "Manual". A trigger event initiates one sweep from the start value to

the end value.
● "State = On" sets the signal to the start value: the sweep start frequency, the

sweep start power or the frequency-power value pair of the selected index in the
list.

● Starts signal generation with a trigger event.
● Switches automatically to the next step when the Dwell time has elapsed.
● Stops signal generation at the set end value and waits for the subsequent trigger

event.
● Trigger sources:

– The "Execute Single Sweep" function.
– The corresponding remote control command.
– An externally applied trigger signal.

● "State = Off" stops the signal generation in sweep or list mode.

Signal generation and triggering in the sweep and list modes
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Table 7-2: Cross-reference between manual and remote control in Single / Extern Single modes
(Sweep/List)

Manual control mode:
"Single / Extern Single"

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :TRIGger<hw>:FSWeep:SOURce SINGle [BUS] "Single" or

:TRIGger<hw>:FSWeep:SOURce EXTernal [EXTernal] "Extern Single"

:SOURce<hw>:SWEep:FREQuency:MODE AUTO

RF level sweep :TRIGger<hw>:PSWeep:SOURce SINGle [BUS] for "Single" or

:TRIGger<hw>:PSWeep:SOURce EXTernal [EXTernal] for "Extern Sin-
gle"
:SOURce<hw>:SWEep:POWer:MODE AUTO

LF frequency sweep :TRIGger<hw>:LFFSweep:SOURce SINGle [BUS] "Single" or

:TRIGger<hw>:LFFSweep:SOURce EXTernal [EXTernal] "Extern Sin-
gle"
:SOURce<hw>:LFOutput<ch>:SWEep:FREQuency:MODE AUTO

List :SOURce<hw>:LIST:TRIGger:SOURce SINGle "Single" or

:SOURce<hw>:LIST:TRIGger:SOURce EXTernal "Extern Single"

:SOURce<hw>:LIST:MODE AUTO

Step / Extern Step mode (Sweep/List)

Figure 7-5: Step / Extern Step mode (sweep / list )

● The instrument generates the signal step-by-step.
● Starts signal generation with "State = On".
● Switches to the next step with a manual action.

If the end value is reached, signal generation starts again from the beginning.
● Stops signal generation with "State = Off".

Signal generation and triggering in the sweep and list modes
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● Trigger sources:
– The rotary knob at the front panel.
– The [Arrow] keys at the front panel.
– The corresponding remote control commands.
– An externally applied trigger signal.

To step through the sweep frequencies or levels:
● In manual mode:

– Set the Current Frequency or Current Level values
– Use the [Up] and [Down] keys or the rotary knob

● In remote control mode:
– Use the commands [:SOURce<hw>]:FREQuency:MANual or

[:SOURce<hw>]:POWer:MANual with the UP or DOWN parameter

Steps that would exceed the sweep range are ignored.

Table 7-3: Cross-reference between manual and remote control in Step / Extern Step modes (Sweep/
List)

Manual control mode:
"Step / Extern Step"

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :TRIGger<hw>:FSWeep:SOURce SINGle [BUS] "Step" or

:TRIGger<hw>:FSWeep:SOURce EXTernal [EXTernal] for "Extern
Step"
:SOURce<hw>:SWEep:FREQuency:MODE STEP

RF level sweep :TRIGger<hw>:PSWeep:SOURce SINGle [BUS] "Step" or

:TRIGger<hw>:PSWeep:SOURce EXTernal [EXTenal] "Extern Step"

:SOURce<hw>:SWEep:POWer:MODE STEP

LF frequency sweep :TRIGger<hw>:LFFSweep:SOURce SINGle [BUS] "Step" or

:TRIGger<hw>:LFFSweep:SOURce EXTernal [EXTenal] "Extern Step"

:SOURce<hw>:LFOutput<ch>:SWEep:FREQuency:MODE STEP

List :SOURce<hw>:LIST:TRIGger:SOURce SINGle "Step" or

:SOURce<hw>:LIST:TRIGger:SOURce EXTernal "Extern Step"

:SOURce<hw>:LIST:MODE STEP

Signal generation and triggering in the sweep and list modes
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Extern Start/Stop mode (sweep)

Figure 7-6: Extern Start/Stop mode (sweep)

● The instrument generates the signal continuously.
● Trigger mode "Auto" and "Sweep > State = On" are prerequisite.
● State "On" sets the signal to the start value, that is one of the following:

– Sweep start frequency
– Sweep start power
– Frequency-power value pair of the selected index in the list

● Starts signal generation with a trigger event.
● Switches automatically to the next sweep step when the Dwell time has elapsed.

If the end value is reached, signal generation continues with the next sweep cycle.
● Stops signal generation with the next external trigger event.
● Starts the signal generation again with the next trigger event, beginning at the start

value.
● "State = Off" stops the signal generation in sweep or list mode.
● Trigger source: An externally applied trigger signal.
Table 7-4: Cross-reference between manual and remote control in Extern Start/Stop modes (sweep)

Manual control mode:
"Extern Start/Stop"

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :TRIGger<hw>:FSWeep:SOURce EAUTo [-]
:SOURce<hw>:SWEep:FREQuency:MODE AUTO

RF level sweep :TRIGger<hw>:PSWeep:SOURce EAUTo [-]
:SOURce<hw>:SWEep:POWer:MODE AUTO

LF frequency sweep :TRIGger<hw>:LFFSweep:SOURce EAUTo [-]
:SOURce<hw>:LFOutput<ch>:SWEep:FREQuency:MODE AUTO

Signal generation and triggering in the sweep and list modes



List and sweep modeR&S®SMA100B

179User Manual 1178.3834.02 ─ 09

Manual mode (Sweep/List)

The manual mode only applies to remote control. It is not visible in the graphical user
interface of the instrument and is described here for completeness.

Figure 7-7: Manual mode in remote control (sweep / list )

● The instrument generates the signal in steps.
● Starts signal generation with "State = On".
● Switches to the next step with a user defined setting via remote control.

You can arbitrarily select a value within the range of the start and stop values by
setting the frequency, power or index using the corresponding remote control com-
mand. There is no ascending or descending order.

● Stops signal generation with "State = Off".
Table 7-5: Remote control commands in manual mode (Sweep/List)

Remote control mode:
Manual

Remote commands
Rohde & Schwarz proprietary and [SCPI conform] value name

RF frequency sweep :SOURce<hw>:FREQuency:MANUal <Manual>

RF level sweep :SOURce<hw>:POWer:MANual <Manual>

LF frequency sweep :SOURce<hw>:LFOUTput:FREQuency:MANual <Manual>

List :SOURce<hw>:LIST:INDex <Index>

Signal generation and triggering in the sweep and list modes
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The Retrace function

Retrace is a function especially designed for "Single" sweep modes, when the sweep
signal follows a sawtooth shape. Working in this mode, the instrument performs a sin-
gle sweep cycle when a trigger event occurs. The signal generation stops at the set
end point (stop frequency or stop level), and waits for the next trigger event.

In this state, the upper value of the signal remains at the output until the next cycle
starts. In particular, if you generate a level sweep signal, the high amplitude of the sig-
nal is output for a certain time. To protect the DUT from overload, the retrace function
immediately resets the signal value to the start value at the end of a sweep cycle. It
returns to the start level or start frequency until the next trigger is applied.

You can use the "Retrace" function if "Sweep > Mode = Single/External Single" and
"Shape = Sawtooth", see:
● "Shape" on page 191
● "Mode" on page 189

7.2  About sweep mode

In sweep mode, the signal generator scans the sweep range gradually from one point
to another, using a defined step size and following a triangle or sawtooth shape. This
mode also enables you to change direction, that means, it is possible to step back-
wards.

See Chapter 7.2.2, "Sweep signal shapes", on page 183.

About sweep mode
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Configuration and operation of sweep mode signals

● The R&S SMA100B generates a sweep signal by varying the following parameters:
either the RF frequency, the RF level or both, the RF frequency and the RF level in
combined RF sweep mode, or the LF frequency.

● In all sweep modes, you can perform a complete sweep cycle once, repeat the
cycle continuously or step through it gradually.

● The instrument generates the sweep signal according to the sweep settings.
● The "Reset Sweep" function, provided in the sweep settings dialogs enables you to

reset the sweep to its initial value and restart it.

Impact of changing the sweep mode during performance
If you change the sweep mode during the execution, the signal generator stops the
sweep and starts with the next trigger event at the initial value.

Combined RF frequency / level sweep processing mode

The combined RF sweep functionality processes the signal similar to the Live list
mode. The R&S SMA100B sets the frequency and level values simultaneously in the
hardware. The difference to the list mode is that the values are not taken from a previ-
ously created list, but are calculated using the selected frequency and level ranges, the
dwell time and the number of steps.

7.2.1  Correlating parameters in sweep mode

A sweep signal is a periodic signal that changes its frequency or level, or both, from a
starting value to an ending value in a defined time.

The R&S SMA100B provides various possibilities to configure a sweep signal. For
example, you can determine the sweep range by the start and end values, or based on
the start value and span. In any case, related parameters are adjusted accordingly.

The formulas below show how the sweep parameters correlate and the corresponding
calculation basis, by the frequency and offset settings. Apart from "Center Frequency",
"Span" and "Step_lin", the values apply accordingly to the level settings.
Table 7-6: Variables that are used in the following formulas

Variable Description

Sweep range Defined frequency or level value range

fCENTer Defined center frequency

fSPAN Defined extend of the sweep range

fOFFSet Frequency offset

fSTARt Start frequency of the sweep range

fSTOP End frequency of the sweep range

f1 Current sweep frequency

About sweep mode
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Variable Description

f2 Next, subsequent sweep frequency

step_lin Step size in linear scaling

step_log Step size in logarithmic scaling

POINts Number of steps within the sweep range

Sweep range

The sweep range is defined by a start and an end value. How the remaining parame-
ters correlate is shown below.

Offset = 0

Sweep Range = fSTARt to fSTOP

fCENTer = (fSTARt + fSTOP)/2

fSPAN = (fSTOP - fSTARt)

Where:

fSTARt = fCENTer - (fSPAN/2)

fSTOP = fCENTer + (fSPAN/2)

Offset≠0

A defined offset also affects the sweep range and the center frequency. Therefore, the
set frequencies are only absolute values, if the Offset = 0. Offset ≠ 0 shifts the frequen-
cies with the offset value:

Sweep Range = fSTARt + fOFFSet to fSTOP + fOFFSet

fCENTer = fCENTer+ fOFFSet

fSPAN = fSPAN + fOFFSet

The value range of the instrument is calculated as follows:

RFmin + fOFFSet to RFmax + fOFFSet

It is possible to set fSTARt > fSTOP and fSTARt < fSTOP, so that even a negative value is per-
mitted for the "Span".
If you change the start and/or stop frequency, the span and center frequency change
accordingly, and vice versa.

Sweep steps

In the following, you see how the sweep steps are calculated depending on the defined
spacing mode. The formulas show a frequency sweep, but apply to the level settings in
the same way.

The step size is added to the current value, to get the subsequent sweep step.

About sweep mode
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With linear scaling, the next frequency is calculated according to:

f2 = f1 + step_lin

In the logarithmic scaling, the step size is determined in per cent, as a constant frac-
tion of the current frequency.

Successive frequencies are calculated as follows:
● For fSTARt < fSTOP

f2 = f1*(1 + step_log/100)
If f2 > fSTOP, then f2 = fSTOP

● For fSTARt > fSTOP

f2 = f1/(1 + step_log/100)
If f2 < fSTOP, then f2 = fSTOP

With "Shape = Triangle", the frequency values on the slope from fSTOP to fSTARt are the
same as on the slope from fSTARt to fSTOP.

If you specify the number of steps within the sweep range, the step size is adjusted
according to the following correlation:
● For linear sweeps and fSTARt < fSTOP

POINtsfrequency = ((fSTARt - fSTOP)/step_lin) +1 = (fSPAN/step_lin) + 1
● For logarithmic sweeps and fSTARt < fSTOP

POINtsfrequency = ((log fSTOP - log fSTARt)/log step_log) +1

If step_log changes, the value of POINts is adjusted. The fSTARt and fSTOP values are
retained.

7.2.2  Sweep signal shapes

The R&S SMA100B supports the following sweep shapes:
● Sawtooth

The sweep sequence resembles a sawtooth. One sweep runs from start to stop
frequency, or level value respectively. Each subsequent sweep starts again at the
start value.

About sweep mode
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Figure 7-8: Sweep signal sawtooth shape

1 = Start value
2 = Stop value
3 = Step size

● Triangle
The sweep sequence resembles a triangle. One sweep runs from start to stop
value frequency and back. Each subsequent sweep starts at the start value.

Figure 7-9: Sweep signal triangle shape

1 = Start value
2 = Stop value
3 = Step size

The current frequency or level of an RF frequency, level or LF frequency sweep is
determined by the shape (e.g. sawtooth or triangle) and the spacing (linear or logarith-
mic), and the step size.

7.3  About list mode

The list mode is used to generate the RF signal based on a set of predefined fre-
quency and amplitude value pairs, with individual step times. You can define the values

About list mode
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arbitrarily, in any order and varying step sizes, within the entire configurable value
range of the instrument.

Configuration and operation of list mode signals

The parameters configuring the RF signal are defined in a list (table) and stored in a
file.

Creating and handling lists

List files can be created in the following ways:
● Internally

Use the build-in table editor with columns for the frequency-level values pairs and
the dwell time.
Define the values manually (row by row) or automatically, based on value range
and step size.
(See Chapter 7.7, "List editor", on page 207)
Lists are saved as files with user-definable filename and the predefined file exten-
sion *.lsw. To load a saved file, use the "File Manager".
(See Chapter 11.8, "Using the file manager", on page 324)

● Lists can be exported, too. For example, to exchange configuration between instru-
ments or to modify the file content with an external program and reload them again.

● Externally
Create a list file as a CSV file with Microsoft Excel, with a Notepad or a similar tool
and save it with the predefined extension. Transfer the file to and load it into the
instrument.

Dwell time mode

You can choose whether you want to use different dwell times or a fixed value for all
steps in the list mode:
● "From List"

This mode uses the values from the data table.
See Edit List Mode Data

● "Global"
This mode processes the list with a fixed time interval you can set with Global
Dwell Time.

List processing mode

See:
● "Live list processing mode" on page 187

7.4  Significant parameters and functions

This section provides some basic parameters, settings and functions that affect the
operating modes CW, list and sweep, that means at all frequency and level transitions
of the RF signal.

Significant parameters and functions
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Dwell time

Dwell time is the length of time that elapses from the beginning until the end of a step
in list or sweep mode.

Figure 7-10: Dwell Time vs. settling time

1 = "Dwell Time" (as set with the parameter)
2 = Settling time
3 = Dwell time (effective)

However, the time the instrument requires for the signal to settle reduces the set dwell
time:

tdwell(effective) = tdwell - tsetlting

If the dwell time in sweep or list mode is too short or external trigger signals come too
fast, the signal generation delays. As the delay increases, the R&S SMA100B signals
an overrun, or even stops sweep or list mode signal generation, if the delay gets too
long.
The instrument diplays corresponding error messages.

Hardware adjustments

The first time a list (new or modified) is processed, the instrument automatically calcu-
lates the necessary hardware settings. It can be performed during list processing, but
delays the first cycle, especially with short dwell times.

With long dwell times, you can perform this calculation while the list is being pro-
cessed; the entered dwell times are observed. With short dwell times, calculation of the
hardware settings increases the dwell time for the initial processing cycle; the entered
value is only observed from the second processing cycle onwards. In this case, a mes-
sage indicates that there is a deviation between the current and set dwell times. After
the first cycle, you do not need to perform additional calculations. The current dwell
times do not deviate from the set dwell times.

Blanking

The instrument applies blanking, which temporarily turns off the RF signal when the
frequency or level changes, until the signal has settled to a stable state.

Temporary blanking applies to all operating modes.

Significant parameters and functions
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Live list processing mode

The R&S SMA100B generates the signal directly from the value pairs in the database,
and adjusts the hardware settings accordingly. The current instrument state and thus
any change during the signal generation directly affects the RF signal. The temporary
memory is not used.

You can conveniently modify parameters like modulation settings during run-time.
Learning list mode data is not required. Impacts like temperature drift are also consid-
ered immediately.

This mode is optimized for maximum signal quality, and is useful if dwell times higher
than 2 ms are sufficient.

7.5  Sweep mode settings

This section lists the settings of all available sweep modes.

Access:

1. Select "Sweep" > "RF Frequency Sweep"

2. Select "Sweep" > "RF Level Sweep"

3. Select "Sweep" > "RF Combined Sweep"

4. Select "Sweep" > "LF Frequency Sweep"

The remote commands required to define these settings are described in:
● Chapter 14.16.13, "SOURce:SWEep subsystem", on page 697
● Chapter 14.16.4, "SOURce:FREQuency subsystem", on page 642
● Chapter 14.16.11, "SOURce:POWer subsystem", on page 681
● Chapter 14.16.6, "SOURce:LFOutput subsystem", on page 652

Settings

● General sweep settings.........................................................................................187
● Frequency range settings......................................................................................194
● Level range settings..............................................................................................196
● Output settings......................................................................................................198
● Edit marker settings.............................................................................................. 199

7.5.1  General sweep settings

Access:

► Select for example "Sweep" > "RF Frequency Sweep".

Sweep mode settings
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Table 7-7: General settings dialog: Examples of RF Frequency and RF Combined Sweep dialogs

> "RF Frequency Sweep" > "RF Combined Sweep"

Settings

Sweep Type................................................................................................................ 188
State (RF frequency sweep)....................................................................................... 188
State (RF level sweep)................................................................................................189
State (RF frequency / level sweep)............................................................................. 189
State (LF frequency sweep)........................................................................................ 189
Current Frequency...................................................................................................... 189
Current Level...............................................................................................................189
Mode........................................................................................................................... 189
Retrace........................................................................................................................190
Shape..........................................................................................................................191
Spacing....................................................................................................................... 192
Sweep Time................................................................................................................ 192
Dwell Time...................................................................................................................192
Trigger Slope...............................................................................................................193
Show Connector..........................................................................................................193
Reset Sweep...............................................................................................................193
Execute Single Sweep................................................................................................ 193

Sweep Type
Selects the kind of the frequency sweep.
"Step" Increases or decreases the frequency at each step.

To determine the frequency intervals, see Spacing.
"Ramp" Provides a synthesized continuous analog frequency sweep with the

set Sweep Time.
Remote command: 
[:SOURce<hw>]:SWEep:GENeration on page 701

State (RF frequency sweep)
Activates RF frequency sweep signal generation.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.

Sweep mode settings
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Remote command: 
[:SOURce<hw>]:FREQuency:MODE on page 643

State (RF level sweep)
Activates RF level sweep signal generation.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:POWer:MODE on page 687

State (RF frequency / level sweep)
Activates the RF frequency / level sweep signal generation.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:FREQuency:MODE on page 643
[:SOURce<hw>]:POWer:MODE on page 687

State (LF frequency sweep)
Status of the LF frequency sweep signal.
You find this parameter in two dialogs:
● "LF Frequency Sweep" turns on/off the signal generation.

See Sweep mode settings for access.
● "Analog Modulation Sources" displays the current state (read-only). If it is turned

on, this dialog provides the varying sweep frequency, see Current Frequency.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:LFOutput:FREQuency:MODE on page 656

Current Frequency
Displays the current frequency sweep value for all sweep Modes, except of Mode >
Step. In this mode, you can enter the next frequency setting manually.
Remote command: 
[:SOURce<hw>]:FREQuency:MANual on page 645
[:SOURce<hw>]:LFOutput:FREQuency:MANual on page 655

Current Level
Displays the current level sweep value for all sweep Modes, except of Mode > Step. In
this mode, you can enter the next level setting manually.
Remote command: 
[:SOURce<hw>]:POWer:MANual on page 686

Mode
Selects the sweep mode.
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See Chapter 7.1, "Signal generation and triggering in the sweep and list modes",
on page 173.
"Auto" Generates a continuously repeating sweep signal directly after acti-

vating the sweep mode.
The sweep steps are performed automatically, controlled by the dwell
time.

"Single / Extern Single"
Generates a single sweep cycle after a trigger event.
The sweep steps within the cycle are performed automatically, con-
trolled by the dwell time. If one cycle is completed, the instrument
waits for the next trigger event.

"Step / Extern Step"
Generates the sweep signal step-by-step, manually triggered.

"Extern Start/Stop"
Generates a continuously repeating sweep signal that is started,
stopped, and restarted by subsequent external trigger events.
The sweep steps are performed automatically, controlled by the dwell
time.

Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:MODE on page 703
:TRIGger<hw>:FSWeep:SOURce on page 742
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:MODE on page 701
:TRIGger<hw>:PSWeep:SOURce on page 742
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:MODE on page 709
:TRIGger<hw>:FPSWeep:SOURce on page 744
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE on page 662
:TRIGger<hw>:LFFSweep:SOURce on page 742

Retrace
For "Shape = Sawtooth" and "Mode = Single/External Single", enables changing the
signal to the start value while it is waiting for the next trigger event. It returns to the
start level or start frequency until the next trigger is applied.
Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:RETRace on page 705
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:RETRace on page 705
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:RETRace on page 709
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RETRace on page 663
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Shape
Selects the waveform shape of the sweep signal.
"Sawtooth" The sweep runs from start to stop frequency. The subsequent sweep

starts at the start value, i.e. the shape of the sweep sequence resem-
bles a sawtooth.

Figure 7-11: Sweep signal sawtooth shape

1 = Start value
2 = Stop value
3 = Step width

"Triangle" The sweep runs from start to stop value and back, i.e. the shape of
the sweep resembles a triangle. Each subsequent sweep starts at the
start frequency.
The triangle shape is only available for Sweep Type > Step.

Figure 7-12: Sweep signal triangle shape

1 = Start value
2 = Stop value
3 = Step width

Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:SHAPe on page 705
RF level sweep:
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[:SOURce<hw>]:SWEep:POWer:SHAPe on page 705
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:SHAPe on page 710
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SHAPe on page 663

Spacing
In "RF and LF Frequency Sweep" mode, "Spacing " selects the mode for calculating
the frequency interval, which increases or decreases the current frequency at each
step.
In "RF Frequency Sweep" mode and Sweep Type > Ramp, the parameter automati-
cally distributes the step intervals linearly.
To determine the step size, select the parameter Step Linear/Step Logarithmic.
In "RF Combined Sweep" mode, the parameter indicates that the step intervals are lin-
early (straight proportional) distributed, i.e. the intervals have the same size. The fre-
quency / level range and the Dwell Time time determine the calculated step size.
"Linear" The spacing depends on the selected sweep type.

● Sweep Type > Step
Takes the frequency value entered as absolute value in Hz.

● Option: R&S SMAB-B28
Sweep Type > Ramp
Generates a synthesized continuous analog frequency sweep for
the duration set with the parameter Sweep Time.

"Logarithmic" (Sweep Type > Step only)
Takes the value entered as a logarithmic value, i.e. as a constant
fraction of the current frequency in %.

Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:SPACing on page 704
RF combined sweep: n.a.
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SPACing on page 664

Sweep Time
Option: R&S SMAB-B28
For "RF Frequency Sweep" with Sweep Type > Ramp, the parameter sets the duration
of a ramp sweep step.
Remote command: 
[:SOURce<hw>]:SWEep[:FREQuency]:TIME on page 710

Dwell Time
Defines the duration of the individual sweep steps.
Note: In case of considerable overrun conditions, the R&S SMA100B turns off the
sweep mode.
See also Chapter 7.4, "Significant parameters and functions", on page 185.
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Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:DWELl on page 703
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:DWELl on page 701
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:DWELl on page 708
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:DWELl on page 661

Trigger Slope
For "Mode = Extern Step/Single", selects the polarity of the active slope of an applied
instrument trigger.
Trigger signal is expected at the Inst Trig connector.
"Positive" The rising edge of the trigger signal triggers the instrument.
"Negative" The falling edge of the trigger signal triggers the instrument.
Remote command: 
[:SOURce]:INPut:TRIGger:SLOPe on page 652

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Reset Sweep
Resets a sweep.
With the next trigger event, the sweep starts at the initial value.
Remote command: 
[:SOURce<hw>]:SWEep:RESet[:ALL] on page 710

Execute Single Sweep
In "Mode = Single", starts a sweep manually.
Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:EXECute on page 705
:TRIGger<hw>:FSWeep[:IMMediate] on page 744
RF level sweep:
[:SOURce<hw>]:SWEep:POWer:EXECute on page 705
:TRIGger<hw>:PSWeep[:IMMediate] on page 744
RF combined sweep:
[:SOURce<hw>]:SWEep:COMBined:EXECute on page 708
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:EXECute on page 662
:TRIGger<hw>:LFFSweep:IMMediate on page 744
General:
:TRIGger<hw>[:SWEep][:IMMediate] on page 744
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7.5.2  Frequency range settings

Access:

1. Select for example "Sweep" > "RF Frequency Sweep"

2. Select for example "Frequency Range".
Table 7-8: Range settings dialog: Examples of RF Frequency and RF Combined Sweep dialogs

> "Frequency Range" > "Frequency / Level Range"

Settings

Start Frequency/Stop Frequency................................................................................ 194
Center Frequency....................................................................................................... 194
Span............................................................................................................................195
Spacing....................................................................................................................... 195
Step Linear/Step Logarithmic......................................................................................195

Start Frequency/Stop Frequency
Defines the frequency sweep range by setting the start and end values.
See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.
Remote command: 
RF frequency sweep:
[:SOURce<hw>]:FREQuency:STARt on page 647
[:SOURce<hw>]:FREQuency:STOP on page 648
RF combined sweep:
[:SOURce<hw>]:COMBined:FREQuency:STARt on page 707
[:SOURce<hw>]:COMBined:FREQuency:STOP on page 707
LF frequency sweep:
[:SOURce<hw>]:LFOutput:FREQuency:STARt on page 656
[:SOURce<hw>]:LFOutput:FREQuency:STOP on page 656

Center Frequency
In "RF Frequency Sweep" mode, sets the RF center frequency.
See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.
Remote command: 
[:SOURce<hw>]:FREQuency:CENTer on page 647
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Span
In "RF Frequency Sweep" mode, sets the span of the frequency sweep range.
See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.
Remote command: 
[:SOURce<hw>]:FREQuency:SPAN on page 647

Spacing
In "RF and LF Frequency Sweep" mode, "Spacing " selects the mode for calculating
the frequency interval, which increases or decreases the current frequency at each
step.
In "RF Frequency Sweep" mode and Sweep Type > Ramp, the parameter automati-
cally distributes the step intervals linearly.
To determine the step size, select the parameter Step Linear/Step Logarithmic.
In "RF Combined Sweep" mode, the parameter indicates that the step intervals are lin-
early (straight proportional) distributed, i.e. the intervals have the same size. The fre-
quency / level range and the Dwell Time time determine the calculated step size.
"Linear" The spacing depends on the selected sweep type.

● Sweep Type > Step
Takes the frequency value entered as absolute value in Hz.

● Option: R&S SMAB-B28
Sweep Type > Ramp
Generates a synthesized continuous analog frequency sweep for
the duration set with the parameter Sweep Time.

"Logarithmic" (Sweep Type > Step only)
Takes the value entered as a logarithmic value, i.e. as a constant
fraction of the current frequency in %.

Remote command: 
RF frequency sweep:
[:SOURce<hw>]:SWEep[:FREQuency]:SPACing on page 704
RF combined sweep: n.a.
LF frequency sweep:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SPACing on page 664

Step Linear/Step Logarithmic
In "RF/LF Frequency Sweep" mode, sets the step width for the individual frequency
sweep steps. The value is added at each sweep step to the current frequency.
Depending on the current Spacing, you can enter either an absolute or logarithmic step
width.
This parameter is only available for Sweep Type > Step.
See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.
"Step Linear" The step width is a constant value in Hz.
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"Step Logarithmic"
The step width is determined logarithmically in %, i.e. as a constant
fraction of the current frequency.

Remote command: 
[:SOURce<hw>]:SWEep[:FREQuency]:STEP[:LINear] on page 706
[:SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic on page 706
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP[:LINear] on page 664
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP:LOGarithmic
on page 664

7.5.3  Level range settings

Access:

1. Select "Sweep" > "RF Level Sweep"

2. Select for example "Level Range".
Table 7-9: Range settings dialog: Examples of RF Level and RF Combined Sweep dialogs

> "Level Range" > "Frequency / Level Range"

Settings

Start Level / Stop Level............................................................................................... 196
Step Count.................................................................................................................. 197
Spacing....................................................................................................................... 197
Step.............................................................................................................................197
Setting Characteristics................................................................................................ 197
Sweep Level Range.................................................................................................... 198

Start Level / Stop Level
Defines the RF level sweep range by setting the start and end values.
See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.
Remote command: 
RF level sweep:
[:SOURce<hw>]:POWer:STARt on page 688
[:SOURce<hw>]:POWer:STOP on page 688
RF combined sweep:
[:SOURce<hw>]:COMBined:POWer:STARt on page 707
[:SOURce<hw>]:COMBined:POWer:STOP on page 708
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Step Count
In "RF Combined Mode", defines the number of sweeps to be executed in Mode > Sin-
gle.
To start the sweep cycles, select Execute Single.
Remote command: 
[:SOURce<hw>]:SWEep:COMBined:COUNt on page 708

Spacing
Indicates that the instrument distributes the level steps linearly (straight proportional),
i.e. the level steps have the same size.
To determine the step size, use the parameter Step.
Remote command: 
n.a.

Step
Sets the step width for the RF level sweep in dB.
The "RF level sweep" mode increases or decreases the level value linearly by the set
value.
Remote command: 
[:SOURce<hw>]:SWEep:POWer:STEP[:LOGarithmic] on page 702

Setting Characteristics
Selects additional quality characteristics to optimize the behavior of the RF signal level
for the specific application.
"Auto" Sets the RF output level automatically according to the selected

mode.
In this mode, the instrument provides the highest dynamic range and
fastest setting times, as specified in the data sheet.
The RF signal is shortly blanked when the step attenuator is switch-
ing.

"Uninterrupted"
Suppresses blanking at level transitions. Frequency transitions can
lead to an RF level blanking due to hardware specific switching
points.
This mode reduces the dynamic range of the instrument. The step
attenuator is fixed.

"Strictly Monotone"
Executes signal level changes monotonically increasing or decreas-
ing.
The setting makes sure that increasing the level value exclusively
results in an increased output level, and vice versa.
All electronic switches, which might affect the monotonicity are fixed.
The operation mode is useful for applications using level searching
algorithms which rely on a strictly monotonous behavior.

"Constant-VSWR"
Suppresses output impedance variations at the RF output connector,
due to changed level settings.
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"High Dyn. Uninterrupted"
R&S SMAB-K724
Provides a linear output power that is uninterrupted over a wide
dynamic range.
Note: The R&S SMA100B supports this characteristic at frequencies
above 52 MHz. If you select the setting at lower frequencies
(≤52 MHz), the instrument reports a settings conflict.

"User" Indicates that a setting has been modified in the expert mode. The
expert mode is a protected function, that requires protection level 2
password.

Remote command: 
[:SOURce<hw>]:POWer:LBEHaviour on page 686

Sweep Level Range
Displays the RF level sweep range.
See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.
Remote command: 
[:SOURce<hw>]:POWer:RANGe:MIN? on page 691
[:SOURce<hw>]:POWer:RANGe:MAX? on page 691

7.5.4  Output settings

Option: R&S SMAB-B28

Access:

1. Select "Sweep" > "RF Frequency Sweep".

2. Select "Output".

Settings

V/GHz / X-Axis............................................................................................................ 198
Marker / User.............................................................................................................. 199

V/GHz / X-Axis
Option: R&S SMAB-B28
Selects the mode the voltage is supplied depending on the frequency.
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The R&S SMA100B supplies the signal at the V/GHz X-Axis connector.

"0,25 V/GHz" /
" 0,5 V/GHz" / "
1 V/GHz"

Supplies the voltage proportional to the set frequency, derived from
the selected setting.

"X-Axis" Supplies a voltage range from 0 V to 10 V proportional to the fre-
quency sweep range, set with Start Frequency/Stop Frequency.

Remote command: 
:OUTPut:FPRoportional:SCALe on page 491

Marker / User
Option: R&S SMAB-B28
Selects the signal to be supplied at the Marker User1 connector.
"Marker" Assigns a marker signal to the output.

To configure and assign the marker signals, see Chapter 7.5.5, "Edit
marker settings", on page 199.

"User" Intended for future use.
Remote command: 
:OUTPut:USER:MARKer on page 492

7.5.5  Edit marker settings

Option: R&S SMAB-B28

Access:

1. Select "Sweep" > "RF Frequency Sweep"

2. Select "Edit Marker".
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You can define up to 10 markers, and assign one of them to the output at a time.
When the sweep run has reached the marker frequency, the R&S SMA100B acti-
vates the marker signal and supplis it at the Marker User1 connector. The duration
of the active signal corresponds to the dwell time of a step.

Settings

Frequency x................................................................................................................ 200
State............................................................................................................................200
Marker Polarity............................................................................................................ 201
Active Marker.............................................................................................................. 201

Frequency x
Sets the frequency that the selected marker indicates.
When the specified value is used, the polarity of the marker signal changes, as
selected with the parameter .
Remote command: 
[:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:FREQuency on page 711

State
Enables the selected marker.
A marker signal at the output connector marks the moment the specified frequency val-
ues is used.
Remote command: 
[:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:FSTate on page 711
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Marker Polarity
Sets the polarity of the marker signal.
The duration of the active signal is equal to the dwell time of a step.
Remote command: 
[:SOURce<hw>]:SWEep:MARKer:OUTPut:POLarity on page 710

Active Marker
Boosts a specific marker signal so that it is output with higher voltage than all other
markers.
Remote command: 
[:SOURce<hw>]:SWEep[:FREQuency]:MARKer:ACTive on page 711

7.6  List mode settings

The "List Mode" dialog contains all the functions and settings for creating and handling
lists with RF frequency/level pairs including the corresponding dwell times for generat-
ing the RF signal based on these values.

Access:

► Select "Sweep" > "List mode".

The dialog contains parameters for configuring the list mode processing, entering
list mode data and transferring data files from or to the instrument.
The remote commands required to define these settings are described in Chap-
ter 14.16.7, "SOURce:LIST subsystem", on page 665.

● General settings....................................................................................................202
● List mode data settings......................................................................................... 204
● Import/export settings............................................................................................205
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7.6.1  General settings

Access:

► Select "Sweep" > "List mode".

In the "General" tab, you can configure the trigger and dwell time modes for list
processing and activate signal generation.

Settings

State............................................................................................................................202
Current Index.............................................................................................................. 202
Mode........................................................................................................................... 203
Dwell Time Mode.........................................................................................................203
Global Dwell Time....................................................................................................... 203
Trigger Slope...............................................................................................................203
Reset...........................................................................................................................204
Execute Single............................................................................................................ 204

State
Activates the list mode and processes the currently selected list.
Note: Active RF frequency, RF level or RF combined sweep modes deactivate the LF
sweep or List mode and vice versa.
Remote command: 
[:SOURce<hw>]:FREQuency:MODE on page 643

Current Index
Sets the list index for list processing in "Step" mode. In the other modes, the index indi-
cates the current step.
Remote command: 
[:SOURce<hw>]:LIST:INDex on page 670
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Mode
Selects the mode for list processing.
See Chapter 7.1, "Signal generation and triggering in the sweep and list modes",
on page 173.
"Auto" Generates the signal by processing the frequency/level value pairs of

the list from the beginning to the end.
The list steps are performed automatically, controlled by the dwell
time. If you switch from any mode to "Auto", signal generation always
starts at the top of the list.

"Single / Extern Single"
Generates the signal by processing the frequency/level value pairs of
the list once from the beginning to the end after a trigger event.
The list steps are performed automatically, controlled by the dwell
time. If one cycle is completed, the instrument waits for the next trig-
ger event.

"Step / Extern Step"
Generates the signal by processing the frequency/level value pairs of
the list step-by-step, manually triggered.

Remote command: 
[:SOURce<hw>]:LIST:TRIGger:SOURce on page 672
[:SOURce<hw>]:LIST:MODE on page 670

Dwell Time Mode
Selects either variable dwell times or a fixed dwell time to perform signal generation in
list mode.
"Global" Uses the same dwell time for all lists steps, set with Global Dwell

Time.
"From List" Uses the dwell times from the list.

You can define the dwell time for each frequency/level value pair indi-
vidually, see Chapter 7.7, "List editor", on page 207.

Remote command: 
[:SOURce<hw>]:LIST:DWELl:MODE on page 668

Global Dwell Time
Sets the dwell time for Dwell Time Mode > "Global".
Note: In case of considerable overrun conditions, the R&S SMA100B turns off the list
mode.
See also "Dwell time" on page 186.
Remote command: 
[:SOURce<hw>]:LIST:DWELl on page 668

Trigger Slope
For "Mode = Extern Step/Single", selects the polarity of the active slope of an applied
instrument trigger.
Trigger signal is expected at the Inst Trig connector.
"Positive" The rising edge of the trigger signal triggers the instrument.
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"Negative" The falling edge of the trigger signal triggers the instrument.
Remote command: 
[:SOURce]:INPut:TRIGger:SLOPe on page 652

Reset
Resets the list to the starting point.
Remote command: 
[:SOURce<hw>]:LIST:RESet on page 674

Execute Single
Manually starts list processing in "Single" mode.
Remote command: 
[:SOURce<hw>]:LIST:TRIGger:EXECute on page 672

7.6.2  List mode data settings

Access:

1. Select "Sweep" > "List mode".

2. Select "List Mode Data".

This dialog contains the parameters required for creating and editing lists, activat-
ing the learning function and selecting the list processing mode.

Settings

List Mode Data............................................................................................................ 204
Edit List Mode Data.....................................................................................................205
List Range from/to.......................................................................................................205

List Mode Data
Accesses the standard "Select List" dialog for selecting, creating and editing a list file.
The currently loaded file is indicated.
You can create data lists with the internal editor or import externally created files, see
"Creating and handling lists" on page 185.
Remote command: 
[:SOURce<hw>]:LIST:CATalog? on page 673
[:SOURce<hw>]:LIST:SELect on page 675
[:SOURce<hw>]:LIST:DELete on page 673
[:SOURce<hw>]:LIST:DELete:ALL on page 674
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Edit List Mode Data
Opens the editor to insert and save data lists with RF frequency, power and dwell time
values, see Chapter 7.7, "List editor", on page 207.
You find this function also in standard file select dialog, accessed via List Mode Data.

List Range from/to
Defines an index range in the current list by setting the start and stop index.
The instrument generates the signal with the values of the selected index range and
ignores all other list entries.
Remote command: 
[:SOURce<hw>]:LIST:INDex:STARt on page 670
[:SOURce<hw>]:LIST:INDex:STOP on page 670

7.6.3  Import/export settings

Access:

1. Select "Sweep" > "List Mode".

2. Select "List Mode Data" > "Im-/Export".

The "Im-/Export" dialog provides the parameters for importing or exporting files with
user data in standard ASCII *.txt or *.csv file format.
The table separators and the decimal floating point numbers are customizable.
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Settings

Mode........................................................................................................................... 206
ASCII File Settings...................................................................................................... 206
Select (ASCII) Source/Select (ASCII) Destination...................................................... 206
Select Source/Select ASCII Destination..................................................................... 207
Import / Export.............................................................................................................207

Mode
Selects import or export of a data list file. The provided parameters vary according to
the selected mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:MODE on page 677
[:SOURce<hw>]:CORRection:DEXChange:MODE on page 642
[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE on page 590

ASCII File Settings
Defines the format and the separators of the associated data file.
"Extension" Selects *.csv or *.txt format.

"Decimal
Point"

Sets "Point" (dot) or "Comma" as the decimal separator used in the
ASCII data with floating-point numerals.

"Column Separator"
Sets the separator between the columns in an ASCII table.
Available are: "Tab", "Semicolon", "Comma" or "Space".

Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension on page 676
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal on page 676
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn on page 676
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension on page 640
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal
on page 641
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn
on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension on page 590
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal
on page 591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn
on page 591

Select (ASCII) Source/Select (ASCII) Destination
In "Mode > Import", access the file select dialog that provides standard file handling
functions.
Where:
● "Select ASCII Source": defines the file to be loaded (imported)
● "Select ASCII Destination": selects the filename under that the loaded file is saved
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Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog? on page 675
[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect on page 676
[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog? on page 640
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog? on page 591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect on page 591

Select Source/Select ASCII Destination
In "Mode > Export", access the file select dialog that provides standard file handling
functions.
Where:
● "Select Source": selects the file to be exported
● "Select ASCII Destination": defines the filename and the file path for the exported

file
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:SELect on page 677
[:SOURce<hw>]:CORRection:DEXChange:SELect on page 642
[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect on page 592

Import / Export
Imports or exports the selected data list file, depending on the current mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:EXECute on page 675
[:SOURce<hw>]:CORRection:DEXChange:EXECute on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute on page 592

7.7  List editor

The "User Correction" and "List Mode" dialogs provide a build-in list editor for defining
the corresponding value pairs.

The table and navigation functions of the UCOR and list mode editors have the same
structure and are therefore summarized below. The access is specified for both modes,
the fields and functions are explained using the example of the list mode.

Access to "Edit List Mode Data":

► "Sweep" > "List Mode" > "List Mode Data" > "Edit List Mode Data"

The editor for list mode provides a table with RF frequency and power values, an
extra column for defining variable dwell times, and standard navigation functions.

List editor
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The remote commands required to define the list mode data are described in
Chapter 14.16.7, "SOURce:LIST subsystem", on page 665.

Access to "Edit User Correction Data":

► "Level" > "User Correction" > "Edit User Cor. Data"

The editor for user correction data provides a table with RF frequency and power
values and standard navigation functions.
The remote commands required to define the user correction data are described in
Chapter 14.16.3, "SOURce:CORRection subsystem", on page 634.

All columns in a row must contain values. Cells with missing values are therefore filled
automatically, using the value of the previous row.
If you use global dwell time in list mode, consider also that the instrument uses the
value set with Global Dwell Time for all list steps and not the values from the list.

List editor
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Since the table and navigation functions can be assumed to be known, the following
description contains a brief overview, shown by the example of the "Edit List Mdoe
Data" dialog. If a function relates to a particular dialog, it is explicitly stated.

Settings

Edit List Mode Data.....................................................................................................209
Data handling keys......................................................................................................209

└ Go To............................................................................................................ 209
└ Edit................................................................................................................210
└ Fill with Sensor..............................................................................................210
└ Save As/Save............................................................................................... 210

Fill................................................................................................................................210

Edit List Mode Data
Table with values for list or user correction processing.
Note: Once you enter a value, the editor automatically adds preset values in the other
columns. This functionality protects against data loss, otherwise incomplete rows are
lost when saving. You can simply override these values.
"Frequency /Hz"

Sets the frequency values.
Remote command: 
[:SOURce<hw>]:LIST:FREQuency on page 669
[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency on page 637

"Power /dBm" (list mode data table)
Sets the level values.

Remote command: 
[:SOURce<hw>]:LIST:POWer on page 671

"Correction Value /dBm" (user correction data table)
Sets the level values.

Remote command: 
[:SOURce<hw>]:CORRection:CSET:DATA:POWer on page 637

"Dwell /s"
In list mode, sets the dwell time values.

Remote command: 
[:SOURce<hw>]:LIST:DWELl:LIST on page 668

Data handling keys
Standard functions for file and data handling.

Go To ← Data handling keys
Selects a row for editing.

List editor
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Edit ← Data handling keys
Enables you to insert, or delete a row or ranges within a list, and provides access to a
dialog for automatic filling, see "Fill..." on page 107.

Fill with Sensor ← Data handling keys
Opens a dialog to configure the automatic filling of user correction data with an R&S
NRP power sensor. Available in UCOR mode only.
See Chapter 8.3.3, "Fill with sensor", on page 229

Save As/Save ← Data handling keys
Stores the list in a file with user-defined name and predefined file extension. To save a
copy or create a file, use the "Save as" function.

Fill...
Provides parameters for filling a table automatically with user-defined values.

To fill the table, select "Fill".
Note: Once you enter a value or fill a column, the editor automatically adds preset val-
ues in the other columns. This functionality protects against data loss, otherwise
incomplete rows will be lost when saving. You can simply override these values.
"From / Range"

Defines the start line and number of lines to be filled.
"Column To Fill"

Selects, if the column is filled up with frequencies in Hz, levels in dBm
or dwell times in s.

"Start Value / End Value"
Sets the start value for frequency, level or dwell time. The end value
is read only and depends on the increment value and the range.

"Increment Value"
Determines the step size.

"Fill" Fills the column specified in "Column To fill".

List editor
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7.8  How to generate a signal in list or sweep mode

This section shows you how to configure a varying RF output signal for both, the list
and sweep modes.

To configure the frequency sweep signal

► For a step-by-step description, see Chapter 3.3.2, "Generating an RF frequency
sweep signal", on page 49.

Example: Fast changing frequency and level settings in list mode
The following example shows you how to generate an amplitude modulated RF signal
based on list mode data.

General workflow

Since any change of the hardware settings or list entries can affect the RF signal char-
acteristics directly, we recommend that you proceed as follows:

1. Configure the modulation settings.
Activate the RF signal.

2. Wait until the hardware settings have settled.

3. Create a list file.

4. Configure the list mode.

5. Activate list mode.

To configure amplitude modulation and switch RF on

1. Press [Preset] to start from an initial state.

2. Select "Modulation" > "Amplitude Modulation > On".

3. Select "Level" > "RF ON" to activate RF signal generation.

To create list mode data

1. Select "Sweep" > "List Mode".

2. In the "List Mode Data" tab, select "List Mode Data > New"

3. Enter the filename ListMode_Test for the data list and confirm with "Ok".

The instrument creates a file and stores it in the /var/user/ directory.

4. Select "Edit List Mode Data".

5. Enter the first values "Frequency > 2", "Power > 0" and "Dwell > 2".

6. Enter further frequency, power and dwell time values in the same way.

7. Select "Save" and close the dialog.

How to generate a signal in list or sweep mode
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To configure the list mode and start signal generation

1. In the "General" tab, select "List Mode > Auto".

2. Select "Dwell Time Mode > From List".

3. Switch state to "On".

4. Select "General > State > On".

The instrument continuously generates an amplitude-modulated RF signal whose
frequency and level values change according to the dwell times, as defined in the
list.
With active list mode, the generator displays no frequency and level values in the
status bar, but you can check the following parameters.
● In the list mode dialog, the current index indicates the steps of the signal gener-

ation.
● In remote control mode, you can query:

– The current state with [:SOURce<hw>]:LIST:RUNNing?
– Current parameters with the commands FREQ?, POW? and LIST:DWEL?.

How to generate a signal in list or sweep mode
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8  Improving level performance
To adjust the RF output signal to specific needs in your application, the R&S SMA100B
offers different functions:
● Attenuator

The R&S SMA100B is equipped with a step attenuator that enables you to vary the
amplitude of the RF signal in a wide range. It is characterized by low VSWR (volt-
age standing wave ratio) over the full level and frequency range, and provides
highest level accuracy and noise suppression.
See "About the attenuator" on page 213.

● Automatic Level Control (ALC)
The automatic level control system provides stable RF signals with highest abso-
lute level accuracy over temperature and time.
See "About ALC" on page 216.

● User correction (UCOR)
The user correction function allows you to compensate frequency responses of
external setups (e.g. losses of cables) and achieve a stable input signal over fre-
quency directly at the DUT.
See "About UCOR" on page 221.

● Power sensors
The R&S SMA100B has excellent absolute level accuracy. Since a DUT is rarely
connected directly to the generator, but with cables or other components, the refer-
ence level shifts from the RF output to the DUT. To calibrate this level with high
accuracy, i.e. in the tenth dB range, you can connect an R&S NRP power sensor to
the generator. The power sensor transmits its readings to the generator, which indi-
cates these measurement results in the display. Thus you can adjust the RF output
power of the generator until you reach the target level at the DUT.
See Chapter 8.4, "Using power sensors", on page 233

8.1  Attenuator

About the attenuator

The step attenuator is either an electronic or a mechanical device. Instruments with fre-
quency options up to 20 GHz use an electronic step attenuator, providing fast and wear
free level settings. Instruments capable to generate higher frequency signals use
mechanical step attenuators. Depending on the frequency range and the installed high-
power option, both types of step attenuators can be built in, and you can select the
type to be used below 20 GHz.

To achieve a consistent level setting behavior for all frequencies, the mechanical step
attenuator is used even for lower frequencies while the electronic one is disregarded.
Especially in frequency ramp sweep mode, which requires a consistent level adjust-
ment behavior, the R&S SMA100B automatically activates the mechanical step attenu-
ator and disables the selection of the electronic step attenuator.

Attenuator
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However, option R&S SMAB-B36S does not support using the mechanical attenuator
below 20 GHz.

According to the requirements of your application, you can select different attenuator
characteristics.

The following are examples of test requirements and the corresponding configuration:
● Automatic configuration

Select standard operation mode ("Auto"), in which the generator adjusts the attenu-
ation of the RF output signal automatically.

● DUT tests under low signal to noise conditions
Low output power is suitable to test the behavior of a DUT under low signal to
noise conditions.

● Uninterrupted level settings with constant VSWR
A fix attenuation value is required for obtaining uninterrupted level settings with
constant VSWR.
The configuration "RF Off Mode > Unchanged" ensures that constant VSWR is
maintained if you turn the signal off and on again.

● Noise sensitive applications
The parameter "RF OFF Mode > Full Attenuation" sets maximum attenuation and
thus suppresses noise when you turn off the RF signal.

8.1.1  Attenuator settings

Access:

► Select "Level" > "Level > Attenuator".

In the "Attenuator" dialog, you can select the operating mode of the electronic step
attenuator.

The remote commands required to define these settings are described in Chap-
ter 14.13, "OUTPut subsystem", on page 489 and Chapter 14.16.11, "SOURce:POWer
subsystem", on page 681.

Attenuator
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Settings

Mode........................................................................................................................... 215
Step Attenuator below 20 GHz....................................................................................215
Level Range................................................................................................................ 215
RF OFF Mode............................................................................................................. 215

Mode
Determines the operating mode of the step attenuator.
"Auto" Adjusts the attenuator settings automatically.
"Fixed" Fixes the attenuator and amplifier paths for the current RF level and

provides signal output with constant output VSWR. The resulting level
range is indicated under "Level Range" on page 215.

Remote command: 
:OUTPut<hw>:AMODe on page 490

Step Attenuator below 20 GHz
Without option R&S SMAB-B36S only
Selects the type of the step attenuator for frequencies up to 20 GHz.
This setting depends on the frequency range and the installed high power options, see
"About the attenuator" on page 213.
"Mechanical" Selects that the R&S SMA100B uses the mechanical step attenuator

over the whole frequency range.
The mechanical attenuator is used even for lower frequencies, to
achieve a consistent level setting behavior for all frequencies. The
electronic step attenuator is disregarded.
Sweep Type > Ramp also requires a consistent level adjustment
behavior. Therefore, the R&S SMA100B automatically activates the
mechanical step attenuator and disables the selection of the elec-
tronic step attenuator.

"Electronic" Selects that the R&S SMA100B uses the electronic attenuator as
long as the frequency is below 20 GHz, providing benefits regarding
setting time and wear.

Remote command: 
[:SOURce<hw>]:POWer:ATTenuation:PATTenuator on page 685

Level Range
Shows the interruption-free range of the level that you can use in the selected mode.
Remote command: 
:OUTPut<hw>:AFIXed:RANGe:LOWer? on page 492
:OUTPut<hw>:AFIXed:RANGe:UPPer? on page 492

RF OFF Mode
Determines the state of the step attenuator, when the RF signal is switched off.
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.

Attenuator
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"Unchanged" Freezes the setting of the step attenuator.
Use this mode if a constant VSWR (Voltage Standing Wave Ratio) is
required.

"Full Attenuation"
Switches to the maximum attenuation.
Use this mode for applications that require a high level of noise sup-
pression.

Remote command: 
[:SOURce<hw>]:POWer:ATTenuation:RFOFf:MODE on page 685

8.1.2  Reverse power protection

The R&S SMA100B is equipped with a reverse power protection circuit.

The reverse power protection is tripped when the power of signals reflected from the
load or external signals applied to the RF output get too high. A relay opens and inter-
rupts the internal connection to the RF output. This condition is indicated in the status
bar by the "Overload" status message.

Overload
If an "Overload" status message is indicated in the status bar, perform the following:
● Remove the cause for the overload
● Press the [RF on/off] key to reset the overload protection
The RF input is activated when the overload protection is reset.
Remote command: 
:OUTPut<hw>:PROTection:TRIPped? on page 493
:OUTPut<hw>:PROTection:CLEar on page 492

8.2  Automatic level control (ALC)

The R&S SMA100B is equipped with an automatic level control (ALC) unit to obtain
best RF level accuracy.

About ALC

ALC is an adaptive control system to stabilize the RF output level. It continuously moni-
tors the current level and adjusts it to keep a steady state over temperature and time.

ALC is active in almost all applications by default. However, when pulse modulation
with short pulses is used, the ALC uses table-based level settings with table values
depending on the pulse width.

Also note that ALC can detect incorrect values in multi-transmitter test setups. If mul-
tiple generators are coupled, reverse power can affect the ALC readings, which leads
to an incorrect RF output power.

Automatic level control (ALC)
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ALC states and their effects

The following description basically explains the ALC states and their principle of opera-
tion:
● "Auto"

Adjusts the output level to the operating conditions automatically. ALC is active in
almost all operating modes.

● "On"
Activates the internal level control permanently, regardless of the operating condi-
tions.
Note: This mode is not useful for pulse modulation with narrow pulses and low rep-
etition rates, since the automatic level control cannot settle in time. Set ALC
"Table & On" instead.

● "Off (Table)"
Deactivates internal level control loop. The instrument calculates every level setting
using the attenuation values from the internal (ALC) table. Level attenuation
between two table values is done with linear interpolation. This mode enables you
to perform a fast and strictly monotonic, but not quite as precise level adjustment.

● "Table & On"
Starts with the associated value of the internal level table and then activates the
automatic level control. This mode achieves maximum level accuracy and fast set-
ting times.
If pulse modulation is applied, this mode ensures fast level settings even with nar-
row pulses at low repetition rate.

● "External ALC"
Activates the external ALC detector mode.
This setting enables you to control the RF signal level at a specific point in the sig-
nal chain following the signal generator output with high accuracy.

The R&S SMA100B displays the level control setting as a status message in the info
line.

About external ALC

Some applications require precise control of the RF signal level at a specific point in
the signal chain following the signal generator output.

For this purpose, the "External ALC" function of the R&S SMA100B enables you to
close the level control loop of the instrument using an external level detector diode with
negative polarity and a coupler device.

The diode rectifies the signal received from the coupler and loops it back to the
R&S SMA100B to control the ALC system.

As shown in Figure 8-1, you must apply the feed back signal at the modulation input
connector Ext1.

Automatic level control (ALC)
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1

2

3

4

Figure 8-1: External ALC setup

1 = RF output connector
2 = Leveled output
3 = Negative polarity detector diode
4 = Ext1 input connector

How to: see Chapter 8.2.2, "How to set up an external ALC", on page 220.

8.2.1  ALC settings

Access:

► Select "Level" > "Automatic Level Control".

In the "ALC" dialog, you can configure the settings for the automatic level control of
the RF signal to achieve optimal accuracy.

The remote commands required to define these settings are described in Chap-
ter 14.16.11, "SOURce:POWer subsystem", on page 681.

Automatic level control (ALC)
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Settings

State............................................................................................................................219
Detector Sensitivity..................................................................................................... 219
Detector Coupling Factor............................................................................................ 219
Required Generator Level...........................................................................................219

State
Selects the internal level control mode.
"Auto" Selects the most appropriate ALC mode automatically.
"On" Activates ALC permanently.
"Off (Table)"

Controls the level using the attenuation values of the internal ALC
table.

"Table & On"
Starts with the attenuation setting from the internal ALC table and
continues with automatic level control.

"External ALC" Activates the external detector ALC mode.
For further details on the individual settings, an overview of the functionality and details
on what is to be considered, see "ALC states and their effects" on page 217.
Remote command: 
[:SOURce<hw>]:POWer:ALC[:STATe] on page 683

Detector Sensitivity
Determines the path of the internal level detector.
The level detector of the ALC has multiple paths distinguished by their sensitivity.
"Auto" Selects the detector path automatically, according to the given level.

This mode is the recommended operation mode.
"Fix" Fixes the last set sensitivity setting.
Remote command: 
[:SOURce<hw>]:POWer:ALC:DSENsitivity on page 683

Detector Coupling Factor
Option: R&S SMAB-K726
Sets the attenuation value for the external RF coupler of the external ALC.
See Chapter 8.2.2, "How to set up an external ALC", on page 220
Remote command: 
[:SOURce<hw>]:POWer:ALC:EDETector:FACTor on page 684

Required Generator Level
Option: R&S SMAB-K726
Sets the maximum power level at the RF output required to compensate external cou-
pler and cable losses of the external ALC.
See Chapter 8.2.2, "How to set up an external ALC", on page 220

Automatic level control (ALC)
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Remote command: 
[:SOURce<hw>]:POWer:ALC:EDETector:LEVel on page 684

8.2.2  How to set up an external ALC

Prerequisites

● R&S SMAB-K726
● Negative polarity RF detector diode with adequate frequency range
● RF coupler with adequate frequency range

Setting up an external ALC control loop

To set up an external ALC control loop, connect the detector diode and coupler as fol-
lows, see also "About external ALC" on page 217:

1. Connect the coupled output to the detector RF input.

2. Connect the detector output to the R&S SMA100B modulation input connector
Ext1.

Setting the external ALC parameters

To configure the external ALC settings:

1. Select "Level" > "Automatic Level Control" > "ALC".

2. Select "State" > "External ALC" to activate the external detector ALC mode.

The R&S SMA100B displays the parameters required for the settings in the dialog.

3. Set "Detector Coupling Factor", e.g. "16 dB", to determine the attenuation value of
the RF coupler.

Automatic level control (ALC)
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4. Set "Required Generator Level", e.g. "20 dBm" to configure the maximum power
level at the RF output.

This value corresponds to the losses of cabling and coupler to compensate.

5. In the "RF Level" tab, select "Readjust " to execute the instrument detector offset
compensation.
This function recalculates and compensates the internally detected offset voltages.

6. Set "RF" > "State" > "On".

After turning on the RF output, the system levels the coupler output power to the
value set in the instrument level display

8.3  User correction

The R&S SMA100B supports a correction function to compensate external losses,
caused, for example, by the RF cable, to achieve a precise target input level at the
DUT.

The signal at the RF outputs of the R&S SMA100B is flat. However, the DUT is usually
not connected directly to the outputs of the instrument but rather via connecting cables.
Components like cables, power combiners, switches or mixers can affect the signal
flatness at the DUT input.

Figure 8-2: Effect of external losses on the signal flatness at the DUT input

DUT = Device under test
Components = Designation of all components between the measurement equipment and the DUT, e.g.

cables
1 = Flat signal at the outputs of the R&S SMA100B
2 = Signal received at the DUT, incl. the external losses

About UCOR

User correction (UCOR) is a method that determines the external level loss over a fre-
quency range in advance, see Figure 8-3.

The difference between the generator output level and the level at the DUT determines
the correction value at the respective frequency. Alternatively, the attenuation charac-
teristics over a certain frequency range of, for example, RF cables are also specified in
the associated data sheet.

User correction
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Figure 8-3: Understanding the principle of user correction

DUT = Device under test
Compo-
nents

= Designation of all components between the measurement equipment and the DUT, e.g.
cables

PS = Power sensor, e.g. R&S NRP, connected at the DUT's input and the USB connector of the
R&S SMA100B

1 = Power sensor measures the level over a frequency range, where the collected values corre-
spond to the losses caused by the components between the R&S SMA100B and the DUT

2 = Obtain the correction data by inverting the collected data; load the correction parameters in
the R&S SMA100B

3 = In the R&S SMA100B, the RF signal is pre-processed with the correction values so that the
signal at the outputs is the inverted version of the external losses

4 = Received at the DUT input, the pre-processed signal if flat

With active UCOR, the generator adds the correction value internally and thus increa-
ses the output level by exactly the amount of the loss between its output and the DUT.
For frequencies which are not contained in the list, the level correction is calculated by
interpolation of the closest correction values.

Possible ways for configuring the user correction values

You can configure correction values in the following ways:
● Internally

– Use the built-in table editor in the "UCOR > Edit User Correction Data" dialog.
Once defined, user correction values can be saved in a file.
Files with correction data can be exported, for example, to exchange configura-
tion between instruments or to modify the file content with an external program
and reload them again.

– Using the corresponding remote-control commands.
Note that you have to create a user correction file first.

● Externally
Create a file with correction values as a CSV file with Microsoft Excel, with a Note-
pad or a similar tool and save it with the predefined extension. Transfer the file to
and load it into the instrument.

User correction
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UCOR file format

Files containing correction data are simple files in text or comma-separated value
(CSV) file format. The filename is user-definable; the file extension is *.ucor.

The file contains a list of correction values, one row per frequency and correction value
pair; a new line indicator separates the correction values.

For file handling, use the standard functions in the "File Manager", see Chapter 11.8,
"Using the file manager", on page 324.

Collecting correction data

To fill the frequency and power values in the correction table, use one of the following
options:
● Manually, row by row.
● Fill the table automatically with linearly interpolated values, calculated from value

range and step size.
● Acquire the real frequency response characteristics of the used component with

the R&S NRP power sensor, see Understanding the principle of user correction.

Using a power sensor for frequency response measurements

Consider the following when using R&S NRP power sensors to measure the correction
values:
● Measure the level directly at the input of the DUT.
● Use the internal correction functions of an R&S NRP power sensor to increase the

measurement accuracy.
● Use S-parameter to consider the impact of any two-port device like an adapter

between the signal generator and the sensor input.

Interactions and characteristics
Activated user correction is effective in all operating modes.
The RF output level (LevelRF) is the sum of the level value and the correction for the
particular frequency:
LevelRF = "Status bar > Level" + "UCOR"

Activated user correction is indicated by the status indication "Lev Ucor" in the "Level"
tile.

8.3.1  User correction settings

Access:

1. Select "Level" > "User Correction".

2. If you already have created a file with user correction data:

a) Select "UCOR Data > navigate to the file *.uco > Select".

User correction
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b) Proceed with step 4.

3. If you need to create a file:

a) Select "UCOR Data > New".
b) Enter the filename UCOR_Data and confirm with "Ok".
c) Choose the file and confirm with "Select".
d) Select "Edit UCOR Data".
e) To fill the user correction data table, proceed as described in Chapter 7.7, "List

editor", on page 207.

4. Select "RF Level > RF State > On".

5. Select "User Cor. Data > State > On".

The "UCOR" dialog contains all settings for creating and handling files with user-
defined level correction values.

The remote commands required to define these settings are described in Chap-
ter 14.16.3, "SOURce:CORRection subsystem", on page 634.

Settings

State............................................................................................................................224
User Correction........................................................................................................... 224
UCOR Data................................................................................................................. 225
Edit UCOR Data..........................................................................................................225

State
Activates user correction.
The R&S SMA100B displays the status icon "Lev Ucor" in the "Level" panel.
Remote command: 
[:SOURce<hw>]:CORRection[:STATe] on page 639

User Correction
Indicates the corrected level value for a specific frequency point.

User correction
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Remote command: 
[:SOURce<hw>]:CORRection:VALue? on page 638

UCOR Data
Accesses the standard "File Select" function of the instrument. The provided navigation
possibilities in the dialog are self-explanatory.
Files with user correction values are files with predefined file extension *.uco. When a
file is selected, the dialog indicates the filename.
You can create the file internally in the table editor or externally.
● To select an existing file, select "Select List > navigate to the file *.uco > Select"
● Use the general editor function to create internally new file or to edit an existing

one.
● Use the standard file manager function to load externally created files to the instru-

ment.
Remote command: 
[:SOURce]:CORRection:CSET:CATalog? on page 639
[:SOURce<hw>]:CORRection:CSET[:SELect] on page 638
[:SOURce]:CORRection:CSET:DELete on page 640

Edit UCOR Data
Opens the build-in table editor to define a new correction table or edit an existing one.
See also:
● Chapter 7.7, "List editor", on page 207
● "Fill..." on page 107
● Chapter 8.3.3, "Fill with sensor", on page 229

8.3.2  List editor

The "User Correction" and "List Mode" dialogs provide a build-in list editor for defining
the corresponding value pairs.

The table and navigation functions of the UCOR and list mode editors have the same
structure and are therefore summarized below. The access is specified for both modes,
the fields and functions are explained using the example of the list mode.

Access to "Edit List Mode Data":

► "Sweep" > "List Mode" > "List Mode Data" > "Edit List Mode Data"

The editor for list mode provides a table with RF frequency and power values, an
extra column for defining variable dwell times, and standard navigation functions.

User correction
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The remote commands required to define the list mode data are described in
Chapter 14.16.7, "SOURce:LIST subsystem", on page 665.

Access to "Edit User Correction Data":

► "Level" > "User Correction" > "Edit User Cor. Data"

The editor for user correction data provides a table with RF frequency and power
values and standard navigation functions.
The remote commands required to define the user correction data are described in
Chapter 14.16.3, "SOURce:CORRection subsystem", on page 634.

All columns in a row must contain values. Cells with missing values are therefore filled
automatically, using the value of the previous row.
If you use global dwell time in list mode, consider also that the instrument uses the
value set with Global Dwell Time for all list steps and not the values from the list.

User correction
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Since the table and navigation functions can be assumed to be known, the following
description contains a brief overview, shown by the example of the "Edit List Mdoe
Data" dialog. If a function relates to a particular dialog, it is explicitly stated.

Settings

Edit List Mode Data.....................................................................................................227
Data handling keys......................................................................................................227

└ Go To............................................................................................................ 227
└ Edit................................................................................................................228
└ Fill with Sensor..............................................................................................228
└ Save As/Save............................................................................................... 228

Fill................................................................................................................................228

Edit List Mode Data
Table with values for list or user correction processing.
Note: Once you enter a value, the editor automatically adds preset values in the other
columns. This functionality protects against data loss, otherwise incomplete rows are
lost when saving. You can simply override these values.
"Frequency /Hz"

Sets the frequency values.
Remote command: 
[:SOURce<hw>]:LIST:FREQuency on page 669
[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency on page 637

"Power /dBm" (list mode data table)
Sets the level values.

Remote command: 
[:SOURce<hw>]:LIST:POWer on page 671

"Correction Value /dBm" (user correction data table)
Sets the level values.

Remote command: 
[:SOURce<hw>]:CORRection:CSET:DATA:POWer on page 637

"Dwell /s"
In list mode, sets the dwell time values.

Remote command: 
[:SOURce<hw>]:LIST:DWELl:LIST on page 668

Data handling keys
Standard functions for file and data handling.

Go To ← Data handling keys
Selects a row for editing.
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Edit ← Data handling keys
Enables you to insert, or delete a row or ranges within a list, and provides access to a
dialog for automatic filling, see "Fill..." on page 107.

Fill with Sensor ← Data handling keys
Opens a dialog to configure the automatic filling of user correction data with an R&S
NRP power sensor. Available in UCOR mode only.
See Chapter 8.3.3, "Fill with sensor", on page 229

Save As/Save ← Data handling keys
Stores the list in a file with user-defined name and predefined file extension. To save a
copy or create a file, use the "Save as" function.

Fill...
Provides parameters for filling a table automatically with user-defined values.

To fill the table, select "Fill".
Note: Once you enter a value or fill a column, the editor automatically adds preset val-
ues in the other columns. This functionality protects against data loss, otherwise
incomplete rows will be lost when saving. You can simply override these values.
"From / Range"

Defines the start line and number of lines to be filled.
"Column To Fill"

Selects, if the column is filled up with frequencies in Hz, levels in dBm
or dwell times in s.

"Start Value / End Value"
Sets the start value for frequency, level or dwell time. The end value
is read only and depends on the increment value and the range.

"Increment Value"
Determines the step size.

"Fill" Fills the column specified in "Column To fill".
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8.3.3  Fill with sensor

Access:

1. Select "Level" > "User Correction".

2. Select "UCOR Data > navigate to the file *.ucor > Select".

3. Select "Edit UCOR Data > Fill With Sensor...".

This dialog contains parameters for filling a table automatically with sensor read-
ings.

To fill the table, select "Execute".
For information on power sensors an how to use them, see Chapter 8.5, "How to cali-
brate the power level with an R&S NRP power sensor", on page 290.

Settings

Fill User Correction Data with Sensor......................................................................... 229
Used SMAB Settings For Measurement..................................................................... 230

Fill User Correction Data with Sensor
● "Sensor"

Displays connected sensors for selection.
● "List To Fill"

Indicates the used list.
● "S-Parameter"

Indicates whether S-Parameter correction in the R&S NRP power sensor is used.
● "Include Zeroing"
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Performs a zeroing procedure before acquiring the user correction data to improve
precision.
No signal is applied to the sensor during zeroing. RF output is temporarily switched
off during that time.
When unchecked, the zeroing procedure is skipped. However, the RF signal level
might be blanked shortly. This setting is useful if blanking of RF is undesirable or
the absence of power at the sensor cannot be guaranteed.

● "Execute"
The "Execute" button is only enabled if a sensor is detected and the user correction list
contains at least one frequency value.
Remote command: 
[:SOURce<hw>]:CORRection:ZERoing:STATe on page 639
[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe
on page 638

Used SMAB Settings For Measurement
Displays the settings relevant for the measurement.
"Modulation" Indicates the modulation state
"Amplitude" Displays the currently set level.
Remote command: 
[:SOURce<hw>]:POWer:POWer on page 687

Remote command: 
n.a.

8.3.4  Import/export list files

Access:

1. Select one of the following:

● "Sweep" > "List mode".
● "Level" > "User Correction".
● "Modulation > Pulse Modulation > Pulse Generator > Pulse Mode = Train".
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2. Select "Import/Export".

Figure 8-4: Im-/Export dialog (example with UCOR settings)

The "Import/Export" dialog contains all functions and settings to import externally
created list data or to export it accordingly. You can process and store a list in the
formats *.txt (ASCII), or *.csv (plain text with identical sequence of fields). The
table separators and the decimal floating point numbers are customizable.

Settings

Mode........................................................................................................................... 231
ASCII File Settings...................................................................................................... 231
Select (ASCII) Source/Select (ASCII) Destination...................................................... 232
Select Source/Select ASCII Destination..................................................................... 232
Import / Export.............................................................................................................232

Mode
Selects import or export of a data list file. The provided parameters vary according to
the selected mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:MODE on page 677
[:SOURce<hw>]:CORRection:DEXChange:MODE on page 642
[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE on page 590

ASCII File Settings
Defines the format and the separators of the associated data file.
"Extension" Selects *.csv or *.txt format.

"Decimal
Point"

Sets "Point" (dot) or "Comma" as the decimal separator used in the
ASCII data with floating-point numerals.

"Column Separator"
Sets the separator between the columns in an ASCII table.
Available are: "Tab", "Semicolon", "Comma" or "Space".

Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension on page 676
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal on page 676
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[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn on page 676
[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension on page 640
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal
on page 641
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn
on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension on page 590
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal
on page 591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn
on page 591

Select (ASCII) Source/Select (ASCII) Destination
In "Mode > Import", access the file select dialog that provides standard file handling
functions.
Where:
● "Select ASCII Source": defines the file to be loaded (imported)
● "Select ASCII Destination": selects the filename under that the loaded file is saved
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog? on page 675
[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect on page 676
[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog? on page 640
[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog? on page 591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect on page 591

Select Source/Select ASCII Destination
In "Mode > Export", access the file select dialog that provides standard file handling
functions.
Where:
● "Select Source": selects the file to be exported
● "Select ASCII Destination": defines the filename and the file path for the exported

file
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:SELect on page 677
[:SOURce<hw>]:CORRection:DEXChange:SELect on page 642
[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect on page 592

Import / Export
Imports or exports the selected data list file, depending on the current mode.
Remote command: 
[:SOURce<hw>]:LIST:DEXChange:EXECute on page 675
[:SOURce<hw>]:CORRection:DEXChange:EXECute on page 641
[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute on page 592
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8.4  Using power sensors

The R&S SMA100B works with most of the R&S NRP power sensors and thus sup-
ports various application tasks. Using power sensors, you can for example determine
attenuation characteristics of downstream equipment or cables. You can use the mea-
sured values to compensate the losses with internal control functions or with an exter-
nal control circuit in real time.

R&S NRP sensors are highly accurate standalone measuring devices, suitable for a
wide range of applications. The devices communicate directly with the signal genera-
tor, calculate the average or peak power internally, include S-parameter correction and
return the measurement results to the generator.

The R&S SMA100B works with any sensor of the R&S NRP series and can perform up
to four power measurements simultaneously.

Only for the NRP-Z power analysis function, you have to use R&S NRP power sensors
that support power analysis in frequency, power and time domain, see Chapter 8.4.4.1,
"Required options", on page 245

Check the firmware version of the R&S NRP sensors regularly. Update the firmware, if
necessary.
For updates, see the Rohde & Schwarz website http://www.rohde-schwarz.com in sec-
tion "Power Meters & Voltmeters".

● Connecting R&S NRP power sensors to the R&S SMA100B...............................233
● NRP sensor mapping............................................................................................234
● NRP power viewer................................................................................................ 237
● NRP-Z power analysis.......................................................................................... 245

8.4.1  Connecting R&S NRP power sensors to the R&S SMA100B

R&S NRP sensors are connected to the R&S SMA100B in the following ways:
● Connection to the Sensor connector

– R&S NRP-ZK8 (eight-pole interface cable) for R&S NRPxx power sensors
– R&S NRP-ZK6 (six-pole interface cable) for R&S NRPxx power sensors
– No additional cable for R&S NRP-Zxx power sensors (cable is fixed on the sen-

sor)
● Connection to the USB connector

Requires the following cables, depending on the used sensor type:
– R&S NRP-ZKU (USB interface cable) for R&S NRPxx power sensors
– R&S NRP-Z3 or R&S NRP-Z4 (USB adapter cables) for sensors of the R&S

NRP-Zxx family
● Connection via R&S NRP-Z5 sensor hub

The R&S NRP-Z5 USB sensor hub (high-speed USB 2.0) can host up to 4 R&S
NRP sensors. It provides simultaneous internal and external triggering of all con-
nected sensors.

Using power sensors
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Requires additional cables, depending on the used output connector of the hub.
Choose one of the following:
– Short extension cable R&S NRP-Z2 for connection to the sensor connector.

This six-pole connection provides the external trigger capability.
– Standard USB cable (USB type A to USB type B) to any USB type A connector

of the R&S SMA100B. This connection does not support external triggering.
● Connection via USB hub with external power supply unit

Requires the following cables, depending on the used sensor type:
– R&S NRP-ZKU (USB interface cable) for R&S NRPxx power sensors
– R&S NRP-Z3 or R&S NRP-Z4 (USB adapter cables) for sensors of the R&S

NRP-Zxx family
● Connection via LAN for R&S NRPxxxSN/xxxTN/xxxAN power sensors

Using the Ethernet interface requires PoE (Power over Ethernet) to provide the
electrical power.
To establish the connection, you can use:
– A PoE Ethernet switch, e.g. R&S NRP-ZAP1 and an RJ-45 Ethernet cable.
– A PoE injector and an RJ-45 Ethernet cable.

For details, see the description R&S®NRP®Series Power Sensors Getting Started.

Detection and mapping

The R&S SMA100B automatically detects a connected R&S NRP power sensor and
indicates it in the "NRP Power Viewer" and "NRP Sensor Mapping" dialogs.

By default, detected sensors are indicated as follows:
● A sensor connected at the Sensor socket is assigned as "Sensor 1".

If no sensor is connected to this socket, channel 1 remains unassigned.
● Sensors 2 to 4 are assigned to the sensors at the USB connectors, according to

their sequence of connection.

You can change the default mapping in the NRP sensor mapping dialog.

On connection, the R&S SMA100B immediately starts the measurement of a detected
R&S NRP power sensor. If you perform an instrument preset ([Preset] key or *RST),
the R&S SMA100B stops the measurements. The connection and the mapping of the
power sensors remain, the measurements must be restarted.

8.4.2  NRP sensor mapping

The "NRP Sensor Mapping" lists all R&S NRP sensors detected by the instrument.

Any R&S NRP sensor that supports the USB legacy protocol and is connected to one
of the USB interfaces, is detected automatically and added to the list. Vice versa, the
R&S SMA100B removes a sensor from the list, when it is disconnected.

R&S NRP sensors that are connected via LAN or use the USBTMC protocol are not
automatically detected. They are detected by the scan search function.

Using power sensors



Improving level performanceR&S®SMA100B

235User Manual 1178.3834.02 ─ 09

Access:

► Select "Clk Syn/Power Sens" > "NRP Sensor Mapping".

The dialog lists all detected R&S NRP sensors for selection and mapping. You can
also browse the network for sensors.
The detected sensors are characterized by the used protocol and the correspond-
ing connector icon. In the "Mapping" column, you can assign the sensor to one of
the available sensor channels. The list can contain several entries but the
R&S SMA100B can only use up to four sensors simultaneously.
The remote commands required to define these settings are described in Chap-
ter 14.15, "SENSe, READ, INITiate and SLISt subsystems", on page 546.

Settings

Sensor Mapping List................................................................................................... 235
Scan............................................................................................................................ 236
Clear............................................................................................................................236
Add Sensor/Hide 'Add Sensor'....................................................................................236
Add Sensor settings.................................................................................................... 236

└ Add LAN Sensor settings..............................................................................236
└ Add USB Sensor settings............................................................................. 236

Sensor Mapping List
Shows the sensors that are connected to the R&S SMA100B.
The table informs on the sensor type, specific features and the installed sensor firm-
ware. It also shows the interface the sensor is connected to, including the communica-
tion protocol and the assigned channel.
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Remote command: 
:SLISt[:LIST]? on page 549
:SLISt:ELEMent<ch>:MAPPing on page 551
:SLISt:SENSor:MAP on page 551

Scan
Scans the network and the USB connections for sensors connected using the VISA
communication protocol, i.e. sensors that are addressed over LAN or USBTMC.
The instrument detects sensors communicating over the USB legacy protocol automat-
ically.
Remote command: 
:SLISt:SCAN[:STATe] on page 549

Clear
Removes the selected sensor from the sensor mapping list.
Remote command: 
:SLISt:CLEar:LAN on page 550
:SLISt:CLEar:USB on page 550
:SLISt:CLEar[:ALL] on page 551

Add Sensor/Hide 'Add Sensor'
Shows or hides the "Add Sensor" settings.

Add Sensor settings
Configures settings to add sensors connected to the R&S SMA100B via USB or LAN.

Add LAN Sensor settings ← Add Sensor settings
Configures settings to add sensors connected to the R&S SMA100B via LAN.

"IP Address or Host Name"
Displays the host name or the IP address of a R&S NRP power sen-
sor.
If the R&S SMA100B does not detect a connected R&S NRP sensor,
you can assign the address information manually.

"Add LAN Sensor"
Adds a detected R&S NRP sensor connected in the LAN to the list of
sensors, including its device ID or name and its serial number.

Remote command: 
:SLISt:SCAN:LSENsor on page 549

Add USB Sensor settings ← Add Sensor settings
Configures settings to add sensors connected to the R&S SMA100B via USB.

"Device ID or Sensor Name"
Displays the device identifier or the name of the R&S NRP power
sensor.
If the R&S SMA100B does not detect a connected R&S NRP sensor,
you can assign the ID or name manually.
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"Serial Number"
Displays the serial number of the R&S NRP power sensor.
If the R&S SMA100B does not detect a connected R&S NRPsensor,
you can assign the serial number manually.

"Add USBTMC Sensor"
Adds a detected R&S NRP sensor connected at the USB interface to
the list of sensors, including its device ID or name and its serial num-
ber.

Remote command: 
:SLISt:SCAN:USENsor on page 550

8.4.3  NRP power viewer

The R&S SMA100B features the power viewer function for measuring or monitoring
signals with R&S NRP power sensors.

8.4.3.1  About

The R&S SMA100B can perform up to four power measurements simultaneously.

Depending on the signal characteristic (CW, AM, pulsed, etc.) or the parameter to be
measured (average, peak, etc...) a suitable R&S power sensor must be used.

About the measuring principle, averaging filter, filter length, and achieving stable
results

A sensor measures the average or peak RF power of the source continuously. The
measurement results are displayed in the "NRP Power Viewer" dialog.

The power viewer function uses averaging filters for getting a stable readout.

Measurement results could be interfered for instance by to much noise in your setup,
by a bad supression of harmonics or non harmonics or when you reach the sensitivity
level of your power sensor.

Measurements are continuously repeated in a predefined time window. The measure-
ment result is obtained by averaging the measured values for the last 2N time win-
dows. This approach is referred as a two-step averaging process.

The factor of 2 in the formula arises because the output signals from the microwave
detector are chopped at the same rate as the time windows to suppress low-frequency
noise. An independent measured value can only be obtained from two consecutive val-
ues.

The variable N in the formula indicates the filter length. The filter length then directly
influences the measurement time. The filter length can be selected automatically or it
can be manually set to a fixed value.

Depending on the R&S NRP power sensor type, the manual setting of the filter length
varies in resolution:
● Resolution = 1 for the R&S NRPxx power sensor family
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● Resolution = 2n for R&S NRP-Zxx power sensors, with n = 1 to 16

Follow the following general recommendation to find out the optimum filter length:
● Always start a measurement in auto mode ("Filter > Auto").

Check if the measurement results are sufficient.
● If the power is not constant, select the filter length manually ("Filter > User").

Trigger the "Auto Once" function to search for the optimum filter length for the cur-
rent measurement conditions.
The estimated value is indicated as filter length.

● If the target measurement accuracy value is known, select "Filter > Fixed Noise".
The averaging factor is selected automatically and so that the sensor's intrinsic
noise (two standard deviations) does not exceed the specified noise content.

● Different sensor types achieve the same filtering result with different filter and time
window lengths.
The time window length depends on the sensor type:
– For most sensors, it is fixed to 20 ms.
– For the R&S NRP-Z81 sensor, it is 10 μs.

The R&S NRP-Z81 uses filter length that is 1000 times larger than the filter
length for other sensors.

About zeroing

Activates the auto zero function.

Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.

Tips for zeroing

When to perform zeroing:
● During warm up after switching on or connecting the instrument
● After a substantial change of the ambient temperature
● After fastening the power sensor module to an RF connector at high temperature
● After several hours of operation
● When low-power signals are to be measured, e.g. less than 10 dB above the lower

measurement limit.
● Switch off the RF power source for zeroing, but do not disconnect it from the power

sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).

Related settings and functions

● Measurements-related settings, like results, filter, filter length:
Chapter 8.4.3.2, "NRP power viewer settings", on page 239

Using power sensors



Improving level performanceR&S®SMA100B

239User Manual 1178.3834.02 ─ 09

● Software version of the connected power sensor:
:SENSe<ch>[:POWer]:TYPE? on page 560

● Acquisition of level correction data:
Chapter 8.3, "User correction", on page 221

Additional information

See Rohde & Schwarz website http://www.rohde-schwarz.com in section "Power
Meters & Voltmeters" for:
● R&S NRP power sensor manual.
● Information on the R&S NRP-Z5 sensor hub and the available accessories.
● Sensor software updates.

8.4.3.2  NRP power viewer settings

Access:

► Select "Clk Syn/Power Sens" > "NRP Power Viewer".

Using power sensors
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The "Overview" tab shows the list of detected sensors, and provides a separate tab
per sensor.

A sensor tab contains all parameters for configuring the sensor settings, like aver-
age or peak display, reference source, filter and level offset.
The remote commands required to define these settings are described in Chap-
ter 14.15, "SENSe, READ, INITiate and SLISt subsystems", on page 546, including
the triggering of the measurement and the retrieval of measurement results.
See also Chapter 8.5, "How to calibrate the power level with an R&S NRP power
sensor", on page 290.

Settings

Sensor type and serial number................................................................................... 241
Level (Peak) / Level (Average)....................................................................................241
Sensor Mapping.......................................................................................................... 241
Sensor settings........................................................................................................... 241

└ State..............................................................................................................241
└ Zero...............................................................................................................241
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└ Display.......................................................................................................... 242
└ Permanent.......................................................................................... 242
└ Display................................................................................................242

└ Use Frequency Of.........................................................................................242
└ Frequency.....................................................................................................242
└ Level Offset State,Level Offset..................................................................... 242
└ Filter..............................................................................................................243
└ Filter Length..................................................................................................243
└ Noise/Signal Ratio........................................................................................ 243
└ Auto Once.....................................................................................................243
└ Timeout......................................................................................................... 244
└ Default Aperture Time...................................................................................244
└ Aperture Time............................................................................................... 244
└ S-Parameter..................................................................................................244
└ Enable Logging.............................................................................................244

Sensor type and serial number
Indicates the type and the serial number of a selected R&S NRP power sensor, and
the channel the sensor is assigned to.
The displayed Level (Peak) / Level (Average) values correspond to the particular sen-
sor.
Remote command: 
:SENSe<ch>[:POWer]:TYPE? on page 560
:SENSe<ch>[:POWer]:SNUMber? on page 558

Level (Peak) / Level (Average)
Indicates the measured peak or average level value.
You can also change the unit for the results display: Watt, dBm or dBμV.

Note: Peak level measurements are provided if the power sensor supports this feature.
Remote command: 
:READ<ch>[:POWer]? on page 552
:SENSe<ch>:UNIT[:POWer] on page 552

Sensor Mapping
Accesses the NRP sensor mapping dialog.

Sensor settings
One tab per sensor provides the corresponding settings.

State ← Sensor settings
Activates level measurement.
Remote command: 
:INITiate<hw>[:POWer]:CONTinuous on page 501
To query the availability of a sensor at a given connector, use the command :
SENSe<ch>[:POWer]:STATus[:DEVice]? on page 559.

Zero ← Sensor settings
Activates the auto zeroing.
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For details, see "About zeroing" on page 238.
Remote command: 
:SENSe<ch>[:POWer]:ZERO on page 560

Display ← Sensor settings
Sets the display mode for power readings.

Permanent ← Display ← Sensor settings
Activates the permanent indication of the power measurement result in the status bar
of the home screen.
You can activate the permanent display for several sensors.
Remote command: 
:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe on page 554

Display ← Display ← Sensor settings
Sets the display of results on mean or peak power.
Remote command: 
:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority on page 554

Use Frequency Of ← Sensor settings
Selects the source for measurement.
"RF" The R&S SMA100B transfers the RF frequency and level settings to

the R&S power sensor automatically. Thus you achieve power read-
ings of high accuracy, irrespective from the connected sensor type.

"User" Sets a user defined frequency.

Example: 
If you have a frequency converting device between the generator and
the DUT. If the frequency converter doubles the frequency, you can
set twice the frequency in the R&S SMA100B. The R&S power sen-
sor considers this RF frequency setting.

Set the parameter Frequency to the measurement's frequency.
Remote command: 
:SENSe<ch>[:POWer]:SOURce on page 559

Frequency ← Sensor settings
Defines the frequency value if "Source > User" is used.
Remote command: 
:SENSe<ch>[:POWer]:FREQuency on page 557

Level Offset State,Level Offset ← Sensor settings
Activates and defines a level offset which is considered in the power meassurement
result. The level offset value is always expressed in dB, irrespective of the display of
the measurement result.
This function allows you to consider, for example, an attenuator in the signal path.
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Remote command: 
:SENSe<ch>[:POWer]:OFFSet on page 558
:SENSe<ch>[:POWer]:OFFSet:STATe on page 558

Filter ← Sensor settings
Selects the way the length of the used filter is defined.
See also "About the measuring principle, averaging filter, filter length, and achieving
stable results" on page 237.
"Auto" Selects the filter length automatically and adjusts it to the measured

value. The value is indicated with the parameter Filter Length.
When high output power is applied, the filter length and therefore the
measurement time can be short.
When low output power is applied, the filter length and therefore the
measurement time is increased which reduces the considered noise
content in your measurement.

"User" The filter length is defined manually, with the parameter Filter Length.
As the filter length works as a multiplier for the time window, constant
filter length results in a constant measurement time.
Values 1 and 2N are allowed.

"Fixed Noise" The averaging factor is taken automatically in accordance to the
value Noise/Signal Ratio. Thus, the sensor's intrinsic noise (2 stan-
dard deviations) does not exceed the specified noise content.
To avoid long measurement times when the power is too low, set a
Timeout.
Timeout is the maximum acceptable measurement time which limits
the averaging factor and therefore leads to a more unstable readout.

Remote command: 
:SENSe<ch>[:POWer]:FILTer:TYPE on page 557

Filter Length ← Sensor settings
Sets or indicates the filter length, depending on the selected filter mode.
● "Filter > Auto" indicates the automatically adjusted filter length.
● "Filter > User" enables you to set the filter length manually.
● "Filter > Fixed Noise" hides the setting parameter.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO? on page 555
:SENSe<ch>[:POWer]:FILTer:LENGth[:USER] on page 555

Noise/Signal Ratio ← Sensor settings
For Filter > Fixed Noise, sets the noise content.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:NSRatio on page 556

Auto Once ← Sensor settings
Searches the optimum filter length for the current measurement conditions. The result
is indicated with the parameter Filter Length.
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See also "About the measuring principle, averaging filter, filter length, and achieving
stable results" on page 237.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:SONCe on page 556

Timeout ← Sensor settings
For "Filter > Fixed Noise", sets a time limit for the averaging process.
Remote command: 
:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe on page 556

Default Aperture Time ← Sensor settings
The sensor default setting is sufficient. Disable this parameter to specify a user-defined
aperture time per sensor, if, for example, the readings vary.
To obtain stable readings, set the Aperture Time exactly to one modulation period.
Remote command: 
:SENSe<ch>[:POWer]:APERture:DEFault:STATe on page 553

Aperture Time ← Sensor settings
If "Use Default Aperture Time > Off", defines the acquisition time per sensor.
For example, to obtain a sufficient low average value, set the aperture time exactly to
one modulation period.
Remote command: 
:SENSe<ch>[:POWer]:APERture:TIMe on page 553

S-Parameter ← Sensor settings
Lists the S-Parameter correction data files retrieved for the connected power sensor.
To activate the correction data, select the corresponding file.
S-Parameter correction is used to mathematically shift the reference plane to the DUT
by considering the S-parameters for any components connected upstream of the sen-
sor.
The S-Parameter table can be changed with the S-Parameters tool, provided as part of
the free R&S NRP Toolkit software. For more information, refer to the manual of the
connected R&S NRP power sensor.
Remote command: 
:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe on page 554
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST? on page 554
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect on page 553

Enable Logging ← Sensor settings
Activates recording of R&S NRP power sensor readings in a log file.
There is 1 log file per sensor. The log files are created automatically and filled in con-
tinuously. They are text files with predefined filename SensLog<n>.txt, where <n>
indicates the connected sensor. Log files are stored on the internal memory, in the
directory /var/user/SensorLogging.
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Each log file contains the measured value (2 readings when you work with peak sen-
sors), the sensor type, and the measurement time (timestamp). Logged data is not
overwritten. When a new measurement is started, the collected logging data is appen-
ded in the log file.
Check the used disc space regularly and remove log files to maintain storage capacity.
Note: The logging function is intended for measurements with long time intervals. It is
suitable source for data reconstructions if the connection to the sensor was interrupted.
Remote command: 
:SENSe<ch>[:POWer]:LOGGing:STATe on page 558

8.4.4  NRP-Z power analysis

The NRP-Z power analysis functionality enables you to analyze the measured power of
a DUT in frequency, power or time domain. The instrument provides marker, graphic
and reference value functions.

8.4.4.1  Required options

The NRP-Z power analysis function requires the power analysis option installed on
your instrument, and a sensor that supports power analysis.

R&S SMA100B base unit equipped with the following option:
● Power Analysis (R&S SMAB-K28)

R&S NRP power sensors:
● R&S NRP-Z8x, referred to in the following description
● R&S NRP-Z91
● R&S NRP-Z211

For more information, see data sheet.

8.4.4.2  About

Characteristics and features of the NRP-Z power analysis function

The NRP-Z power analysis displays the measurement data graphically. The measure-
ment diagram covers up to four traces you can manually or automatically assign to one
or more connected power sensors. For evaluation of the readings, you can save a
defined reference trace or even freeze a reading temporarily on the screen. Markers
and mathematic functions enable you to compare particular values.

The NRP-Z power analysis supports three measurement modes:
● Power versus frequency (frequency response).

For this mode, all required generator settings are automatically configured except
for the power level. The power level setting of the generator is used for the fre-
quency sweep measurements.
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The frequency sweep settings are transferred to the sensor to automatically calcu-
late the correct measurement value for each frequency point.

● Power versus power (power sweep, AM/AM)
Power sweep measurements are executed using the frequency settings of the gen-
erator. Alternatively, the sensor can be adjusted to a frequency different from the
generator, see Use Separate Frequency- Power Analysis.
This frequency is transmitted to the sensor to automatically calculate the correct
measurement value.

● Power versus time (power measurement in the time domain, e.g. R&S NRP-Z8x
trace mode).
In the time mode, you can analyze the signal of the generator but also externally
supplied signals. This mode requires an additional trigger event, with selectable
level, hysteresis and drop time. Provided the sensor used supports the power mea-
surement of pulse signals, you can also analyze pulse data in time domain.

Characteristics of pulse data

For R&S NRP-Z8x power sensors that support time domain analysis and automatic
pulse analysis.

The power sensors enable pulse data analysis in measurement mode time. All impor-
tant pulse parameters are measured after setting the threshold levels. The following
graph shows most of these parameters:

The sensor calculates the pulse parameters from each measurement and delivers the
results to the R&S SMA100B.

The indication state of the parameters also affects the save function. Storing the mea-
surement diagram as hardcopy includes the parameters selected in this dialog.
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A total of 6 parameters can be indicated at one time. Structured hierarchically, trace 1
features top priority and trace 4 is addressed with the lowest weighting. This means
that only the first 6 checked parameters are indicated, starting with the settings of trace
1.
The pulse data is only visible for certain zoom levels of the diagram.

8.4.4.3  Accessing the NRP-Z Power Analysis functionality

Access:

► Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

9 58 6

2

4

3

1

7

Figure 8-5: Power analysis window

1 = Softkeys for accessing the "NRP-Z" the sensor settings dialogs
2 = Power analysis diagram
3 = Reference curve, indicated when active
4 = Progress bar indicated during measurement
5 = "Start Continuous / Stop" softkey to trigger the measurement
6 = Softkey for accessing the measurement settlings dialogs
7,8,9 = Softkeys for accessing the trace and marker settings dialogs

The start screen of the NRP-Z power analysis contains the measurement diagram
and labelled softkeys indicating connected power sensors. These softkeys and a
configuration softkey lead you to the dialogs for setting up the measurement and
sensor parameters, and for configuring the trace display in the diagram. You can
start or stop your measurement directly. During the measurement, the
R&S SMA100B shows the progress of the measurement in the progress bar at the
bottom of the diagram.
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Context-sensitive menu

A context-sensitive menu also provides access to the configuration dialogs and some
additional functions.

Access:

► Touch and hold a spot in the power analysis diagram for at least 1 second to
access the context-sensitive menu.

Figure 8-6: Power analysis context-sensitive menu

In the context-sensitive menu you can access:
● "Start Continuous/Stop": Triggers / stops the power analysis measurement

Note: During a measurement in the frequency domain, or the power domain
respectively, the displayed frequency/power value in the status bar (home screen)
does not correspond to the value applied at the output. Therefore, the
R&S SMA100B displays asterisks instead of the frequency or power value during
the measurement and indicates the original value again when the measurement is
completed or aborted.

● "Next Window (Hardkey)": Switches between the measurement views that are
enabled in the following order:
– "Standard View"
– "Marker View"
– "Pulse Data View"
– "Full Screen"
At least one viewing mode has to be selected. For details on the different view
modes, see "Next window list" on page 276.

● "Configure...": opens a dialog for configuring the power analysis measurement. See
Chapter 8.4.4.6, "NRP-Z configure settings", on page 255.

● "Trace/Markers...": opens a dialog for configuring the traces/marker. See Chap-
ter 8.4.4.5, "NRP-Z traces/markers settings", on page 249.

● "Save...(Power Analysis)": opens a dialog to save a hardcopy of the measurement.
See Chapter 8.4.4.7, "Creating screenshots of power analysis settings",
on page 280.

Power Analysis Diagram
Indicates the measurement results graghically, including configured markers, functions,
etc.
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Off / NRP-Zxx
Accesses the dialogs for configuring the traces and markers, see Chapter 8.4.4.5,
"NRP-Z traces/markers settings", on page 249

Configure...
Accesses the dialog for configuring the power analysis measurement, see Chap-
ter 8.4.4.6, "NRP-Z configure settings", on page 255.

Start Continuous / Stop
Starts and stops the power analysis measurement. Depending on the selected mea-
surement mode, the label varies.

8.4.4.4  Test setup example

As a power meter has no built-in selection, it is measuring all signal components from
nearly DC to 40 GHz and higher. Therefore, the DUT's signal must be rather pure or
subjected to external filtering (harmonics, spurious) before measured.

The test setup for the power analysis in the power versus frequency or power versus
power is as follows:

Figure 8-7: 

DUT = Device under test
PS = Power sensor, e.g. R&S NRP-Z8x, connected at the DUT's input and the USB connector of the

R&S SMA100B

1. Connect the DUT RF input to the RF output of the instrument.

2. Connect the DUT RF output to the power sensor.

3. Connect the power sensor to the signal generator.

4. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

5. Select "Configure" to open a dialog for setting up the measurement.

6. Select the power sensor, indicated at the bottom of the dialog to set the trace.

7. Select "Start Cont." to trigger the measurement.

8.4.4.5  NRP-Z traces/markers settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".
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2. Select power sensor indication located at the bottom of the dialog.

3. To access the trace settings, select the respective "Trace x" tab.

The measurement data can be current (sensor trace) or stored trace data. You can
store data either in a file (reference trace) or in a temporary memory (hold trace). Up to
four traces can be indicated at one time. On connection, the sensors are automatically
detected and assigned to a trace. By default, connected sensors are assigned to the
traces in ascending order, that means sensor 1 to trace 1, sensor 2 to trace 2, etc. If
the default trace is already used, the sensor has to be assigned manually in the trace
dialog.

Using the reference and hold traces, you can compare traces. Assign a reference
curve to one trace and your measured values to a second one, and switch on the dis-
play. With this feature you can compare results directly in the graph, or show the devia-
tions in a graph by using the "Mathematics - Trace Power Analysis" on page 251 func-
tion.

Example

The current single measurement of sensor 2 which is assigned to trace 2 is used as
reference trace.

1. Select "Trace 2" with "Indication" = "2 - NRP-Z81".

2. Select "Save To Ref".

3. Select "Trace 1" > "Indication > Ref".

4. Select "Diagram".

The R&S SMA100B indicates two identical traces.

5. Select "Start single".

Triggers a new measurement cycle with sensor 2. You can compare the resulting
measurement trace with the former measurement, which is displayed as reference
trace.
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Trace settings

Indication - Trace Power Analysis
Selects the source for the trace data.
The softkey label in the measurement diagram indicates the current selection.
"Off" No source is selected, the trace is not indicated.
"2 - NRP-Zxx" The current measurement results of the selected power sensor are

the source for the trace data. The index at the beginning of the sen-
sor name indicates the used connector, for example "2" indicates that
the sensor is connected via a USB interface. The data is either con-
tinuously updated (continuous measurement) or represents a single
measurement cycle (single measurement).

"Ref" Selects the reference trace. The reference trace is a static trace that
was stored in a file and can be recalled.
It is possible to store one reference trace at a time.

"Hold" Freezes the current trace data. The hold trace is a temporary trace
that is available until the power analysis is finished. Freezing the
trace of a sensor in one trace and displaying the measurement values
of the same sensor in another trace allows fast comparison between
measurements.

Remote command: 
:TRACe<ch>:FREQ:SWEep:SRC on page 536
:TRACe<ch>:POW:SWEep:SRC on page 536
:TRACe<ch>:TIME:SWEep:SRC on page 537
:TRACe<ch>[:POWer]:SWEep:STATe on page 543
:TRACe<ch>[:POWer]:SWEep:FEED on page 539

Color - Trace Power Analysis
Selects the color of the trace.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:COLor on page 537

Save to Ref - Trace Power Analysis
Saves the selected trace as reference trace. Only one reference trace is available at a
time.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:COPY on page 538

Define Reference - Trace Power Analysis
Opens a dialog for defining a linear reference curve, see "Define reference NRP-Z
analysis settings" on page 252.

Mathematics - Trace Power Analysis
Activates the mathematic function.
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The function enables you to determine the deviation of two test series, either of mea-
surement traces, or also of traces that contain math results or stored reference curves.
That means you can also assign a math result to an operand for further calculation.
Various nested computation steps are possible.
The math operation follows the formula:
T<ch>result = T<ch> Operand1 - T<ch>Operand2

How to proceed:
Determine T<ch> Operand1 in the entry field next to "Tx", and then select T<ch>Operand2 in
the second entry field right to it.
The result ("T<ch>result") is assigned to the above selected "Trace". If switched on, the
graph shows the resulting curve.
Note:
Depending on the type of trace, the instrument automatically sets the appropriate unit
on the y-axis:
● "dBm" if it shows only measurement traces.
● "dB" for purely mathematical curves.
● "dB/dBm" ratio scale for mixed display, that means measurements and mathemati-

cal curves.

Example: 
Example of a nested calculation.
● T1 shows the result of the subtraction of the trace ("Trace 1"), and the reference

curve.
● Trace2 subtracts Ref from T1.

That illustrates the nested calculation, since T1 covers already a math operation.
Note: "(Ind.)" denotes the currently selected trace.

Remote command: 
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:STATe on page 494
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:SUBTract on page 495
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:STATe on page 496
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:SUBTract on page 496
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:STATe on page 499
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:SUBTract on page 500

Define reference NRP-Z analysis settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select a power sensor at the bottom of the power analysis main screen.

The traces dialog opens.

3. Select a "Trace" tab.
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4. Select "Define Reference".

Figure 8-8: Defining the reference curve, e.g. in frequency mode

In this dialog, you can specifiy a linear reference curve for the measurement of the
corresponding trace. The measurement mode, selected with Configure measure-
ment settings, determines the parameters assigned to the x-axis and the y-axis in
the diagram.

The remote commands required to define these settings are described in Chap-
ter 14.15, "SENSe, READ, INITiate and SLISt subsystems", on page 546.

Freq (X)
For Configure measurement settings > "Frequency", sets the frequency values for
points A and B of the reference curve.
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:XVALues on page 513
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:XVAL on page 495

POW (Y)
For Configure measurement settings > "Frequency", sets the power values for points A
and B of the reference curve.
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:YVALues on page 513
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:YVAL on page 495

Pow (X)
For Configure measurement settings > "Power", sets the power values for points A and
B of the reference curve on the x-axis.
Remote command: 
:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:XVALues on page 525
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:XVAL on page 497
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Pow (Y)
For Configure measurement settings > "Power", sets the power values for points A and
B of the reference curve on the x-axis.
Remote command: 
:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:YVALues on page 525
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:YVAL on page 497

Time (X)
For Configure measurement settings > "Time", sets the time values for points A and B
of the reference curve on the x-axis.
Remote command: 
:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:XVALues on page 530
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:XVAL on page 500

Pow (Y)
For Configure measurement settings > "Time", sets the power values for points A and
B of the reference curve on the y-axis.
Remote command: 
:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:YVALues on page 530
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:YVAL on page 500

Save To Ref
Saves the selected trace as reference trace. One reference trace is available at a time.
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:COPY on page 512
:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:COPY on page 525
:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:COPY on page 530

Marker settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select a power sensor button at the bottom power analysis main screen.

The traces dialog opens.
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3. Select the "Markers" tab.

In this dialog, you can assign markers to the corresponding traces and activate
them for dsplay.

Trace - Power Analysis
Selects the trace the marker is assigned to.
Remote command: 
n.a.

Marker x Visible - Power Analysis
Selects if the respective marker and the marker list are shown in the diagram.
Remote command: 
n.a.

8.4.4.6  NRP-Z configure settings

The "Configure" dialog allows you to set measurement and sensor parameters.

● Configure measurement settings.......................................................................... 255
● Configure sensors settings....................................................................................259
● Configure diagram.................................................................................................263
● Configure time mode settings............................................................................... 264
● Trace settings........................................................................................................265
● Pulse data notifications settings............................................................................267
● Trigger settings..................................................................................................... 272
● Gate mode settings...............................................................................................274
● Next window list.................................................................................................... 276

Configure measurement settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".
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2. Select "Configure" > "Configure Measurement".

The measurement section provides the parameters for configuring the measurement
either in frequency, power or time domain. Depending on the measurement domain,
the settings vary.

Mode - Power Analysis
Selects the measurement mode.
"Frequency" Power versus frequency measurement (frequency response).
"Power" Power versus power measurement (power sweep, AM/AM).
"Time" Power versus time measurement (envelope power measurement as a

function of time, NRP trace mode). The R&S SMA100B samples
power over a time interval and assigns the internal power values that
have been determined to several points.
This mode also provides gated measurement and pulse data analy-
sis, e.g. with a connected R&S NRP-Z81, and the corresponding
graphical display "Gate View" and "Pulse Data View".

Remote command: 
:SENSe[:POWer]:SWEep:MODE on page 524

Min - Power Analysis
Sets the minimum frequency/power/time of the measurement.
The available frequency/power range depends on the frequency/power range of the
generator and the used power sensor.
The range for the start time is -1s to +1s. Value 0 defines the trigger point. By choosing
a negative time value, the trace can be shifted in the diagram.
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It is possible, that the measurement cannot be performed over the complete time range
because of limitations due to sensor settings. In this case, the R&S SMA100B gener-
ates an error message.
If you change this value for a finished single measurement, only the scaling of the x-
axis changes. This way, you can zoom the trace. However, for subsequent measure-
ments, the measurement range is changed according to the new setting.
If you change this value during a continuous measurement, only the scaling of the x-
axis changes for measurement cycles that have been triggered before the change. For
subsequent measurement cycles, the measurement range changes according to the
new setting.
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:STARt on page 514
:SENSe[:POWer]:SWEep:POWer:STARt on page 526
:SENSe[:POWer]:SWEep:TIME:STARt on page 531

Max - Power Analysis
Sets the maximum frequency/power/time of the measurement.
The available frequency/power range depends on the frequency/power range of the
instrument and the used power sensor.
The range for the stop time is 0 s to 2 s. Value 0 defines the trigger point.
It is possible, that the measurement cannot be performed over the complete time range
because of limitations due to sensor settings. In this case, an error message is output.
If you change this value for a finished single measurement, only the scaling of the x-
axis changes. This way, you can zoom the trace. However, for subsequent measure-
ments the measurement range is changed according to the new setting.
If you change this value during a continuous measurement, only the scaling of the x-
axis changes for measurement cycles that have been triggered before the change. For
subsequent measurement cycles, the measurement range changes according to the
new setting.
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:STOP on page 514
:SENSe[:POWer]:SWEep:POWer:STARt on page 526
:SENSe[:POWer]:SWEep:TIME:STOP on page 532

Steps - Power Analysis
Sets the number of steps for the sweep. The number of measured points is steps + 1.
The number of steps is one of the parameters that define the measurement speed. The
higher the number of steps, the longer the measurement takes (frequency and power
mode).
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:STEPs on page 514
:SENSe[:POWer]:SWEep:POWer:STEPs on page 526
:SENSe[:POWer]:SWEep:TIME:STEPs on page 531

Timing - Power Analysis
Selects the timing mode in frequency or power domain.
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This parameter is only available for Configure measurement settings > "Fre-
quency"/"Power".
"Fast" Fast measurement with an integration time of 2 ms for each measure-

ment step.
"Normal" A longer but more precise measurement (integration time is 20 ms/

step).
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:TIMing[:MODE] on page 514
:SENSe[:POWer]:SWEep:POWer:TIMing[:MODE] on page 527

Average - Power Analysis
Selects the averaging factor in time domain.
The factor determines how many measurement cycles are used to form a measure-
ment result. Higher averaging counts reduce noise but increase the measurement
time. Averaging requires a stable trigger event so that the measurement cycles have
the same timing. If factor 1 is selected, no averaging is performed.
This parameter is only available for Configure measurement settings > "Time".
Remote command: 
:SENSe[:POWer]:SWEep:TIME:AVERage[:COUNt] on page 529

Spacing - Power Analysis
Sets the mode for calculating the sweep steps.
In power versus frequency mode, selection between linear and logarithmic spacing is
possible.
"Linear" ● Power versus frequency

In a linear sweep, the frequency is swept in equidistant steps over
the continuous frequency range. The x-axis is a linear frequency
axis.

● Power versus power
The sweeps are performed at constant frequency but with vari-
able generator power that is swept in linear, equidistant steps
over a continuous range. The x-axis is a dB-linear power axis.

● Power versus time
The sweeps are performed at constant frequency and stimulus
power. The measurement is repeated over a specified period of
time at constant time intervals.

"Logarithmic" Power versus frequency
In a logarithmic sweep, the frequency is swept in equidistant steps on
a logarithmic scale. The x-axis is a logarithmic frequency axis.

Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:SPACing[:MODE] on page 513
:SENSe[:POWer]:SWEep:POWer:SPACing[:MODE] on page 526
:SENSe[:POWer]:SWEep:TIME:SPACing[:MODE] on page 531

Execution - Power Analysis
Selects single or continuous mode in power analysis.
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The measurement is started in the diagram using the "Start" button. During measure-
ment, the "Start" button is replaced by a "Stop" button which can be used to abort the
measurement. The progress bar indicates the status of the measurement.
"Single" Selects single measurement.
"Cont." Selects continuous measurements.
Remote command: 
:SENSe[:POWer]:SWEep:RMODe on page 529
:SENSe[:POWer]:SWEep:POWer:RMODe on page 526
:SENSe[:POWer]:SWEep:FREQuency:RMODe on page 513
:SENSe[:POWer]:SWEep:TIME:RMODe on page 531

All Trigger Events - Power Analysis
Selects the trigger mode for measurements in the time domain.
The measurement data processing starts with a trigger event in one of the sensors
(Logical OR), or when all channels are triggered (logical AND). Each sensor evaluates
a trigger event according to its setting independently.
This function supports the internal or external trigger modes with multi-channel time
measurements.
"Wired AND" The measurement starts when all channels are triggered.
"Wired OR" The measurement starts when a trigger event occurs.
Remote command: 
:SENSe[:POWer]:SWEep:TIME:TEVents on page 532

Configure sensors settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Sensors"
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The "Configure Sensors" dialog provides specific parameters for the power sensor.
This part of the dialog can differ from the following description depending on the sensor
used. Refer to the manual of the power sensor in this case.

Power Sensor - Power Analysis
Selects the power sensor to be set if more than one sensor is connected to the instru-
ment.
Remote command: 
n.a.
In remote control, the sensor is selected via the numeric suffix in the sense key word of
the command, for example SENSe2:POWer:SWEep:….

Zero - Power Analysis
Activates the auto zero function.
Zeroing calibrates the external power sensor by adjusting its reading at zero signal
power. For this purpose, the RF power source must be switched off or disconnected
from the sensor. If a Rohde & Schwarz power sensor receives an input power during
the zeroing process, it aborts zeroing and generates an error message. Zeroing takes
a few seconds, depending on the sensor model. Refer to the documentation of your
power sensor for more information.
Tips for zeroing
When to perform zeroing:
● During warm up after switching on or connecting the instrument
● After a substantial change of the ambient temperature
● After fastening the power sensor module to an RF connector at high temperature
● After several hours of operation
● When low-power signals are to be measured, e.g. less than 10 dB above the lower

measurement limit.
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● Switch off the RF power source for zeroing, but do not disconnect it from the power
sensor. This proceeding keeps the thermal equilibrium, and the zeroing process
also compensates the noise that superimposes the measured signal (e.g. from a
broadband amplifier).

Pulse Data
Accesses the dialog for configuring the settings for pulse data analysis.
See "Trace settings" on page 265.

Trigger..
Accesses the dialog for configuring the trigger settings.
See "Trigger settings" on page 272

Level Offset State- Power Analysis
Activates a level offset at the sensor input. Set the offset value in the entry field on the
right.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:OFFSet:STATe
on page 504
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet:STATe on page 507
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet:STATe on page 507

Level Offset - Power Analysis
Sets the level offset at the sensor input. To consider the value, activate the offset.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:OFFSet on page 504
:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:OFFSet on page 506
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet on page 507

Use S-Parameter - Power Analysis
Activates the use of the S-parameters correction data of the connected power sensor.
For sensors with attenuator, this checkbox is automatically checked.
Refer also to the manual of the connected R&S power sensor for a description on how
to use the S-parameters table.

Use Separate Frequency- Power Analysis
This setting is offered for measurements with DUTs that change the measurement fre-
quency (like modulators), thus changing the input frequency of the sensor.
The parameters vary depending on the measurement modes:
● Power versus frequency measurement

Activates the use of a different frequency range other than the set signal generator
frequency range for the measurement. The separate minimum and maximum fre-
quency values are set below.
The x-scale of the diagram can be adjusted to the separate frequency range with
functions "Use as X Scale" and "Map to X Scale".

● Power versus power measurement / Power versus time measurement
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Activates the use of a different frequency other than the set signal generator fre-
quency for the measurement. The separate frequency value is set in the entry win-
dow below.

Remote command: 
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge[:STATe]
on page 505
:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:SFRequency:STATe
on page 507
:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:SFRequency on page 506
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:SFRequency:STATe
on page 510
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:SFRequency on page 509

Min Frequency - Power Analysis
This parameter is only available for Configure measurement settings > "Frequency"
and Use Separate Frequency- Power Analysis > "Active".
Sets the minimum frequency of the measurement.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge:STARt
on page 504

Max Frequency - Power Analysis
This parameter is only available for Configure measurement settings > "Frequency"
and Use Separate Frequency- Power Analysis > "Active".
Sets the maximum frequency of the measurement.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge:STOP
on page 505

Use as X Scale - Power Analysis
This parameter is only available for Configure measurement settings > "Frequency"
and Use Separate Frequency- Power Analysis > "Active".
Activates the use of the separate frequency min and max values for the scaling of the
x-axis. Thus, the trace for this sensor is visible in the diagram , especially for frequency
ranges that differ substantially from the generator settings.
If more than one sensor is active, which use separate frequencies, the option is only
available for one sensor. To indicate the traces of the other sensors, use function "Map
to X Scale".
Remote command: 
n.a.

Map to X Scale - Power Analysis
This parameter is only available for Configure measurement settings > "Frequency"
and Use Separate Frequency- Power Analysis > "Active".
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Maps the trace of a sensor that uses separate frequency to the current scaling of the
diagram. Usually the scale is determined by the set frequency range of the generator. If
more than one sensor is active, which use separate frequencies, the scale can also be
determined by the separate frequency range of one of the other sensors.
Remote command: 
n.a.

Configure diagram

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Diagram"

The "Configure Diagram" covers the parameters for scaling the y-axis and the appear-
ance of the diagram.

Min - Max Level - Power Analysis
Selects the minimum and maximum value of the y-axis.
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:YSCale:MAXimum on page 516
:SENSe[:POWer]:SWEep:FREQuency:YSCale:MINimum on page 516
:SENSe[:POWer]:SWEep:POWer:YSCale:MAXimum on page 528
:SENSe[:POWer]:SWEep:POWer:YSCale:MINimum on page 529
:SENSe[:POWer]:SWEep:TIME:YSCale:MAXimum on page 533
:SENSe[:POWer]:SWEep:TIME:YSCale:MINimum on page 534

Auto Scale - Power Analysis
Activates autoscaling of the y-axis of the diagram. The "Auto Scale" function adjusts
the scale divisions so that the entire trace fits into the diagram area.
"Off" Auto scale is deactivated. Switching from activated to be deactivated,

the scaling is maintained.
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"Expand Only (Coarse/Fine)"
Auto scale is activated. Automatically selects the appropriate scaling
of the y-axis so that the trace is always visible. The range is expan-
ded when a value is out of the right or the left end-of-scale value. The
step width is 5 dB for selection "Exp. (Coarse)" and variable in the
range of 0.2 db to 5 dB for selection "Exp. (Fine)".

"Float (Coarse/Fine)"
Auto scale is activated, that means this parameter automatically
selects the appropriate scaling of the y-axis so that the trace is
always visible. The range is either expanded, when a value is out of
the right/left end-of-scale value or it is reduced when the trace fits into
a smaller scale area. The step width is 5 dB for selection "Flt.
(Coarse)" and variable in the range of 0.2 db to 5 dB for selection "Flt.
(Fine)".

Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:YSCale:AUTO on page 515
:SENSe[:POWer]:SWEep:POWer:YSCale:AUTO on page 527
:SENSe[:POWer]:SWEep:TIME:YSCale:AUTO on page 532

Reset Auto Scale - Power Analysis
Resets the scaling of the y-axis to suitable values after the use of auto scaling in the
expanding mode. For this mode, the Y scale can get too expanded because of tempo-
rary high-power values. The reset function resets the diagram again, to indicate
smaller power values.
Remote command: 
:SENSe[:POWer]:SWEep:FREQuency:YSCale:AUTO:RESet on page 515
:SENSe[:POWer]:SWEep:POWer:YSCale:AUTO:RESet on page 528
:SENSe[:POWer]:SWEep:TIME:YSCale:AUTO:RESet on page 533

Show Grid - Power Analysis
Activates the indication of a grid in the diagram area.
Remote command: 
:DISPlay[:WINDow][:POWer]:SWEep:GRID:STATe on page 501

Background Color - Power Analysis
Sets the background color of the diagram to black or white. The background color is
also effective for the hardcopy of the diagram.
Remote command: 
:DISPlay[:WINDow][:POWer]:SWEep:BACKground:COLor on page 501

Configure time mode settings

The time measurement mode enables you to analyze internally generated or externally
supplied signals. I time mode, the measurement requires an additional trigger event,
with selectable level, hysteresis and drop time. In time domain, you can also analyze
measured pulse data.
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Trace settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Measurement".

3. Set "Mode" > "Time".

4. Select "Configure Time Mode"

5. Select the "Trace" tab.

The "Trace" tab contains the parameters for the evaluation of important pulse
parameters, provided the used power sensor supports automatic pulse analysis.

Trace
Selects the trace the sensor is assigned to.
To assign a sensor to a trace, use the trace buttons, see Off / NRP-Zxx.

Indication
Indicates the type of power sensor assigned to the selected trace. This field is auto-
matically updated if the sensor is connected or disconnected. Also, this sensor is indi-
cated on the trace button in the measurement diagram.
This parameter is only available for Configure measurement settings > "Time".
Remote command: 
n.a.
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Pulse Analysis
Activates pulse data analysis.
To start the automatic pulse analysis, select "Start Cont." button in the main measure-
ment diagram.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:STATe on page 508

All Annotations Off
Indicates the state of the annotations.
Remote command: 
n.a.

Base
Selects the calculation basis for the threshold parameters.
"Voltage related"

Calculates the pulse parameters rise/fall time and pulse width by the
voltage over time U(t).
Voltage-related parameters represent the usual case.

"Power related"
Represents the pulse parameters as power values.
To obtain equivalent power-dependent values, the voltage-dependent
threshold values are converted (squared), (see example in table
below).

 Distal Mesial Proximal

Voltage related: 90% 50% 10%

Power related: 81% 25% 1 %

    

log. Scale (for example):

(approximately, difference between top- base
power > 30 dB )

-0.9dB -6dB -20dB

Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:BASE
on page 508
:TRACe<ch>[:POWer]:SWEep:PULSe:THReshold:BASE? on page 542

Distal
Sets the upper reference level in terms of percentage of the overall pulse level (power
or voltage related). The distal power defines the end of the rising edge and the start of
the falling edge of the pulse.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:
HREFerence on page 508
:TRACe<ch>[:POWer]:SWEep:PULSe:THReshold:POWer:HREFerence
on page 542
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Mesial
Sets the medial reference level in terms of percentage of the overall pulse level (power
or voltage related). This level is used to define the pulse width (τ) and pulse period.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:
REFerence on page 509
:TRACe<ch>[:POWer]:SWEep:PULSe:THReshold:POWer:REFerence
on page 543

Proximal
Sets the lower reference level in terms of percentage of the overall pulse level (power
or voltage related).
The proximal power defines the start of the rising edge and the end of the falling edge
of the pulse.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:
LREFerence on page 509
:TRACe<ch>[:POWer]:SWEep:PULSe:THReshold:POWer:LREFerence
on page 543

Pulse data notifications settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Measurement".

3. Set "Mode" > "Time".

4. Select "Configure Time Mode"
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5. Select the "Pulse Data notifications" tab.

In the "Pulse Data Notification" tab, you can determine the parameter values to be
indicated on bottom of the diagram.

Notifications - Pulse Data Analysis
Selects the pulse parameters to be indicated below the measurement diagram.
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Duty Cycle ← Notifications - Pulse Data Analysis
Indicates the ratio between the pulse duration (τ) and the pulse period (T) of the mea-
sured pulse signal in per cent:
Duty Cycle = (pulse duration / pulse period) * 100
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:DCYCle? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:DCYCle:DISPlay:
ANNotation[:STATe] on page 541

Pulse Width ← Notifications - Pulse Data Analysis
Indicates the pulse duration of the pulse data measurement in seconds.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:DURation? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:DURation:DISPlay:
ANNotation[:STATe] on page 541

Pulse Period ← Notifications - Pulse Data Analysis
Indicates the time the pulse signal needs to complete one cycle.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:PERiod? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:PERiod:DISPlay:
ANNotation[:STATe] on page 541

Pulse Off Time ← Notifications - Pulse Data Analysis
Determines the time the pulse signal is low, that means as long as the signal level is
below the proximal value.
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Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:SEParation? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:PERiod:DISPlay:
ANNotation[:STATe] on page 541

Transition Times - Pulse Data Analysis
Selects the transition parameters of the pulse signal to be indicated below the mea-
surement diagram.
The R&S NRP-Z sensor searches for the first rising edge and the first falling edge in
the trace.

Rise Time / Fall Time ← Transition Times - Pulse Data Analysis
Displays the time the signal requires from crossing low reference until it reaches high
reference level and vice versa.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:
DURation? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:
DURation:DISPlay:ANNotation[:STATe] on page 541
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:
DURation? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:
DURation:DISPlay:ANNotation[:STATe] on page 541

Pulse Start Time / Pulse Stop Time ← Transition Times - Pulse Data Analysis
Displays the time when the pulse signal crosses the medial reference level.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:
OCCurrence? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:
OCCurrence:DISPlay:ANNotation[:STATe] on page 541
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:
OCCurrence? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:
OCCurrence:DISPlay:ANNotation[:STATe] on page 541

Overshoot (Rising Edge / Falling Edge) ← Transition Times - Pulse Data Analysis
Display the maximum value of the pulse signal following a rising transition and the min-
imum value of the signal after a falling transition, respectively.
Overshoot values are given in per cent of the pulse amplitude as shown below:
● Overshoot(pos) = 100* (maximum - top level ) / (top level - base level)
● Overshoot(neg) = 100* (base level - minimum) / (top level - base level)
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:
OVERshoot? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:
OVERshoot:DISPlay:ANNotation[:STATe] on page 541
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:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:
OVERshoot? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:
OVERshoot:DISPlay:ANNotation[:STATe] on page 541

Signal Power - Pulse Data Analysis
Selects the power parameters of the pulse signal to be indicated below the measure-
ment diagram.

Minimal / Peak / Average Power ← Signal Power - Pulse Data Analysis
Display the minimum, the maximum and the average power of the pulse signal in dBm.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:MINimum? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:MINimum:DISPlay:
ANNotation[:STATe] on page 541
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:MAXimum? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:MAXimum:DISPlay:
ANNotation[:STATe] on page 541
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:AVERage? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:AVERage:DISPlay:
ANNotation[:STATe] on page 541

Pulse Power - Pulse Data Analysis
Selects which pulse power parameters are indicated in the diagram (pulse data view
only).

Top / Base Power ← Pulse Power - Pulse Data Analysis
Indicate the pulse top and base level of the analyzed signal in dBm.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:PULSe:BASE? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:PULSe:BASE:DISPlay:
ANNotation[:STATe] on page 541
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:PULSe:TOP? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:PULSe:TOP:DISPlay:
ANNotation[:STATe] on page 541

Distal / Mesial / Proximal Power ← Pulse Power - Pulse Data Analysis
Display the absolute power values of the medial, low and high reference level in dBm.
Remote command: 
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:LREFerence? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:LREFerence:DISPlay:
ANNotation[:STATe] on page 541
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:HREFerence? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:HREFerence:DISPlay:
ANNotation[:STATe] on page 541
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:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:REFerence? on page 540
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:REFerence:DISPlay:
ANNotation[:STATe] on page 541

Trigger settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Measurement".

3. Set "Mode" > "Time".

4. Select "Configure Time Mode"

5. Select the "Trigger" tab.

Sensor - Power Analysis
Selects the power sensor to be set if more than one sensor is connected to the instru-
ment.
Remote command: 
n.a.
In remote control, the sensor is selected via the numeric suffix in the sense key word of
the command, for example SENSe2:POWer:SWEep:….

Mode - Power Analysis
Selects if the measurement is free running, or starts only after an internal or external
trigger event.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:SOURce on page 511
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Level - Power Analysis
Sets the trigger threshold. This setting is also possible by the trigger marker on the left
side of the diagram.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:LEVel on page 511

Slope - Power Analysis
Sets the polarity of the active slope of the trigger signals.
"Positive" The rising edge of a trigger signal is active.
"Negative" The falling edge of a trigger signal is active.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:SLOPe on page 511

Hysteresis - Power Analysis
Sets the hysteresis of the internal trigger threshold. Hysteresis is the magnitude (in dB)
the trigger signal level must drop below the trigger threshold (positive trigger slope)
before triggering can occur again.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:HYSTeresis
on page 510

Drop out Time - Power Analysis
Determines the minimum time for which the signal must be below (above) the power
level defined by Level - Power Analysis and Hysteresis - Power Analysis before trigger-
ing can occur again. This setting prevents the trigger system from being activated too
early if the trigger threshold is temporarily underranged or exceeded.
The dropout time parameter is useful when dealing with, for example, GSM signals
with several active slots. When measuring in sync with the signal, a trigger event must
be generated at A, but not at B or C. As the RF power between the slots is below the
threshold defined by Level - Power Analysis and Hysteresis - Power Analysis, the trig-
ger hysteresis cannot prevent triggering at B or at C. To achieve triggering at A, the
value of the drop out time must be greater than the time interval between E and B and
between F and C. But it must be lower than the time that elapses between G and A.
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As the mechanism associated with the dropout time parameter is reactivated whenever
the trigger threshold is crossed, unambiguous triggering can also be obtained for many
complex signals. By contrast, all triggering is suppressed during the hold-off time. The
example nevertheless shows that you can achieve stable triggering. conditions with a
suitable hold-off time, i.e. regular triggering at the same point. But setting a trigger that
occurs at A exclusively is not possible.
it would not be possible to set exclusive triggering at A . But you cannot set a trigger
that occurs exclusively at A.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:DTIMe on page 510

Auto Set - Power Analysis
Sets the trigger level, the hysteresis and the drop out time to default values.
Remote command: 
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:AUTO on page 510

Gate mode settings

For "Time" measurement mode only.

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Measurement".

3. Set "Mode" > "Time".

4. Select "Configure Time Mode"
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5. Select the "Gate Mode" tab.

The "Gate Mode" tab contains the parameters for defining the time gates for the
measurement.

Almost all R&S NRP sensors also support time gated measurements of peak and aver-
age power (see the data sheet or operating manual of the respective sensor). Two
user-configurable gates can be assigned to one of the traces. Both gates are active at
the same time. The values are calculated from the trace data, the time resolution is
determined by the resolution of the sensor. An external trigger signal or signal trigger-
ing is required for synchronization.

The start and stop time of the gates are indicated as gate markers, a bar between the
start and stop marker shows the gate length. The indication state of the gate borders
and measurement values is only available for certain diagram views which are
switched with the "Next Window List" key. The "Next Window List" dialog provides a
selection of views, between which is toggled (see "Next window list" on page 276 ).

Trace - Gate
Selects the trace of the sensor assigned for the gate measurement. Both gates are
assigned to the same trace.
To assign the sensor to a trace, use the trace buttons, see Off / NRP-Zxx.
Remote command: 
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:FEED on page 498

Indication
Indicates the type of power sensor assigned to the selected trace. This field is auto-
matically updated if the sensor is connected or disconnected. Also, this sensor is indi-
cated on the trace button in the measurement diagram.

Using power sensors



Improving level performanceR&S®SMA100B

276User Manual 1178.3834.02 ─ 09

This parameter is only available for Configure measurement settings > "Time".
Remote command: 
n.a.

State - Gate
Enables time gated measurement. The measurement is started with the "Start" button
in the main measurement diagram. Both gates are active at one time.
The gate borders and the measurement values (average and peak power) are indica-
ted in/below the measurement diagram. The indication is only available for certain dia-
gram views which are switched with the "Rearrange" key.
Remote command: 
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STATe on page 499
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:AVERage? on page 497
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:MAXimum? on page 498
:TRACe[:POWer]:SWEep:MEASurement:GATE:DISPlay:ANNotation[:STATe]
on page 544

Start / Stop - Gate
Sets the start and the stop times for the respective gate.
Remote command: 
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STARt on page 499
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STOP on page 499

Next window list

Access:

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Next Window List"
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The "Next Window List" dialog provides functions to activate only the required
"Views" on the checkboxes to the right.

Standard View
Shows the graph and the button bar at the left for frequency power and level sweep
measurement.

Remote command: 
:TRACe[:POWer]:SWEep:MEASurement:STANdard:DISPlay:ANNotation[:
STATe] on page 545

Marker View
Shows the graph and the corresponding marker values at the bottom for frequency
power and level sweep measurement.
Up to four markers can be used to display the current power according to the position
of the marker. R&S SMA100B indicates the marker values on the bottom of the dia-
gram.
To move the marker lines, you can select them and drag them with your finger. Alterna-
tively you can move them with the rotary knob.
For details on configuring the markers, see "Marker settings" on page 254.
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Remote command: 
:TRACe[:POWer]:SWEep:MEASurement:MARKer:DISPlay:ANNotation[:
STATe] on page 545

Gate View
Shows the graph with the corresponding gate data for time trace and pulse data mea-
surements.
Remote command: 
:TRACe[:POWer]:SWEep:MEASurement:GATE:DISPlay:ANNotation[:STATe]
on page 544

Pulse Data View
Shows the graph and the corresponding pulse data for time trace and pulse data mea-
surements.
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Remote command: 
:TRACe[:POWer]:SWEep:MEASurement:PULSe:DISPlay:ANNotation[:
STATe] on page 545

Full Screen
Shows the graph in fullscreen, and fades out buttons and list values for frequency
power and level sweep measurement.

Remote command: 
:TRACe[:POWer]:SWEep:MEASurement:FULLscreen:DISPlay:ANNotation[:
STATe] on page 544
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8.4.4.7  Creating screenshots of power analysis settings

The power analysis save function enables you to save current settings in a file. To
document the most important settings for a performed signal generation, you can also
save a hardcopy of the current display.

Save (Power analysis) settings

In the "Save …" dialog you can find the settings to store a screenshot of the current
measurement diagram. The current screen shot is stored as indicated, that means with
or without marker indication.

Main settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP Power Analysis".

2. In the diagram window, open the context-sensitive menu.

3. In the menu, select "Save... (Power Analysis)".

File name - Power Analysis
Indicates the file name and directory.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy[:EXECute] on page 524
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME] on page 520

Using power sensors



Improving level performanceR&S®SMA100B

281User Manual 1178.3834.02 ─ 09

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:STATe on page 521
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:FILE? on page 521

Format - Power Analysis
Selects the file format.
Several bitmap graphic formats are offered. In addition, format *.csv is available
which stores the measurement values as ASCII data.
You can refine the csv settings further, see "CSV options" on page 283.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage on page 518

Options
Opens a dialog to select the screenshot format and also to activate and select the
automatic naming settings.

Common settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP Power Analysis".

2. In the diagram window, open the context-sensitive menu.

3. In the menu, select "Save... (Power Analysis)".

4. Select "Options".

Automatic Naming
If enabled, the file names are created by selected rules. The filename includes at least
one number and optionally additional information.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:STATe on page 521

Format - Power Analysis
Selects the file format.
Several bitmap graphic formats are offered. In addition, format *.csv is available
which stores the measurement values as ASCII data.
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You can refine the csv settings further, see "CSV options" on page 283.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage on page 518

Automatic naming settings

Access:

1. Select "Clk Syn/Power Sens" > "NRP Power Analysis".

2. In the diagram window, open the context-sensitive menu.

3. In the menu, select "Save... (Power Analysis)".

4. Select "Options".

5. In the "Save NRP-Z Analysis Options" dialog, enable "Automatic Naming."

Path
Sets the directory for saving the files.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:DIRectory on page 520

Clear Parth
Deletes all image files with extensions "bmp", "img", "png", "xpm" and "csv" in the
directory set for automatic naming.
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Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar
on page 520

Prefix, Year, Month, Day, Instrument Name
A selection of the prefix, year, month, day and instrument name are included in the file
name.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe
on page 523
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix
on page 523
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe
on page 522
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY?
on page 521
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe
on page 522
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh?
on page 522
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe
on page 524
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR?
on page 523

Current Auto Number
Indicates the number which is used in the automatically generated file name.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?
on page 523

Resulting File Name
Indicates the automatically generated file name.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:FILE? on page 521

CSV options

Access:

1. Select "Clk Syn/Power Sens" > "NRP Power Analysis".

2. In the diagram window, open the context-sensitive menu.

3. In the menu, select "Save... (Power Analysis)".

4. Set "Format" > "CSV".

5. Select "Options".
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6. Select the "CSV Options" tab.

If file format *.csv is selected, the trace data is saved as an ASCII file with separated
values. CSV files can be imported into the program MS Excel and then processed fur-
ther. Adjust the value separator and the decimal point according to the language ver-
sion, to import the data correctly.

Orientation
Defines the orientation of the X/Y value pairs:
● Horizontal:

X/Y values of trace 1 in rows 1 and 2,
X/Y values of trace 2 in rows 3 and 4,
X/Y values of trace 3 in rows 5 and 6,
X/Y values of trace 4 in rows 7 and 8.

Example: 
Trace1,X[Hz]: 10000.0; 10010.0; 10020.0; 10030.0; ...
Trace1,Y[dBm]: -20.09; -19.17; -18.19; -15.43; ...
Trace2,X[Hz]: 10000.0; 10010.0; 10020.0; 10030.0; ...
Trace2,Y[dBm]: -19.09; -18.17; -17.19; -14.43; ...
Trace3,X[Hz]: 10000.0; 10010.0; 10020.0; 10030.0; ...
Trace3,Y[dBm]: -21.09; -20.17; -19.19; -16.43; ...
Trace4,X[Hz]: 10000.0; 10010.0; 10020.0; 10030.0; ...
Trace4,Y[dBm]: -22.07; -20.14; -21.56; -17.67; ...
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● Vertical:
X/Y values of trace 1 in column 1 and 2,
X/Y values of trace 2 in column 3 and 4,
X/Y values of trace 3 in column 5 and 6,
X/Y values of trace 4 in column 7 and 8.

Example: 
Trace1,X[Hz]; Trace1,Y[dBm]; Trace2,X[Hz]; Trace2,Y[dBm]; Trace3,X[Hz];
Trace3,Y[dBm]; Trace4,X[Hz]; Trace4,Y[dBm];
10000.0;-20.09;10000.0; -19.09;10000.0;21.09;10000.0;22.07;
10010.0;-19.17;10010.0;-18.17;10010.0; -20.17;10010.0; -20.14;
10020.0;-18.19;10020.0;-17.19;10020.0;-19.19;10020.0;-21.56;
10030.0; -15.43;10030.0; -14.43;10030.0;-16.43;10030.0;-17.67;...

Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:ORIentation
on page 519

Separator
Defines the character to be used to separate the values: tabulator, semicolon, comma
or blank.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV[:COLumn]:
SEParator on page 519

Decimal Point
Defines the character to be used as the decimal point of the values: dot or comma.
Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:DPOint on page 518

Row Header
Defines a header for each row or column, depending on the orientation. A header con-
tains information on the trace, e.g. the trace index, or frequency, power or time values.

Example: 
Trace=2;Source=detecting..;X[Hz]";"Trace=2;Source=detecting..;Y[dBm]"

Remote command: 
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:HEADer on page 518

How to save a hardcopy of the power analysis window

1. Select "Clk Syn/Power Sens" > "NRP Power Analysis".

2. In the diagram window, open the context-sensitive menu.

3. In the menu, select "Save... (Power Analysis)".
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4. To define the output format, select "Format > JPG".

5. Select "Options...".

6. To enable the instrument to create output filenames, select "Automatic Naming >
On".

7.

In the "Automatic Naming" tab:
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a) To change the default directory the file is saved in, select " Path" and define a
path and a filename. For example, select the default directory /var/user.

b) If necessary, disable or change some of the parameters in the "Automatic Nam-
ing Settings".

c) Close the "Save NRP-Z Analysis Options" dialog.

8. In the "Save NRP-Z Analysis" dialog, select "Save".

The instrument saves a hardcopy of the current instrument display as a *.jpg file.
The filename is automatically created.

9. To print the hardcopy, connect the instrument to a LAN and:

a) Transfer the file to a remote computer as described in Chapter 11.9, "How to
transfer files from and to the instrument", on page 330.

b) On the remote computer, navigate through the file system.
c) Print the selected file.

For more information, refer to the online help of the operating system.

8.4.4.8  How to set up a frequency sweep measurement

Prerequisites: the sensor is connected to the instrument and configured, see Chap-
ter 8.4, "Using power sensors", on page 233.

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Measurement".

3. Set "Mode" > "Frequency".

4. Configure the measurement:

a) Set "Min = 8 KHz".
b) Set "Max = 6 GHz".
c) Set "Steps = 200".

5. Select the "Configure Diagram" tab.
Ho to: see Chapter 8.4.4.11, "How to configure the power analysis diagram",
on page 289.

6. Select the "Configure Sensors" tab.

7. Select the connected sensor, e.g. "2-NRP-Z81".

8. If you want to configure the frequency settings of the sensor differently than the
generator settings, enable "Use Separate Frequ.".

a) Set "Min = 1 MHz".
b) Set "Max =10 MHz".

9. In the "Next Window List" tab, enable the "Standard View".

10. Close the "Configure" dialog.
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11. Press "Start Cont" to start the measurement.

8.4.4.9  How to set up a power sweep measurement

Prerequisites: the sensor is connected to the instrument and configured, see Chap-
ter 8.4, "Using power sensors", on page 233.

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Measurement".

3. Set "Mode" > "Power".

4. Configure the measurement:

a) Set "Min = -20 dBm".
b) Set "Max = 30 dBm".
c) Set "Steps = 200".

5. Select the "Configure Diagram" tab.
Ho to: see Chapter 8.4.4.11, "How to configure the power analysis diagram",
on page 289.

6. Select the "Configure Sensors" tab.

7. Select the connected sensor, e.g. "2-NRP-Z81".

8. If you want to configure the frequency settings of the sensor differently than the
generator settings, enable "Use Separate Frequ.".

a) Set "1 MHz".

9. In the "Next Window List" tab, enable the "Standard View".

10. Close the "Configure" dialog.

11. Press "Start Cont" to start the measurement.

8.4.4.10  How to set up a pulse measurement

Prerequisites: the sensor is connected to the instrument and configured, see Chap-
ter 8.4, "Using power sensors", on page 233.

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Measurement".

3. Set "Mode" > "Time".

4. Configure the measurement:

a) Set "Min = -5 us".
b) Set "Max = 45 us".
c) Set "Steps = 200".
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5. Select the "Configure Diagram" tab.
How to: see Chapter 8.4.4.11, "How to configure the power analysis diagram",
on page 289.

6. Select the "Configure Sensors" tab.

7. Select the connected sensor, e.g. "2-NRP-Z81".

8. In the "Next Window List" tab, enable the "Pulse Data View".

9. Close the "Configure" dialog.

10. In the diagram window, open the context-sensitive menu.

11. Select "Trace/Pulse Data Notifications/ Trigger".

12. Select the "Trace" tab.

13. Set "State > On".

14. Set the thresholds:

a) Set "Base > Voltage Related".
b) Set "Distal = 90%".
c) "Mesial = 50%".
d) "Proximal = 10%".

15. Select the "Pulse Data Notifications" tab.

16. Enable up to six parameters, for example:

● "Duty Cycle"
● "Pulse Width"
● "Pulse Period"
● "Off Time"
● "Start Time"

17. Close the "Trace/Pulse Data Notifications/ Trigger" dialog.

18. Press "Start Cont" to start the measurement.

8.4.4.11  How to configure the power analysis diagram

1. Select "Clk Syn/Power Sens" > "NRP-Z Power Analysis".

2. Select "Configure" > "Configure Diagram".

3. Set "Max Level = 30 dBm".

4. Set "Min Level = -40 dBm".

5. Select "Auto Scale > Expand Only (Coarse)".

6. Enable "Show Grid".

7. Set "Background Color > Black."
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8.5  How to calibrate the power level with an R&S NRP
power sensor

Using a R&S NRP power sensor and the user correction function of the instrument,
you can compensate external frequency responses. The R&S SMA100B utilizes the
readings of the power sensor and creates a correction value table for controlling the
output level during operation.

To connect the R&S NRP to the R&S SMA100B

1. Connect the power sensor.
See Chapter 8.4.1, "Connecting R&S NRP power sensors to the R&S SMA100B",
on page 233.

2. Select "Clk Syn/Power Sens" > "NRP Sensor Mapping".

3. If the sensor is not detected automatically, select "Scan > Start".

The instrument scans the network and the USB connections for connected sensors
and lists all detected R&S NRP sensors in the mapping table.

4. In the "Mapping" column, assign the sensor to a sensor channel, see Chap-
ter 8.4.2, "NRP sensor mapping", on page 234.

5. Close the dialog.

To configure and calibrate the R&S NRP in the R&S SMA100B

Provided the power sensor is connected to the R&S SMA100B and is assigned to a
sensor channel, we recommend that you calibrate and configure the power sensor in
the "NRP Power Viewer" dialog.

1. Select "Level" > "RF ON > Off"

2. Select "Clk Syn/Power Sens" > "NRP Power Viewer".

3. If the R&S SMA100B has detected several connected power sensors, select the
tab of the sensor you want to use.

4. Select "Zero" to start zeroing of the sensor.
Note: Always turn the RF power off or disconnect the sensor from RF before zero-
ing, since the function calibrates the power sensor at zero signal power.

The zeroing process takes a few seconds, depending on the power sensor type.

5. Configure additional parameters for the selected sensor as required.
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6. Select "State > On".

7. Close the dialog.

To create user correction data with an R&S NRP and the R&S SMA100B

We assume, that the power sensor is connected, assigned and ready for operation.

1. Select "Level" > "User Correction".

2. Select "UCOR Data" > "UCOR Data...."

3. Create a file: "New" > Filename and confirm with "OK".

4. Select the new file with "Select".

5. Select "Edit UCOR Data...".

6. Select "Edit" > "Fill".

The "Fill Table" dialog enables you to fill in the values of the columns automatically.

7. To fill in the frequency column:

a) Select "Select Column To Fill > Frequency / Hz".
b) Select "Range > e.g. 15" to determine the number of values.
c) Select "Start Value > e.g. 1.56 GHz".
d) Select "Increment Value > e.g. 1 MHz", to determine the frequency steps.
e) Select "Fill", to insert the frequency values.
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The "Fill" function also fills the column of the "Correction Value / dB" values with a
predefined value, since empty cells lead to the data loss of the entire line. If you
need different values, you can change them manually, or you can use the auto-
matic function "Fill with Sensor" as described in the next steps.

8. Select "Fill with Sensor".

The "Fill User Correction Data With Sensor" dialog provides an overview of the
sensor configuration.

9. Select "Execute".

The R&S SMA100B successively sets each frequency point, reads the measured
power of the sensor and fills in the value in the correction table.

10. Select "Save" to save the data in the file.

11. Close the dialog.

To perform power leveling calibration with user correction data

We assume that a user correction file is available in the user directory of the
R&S SMA100B or on a memory stick or in a shared directory.

If you have created and saved the file immediately before this step, the file is loaded in
the "User Correction" dialog automatically. Otherwise you can load a previously saved
file.

1. Select "Level" > "User Correction".

2. Select "UCOR Data" > "UCOR Data...", if there is no file loaded already.

3. Select the directory and file you want to use.
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4. Load the file with "Select".

5. To view the file content, select "Edit UCOR Data...".

6. Select "UCOR Data" > "State" > "On" to apply the user correction values.

When you activate the RF output, the R&S SMA100B considers the user correction
data and adjusts the signal level accordingly to compensate external frequency
responses.
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9  Reference oscillator
The R&S SMA100B is equipped with an internal reference oscillator that generates a
reference frequency of 10 MHz. It is used as internal reference source for the synthe-
sizer.

Alternatively, you can apply an external reference signal. If equipped with the required
options, the R&S SMA100B can process external reference frequency in the range
1 MHz to 100 MHz and the 1 GHz reference frequency.

Regardless of the used reference source (internal or external), the R&S SMA100B
always provides the configured reference frequency at the output. You can use it, for
example to synchronize several interconnected instruments, see Chapter 9.5, "Using
the reference frequency for instruments synchronization", on page 300, for an overview
of typical test situations.

The reference oscillator settings are not affected by an instrument preset ([Preset] key
or *RST) and the "Save/Recall" function. They are reset only by factory preset.

9.1  Required options

R&S SMA100B base unit equipped with the following options:
● 100 MHz, 1 GHz ultra low noise reference input and output (R&S SMAB-K703)
● 1 MHz to 100 MHz flexible reference input (R&S SMAB-K704)

For more information, see data sheet.

9.2  Reference frequency settings

Access:

1. Select "Frequency" > "Reference Frequency".

Reference frequency settings
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In the "Reference Frequency" tab, you can select the reference frequency signal
source and the frequency and synchronization bandwidth mode of an external ref-
erence signal.

2. Observe the information on the home screen, "Frequency" tile.
Observe the information on the home screen, "Measurement Setup" tile.

The "Frequency" tile indicates the current reference oscillator configuration, incl.
the reference oscillator source, external reference frequency (rounded value) and
output connector. A warning symbol in the "Frequency" tile indicates a missing
external source.

The remote commands required to define these settings are described in Chap-
ter 14.16.12, "SOURce:ROSCillator subsystem", on page 691.

Settings:

Set to Default.............................................................................................................. 296
Source.........................................................................................................................296
Show Connector..........................................................................................................296
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Deactivate RF Output (if external reference is missing)..............................................296
External Reference Frequency................................................................................... 296
Variable Reference Frequency....................................................................................297
Synchronization Bandwidth.........................................................................................297
Nominal Synchronization Bandwidth...........................................................................297
Minimum Locking Range.............................................................................................297
External Tuning Active................................................................................................ 298
External Tuning Slope.................................................................................................298

Set to Default
Calls the default settings.
Remote command: 
[:SOURce]:ROSCillator:PRESet on page 693

Source
Selects the reference frequency source.
"Internal" Uses the internal reference oscillator, either with calibrated or a user-

defined Adjustment Value.
"External" Uses an external reference signal.

Note: If the external reference is missing, the R&S SMA100B issues
a warning message and indicates the icon  (external reference
missing).
To set the frequency of the external reference, see "External Refer-
ence Frequency" on page 296.

Remote command: 
[:SOURce]:ROSCillator:SOURce on page 693

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

Deactivate RF Output (if external reference is missing)
Turns off the RF output when the external reference signal is selected, but no signal is
supplied.
This function prevents that no improper RF signal due to the missing external refer-
ence signal is used for measurements. A message indicates that the RF output is
deactivated.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe] on page 694

External Reference Frequency
Selects the frequency of the external reference signal.
Set the reference output frequency with the parameters in the Reference output set-
tings dialog.
"10 MHz" Selects 10 MHz for the external reference frequency signal.

Reference frequency settings
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"100 MHz, 1 GHz"
Option: R&S SMAB-K703
Selects the external reference frequency.

"Variable" Option: R&S SMAB-K704
The external reference signal has an arbitrary frequency, within the
permissible range from 1 MHz to 100 MHz.

Remote command: 
[:SOURce]:ROSCillator:EXTernal:FREQuency on page 694

Variable Reference Frequency
Option: R&S SMAB-K704
Sets the variably settable external reference frequency.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:FREQuency:VARiable on page 694

Synchronization Bandwidth
Selects the synchronization bandwidth for an external reference signal.
The resulting bandwidth is indicated by the parameter Nominal Synchronization Band-
width.
"Narrow" The internal reference oscillator is synchronized to the external signal

with narrow bandwidth.
This setting is recommended if the phase noise of the external signal
is worse than the phase noise of the internal OCXO.

"Wide" Synchronizes the internal oscillator to the external signal with the
maximum possible bandwidth.
This mode is the recommended standard mode and for precise refer-
ence sources of high spectral purity.
Note: If the frequency of the external reference signal is outside the
locking range of the internal reference oscillator, spurs due to the dif-
ference of the internal and external reference frequency are gener-
ated in the reference PLL.
The R&S SMA100B issues an error message.
For more information, see data sheet.

Remote command: 
[:SOURce]:ROSCillator:EXTernal:SBANdwidth on page 694

Nominal Synchronization Bandwidth
Indicates the nominal synchronization bandwidth for the selected External Reference
Frequency and the Synchronization Bandwidth.
Remote command: 
[:SOURce]:ROSCillator:EXTernal:NSBandwidth? on page 695

Minimum Locking Range
Indicates the minimum locking range for the selected External Reference Frequency
and the Synchronization Bandwidth.

Reference frequency settings
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Remote command: 
[:SOURce]:ROSCillator:EXTernal:MLRange? on page 695

External Tuning Active
For "Source > Internal", activates the EFC (external frequency control).
EFC is a function that transforms an external tuning voltage into frequency shift, where
the value range of the resulting frequency is a technical characteristic listed in the data
sheet.
See the data sheet also for information on the sensitivity, input voltage range, impe-
dance and maximum bandwidth for external tuning signal.
Remote command: 
[:SOURce]:ROSCillator:INTernal:TUNing[:STATe] on page 693

External Tuning Slope
Sets the sensitivity of the external tuning voltage.
Remote command: 
[:SOURce]:ROSCillator:INTernal:TUNing:SLOPe on page 693

9.3  Reference output settings

Access:

1. Select "Frequency" > "Reference Frequency".

2. Select "Reference Output".

In the "Reference Output" tab, you can set the reference frequency value at the
output connectors.
As a result of parameter dependencies, "Preset This Parameter" sometimes does
not affect output dialogs.
The remote commands required to define these settings are described in Chap-
ter 14.16.12, "SOURce:ROSCillator subsystem", on page 691.

Settings:

Reference Output/1 GHz Reference Output............................................................... 298
Show Connector..........................................................................................................299

Reference Output/1 GHz Reference Output
Selects frequency reference output signal for downstream instruments.

Reference output settings
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"Off" Deactivates the reference signal output.
"10 MHz" Derives a signal with 10 MHz frequency from the internal reference

oscillator and provides this signal at the output.
"100 MHz" Option: R&S SMAB-K703

Provides the 100 MHz reference frequency signal at the output.

"1 GHz" Option: R&S SMAB-K703
Provides the 1 GHz reference frequency signal at the output.

"Input Signal (loop through)"
Option: R&S SMAB-K703/-K704
Passes the external reference frequency to the output directly.

Remote command: 
[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE on page 695
[:SOURce]:ROSCillator:OUTPut:ALTernate:FREQuency:MODE on page 696

Show Connector
Accesses a dialog that displays the physical location of the selected connector on the
front/rear panel of the instrument.

9.4  Adjustment settings

Access:

1. Select "Frequency" > "Reference Frequency".

2. Select "Adjustment".

Settings:

Adjustment Active....................................................................................................... 299
Adjustment Value........................................................................................................ 300

Adjustment Active
Selects the adjustment mode.
"Off" Uses the calibrated internal reference frequency.
"On" Allows you to apply a deviation to the internal reference frequency,

according to your requirements.
Enter the value in the Adjustment Value field.

Remote command: 
[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] on page 697

Adjustment settings



Reference oscillatorR&S®SMA100B

300User Manual 1178.3834.02 ─ 09

Adjustment Value
Sets a user-defined adjustment value for the internal reference frequency. This value
takes effect when it is activated with Adjustment Active.
● "0" represents the calibrated state.
● The setting range depends on the reference oscillator type and its factory calibra-

tion value.
Note:
The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.
Remote command: 
[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue on page 696

9.5  Using the reference frequency for instruments syn-
chronization

Test setups with two or more instruments often require that the instruments use a com-
mon reference frequency. Depending on the availability of external reference frequency
source and its quality, the instruments are connected and configured in different ways.

This section gives an overview of the possible test setups and the related settings. The
following situations are considered:
● External reference source is not available or the built-in reference oscillator is of

better quality than the external source
(see "Distributing the internal 10 MHz reference signal to further instruments"
on page 300)

● Clean external reference source with quality exceeding the quality of the built-in
reference oscillator
(see "Using external reference source" on page 302)

● Interfered or noisy external reference signal
(see "Deriving 10 MHz from the external reference frequency" on page 302)

● 1 GHz reference coupling for phase coherence of the RF signals with enhanced
long-term phase stability
(see "Sharing the 1 GHz reference frequency to obtain phase-coherent signals"
on page 301)

Connectors overview

Use the "Show Connector" function to indicate the connector on the front/real panel:
● "Ref In/Ref Out" on page 45
● 1GHz "Ref In/Ref Out" on page 45
● "EFC" on page 45

Distributing the internal 10 MHz reference signal to further instruments

The internal reference oscillator provides the reference frequency:
● Internal fref = 10 MHz (10 MHz at connector Ref Out)

Using the reference frequency for instruments synchronization
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● Source = "Internal"
● Reference Output/1 GHz Reference Output = "10 MHz"
● Optional:

– External Tuning Active = "On"
– External Tuning Slope = "Low"

Figure 9-1: Synchronizing instruments using the internal 10 MHz reference signal of the
R&S SMA100B

EFC = External frequency control
EFC,Ref In,Ref Out = Connectors

In phase noise measurement systems, for example, you can also use the EFC (exter-
nal frequency control) function and shift the frequency. EFC is a function that trans-
forms an external tuning voltage into frequency shift, where the value range of the
resulting frequency is a technical characteristic listed in the data sheet. See the data
sheet also for information on the sensitivity, input voltage range, impedance and maxi-
mum bandwidth for external tuning signal.

Consider the following interdependency:
● EFC in combination with an external PLL

If the EFC is applied in combination with an external PLL (phase locked loop), the
PLL bandwidth must be smaller than the bandwidth of the external tuning signal.

● FM-DC mode
If the measurement requires higher PLL bandwidth, we recommend that you use
the external FM modulation (DC coupling) in low noise mode.
The FM-DC mode yields a fixed tuning sensitivity that is independent of the RF out-
put frequency and corresponds to the selected FM deviation.

Sharing the 1 GHz reference frequency to obtain phase-coherent signals

Compared to 10 MHz, a 1 GHz reference signal significantly improves the achievable
phase stability between two signal sources. Because the synchronization frequency
increases by a factor of 100, the relative phase fluctuations between the sources can
be reduced.

1 GHz at connector Ref In 1GHz and 1 GHz at Ref Out 1GHz
● External fRef = 1 GHz
● Source = "External"
● External Reference Frequency = "1 GHz"
● 1GHz Reference Output = "1 GHz"

Using the reference frequency for instruments synchronization
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Using external reference source

If you have a clean external reference signal with 10 MHz or 100 MHz frequency, for
example, you can directly pass it to the output. The signal quality remains the same.

10 MHz, 100 MHz at connector Ref Out and Ref In
● External fRef = 10 MHz or 100 MHz

(earlier RF hardware versions: 5 MHz, 10 MHz, 13 MHz)
● Source = "External"
● Reference Output = "10 MHz, 100 MHz" or "Input Signal (loop through)"

(earlier RF hardware versions: 5 MHz, 10 MHz, 13 MHz)
● Set the synchronization bandwidth according to the requirements of the applica-

tion.

Figure 9-2: Synchronizing instruments with a 10 MHz external reference signal

Ref. Frequency Source = e.g., Rohde & Schwarz signal analyzer
fRef = 10 MHz, 100 MHz, 1 MHz to 100 MHz external reference frequency
Ref In, Ref Out = Connectors

You can forward reference frequency between 1 MHz and 100 MHz directly to the out-
put in the same way.

● External fRef = 1 MHz to 100 MHz
(1 MHz to 100 MHz at connector Ref In and Ref Out)

● Source = "External"
● Variable Reference Frequency = "Variable"
● External Reference Frequency = current external frequency
● Reference Output = "Input Signal (loop through)" or specify the reference fre-

quency the synchronized instrument supports
● Set the synchronization bandwidth according to the requirements of the applica-

tion.

Deriving 10 MHz from the external reference frequency

10 MHz reference frequency can be derived from the following external reference sig-
nals:
● 10 MHz from internal oscillator locked to external input
● 100 MHz and 1 GHz external reference signals
● External reference signal between 1 MHz and 100 MHz
● If the external reference signal is interfered (noisy)

Using the reference frequency for instruments synchronization
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Figure 9-3: Synchronizing instruments with 10 MHz (derived from an external reference frequency)

Ref. Frequency Source = e.g., Rohde & Schwarz signal analyzer
fRef = 10 MHz, 100 MHz, 1 MHz to 100 MHz, 1 GHz** external reference frequency
** = 1 GHz uses Ref In 1 GHz connector
Ref In, Ref Out = Connectors

1 GHz, 1 MHz to 100 MHz at connector Ref In 1 GHz/Ref In and 10 MHz at Ref Out
● E.g., external Ref. fref = 100 MHz
● Source = "External"
● External Reference Frequency = "100 MHz"
● Reference Output/1 GHz Reference Output = "10 MHz"
● Synchronization Bandwidth = "Narrow"

Using the reference frequency for instruments synchronization
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10  Clock synthesis
The clock synthesis provides a separate system clock with a freely selectable fre-
quency for test setups that require an additional clock reference. For example, in a test
setup that uses an A/D converter, the required system clock for data sampling can be
provided without the need of additional signal generator.

Output connectors

The generated clock reference is synchronized to the selected reference clock of the
signal generator (internal or external). The differential signal is output at the [Clk Syn]
and [Clk Syn N] connectors.

Required options

● Option frequency R&S SMAB-B10x
● Option differential clock synthesis up to 3 GHz R&S SMAB-B29
● Option clock synthesis extension 6 GHz R&S SMAB-K722

(requires at least R&S SMAB-B106)

For more information, see data sheet.

Settings

Access:

1. Select "Clk Syn/Power Sens > Clock Synthesis".

2. Select "User Variation" to set the step width to be used when setting the clock fre-
quency using the rotary knob.
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3. Observe the information on the home screen, "Clk Syn/Power Sens" tile.

The "Clk Syn/Power Sens" tile indicates that clock synthesis is activated and gives
an overview of the key parameters.

Settings

State............................................................................................................................305
Output Type.................................................................................................................305
Frequency................................................................................................................... 306
Level............................................................................................................................306
DC Offset State........................................................................................................... 306
DC Offset.....................................................................................................................307
Voltage........................................................................................................................ 307
Delta Phase.................................................................................................................307
Reset Delta Phase Display......................................................................................... 307
User Variation..............................................................................................................307

└ Variation Active............................................................................................. 307
└ Variation Step................................................................................................307

State
Activates/deactivates generation of a system clock.
The signal is output at the [Clk Syn] connector.
Remote command: 
:CSYNthesis:STATe on page 470

Output Type
Defines the shape of the generated clock signal.
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"Single-Ended/Differential Sine"
Sine signals with user-definable amplitude.

"Differential Square"
Squared signal with fixed amplitude.

"CMOS" CMOS-like signal with user-definable amplitude and limited frequency
range.

Remote command: 
:CSYNthesis:OTYPe on page 471

Frequency
Sets the frequency of the generated clock signal.

Output Type Min. frequency Max. frequency

Single-ended sinus

Differential sinus

100 kHz 6 GHz

Differential square 10 MHz 6 GHz

CMOS 100 kHz 200 MHz

Remote command: 
:CSYNthesis:FREQuency on page 471

Level
For Output Type = "Single-Ended/Differential Sine", sets the amplitude of the gener-
ated clock signal.
Remote command: 
:CSYNthesis:POWer on page 471

DC Offset State
Activates a DC offset for both clock synthesis signal outputs.
The DC offset can be used e.g. to shift the clock synthesis output signal into the trigger
threshold of some logic elements.

Figure 10-1: Example: DC offset = 1.65V and Output Type = Differential Square
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Remote command: 
:CSYNthesis:OFFSet:STATe on page 472

DC Offset
Sets the value of the DC offset for both clock synthesis signal outputs.
Remote command: 
:CSYNthesis:OFFSet on page 472

Voltage
For Output Type = "CMOS", sets the high-level of the output signal.
Remote command: 
:CSYNthesis:VOLTage on page 472

Delta Phase
Shifts the phase of the generated clock signal.
Remote command: 
:CSYNthesis:PHASe on page 472

Reset Delta Phase Display
Resets the parameter Delta Phase.

User Variation
Defines and activates a user-defined step width for varying the frequency or level with
the rotary knob.
If disabled, the step width varies in steps of one unit at the cursor position.

Variation Active ← User Variation
Activates the set user-defined step width.
Remote command: 
:CSYNthesis:FREQuency:STEP:MODE on page 473
:CSYNthesis:POWer:STEP:MODE on page 473

Variation Step ← User Variation
Sets the user-defined step width.
Remote command: 
:CSYNthesis:FREQuency:STEP on page 474
:CSYNthesis:POWer:STEP[:INCRement] on page 473
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11  File and data management
The R&S SMA100B uses files to save all instrument data. The instrument allows you to
save and to load instrument settings, and to import and to export user data for process-
ing in another instrument or later. Finally, you can create a screenshot of the current
settings displayed on the screen and save it as a file.

This section focuses on the functions provided for managing of user data files and cov-
ers the topics listed below.

For information on the related remote control commands, refer to Chapter 14.5, "MME-
Mory subsystem", on page 456.

For information on how to save the displayed setting in a file, refer to Chapter 11.10,
"Creating screenshots of current settings", on page 336.

● About the file system.............................................................................................308
● Restoring the (default) instrument configuration................................................... 311
● Protecting data......................................................................................................316
● Saving and recalling instrument settings...............................................................317
● Accessing files with user data...............................................................................321
● Exporting and importing remote command lists....................................................323
● Loading, importing and exporting lists...................................................................324
● Using the file manager.......................................................................................... 324
● How to transfer files from and to the instrument................................................... 330
● Creating screenshots of current settings...............................................................336

11.1  About the file system

Depending on the contained information, two file groups can be distinguished: system
and user files.

Due to security reasons, system files and the system directory are protected and there-
fore not accessible.
The scope of this section is only the files with user data.

This section is an overview of the R&S SMA100B file system and covers the following
topics:
● "Types of user data" on page 309
● "File storage location" on page 309
● "File handling" on page 310
● "File naming conventions" on page 310
● "File extensions" on page 310
● "File contents" on page 311

About the file system
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Types of user data

Depending on the content, the user data can be roughly divided into the following
data types:
● Settings, e.g. the current instrument settings, can be saved and loaded later or

used in other instrument of the same kind.
See Chapter 11.4, "Saving and recalling instrument settings", on page 317

● SCPI scripts, a series of commands that can be run to perform a task.
See Chapter 11.6, "Exporting and importing remote command lists", on page 323

● Externally or internally generated lists, e.g. user correction lists, or data lists can be
loaded in the instrument.
See Chapter 11.7, "Loading, importing and exporting lists", on page 324 and
Chapter 11.5, "Accessing files with user data", on page 321

Depending on the data storage method, user data can be:
● Persistent, i.e. user files that are recorded on the data storage.

Data is preserved when instrument is powered off and can be accessed and modi-
fied subsequently.

● Temporary, i.e. volatile data that the instrument retains while it is powered on.
Volatile data is immediately lost when the R&S SMA100B is switched off.

File storage location

Without any additional measures, the R&S SMA100B stores user files on the internal
memory, the removable memory, or if connected, on a memory stick.

Both, the user directory /var/user/ on the internal memory or the /usb/ directory
on the memory stick, can be used to preserve user-defined data. Any directory struc-
ture can be created.

The /var/volatile directory serves as a RAM drive and can be used to protect
sensitive information. The data is available temporarily.

If option R&S SMAB-B85 is installed, the R&S SMA100B maps the user directory to
the removable memory. If a memory is mounted, user data is saved there. Otherwise
user data is redirected to the volatile memory.

Default storage location

The R&S SMA100B stores user data in the user directory.

Depending on the installed options, the user directory is physically located on the inter-
nal memory or on the removable memory.

In the file system, user directory is always indicated as /var/user/.

In manual control, you access this directory via the "File Manager", see Chapter 11.8,
"Using the file manager", on page 324. In remote control, you can query it with the
command :SYSTem:MMEMory:PATH:USER?.

To query and change the default directory used for mass storage, use the command :
MMEMory:CDIRectory.

About the file system
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File handling

To access files and the file system of the instrument or to use the general file manage-
ment functions such as copying and moving data, use the standard "File Manager" dia-
log.

See Chapter 11.8, "Using the file manager", on page 324.

To transfer files from and to the instruments or to exchange files, use one of the follow-
ing alternatives:
● Connect a memory stick to one of the USB interfaces.

The instrument recognizes automatically a connected memory stick and assigns
the /usb/ drive to it.

● Connect the instrument to a LAN.
An instrument connected to a LAN supports two standard file transfer methods
from a remote client:
– FTP (file transfer protocol)
– File sharing according to the SAMBA/SMB (server message block) protocol.
Both file transfer methods access the folder /user, that is the /var/user/ folder
on the instrument.
For step-by-step description, see Chapter 11.9, "How to transfer files from and to
the instrument", on page 330.

● Map a network folder or a computer to an instrument connected to a LAN.
A mapped network folder is indicated as /shares/<"Local Folder">.
For step-by-step description, see Chapter 11.8.4, "How to map a network folder",
on page 328.

File naming conventions

To enable files to be used in different file systems, consider the following file naming
conventions:
● The filename can be of any length and is case-sensitive, i.e it is distinguished

between uppercase and lowercase letters.
● All letters and numbers are permitted (numbers are, however, not permitted at the

beginning of the filename).
● Avoid using special characters.
● Do not use slashes "\" and "/". These symbols are used in file paths.
● Avoid using the following filenames: CLOCK$, CON, COM1 to COM4,

LPT1 to LPT3, NUL or PRN
They are reserved by the operating system.

File extensions

The R&S SMA100B distinguishes the files according to their extensions; each type of
file is assigned a specific file content and also a specific file extension. The extension
is usually of no consequence to you since access to the files occurs in the individual
dialogs where only the relevant type of file is available. For example, files with user
correction data can only be saved and loaded in the "UCOR" dialog.

About the file system
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See Chapter B, "Extensions for user files", on page 781 for an overview of the suppor-
ted file extensions.

File contents

To maintain the file size and to accelerate the loading and processing times, not all
instrument settings but rather the settings in state different than the preset one are
saved. Considered is also configuration data for the operating elements and lists with
user data, e.g. dialog positions and a list of user correction data. However, if a list data
is part of the instrument settings, a reference to this list is saved, not the list itself.

This approach ensures that the created files contain only relevant information and
allows you to transfer instrument settings even between different equipped signal gen-
erators. During the recall process, the instrument interprets only the relevant settings;
all non-referenced parameters are set to their preset values. Error messages indicate
the settings which cannot be implemented, like referencing non-existing lists or the
attempt to activate settings which are not supported by the instrument.

Network settings and remote settings cannot be saved and restored.

11.2  Restoring the (default) instrument configuration

The R&S SMA100B has various options to set default settings. You can preset the
R&S SMA100B to an initial state at any time as a known starting point for configura-
tions. It is often useful as a first step in troubleshooting when unusual results arise.

The graph on Figure 11-1 shows the impact of the particular reset functions.

Figure 11-1: Parameter and operating modes, reset by the respective preset functions

Restoring the (default) instrument configuration
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Overview of the characteristics of the preset functions

Select the preset option that most fits to your particular application:

● [Preset]
It is the most frequently used function.
A Preset executes a defined instrument setup to provide an initial instrument state
as a basis for a new configuration. It resets all parameters and switching states,
including also the states of inactive operating modes.
Network, remote access or system settings are retained.

► To execute a preset, press the [Preset] key at the front panel.

● "Set to Default"
Set To Default relates to individual dialogs or tabs and resets the associated set-
tings of the corresponding dialog. All other settings are retained.

► To reset the grouped settings, click "Set To Default".

● "Preset this parameter"
Sets a single parameter to its default value.

► To reset an individual parameter: Open its context-sensitive menu and select "Pre-
set this parameter...".

● "Factory Preset"
A factory preset is the most profound preset function that resets almost all instru-
ment settings, including reference oscillator, network and remote access settings.
Retained are the following settings:
– Security, password, and settings protected by these passwords
– User-defined data, like setups or data lists
– Settings that relate to an integration of the instrument in a measurement setup.

► To restore the factory defaults, select System Config > Setup > Settings > Factory
Preset.

Note: Perform a "Factory Preset" only if it is necessary. After a "Factory Preset",
the network connection to the instrument no longer exists.

Restoring the (default) instrument configuration
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Presetting the instrument to a user-defined instrument state

The reset functions set the parameters and operating modes to default values prede-
fined by the factory. Alternatively to these default settings, you can:

● Define user-specific recall settings to be restored after a preset
(see Chapter 11.2.3, "How to recall user settings automatically after preset",
on page 315)

● Store and reload user-defined instrument states
(see Chapter 11.4.2, "How to save and recall instrument settings", on page 320)

Mark / Do not mark parameters changed from preset

To survey the current state of the settings concerning default values, the
R&S SMA100B offers a feature that visually identifies deviations from the default val-
ues.

For more information, see Chapter 11.2.2, "How to identify parameters which are not in
a preset state", on page 314.

11.2.1  Preset, set to default and factory preset settings

Preset..........................................................................................................................313
Set To Default..............................................................................................................313
Preset this Parameter................................................................................................. 313
Execute Factory Preset...............................................................................................314

Preset
Resets all parameters and switching states, and closes all opened dialogs.
Note:
In contrast to the [Preset] key, the SCPI commands *RST and :SYSTem:PRESet do
not close open dialogs in the GUI.
Consider also the following possibilities:
● You can define the settings that are restored when you preset the instrument

(see Chapter 11.2.3, "How to recall user settings automatically after preset",
on page 315)

● You can reset the instrument to the factory state
(see "Execute Factory Preset" on page 314)

See also Table 11-1 that contains the key parameters that are reset by the correspond-
ing preset functions.
Remote command: 
*RST on page 453

Set To Default
Resets the associated settings of the corresponding dialog or tab.

Preset this Parameter
Restores the default value of a single parameter.

Restoring the (default) instrument configuration
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Execute Factory Preset
Resets the instrument to its factory settings.
Note: "Factory Preset" retains all security settings and does not delete any user files
like setups or user data.
See also Table 11-1 that contains the key parameters that are reset by the correspond-
ing preset functions.
Remote command: 
:SYSTem:FPReset on page 456

11.2.2  How to identify parameters which are not in a preset state

To recognize the current state of the settings related to their default values at the first
glance, enable a function that visually identifies parameters in states different than pre-
set.

To activate this display:

1. Open the context-sensitive menu (touch and hold the screen anywhere in the GUI
of the R&S SMA100B).

2. Select "Mark all parameters changed from preset".

If enabled, the corresponding settings are marked.

Example: 

Figure 11-2: Labeled parameters show that the value deviates from its default

Frequency = changed (default = 1 GHz)
Offset = changed (default = 0 kHz)
Multiplier = unchanged
Variation active = changed (default = disabled)
Variation step = unchanged

Restoring the (default) instrument configuration
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11.2.3  How to recall user settings automatically after preset

You can define the settings that are restored when you preset the instrument.

1. Configure the settings as required. Save them as described in Chapter 11.4.2,
"How to save and recall instrument settings", on page 320.

2. Save the settings as a file with the predefined filename UserPreset.savrcltxt.
Save this file in the directory /var/user/.

The filename UserPreset.savrcltxt and the directory /var/user/ are man-
datory.

Now when you press the [Preset] key or send the *RST command to the instru-
ment, the defined settings are restored.
An "Info" message appears and confirms, that a file with user-defined preset set-
ting is loaded.

11.2.4  Reference

See Table 11-1 for an overview of the main generator settings that are affected by the
corresponding preset functions. While the regular [Preset] key primarily resets the sig-
nal relevant parameters of the instrument, the "Factory Preset" affects almost all instru-
ment settings.

For information on the default values of further parameters, refer to the description of
the corresponding remote commands.
Table 11-1: Key parameters affected by preset and factory preset

Parameter Preset value Preset Factory
Preset

RF frequency 1 GHz x x

RF level (RF output) off x x

RF OFF mode - - x

Offsets 0 x x

Modulation state off x x

Uninterrupted level settings off x x

Level attenuator mode auto x x

Level ALC (internal level control) auto x x

Level UCOR (user correction) off x x

LF output state off x x

Sweep state off x x

List mode state off x x

Reference frequency settings (reference oscillator) - - x

Restoring the (default) instrument configuration
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Parameter Preset value Preset Factory
Preset

Power on settings (Level/EMF) - - x

Network settings - - x

Hostname - - x

GPIB address - - x

Start/Stop display update - - x

Display and keyboard settings - - x

Password and settings protected by passwords (e.g. dis-
abled LAN or USB)

- - -

Security settings - - -

User files (setups2), data lists, etc.) - - -

● 2) UserPreset.savrcltxt is renamed as UserPresetInactive.savrcltxt;
an existing file with the same name is overwritten.

If the default values in the "Remote Access" dialog had been changed, a factory preset
via remote control (:SYSTem:FPReset) terminates the connection to the instrument.
Security settings are never reset.

Resets all parameters and switching states, and closes all opened dialogs.

11.3  Protecting data

During operation, the R&S SMA100B saves user data permanently in the user direc-
tory, see "File storage location" on page 309.

To protect any classified data and to avoid saving any sensitive data on the
R&S SMA100B permanently, you have the following options:
● Activate the volatile mode. This mode redirects user data to the volatile memory,

see "Volatile Mode" on page 365.
The internal memory and the removable memory are write-protected.
Once you power off the instrument for at least five minutes, all volatile memory
modules lose their contents.
Instead, you can redirect the user data to an external memory device, as, e.g., a
USB stick.
See also:
– "Default storage location" on page 309
– "Volatile Mode" on page 365
– Chapter 11.9.4, "Using a USB storage device for file transfer", on page 335

● If the R&S SMA100B is equipped with the removable memory R&S SMAB-B85
and an SD card is inserted:

Protecting data
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– If the volatile mode is disabled (default setting) the R&S SMA100B saves user
data permanently and only on this storage medium.
You can access data saved on the removable memory just as data saved in
the /var/user/.

– If the volatile mode is enabled, the R&S SMA100B redirects user data to the
volatile memory (SDRAM).
The volatile memory loses its contents when you power off the instrument.

● Save user files temporarily in the /var/volatile directory, which remains
available only until the instrument is turned off.
You can access data in the volatile memory just as data that is saved permanently
in the /var/user/.
See also Chapter 11.8.3, "How to display all saved files", on page 328.

For detailed information on how to protect the instrument and sensitive data from unau-
thorized access, see the Instrument Security Document on the product website.

11.4  Saving and recalling instrument settings

Possibly you would like to restore or repeat a signal generation you performed under
specific conditions on the instrument. Or, in a test setup with more than one signal gen-
erator, you want to transfer the used settings to another R&S SMA100B. In these
cases, you can save and recall instrument and user settings, and possibly other related
data.

Save/Recall the complete instrument settings

Two different methods are available for managing complete instrument settings:
● Immediate (quick) Save/Recall

A defined set of instrument settings are saved or recalled quickly in just one step,
without defining a filename or storage location. This function enables a fast switch-
ing between different instrument settings.

● Save/Recall in files with user-defined names
The defined set of instrument settings are saved to a definable storage location.
The file extension is *.savrcltxt.
Settings files created in this way are visible in the file system and accessible with
the supported methods for file handling.

In the general case, a recall process replaces the instruments settings with the saved
values. An exception is the frequency and level settings. During recall of the instrument
settings, it is possible to retain the current settings or to overwrite them with the saved
values.

Saving and recalling instrument settings
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11.4.1  Save/recall settings

To access the dialog for saving and loading the complete instrument settings

1. Select "System Config > Save/Recall".

2. Select "Operation Mode > Save or Recall" to access the corresponding settings.

The provided settings for both operations are similar and closely related.

Settings:

Operation Mode.......................................................................................................... 318
Directory, File List and Filename.................................................................................318
Recent files................................................................................................................. 319
Show SCPI List........................................................................................................... 319
SCPI List..................................................................................................................... 319
Save............................................................................................................................ 319
Save Immediate x....................................................................................................... 319
Exclude Frequency..................................................................................................... 320
Exclude Level..............................................................................................................320
Recall.......................................................................................................................... 320
Recall Immediate x......................................................................................................320
File Manager............................................................................................................... 320

Operation Mode
Accesses the settings for storing ("Save") and loading ("Recall") of the instrument set-
tings. Also, you can import SCPI-Files ("SCPI-Import") or export SCPI files ("SCPI-
Export").
See Chapter 11.6, "Exporting and importing remote command lists", on page 323.

Directory, File List and Filename
Note:

Saving and recalling instrument settings
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You access this generic standard function each time you perform one of the following:
● Save or load (settings) files
● Define a folder in that these files are saved
● Navigate through the file system.
The dialog name changes depending on the context. The provided functions are self-
explanatory and similar.
Use the settings for example as follows:
● To navigate through the file system, use the directory tree.
● To create a file, load and save files, use the dedicated functions "New", "Select",

Save, and Recent files.
● To access the general data list editor, use the"Edit" button

(see also Chapter 7.7, "List editor", on page 207).
● To perform standard file management functions, like create directories, move, copy,

delete files and/or directories, use the standard "File Manager" function (see Chap-
ter 11.8, "Using the file manager", on page 324).

Remote command: 
To list all files in a directory:
:MMEMory:CDIRectory on page 462
:MMEMory:CATalog? on page 461
[:SOURce]:CORRection:CSET:CATalog? on page 639

Recent files
Displays the files last used.

Show SCPI List
Opens the "SCPI List", which lists the current settings of the R&S SMA100B as SCPI
commands.
The R&S SMA100B provides this function for Operation Mode > SCPI-Export.

SCPI List
Contains a list of all SCPI commands corresponding to the current instrument settings.
See also "How to create a SCPI list with the current instrument settings in one step"
on page 435

Save
Saves the current instrument settings under the defined filename.
Remote command: 
:MMEMory:STORe:STATe on page 466

Save Immediate x
Stores the current instrument setting in one of the intermediate memories.
These instrument settings are retained until a different instrument setting is stored in
the intermediate memory. When the instrument is switched off, the contents of the
intermediate memories are retained.
Remote command: 
*SAV on page 453

Saving and recalling instrument settings



File and data managementR&S®SMA100B

320User Manual 1178.3834.02 ─ 09

Exclude Frequency
The current frequency is retained when a stored instrument setting is loaded.
Remote command: 
[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL on page 645

Exclude Level
The current level is retained when a stored instrument setting is loaded.
Remote command: 
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:RCL on page 689

Recall
Restores the selected configuration.
During recall, the instrument considers all related settings, for example sweeps in
active state or lists. An error message indicates the settings which cannot be imple-
mented.
Remote command: 
:MMEMory:LOAD:STATe on page 464

Recall Immediate x
Loads the selected configuration from one of the intermediate memories. A message
appears if no instrument configuration is stored in this memory.
Remote command: 
*RCL on page 453

File Manager
Accesses the "File Manager" dialog, see Chapter 11.8, "Using the file manager",
on page 324.

11.4.2  How to save and recall instrument settings

Instrument settings can be saved to a file and loaded again later, so that you can
repeat the tests with the same settings.

To access and recall instrument setups quickly

► Assign the appropriate action to the [★ (User)] key.
See Chapter 12.2.4, "How to assign actions to the [★ (User)] key", on page 353.

To save and recall instrument settings

1. Select "System Config > Save/Recall" > "Operation Mode > Save".

2. Select "Save Immediate 1".

The instrument saves its settings in the intermediate memory 1. The filename and
the storage location cannot be changed.

3. Adapt the instrument settings as required. Select "Save Immediate 2"

4. To restore the settings, select the "Operation Mode > Recall"

Saving and recalling instrument settings
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5. Select "Recall Immediate 1"

The instrument is restored to the previous state.

6. Select "Recall Immediate 2" to switch to the settings saved in the second file.

To save complete instrument settings

1. Select "System Config > Save/Recall" > "Operation Mode > Save".

2. In the file selection dialog, select a filename and storage location for the settings
file.

3. Select "Save".

A file with the defined name and path and the extension *.savrcltxt is created.

To restore instrument's configuration

Save the configuration as described in "To save complete instrument settings"
on page 321.

1. To restore settings, select "System Config > Save/Recall" > "Operation Mode >
Recall".

2. To retain the current frequency and level settings, enable "Save/Recall > Exclude
Frequency/Level"

3. In the file selection dialog, select the filename and storage location of the settings
file.

The settings are restored, but the frequency and level settings are retained; you
can repeat the signal generation with the same settings.
See also Chapter 11.2.3, "How to recall user settings automatically after preset",
on page 315.

11.5  Accessing files with user data

Signal generation in list mode, the generation of pulse train signals or applying user
correction values use data from list files. Whenever a list file is required as a data
source, the instrument provides direct access to the standard "File Select" function.
This function enables you to select, create and edit the list files.

11.5.1  File select settings

The "File Select" dialog opens automatically each time the signal generation requires
list file as data source.

To access a loadable data list file

1. Select "Sweep" > "List Mode Data" > "List Mode" = "Data".

A file select dialog for loading, creating and modifying a file opens.

Accessing files with user data
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Tip: The name of the dialog is context-sensitive and differs depending on the par-
ticular function this dialog is from. However, the provided functions are similar.

2. To load an existing file:
Navigate through the file system.
Select the file and confirm with "Select".

3. To create a file, for example if there is no data list file specified:
Navigate through the file system.
Select "New" and specify the filename.

A new empty file is created and saved in the selected folder.

4. To edit an existing or newly created file:
Navigate through the file system.
Select the file and select "Edit".

The standard "Data List Editor" dialog opens

5. Edit the file content.
Confirm with "Save".

Settings:

Directory, File List and Filename.................................................................................322
Functions for handling of data lists..............................................................................323
Recent files................................................................................................................. 323
File Manager............................................................................................................... 323

Directory, File List and Filename
Note:
You access this generic standard function each time you perform one of the following:
● Save or load (settings) files
● Define a folder in that these files are saved
● Navigate through the file system.

Accessing files with user data
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The dialog name changes depending on the context. The provided functions are self-
explanatory and similar.
Use the settings for example as follows:
● To navigate through the file system, use the directory tree.
● To create a file, load and save files, use the dedicated functions "New", "Select",

Save, and Recent files.
● To access the general data list editor, use the"Edit" button

(see also Chapter 7.7, "List editor", on page 207).
● To perform standard file management functions, like create directories, move, copy,

delete files and/or directories, use the standard "File Manager" function (see Chap-
ter 11.8, "Using the file manager", on page 324).

Remote command: 
To list all files in a directory:
:MMEMory:CDIRectory on page 462
:MMEMory:CATalog? on page 461
[:SOURce]:CORRection:CSET:CATalog? on page 639

Functions for handling of data lists
Provided are the following standard functions for file handling:
"Select" Select and load the file.
Remote command: 
[:SOURce<hw>]:LIST:SELect on page 675
[:SOURce<hw>]:PULM:TRAin:SELect on page 589
[:SOURce<hw>]:CORRection:CSET[:SELect] on page 638

"New" Creates file with the specified "Filename".
To confirm, select "OK"; use "Cancel" to undo the operation.
To edit the file content, select "File Select > Edit".

"Edit" Accesses the "Data List Editor" and loads the selected file for editing

Recent files
Displays the files last used.

File Manager
Accesses the "File Manager" dialog, see Chapter 11.8, "Using the file manager",
on page 324.

11.6  Exporting and importing remote command lists

To set specific instrument settings or perform tasks automatically, you can create
scripts or import scripts that contain the settings in the form of remote control com-
mand sequences.

The R&S SMA100B also offers a SCPI macro recorder with code generator that is
used to record manual settings and create an executable script, see Chapter 13.9.4,
"How to record / create SCPI lists", on page 434.

Exporting and importing remote command lists
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Completed scripts are saved in files and possibly converted to different formats,
depending on the used language of the source code.

The R&S SMA100B supports the following commonly used languages:
● Plain SCPI: *.txt
● MATLAB: *.m
● NICVI: *.c
● Python: *.py
It is also possible to convert the SCPI command list to a user-specific language, see
Chapter 13.9.5, "How to convert and save SCPI lists", on page 437.

11.7  Loading, importing and exporting lists

The R&S SMA100B provides built-in editors for creating list files, for example for the
list mode or lists with user correction data. You can also create or evaluate them with
an external application. The instrument provides interfaces with the following function-
ality:
● Import and export list files in a standard ASCII format file

Lists are saved and loaded in the corresponding dialogs. For example, the user correc-
tion data list is created and saved in the "User Correction" dialog.

11.8  Using the file manager

The "File Manager" is a tool similar to a standard Windows Explorer. It helps you man-
age mass storage media and files saved on the R&S SMA100B.

You can perform the following tasks:
● Copying multiple files from disk to other media

See Chapter 11.9, "How to transfer files from and to the instrument", on page 330
● Copying files into another directory

See Cut, Copy&Paste and Delete
● Renaming and deleting files
● Creating directories

See Create New Directory
● Mapping shared network folders

See Chapter 11.8.4, "How to map a network folder", on page 328
● Displaying saved files

See Chapter 11.8.3, "How to display all saved files", on page 328

Access:

► Select "System Config > Save/Recall" > "File Manager".

Using the file manager
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Tip: Each "Save/Recall" dialog and each "File Select" dialog provides a quick
access to the "File Manger", i.e. whenever you select data lists or files with user
data.

The "File Manager" dialog provides all standard functions required for file manage-
ment. It displays the contents of the selected folder on the R&S SMA100B and pro-
vides functions to rename, delete, copy, or move individual files.

11.8.1  File manager settings

Access:

► Select "System Config > Save/Recall" > "File Manager".

Settings:

Map Network Share.................................................................................................... 325
File Type......................................................................................................................325
Directory and Filename............................................................................................... 326
Cut, Copy&Paste and Delete...................................................................................... 326
Rename ......................................................................................................................326
Create New Directory..................................................................................................326

Map Network Share
Accesses the Map network share settings dialog where you can map one or more net-
work folders.
See also Chapter 11.8.4, "How to map a network folder", on page 328.

File Type
Selects the file type to be listed. If a file type with a specific file extension is selected,
only files with this extension are listed.

Using the file manager
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See Chapter B, "Extensions for user files", on page 781 for an overview of the suppor-
ted file extensions.

Directory and Filename
Selects the directory in which the file to be deleted or copied is located. The dialog lists
all files in this directory. Selected files are highlighted. The path is indicated above the
directory tree.
Unlike the "Save/Recall" and "File Select" dialogs, the "File Manager" displays the full
filenames including extensions.
Remote command: 
:MMEMory:CDIRectory on page 462

Cut, Copy&Paste and Delete
Standard file management functions.
Before a file is deleted, you have to confirm the delete operation.
Remote command: 
:MMEMory:DELete on page 464
:MMEMory:COPY on page 462

Rename
Renames the selected file or directory.
Remote command: 
:MMEMory:MOVE on page 465

Create New Directory
Creates a folder and opens an edit dialog box to enter name and path (absolute or rel-
ative to the current directory) of the new folder.
Remote command: 
:MMEMory:MDIRectory on page 465

11.8.2  Map network share settings

Access:

► Select "System Config > Save/Recall" > "File Manager > Map Network Share".

The "Map Network Share" dialog provides settings that are similar to the standard Win-
dows Explorer function "Map network drive". These settings help you to create up to 10
"shortcuts" to shared folders or computers in the network.

The dialog displays a list of current mapped network folders. The directory tree of the
"File Manager", "Save/Recall", and "File Select" dialogs indicate a mapped network
folder as /shares/<"Local Folder">.

Using the file manager
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See also Chapter 11.8.4, "How to map a network folder", on page 328.

Settings:

Network Folder............................................................................................................327
Local Folder................................................................................................................ 327
User Name.................................................................................................................. 327
Password.................................................................................................................... 327
Reconnect at Startup.................................................................................................. 327
Connect.......................................................................................................................328
Change........................................................................................................................328
Disconnect.................................................................................................................. 328

Network Folder
Enter the path of the folder or computer, e.g. //<IP Address>/user or //<server
name>/user.

Local Folder
Enter a letter or an alias name to describe the folder.
In the directory tree, a mapped network folder is indicated as /shares/
<"Local Folder">.

User Name
Enter a user name of a user that has the permission to access the selected network
folder.

Password
Enter the password of the selected user.

Reconnect at Startup
Enables reconnecting every time you start up the instrument.

Using the file manager
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Connect
Triggers the instrument to prove the credential and to map (i.e. connect) the selected
network folder or computer to the instrument.
You can map up to 10 network folders.

Change
Applies the changes.

Disconnect
Disconnects the network drive.

11.8.3  How to display all saved files

To display all files on the internal memory

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /var/user/.

To display all files on a connected USB flash drive

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /usb/.

To display all files in the volatile memory

1. Select "System Config > Save/Recall" > "File Manager".

2. Navigate to /var/volatile/.

11.8.4  How to map a network folder

Possibly you would like to transfer instrument or user settings to another
R&S SMA100B, distribute waveform files to several instruments or you have to access
frequently the same network drive. In these cases, on a R&S SMA100B connected to a
LAN you can create a shortcut to this network folder or this computer.

How to: see Chapter 13.7.3, "How to connect to LAN", on page 415.

To map a network folder, proceed as follows:

1. On the computer or the network folder you want to map, enable remote access.
You can specify a list of users allowed for remote access.
The remote access settings depend on the operating system the remote computer
is using. For step-by-step instructions, refer to the documentation of the particular
operating system.

2. On the R&S SMA100B, enable file transfer via SMB (samba).

Using the file manager
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3. Select "System Config > Setup > Remote Access > Network".
Select:

a) "Address Mode > Auto (DHCP)"
b) Check that the "DNS Suffix" and "DNS Server" are correct.

4. In the "Save/Recall" dialog, select "File Manager > Map Network Share".

5. In the "Map Network Share" dialog, select:

a) In the "Network Folder" field, enter //<IP Address>/user or //
<Server Name>/user.

b) In the "Local Folder" field, enter an alias name, e.g. setups.
c) Enter the "User Name" and "Password" of a user with a remote access permis-

sion to the selected network folder.
d) If necessary, enable "Reconnect at Startup".
e) Select "Connect".

The selected network folder is mapped to your instrument. The list of mapped net-
work folders is updated.

6. Close the "Map Network Share" dialog.

The navigation tree in the "File Manager" dialog displays the mapped network
folder as /shares/Setups.

Using the file manager
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If the connection does not succeed, consider to check the following:
● Is the network folder or computer you try to map turned on?
● Is the network folder or computer enabled for remote access?
● Does the selected user name have the necessary permissions?

See also Chapter 11.9.5, "Using a file server for test files exchange", on page 335.

11.9  How to transfer files from and to the instrument

As explained in "File handling" on page 310, you access the file system of the
R&S SMA100B via one of the following ways:
● Via the built-in "File Manager"

See Chapter 11.8, "Using the file manager", on page 324.
● On an instrument connected to a LAN:

– Via one of the standard functions FTP or SMB (samba)
See Chapter 11.9.2, "Accessing the file system of the R&S SMA100B via FTP",
on page 332 and
Chapter 11.9.3, "Accessing the R&S SMA100B file system via SMB (Samba)",
on page 333

– Via mapped network drives
See Chapter 11.8.4, "How to map a network folder", on page 328.

● Via a connected USB storage device
See Chapter 11.9.4, "Using a USB storage device for file transfer", on page 335

Mainly because of security reasons, the access to the file system of your
R&S SMA100B can be denied, because one or all these access methods are deliber-
ately disabled. Access to the file system via LAN and/or USB requires that the corre-
sponding service is enabled and a write access to the file system is enabled. Refer to

How to transfer files from and to the instrument
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Chapter 11.9.1, "Removing file system protection", on page 331 for description of the
required steps.

This section provides an introduction to the topic. For comprehensive information, refer
to the application note 1GP72: Connectivity of Rohde&Schwarz Signal Generators.

● Removing file system protection........................................................................... 331
● Accessing the file system of the R&S SMA100B via FTP.....................................332
● Accessing the R&S SMA100B file system via SMB (Samba)...............................333
● Using a USB storage device for file transfer......................................................... 335
● Using a file server for test files exchange............................................................. 335

11.9.1  Removing file system protection

Before you try to access the file system via FTP, SMB (samba) or USB, fulfill the follow-
ing:
● Disable write protection on the file system
● Enable the corresponding service or interface

To enable write permission on the file system

1. Select "System Config > Setup > Security > Security > General".

2. Select "Disk & Memory".

3. Enable "Volatile Mode".

4. Enter the "Security Password".
The default password is 123456. For more information, see Chapter 12.4, "Using
the security settings", on page 360.

The R&S SMA100B requests a reboot.

5. Confirm the request.

The system reboots. The enabled settings are active.

To enable file transfer over FTP

1. Select "System Config > Setup > Security > Security > LAN Services".

2. In the "Common Services" tab, enable "LAN Interface"

3. Enable "FTP"

4. Enter the "Security Password".
The default password is 123456. For more information, refer to Chapter 12.4,
"Using the security settings", on page 360.

5. Select "Accept".

To enable file transfer over SMB (samba)

1. Select "System Config > Setup > Security > Security > LAN Services"

How to transfer files from and to the instrument
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2. Enable "LAN Interface"

3. Select "Samba Services".

4. Enable the "SMB 1.0/2.0 Client".

5. Enable the "SMB 1.0/2.0 Server".

6. Enter the "Security Password".
The default password is 123456. For more information, refer to Chapter 12.4,
"Using the security settings", on page 360.

7. Select "Accept".

To enable file transfer over USB

1. Select "System Config > Setup > Security > Security > General"

2. Select "Disk & Memory".

3. Enable "USB Storage"

4. Enter the "Security Password".
The default password is 123456. For more information, refer to Chapter 12.4,
"Using the security settings", on page 360.

5. Select "Accept".

11.9.2  Accessing the file system of the R&S SMA100B via FTP

If the R&S SMA100B is connected to a LAN, you can use file transfer protocol (FTP) to
access the file system and to transfer files from and to the instrument.

How to: see Chapter 13.7.3, "How to connect to LAN", on page 415.

To access the file system via FTP

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via FTP

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.

4. In the address field, enter ftp://<"IP Address" of the Instrument>, e.g.
ftp://10.124.0.166.
Tip: The R&S SMA100B indicates its IP address on the home screen.

A log-on dialog opens and requests a password.

The default user name and password is instrument.

Tip:
Default password
The FTP and SAMBA file access use the user "instrument" with default password
"instrument".

How to transfer files from and to the instrument
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We recommend that you change this password in the "Setup > Security > Pass-
word Management > Change User Password" dialog before connecting the instru-
ment to the network.
See Chapter 12.4.4, "Password management", on page 370.

5. Enter the password to access the user directory.
The user directory corresponds to the /var/user/ directory of the instrument.

There, you can perform standard functions like creating directory, or saving files.

6. In the user directory, create a directory, e.g. test ftp.

7. Select "System Config > Save/Recall".
Open the /var/user/ directory.

The dialog displays the /var/user/test ftp directory.

11.9.3  Accessing the R&S SMA100B file system via SMB (Samba)

The SMB (Samba) protocol is an alternative way to access the file system of the instru-
ment from a remote PC. This protocol works if both the instrument and the PC are con-
nected to a LAN.

How to: see Chapter 13.7.3, "How to connect to LAN", on page 415.

How to transfer files from and to the instrument
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To access the file system via SMB

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via FTP

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.

4. In the address field, enter //<"IP Address" of the Instrument>, e.g. ftp://
10.124.0.166.
Tip: The R&S SMA100B indicates its IP address on the home screen.

The user directory corresponds to the /var/user/ directory of the instrument;
the volatile directory - to the /var/volatile directory.

To map the R&S SMA100B as a network drive to the remote PC

We assume that the instrument and the remote PC are connected to a LAN.

1. Enable file transfer via SMB (Samba)

2. Enable write permission on the file system

3. On the remote PC, start the Windows Explorer.
Open the "Map Network Drive" dialog.

a) Select a valid "Drive", e.g. W.
b) In the "Folder" field, enter //<"IP Address" of the Instrument>/user

or //<"Hostname" of the Instrument>/user
For example: //10.124.0.166/user or //SMA100B-102030/user.
Tip: The R&S SMA100B indicates its IP address on the screen.

c) Select "Finish".

A log-on dialog opens and requests a user name and a password.

The default user name and password is instrument.

Tip:
Default password
The FTP and SAMBA file access use the user "instrument" with default password
"instrument".
We recommend that you change this password in the "Setup > Security > Pass-
word Management > Change User Password" dialog before connecting the instru-
ment to the network.

How to transfer files from and to the instrument
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See Chapter 12.4.4, "Password management", on page 370.

4. Enter the user name and the password of your instrument.

The /var/user/ directory of the instrument is mapped to and displayed as a net-
work drive of the remote PC.

You can access the files in the /var/user/ directory, perform standard function
like creating directory, or saving files.

11.9.4  Using a USB storage device for file transfer

Alternatively to the file transfer possibility via LAN, you can use a USB storage device
for direct file transfer from and to the instrument.

We recommend that you transfer files with user data (like lists or instrument setup files)
to the instrument, rather than load and play them from a connected USB storage
device.

To transfer a file with user data to the instrument

1. Connect a USB storage device, for example a USB memory stick to one of the
USB interfaces of the instrument.

The R&S SMA100B recognizes the connected USB storage device automatically.

2. Enable file transfer via USB

3. Enable write permission on the file system

4. Select "System Config > Save/Recall".

The dialog displays the /var/user/ directory and the /usb/ drive.

5. In the "Save/Recall" dialog, select "File Manager".

6. In the directory tree, navigate to the /usb/ drive.
Select the required file with user data.

7. Select "Copy".

8. In the directory tree, navigate to the /var/user/ directory.
Select "Paste".

The file with user data is transferred to the instrument.

11.9.5  Using a file server for test files exchange

You can use a central file storage location like a file server in your company network to
save setup files, SCPI scripts, application programs, or waveform files on it. Usually,
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you would like to distribute the files to several instruments. If the R&S SMA100Bs are
connected to a LAN, you can create a shortcut on the instruments to the file server.

To access the file server

1. On each R&S SMA100B, map the required directory of the file server to the instru-
ment.
Perform the steps described in Chapter 11.8.4, "How to map a network folder",
on page 328.

2. On each R&S SMA100B, use the same alias name for the directory of the file
server, i.e. enter the same "Local Folder" (in this example Setups).

On any of the R&S SMA100B, you access the file server directly from the "File
Manager" and under the same name, e.g. /shares/Setups.
An extra advantage in remote control is that the same application program would
control the instruments.
For example, use the remote control command MMEMory:CDIRectory
"/shares/Setups" to set the default directory for mass storage.

11.10  Creating screenshots of current settings

The save/recall function enables you to save current settings in a file. To document the
most important settings for a performed signal generation, you can also save a hard-
copy of the current display.

● Hardcopy settings................................................................................................. 336
● How to save a hardcopy of the display................................................................. 340

11.10.1  Hardcopy settings

Access:

► Select "System Config > Setup > User Interface > Hardcopy".

Creating screenshots of current settings
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The remote commands required to define these settings are described in Chap-
ter 14.11, "HCOPy subsystem", on page 483.

Settings:

File.............................................................................................................................. 337
Format.........................................................................................................................338
Options........................................................................................................................338
Save............................................................................................................................ 338
Hardcopy Options > Common.....................................................................................338

└ Automatic Naming.........................................................................................338
└ Format...........................................................................................................338
└ Region...........................................................................................................338

Hardcopy Options > Automatic Naming......................................................................339
└ Path...............................................................................................................339
└ Clear Path.....................................................................................................339
└ Prefix, Year, Month, Day............................................................................... 339
└ Current Auto Number....................................................................................340

File...
In "Automatic Naming > Off" mode, accesses the standard file select dialog for select-
ing the filename and folder the hardcopy is stored in.
If you have enabled "Automatic Naming", the instrument displays the automatically
generated filename.
Remote command: 
:HCOPy:FILE[:NAME] on page 485
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Format
Selects the output file format, for example *.bmp, *.jpg*.xpm and *.png.

Remote command: 
:HCOPy:IMAGe:FORMat on page 485
:HCOPy:DEVice:LANGuage on page 485

Options...
Accesses Hardcopy Options dialog.

Save
Saves a hardcopy of the current display as a file.
Remote command: 
:HCOPy[:EXECute] on page 486

Hardcopy Options > Common
Access: select "Hardcopy > Options... > Common".
With the provided settings, you can customize the file format and the syntax of the
automatically assigned filename.

Automatic Naming ← Hardcopy Options > Common
If enabled, creates the output filenames automatically according to the rules set with
the Hardcopy Options > Automatic Naming settings.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO:STATe on page 487

Format ← Hardcopy Options > Common
Selects the output file format, for example *.bmp, *.jpg*.xpm and *.png.

Remote command: 
:HCOPy:IMAGe:FORMat on page 485
:HCOPy:DEVice:LANGuage on page 485

Region ← Hardcopy Options > Common
Displays the snapshot area.
Remote command: 
:HCOPy:REGion on page 485
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Hardcopy Options > Automatic Naming
Access: select "Hardcopy > Options... > Automatic Naming".

Provided are the following settings:

Path... ← Hardcopy Options > Automatic Naming
Selects the directory.
Note: To select the destination path, specify also a filename. Otherwise an error mes-
sage is displayed and selection is canceled.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO:DIRectory on page 486

Clear Path ← Hardcopy Options > Automatic Naming
Deletes all image files with extensions *.bmp, *.jpg, *.png and *.xmp in the direc-
tory set for automatic naming.
Before the command is executed, a warning message prompts you to confirm the dele-
tion of the files.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar on page 487

Prefix, Year, Month, Day ← Hardcopy Options > Automatic Naming
Determines the rules for "Automatic Naming".
Per default, the automatically generated filename is composed of:
<Path>/<Prefix><YYYY><MM><DD><Number>.<Format>, where Y, M and D mean
year, month, Day; Number is the Current Auto Number.

You can activate or deactivate each component separately.
The "Resulting filename" indicates the current filename syntax.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix on page 488
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe on page 488

Creating screenshots of current settings



File and data managementR&S®SMA100B

340User Manual 1178.3834.02 ─ 09

:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe on page 487
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe on page 487
:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe on page 487

Current Auto Number ← Hardcopy Options > Automatic Naming
Indicates the number which is used in the automatically generated filename.
Note: When initially switching on the instrument, the number is reset to the lowest pos-
sible value. Starting with number 0 the output directory is scanned for existing files. As
long as files with the same name are existing, the number is increased by 1. The num-
ber is automatically set so that the resulting filename is unique within the selected path.
The current number is not in the save/recall file but is temporarily stored within the
database. At the following save operation, the number is increased.
Remote command: 
:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer? on page 488

11.10.2  How to save a hardcopy of the display

1. Select "System Config > Setup > User Interface > Hardcopy".

2. To define the output format, select "Format > JPG".

3. To enable the instrument to create output filenames, select "Automatic Naming >
On".

4. Select "Options...".

5. In the "Hardcopy Options" dialog:
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a) To change the default directory the file is saved in, select "Automatic Naming
Settings > Path" and define a path and a filename. For example, select the
default directory /var/user.

b) If necessary, disable or change some of the parameters in the "Automatic Nam-
ing Settings".

c) Close the "Hardcopy Options" dialog.

6. In the "Hardcopy" dialog, select "Save".

The instrument saves a hardcopy of the current instrument display as a *.jpg file.
The filename is automatically created.

7. To print the hardcopy, connect the instrument to a LAN and:

a) Transfer the file to a remote computer as described in Chapter 11.9, "How to
transfer files from and to the instrument", on page 330.

b) On the remote computer, navigate through the file system.
c) Print the selected file.

For more information, refer to the online help of the operating system.
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12  General instrument functions
The general instrument functions include basic instrument settings, regardless of the
selected operating mode and measurement. Some of these settings like screen display
and peripherals are initially configured at the setup of the instrument, according to per-
sonal preferences and requirements. However, you can individually adjust the settings
at any time, for example, if necessary for specific applications.

The following special functions help you in service and basic system configuration:
● Chapter 12.1, "Customizing the user interface", on page 342

Allows you to adjust the display and keyboard language settings.
● Chapter 12.2, "Organizing frequently used settings as favorites", on page 347

Enables you to group user defined settings in a favorites list or to assign actions to
the [★ (User)] as quick access for later retrieval.

● Chapter 12.3, "Managing licenses and license keys", on page 354
If you have purchased an additional option for the R&S SMA100B, you can enable
it using a license key.

● Chapter 11.2, "Restoring the (default) instrument configuration", on page 311
At any time, you can restore a default configuration to start a measurement at a
defined instrument state, or set the instrument to factory preset.

● Chapter 17.3, "Performing maintenance tasks", on page 761
Special functions like calibration routines and self-tests put your instrument to an
initial state.

● Chapter 12.4, "Using the security settings", on page 360
Special security and protection functions protect your instrument from unauthorized
use or activate specific test routines.

12.1  Customizing the user interface

The R&S SMA100B provides basic alignments of instrument settings regarding the
user interface, that means the touch panel (screen), the appearance of the displayed
dialogs and graphics, and an external keyboard.

Start / stop display update

The operating system of the R&S SMA100B refreshes the displayed settings by default
in almost real-time, to keep the display updated with the internally used values. How-
ever, you can turn off this function to reduce settling times when the instrument is
remote controlled.

We recommend that you switch off the display update for optimum sweep performance
with short dwell times and for fast settling times.
Consider that in this case the displayed values can differ from the operated values.
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In detail described in the following paragraphs, you can:
● Set display and keyboard language, see Chapter 12.1.1, "Display and keyboard

settings", on page 343
● Set date and time for the system clock, see Chapter 17.3.2, "Date and time",

on page 766
● Configure and activate a Screen Saver
● Deactivate display update to improve performance, see Chapter 12.1.2, "Display

update settings", on page 344
● Determine the state of the RF signal, and the level display in the status bar when

you turn on the R&S SMA100B, see Chapter 12.1.3, "Defining the RF signal state
on power on", on page 345.

12.1.1  Display and keyboard settings

Access:

1. Select "System Config > Setup > User Interface > Display/Keyboard > Display".

2. Select "Display/Keyboard > USB Keyboard".

In the "Display/Keyboard" dialog, you can change regional and language options
for the GUI and an external keyboard, and define the screen saver settings.

The remote commands required to configure the display and keyboard are described in
Chapter 14.9, "DISPlay subsystem", on page 477 and Chapter 14.12, "KBOard sub-
system", on page 488.

Screen Saver.............................................................................................................. 344
Wait Time.................................................................................................................... 344
Display........................................................................................................................ 344
RF Hardkey................................................................................................................. 344
USB Keyboard > Layout..............................................................................................344
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Screen Saver
Activates the screensaver.
If activated, the display including backlight is switched off after the selected Wait Time
elapses and if no entries via touch panel, front panel, external mouse, or external key-
board are made
Remote command: 
:DISPlay:PSAVe[:STATe] on page 479

Wait Time
Enters the idle time that must elapse before the display lamp is shut off when no
entries are made.
Remote command: 
:DISPlay:PSAVe:HOLDoff on page 478

Display
Adjusts the brightness of the display.
Increase the value to turn up the display brightness.
Remote command: 
:DISPlay:BRIGhtness on page 479

RF Hardkey
Adjusts the brightness of the [RF on/off] key.
Increase the value to change the contrast between the key and the front panel back-
ground color.
Remote command: 
:DISPlay:BUTTon:BRIGhtness on page 479

USB Keyboard > Layout
Selects the language of an externally connected keyboard via USB. The function
assigns the corresponding keys automatically.
Remote command: 
:KBOard:LAYout on page 489

12.1.2  Display update settings

Access:

► Select "System Config > Setup > User Interface > Start/Stop Display Update".
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This dialog enables you, to deactivate updating the display.

The remote command to switch off the display update is described in Chapter 14.9,
"DISPlay subsystem", on page 477.

Display Update is
Disables the automatic refreshing of the displayed values.
Remote command: 
:DISPlay:UPDate[:STATe] on page 479

12.1.3  Defining the RF signal state on power on

As additional functions for the level settings, you can determine the state of the RF sig-
nal, and the level display in the status bar when you turn on the R&S SMA100B.

Power-On/EMF settings

Access:

► Select "Level" > "Power-On / EMF".

The "Power-On/EMF" dialog contains all settings for configuring the power-on
behavior and the level display.

Settings:

Power-On State...........................................................................................................345
Display Level as Voltage of EMF................................................................................ 345

Power-On State
Determines the RF signal output state when the instrument is switched on.
You can disable the RF output signal in general, or start it in the same state as it had
been when it was switched off.
Remote command: 
:OUTPut<hw>[:STATe]:PON on page 490

Display Level as Voltage of EMF
Activates display of the signal level as voltage of the EMF (no-load voltage).
If disabled, the level is displayed as a voltage over a 50 Ohm load.
Note:
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The setting is not affected by an instrument preset ([Preset] key or *RST) and the
"Save/Recall" function. It is reset only by factory preset.
Remote command: 
[:SOURce<hw>]:POWer:EMF:STATe on page 685

12.1.4  How to set the initial instrument settings

This section describes how to set up the R&S SMA100B initially.

12.1.4.1  Setting the keyboard language

You can select the language of the external keyboard connected to the instrument.

To adjust the keyboard settings

1. Press the [Setup] key.

2. Select "User Interface > Keyboard".

3. Select the "Layout".

The dialog closes and the changes take effect immediately.

12.1.4.2  Setting the screen saver

You can enable a screen saver that automatically turns off the display after a user-
defined period of time. The screen saver is activated if no settings are made on the
touch screen, or via keys or the rotary knob during the selected wait time.

To activate the screen saver

1. Press the [Setup] key.

2. Select "User Interface > Display"

3. Activate the "Screen Saver".
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4. Define the "Wait Time" in minutes.

The instrument turns off the display after the defined period of time.

5. To reactivate the display, tap the screen or press any key on the front panel.

To deactivate the screen saver

1. Press the [Setup] key.

2. Select "User Interface > Display"

3. Disable the "Screen Saver" state.

12.2  Organizing frequently used settings as favorites

The R&S SMA100B provides two possibilities to define frequently used settings and
procedures for later retrieval individually.

User menu and [★ (User)] key

These two functions work similar to the favorites function of a browser or other pro-
grams. They allow you to create a list of frequently used actions or to group frequently
used settings in one dialog.

You can collect the parameters of your configuration in a favorites list, i.e. in the "User
Menu", or define settings and actions with the [★ (User)] key:
● "User Menu" to group settings of specific tasks.

Similar to a favorites function, you can use this menu for:
– Grouping the settings required for a task in one dialog.
– Saving and recalling the settings of a task.
– Transferring the settings for use on multiple instruments.

● [★ (User)] key, with customizable function.
You can perform the following steps using this key:
– Open the "User Menu" (default functionality).
– Add or remove settings and functions.
– Execute actions and access functions.

Organizing frequently used settings as favorites
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Possible applications

The ★ (User) key and the "User Menu" are useful for the following situations:
● There are functions or tasks you have to perform in a defined order but the setting

parameters are distributed across several dialogs.
● There are functions or tasks you have to perform frequently but they are not acces-

sible via the front panel keys.
● The required functions are grouped in a dialog that is not directly accessible from

the home screen.
● Your task involves the frequently loading and executing of certain SCPI scripts.

Refer to Chapter 13.9.4, "How to record / create SCPI lists", on page 434 for infor-
mation on how to create an SCPI script.

● A quick access to saved setups is required.
● There are functions and tasks you have to perform on several instruments.

Dialog identification

To identify each dialog, the instrument uses a dedicated dialog ID. The dialog ID con-
tains the dialog position on the display and the current active tab. The action that trig-
gers the instrument to open a dialog uses this identification.

Save/Recall vs. recall setup

If you need to restore a specific signal generation setup and perform further configura-
tions based on this particular instrument state, the R&S SMA100B provides two
options:
● "Save/Recall" function

For a detailed description, refer to Chapter 11.4, "Saving and recalling instrument
settings", on page 317.

● "Recall Setup" function
If the "Recall Setup" is the only user action assigned to the [★ (User)] key, pressing
this key triggers the R&S SMA100B to load the user-defined preset file immedi-
ately.

12.2.1  User menu settings

The "User Menu" dialog contains function keys to organize, save and load a favorites
list. You can also modify, add or delete list entries directly in the dialog.

Clear User Menu
Removes all entries from the "User Menu" at once.

Save User Menu
Saves the current "User Menu" under the defined filename.

Recall User Menu
Loads the selected "User Menu" file.
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This function enables you to use the user specific favorites file on another instrument.
However, if functions or parameters are not provided due to varying configuration of
the instrument, the settings of these particular parameters take no effect.

12.2.2  How to use the user menu for fast adjustments

Access:

1. Press the [★ (User)] key.

The "User Menu" dialog opens.

If you execute this action for the first time, the dialog displays instructions on how
to use the "User Menu".

2. If you already have a saved user menu file on the instrument, you can load with
"Recall User Menu".

Creating a "User Menu"

To create your own user dialog with settings:

1. Open a dialog with settings you frequently use.

2. Select a parameter.

3. Open the context menu and select "Add to User Menu".
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A favorites icon  indicates that the parameter is used in the "User Menu".

The "User Menu" button in the taskbar confirms that you have created a "User
Menu" with at least one entry.

4. Press the [★ (User)] key.

The "User Menu" dialog shows all parameters that you have added to the list.

You can modify the parameter settings directly in this dialog, e.g .change a state or
set values, as you do in the particular dialog the parameter originally belongs to.

5. To remove an entry, select the parameter either in the "User Menu" or in the dialog
where it originally belongs to.

a) Open the context menu and select "Remove from User Menu".

6. To remove all entries at once, select "Clear User Menu".

7. To save your individual favorites list, select "Save User Menu", and follow the file
managing instructions.
The file system automatically assigns the file extension *.user_menu.
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8. To recall a previously saved user menu, select "Recall User Menu" and proceed
accordingly.

Providing a user menu favorites list for several instruments

To transfer files from or to an instrument:

1. Create the favorites list, as described in "Creating a "User Menu"" on page 349.

2. Save the favorites list.

3. To tansfer a file from or to an instrument, the R&S SMA100B provides several
options, see "File handling" on page 310.

12.2.3  Define user key actions settings

Access:

► Select "System Configuration > Setup > User Interface > Define User Key".

The dialog displays a list of the currently enabled actions and provides functions to
define new, edit or remove existing actions. If no actions have been defined, the list
is empty.
See Chapter 12.2.4, "How to assign actions to the [★ (User)] key", on page 353.

The remote commands required to define these settings are described in Chapter 14.9,
"DISPlay subsystem", on page 477.

Name
Enters a user-defined name for the action.

Wizard
Defines the action to be executed.
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"Load SCPI Script"
Selecting the action load and executes the SCPI script.

"Recall Setup" Load a setup for quick access to the user-defined settings.
"Open Dialog"

Quick access to the selected dialog.

Select
Depending on the selected "Wizard", provides access to:
● The standard "File Select" function for loading of an SCPI script or setup file
● A list of the dialog IDs of all currently opened dialogs. The dialog ID is used for dia-

log identification in the remote control.
See SCPI.

SCPI
For the currently selected action, displays the corresponding SCPI command with the
associated parameter for dialog identification (dialog ID). The automatically displayed
SCPIs are enabled for subsequent modification.
Remote command: 
:DISPlay:DIALog:OPEN on page 481
See also :DISPlay:DIALog:ID? on page 480

Add, Change, Remove
Standard functions for managing of the actions.

Back to Execute Mode
Opens the "Select Action to Execute" dialog. Select an Action form the list to execute
it.
To return to the "Define User Key Actions" dialogs, select Select Action to Execute >
Define Actions.

Select Action to Execute > Define Actions

Accesses the "Define User Key Actions" dialog.
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12.2.4  How to assign actions to the [★ (User)] key

The customizable [★ (User)] key has no predefined function assigned. You can individ-
ually define actions to be executed or functions to be accessed when pressing this key.

To assign a frequently used dialog to the [★ (User)] key:

1. Open the dialog you want to quickly access.
For example, select "Level > UCOR > Import/Export"

2. Select "System Configuration > Setup > User Interface > Define User Key".

3. To create an action:

a) Specify the "Name".
E.g. OpenUcorImportExportList.

b) Select "Wizard > Open Dialog"
c) Select "Select" and select the dialog ID from the list

The corresponding SCPI command is automatically displayed and can be later
modified.

4. Select "Add" to store the new action in the list of user key actions.

5. To execute the created action, press ★ (User).
In the list of actions ("Select Action to Execute" dialog), navigate to the required
action.
In this example, this is "OpenUCORImportExportList".
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The R&S SMA100B executes the action and opens the dialog.

12.3  Managing licenses and license keys

An option is ready to operate after it is enabled with a license keycode supplied with
the option. The license key is delivered as a file or on paper. Unregistered licenses
must be registered for a particular instrument before the corresponding option can be
enabled for operation.

For reliable operation, a software option usually requires the latest firmware version.
The required version is specified in the delivery. If your instrument works with a former
firmware version, update the firmware before enabling the software option.
The firmware update is described in the release notes provided on the product page of
the R&S SMA100B.

12.3.1  Manage license keys settings

The "Manage Licnese Keys" dialog provides all information on the available licenses.
Instrument-related steps guide you through the process of registering or deactivating
licenses.

Access:

1. Select "System Config > Setup > Instrument Assembly > Manage License Keys >
Manage License Keys".

Managing licenses and license keys
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In this tab, you can activate licenses for newly purchased or newly registered
options.

2. Select "System Config > Setup > Instrument Assembly > Manage License Keys >
Installed License Keys".

This tab lists all active options, with information on the available number of an
option, the license type and registration. You can query inactive or disabled options
also.

3. Select "Open License Server".
See Chapter 12.3.2, "Using the license server", on page 357.

The "Manage License Keys" dialog covers all required parameters for activating or
deactivating newly purchased or newly registered options, and provides access to
the onboard license server, see Chapter 12.3.2, "Using the license server",
on page 357.
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Settings

Device ID.....................................................................................................................356
Enter License Key....................................................................................................... 356
Import License Key from File...................................................................................... 356
Export Deactivation Response to File......................................................................... 356
License Installation Info...............................................................................................356
Installed License Keys................................................................................................ 356

└ Show Inactive................................................................................................356
└ Show Deactivated.........................................................................................356
└ Installed License Keys Table.........................................................................357

Open License Server.................................................................................................. 357

Device ID
Displays the instrument-specific identification number. The device ID is a unique string
with the following structure:
<stock number>-<serial number>-<checksum>

Enter License Key
Type here the license key provided with the option.
For license keys delivered as a file, use Import License Key from File....

Import License Key from File...
Opens a dialog for selecting the file with the license key.
Use this function also to import the deactivation key file generated by the R&S License
Manager online tool (see How to move a portable license).

Export Deactivation Response to File...
Exports the generated deactivation response key to a file and opens a file manage-
ment dialog to save the file.
This key is required during the unregistration process, e.g. when you want to deinstall
an option or have a portable option, which you want to register later on another instru-
ment (see How to move a portable license).

License Installation Info
Indicates status information on the performed actions.

Installed License Keys
Access: select "System Config > Setup > Instrument Assembly > Manage License
Keys > Installed License Keys".
Comprises information on the installed options.

Show Inactive ← Installed License Keys
Enables the display of the inactive (expired) licenses in the Installed License Keys
Table.

Show Deactivated ← Installed License Keys
Enables the display of the deactivated licenses in the Installed License Keys Table.
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See How to move a portable license for information on how to activate deactivated
licenses.

Installed License Keys Table ← Installed License Keys
Shows information on the currently installed options.
"Export License Key to File"

Opens a dialog to save the generated license key file. This file is
required during the unregistration process.
If you have a portable unregistered option, you can register it later on
another instrument (see How to move a portable license).

"Option" Displays the option short designation.
Tip: Open the Hardware Options/Software Options dialog to retrieve
more information about the installed options.

"License Count"
Displays the number of the licenses for the selected option key.

"License Type" Displays the type of license.
A license type determines the common qualification application dura-
tion and the portability of a license. The following license types are
provided: evaluation, permanent, portable, quantified, time-controlled
with a duration of 1, 3, 6 or 12 months. A license can also be deacti-
vated or expired.
For time limited licenses, the left time of applicability is displayed too.

"Registrations" (reserved for future use)

Open License Server
Opens the R&S License Server of the R&S SMA100B, see Chapter 12.3.2, "Using the
license server", on page 357.

12.3.2  Using the license server

The R&S SMA100B now supports handling of software licenses using the license
server from Rohde & Schwarz.

The R&S License Server is a browser application you can access directly in the
R&S SMA100B. The onboard license server is integrated in the instrument firmware
with connection to a local smartcard memory. The local smartcard holds local licenses,
i.e. licenses used on this specific instrument.

To open the license server

Access:

1. Select "System Config > Setup > Instrument Assembly > Manage License Keys >
Installed License Keys".
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2. Select "Open License Server".

The license server browser opens. The application shows the internal license
server of the R&S SMA100B in the "License providers" tile. The "License", "Analyt-
ics" and "Configuration" views enable you to activate licenses, or, e.g., deactivate
and release licenses again.
In the "License Info" tile on the right, the application shows the characteristics of
the selected license provider.

To expand the license key list window, fold in  the "License Provider" and the
"License Info " tiles .

Short glance at the "Analytics" and "Configuration" views

To get a brief introduction on these views:

1. Select "Analytics".

Shows information on configured client applications, license providers and license
types. It provides access to the client applications and enables you to export statis-
tics data for evaluation in external applications.

2. Select "Configuration".

Shows configured license servers, access lists and installed product definitions. It
provides access to add and to remove license server configurations and to manage
local licenses.

For details on handling and functionality, see the manual R&S®License Server -
Managing Licenses - User Manual

To manage licenses on the R&S SMA100B

To request or return a license, proceed as follows:

1. Access: see "To open the license server" on page 357.
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The browser application opens.

2. Select the "Licenses" view.

3. In the "Licenses providers" tile, select the license provider, e.g. R&S SMAB.

The license server shows the license key list with the options available for the
selected provider. In this example, the licenses of the R&S SMA100B.

4. Select the option license summary view .

This view lists the options, the number of available licenses, and the state of their
use. In the last column, you can see the maintenance expiration date of each
license.

5. To request enabling a license, select  (activate) in the toolbar.

6. To return the license, select  (discontinue).

7. Follow the instructions on the screen.

12.3.3  How to move a portable license

This example is intended to explain how to perform the required steps at the instru-
ment.

Use a USB flash drive to transfer the license key files between the instruments and the
browser.

We assume knowledge about the handling of the R&S License Manager online tool
and the description of the whole process.

1. Open your browser. Enter https://extranet.rohde-schwarz.com/service.
Select "Manage Licenses > Move Portable License".

The first step requires the Device IDs of the source and target instruments.

2. To find out the Device IDs, proceed as follows:

a) On the source instrument, select "System Config > Setup > Instrument Assem-
bly > Manage License Keys > Manage License Keys > Device ID".

b) On the target instrument, select "System Config > Setup > Instrument Assem-
bly > Manage License Keys > New License > Device ID".

c) In the browser, select "Manage Licenses > Move Portable License > Select
Devices".

d) Enter the Device IDs.

Managing licenses and license keys
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3. On the source instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > Installed License Keys > License Keys Table".

a) Navigate to the portable license that you want to move.
b) Select the "Export License to File" column.

A standard file manager dialog opens.

4. Enter a filename.

5. Save the exported license key, e.g. k123_portable_key_to_move.xml.

6. In the browser, select "Manage Licenses > Move Portable License > Select
License (from file)" and

a) Select the exported license key.
b) Check the selection.
c) Create the deactivation key.
d) Save it to file.

7. On the source instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > Manage License Keys > Import License Keys from File".
Select the transferred deactivation key.

8. On the source instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > Manage License Keys > Export Deactivation Response to
File".

9. In the browser, go to "Manage Licenses > Move Portable License > Install Deacti-
vation Key (from file)".

10. Enter the deactivation response of the instrument.

The license is deactivated for the source instrument.

11. In the "Manage Licenses > Move Portable License", go to step "Create License" to
generate a license key for this portable option and the selected target instrument.

a) Download the license key as a file.
b) Transfer it to the target instrument.

12. In the target instrument, select "System Config > Setup > Instrument Assembly >
Manage License Keys > New License > Import License Keys from File".

13. Select the created license key file.

The portable option is installed on the target instrument.

12.4  Using the security settings

The protection function of the R&S SMA100B offers several levels to activate particular
functions like self-test or tests for service purposes specifically.
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Protection

The five protection levels are automatically active on startup, the protection levels, that
means all protected functions are locked.

To unlock a protection level:

► In the "System Config > Setup > Security > Protection", enter the correct password.

To lock a protection level:

► Clear the corresponding checkbox.

Protection levels

The following functions are protected in the respective levels:
● Protection level 1

Protects against accidental changes, like, for example, the clock and date, several
internal adjustments functions and the self-test, as well as network settings or the
instrument hostname.
You can access this level with the password 123456.

● Protection level 2
Unlocks protected service functions. It is accessible to authorized personnel of
Rohde & Schwarz service department only.

● Protection level 3 to 5
Are reserved for internal use.

Security

The security concept of the R&S SMA100B helps you to protect your instrument
against uncontrolled access and changes. All provided security services require that
you enter the security password.

Provided security services are:
● General security parameters, such as:

– USB storage that secures controlled access to the mass memory of the instru-
ment

– Volatile mode that prevents information to be written to the internal memory
permanently.

– Sanitizing that prevents the instrument from leaving a secure environment with
stored user information.

– Annotation frequency and amplitude prevent reading the display.
– Secure Update Policy check that verifies the integrity and origin of the firm-

ware package to be installed.
To access the settings of these topics, see Setting security parameters >
"Secure Update Policy" on page 364.

● Password management secures controlled user access to the instrument
With the two-step password concept, you can assign a user-defined password for
the operating system, and a security password for accessing the mass storage of
the instrument.
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See also Chapter 12.4.4, "Password management", on page 370.
● LAN services secure controlled network access

You can individually lock and unlock supported LAN interface services. Also you
can activate and deactivate SMB client and SMB server, that use versions 1.0 and
2.0 of the SMB protocol. See Chapter 12.4.3, "Configuring LAN services",
on page 368.
Remote control via the LAN interface requires that the interface is activated. Once
the interface is activated, enable or disable LAN services as needed.

● User interface prevents front panel operation and/or reading the display.

For more information, see the document R&S SMA100B Instrument Security Proce-
dures.

12.4.1  Protection level settings

Access:

► Select "System Config > Setup > Security > Protection".

The "Protection" dialog provides access to the unlocking of different protection lev-
els.
Several functions in the instrument are password-protected to prevent for example
accidental changes, "Protection" on page 361.

The remote commands required to unlock a protected stage are described in Chap-
ter 14.17, "SYSTem subsystem", on page 712.

Protection Level/Password
Unlocks the selected level of protection, if you enter the correct password.
The default protection level 1 password is 123456.
To lock the protection level again, clear the checkbox.
Remote command: 
:SYSTem:PROTect<ch>[:STATe] on page 721
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12.4.2  Setting security parameters

Access:

► Select "System Config > Setup > Security > Security > General".

In the "General" tab, you can determine the security level for firmware updates, and
configure the security settings for the mass memory and manual operation.

All modified settings in this dialog are not applied until you enter the Security Password
and confirm with Accept.

12.4.2.1  Update policy security settings

Access:

► Select "System Config > Setup > Security > Security > General > SW Update".

The SW Update tab enables you to select the security mode for firmware updates.

The remote commands available to control security settings are described in Chap-
ter 14.17, "SYSTem subsystem", on page 712.
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Secure Update Policy
Allows you to configure the automatic signature verification for firmware installation.
To apply the change: enter the security password and confirm with "Accept". Otherwise
the change has no effect.
See also:
● Chapter 12.4, "Using the security settings", on page 360 for more information on

the security concept.
● The release notes for details on signature verification when installing new or former

firmware versions, available at www.rohde-schwarz.com/firmware/sma100b.
"Confirm Unsigned"

Performs the signature verification.
If the check detects any discrepancies, the instrument issues a warn-
ing message. You can still update the firmware or reject updating.
This setting also enables you to downgrade the firmware version.

"All Packages" Accepts all packages without signature verification.
"R&S Signed Packages"

Performs the signature check.
If the check detects any discrepancies, the instrument issues a warn-
ing message and locks the update to this firmware.

Remote command: 
:SYSTem:SECurity:SUPolicy on page 730

12.4.2.2  Disk & memory security settings

Access:

► Select "System Config > Setup > Security > Security > General > Disk & Memory".

The "Disk & Memory" tab secures controlled access to the mass memory and pre-
vents information from leaving a secure environment.

The remote commands available to control security settings are described in Chap-
ter 14.17, "SYSTem subsystem", on page 712.
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USB Storage
Activates the access to external USB storage media.
To apply the change: enter the security password and confirm with "Accept". Otherwise
the change has no effect.
See also Chapter 11.9.4, "Using a USB storage device for file transfer", on page 335.
Note: Remove all USB memory devices before disabling the USB storage. If any USB
memory device remains connected, disabling is blocked, and the instrument returns a
warning message.
The microSD card is also considered a USB memory device and must be removed. If
you have sealed the SD card slot, you can not disable the USB storage.

Volatile Mode
Activates volatile mode, so that no user data can be written on the internal memory
permanently.
In volatile mode:
● Data that the instrument normally stores on the internal memory is redirected to

volatile memory.
● The user directory is mapped to the volatile memory. You access the temporary

data just as data stored in the /var/user/, see Chapter 11.3, "Protecting data",
on page 316.

● Data on the internal memory cannot be changed. It is protected against modifica-
tion or erasure.

● You can only save data:
– Temporarily in the volatile memory
– On a connected external storage device, such as a memory stick

To activate volatile mode: enter the security password, confirm with "Accept" and
reboot the instrument. Otherwise the change has no effect.
Activated volatile mode is indicated by the icon .
Remote command: 
:SYSTem:SECurity:VOLMode[:STATe] on page 722

Sanitize
Executes the erase procedure that sanitizes the internal memory.
The sanitizing function makes sure that no user information is stored on the instrument
when it leaves the secure environment.
To apply the change: enter the security password and confirm with "Accept". Otherwise
the change has no effect.
Note: If the instrument is subject to high security, and you have disabled volatile mode,
the internal memory holds user-data, and thus poses a security risk.
See also Chapter 12.4, "Using the security settings", on page 360 for more information
on the security concept.
Remote command: 
:SYSTem:SECurity:SANitize[:STATe] on page 730
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12.4.2.3  Manual operation security settings

Access:

► Select "System Config > Setup > Security > Security > General > Manual Opera-
tion".

The "SW Update" tab enables you to lock front panel operation and/or reading the
display.

The remote commands available to control security settings are described in:
● Chapter 14.9, "DISPlay subsystem", on page 477
● Chapter 14.17, "SYSTem subsystem", on page 712.

Annotation Frequency
Enables the display of the currently used frequency in the status bar.
How to: see "Disabling the frequency and level indication in the status bar"
on page 375.
Remote command: 
:DISPlay:ANNotation:FREQuency on page 480

Annotation Amplitude
Enables the display of the currently selected level in the status bar.
How to: see "Disabling the frequency and level indication in the status bar"
on page 375.
Remote command: 
:DISPlay:ANNotation:AMPLitude on page 480

User Interface
Allows you to lock the controls for manual operation and the display individually.
How to: see "Deactivating the user interface" on page 375.
See also Chapter 12.4, "Using the security settings", on page 360.
"Enabled" Enables the display and all controls for the manual operation of the

instrument.
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"Touchscreen Off"
Locks the touch sensitivity of the screen.
This security feature protects the instrument against unintentional
change of settings by accidentally touching of the screen.
Still available controls for manual operation are:
● The keys at the front panel, including the rotary knob
● The external mouse and keyboard
● Remote operation over VNC
The instrument indicates the locked touchscreen by an icon .
Unlocking is possible via VNC, external controls or remote control.

"VNC Only" Locks the keys at the front panel, the touchscreen and externally con-
nected keyboard and mouse.
The display on the screen remains and shows the current settings
and changes.
The instrument indicates the activated "VNC only" feature by the icon

.
Unlocking is possible via VNC or turning off and on again.

"Display Only" Locks the manual operation of the instrument. The display on the
screen remains and shows the current settings and changes.
This security feature protects the instrument against unauthorized
access, but still shows the current settings and processes, for exam-
ple when you operate the instrument via remote control.
The function disables:
● The touchscreen functionality of the display
● The keys at the front panel of the instrument
● The external mouse and keyboard
The instrument indicates the locked controls by a padlock  softkey.
How to unlock: see "Unlocking (reactivating) the user interface for
manual operation" on page 375.

"Disabled" Locks the display and all controls for the manual operation of the
instrument.
This security feature protects the instrument against unauthorized
reading and access, for example when you operate the instrument via
remote control.
The function disables:
● The display
● The touchscreen
● The keys at the front panel of the instrument
● The external mouse and keyboard
The screen shuts off and displays a padlock symbol  instead.
How to unlock: see "Unlocking (reactivating) the user interface for
manual operation" on page 375.

Remote command: 
:SYSTem:ULOCk on page 719
:SYSTem:DLOCk on page 718
:SYSTem:KLOCk on page 719
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Enabling a locked user interface for manual operation
Follow the instructions listed in "Unlocking (reactivating) the user interface for manual
operation" on page 375.
Remote command: 
:SYSTem:ULOCk on page 719
:SYSTem:DLOCk on page 718
:SYSTem:KLOCk on page 719

12.4.3  Configuring LAN services

Access:

1. Select "System Config > Setup > Security > Security > LAN Services > Main Ser-
vices".

In the "Main Services" side tab, you can individually enable or disable the suppor-
ted LAN interface services.

2. Select "System Config > Setup > Security > Security > LAN Services > Samba Ser-
vices".

In the "Samba Services" side tab, you can activate older versions of the SMB client
and SMB server.
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How to:
● "Disabling the LAN interface" on page 374
● "Disabling LAN services" on page 374
● "Activating SMB version 1.0/2.0 client and server" on page 374

Common Services
Enable or disable the LAN interface and supported LAN interface services.

LAN ← Common Services
Enables the LAN interface in general, and thus provides remote access via all
unlocked services.

Enable LAN Services individually ← Common Services
Enables or disables the following interface services individually.
"SCPI over LAN"

Activates access over LAN to control the instrument remotely, by
using SCPI (Standard Commands for Programmable Instruments)
commands.
See also "Starting a remote control session over LAN with R&S VISA"
on page 423.

"VNC" Activates access over VNC (Virtual Network Computing) interface, a
graphical desktop sharing system that uses RFB protocol to control
the instrument remotely.
See also Chapter 13.10, "Operating the R&S SMA100B remotely
using VNC", on page 439.

"SSH (SCP)" Activates access over SSH (Secure Shell), a network protocol for
secure data communication.

"Remote Support"
Activates remote support over SSH.
Per default, this service is disabled. It provides communication for
service support purposes only.

"HTTP" Activates access via HTTP (Hyper Text Transfer Protocol), the appli-
cation protocol for hypermedia information systems.

"FTP" Activates access over FTP (File Transfer Protocol), used to transfer
files from a host to the instrument and vice versa.
See also Chapter 11.9.2, "Accessing the file system of the
R&S SMA100B via FTP", on page 332.

"SMB (Samba)"
Activates access to SMB (Server Message Block), used for providing
shared access to files, printers and serial ports of a network.
See also Chapter 11.9.3, "Accessing the R&S SMA100B file system
via SMB (Samba)", on page 333.

"Avahi (Zeroconf)"
Activates Avahi, a service for automatic configuration of the instru-
ment in a network environment.
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"Software Update"
Allows updating the software.

Samba Services
Activate or deactivate support of SMB client and SMB server version 1.0 and 2.0 of the
SMB protocol.
Support of version 1.0 and 2.0 is additional to the current SMB protocol version sup-
ported in the firmware. This firmware supports SMB protocol versions up to version 4.

SMB 1.0/2.0 Client ← Samba Services
Activates support of the SMB client compatible with SMB protocol versions 1.0 and 2.0.

SMB 1.0/2.0 Server ← Samba Services
Activates support of the SMB server compatible with SMB protocol versions 1.0 and
2.0.

Security Password
Enters the password that is required to enable or to disable the settings protected by a
security password. Default is 123456.
How to:
● "Disabling the LAN interface" on page 374
● "Disabling LAN services" on page 374
● "Changing the default security password" on page 374.

Accept
Applies the modified settings, provided the security password is entered and correct.

12.4.4  Password management

Access:

1. Select "System Config > Setup > Security > Security > Password Management >
User Password".
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In this tab, you can assign the security and a user-defined password.

2. Select "System Config > Setup > Security > Security > Password Management >
Security Password".

How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.

User Name
Indicates the user name used for access to the Linux operating system and valid for
VNC, FTP and SMB (Samba) access.
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User Password
Access: select "System Config > Setup > Security > Security > Password Management
> User Password".
Allows you to change and confirm the user password.

Old Password ← User Password
Enters the current user password. The default password is "instrument".
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.
Note: Note that you cannot reset the password to factory state.
If you encounter problems with the password, contact the Rohde & Schwarz customer
support, see Chapter 15.9, "Contacting customer support", on page 758.

New Password ← User Password
Enters the new user password.
The security password can contain decimal characters only.

Confirm Password ← User Password
Confirms the new user password by repeating.
How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.

Change Password ← User Password
Changes the user password accordingly.

Security Password
Access: select "System Config > Setup > Security > Security > Password Management
> Security Password".
Enables you to change and confirm the security password.

Old Password ← Security Password
Enters the currently used security password. The default password is '123456'.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.
The security password is required when changing the status of the USB and LAN inter-
face or other security settings.
Note: Note that you cannot reset the password to factory state.
If you encounter problems with the password, contact the Rohde & Schwarz customer
support, see Chapter 15.9, "Contacting customer support", on page 758.
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New Password ← Security Password
Enters the new security password.
The security password can contain decimal characters only.

Confirm Password ← Security Password
Confirms the new security password by repeating.
How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.

Change Password ← Security Password
Changes the password accordingly.

12.4.5  How to prevent unauthorized access

The default computer name and user password are instrument. The user password is
the password required for VNC, FTP and SMB (samba) connections. If, for example,
the VNC service or FTP are enabled, anyone in the network who knows the computer
name and user password of the instrument can access it.

The default security password is 123456. The security password is required when
changing the status of the USB and LAN interface.

To prevent unauthorized access, use the following configurations exclusively or com-
plementary:
● "Changing the default user password of the instrument" on page 373
● "Changing the default security password" on page 374
● "Disabling the LAN interface" on page 374
● "Disabling LAN services" on page 374
● "Activating SMB version 1.0/2.0 client and server" on page 374
● "Disabling the frequency and level indication in the status bar" on page 375
● "Deactivating the user interface" on page 375

If security is a concern, see the document instrument security procedures for compre-
hensive description.

Changing the default user password of the instrument

► Note: We recommend that you change the default password before connecting the
instrument to a network.

How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.

a) Select "System Config > Setup > Security > Security > Password Management
> User Password".

b) Enter the current password in the "Old Password" field.
c) Enter the new password in the "New Password" and "Confirm Password" fields.
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d) Select "Change Password".

The user password is changed; the user name is displayed ("Security > Password
Management > User Password > User Name").

Changing the default security password

► Note: We recommend that you change the default password before connecting the
instrument to a network.

How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.

a) Select "System Config > Setup > Security > Security > Password Management
> Security Password".

b) Enter the current password in the "Old Password" field.
The default password is 123456.

c) Enter the new password in the "New Password" and "Confirm Password" fields.
d) Select "Change Password".

Disabling the LAN interface

1. Select "System Config > Setup > Security > Security > LAN Services > Main Ser-
vices".

2. Select "LAN > Off".

All LAN connections and hence all LAN services are disabled.

Disabling LAN services

1. Select "System Config > Setup > Security > Security > LAN Services > Main Ser-
vices".

2. Select, for example, "FTP > Off" or "VNC > Off".

3. Enter the Security Password.

4. Select "Accept".

Activating SMB version 1.0/2.0 client and server

By default, support of SMB client and SMB server of the SMB protocol versions 1.0
and 2.0 is deactivated.

Activate support only, if needed:

1. Select "System Config > Setup > Security > Security > LAN Services > Samba Ser-
vices".

2. Select "SMB 1.0/2.0 Client > On" and "SMB 1.0/2.0 Server > On".

3. Enter the Security Password.

4. Select "Accept".
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Disabling the frequency and level indication in the status bar

These settings are useful to prevent unauthorized personnel from reading the display,
when you remotely control the instrument from a different location.

1. Select "System Config > Setup > Security > General > Manual Operation".

2. Select "Annotation Frequency > Off" or "Annotation Amplitude > Off".

3. Enter the Security Password.

4. Select "Accept".

Deactivating the user interface

1. Select "System Config > Setup > Security > General > Manual Operation".

2. Select "User Interface > Disabled".

3. Enter the Security Password.

4. Select "Accept".

The screen shuts off and displays a padlock symbol  instead.
There are further possible configurations. For details, see "User Interface"
on page 366.

Unlocking (reactivating) the user interface for manual operation

1. In manual operation:

a) On the instrument's keypad or external keyboard, press any key.
The instrument prompts you to enter the security password for unlocking.

If you press the character of the first key, the input field accepts the character
immediately.

b) Delete the entry before inserting the password.
Enter the security password 123456.

2. In remote control mode:

a) Send the command SYST:ULOC ENABled to release all locks at once.
b) Send the command SYST:KLOC OFF to unlock the keyboard and touchscreen.
c) Send the command SYST:DLOC OFF to release all locks.

Via remote control, there is no password required.

Using the security settings



General instrument functionsR&S®SMA100B

376User Manual 1178.3834.02 ─ 09

12.5  Undoing or restoring actions

"Undo" is a function that removes the effect of the last action on the instrument and
reverts it to an older state. Conversely, "Redo" restores a previously undone action.

You can "Undo/Redo" actions according to two criteria:
● Step by step

Gradually undo/redo the actions in reverse order as previously performed.
Depending on the available memory the "Undo/Redo" steps may restore all
actions.

● Multiple steps at once
Select any specific action in the history list to "Undo/Redo" multiple actions in a sin-
gle step.
Note: This mode requires a system restoration file on the instrument.

Access:

► Select "Setup > Settings > Undo/Redo".

The dialog contains all functions for enabling the "Undo/Redo" functionality.

Settings:

State............................................................................................................................376
History List.................................................................................................................. 377
Clear History............................................................................................................... 377
Apply........................................................................................................................... 377

State
Enables the recording of the performed actions.

Undoing or restoring actions
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History List
Lists the performed actions, provided "Undo/Redo" state is "On".

Clear History
Deletes the recorded list of the performed steps.

Apply
Performs the "Undo/Redo".
If you select a previously performed action of the list, all subsequent actions are
undone. The list entries remain.
If you select a subsequently executed action, you can restore all the actions undone up
to this state.

12.6  Shutting down and rebooting the instrument

The [On/Standby] front panel key switches the instrument from the standby to the
ready state or vice versa. In remote operation from a remote computer or in manual
control, there is another possibility to shut down the instrument or to reboot the system.

Access:

► Select "System Config > Setup > Maintenance > Shut Down".

● :SYSTem:REBoot on page 736
● :SYSTem:SHUTdown on page 736

Shutting down and rebooting the instrument
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13  Network operation and remote control
As an alternative to the interactive operation directly at the instrument, you can operate
the R&S SMA100B also from a remote location.

The various interfaces provide flexible access to the instrument, such as remote con-
trol, remote operation or remote file access. These remote access modes are funda-
mentally different, although they are often considered interchangeable, as described in
Overview of remote access modes.

Figure 13-1 shows the possibilities of the physical connection (interfaces) for remote
access.

The following descriptions provide information required for operating the
R&S SMA100B remotely. The information applies to all applications and operating
modes supported by the instrument. Definitions specified in the SCPI standard are not
provided.
For basic knowledge on remote control operation and additional information, see the
following documents, available on the Rohde & Schwarz website:
● Remote control via SCPI
● 1GP72: Connectivity of Rohde&Schwarz Signal Generators
● 1MA208: Fast Remote Instrument Control with HiSLIP

Figure 13-1: Supported remote connections

● Overview of remote access modes.......................................................................379
● Remote control interfaces and protocols...............................................................380
● Remote control programs and libraries.................................................................385
● Status reporting system........................................................................................ 388
● Remote access settings........................................................................................396
● LXI settings........................................................................................................... 407
● Connecting the instrument to the network (LAN).................................................. 414
● Controlling the R&S SMA100B remotely...............................................................417

https://www.rohde-schwarz.com/appnote/1GP72.html
https://www.rohde-schwarz.com/appnote/1MA208.html
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● Automating tasks with remote command scripts...................................................429
● Operating the R&S SMA100B remotely using VNC..............................................439
● References............................................................................................................445

13.1  Overview of remote access modes

This section outlines the possible access modes and their major characteristics.

Remote control (SCPI)

● A remote PC controls the instrument, usually via VISA (Virtual Instrument Software
Architecture) interfaces.

● Remote control disables the manual operation of the instrument; you can set differ-
ent lock states.

● The GUI is not visible.
● Remote control commands (SCPI) perform the settings, either individually or in

sequences (SCPI programs).
● Using SCPI programs is faster than the manual operation, since they automate

repeating applications.

Remote operation (VNC)

● A remote device accesses the instrument via the common platform technology
VNC (Virtual Network Computing).

● The protocol allows simultaneous operation from several remote devices and the
instrument nevertheless remains locally operable.

● The GUI is visible.
● To perform the settings, you can operate the instrument as with the manual control.
● During remote operation via VNC, the direct control of the instrument is not dis-

abled.
You can control the instrument from the front panel and via the remote computer
alternately.

● Clients supporting remote operation depend on the used remote device, see
Table 13-1.

● How to: see Chapter 13.10, "Operating the R&S SMA100B remotely using VNC",
on page 439.

Table 13-1: Supported VNC operation modes

Remote device VNC client Requirements Characteristics

Desktop

(Windows, Linux,
MacTMOS)

● Ultr@VNC
● Other dedicated client soft-

ware

Ultr@VNC or Client Software
must be installed.

Fast, supports several options like
full screen mode or auto-login.

 ● Any web browser Java Runtime must be installed
and activated in the browser set-
tings.

Fast and convenient - only the
instrument address required.

Java runtime is sometimes con-
sidered as security concern.

Overview of remote access modes
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Remote device VNC client Requirements Characteristics

 ● Web browser with HTML5 Web sockets must be supported. Slower than the other modes.

No additional installation or acti-
vation required.

No security concern.

Smart device

(Tablet/ smartphone)

● Dedicated client App App must be installed. Fast, supports several options like
full screen mode or auto-login.

 ● Web browser with HTML5 Web sockets must be supported. Support of QR code scanning

Slower than a dedicated App.

Remote file access (FTP, SAMBA/SMB)

● A remote client accesses the instrument's file system, using the protocols FTP (file
transfer protocol) and SAMBA/SMB (server message block).

● The protocols enable you to transfer files from or to the instrument and to get direct
access to its file sharing directory share.

How to:

Chapter 11.9, "How to transfer files from and to the instrument", on page 330.

"Activating SMB version 1.0/2.0 client and server" on page 374

13.2  Remote control interfaces and protocols

The instrument supports various interfaces for remote control. Table 13-2 gives an
overview on the connectivity:

Table 13-2: Remote control interfaces and protocols

Interface Protocols, VISA*) address string and library Remarks

Local area network
(LAN)

● HiSLIP High-Speed LAN Instrument Protocol
(IVI-6.1)
TCPIP::host address::hislip0[::INSTR]
VISA

● VXI-11
TCPIP::host address[::
LAN device name][::INSTR]
VISA

● Socket communication (Raw Ethernet, simple
Telnet)
TCPIP::host address[::
LAN device name]::<port>::SOCKET
VISA or socket controller

The LAN connector is at the rear panel of the
instrument.

The interface is based on TCP/IP, see Chap-
ter 13.2.1, "LAN interface", on page 381 for
details on the address information.

USB ● USBTMC
USB::<vendor ID>::<product ID>::
<serial number>[::INSTR]
VISA

The USB In connector is at the rear panel of the
instrument.

For a description of the interface, see Chap-
ter 13.2.2, "USB interface", on page 383

Remote control interfaces and protocols
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Interface Protocols, VISA*) address string and library Remarks

GPIB (IEC/IEEE Bus
Interface)

● VISA*) address string:
GPIB::<address>[::INSTR] (no secondary
address)
VISA (optional)

The optional GPIB bus interface according to
standard IEC 625.1/IEEE 488.1 is at the rear
panel of the instrument.

For a description of the interface, see Chap-
ter 13.2.3, "GPIB interface (IEC/IEEE bus inter-
face)", on page 384.

*) VISA (Virtual Instrument Software Architecture) is a standardized software interface library providing input and output functions to
communicate with instruments. A VISA installation on the controller is a prerequisite for remote control over LAN (when using
VXI-11 or HiSLIP protocol), USB and serial interface. When using socket communication or the GPIB interface, VISA installation is
optional. For basic information, see Remote control via SCPI.

http://www.rohde-schwarz.com/rsvisa provides the standardized I/O software library
R&S VISA for download at the Rohde & Schwarz website http://www.rohde-
schwarz.com/rsvisa.

How to: Chapter 13.8, "Controlling the R&S SMA100B remotely", on page 417
describes how to configure the remote control interfaces.

● LAN interface........................................................................................................ 381
● USB interface........................................................................................................383
● GPIB interface (IEC/IEEE bus interface)...............................................................384
● LXI browser interface............................................................................................ 385

13.2.1  LAN interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, consisting
of a connector, a network interface card and protocols.

For remote control, the PC and the instrument must be connected over the LAN inter-
faces to a common network with TCP/IP network protocol. The instruments are con-
nected using a commercial RJ45 cable (shielded or unshielded twisted-pair category
5). The TCP/IP network protocol and the associated network services are preconfig-
ured on the instrument. Software for instrument control and, if necessary, the VISA pro-
gram library must be installed on the controller.

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
the resource string.

13.2.1.1  VISA resource strings

The VISA resource string is required to establish a communication session between
the controller and the instrument in the LAN. The resource string is a unique identifier,
composed of the specific IP address of the instrument and some network and VISA-
specific keywords.

Remote control interfaces and protocols
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TCPIP::<host address>[::<LAN device name>][::INSTR]

TCPIP = designates the network protocol
host address = designates the IP address or hostname of the instrument
[::LAN device name] = defines the protocol and the instance number of a subinstrument
[::INSTR] = indicates the instrument resource class (optional)

The IP address (host address/computer name) is used by the programs to identify and
control the instrument. It is automatically assigned by the DHCP server the first time
the device is registered in the network. Optionally, you can also assign its LAN device
name.

If assigned, the IP address is displayed in the home screen. You can adjust it manually
with the parameter the "System Config > Remote Access > Network" > IP Address
Enabling a locked user interface for manual operation.

The following section lists the characteristics of the VISA resource strings for the corre-
sponding interface protocols. The emphasized characters determine the protocol.

For description of the interface protocols, control commands and messages, refer to
Remote control via SCPI.

HiSLIP

TCPIP::<host address>::hislip0[::INSTR]

hislip0 = HiSLIP device name, designates that the interface protocol HiSLIP is used (mandatory)

hislip0 is composed of [::HiSLIP device name[,HiSLIP port]] and must be
assigned.

Example: 
TCPIP::192.1.2.3::hislip0

VXI-11

TCPIP::<host address>[::inst0][::INSTR]

[::inst0] = LAN device name, indicates that the VXI-11 protocol is used (optional)

inst0 currently selects the VXI-11 protocol by default and can be omitted.

Example: 
TCPIP::192.1.2.3::INSTR

Socket communication

TCPIP::<host address>::<port>::SOCKET

Remote control interfaces and protocols
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port = determines the used port number
SOCKET = indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred to as
port number) and of "SOCKET" to complete the resource string.

Basically, instruments from Rohde & Schwarz use port number 5025 for socket com-
munication.

Example: 
TCPIP::192.1.2.3::5025::SOCKET

13.2.2  USB interface

Option: R&S SMAB-B86

For remote control using USB, the controller PC and the instrument must be connected
over the USB type B interface. Software for instrument control and the VISA program
library must be installed on the controller.

The serial interface "RS232" enables you to connect the instrument over serial inter-
face. You can connect to the interface by using the external USB/serial-adapter
R&S TS1-USB (see recommended extras in the data sheet) and a serial crossover
(null modem) cable.

VISA detects and configures the Rohde & Schwarz instrument automatically when the
USB connection is established. You do not have to install a separate driver.

USBTMC (USB Test & Measurement Class Specification) is a protocol that is built on
top of USB for communication with USB devices. It defines class code information of
the instrument, that identifies its functionality to load the respective device driver. Using
VISA library, the protocol supports service request, trigger, and other specific opera-
tions.

13.2.2.1  USB resource string

The resource string represents an addressing scheme that is used to establish a com-
munication session with the instrument. It is based on the instrument address and
some instrument- and vendor-specific information.

The USB resource string syntax is as follows:

USB::<vendor ID>::<product ID>::<serial number>[::INSTR]

USB = denotes the used interface
<vendor ID> = is the manufacturer ID for Rohde & Schwarz
<product ID> = is the product identification of the instrument
<serial number> = is the individual serial number at the rear of the instrument
[::INSTR] = indicates the instrument resource class (optional)

To set the USB resource string, see Remote access settings.

Remote control interfaces and protocols
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Example: 
USB::0x0AAD::0x01DD::100001::INSTR
0x0AAD is the vendor ID for Rohde & Schwarz.
0x01DD is the product ID for the R&S SMA100B
100001 is the serial number of the particular instrument.

13.2.2.2  RS232 resource string

The RS232 resource string represents the addressing scheme for a device connected
to the serial interface of the instrument.

The USB resource string syntax is as follows:

ASRL<port number>[::INSTR]

ASRL is the name of the serial interface

<port number> is the number of the serial interface

Example: 
ASRL1::INSTR

13.2.3  GPIB interface (IEC/IEEE bus interface)

Option: R&S SMAB-B86

To control the R&S SMA100B over the GPIB bus, the instrument and the controller PC
must be connected with a GPIB bus cable. A GPIB bus card, the card drivers and the
program libraries for the used programming language must be installed on the control-
ler.

For description of the characteristics, control commands and messages of the GPIB
interface, refer to Remote control via SCPI.

GPIB address

The controller PC addresses the instrument with the GPIB bus channel, see Chap-
ter 13.5.3, "GPIB address settings", on page 402. GPIB provides channel addresses
from 0 to 30.

The GPIB resource string syntax is as follows:

GPIB:://<channel>[::INSTR]

GPIB = denotes the used interface
<channel address> = the used channel
[::INSTR] = indicates the instrument resource class (optional)

Remote control interfaces and protocols
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Note: If the VISA implementation supports the GPIB interface, you can optionally
define the VISA Instrument Control Resource (INSTR). It is used to define the basic
operations and attributes for a device, such as reading, writing, or triggering.

Example: 
GPIB::28::INSTR
28 is the selected GPIB bus channel

13.2.4  LXI browser interface

The LXI browser interface allows easy configuration of the LAN and remote control of
the R&S SMA100B without additional installation requirements. The instrument's LXI
browser interface works correctly with all W3C compliant browsers.

See Chapter 13.11.1, "LXI functionality", on page 445 for more about LXI.

The LAN settings are configured using the instrument's LXI browser interface descri-
bed in Chapter 13.6.2.1, "LAN configuration", on page 410.

13.3  Remote control programs and libraries

This section shows how the remote-control programs access the instrument, and the
libraries they require for the corresponding interface protocols.

Figure 13-2: Overview of remote control interfaces, protocols and libraries

Possible setups and access functions

The following examples give an overview of dependencies between the available libra-
ries, the possible interfaces and protocols, and whether an instrument driver is provi-
ded. For detailed information, see the application note 1GP72: Connectivity of
Rohde&Schwarz Signal Generators.

Remote control programs and libraries
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Example: Remote control (application) program using VISA

Figure 13-3: Application program using VISA

Protocol Remote control program

Socket viOpen (..., "TCPIP:SMA100B-102030::5025::SOCKET", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

VXI-11 viOpen (..., "TCPIP:SMA100B-102030::inst0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

HiSLIP viOpen (..., "TCPIP:SMA100B-102030::hislip0::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

USBTMC viOpen (..., "USB::0x0AAD::0x01DD::100001::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

GPIB viOpen (..., "GPIB::28::INSTR", ...)
viPrintf (..., "SOUR:FREQ 2GHz\n")

Remote control programs and libraries
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Example: Remote control program using instrument driver (VISA available)

Figure 13-4: Application using instrument driver (VISA available)

Protocol Remote control program

Socket rssma_init ("TCPIP:SMA100B-102030::5025::SOCKET", ...)
rssma_SetFrequency (..., 2e9)

VXI-11 rssma_init ("TCPIP:SMA100B-102030::inst0::INSTR", ...)
rssma_SetFrequency (..., 2e9)

HiSLIP rssma_init ("TCPIP:SMA100B-102030::hislip0::INSTR", ...)
rssma_SetFrequency (..., 2e9)

USBTMC rssma_init ("USB::0x0AAD::0x01DD::100001::INSTR", ...)
rssma_SetFrequency (..., 2e9)

GPIB rssma_init ("GPIB::28::INSTR", ...)
rssma_SetFrequency (..., 2e9)

Remote control programs and libraries
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Example: Remote control program using instrument driver (VISA not available)

Figure 13-5: Remote control program using instrument driver (VISA not available)

Protocol Remote control program

Socket rssma_init ("TCPIP:SMA100B-102030::5025::SOCKET", ...)
rssma_SetFrequency (..., 2e9)

GPIB rssma_init ("GPIB::28::INSTR", ...)
rssma_SetFrequency (..., 2e9)

13.4  Status reporting system

The status reporting system stores all information on the current operating state of the
instrument, and on errors which have occurred. This information is stored in the status
registers and in the error queue.

You can query both with the commands of the STATus subsystem.

13.4.1  Hierarchy of the status registers

The Figure 13-6 shows the hierarchical structure of information in the status registers
(ascending from left to right).

Status reporting system



Network operation and remote controlR&S®SMA100B

389User Manual 1178.3834.02 ─ 09

Figure 13-6: Graphical overview of the status registers hierarchy

OPER = Operation Status Summary Bit
RQS/MSS = Service Request Generation
ESB = Standard Event Status Summary Bit
MAV = Message Available in Output Queue
QUES = Questionable Status Summary Bit
2 = Error- /Event-Queue
1, 0 = not used

Note: This legend explains the abbreviations to the Status Byte Register.

The R&S SMA100B uses the following status registers:
● Status Byte (STB) and Service Request Enable (SRE), see Chapter 13.4.3, "Sta-

tus byte (STB) and service request enable register (SRE)", on page 392.

Status reporting system
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● Standard Event Status, i.e. the Event status Register (ESR) and the Event Status
Enable (ESE), see Chapter 13.4.4, "Event status register (ESR) and event status
enable register (ESE)", on page 393.

● Questionable Status and Operation Status, the (SCPI status registers, see
Chapter 13.4.2, "Structure of a SCPI status register", on page 390, Chapter 13.4.5,
"Questionable status register (STATus:QUEStionable)", on page 393 and Chap-
ter 13.4.6, "Operation status register (STATus:OPERation)", on page 394.

● Output-Queue
The output queue contains the messages the instrument returns to the controller. It
is not part of the status reporting system but determines the value of the MAV bit in
the STB and thus is represented in the overview.

● Error- /Event-Queue
The error-/event-queue contains all errors and events that have occurred in the
past. When reading the queue, the instrument starts with the first occurred error/
event.

All status registers have the same internal structure.

SRE, ESE
The service request enable register SRE can be used as ENABle part of the STB if the
STB is structured according to SCPI. By analogy, the ESE can be used as the ENABle
part of the ESR.

13.4.2  Structure of a SCPI status register

Each SCPI status register consists of five parts. Each part has a width of 16 bits and
has different functions. The individual bits are independent of each other, i.e. each
hardware status is assigned a bit number, which is valid for all five parts. Bit 15 (the
most significant bit) is set to zero for all parts. Thus, the contents of the register parts
can be processed by the controller as positive integers.

Figure 13-7: The status-register model

Status reporting system
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Description of the five status register parts

The five parts of a SCPI status register have different properties and functions:

● CONDition
The CONDition part is written directly by the hardware or it mirrors the sum bit of
the next lower register. Its contents reflect the current instrument status. This regis-
ter part can only be read, but not written into or cleared. Its contents are not affec-
ted by reading.

● PTRansition / NTRansition
The two transition register parts define which state transition of the CONDition
part (none, 0 to 1, 1 to 0 or both) is stored in the EVENt part.
The Positive-TRansition part acts as a transition filter. When a bit of the
CONDition part is changed from 0 to 1, the associated PTR bit decides whether
the EVENt bit is set to 1.
– PTR bit =1: the EVENt bit is set.
– PTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.
The Negative-TRansition part also acts as a transition filter. When a bit of the
CONDition part is changed from 1 to 0, the associated NTR bit decides whether
the EVENt bit is set to 1.
– NTR bit =1: the EVENt bit is set.
– NTR bit =0: the EVENt bit is not set.

This part can be written into and read as required. Its contents are not affected by
reading.

● EVENt
The EVENt part indicates whether an event has occurred since the last reading, it
is the "memory" of the condition part. It only indicates events passed on by the
transition filters. It is permanently updated by the instrument. This part can only be
read by the user. Reading the register clears it. This part is often equated with the
entire register.

● ENABle
The ENABle part determines whether the associated EVENt bit contributes to the
sum bit (see below). Each bit of the EVENt part is "ANDed" with the associated
ENABle bit (symbol '&'). The results of all logical operations of this part are passed
on to the sum bit via an "OR" function (symbol '+').
ENABle bit = 0: the associated EVENt bit does not contribute to the sum bit
ENABle bit = 1: if the associated EVENt bit is "1", the sum bit is set to "1" as well.
This part can be written into and read by the user as required. Its contents are not
affected by reading.

Sum bit

The sum bit is obtained from the EVENt and ENABle part for each register. The result
is then entered into a bit of the CONDition part of the higher-order register.

Status reporting system
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The instrument automatically generates the sum bit for each register. Thus an event
can lead to a service request throughout all levels of the hierarchy.

13.4.3  Status byte (STB) and service request enable register (SRE)

The STatus Byte (STB) is already defined in IEEE 488.2. It provides a rough over-
view of the instrument status by collecting the pieces of information of the lower regis-
ters. A special feature is that bit 6 acts as the sum bit of the remaining bits of the status
byte.

The STB is read using the command *STB? or a serial poll.

The STatus Byte (STB) is linked to the Service Request Enable (SRE) register.
Each bit of the STB is assigned a bit in the SRE. Bit 6 of the SRE is ignored. If a bit is
set in the SRE and the associated bit in the STB changes from 0 to 1, a service
request (SRQ) is generated. The SRE can be set using the command *SRE and read
using the command *SRE?.

Table 13-3: Meaning of the bits used in the status byte

Bit No. Meaning

0...1 Not used

2 Error Queue not empty

The bit is set when an entry is made in the error queue. If this bit is enabled by the SRE, each
entry of the error queue generates a service request. Thus an error can be recognized and
specified in greater detail by polling the error queue. The poll provides an informative error mes-
sage. This procedure is to be recommended since it considerably reduces the problems
involved with remote control.

3 QUEStionable status register summary bit

The bit is set if an EVENt bit is set in the QUEStionable status register and the associated
ENABle bit is set to 1. A set bit indicates a questionable instrument status, which can be speci-
fied in greater detail by querying the STATus:QUEStionable status register.

4 MAV bit (message available)

The bit is set if a message is available in the output queue which can be read. This bit can be
used to enable data to be automatically read from the instrument to the controller.

5 ESB bit

Sum bit of the event status register. It is set if one of the bits in the event status register is set
and enabled in the event status enable register. Setting of this bit indicates a serious error which
can be specified in greater detail by polling the event status register.

6 MSS bit (main status summary bit)

The bit is set if the instrument triggers a service request. This is the case if one of the other bits
of this registers is set together with its mask bit in the service request enable register SRE.

7 STATus:OPERation status register summary bit

The bit is set if an EVENt bit is set in the OPERation status register and the associated
ENABle bit is set to 1. A set bit indicates that the instrument is just performing an action. The
type of action can be determined by querying the STATus:OPERation status register.

Status reporting system
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13.4.4  Event status register (ESR) and event status enable register (ESE)

The ESR is defined in IEEE 488.2. It can be compared with the EVENt part of a SCPI
register. The event status register can be read out using command *ESR?.

The ESE corresponds to the ENABle part of a SCPI register. If a bit is set in the ESE
and the associated bit in the ESR changes from 0 to 1, the ESB bit in the STB is set.
The ESE register can be set using the command *ESE and read using the command
*ESE?.

Table 13-4: Meaning of the bits used in the event status register

Bit No. Meaning

0 Operation Complete

This bit is set on receipt of the command *OPC exactly when all previous commands have been
executed.

1 Not used

2 Query Error

This bit is set if either the controller wants to read data from the instrument without having sent a
query, or if it does not fetch requested data and sends new instructions to the instrument
instead. The cause is often a query which is faulty and hence cannot be executed.

3 Device-dependent Error

This bit is set if a device-dependent error occurs. An error message with a number between
-300 and -399 or a positive error number, which denotes the error in greater detail, is entered
into the error queue.

4 Execution Error

This bit is set if a received command is syntactically correct but cannot be performed for other
reasons. An error message with a number between -200 and -300, which denotes the error in
greater detail, is entered into the error queue.

5 Command Error

This bit is set if a command is received, which is undefined or syntactically incorrect. An error
message with a number between -100 and -200, which denotes the error in greater detail, is
entered into the error queue.

6 User Request

This bit is set when the instrument is switched over to manual control.

7 Power On (supply voltage on)

This bit is set on switching on the instrument.

13.4.5  Questionable status register (STATus:QUEStionable)

This register contains information on questionable instrument states. Such states may
occur when the instrument is not operated in compliance with its specifications.

To read the register, use the query commands STAT:QUEST:COND? or
STAT:QUEST[:EVEN]?.
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Table 13-5: Meaning of the bits used in the questionable status register

Bit No. Meaning

0–15 Not used

13.4.6  Operation status register (STATus:OPERation)

This condition part contains information on the actions currently being performed by
the instrument, while the event part contains information on the actions performed by
the instrument since the last readout of the register.

To read the register, use the query commands STAT:OPER:COND? or
STAT:OPER[:EVEN]?.

Table 13-6: Meaning of the bits used in the operation status register

Bit No. Meaning

0 Calibrating

The bit is set during the calibration phase.

1–2 Not used

3 Sweeping

This bit is set during a sweep in automatic or single mode.

4–15 Not used

13.4.7  Application of the status reporting system

The purpose of the status reporting system is to monitor the status of one or several
devices in a measuring system. To do this and react appropriately, the controller must
receive and evaluate the information of all devices. The following standard methods
are used:

● Service request (SRQ) initiated by the instrument
● Serial poll of all devices in the bus system, initiated by the controller to find out

who sent an SRQ and why
● Query of a specific instrument status by commands
● Query of the error queue

13.4.7.1  Service request

Under certain circumstances, the instrument can send a service request (SRQ) to the
controller. Usually this service request initiates an interrupt at the controller, to which
the control program can react appropriately. An SRQ is always initiated if one or sev-
eral of bits 2, 4 or 5 of the status byte are set and enabled in the SRE. Each of these
bits combines the information of the error queue or the output buffer. To use the possi-
bilities of the service request effectively, all bits should be set to "1" in the enable regis-
ters SRE and ESE.
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Example: 
Use command *OPC to generate an SRQ .
*ESE 1 - set bit 0 of ESE (Operation Complete)
*SRE 32 - set bit 5 of SRE (ESB).
After its settings have been completed, the instrument generates an SRQ.

The SRQ is the only possibility for the instrument to become active on its own. Each
controller program should set the instrument such that a service request is initiated in
the case of malfunction. The program should react appropriately to the service request.

13.4.7.2  Serial poll

In a serial poll, just as with command *STB, the status byte of an instrument is queried.
However, the query is realized via interface messages and is thus clearly faster.

The serial poll method is defined in IEEE 488.1 and used to be the only standard pos-
sibility for different instruments to poll the status byte. The method also works for
instruments which do not adhere to SCPI or IEEE 488.2.

The serial poll is mainly used to obtain a fast overview of the state of several instru-
ments connected to the controller.

13.4.7.3  Query of an instrument status

Each part of any status register can be read using queries. There are two types of
commands:

● The common commands *ESR?, *IDN?, *IST?, *STB? query the higher-level
registers.

● The commands of the STATus system query the SCPI registers
(STATus:QUEStionable...)

The returned value is always a decimal number that represents the bit pattern of the
queried register. This number is evaluated by the controller program.

Queries are usually used after an SRQ in order to obtain more detailed information on
the cause of the SRQ.

13.4.7.4  Error queue

Each error state in the instrument leads to an entry in the error queue. The entries of
the error queue are detailed plain text error messages that can be looked up in the
Error Log or queried via remote control using SYSTem:ERRor[:NEXT]?. Each call of
SYSTem:ERRor[:NEXT]? provides one entry from the error queue. If no error mes-
sages are stored there any more, the instrument responds with 0, "No error".

The error queue should be queried after every SRQ in the controller program as the
entries describe the cause of an error more precisely than the status registers. Espe-
cially in the test phase of a controller program the error queue should be queried regu-
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larly since faulty commands from the controller to the instrument are recorded there as
well.

13.4.8  Reset values of the status reporting system

The following table contains the different commands and events causing the status
reporting system to be reset. None of the commands, except of *RST and
SYSTem:PRESet affect the functional instrument settings. In particular, DCL does not
change the instrument settings.
Table 13-7: Resetting the status reporting system

Event Switching on supply
voltage
Power-On-Status-
Clear

DCL,
SDC
(Device
Clear,
Selected
Device
Clear)

*RST or
SYSTem:
PRESet

STATus:
PRESet

*CLS

Effect 0 1

Clear STB, ESR - Yes - - - Yes

Clear SRE, ESE - Yes - - - -

Clear PPE - Yes - - - -

Clear error queue Yes Yes - - - Yes

Clear output buffer Yes Yes Yes 1) 1) 1)

Clear command processing
and input buffer

Yes Yes Yes - - -

1) The first command in a command line that immediately follows a <PROGRAM MESSAGE TERMINA-
TOR> clears the output buffer.

13.5  Remote access settings

This section outlines the settings required for accessing and configuring the provided
remote control interfaces. It includes network settings, access addresses, emulation
settings for using the command sets of other generators, and the access whith smart
devices.

About instrument emulations

You can remotely control the R&S SMA100B using the command set of another signal
generator. With this function you can, for example, replace a signal generator with an
R&S SMA100B in an automated test setup, without adjusting the command scripts
used.

The R&S SMA100B also covers command sets of Rohde & Schwarz signal genera-
tors. To achieve optimal compatibility when replacing an instrument, we recommend
that you select the emulation command set for the corresponding signal generator.
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You find the remote control command sets supported by the R&S SMA100B in a selec-
tion list.

For more information, see the application note:

1GP120: Remote Emulation with the R&S SMA100B Signal Generator.

The selected instrument also defines the identification string that is retrieved with query
*IDN?. If necessary, use the parameter Mode and IDN String to change this string.

As any other parameter, the remote control command set can also be changed
remotely by the command :SYSTem:LANGuage.

While working in an emulation mode, the R&S SMA100B specific command set is dis-
abled and the SCPI command :SYSTem:LANGuage is discarded.

To return to the SCPI command set of the R&S SMA100B, use the appropriate com-
mand of the selected command set.

If for example an HP generator is emulated, the HP command EX returns to the instru-
ment-specific GPIB command set.

13.5.1  Network settings

Access:

► Select "System Config > Remote Access > Network".

In the "Network" dialog, you can configure the settings of the general network envi-
ronment and specific identification parameters of the instrument in the network.

Remote access settings
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The remote commands required to configure the network remotely are described in
Chapter 14.17, "SYSTem subsystem", on page 712.

How to: see Chapter 13.7.3, "How to connect to LAN", on page 415.

Network Status
Indicates that the instrument is connected to the network.
Remote command: 
:SYSTem:COMMunicate:NETWork:STATus? on page 725

Restart Network
Terminates the network connection of the instrument and sets it up again. You can use
this function to fix network problems.
Note: This function restarts only the connection of the instrument to the network. It
does not impact the network itself.
Remote command: 
:SYSTem:COMMunicate:NETWork:RESTart on page 724

Hostname
Displays the hostname.
Each instrument is delivered with an assigned hostname, a logical name which can be
used instead of the IP address. With the default network settings, the IP address is
allocated by the DHCP server. This address can change each time the instrument is
reconnected. Unlike the IP address, the hostname name does not change.
Note:
This function is password-protected. Unlock the protection level 1 to access it.
● We recommend that you do not change the default network settings or the host-

name to avoid problems with the network connection.
If you change the hostname, be sure to use a unique name.

Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname on page 725

Workgroup
Sets the individual windows workgroup name of the R&S SMA100B. This parameter is
required in case the instrument is integrated in a windows network.
This function is password-protected. Unlock the protection level 1 to access it.
Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup on page 725

Address Mode
Selects the mode for assigning the IP address.
How to: Chapter 13.7.4, "How to assign the IP address", on page 416
"Auto (DCHP)"

Assigns the IP address automatically, provided the network supports
DHCP (Dynamic Host Configuration Protocol).

"Static" Enables you to assign the IP address manually.
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Remote command: 
:SYSTem:COMMunicate:NETWork:IPADdress:MODE on page 724

IP Address
Displays the IP address of the instrument in the network.
By default, the R&S SMA100B is configured to use dynamic TCP/IP configuration and
to obtain the whole address information automatically.
If the network does not support DHCP or the attempt does not succeed, the instrument
tries to obtain the IP address via Zeroconf (APIPA) protocol. IP addresses assigned via
Zeroconf start with the number blocks 169.254.*.*.

Note: An IP address that is assigned via the Zeroconf protocol although the network
requires an IP address assigned via the DHCP server can cause network connection
failures.
See Chapter 15.5, "Resolving network connection failures", on page 751.
How to:
● "To assign the IP address manually on the instrument" on page 416.
● Chapter 13.7.2, "How to activate LAN services", on page 415.
Remote command: 
:SYSTem:COMMunicate:NETWork:IPADdress on page 723

Subnet Mask
Displays the bit group of the subnet in the host identifier.
To assign the subnet mask manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK on page 726

Default Gateway
Displays the gateway address.
This address identifies the router on the same network as the instrument that is used to
forward traffic to destinations beyond the local network.
To assign the gateway address manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway on page 726

DNS Suffix
Displays the primary DNS (Domain Name System) suffix, that means the DNS name
without the hostname part.
The DNS system uses the suffix for registration and name resolution for unique identifi-
cation of the instrument in the entire network.
To assign the DNS suffix manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain on page 725
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DNS Server
Determines the preferred server for name resolution. The DNS server contains the
underlying numerical values that are required for name resolution of the hostname as
part of the IP address.
To select the DNS server manually, select Address Mode > "Static".
Remote command: 
:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS on page 726

MAC Address
Indicates the MAC (Media Access Control) address, a unique identifier of the network
adapter in the R&S SMA100B.
Remote command: 
:SYSTem:COMMunicate:NETWork:MACaddress on page 724

13.5.2  VISA resource strings

Access:

► Select "System Config > Remote Access > Visa Resource Strings".

The "Visa Resource String" dialog displays the VISA resource strings provided for
remote control over the different interfaces.

The remote commands required to query the address information remotely are descri-
bed in Chapter 14.17, "SYSTem subsystem", on page 712.
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Settings:

HISLIP.........................................................................................................................401
VXI11...........................................................................................................................401
Socket......................................................................................................................... 401
GPIB............................................................................................................................401
USB.............................................................................................................................401
SERIAL....................................................................................................................... 401

HISLIP
Displays the visa resource string for remote control with HiSLIP protocol.
See also Chapter 13.2.1, "LAN interface", on page 381
Remote command: 
:SYSTem:COMMunicate:HISLip:RESource? on page 723

VXI11
Displays the visa resource string for remote control over LAN.
See also Chapter 13.2.1, "LAN interface", on page 381
Remote command: 
:SYSTem:COMMunicate:NETWork:RESource? on page 724

Socket
Displays the visa resource string for remote control over LAN, using the socket com-
munication protocol.
See also Chapter 13.2.1, "LAN interface", on page 381
Remote command: 
:SYSTem:COMMunicate:SOCKet:RESource? on page 727

GPIB
Displays the visa resource string for remote control over the GPIB interface.
See also Chapter 13.2.3, "GPIB interface (IEC/IEEE bus interface)", on page 384.
Remote command: 
:SYSTem:COMMunicate:HISLip:RESource? on page 723

USB
Displays the visa resource string for remote control over the USB interface.
See also Chapter 13.2.2, "USB interface", on page 383
Remote command: 
:SYSTem:COMMunicate:USB:RESource? on page 728

SERIAL
Displays the visa resource string for remote control over the serial interface.
See also Chapter 13.2.2, "USB interface", on page 383
Remote command: 
:SYSTem:COMMunicate:SERial:RESource? on page 727
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13.5.3  GPIB address settings

Access:

► Select "System Config > Remote Access > GPIB Address".

The "GPIB Address" enables you to select the channel for remote control over the
IEC/IEE bus interface.

The remote command to configure the setting remotely is described in Chapter 14.17,
"SYSTem subsystem", on page 712.

Settings:

GPIB Channel Address............................................................................................... 402

GPIB Channel Address
Sets the GPIB (IEC/IEEE bus) channel address for the connected instrument.
Remote command: 
:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess on page 723

13.5.4  RS232 settings

Access:

► Select "System Config > Remote Access > RS232".

The "RS232" dialog enables you to control the instrument over a serial interface
using a USB adapter. The controller and the instrument must be connected with
the external USB/serial-adapter R&S TS1-USB (see recommended extras in the
data sheet) and a serial crossover (null modem) cable. The USB connection
requires the Visa library to be installed on the controller. Visa detects and config-
ures the R&S SMA100B automatically when the USB connection is established.
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The remote commands required to configure the parameters remotely are described in
Chapter 14.17, "SYSTem subsystem", on page 712.

Settings:

Baud Rate
Sets the baudrate for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:BAUD on page 726

Parity
Sets the parity for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:PARity on page 726

Stop Bits
Sets the number of stop bits for the serial remote control interface.
Remote command: 
:SYSTem:COMMunicate:SERial:SBITs on page 727

13.5.5  Instrument emulations settings

Access:

► Select "System Config > Remote Access > Instrument Emulations".
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The "Instrument Emulations" dialog enables you to emulate a remote control com-
mand set of another signal generator.

The remote commands required to configure the emulation settings remotely are
described in Chapter 14.17, "SYSTem subsystem", on page 712.

Language
Selects the instrument whose remote command set is emulated by the R&S SMA100B.
Remote command: 
:SYSTem:LANGuage on page 729

Mode
Selects the way the instrument identification is performed.
"Automatic" Sets the "IDN String" and the "OPT String" automatically for the

instrument selected with the parameter Language.
"User Defined" Enables you to define the "IDN String" and the "OPT String".
Remote command: 
:SYSTem:IDENtification on page 728

Set to Default
In "Mode > User Defined", resets the *IDN and *OPT strings.

Remote command: 
:SYSTem:IDENtification:PRESet on page 729

IDN String
Indicates the identification string of the instrument when queried with the common
command *IDN?.

In addition to the preset values, you can define your own identification string so that
each generator uses an individual identification, like My_SigGen for instance, see
Mode .
Remote command: 
*IDN? on page 451
:SYSTem:IRESponse on page 729

OPT String
Indicates the option string of the instrument as queried with common command *OPT?.

In Mode > "User Defined", you can define your own option string. A query responds
with this option string instead of the automatically created option string.
Remote command: 
*OPT? on page 452
:SYSTem:ORESponse on page 729
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13.5.6  Remote connections settings

The "Remote Connections" dialog covers the active SCPI and TCP/IP connections,
and a history list of the connections that have accessed the instrument before.

13.5.6.1  Active connections

Access:

► Select "System Config > Remote Access > Remote Connections > Active".

The "Active " tab shows the currently active remote connections, and you can
enable the display of the active connections in the task bar.

Show Remote Connections in Taskbar
Displays the currently active connections in the taskbar.

SCPI Connections
Displays the VISA resources strings of the remote connections currently controlling the
instrument via the LAN interface.
Remote command: 
n.a.

TCP/IP Connections
Displays the types and client addresses of the remote connections currently controlling
the instrument via the LAN interface.
Remote command: 
n.a.
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13.5.6.2  Closed connections

Access:

► Select "System Config > Remote Access > Remote Connections > Closed".

The "Closed" tab shows the currently active remote connections, and you can
enable the display of the active connections in the task bar.

SCPI Connections
Lists the VISA resource strings of the last remote connections that have accessed the
instrument via the LAN interface before.
Remote command: 
n.a.

TCP/IP Connections
Lists the types and client addresses of the last remote connections that had accessed
the instrument via the LAN interface before.
Remote command: 
n.a.

13.5.7  QR code

Access:

► Select "System Config > Remote Access > QR Code".
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The "QR Code" dialog shows the current instrument address (IP address) in quick
response (QR) format.

This functionality provides fast access to the instrument via VNC with, for example, a
smartphone or a tablet.

See Chapter 13.10.3, "How to set up remote operation from a smart device",
on page 442.

13.6  LXI settings

On the R&S SMA100B, an LXI functionality is already installed and enabled, see LXI
status settings. Thus, you can access he instrument using any web browser to perform
the following tasks:
● Modifying network configurations, see Chapter 13.6.2.1, "LAN configuration",

on page 410.
● Accessing the instrument remotely
● Analyzing SCPI remote diagnostics

13.6.1  LXI status settings

Access:

► Select "System Config > Setup > Remote Access > LXI Status".
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The LXI "LAN Status" dialog shows the parameters of the LAN connection.

Alternatively, you can change the LAN settings using the LXI web browser interface,
see Chapter 13.6.2.1, "LAN configuration", on page 410.

LAN Status
The LED indicates the LXI status.
"green" Normal operation
"green (flashing)"

Device identification
"red" LAN fault

Hostname / MAC Address / IP Address
See "Hostname" on page 398.

LAN Reset
Initiates the network configuration reset mechanism for the instrument and resets the
hostname, MAC address, and IP address.
According to the LXI standard, a LAN reset must set the following network parameters
to a default state:

Parameter Value

TCP/IP mode DHCP + Auto IP address

Dynamic DNS Enabled

ICMP ping Enabled

Password for LAN configuration LxiWebIfc

The LAN reset also resets the following parameters for the Signal Generator:
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Parameter  

Hostname Instrument-specific hostname

Description Vector signal generator

Negotiation Auto detect

VXI-11 discovery Enabled

13.6.2  LXI browser settings

The LXI browser functionality enables you to control the instrument remotely over a
web browser.

Access:

► In the address field of the browser, enter the URL address, composed of the instru-
ment's IP address or host name, for example http://10.113.1.151.
Note: Do not add the missing zeros in the IP address, while opening the instru-
ment homepage.

The instrument homepage (welcome page) opens.

The navigation pane of the browser interface contains the following elements:
● "LXI"

– "Home" opens the instrument homepage.
The homepage displays the device information required by the LXI stan-
dard, including the VISA resource string in read-only format.

– "Device Indicator" activates or deactivates the LXI status indication.
When activated, the LXI LED flashes. A green LXI status symbol indicates
that a LAN connection has been established; a red symbol indicates that no
LAN cable is connected.

– "Lan Configuration" allows you to configure LAN parameters and to initiate
a ping, see "Ping client" on page 412.
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– "Status" displays information about the LXI status of the instrument.
– "Utilities" provides access to the LXI event logging functionality required by

the LXI standard.
● "Instrument Control"

"Web Control" provides remote access to the instrument, see "Starting a
remote control via the LXI web browser" on page 420.

● "Diagnostics"
– "SCPI Remote Trace" records messages exchanged via the remote control

interface, see Chapter 13.6.2.2, "SCPI remote trace", on page 412.
● "Datasheet"

Provides the data sheet with the specification data of the instrument at the time
of delivery, see Chapter 13.6.2.3, "Datasheet", on page 414.

● "Help"
– "Glossary" explains terms related to the LXI standard.
– www.rohde-schwarz.com opens the Rohde & Schwarz homepage.

13.6.2.1  LAN configuration

The "LAN Configuration" web page displays all mandatory LAN parameters and allows
their modification.

It comprises the following navigation entries.

● IP configuration..................................................................................................... 410
● Advanced config....................................................................................................411
● Ping client..............................................................................................................412

IP configuration

The "IP configuration" web page displays all mandatory LAN parameters and allows
their modification.

The "IP Address Mode" selects a configuration mode for the IP address of the instru-
ment. With static configuration, the entered IP address, subnet mask, and default gate-

LXI settings
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way are used. With dynamic configuration, DHCP or dynamic link local addressing
(automatic IP) is used to obtain the instrument IP address.

Changing the LAN configuration
This function is password-protected. Unlock the protection level 1 to access it.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.

See Chapter 12.4.4, "Password management", on page 370.

Advanced config

The "Advanced Config" web page provides LAN settings that are not declared manda-
tory by the LXI standard.

The following advanced parameters are available:
● "mDNS and DNS-SD": The additional protocols "multicast DNS" and "DNS service

discovery" are used for device communication in zero configuration networks,
working without DNS and DHCP.

● "ICMP Ping": Must be enabled to use the ping utility.
If you disable this setting, the instrument does not answer ping requests. The set-
ting does not affect the LXI ping client. You can ping other hosts from the instru-
ment, even if the setting is disabled.

● "VXI-11 Discovery": Must be enabled to detect the instrument in the LAN.
If you disable this setting, the instrument cannot be detected by the VXI-11 discov-
ery protocol mechanism. The setting does not affect other detection mechanisms.
Setting up a VXI-11 connection via the IP address or the host name is independent
of this setting.
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Changing the LAN configuration
This function is password-protected. Unlock the protection level 1 to access it.
Note: We recommend that you change the default password before connecting the
instrument to a network.
How to:
● "Changing the default user password of the instrument" on page 373.
● "Changing the default security password" on page 374.

See Chapter 12.4.4, "Password management", on page 370.

Ping client

The "Ping Client" page provides the ping utility to verify the connection between the
LXI-compliant instrument and another device.

The ping is initiated from the instrument. Using the ICMP echo request and echo reply
packets, this function checks whether the communication with a device via LAN is
working. Ping is useful for the diagnosis of IP network or router failures.

To initiate a ping at the instrument:

1. On the "Ping Client" page, enter the IP address of the host in the "Destination
Address" field (for example 10.113.1.151).

2. Select "Submit".

13.6.2.2  SCPI remote trace

The remote trace functionality allows you to trace input and output strings at the
remote control interface of the R&S SMA100B, see Chapter 13.8.8, "How to trace mes-
sages with the LXI web browser interface", on page 428.
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A recorded trace (message log) can be evaluated directly in the dialog. Use the high-
lighting and navigation functions provided by the lower toolbar to locate error mes-
sages and messages containing arbitrary search strings. You can also export the mes-
sage log to a *.csv file and evaluate the file using a suitable program.

To trace and display messages, switch on "logging" and "live mode" in the toolbar.

Toolbars

The toolbar at the top of the dialog provides basic settings and functions.

● "Live mode" / "logging": If logging is switched on, messages are traced. They are
stored in an internal database and can be displayed upon request, using the
refresh button (live mode off) or they can be displayed automatically (live mode
on).

● "Filter": applies a filter to columns and/or rows when working (live mode off)
● "Refresh": reads the message log from the internal database and displays it
● "Download": stores the SCPI trace log to a *.csv file
● "Clear": deletes all message log entries in the database and at the screen
● "Details": displays details of the selected message, for example an SCPI command

in hex format (also possible by double\-clicking a message)

Columns

The following columns are available if no column filter is applied:

● "Rec": record number of the message within the message log
● I: number of the subinstrument
● "MT": indicates the type of the message. Possible values and related message

contents are:
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– > = incoming command
– < = outgoing response to a query
– E = error message, highlighted by red color
– T = execution time, i.e. time required by the instrument to process the com-

mand internally.
● "message": indicates the type of the message. Possible values and related mes-

sage contents are:
– > = incoming command
– < = outgoing response to a query
– E = error message, denoted in red
– T = execution time, i.e. time required by the instrument to process the com-

mand internally

13.6.2.3  Datasheet

The data sheet functionality allows you to retrieve the specification data of the instru-
ment at the time of delivery.

The document contains all specified value ranges and information of the data sheet, for
example important as reference values for recalibration.

13.7  Connecting the instrument to the network (LAN)

The R&S SMA100B is equipped with a network interface and can be connected to an
Ethernet LAN (local area network).

Connecting the instrument to the network (LAN)
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There are two methods to establish a LAN connection to the instrument:
● A non-dedicated network (Ethernet) connection from the instrument to an existing

network
● A dedicated network connection (Point-to-point connection) between the instru-

ment and a single computer

For addressing, both the instrument and the computer require an IP address. The
address information is usually assigned to the devices automatically, see Chap-
ter 13.7.4, "How to assign the IP address", on page 416.

● How to enable access via LAN............................................................................. 415
● How to activate LAN services............................................................................... 415
● How to connect to LAN......................................................................................... 415
● How to assign the IP address............................................................................... 416
● How to use computer names (hostnames)........................................................... 417

13.7.1  How to enable access via LAN

Per default, the LAN interfaces on the instrument are enabled.

If they have been disabled because of security reasons, enable them as follows:

1. Select "Setup > Security > LAN Services > LAN Interface = On".

2. Enter the Security Password.

3. Select "Accept".

13.7.2  How to activate LAN services

Per default, the LAN interfaces and all LAN services are enabled.

If they have been disabled because of security reasons, enable them as follows:

1. Select "Setup > Security > LAN Services".

2. Enable the required service, e.g. "LAN Services > FTP > On".

3. Enter the Security Password.

4. Select "Accept".

See Chapter 12.4.5, "How to prevent unauthorized access", on page 373.

13.7.3  How to connect to LAN

1. NOTICE! Connecting to the network can cause network failure. Errors can affect
the entire network.

Connecting the instrument to the network (LAN)
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Consult your network administrator before performing the following tasks:
● Connecting the instrument to the network
● Configuring the network
● Changing IP addresses

2. Connect the LAN socket on the rear panel via an RJ-45 cable to the LAN.

The R&S SMA100B displays its IP address on the screen.

13.7.4  How to assign the IP address

Depending on the network capacities, the TCP/IP address information for the instru-
ment can be obtained in different ways.
● If the network supports DHCP (dynamic host configuration protocol), the address

information is assigned automatically.
● If the network does not support DHCP, the instrument tries to obtain the IP address

via Zeroconf (APIPA) protocol. If this attempt does not succeed or if the instrument
is set to use, alternate TCP/IP configuration, the addresses must be set manually.

Since the dynamic TCP/IP configuration assigns the address information automatically,
it is safe to establish a physical connection to the LAN without any previous instrument
configuration.

To assign the IP address manually on the instrument

1. NOTICE! Connecting to the network can cause network failure. Errors can affect
the entire network.
Consult your network administrator before performing the following tasks:
● Connecting the instrument to the network
● Configuring the network
● Changing IP addresses

2. Select "System Config > Remote Access > Network".

3. Select "Address Mode > Static".

4. Select the "IP Address".

5. Enter the IP address, for example 192.168.0.1.

The IP address consists of four number blocks separated by dots. Every block con-
tains 3 numbers in maximum.

6. Select the "Subnet Mask" and enter the subnet mask, for example 255.255.255.0.

The subnet mask consists of four number blocks separated by dots. Every block
contains 3 numbers in maximum.

To assign the IP address manually on the computer

► Obtain the necessary information from your network administrator. If you use more
than one LAN connector, you need separate address information for each connec-
tor.

Connecting the instrument to the network (LAN)
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For information on how to perform the configurations, refer to the documentation of
the operating system the computer uses.

13.7.5  How to use computer names (hostnames)

In a LAN that uses a DNS server, each PC or instrument connected in the LAN can be
accessed via an unambiguous computer name (hostname) instead of the IP address.
The DNS server translates the hostname to the IP address. It is especially useful when
a DHCP server is used, as a new IP address can be assigned each time the instru-
ment is restarted.

Each instrument is delivered with an assigned computer name, that remains perma-
nent as long as it is not explicitly changed.

The default computer name follows the syntax <INST>-<Serial Number>, where:
● <INST> is the short name of your instrument, as stated on the front panel.
● <Serial Number> is the individual serial number of the instrument.

You can find the serial number at the rear panel of instrument. It is the third part of
the device ID printed on the barcode sticker .

Example: 
The default hostname of an R&S SMA100B with a serial number 102030 is
SMA100B-102030.

To query and change a computer name

1. Select "System Config > Remote Access > Network".

The computer name is displayed under "Hostname".

2. Select "System Config > Setup > Security > Protection".

3. Enable the "Protection Level 1".
The default password is 123456.

The parameter "Hostname" in the "Network" tab is now enabled for configuration.

4. Change the "Hostname".

13.8  Controlling the R&S SMA100B remotely

This section shows you how to set up remote control connections over the available
interfaces.

Controlling the R&S SMA100B remotely
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The following general prerequisites must be fulfilled:
● The instrument and the controller have to be connected with the suitable cable and

switched on.
See Chapter 13.7, "Connecting the instrument to the network (LAN)", on page 414.

● To operate the instrument via remote control, it must be addressed using the
defined interface address.
See:
– Chapter 13.2.1, "LAN interface", on page 381
– Chapter 13.2.2, "USB interface", on page 383
– Chapter 13.2.3, "GPIB interface (IEC/IEEE bus interface)", on page 384

● A remote control program must open a connection to the instrument, before it can
send commands to and receive device responses from the instrument.

If security is a concern, see:
● Document Instrument Security Procedures.
● Chapter 12.4.5, "How to prevent unauthorized access", on page 373.

● How to find the VISA resource string.................................................................... 418
● How to change the GPIB instrument address.......................................................419
● Establishing a remote control connection over the LXI browser interface............ 420
● Establishing a remote control connection over LAN using VXI-11 protocol.......... 420
● Establishing a remote control connection over LAN using socket communication

.............................................................................................................................. 425
● Setting up a remote control connection over GPIB...............................................426
● Setting up a remote control connection over USB................................................ 427
● How to trace messages with the LXI web browser interface.................................428
● How to return to manual operation........................................................................428

13.8.1  How to find the VISA resource string

► Select "System Config > Remote Access > VISA Resource Strings".
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The dialog shows all specified resource strings of the supported remote control
interfaces.

Note: Using the RS232 serial interface via USB requires the USB serial adapter
R&S TS-USB1.

13.8.2  How to change the GPIB instrument address

Option: R&S SMAB-B86

To control the instrument remotely via the GPIB bus, it must be addressed using the
GPIB address. The remote control address is factory-set to 28, but it can be changed if
it does not fit in the network environment. For remote control, addresses 0 through 30
are allowed. The GPIB address is maintained after a reset of the instrument settings.

To set the GPIB address:

1. Select "System Config > Remote Access > GPIB Address".

2. Select "GPIB Channel Address" and enter a value between 0 and 30.

Risk of losing remote connection
If the remote access and network settings had been configured to values different to
the default, executing a factory preset via remote control terminates the connection to
the instrument.

Controlling the R&S SMA100B remotely
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13.8.3  Establishing a remote control connection over the LXI browser
interface

Via the LXI browser interface to the R&S SMA100B one or more users can control the
instrument remotely from another PC without additional installation. Most instrument
controls are available via the front panel simulation. File upload and download between
the instrument and the remote PC is also available.

Starting a remote control via the LXI web browser

1. On the instrument, enable the LAN interface.
See Chapter 13.7.1, "How to enable access via LAN", on page 415.

2. Connect the remote PC and the instrument in the same network.
See Chapter 13.7.3, "How to connect to LAN", on page 415.

3. On the remote PC, start a web browser that supports HTML5 (W3C compliant).

4. Enter the IP address of the R&S SMA100B in the browser's address bar.

The R&S SMA100B's welcome page is displayed.

5. In the navigation pane, select "Instrument Control" > "Web Control".

Remote access to the instrument requires the password. The default password is
instrument.

6. Enter the password and confirm with the [Enter] key.

After the connection is established, the current screen of the R&S SMA100B is dis-
played in the browser window.

7. Use the mouse cursor and keyboard to access the functionality of the instrument
as you would directly perform on the instruments touchscreen and front panel.

13.8.4  Establishing a remote control connection over LAN using VXI-11
protocol

In this example, the I/O software library R&S VISA from Rohde & Schwarz is used to
set up a LAN remote control link and remotely control the R&S SMA100B. R&S VISA is
running on a controller PC with Windows operating system. When the connection is set
up, you can send commands to the instrument and receive the responses.

The remote control connection requires a VISA installation but no additional hardware
on the controller PC. The LAN I/O channel is selected at initialization time using the
VISA resource string (also referred to as "address string"). A VISA alias (short name) is
used to replace the complete resource string. The host address is the R&S SMA100B's
hostname or its IP address.

See also Chapter 13.2.1, "LAN interface", on page 381.

Setting up the controller with R&S VISA

To remote control the R&S SMA100B, we use the R&S VISA Tester application. The
application communicates via TCP/IP protocol.

Controlling the R&S SMA100B remotely
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The instrument is preconfigured for networks using DHCP (dynamic host configuration
protocol). If this configuration is used, enter the computer name in the position of the IP
address.

1. On the instrument:

a) Enable the LAN interface.
See Chapter 13.7.1, "How to enable access via LAN", on page 415.

b) Enable "SCPI over LAN".
See Chapter 13.7.2, "How to activate LAN services", on page 415.

2. On the controller (remote PC), install the R&S VISA program.
See http://www.rohde-schwarz.com/rsvisa > "RS VISA Release Notes".

3. Connect the controller and the instrument in the same network (network cable).
Switch them on.
See also Chapter 13.7.3, "How to connect to LAN", on page 415.

4. On the controller, start "R&S VISA > Tester 32bit" or "R&S VISA > Tester 64bit".

5. In the menu bar, select "Choose VISA Implementation > Rohde & Schwarz Visa"
and confirm with "OK".

6. In the menu bar, select "Find Resource" to search for the instrument in the LAN.

Controlling the R&S SMA100B remotely
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7. Select "VXI-11" and "Find Resources".

R&S VISA scans the network for connected instruments and lists all detected
instruments in the "Resource" list.
Note: The search may take some time, particularly in large networks.

8. Select the required instrument and confirm with "Select".

The "Find and select resource" dialog closes and R&S VISA indicates the IP
address in the "Resource" field of the main application window.

9. As an alternative to the IP address, you can assign an alias name to the
R&S SMA100B:

a) In the menu bar, select "RsVisaConfig".

b) In the toolbar, select "+" to access the "VISA Resource String Composer".

Controlling the R&S SMA100B remotely
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c) Fill in the "Alias" name, the "VISA Resource String" and the "Device IP Address
or host name" as shown in the figure, and confirm with "OK".

The "Alias" name is assigned.

d) Close the dialog.
The R&S SMA100B is registered in the program. It can be addressed via the
resource string or alias name.

10. In the main window, select "Connect".

R&S VISA establishes the connection to the R&S SMA100B.

You can send settings to configure the instrument and receive its responses.

Note: If the connection cannot be set up, R&S VISA displays an error in the log
view.
See also Chapter 15.5, "Resolving network connection failures", on page 751.

For further information on the functions to read and write to an open session, and
the utility applications the software provides, see the R&S VISA user manual.

Starting a remote control session over LAN with R&S VISA

To set the instrument to remote control, you can use the addressed command &GTR or
send any command from the controller.

1. Start the R&S VISA Tester.
Establish the connection to the R&S SMA100B.
See "Setting up the controller with R&S VISA" on page 420.
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2. In the R&S VISA "Basics" tab, enter a SCPI command, e.g. "*IDN?". Confirm with
"Query".

The instrument is switched to remote control when it receives a command from the
controller.

3. Select "Read" to obtain the instrument response.

Tip: If the "Show Log" checkbox is checked, R&S VISA displays each VISA func-
tion call in the log-view on the left. If you check the "Write Log" checkbox, the log-
view entry is written to the log file as well. You can operate the log-view in two
modes: the "Live Mode" shows only the most recent messages whereas the "View
Mode" allows you to scroll the history.

4. To set, e.g. the frequency, enter SOUR1:FREQ 4 GHz and select "Write".
To check the performed setting, SOUR1:FREQ? and select "Query".
The instrument response is 4000000000. The value corresponds to the frequency
in Hz.

While remote control is active, the "Remote" icon in the status bar indicates that the
instrument is in remote control mode. Currently ongoing communication (data
transfer) is indicated by green colored arrows in the icon.
Operating via the front and touch panel or via mouse and keyboard are locked,
allowing a remote control program to be performed without interruption. On the dis-
play, keys and entry fields are grayed out and cannot be activated or modified, but
you can still open dialogs, for example to verify settings.

5. To disable the access to the dialogs, use the command SYST:KLOC ON.

6. To prevent unintentional return to manual operation, use the command &LLO.
See Remote control via SCPI, section "LAN interface messages".

Controlling the R&S SMA100B remotely
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The instrument switches to "Remote LLO" state. The [Setup] key is disabled.

7. To enable the [Setup] key, use the command &GTR.

8. To return to manual operation, see Chapter 13.8.9, "How to return to manual oper-
ation", on page 428.

Tip: Switching from manual operation to remote control and vice versa does not
affect the other instrument settings.

13.8.5  Establishing a remote control connection over LAN using socket
communication

This section provides an example on how to establish a remote control connection over
Telnet client and a simple sockets-based program example that can be further devel-
oped.

See also Chapter A.1, "Telnet program examples", on page 774.

The telnet client transmits information unencrypted. Therefore, for sensitive information
we recommend that you use a client which supports secure protocols, like SSH.

In the following example, we assume basic knowledge of programming and operation
of the controller. You can find information on the interface commands in the corre-
sponding manuals.

Setting up a Telnet connection

To control the software, only a Telnet program is required. The Telnet program is part of
every operating system.

1. On the instrument:

a) Enable the LAN interface.
See Chapter 13.7.1, "How to enable access via LAN", on page 415.

b) Enable "SCPI over LAN".
See Chapter 13.7.2, "How to activate LAN services", on page 415.

2. Connect the remote PC and the instrument in the same network.
See also Chapter 13.7.3, "How to connect to LAN", on page 415.

3. On the remote PC, start the Telnet program.
Enter the socket address.
The socket address is a combination of the IP address or the hostname of the
R&S SMA100B and the number of the port configured for remote-control via Telnet.
Tip: The R&S SMA100B uses the port number 5025 for remote connection via Tel-
net.
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The connection to the instrument is set up and you can send remote-control com-
mands.

4. Telnet does not reflect your first entry.
Insert a command, e.g. *IDN and confirm with "Enter".

5. Observe the screen.

A response on the query confirms that the connection is working. The client dis-
plays all subsequent inputs and responses.

6. Even if the cursor is not visible on the screen, blindly enter a remote-control com-
mand. Confirm with Enter.

13.8.6  Setting up a remote control connection over GPIB

The program example in this section is written in VISUAL BASIC. A condition for pro-
gramming in VISUAL BASIC is that the modules NIGLOBAL (Niglobal.bas) and
VBIB32 (Vbib_32.bas) are added to the projects.

Controlling the R&S SMA100B remotely
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Drivers for instrument, for example IVI-COM and LabVIEW drivers, are available for
download area on the product page at:
https://www.rohde-schwarz.com/driver/sma100b/

Starting a remote control session over GPIB

1. Connect instrument and controller using a GPIB cable.
Switch them on.

2. Select "System Config > Remote Access > GPIB Address " > "GPIB Channel
Address = 28".
The GPIB address of the instrument must be the default value of 28.

3. Execute the following commands on the controller:

a) Open the port to the instrument.
CALL IBFIND("DEV1", generator%)

b) Inform the controller about instrument address.
CALL IBPAD(generator%, 28)

c) Reset the instrument.
CALL IBWRT(generator%, "*RST;*CLS")

d) Set the instrument to new address.
CALL IBWRT(generator%, "SYST:COMM:GPIB:ADDR 18")

e) Inform the controller about new address.
CALL IBPAD(generator%, 18)

The GPIB address of the instrument is changed.

4. To return to manual operation, press the Local key at the front panel.

13.8.7  Setting up a remote control connection over USB

For remote control via the USB connection, the PC and the instrument must be con-
nected via the USB type B interface. A USB connection requires the VISA library to be
installed. VISA detects and configures the R&S instrument automatically when the
USB connection is established. You do not have to enter an address string or install a
separate driver.

Starting a remote control session over USB

1. Connect instrument and controller using USB cable. Switch them on.

2. Execute the following commands on the controller:

a) Open the port to the instrument.
viOpen (..., "USB::0x0AAD::0x01DD::100001::INSTR", ...)

b) Reset the instrument.
viRST (generator%, "*RST;*CLS")

c) Set 2 GHz frequency
viPrintf (..., "SOUR:FREQ 2GHz\n")

Controlling the R&S SMA100B remotely
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d) Set 20 dBm output level
viPrintf (..., "SOUR:POW -20dBm\n")

The RF frequency and signal level of the instrument are changed.

3. To return to manual operation, press the [Local] key.

13.8.8  How to trace messages with the LXI web browser interface

The remote trace functionality allows you to trace commands and messages
exchanged via a remote control interface of the R&S SMA100B.

Activating the SCPI remote trace

1. On the instrument:

a) Enable the LAN interface.
See Chapter 13.7.1, "How to enable access via LAN", on page 415.

b) Enable "SCPI over LAN".
See Chapter 13.7.2, "How to activate LAN services", on page 415.

2. Connect the remote PC and the instrument in the same network.
See also Chapter 13.7.3, "How to connect to LAN", on page 415.

3. Start a web browser that supports HTML5 (W3C compliant).

4. Enter the IP address of the R&S SMA100B in the browser's address bar.

The welcome page is displayed.

5. In the navigation pane, select "Diagnostics > SCPI Remote Trace".

6. In the toolbar bar of the "SCPI Remote Trace" page, select "live mode > on" and
"logging > on".

"live mode > on" displays all commands and responses, and "logging > on" also
traces messages.

If you now control the R&S SMA100B with SCPI commands, using an appropriate
tool, the LXI function records the information sent and received.
The function records all sent commands, received responses and messages, and
saves them in an internal database. If "live mode" is disabled, you can display the
recent traces upon request, using the "refresh" button. You can also save the log in
a file.
Note: The diagnostics functionality is extended in later releases, e.g. to download
or upload SCPI command files from / to the instrument.

13.8.9  How to return to manual operation

Before returning to manual control, command processing must be completed. Other-
wise, the instrument switches back to remote control immediately.
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1. To return from "Remote" state to manual state, perform one of the following:

● On the controller, use the command &GTL
Note: If &NREN has been set before &GTL is locked. Use &GTR instead.

● In the status bar, select the "Remote" icon.
● On the front panel, press the [Local] key.
● In the block diagram, select "Context sensitive menu > Key Emulation > Local"

2. To return from "Remote LLO" state to manual or to "Remote" state, perform one of
the following:

Note: In the local lockout state, the command &GTL and the [Local] key are locked.
You can unlock this state only via remote control.
● On the controller, use the command &LOCS.

This command switches directly to manual operation.
● Send the command &REMS.

This command changes the remote control state from "Remote LLO" to
"Remote".

● Use the Visual Basic command CALL IBLOC (generator%).
The command switches directly to manual operation.

● VISA function viGpibControlREN()
This function switches directly to manual operation.

13.9  Automating tasks with remote command scripts

To achieve fast configuration, make complex test setups or repeating measurements
reproducible, you can automate the required settings with scripts. A script contains a
series of SCPI commands corresponding to the settings. When completed, it is conver-
ted to an executable format, saved in a file and can be run whenever needed.

If you frequently need to load and run a script, assign the script to the [★ (User)], and
you can quickly and easily perform the task.
See Chapter 12.2.4, "How to assign actions to the [★ (User)] key", on page 353.
In contrast to "Recall Setup" via the [★ (User)] key, an assigned script execution does
not close active dialogs and windows. On the contrary, even active window control
(open / close) is possible.

Figure 13-8: Steps for performing SCPI Scripts

In the graph, you can see the main steps required to work with a SCPI script.
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Creating a SCPI list

With the SCPI record functions, you can create a SCPI command list directly in the
instrument and then export the list to the controller. If you want to edit or write a script
manually, use a suitable editor on the controller. Even for manually creating, the instru-
ment supports you by showing the corresponding command syntax and the current
settings value.

Directly in the instrument, you can create a SCPI list at any time of operation, in the
following ways:
● Recording steps

Both, automatic and manual SCPI recording of settings is possible. You can start,
stop and resume automatic recording, and also record individual commands man-
ually.
– Manually record the steps selectively

In manual recording mode, you can deliberately record a SCPI command with
the "Add CPI Command to Recording List" function, see How to record SCPI
lists manually.

– Automatically record all performed steps
The instrument records the SCPI command and settings value of each step
you perform, and then writes the commands to the file system, see How to
record SCPI lists automatically.
You can also add a SCPI command manually to the recording list during auto-
matic SCPI recording.

Note: The Signal Generator clears the SCPI list after booting automatically.
● Generating all settings at once

Generates the SCPI commands of the current instrument settings in one step, and
writes the command list in a temporary list, see How to create a SCPI list with the
current instrument settings in one step.
Note: This function lists all commands in alphabetical order, in contrast to the
recording or manual creation, which consider the order the settings are configured.
Using this function can slow down the runtime or cause errors during execution.
Therefore, always check and revise a script if necessary, see "How to check a
SCPI list" on page 436.

● Manually create a command script with "Copy" and paste
Enables you to copy the SCPI command and the current setting, see Chap-
ter 13.9.1, "Show SCPI command", on page 432.

Some parameters cannot be set by a SCPI command.
If so, no SCPI command found is entered instead of a command when you record or
generate all settings at once.

The difference between Show SCPI Command and the provided cross-reference

If you want to enter your settings in a script, or use a remote control program, you must
know the corresponding SCPI command and the exact syntax.
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If you need to look up the SCPI command, the instrument offers two ways to figure it
out quickly.
● "Show SCPI command" (context-sensitive menu)

Displays the SCPI command syntax of a selected parameter including the current
setting value, see "Finding out the SCPI command using "Show SCPI Command""
on page 438.
The "Copy" function enables you to write a SCPI script conveniently by hand.

● Instrument help ([Help] key)
Opens a help topic that describes the selected parameter or instrument function,
including a cross-reference to the corresponding SCPI command. The reference
leads you to the description of the SCPI command comprising the complete SCPI
syntax, all available setting values, value ranges, etc.
See "Finding out the SCPI command using the online help" on page 438.

Creating and exporting a script file

When the script list is completed, a code generator translates the SCPI commands into
the source code of a proprietary programming language, using a code template. There-
fore, each language requires an appropriate code template. When converted, you can
save the script in a file with an extension corresponding to the programming language.

The R&S SMA100B provides the following predefined code templates by default:
● Plain SCPI

Represents SCPI base format, that is ASCII format, saved as text file (*.txt).
● MATLAB

A programming environment, frequently used in signal processing and test and
measurement applications (*.m).
You can directly use this format with MATLAB(c) Toolkit. For comprehensive infor-
mation on this topic, refer to the application note 1GP60: MATLAB Toolkit for R&S
Signal Generators.

● NICVI
An ANSI C programming environment designed for measurements and tests (*.c).
You can directly use this format with National Instruments LabWindows CVI.

● Python3
A general-purpose and high-level programming language (*.py).

You can also convert a script to a user-specific format. In this case, you need a code
template with the extension *.expcodetmpl.

For information on how to select the code template and save the script in a file, see
Chapter 13.9.3, "SCPI recording export settings", on page 433.

Executing a SCPI script

A SCPI script primarily runs on the controller PC. In addition, you can execute a script
directly on the instrument, by assigning the script to the [★ (User)] key.

See Chapter 12.2.4, "How to assign actions to the [★ (User)] key", on page 353.
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13.9.1  Show SCPI command

Access:

1. Select the parameter.

2. Open the context-sensitive menu (tap and hold).

3. Select "Show SCPI Command".

This function provides the syntax of the remote command with the current setting.

Copy
Copies the command and the current setting.

Close
Exits the "SCPI Command" dialog.

13.9.2  Displaying an SCPI list

The instrument displays a recorded SCPI list and thus provides viewing the recorded
results before exporting.

► Depending on the starting point, you can access the "SCPI Recording List" dialog
as follows:

● During recording
Select "Show SCPI Recording List" in the context-sensitive menu.

● At any time outside recording
Select "Show SCPI Recording List" in the context-sensitive menu.
This function assumes that at least one recording has been executed after
power-on.

● At the end of the recording
Select "Stop automatic SCPI recording". The dialog opens automatically.

● After you have exported the script to a file.
Select "SCPI Recording Export > Show file content"
See Chapter 13.9.3, "SCPI recording export settings", on page 433.

The "SCPI Recording List" shows the last recorded and exported commands.
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SCPI Recording List
Lists the automatically or manually recorded recorded SCPI commands.

Export
Opens the SCPI Recording Export dialog for configuring the file parameters for export.

Remove All, Remove First, Remove Last
Deletes either the first, the last or all recorded SCPI commands.
To remove several recorded commands, repeat the removing.
For post processing, export the SCPI command list in a file, see Chapter 13.9.5, "How
to convert and save SCPI lists", on page 437.

13.9.3  SCPI recording export settings

Scripts are configured and saved in the "SCPI Recording Export" dialog. This dialog
opens automatically, when you stop recording.

Access:

1. Select "Show SCPI Recording List" in the context-sensitive menu.

The "SCPI Recording List" dialog opens.

2. Select "Export".

The "SCPI Recording Export" dialog contains all functions required for export of
command lists to a file. It enables you to select the source code format, assign an
individual filename and display the file content.

Format
Selects the source code format for the command list.
"Plain SCPI" Uses SCPI syntax.
"Predefined Code Generator"

Accesses the predefined templates for common source code genera-
tors that convert the recorded settings in the programming languages
MATLAB or NICVI or Python.

"User Code Generator"
Use this setting to convert a script by a user-specific code generator.
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Select Code Template
Opens the standard "File Select" dialog and lists the predefined or user-defined code
templates.
See Chapter 11.5.1, "File select settings", on page 321.

File
Opens the standard file select dialog "Select Output File", see Chapter 11.5.1, "File
select settings", on page 321.

Export
Executes data export.
The SCPI list is saved in as file with the selected filename and in the selected directory,
see File.

Reload
Reloads a SCPI list from a file.
You can export recorded SCPI lists to files (see File and Export), that can be modified.

File content
Displays the content of the script in the selected format and code template.

13.9.4  How to record / create SCPI lists

How to record SCPI lists automatically

The following example briefly explains how to proceed when you want to record SCPI
lists.

For comprehensive description, see 1GP98: SCPI Recorder Test Automation on a Fin-
gertip.

1. On the screen, open the context-sensitive menu (touch and hold, or right mouse
click) and select "Start SCPI recording".

Starting from now, all steps you perform are recorded.

2. To stop SCPI recording, select "context-sensitive menu > Stop SCPI recording".

The "SCPI Recording List" dialog opens automatically.

3. Proceed with How to check a SCPI list.

Automating tasks with remote command scripts
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How to record SCPI lists manually

1. To retrace your settings, open the context-sensitive menu and select "Mark all
Parameters Changed from Preset".

This function identifies and highlights all settings you have changed, both in the
block diagram, and in the dialogs.

2. For selectively recording your steps:

a) Set the parameter.
b) Open the context-sensitive menu.
c) Select "Add SCPI Command to Recording List"

Tip: You cannot see "Add SCPI ..." in the menu?
A possible reason is opening the menu outside of a dialog or input field, for
example in a block diagram. Open the context-sensitive menu within the corre-
sponding dialog or input field, and the feature is available.

d) Continue with the next setting, and repeat steps a to b whenever needed.

Each time you select "Add SCPI ...", the SCPI command is appended to a tempo-
rary list.

3. To check the progress of the recording, select "Context-Sensitive > Show SCPI
Recording List".

The "SCPI Recording List" dialog opens, displaying all recorded settings so far.

4. Proceed with How to check a SCPI list.

How to create a SCPI list with the current instrument settings in one step

You can also generate a SCPI list from a manually created instrument state at any
time, in only one step.

Automating tasks with remote command scripts



Network operation and remote controlR&S®SMA100B

436User Manual 1178.3834.02 ─ 09

To generate a SCPI list with commands for all settings performed:

1. Select "Save/Recall > SCPI Export".

The instrument opens the standard file select dialog, see Chapter 11.4.1, "Save/
recall settings", on page 318.

2. In the "Format" entry field, select the source code.

3. Depending on the selected format, convert the script as described in Chap-
ter 13.9.5, "How to convert and save SCPI lists", on page 437

4. Enter a filename.

5. Select "Export".
The instrument writes all SCPI commands of the key parameters and the modified
settings in the file. Also assigns the file extension automatically according to the
source code format.

6. To preview the content of the SCPI list:

a) Select "System Config > Save/Recall".
b) Select "Operation Mode > SCPI-Export".
c) In the /var/user/ directory, select a previously saved file.
d) Select "Show SCPI List".

The list of all SCPI commands is displayed, for example, for a final check.

Exporting the SCPI list of the instrument state in one step is a fast and convenient
method. Nevertheless, it usually requires postprocessing on an external PC.

How to check a SCPI list

The easiest way to check a list, is to execute it. The generator returns a warning if a
setting could not be performed.

Automating tasks with remote command scripts
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However, we recommend that you check the list and possibly rework. It can be that ...
● A parameter has not assigned a SCPI command or an element of the user inter-

face has not an assigned parameter. In these cases, :SYST:INF:SCPI 'SCPI
command not available' is entered in the list instead.
Such entries are also detected during execution. The instrument recognizes these
incomplete commands and displays an error message.

● A preset has been executed, but several standards then perform some internal set-
tings that are also assigned to the list with "SCPI Export".

● After a preset still some settings are defined, which are then written to the list gen-
erated with "SCPI Export."

Some suggestions on how you can check and revise a list:

1. Search and remove missing command entries.

2. Remove unnecessary content written after a preset.

3. Rearrange the commands to a reasonable order. If you, for example, set a STATe
command to the last position of a list, you can avoid intermediate calculations of
the signal.

4. Preview the list for completeness by comparing it with the modified settings in the
manual mode.

a) To retrace your settings in manual operation, open the context-sensitive menu
and select "Mark all parameters changed from preset".
The function identifies all settings you have changed, both in the block dia-
gram, and in the dialogs. They appear orange.

b) Check whether there is a command in the list for all modified settings.

5. To perform modifications, export the list to a PC, using for example a USB flash
drive.

13.9.5  How to convert and save SCPI lists

After completing the recording, the "SCPI Recording Export" dialog opens.

1. Select the "Format" for the command syntax in which you want to save the list.

2. "Select Code Template"
Depending on the selected format, proceed accordingly:
Note: Select the code template before exporting.

a) Plain SCPI
Continue with the next step.

b) Predefined code generator
The "SCPI Recording Export - Select Predefined Code Template" dialog opens.
Select one of the predefined code templates.

Automating tasks with remote command scripts



Network operation and remote controlR&S®SMA100B

438User Manual 1178.3834.02 ─ 09

c) User code generator
A file system ("SCPI Recording Export - Select User Code Template") dialog
opens.
Select your user-defined code template. The code template must have file
extension *.expcodetmpl.

3. Select "File..."
The "SCPI Recording Export - Select Output File" dialog opens.

4. Select "New" and assign a filename for saving the recorded list.

5. In the "SCPI Recording Export" dialog, select "Export".
Saves the recorded data either in ASCII format (plain SCPI), or in the correspond-
ing format of the used code template, and shows the SCPI list in the "File Content"
section.

13.9.6  How to find out the SCPI commands for GUI functions

Finding out the SCPI command using "Show SCPI Command"

1. To find out the SCPI command of a parameter in manual operation, select the
respective parameter.

2. Open the context-sensitive menu and select "Show SCPI command"

You get the detailed command syntax, including the currently set value.

With the "Copy" function, you can conveniently paste the command including the
current setting, e.g., in a command script.

Finding out the SCPI command using the online help

If you are looking for the remote command to a function in manual operation, you find it
in the description of the online help.

1. To find out the SCPI command of a parameter in manual operation, select the
respective parameter.

2. To open the corresponding help topic, select one of the following:

● In the display, select "context-sensitive menu > Help".
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● On the front panel, press the [Help] key.

The help topic opens. Apart from the function description, it contains the SCPI
command in detailed syntax.

How to find the corresponding GUI function to a command
Conversely, if you are looking for a function in the GUI, which belongs to a SCPI, you
find it via a cross-reference in the online help and in the user manual.

13.10  Operating the R&S SMA100B remotely using VNC

This section shows you some examples of the various possibilities to set up remote
operation.

● Using a desktop system
– Chapter 13.10.2.1, "Using a web browser", on page 440
– Chapter 13.10.2.2, "Using a VNC client software", on page 440

● Using a smart device
– Chapter 13.10.3.1, "Using a VNC app", on page 443
– Chapter 13.10.3.2, "Using a web browser with HTML5", on page 443
– Chapter 13.10.3.3, "Special mode QR code", on page 444

13.10.1  How to enable the VNC service

1. NOTICE! Enabled VNC service can lead to unauthorized access.
Change the computer name and password of the instrument.
See Chapter 12.4.5, "How to prevent unauthorized access", on page 373.

2. Select "System Config > Setup > Security > Security > LAN Services".

3. Select "VNC > On".

4. Enter the Security Password.

5. Select "Accept".

Operating the R&S SMA100B remotely using VNC
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13.10.2  How to set up remote operation from a desktop system

13.10.2.1  Using a web browser

The R&S SMA100B supports remote operation via VNC with any web browser, like
Windows Internet Explorer or Mozilla Firefox for instance, or alternatively, an HTML5
web browser.

To operate the instrument via a web browser remotely:

1. Install the JRE (Java Runtime Environment) on the remote computer.
Note: Skip this step if you are working with an HTML5 web browser.

2. Type the instruments' IP address in the address field of the web browser on your
PC, e.g. http://10.113.1.151

The VNC authentication screen appears.

3. Enter the password and confirm with "OK".
The default password is instrument.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated from the remote computer.

13.10.2.2  Using a VNC client software

A VNC client software is an application which can be used to access and control the
instrument from a remote computer through a LAN connection.

The VNC client software for setting up the connection is included in the operating sys-
tem Linux/Unix per default. For Windows operating systems, a VNC client software
must be installed manually.

Various free-of charge programs such as Ultr@VNC or similar VNC client programs
are available for download on the Internet.

Setting up the VNC connection on a Linux/Unix desktop client

1. Start a web browser on the remote computer. Enter the IP address of the instru-
ment.

2. Enter the following address:
vnc://<IP-address of the instrument>, for example vnc://10.113.1.151.

A dialog opens requesting the password for the remote VNC connection.

3. Enter the password and confirm with "OK".
The default password is instrument.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated from the remote computer.

Operating the R&S SMA100B remotely using VNC



Network operation and remote controlR&S®SMA100B

441User Manual 1178.3834.02 ─ 09

Setting up the VNC connection on a Windows desktop client

1. Install the VNC viewer program component on the remote computer.

a) On the Internet, select a VNC client program and download it onto your PC.
For example the free of charge software Ultr@VNC (vncviewer.exe is avail-
able, see http://www.uvnc.com/download/index.html.

b) Execute the VNC client installation.
c) Select the VNC viewer program component and follow the installation instruc-

tions.

2. Start VNC viewer program component on the PC.

3. Select "VNC Server" and enter the IP address of the instrument.

4. To initialize the connection, select "Connect".

A dialog opens requesting the password.

5. Enter the password and confirm with "OK".
The default password is instrument.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated from the remote computer.

Terminating VNC connection

► Perform one of the following:

a) On an external Unix/Linux PC, close the Internet browser or the signal genera-
tor window.

Operating the R&S SMA100B remotely using VNC
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b) On an external Windows PC, close the VNC viewer program.

The connection is terminated but not disabled. It can be established again anytime.
In the "Active Connections" tab, the displayed TCP/IP connection disappears.
See Chapter 12.4.5, "How to prevent unauthorized access", on page 373.

13.10.3  How to set up remote operation from a smart device

The R&S SMA100B supports remote operation via VNC from a smart device (remote
client), like a tablet (tablet computer) or a smartphone. The smart device accesses the
instrument via WLAN, either by a suitable App, or an HTML5 web browser, that means
with embedded javascript.

There are several possibilities to establish a WLAN connection between the smart
device and the R&S SMA100B. This section gives an example of how a network envi-
ronment can be built up, and some essential configuration steps.

For more information, see:
● 1MA216: Remote Operation of Windows Based Instruments with Apple iPad
● 7BM82: Apple iPad Remote Control of Broadcasting T&M Instruments

Example: 

Figure 13-9: Example of a network configuration for remote operation with a smart device

As shown in the figure, the R&S SMA100B and the WLAN router are connected to the
LAN router. The smart device accesses the Rohde & Schwarz instrument via the
WLAN router.

Prerequisites

For this network configuration, the following prerequisites must be met:
● The required equipment is:

– A LAN router

Operating the R&S SMA100B remotely using VNC
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– A WLAN router (hot spot)
Required for accessing the R&S SMA100B

● The smart device must be known and accepted in the network of the
R&S SMA100B.

● The App or web browser implements the VNC functionality on the smart device for
remote operation.

It is recommended that all components in the network use DHCP, which automatically
assigns the relevant address information.

With the configuration in the example, you can reach the instrument from a great dis-
tance, since the WLAN router acts as an additional access point.

13.10.3.1  Using a VNC app

Using a VNC App enables the smart device to access the R&S SMA100B via WLAN.

The VNC Apps are available from various manufacturers of the smart devices.

The list of supported devices is different according to the smart device.

1. Refer to the manufacturer's website to find out whether a VNC App is available for
your device, and how it is installed.

2. In the network, establish the connection of the WLAN router to the LAN router.
We assume the connection of the LAN router and the R&S SMA100B and their
configuration in the LAN.

3. Configure the WLAN router according to the manufacturer's instructions.

4. Install the required VNC App on your smart device.

5. On the smart device, start the VNC App.

6. In the address field, enter the IP address of the instrument.

A log-on dialog opens and requests the password for the VNC connection.

7. Enter the password to establish the remote access.
The default user name and password is instrument.
See Chapter 12.4.5, "How to prevent unauthorized access", on page 373.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated.

13.10.3.2  Using a web browser with HTML5

The R&S SMA100B supports remote operation from a smart device via VNC with any
HTML5 compliant web browser, like Internet Explorer, Firefox, Google Chrome, or
Safari for instance.

Operating the R&S SMA100B remotely using VNC
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To operate the instrument remotely via a web browser, proceed as follows:

1. In the web browser enter the IP address of the instrument, e.g. http://10.113.1.151.

2. Type the instrument IP address in the address field of the web browser on your PC,
e.g. http://10.113.1.151

The VNC authentication screen appears.

3. Enter the password and confirm with "OK".
The default password is instrument.
See Chapter 12.4.5, "How to prevent unauthorized access", on page 373.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated.

13.10.3.3  Special mode QR code

If your smart device is equipped with a camera and a QR code reader, you can scan
the instrument's IP address or access the instrument with the Safari web browser.

QR code readers are available from various manufacturers of the smart devices.

The list of supported devices is different according to the smart device.

1. Refer to the manufacturer's website of your smart device to find out whether a
reader is available for your device, and how it is installed.

2. Install the required QR code reader software on your device.

3. Start the reader.

4. On the R&S SMA100B, select "System Config > Remote Access".

5. In the "Remote Access" dialog, select the "QR-Code" tab.

6. Scan the QR code of the instrument with your smart device.

7. On the device, decode the scanned QR code and pass it to the web browser.

A dialog opens requesting the password for the VNC connection.

8. Enter the password and confirm with "OK".
The default password is instrument.

After the connection is established, the current screen of the signal generator is
displayed and the instrument can be remotely operated.
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13.11  References

13.11.1  LXI functionality

LAN Extensions for Instrumentation (LXI) is an instrumentation platform for measuring
instruments and test systems that is based on standard Ethernet technology.

LXI is intended to be the LAN-based successor to GPIB, combining the advantages of
Ethernet with the simplicity and familiarity of GPIB. Like GPIB, LXI determines and
standardizes the way the instrument behaves in a LAN.

The LXI implementation in the R&S SMA100B allows you to change certain LAN set-
tings, to reset the LAN connection, and to identify the instrument.

For information about the LXI standard, refer to the LXI website at http://www.lxistan-
dard.org.
See also "News from Rohde & Schwarz, article 2006/II - 190".

The LXI functionality in the R&S SMA100B is characterized by a common LAN imple-
mentation, including an ICMP ping responder for diagnostics. Using a web browser,
you can configure the instrument. A LAN Configuration Initialize (LCI) mechanism
resets the LAN configuration. The instrument also supports automatic detection in a
LAN via the VXI-11 discovery protocol and programming by IVI drivers.

In addition, the R&S SMA100B provides the following LXI-related functionality:
● Integrated "LXI Status" dialog for LXI status indication and reset of the LAN config-

uration, see Chapter 13.6.1, "LXI status settings", on page 407.
● "LXI Browser Interface", as described in Chapter 13.6.2.1, "LAN configuration",

on page 410.
● "SCPI Remote Trace" utility, see Chapter 13.6.2.2, "SCPI remote trace",

on page 412.

Firmware update
To enable the full LXI functionality after a firmware update, shut down and restart the
instrument.

13.11.2  Code generator templates

This section describes the main structure of the code generator templates, and shows
the method with the NICVI template.

The code generation is controlled by templates with the following blocks:
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Command Function

#EXTENSION_START
#EXTENSION_END

Defines the output file extension.

#INIT_CODE_START
#INIT_CODE_END

Contains initial entries, such as included files and
libraries, buffer size, commands for synchronization,
or creating a VISA session.

All entries between start and end are written once at
the beginning of the output file.

#COMMAND_CODE_START
#COMMAND_CODE_END

Frame for a SCPI command. A command is
accessed with %COMMAND.

#NO_COMMAND_CODE_START
#NO_COMMAND_CODE_END

Frame for a parameter with no SCPI command
available. A parameter is accessed with
%PARAMETER.

#EXIT_CODE_START
#EXIT_CODE_END

Closes the visa session.

All entries between start and end are written once at
the end of the output file.

Templates are created in ASCII format with file extension *.expcodetempl.

Example: 
Example to the code generator template NICVI.expcodetmpl:

#EXTENSION_START
.c
#EXTENSION_END

#INIT_CODE_START
#include <ansi_c.h>
#include <visa.h>
#include <cvirte.h>

#define MAX_BUFFER_SIZE 200
static ViStatus status;
static ViSession defaultRM, handle;

static void write_command(char *command)
{
  char writeBuffer[MAX_BUFFER_SIZE];
        char readBuffer[MAX_BUFFER_SIZE];
        int length;
        int readCount;
        
        strcpy(writeBuffer, command);
        //append "*OPC?" to sync
        strcat(writeBuffer, ";*OPC?");
        length = strlen (writeBuffer);
        writeBuffer[length]='\n';
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        length = length+1;
        viWrite (handle, writeBuffer, length, VI_NULL);
        //read result
        viRead(handle, readBuffer, 100, &readCount);
}     
int main (int argc, char *argv[])
{
  if (InitCVIRTE (0, argv, 0) == 0)
     return -1;    /* out of memory */
        //create a VISA session and return a handle to it
     viOpenDefaultRM (&defaultRM);
        //create a VISA session to the serial port and return a handle to it
        viOpen (defaultRM, (ViRsrc)"TCPIP::localhost::INSTR", VI_NULL, VI_NULL, 
&handle);
#INIT_CODE_END

#COMMAND_CODE_START
  write_command("%COMMAND");
#COMMAND_CODE_END

#NO_COMMAND_CODE_START
  //no SCPI command available for parameter %PARAMETER !
#NO_COMMAND_CODE_END

#EXIT_CODE_START
  viClose (handle);
        viClose (defaultRM);
        return 0;
}
#EXIT_CODE_END

13.11.3  Remote control states

How to recognize if there is an active remote connection to the instrument

► Observe the indication on the taskbar.

A softkey in the taskbar indicates if and what kind of remote connections are cur-
rently set up.
See also Chapter 13.5.6, "Remote connections settings", on page 405.

The following table shows the different remote control states and the associated com-
mands or actions to return to manual control.
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Table 13-8: Remote control status icons

GUI symbol Transition to remote control state... Transition to manual operation...(local state)

&GTR (controller)

Remote control, but usable front panel keys.

The parameters are in read-only mode.

● &GTL (controller)
● Tap the "Remote" icon (display)
● [Local] (front panel or key emulation)

 A currently performed setting is indicated by the green
arrows.

The setting must be completed (white arrows), other-
wise the instrument remains in remote state.

 &LLO (controller)

Remote control with locked front panel keys to
prevent user interaction.

The parameters are in read-only mode.

You can unlock LLO, and thus return to manual
operation only via remote control.

● &LOCS (controller)
● CALL IBLOC (generator%) (controller)

Note: The command &REMS returns to "Remote" state.
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14  Remote control commands
In the following, all remote-control commands are presented in detail with their param-
eters and the ranges of numerical values.

For an introduction to remote control and the status registers, see Chapter 13, "Net-
work operation and remote control", on page 378.

14.1  Conventions used in SCPI command descriptions

The following conventions are used in the remote command descriptions:
● Command usage

If not specified otherwise, commands can be used both for setting and for querying
parameters.
If a command can be used for setting or querying only, or if it initiates an event, the
usage is stated explicitly.

● Parameter usage
If not specified otherwise, a parameter can be used to set a value and it is the
result of a query.
Parameters required only for setting are indicated as Setting parameters.
Parameters required only to refine a query are indicated as Query parameters.
Parameters that are only returned as the result of a query are indicated as Return
values.

● Conformity
Commands that are taken from the SCPI standard are indicated as SCPI con-
firmed. All commands used by the R&S SMA100B follow the SCPI syntax rules.

● Asynchronous commands
A command which does not automatically finish executing before the next com-
mand starts executing (overlapping command) is indicated as an Asynchronous
command.

● Reset values (*RST)
Default parameter values that are used directly after resetting the instrument (*RST
command) are indicated as *RST values, if available.

● Factory preset values
Default parameter values that are reset only by factory preset.

● Default unit
The default unit is used for numeric values if no other unit is provided with the
parameter.

● Manual operation
If the result of a remote command can also be achieved in manual operation, a link
to the description is inserted.

Conventions used in SCPI command descriptions



Remote control commandsR&S®SMA100B

450User Manual 1178.3834.02 ─ 09

14.2  Programming examples

The corresponding sections of the same title provide simple programming examples for
the R&S SMA100B. The purpose of the examples is to present all commands for a
given task. In real applications, one would rather reduce the examples to an appropri-
ate subset of commands.

The programming examples have been tested with a software tool which provides an
environment for the development and execution of remote tests. To keep the examples
as simple as possible, only the "clean" SCPI syntax elements are reported. Non-exe-
cutable command lines (for example comments) start with two // characters.

At the beginning of the most remote control program, an instrument (p)reset is recom-
mended to set the R&S SMA100B to a definite state. The commands *RST and
SYSTem:PRESet are equivalent for this purpose. *CLS also resets the status registers
and clears the output buffer.

In all the examples we assume that:
● A remote PC is connected to the instrument
● The remote PC and the instrument are switched on
● A connection between them is established
● The security setting "System Config > Setup > Security > SCPI over LAN" is

enabled.

14.3  Common commands

Common commands are described in the IEEE 488.2 (IEC 625-2) standard. These
commands have the same effect and are employed in the same way on different devi-
ces. The headers of these commands consist of "*" followed by three letters. Many
common commands are related to the Status Reporting System.

Available common commands:

*CLS.............................................................................................................................451
*ESE.............................................................................................................................451
*ESR?...........................................................................................................................451
*IDN?............................................................................................................................451
*IST?............................................................................................................................ 452
*OPC............................................................................................................................452
*OPT?...........................................................................................................................452
*PRE............................................................................................................................ 452
*PSC............................................................................................................................ 452
*RCL.............................................................................................................................453
*RST.............................................................................................................................453
*SAV.............................................................................................................................453
*SRE............................................................................................................................ 454
*STB?...........................................................................................................................454
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*TRG............................................................................................................................ 454
*TST?........................................................................................................................... 454
*WAI.............................................................................................................................454

*CLS

Clear status

Sets the status byte (STB), the standard event register (ESR) and the EVENt part of
the QUEStionable and the OPERation registers to zero. The command does not
alter the mask and transition parts of the registers. It clears the output buffer.

Usage: Setting only

*ESE <Value>

Event status enable

Sets the event status enable register to the specified value. The query returns the con-
tents of the event status enable register in decimal form.

Parameters:
<Value> Range: 0 to 255

*ESR?

Event status read

Returns the contents of the event status register in decimal form and then sets the reg-
ister to zero.

Return values: 
<Contents> Range: 0  to  255

Usage: Query only

*IDN?

Identification

Returns the instrument identification.

Return values: 
<ID> "Rohde&Schwarz,<device type>,<part number>/<serial num-

ber>,<firmware version>"

Example: Rohde&Schwarz,SMA100B,1419.8888K02/0,4.00.033
Usage: Query only

Manual operation: See "IDN String" on page 404

Common commands
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*IST?

Individual status query

Returns the contents of the IST flag in decimal form. The IST flag is the status bit
which is sent during a parallel poll.

Return values: 
<ISTflag> 0 | 1

Usage: Query only

*OPC

Operation complete

Sets bit 0 in the event status register when all preceding commands have been execu-
ted. This bit can be used to initiate a service request. The query writes a "1" into the
output buffer when all preceding commands have been executed, which is useful for
command synchronization.

*OPT?

Option identification query

Queries the options included in the instrument. For a list of all available options and
their description, refer to the data sheet.

Return values: 
<Options> The query returns a list of options. The options are returned at

fixed positions in a comma-separated string. A zero is returned
for options that are not installed.

Usage: Query only

Manual operation: See "OPT String" on page 404

*PRE <Value>

Parallel poll register enable

Sets parallel poll enable register to the indicated value. The query returns the contents
of the parallel poll enable register in decimal form.

Parameters:
<Value> Range: 0  to  255

*PSC <Action>

Power on status clear

Common commands
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Determines whether the contents of the ENABle registers are preserved or reset when
the instrument is switched on. Thus a service request can be triggered when the instru-
ment is switched on, if the status registers ESE and SRE are suitably configured. The
query reads out the contents of the "power-on-status-clear" flag.

Parameters:
<Action> 0 | 1

0
The contents of the status registers are preserved.
1
Resets the status registers.

*RCL <Number>

Recall

Loads the instrument settings from an intermediate memory identified by the specified
number. The instrument settings can be stored to this memory using the command
*SAV with the associated number.

It also activates the instrument settings which are stored in a file and loaded using the
MMEMory:LOAD <number>, <file_name.extension> command.

Manual operation: See "Recall Immediate x" on page 320

*RST

Reset

Sets the instrument to a defined default status. The default settings are indicated in the
description of commands.

The command is equivalent to SYSTem:PRESet.

Usage: Setting only

Manual operation: See "Preset" on page 313

*SAV <Number>

Save

Stores the current instrument settings under the specified number in an intermediate
memory. The settings can be recalled using the command *RCL with the associated
number.

To transfer the stored instrument settings in a file, use the command :MMEMory:
STORe:STATe.

Manual operation: See "Save Immediate x" on page 319
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*SRE <Contents>

Service request enable

Sets the service request enable register to the indicated value. This command deter-
mines under which conditions a service request is triggered.

Parameters:
<Contents> Contents of the service request enable register in decimal form.

Bit 6 (MSS mask bit) is always 0.
Range: 0  to  255

*STB?

Status byte query

Reads the contents of the status byte in decimal form.

Usage: Query only

*TRG

Trigger

Triggers all actions waiting for a trigger event. In particular, *TRG generates a manual
trigger signal. This common command complements the commands of the TRIGger
subsystem.

Usage: Event

*TST?

Self-test query

Initiates self-tests of the instrument and returns an error code.

Return values: 
<ErrorCode> integer > 0 (in decimal format)

An error occurred.
(For details, see the Service Manual supplied with the instru-
ment).
0
No errors occurred.

Usage: Query only

*WAI

Wait to continue
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Prevents servicing of the subsequent commands until all preceding commands have
been executed and all signals have settled (see also command synchronization and
*OPC).

Usage: Event

14.4  Preset commands

The preset commands are not bundled in one subsystem. Therefore, they are listed
separately in this section.

Four presetting actions are available:
● Activating the default state of all internal instrument functions (*RST on page 453).

Functions that concern the integration of the instrument into a measurement setup
are not changed, e.g. reference oscillator source settings.

● Activating the preset state of the parameters related to the selected signal path (:
SOURce<hw>:PRESet on page 455)

● Activating the preset state of all parameters that are not related to the signal path
(:DEVice:PRESet on page 455)

● Activating the original state of delivery (factory reset, :SYSTem:FPReset
on page 456). Only functions that are protected by a password remain unchanged
as well as the passwords themselves.

When resetting, the following deviation between remote and manual control exists:
In contrast to the [Preset] key, the SCPI commands *RST and :SYSTem:PRESet do
not close open dialogs in the GUI.

:DEVice:PRESet............................................................................................................ 455
:SOURce<hw>:PRESet.................................................................................................. 455
:SYSTem:PRESet.......................................................................................................... 456
:SYSTem:FPReset......................................................................................................... 456

:DEVice:PRESet

Presets all parameters which are not related to the signal path, including the LF gener-
ator.

Example: DEV:PRES
Presets all instruments settings that are not related to the signal
path.

Usage: Event

:SOURce<hw>:PRESet

Presets all parameters which are related to the selected signal path.

Preset commands
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Example: SOUR:PRES
Presets all settings that are related to signal path

Usage: Event

:SYSTem:PRESet

Triggers an instrument reset. It has the same effect as:
● The [Preset] key.

However, the command does not close open GUI dialogs like the key does.
● The *RST command

For an overview of the settings affected by the preset function, see Table 11-1

Example: SYST:PRES
All instrument settings (also the settings that are not currently
active) are reset to their default values.

Usage: Setting only

Manual operation: See "Preset" on page 313

:SYSTem:FPReset

Triggers an instrument reset to the original state of delivery.

Example: SYST:FPR
All instrument settings (also the settings that are not currently
active) are reset to the factory values.

Usage: Event

Manual operation: See "Execute Factory Preset" on page 314

14.5  MMEMory subsystem

The MMEMory subsystem (Mass MEMory) contains the commands for managing files
and directories as well as for loading and saving complete instrument settings in files.

Mass storage location

Without any additional measures, the R&S SMA100B stores user files on the internal
memory, the removable memory, or if connected, on a memory stick.

Both, the user directory /var/user/ on the internal memory or the /usb/ directory
on the memory stick, can be used to preserve user-defined data. Any directory struc-
ture can be created.

The /var/volatile directory serves as a RAM drive and can be used to protect
sensitive information. The data is available temporarily.

MMEMory subsystem
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If option R&S SMAB-B85 is installed, the R&S SMA100B maps the user directory to
the removable memory. If a memory is mounted, user data is saved there. Otherwise
user data is redirected to the volatile memory.

Default storage location

The R&S SMA100B stores user data in the user directory.

Depending on the installed options, the user directory is physically located on the inter-
nal memory or on the removable memory.

In the file system, user directory is always indicated as /var/user/.

In manual control, you access this directory via the "File Manager", see Chapter 11.8,
"Using the file manager", on page 324. In remote control, you can query it with the
command :SYSTem:MMEMory:PATH:USER?.

To query and change the default directory used for mass storage, use the command :
MMEMory:CDIRectory.

14.5.1  File naming conventions

To enable files to be used in different file systems, consider the following file naming
conventions:
● The filename can be of any length and is case-sensitive, i.e it is distinguished

between uppercase and lowercase letters.
● All letters and numbers are permitted (numbers are, however, not permitted at the

beginning of the filename).
● Avoid using special characters.
● Do not use slashes "\" and "/". These symbols are used in file paths.
● Avoid using the following filenames: CLOCK$, CON, COM1 to COM4,

LPT1 to LPT3, NUL or PRN
They are reserved by the operating system.

File extension

The file and the optional file extension are separated by a period sign. The
R&S SMA100B distinguishes the files according to their extensions; each type of file is
assigned a specific file content and hence a specific file extension. Refer to Chapter B,
"Extensions for user files", on page 781 for an overview of the supported file exten-
sions.

Wildcards

The two characters "*" and "?" function as "wildcards", i.e. they are used for selecting
several files. The "?" character represents exactly one character, while the "*" charac-
ter represents all characters up to the end of the filename. "*.*" therefore represents all
files in a directory.

MMEMory subsystem
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Filename and file path

When used in remote control commands, the parameter <filename> is specified as a
string parameter with quotation marks. It can contain either the complete path including
the root user directory /var/user and filename, or only the filename. The filename
must include the file extension. The same applies for the directory /var/volatile
and for the parameters <directory_name> and <path>.

Depending on how much information is provided, the values specified in the parameter
or with the command MMEM:CDIR are used for the path and drive setting in the com-
mands.

14.5.2  Accessing files in the default or in a specified directory

For better overview and easy file handling, you may not save all user files in the user
directory /var/user but rater organize them into subdirectories.

The command syntax defines two general ways to access files with user data in a spe-
cific directory:
● Change the current default directory for mass memory storage and then directly

access the files in this default directory, like saved list files, files with user data or
save/recall files.
The subsequent commands for file handling (select, delete, read out files in the
directory, etc.) require only specification of the filename. File extension can be
omitted; after syntax evaluation of the used command, the R&S SMA100B filters
out the relevant files.

● Define the complete file path, including the user directory /var/user, created
subdirectories and filename (see Example "Load file with user data from a specific
directory" on page 458).
As a rule, whenever an complete file path is determined, it overwrites a previously
specified default directory.

The following example explains this rule as a principle. Exceptions of this general rule
are stated in the description of the corresponding command. The Chapter 14.5.3, "Pro-
gramming examples", on page 459 explains the general working principle with the
commands for mass memory storage.

The same rule applies to the /var/volatile directory, see Example "Working with
files in the volatile memory" on page 460.

Example: Load file with user data from a specific directory
This example shows the principle of file handling in remote environment by using list
commands. Working with the files of other subsystems is analogical. We assume that
the directory /var/user/my_files is existing and contains the files
list_test.lsw and list_2.lsw.

//Query files in the user diectory
SOURce1:LIST:CATalog?
// -
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// no files

// Set the default directory
MMEMory:CDIRectory "/var/user/my_files"
SOURce1:LIST:CATalog?
// "list_test","list_2"

// Specify the complete path to select a list file (*.lsw) 
// in the specific directory
SOURce1:LIST:SELect "/var/user/my_files/list_test"
SOURce1:LIST:DELete "/var/user/my_files/list_2"

14.5.3  Programming examples

Example: Saving and loading current settings
This example shows two ways of how to save the current instrument setting in the file
settings.savrcltxt in the directory /var/user/savrcl.

Before the instrument settings can be saved in a file, they have to be saved in an inter-
mediate memory using common command *SAV <number>. The specified number is
then used in the :MMEMory:STORe:STATe command.
Also, after loading a file with instrument settings with command :MMEMory:LOAD:
STATe, these settings have to be activated with the common command *RCL
<number>.

// Save the current settings in an intermediate memory with number 4
*SAV 4

// save the settings in a file in a specific directory;
// the complete path has to be specyfied
MMEMory:STORe:STATe 4,"/var/user/savrcl/settings.savrcltxt"

// save the settings in a file in the default directory;
// set the default directory; specify only the file name
MMEMory:CDIRectory  "/var/user/savrcl"
*SAV 4
MMEMory:STORe:STATe 4,"settings.savrcltxt"

// Load the saved settings in the intermediate memory 4 and activate them
MMEMory:LOAD:STATe 4,"/var/user/settings.savrcltxt"
*RCL 4

Example: Working with files and directories
This example shows how to list files in a directory, list the subdirectories, query the
number of files in a directory, create directory, rename and delete files.
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// Query the current default directory for mass storage,
// change the directory to the default user directory "/var/user"
// and read out the files in it
MMEMory:CDIRectory?
// "/var/user/temp"
MMEMory:CDIRectory
MMEMory:CDIRectory?
// "/var/user/"
MMEMory:CATalog?
// 1282630,8102817792,".,DIR,4096","..,DIR,4096","Log,DIR,4096",
// "settings.savrcltxt,BIN,16949","temp,DIR,4096","test,DIR,4096",
// "list.lsw,BIN,1245201"
// the directory "/var/user" contains the predefined directory "Log",
// the subdirectories "test" and "temp"
// as well as the files "settings.savrcltxt" and "list.lsw"

// query only the subdirectories of the current or specified directory
MMEMory:DCATalog? "/var/user"
// ".","..","Log","temp","test"

// query only number of subdirectories in the current or specified directory
MMEMory:DCATalog:LENGth? "/var/user"
// 5

// query number of files in the current or specified directory
MMEMory:CATalog:LENGth? "/var/user"
// 7

// Create a new directory for mass memory storage in the specified directory
MMEMory:MDIRectory "/var/user/new"

// Copy the file "settings.savrcltxt" into the new directory
MMEMory:COPY "/var/user/settings.savrcltxt","/var/user/new/settings.savrcltxt"

// Rename the file "settings.savrcltxt" into the new directory
// and read out the files in this specific directory
MMEMory:CDIRectory  "/var/user/new"
MMEMory:MOVE "settings.savrcltxt","settings_new.savrcltxt"
MMEMory:CATalog? "/var/user/new"
// 25141,8102789120,".,DIR,4096","..,DIR,4096","settings_new.savrcltxt,BIN,16949"

// Delete the "test" directory
MMEMory:RDIRectory "/var/user/test"

Example: Working with files in the volatile memory
This example shows how to work with files in the /var/volatile directory.

// Change the default directory for mass storage,
// read out the files, load and play a file with the ARB 
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MMEMory:CDIRectory "/var/volatile"
MMEMory:CDIRectory?
// "/var/volatile"
MMEMory:CATalog?
//13928,525352960,".,DIR,60","..,DIR,4096","list.lst,BIN,9772"

SOURce1:LIST:SELect "/var/volatile/list"
SOURce1:FREQuency:MODE LIST
OUTPut1:STATe 1

14.5.4  Remote control commands

:MMEMory:CATalog?......................................................................................................461
:MMEMory:CATalog:LENGth?......................................................................................... 462
:MMEMory:CDIRectory...................................................................................................462
:MMEMory:COPY...........................................................................................................462
:MMEMory:DATA............................................................................................................463
:MMEMory:DCATalog?....................................................................................................464
:MMEMory:DCATalog:LENGth?....................................................................................... 464
:MMEMory:DELete.........................................................................................................464
:MMEMory:LOAD:STATe.................................................................................................464
:MMEMory:MDIRectory...................................................................................................465
:MMEMory:MOVE.......................................................................................................... 465
:MMEMory:MSIS............................................................................................................465
:MMEMory:RDIRectory...................................................................................................466
:MMEMory:STORe:STATe...............................................................................................466
:MEMory:HFRee?.......................................................................................................... 466

:MMEMory:CATalog? <path>

Returns the content of a particular directory.

Query parameters: 
<path> string

String parameter to specify the directory.
If you leave out the path, the command returns the contents of
the directory selected with :MMEMory:CDIRectory.
The path may be relative or absolute.

Return values: 
<UsedDiskSpace> Byte size of all files in the directory.

<FreeDiskSpace> Remaining disk space in bytes.

<FileInfo> <NameFileN>,<SuffixFileN>,<SizeFileN>
List of files, separated by commas
<NameFileN>
Name of the file.
<SuffixFileN>
Type of the file. Possible suffixes are: ASCii, BINary, DIRectory
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<SizeFileN>
Size of the file in bytes.

Usage: Query only

Manual operation: See "Directory, File List and Filename" on page 318

:MMEMory:CATalog:LENGth? <Path>

Returns the number of files in the current or in the specified directory.

Query parameters: 
<Path> string

String parameter to specify the directory. If the directory is omit-
ted, the command queries the content of the current directory,
queried with :MMEMory:CDIRectory command.

Return values: 
<FileCount> integer

Number of files.

Usage: Query only

:MMEMory:CDIRectory <Directory>

Changes the default directory for mass memory storage. The directory is used for all
subsequent MMEM commands if no path is specified with them.

Parameters:
<Directory> <directory_name>

String containing the path to another directory. The path can be
relative or absolute.
To change to a higher directory, use two dots '..' .

Usage: SCPI confirmed

Manual operation: See "Directory, File List and Filename" on page 318

:MMEMory:COPY <SourceFile>[,<DestinationFile>]

Copies an existing file to a new file. Instead of just a file, this command can also be
used to copy a complete directory together with all its files.

Setting parameters: 
<SourceFile> string

String containing the path and file name of the source file
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<DestinationFile> string
String containing the path and name of the target file. The path
can be relative or absolute.
If <DestinationFile> is not specified, the <SourceFile> is
copied to the current directory, queried with the :MMEMory:
CDIRectory command.
Note: Existing files with the same name in the destination direc-
tory are overwritten without an error message.

Usage: Setting only
SCPI confirmed

Manual operation: See "Cut, Copy&Paste and Delete" on page 326

:MMEMory:DATA <Filename>, <BinaryBlock>
:MMEMory:DATA? <Filename>

The setting command writes the block data <BinaryBlock> to the file identified by
<Filename>.

Tip: Use this command to read/transfer stored instrument settings or waveforms
directly from/to the instrument.

Parameters:
<BinaryBlock> #<number><length_entry><data>

#: Hash sign; always comes first in the binary block
<number>: the first digit indicates how many digits the subse-
quent length entry has
<length_entry>: indicates the number of subsequent bytes
<data>: binary block data for the specified length.
For files with a size with more than nine digits (gigabytes), the
instrument allows the syntax #(<Length>), where <Length>
is the file size in decimal format.

Parameters for setting and query: 
<Filename> string

String parameter to specify the name of the file.

Example: MMEMory:DATA '/var/user/test.txt',#15hallo
Writes the block data to the file test.txt.
The digit 1 indicates a length entry of one digit; the digit 5 indi-
cate a length of the binary data (hallo) in bytes.
MMEMory:DATA? '/var/user/test.txt'
Sends the data of the file test.txt from the instrument to the
controller in the form of a binary block.
Response: #15hallo

Usage: SCPI confirmed
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:MMEMory:DCATalog? <path>

Returns the subdirectories of a particular directory.

Query parameters: 
<path> String parameter to specify the directory. If the directory is omit-

ted, the command queries the content of the current directory,
queried with :MMEMory:CDIRectory command.

Return values: 
<Catalog> <file_entry>

Names of the subdirectories separated by colons. The first two
strings are related to the parent directory.

Usage: Query only

:MMEMory:DCATalog:LENGth? [<Path>]

Returns the number of subdirectories in the current or specified directory.

Query parameters: 
<Path> String parameter to specify the directory. If the directory is omit-

ted, the command queries the contents of the current directory,
to be queried with :MMEMory:CDIRectory command.

Return values: 
<DirectoryCount> integer

Number of parent and subdirectories.

Usage: Query only

:MMEMory:DELete <Filename>

Removes a file from the specified directory.

Setting parameters: 
<Filename> string

String parameter to specify the name and directory of the file to
be removed.

Usage: Event
SCPI confirmed

Manual operation: See "Cut, Copy&Paste and Delete" on page 326

:MMEMory:LOAD:STATe <SavRclStateNumb>, <file_name>

Loads the specified file stored under the specified name in an internal memory.

After the file has been loaded, the instrument setting must be activated using an *RCL
command.
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Setting parameters: 
<SavRclStateNumb> Determines to the specific <number> to be used with the *RCL

command, e.g. *RCL 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Usage: Setting only

Manual operation: See "Recall" on page 320

:MMEMory:MDIRectory <Directory>

Creates a subdirectory for mass memory storage in the specified directory. If no direc-
tory is specified, a subdirectory is created in the default directory. This command can
also be used to create a directory tree.

Setting parameters: 
<Directory> string

String parameter to specify the new directory.

Usage: Event

Manual operation: See "Create New Directory" on page 326

:MMEMory:MOVE <SourceFile>, <DestinationFile>

Moves an existing file to a new location or, if no path is specified, renames an existing
file.

Setting parameters: 
<SourceFile> string

String parameter to specify the name of the file to be moved.

<DestinationFile> string
String parameters to specify the name of the new file.

Usage: Event
SCPI confirmed

Manual operation: See "Rename " on page 326

:MMEMory:MSIS <Msis>

Defines the drive or network resource (in the case of networks) for instruments with
windows operating system, using msis (MSIS = Mass Storage Identification String).

Note: Instruments with Linux operating system ignore this command, since Linux does
not use drive letter assignment.

Usage: SCPI confirmed
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:MMEMory:RDIRectory <Directory>

Removes an existing directory from the mass memory storage system. If no directory
is specified, the subdirectory with the specified name is deleted in the default directory.

Setting parameters: 
<Directory> string

String parameter to specify the directory to be deleted.

Usage: Event

:MMEMory:STORe:STATe <savrcl_state_nr>, <file_name>

Stores the current instrument setting in the specified file.

The instrument setting must first be stored in an internal memory with the same num-
ber using the common command *SAV.

Setting parameters: 
<savrcl_state_nr> Corresponds to the specific <number> defined with the *SAV

command, e.g. *SAV 4.

<file_name> String parameter to specify the file name with extension
*.savrcltxt.

Usage: Event

Manual operation: See "Save" on page 319

:MEMory:HFRee?

Returns the used and available memory in Kb.

Return values: 
<TotalPhysMemKb> integer

Total physical memory.

<ApplicMemKb> integer
Application memory.

<HeapUsedKb> integer
Used heap memory.

<HeapAvailableKb> integer
Available heap memory.

Usage: Query only
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14.6  CALibration subsystem

The CALibration subsystem contains the commands needed for performing internal
adjustments. This procedure is triggered by the query commands.

Common suffixes

The following common suffixes are used in the remote commands:

Suffix Value range Description

CALibration<hw> [1] Optional suffix

Understanding the query response

● 0: error-free execution of the adjustments
● 1: indicates that an error occurred; the process has been canceled

:CALibration:ALL[:MEASure]?......................................................................................... 467
:CALibration<hw>:ALL:DATE?.........................................................................................467
:CALibration<hw>:ALL:INFormation?............................................................................... 468
:CALibration<hw>:ALL:TEMP?........................................................................................ 468
:CALibration<hw>:ALL:TIME?......................................................................................... 468
:CALibration:DATA:FACTory:DATE?.................................................................................469
:CALibration<hw>:CONTinueonerror................................................................................469

:CALibration:ALL[:MEASure]? [<Force>]

Starts all internal adjustments that do not need external measuring equipment.

NOTICE! High power at the RF output applied during internal adjustment can destroy a
connected DUT (device under test).

How to: See "Running internal adjustments" on page 764.

Query parameters: 
<Force> string

Return values: 
<Measure> 1 | ON | 0 | OFF

Example: CAL:ALL:MEAS?
// Response: "0"
// Executes the adjustments of all instrument functions. 
// When completed, it indicates that the adjustment 
// has been performed successfully.

Usage: Query only

Manual operation: See "Adjust All" on page 763

:CALibration<hw>:ALL:DATE?

Queries the date of the most recently executed full adjustment.
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Suffix: 
<hw>

.
[1]
Optional suffix

Return values: 
<Date> string

Example: CAL:ALL:DATE?
// "2016-01-01"

Usage: Query only

Manual operation: See "Last Full Adjustment" on page 763

:CALibration<hw>:ALL:INFormation?

Queries the current state of the internal adjustment.

Return values: 
<CalInfoText> string

Example: CAL:ALL:INF?
"Instrument is calibrated, no adjustment required."
"UNCAL, instrument is warming up."
"UNCAL, Please perform full adjustment after warming up."
"UNCAL, Please perform full adjustment."

Usage: Query only

Manual operation: See "Information" on page 763

:CALibration<hw>:ALL:TEMP?

Queries the temperature deviation compared to the calibration temperature.

Suffix: 
<hw>

.
[1]
Optional suffix

Return values: 
<Temperature> string

Example: CALibration:ALL:TEMP?
// "+12.00 K"

Usage: Query only

Manual operation: See "Temperature Offset" on page 763

:CALibration<hw>:ALL:TIME?

Queries the time elapsed since the last full adjustment.

Return values: 
<Time> string
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Example: CAL:ALL:TIME?
// "22 days"

Usage: Query only

Manual operation: See "Time" on page 763

:CALibration:DATA:FACTory:DATE?

Queries the date of the last factory calibration.

Return values: 
<Date> string

Example: CAL:DATA:FACT:DATE? 
// "2016-01-01"

Usage: Query only

Manual operation: See "Last Factory Calibration" on page 753

:CALibration<hw>:CONTinueonerror <State>

Continues the calibration even though an error was detected. By default adjustments
are aborted on error.

Suffix: 
<hw>

.
[1]
Optional suffix

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: CAL:CONT ON
// Continues calibration after an error

Manual operation: See "Continue Adjustment on Error" on page 763

14.7  CSYNthesis subsystem

This subsystem contains the commands used to define the frequency settings for the
separate clock source (clock synthesis).

Option: see "Required options" on page 304.
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Example: 
CSYNthesis:OTYPe DSIN
CSYNthesis:FREQuency 10000000
CSYNthesis:POWer -15
CSYNthesis:OFFSet:STATe 1
CSYNthesis:OFFSet 0.1
CSYNthesis:PHASe 180
CSYNthesis:PHASe:REFerence
CSYNthesis:PHASe?
// 0
CSYNthesis:FREQuency:STEP:MODE DEC
CSYNthesis:POWer:STEP:MODE DEC
// CSYNthesis:FREQuency:STEP:MODE USER
// CSYNthesis:FREQuency:STEP 1000
// CSYNthesis:FREQuency UP
// 10001000
// CSYNthesis:POWer:STEP:MODE USER
// CSYNthesis:POWer:STEP:INCRement 0.5
CSYNthesis:STATe 1

:CSYNthesis:STATe........................................................................................................470
:CSYNthesis:OTYPe...................................................................................................... 471
:CSYNthesis:FREQuency............................................................................................... 471
:CSYNthesis:POWer...................................................................................................... 471
:CSYNthesis:OFFSet:STATe............................................................................................472
:CSYNthesis:OFFSet......................................................................................................472
:CSYNthesis:VOLTage....................................................................................................472
:CSYNthesis:PHASe...................................................................................................... 472
:CSYNthesis:PHASe:REFerence..................................................................................... 473
:CSYNthesis:POWer:STEP:MODE.................................................................................. 473
:CSYNthesis:FREQuency:STEP:MODE........................................................................... 473
:CSYNthesis:POWer:STEP[:INCRement]......................................................................... 473
:CSYNthesis:FREQuency:STEP......................................................................................474

:CSYNthesis:STATe <State>

Activates the clock synthesis.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "State" on page 305
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:CSYNthesis:OTYPe <Mode>

Defines the shape of the generated clock signal.

Parameters:
<Mode> SESine | DSQuare | CMOS | DSINe

SESine = single-ended sine
DSINe = differential sine
DSQuare = differential square
CMOS = CMOS
*RST: SESine

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "Output Type" on page 305

:CSYNthesis:FREQuency <Frequency>

Sets the frequency of the generated clock signal.

Parameters:
<Frequency> float

Numerical value
Sets the frequency
UP|DOWN
Varies the frequency step by step.
The frequency is increased or decreased by the value set with
the command :CSYNthesis:FREQuency:STEP.
Range: 100E3  to  1.5E9
Increment: 0.001
*RST: 10E6

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "Frequency" on page 306

:CSYNthesis:POWer <Power>

Sets the power level of the generated clock signal.

Parameters:
<Power> float

Numerical value
Sets the level
UP|DOWN
Varies the level step by step.
The level is increased or decreased by the value set with the
command :CSYNthesis:POWer:STEP[:INCRement].
Range: -24  to  10
Increment: 0.01
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*RST: -20

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "Level" on page 306

:CSYNthesis:OFFSet:STATe <State>

Activates a DC offset.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See " DC Offset State" on page 306

:CSYNthesis:OFFSet <Offset>

Sets the value of the DC offset.

Parameters:
<Offset> float

Range: -5  to  5
Increment: 0.001
*RST: 0

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "DC Offset" on page 307

:CSYNthesis:VOLTage <Voltage>

Sets the voltage for the CMOS signal.

Parameters:
<Voltage> float

Range: 0.8  to  2.7
Increment: 0.001
*RST: 1.8

Example: CSYNthesis:OTYPe CMOS
CSYNthesis:VOLTage 1.8
CSYNthesis:FREQuency 100000000
CSYNthesis:STATe 1

Manual operation: See "Voltage" on page 307

:CSYNthesis:PHASe <Phase>

Shifts the phase of the generated clock signal.
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Parameters:
<Phase> float

Range: -36000  to  36000
Increment: 0.1
*RST: 0

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "Delta Phase" on page 307

:CSYNthesis:PHASe:REFerence

Resets the delta phase value.

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Usage: Event

:CSYNthesis:POWer:STEP:MODE <Mode>
:CSYNthesis:FREQuency:STEP:MODE <Mode>
Defines the type of step size to vary the frequency and level at discrete steps.

Parameters:
<Mode> DECimal | USER

DECimal
Increases or decreases the level in steps of 10.
USER
Increases or decreases the value in increments, set with the
command:
:CSYNthesis:FREQuency:STEP
:CSYNthesis:POWer:STEP[:INCRement]
*RST: DECimal

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "Variation Active" on page 307

:CSYNthesis:POWer:STEP[:INCRement] <Increment>

Sets the step width of the rotary knob and, in user-defined step mode, increases or
decreases the level.

Parameters:
<Increment> float

Range: 0  to  35
Increment: 0.01
*RST: 1

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "Variation Step" on page 307

CSYNthesis subsystem



Remote control commandsR&S®SMA100B

474User Manual 1178.3834.02 ─ 09

:CSYNthesis:FREQuency:STEP <Step>

Sets the step width of the rotary knob and, in user-defined step mode, increases or
decreases the frequency.

Parameters:
<Step> float

Range: 0  to  14999E5
Increment: 0.001
*RST: 1E6

Example: See Chapter 14.7, "CSYNthesis subsystem", on page 469.

Manual operation: See "Variation Step" on page 307

14.8  DIAGnostic subsystem

The DIAGnostic subsystem contains the commands used for instrument diagnosis
and servicing. SCPI does not define any DIAGnostic commands; the commands lis-
ted here are all device-specific. All DIAGnostic commands are query commands
which are not affected by *RST.

The test functions are intended for services purposes.
They are thus password-protected functions. Unlock the corresponding protection level
to access them, see :SYSTem:PROTect<ch>[:STATe]
For more information, see R&S SMA100B Service Manual.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

DIAGnostic<hw> [1] Optional suffix
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Example: Programming example
The example lists the commands required to query assemblies and test points for diag-
nosis purposes.
// Query the modules available in the instrument
// and variant and revision state of a certain assembly
:DIAGnostic1:BGINfo:CATalog?
// FRONT_AF,PSU300,IFB.BV,MB2_AF,...
:DIAGnostic1:BGINfo? "PSU300"
// PSU300 2118.2067.02 01.00 100000

// Query the test points available in the instrument
// and trigger the measurement in a selected test point
:DIAGnostic1:POINt:CATalog?
// ATT6HP_AF_DET_N,ATT6HP_AF_DET_P,ATT6HP_AF_DET_TEMP...
:DIAGnostic1:MEASure:POINt? "ATT6HP_AF_DET_N"
//  0.000000V

// Query the operating hours and number of power-on so far.
:DIAGnostic:INFO:OTIMe?
// 112 h
:DIAGnostic:INFO:POCount? 
// 14

Commands

:DIAGnostic<hw>:BGINfo:CATalog?.................................................................................475
:DIAGnostic<hw>:BGINfo?..............................................................................................475
:DIAGnostic:INFO:OTIMe?..............................................................................................476
:DIAGnostic:INFO:POCount?.......................................................................................... 476
:DIAGnostic<hw>:POINt:CATalog?...................................................................................477
:DIAGnostic<hw>[:MEASure]:POINt?...............................................................................477

:DIAGnostic<hw>:BGINfo:CATalog?

Queries the names of the assemblies available in the instrument.

Return values: 
<Catalog> string

List of all assemblies; the values are separated by commas
The length of the list is variable and depends on the instrument
equipment configuration.

Example: See Example "Programming example" on page 475.

Usage: Query only

:DIAGnostic<hw>:BGINfo? [<Board>]

Queries information on the modules available in the instrument, using the variant and
revision state.
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Query parameters: 
<Board> string

Module name, as queried with the command :
DIAGnostic<hw>:BGINfo:CATalog?.
To retrieve a complete list of all modules, omit the parameter.
The length of the list is variable and depends on the instrument
equipment configuration.

Return values: 
<BgInfo> <Module name> <Module stock number incl. variant> <Module

revision> <Module serial number>
List of comma-separated entries, one entry per module.
Each entry for one module consists of four parts that are separa-
ted by space characters.

Example: See Example "Programming example" on page 475.

Usage: Query only

Manual operation: See "Assembly" on page 753

:DIAGnostic:INFO:OTIMe?

Queries the operating hours of the instrument so far.

Return values: 
<OperationTime> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Programming example" on page 475.

Usage: Query only

Manual operation: See "Operation Time / h" on page 753

:DIAGnostic:INFO:POCount?

Queris how often the instrument has been turned on so far.

Return values: 
<PowerOnCount> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Programming example" on page 475.

Usage: Query only

Manual operation: See "Power On Count" on page 753
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:DIAGnostic<hw>:POINt:CATalog?

Queries the test points available in the instrument.

For more information, see R&S SMA100B Service Manual.

Return values: 
<Catalog> string

List of comma-separated values, each representing a test point

Example: See Example "Programming example" on page 475.

Usage: Query only

:DIAGnostic<hw>[:MEASure]:POINt? <Name>

Triggers the voltage measurement at the specified test point and returns the measured
voltage.

For more information, see R&S SMA100B Service Manual.

Query parameters: 
<Name> <test point identifier>

Test point name, as queried with the command :
DIAGnostic<hw>:POINt:CATalog?

Return values: 
<Value> <value><unit>

Example: See Example "Programming example" on page 475.

Usage: Query only

14.9  DISPlay subsystem

The DISPlay system contains the commands to set the power-save mode of the
instrument.

Programming Examples

Example: Activating screen saver mode and display update
Use the following commands to switch on the screen saver of your instrument or to
automatic display. These settings are particularly useful when you control the instru-
ment remotely.

// Set the wait time interval and activate the screen saver
:DISPlay:PSAVe:HOLDoff 10
:DISPlay:PSAVe:STATe ON

// Disable the display of the current frequency and level values in remote control
:DISPlay:ANNotation:ALL ON
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// :DISPlay:ANNotation:FREQuency ON
// :DISPlay:ANNotation:AMPLitude ON

// Enable automatic update of the display at defined time intervals
:DISPlay:UPDate[:STATe] ON

Example: Querying the dialog IDs, opening and closing dialogs
Use the following commands to query the dialog IDs of all currently open dialogs. The
dialog ID is a prerequisite for opening and closing dialogs via the remote control.

The dialog ID is also required to define user key actions.
See Chapter 12.2.4, "How to assign actions to the [★ (User)] key", on page 353.

// Query the dialog IDs of all open dialogs
:DISPlay:DIALog:ID?
// CEUtraDLGenSetDlg,_,$A DlgKeyRf_Rosc

// Open and close dialogs via remote control
:DISPlay:DIALog:OPEN "CEUtraDLGenSetDlg,_,$A"
:DISPlay:DIALog:OPEN "DlgKeyRf_Rosc"
:DISPlay:DIALog:CLOSe "DlgKeyRf_Rosc"
:DISPlay:DIALog:CLOSe:ALL 

:DISPlay:PSAVe:HOLDoff............................................................................................... 478
:DISPlay:PSAVe[:STATe].................................................................................................479
:DISPlay:BRIGhtness..................................................................................................... 479
:DISPlay:BUTTon:BRIGhtness.........................................................................................479
:DISPlay:UPDate[:STATe]............................................................................................... 479
:DISPlay:ANNotation:AMPLitude..................................................................................... 480
:DISPlay:ANNotation:FREQuency....................................................................................480
:DISPlay:ANNotation[:ALL]..............................................................................................480
:DISPlay:DIALog:ID?......................................................................................................480
:DISPlay:DIALog:OPEN..................................................................................................481
:DISPlay:DIALog:CLOSe................................................................................................ 481
:DISPlay:DIALog:CLOSe:ALL..........................................................................................482

:DISPlay:PSAVe:HOLDoff <HoldoffTimeMin>

Sets the wait time for the screen saver mode of the display.

Parameters:
<HoldoffTimeMin> integer

Range: 1  to  60
*RST: n.a. (factory preset: 10)
Default unit: minute

Example: see Example "Activating screen saver mode and display update"
on page 477

Manual operation: See "Wait Time" on page 344
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:DISPlay:PSAVe[:STATe] <State>

Activates the screen saver mode of the display.

We recommend that you use this mode to protect the display, if you operate the instru-
ment in remote control.

To define the wait time, use the command :DISPlay:PSAVe:HOLDoff.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example "Activating screen saver mode and display
update" on page 477

Manual operation: See "Screen Saver" on page 344

:DISPlay:BRIGhtness <BRIGhtness>

Sets the brightness of the dispaly.

Parameters:
<BRIGhtness> float

Range: 1.0  to  20.0
Increment: 1.0
*RST: 14.0

Example: DISPlay:BRIGhtness 14

Manual operation: See "Display" on page 344

:DISPlay:BUTTon:BRIGhtness <ButtonBrightnes>

Sets the brightness of the [RF on/off] key.

Parameters:
<ButtonBrightnes> integer

Range: 1  to  20
*RST: n.a. (no preset. default: 14)

Example: DISPlay:BUTTon:BRIGhtness 15

Manual operation: See "RF Hardkey" on page 344

:DISPlay:UPDate[:STATe] <Update>

Activates the refresh mode of the display.

Parameters:
<Update> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)
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Example: See Example "Activating screen saver mode and display
update" on page 477

Manual operation: See "Display Update is" on page 345

:DISPlay:ANNotation:AMPLitude <State>

Indicates asterisks instead of the level values in the status bar.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example "Activating screen saver mode and display
update" on page 477

Manual operation: See "Annotation Amplitude" on page 366

:DISPlay:ANNotation:FREQuency <State>

Indicates asterisks instead of the frequency values in the status bar.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example "Activating screen saver mode and display
update" on page 477

Manual operation: See "Annotation Frequency" on page 366

:DISPlay:ANNotation[:ALL] <State>

Displays asterisks instead of the level and frequency values in the status bar of the
instrument.

We recommend that you use this mode if you operate the instrument in remote control.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Activating screen saver mode and display
update" on page 477

:DISPlay:DIALog:ID?

Returns the dialog identifiers of the open dialogs in a string separated by blanks.

Return values: 
<DialogIdList> <DialogID#1>< ><DialogID#2>< > ... < ><DialogID#n>
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Dialog identifiers are string without blanks. Blanks are represen-
ted as $$.
Dialog identifiers <DialogID> are composed of two main parts:
<DialogName>[<OptionalParts>]
<DialogName>
Meaningful information, mandatory input parameter for the com-
mands:
:DISPlay:DIALog:OPEN on page 481
:DISPlay:DIALog:CLOSe on page 481
<Optional parts>
String of $<X> values, where <X> is a character, interpreted as
follows:
$q<DialogQualifier>: optional dialog qualifier, usually the
letter A or B, as displayed in the dialog title.
$i<Instances>: comma-separated list of instance indexes,
given in the order h,c,s,d,g,u,0. Default is zero; the termi-
nating ",0" can be omitted.
$t<TabIds>: comma-separated indexes or tab names;
required, if a dialog is composed of several tabs.
$x<Left>$y<Top>$h<Left>$w<Top>: position and size;
superfluous information.

Example: See Example "Querying the dialog IDs, opening and closing dia-
logs" on page 478

Usage: Query only

Manual operation: See "SCPI" on page 352

:DISPlay:DIALog:OPEN <DialogId>

Opens the specified dialog.

Setting parameters: 
<DialogId> string

To find out the dialog identifier, use the query :DISPlay:
DIALog:ID?.
The <DialogName> part of the query result is mandatory.

Example: See Example "Querying the dialog IDs, opening and closing dia-
logs" on page 478

Usage: Setting only

Manual operation: See "SCPI" on page 352

:DISPlay:DIALog:CLOSe <DialogId>

Closes the specified dialog.
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Setting parameters: 
<DialogId> string

To find out the dialog identifier, use the query :DISPlay:
DIALog:ID?.
The <DialogName> part of the query result is sufficient.

Example: See Example "Querying the dialog IDs, opening and closing dia-
logs" on page 478

Usage: Setting only

:DISPlay:DIALog:CLOSe:ALL

Closes all open dialogs.

Example: See Example "Querying the dialog IDs, opening and closing dia-
logs" on page 478

Usage: Event

14.10  FORMat subsystem

The commands in the FORMat subsystem determine the format of data returned by the
R&S SMA100B to the controller. This affects all query commands that return a list of
numerical data or block data, noted in the descriptions of the commands. The set data
format applies to both paths.

:FORMat:BORDer..........................................................................................................482
:FORMat:SREGister.......................................................................................................483
:FORMat[:DATA]............................................................................................................ 483

:FORMat:BORDer <Border>

Determines the sequence of bytes within a binary block. This only affects blocks which
use the IEEE754 format internally.

Parameters:
<Border> NORMal | SWAPped

NORMal
Expects/sends the least significant byte of each IEEE754 float-
ing-point number first and the most significant byte last.
SWAPped
Expects/sends the most significant byte of each IEEE754 float-
ing-point number first and the least significant byte last.
*RST: NORMal

Example: :FORM:BORD SWAP
transfers the data with the most significant bit first.
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:FORMat:SREGister <Format>

Determines the numeric format for responses of the status register.

Parameters:
<Format> ASCii | BINary | HEXadecimal | OCTal

ASCii
Returns the register content as a decimal number.
BINary|HEXadecimal|OCTal
Returns the register content either as a binary, hexadecimal or
octal number. According to the selected format, the number
starts with #B (binary), #H (hexadecimal) or #O (octal).
*RST: ASCii

Example: :FORM:SREG HEX
returns the register content as a hexadecimal number.

:FORMat[:DATA] <Data>

Determines the data format the instrument uses to return data via the IEC/IEEE bus.

The instrument automatically detects the data format used by the controller, and
assigns it accordingly. Data format determined by this SCPI command is in this case
irrelevant.

Parameters:
<Data> ASCii | PACKed

ASCii
Transfers numerical data as plain text separated by commas.
PACKed
Transfers numerical data as binary block data.
The format within the binary data depends on the command.
The various binary data formats are explained in the description
of the parameter types.
*RST: ASCii

Example: :FORM ASC
transfers the data as ASCII data.

14.11  HCOPy subsystem

The HCOPy subsystem contains the commands to generate and save a hard copy of
the display.

To access a stored hard copy file, use the commands of the MEMM subsystem.
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Example: Store a hard copy of the display
The following example lists commands to configure and execute a hard copy to an
automatic named file.

:HCOPy:DEVice:LANGuage PNG
:HCOPy:FILE:NAME:AUTO:STATe 1
// defines the output format
// sets the instrument to automatically create output file names

// ******************************************************************
// Configure hard copy options, set automatic naming rules
// An automatically generated file name consists of:
// <Prefix><YYYY><MM><DD><Number>.<Format>
// ******************************************************************
:HCOPy:DEVice:LANGuage BMP
// defines output format *.bmp
:HCOPy:REGion DIALog    
// selects the region to be copied
:HCOPy:FILE:AUTO:DIR "/usb/HCopy" 
// sets destination directory of automatic named file
:HCOPy:FILE:NAME:AUTO:FILE:PREFix:STATe 1
:HCOPy:FILE:NAME:AUTO:FILE:PREFix:"hardcopy"
:HCOPy:FILE:NAME:AUTO:FILE:YEAR:STATe 1
:HCOPy:FILE:NAME:AUTO:FILE:MONTh:STATe 1
// uses automatic naming prefix
// sets automatic naming prefix to "hardcopy"
// uses automatic naming date parameters year and month

// ******************************************************************
// Execute and transfer the hard copy
// ******************************************************************
:HCOPy:EXECute
:HCOPy:DATA 
// generates a hard copy
// transfers the hard copy to the remote client
:HCOPy:FILE:AUTO:FILE? 
// queries the automatic file name
// "hardcopy1607001.bmp"  
:HCOPy:FILE:AUTO:NUMBer? 
// queries the number in the automatic file name
// "001"  
:HCOPy:FILE:AUTO? 
// queries the path and file name of the automatically generated file
// "/usb/HCopy/hardcopy1607001.bmp"  

14.11.1  Hard copy settings

With the following commands, you can configure the settings of a hard copy.
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:HCOPy:DATA?..............................................................................................................485
:HCOPy:IMAGe:FORMat................................................................................................ 485
:HCOPy:DEVice:LANGuage............................................................................................485
:HCOPy:REGion............................................................................................................ 485
:HCOPy:FILE[:NAME].....................................................................................................485
:HCOPy[:EXECute]........................................................................................................ 486

:HCOPy:DATA?

Transfers the hard copy data directly as a NByte stream to the remote client.

Return values: 
<Data> block data

Example: See Example "Store a hard copy of the display" on page 484

Usage: Query only

:HCOPy:IMAGe:FORMat <Format>
:HCOPy:DEVice:LANGuage <Language>
Selects the graphic format for the hard copy. You can use both commands alterna-
tively.

Parameters:
<Language> BMP | JPG | XPM | PNG

*RST: PNG

Example: See Example "Store a hard copy of the display" on page 484

Manual operation: See "Format" on page 338

:HCOPy:REGion <Region>

Selects the area to be copied.

You can create a snapshot of the screen or an active dialog.

Parameters:
<Region> ALL | DIALog

*RST: ALL

Example: See Example "Store a hard copy of the display" on page 484

Manual operation: See "Region" on page 338

:HCOPy:FILE[:NAME] <Name>

Determines the file name and path to save the hard copy, provided automatic naming
is disabled.

Note: If you have enabled automatic naming, the instrument automatically generates
the file name and directory, see Chapter 14.11.2, "Automatic naming", on page 486.
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Parameters:
<Name> string

Example: See Example "Store a hard copy of the display" on page 484

Manual operation: See "File..." on page 337

:HCOPy[:EXECute]

Generates a hard copy of the current display. The output destination is a file.

Example: See Example "Store a hard copy of the display" on page 484

Usage: Event

Manual operation: See "Save" on page 338

14.11.2  Automatic naming

Use the following commands to automatically assign a file name.

:HCOPy:FILE[:NAME]:AUTO?.........................................................................................486
:HCOPy:FILE[:NAME]:AUTO:DIRectory........................................................................... 486
:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar................................................................. 487
:HCOPy:FILE[:NAME]:AUTO:FILE?................................................................................. 487
:HCOPy:FILE[:NAME]:AUTO:STATe.................................................................................487
:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe................................................................487
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe...........................................................487
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe............................................................. 487
:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?.................................................................. 488
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix..................................................................... 488
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe........................................................... 488

:HCOPy:FILE[:NAME]:AUTO?

Queries path and file name of the hardcopy file, if you have enabled Automatic Nam-
ing.

Return values: 
<Auto> string

Example: See Example "Store a hard copy of the display" on page 484

Usage: Query only

:HCOPy:FILE[:NAME]:AUTO:DIRectory <Directory>

Determines the path to save the hard copy, if you have enabled Automatic Naming.

If the directory does not yet exist, the instrument automatically creates a new directory,
using the instrument name and /var/user/ by default.
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Parameters:
<Directory> string

*RST: /var/user/

Example: See Example "Store a hard copy of the display" on page 484

Manual operation: See "Path..." on page 339

:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar

Deletes all files with extensions *.bmp, *.jpg, *.png and *.xpm in the directory set
for automatic naming.

Example: See Example "Store a hard copy of the display" on page 484

Usage: Event

Manual operation: See "Clear Path" on page 339

:HCOPy:FILE[:NAME]:AUTO:FILE?

Queries the name of the automatically named hard copy file.

An automatically generated file name consists of:

<Prefix><YYYY><MM><DD><Number>.<Format>.

You can activate each component separately, to individually design the file name.

Return values: 
<File> string

Example: See Example "Store a hard copy of the display" on page 484.

Usage: Query only

:HCOPy:FILE[:NAME]:AUTO:STATe <State>

Activates automatic naming of the hard copy files.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Store a hard copy of the display" on page 484

Manual operation: See "Automatic Naming" on page 338

:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe <State>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe <State>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe <State>
Uses the date parameters (year, month or day) for the automatic naming. You can acti-
vate each of the date parameters separately.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Store a hard copy of the display" on page 484

Manual operation: See "Prefix, Year, Month, Day" on page 339

:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?

Queries the number that is used as part of the file name for the next hard copy in auto-
matic mode.

At the beginning, the count starts at 0. The R&S SMA100B searches the specified out-
put directory for the highest number in the stored files. It increases this number by one
to achieve a unique name for the new file.

The resulting auto number is appended to the resulting file name with at least three
digits.

Return values: 
<Number> integer

Range: 0  to  999999
*RST: 0

Example: See Example "Store a hard copy of the display" on page 484

Usage: Query only

Manual operation: See "Current Auto Number" on page 340

:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix <Prefix>
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe <State>
Uses the prefix for the automatic generation of the file name, provided PREF:STAT is
activated.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Store a hard copy of the display" on page 484

Manual operation: See "Prefix, Year, Month, Day" on page 339

14.12  KBOard subsystem

The KBOard subsystem contains the commands to set a connected keyboard.

:KBOard:LAYout.............................................................................................................489
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:KBOard:LAYout <Layout>

Selects the language for an external keyboard and assigns the keys acccordingly.

Parameters:
<Layout> CHINese | DANish | DUTCh | DUTBe | ENGLish | ENGUK |

FINNish | FRENch | FREBe | FRECa | GERMan | ITALian |
JAPanese | KORean | NORWegian | PORTuguese | RUSSian |
SPANish | SWEDish | ENGUS
*RST: n.a. (factory preset: ENGLish)

Example: :KBOard:LAYout US
// activates American keyboard

Manual operation: See "USB Keyboard > Layout" on page 344

14.13  OUTPut subsystem

In the OUTPut subsystem, you can configure the output signals.

The LF output signal is defined with the commands of the Chapter 14.16.6,
"SOURce:LFOutput subsystem", on page 652 system.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

OUTPut<hw> [1] Optional suffix

:OUTPut:ALL[:STATe]..................................................................................................... 489
:OUTPut<hw>[:STATe]....................................................................................................490
:OUTPut<hw>[:STATe]:PON............................................................................................490
:OUTPut<hw>:AMODe................................................................................................... 490
:OUTPut<hw>:FILTer:MODE........................................................................................... 491
:OUTPut<hw>:IMPedance?.............................................................................................491
:OUTPut:FPRoportional:SCALe.......................................................................................491
:OUTPut:USER:MARKer.................................................................................................492
:OUTPut<hw>:AFIXed:RANGe:LOWer?........................................................................... 492
:OUTPut<hw>:AFIXed:RANGe:UPPer?............................................................................492
:OUTPut<hw>:PROTection:CLEar................................................................................... 492
:OUTPut<hw>:PROTection:TRIPped?.............................................................................. 493

:OUTPut:ALL[:STATe] <State>

Activates the RF output signal of the instrument.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)
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Example: :OUTPut:ALL:STATe 0

:OUTPut<hw>[:STATe] <State>

Activates the RF output signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: :OUTPut1 ON
Activates the RF output.

Manual operation: See "RF State/RF ON" on page 65

:OUTPut<hw>[:STATe]:PON <Pon>

Defines the state of the RF output signal when the instrument is switched on.

Parameters:
<Pon> OFF | UNCHanged

*RST: n.a. (factory preset: UNCHanged)

Example: :OUTPut1:PON OFF
The RF output is deactivated when the instrument is switched
on.

Manual operation: See "Power-On State" on page 345

:OUTPut<hw>:AMODe <AMode>

Sets the step attenuator mode at the RF output.

Parameters:
<AMode> AUTO | FIXed

AUTO
The step attenuator adjusts the level settings automatically,
within the full variation range.
FIXed
The step attenuator and amplifier stages are fixed at the current
position, providing level settings with constant output VSWR.
The resulting variation range is calculated according to the posi-
tion.
*RST: AUTO

Example: :SOURce1:POWer:ALC:STATe 1
:OUTPut1:AMODe FIXed

Manual operation: See "Mode" on page 215
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:OUTPut<hw>:FILTer:MODE <Mode>

Activates low harmonic filter or enables its automatic switching.

Parameters:
<Mode> ON | AUTO | 1

ON|1
Ensures best low harmonics performance but decreases the
level range
AUTO
Applies an automatically selected harmonic filter that fits to the
current level setting.
*RST: AUTO

Example: :OUTPut1:FILTer:MODE AUTO

Manual operation: See "Harmonic Filter" on page 77

:OUTPut<hw>:IMPedance?

Queries the impedance of the RF outputs.

Return values: 
<Impedance> G1K | G50 | G10K

*RST: G50

Example: :OUTPut1:IMP?
queries the impedance of RF output.
Response: 50
the impedance is 50 ohms

Usage: Query only

Manual operation: See "RF output impedance" on page 65

:OUTPut:FPRoportional:SCALe <OutpSelScale>

Selects the mode the voltage is supplied depending on the frequency.

The R&S SMA100B supplies the signal at the V/GHz X-Axis connector.

Parameters:
<OutpSelScale> S0V25 | S0V5 | S1V0 | XAXis

S0V25|S0V5|S1V0
Supplies the voltage proportional to the set frequency, derived
from the selected setting.
XAXis
Supplies a voltage range from 0 V to 10 V proportional to the fre-
quency sweep range, set with[:SOURce<hw>]:FREQuency:
STARt and [:SOURce<hw>]:FREQuency:STOP.
*RST: S0V25
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Options: R&S SMAB-B28

Manual operation: See "V/GHz / X-Axis" on page 198

:OUTPut:USER:MARKer <SelUserMarker>

Selects the signal for output at the Marker User1 connector.

Parameters:
<SelUserMarker> MARK | USER

MARK
Assigns a marker signal to the output.
USER
Intended for future use.
*RST: MARK

Options: R&S SMAB-B28

Manual operation: See "Marker / User" on page 199

:OUTPut<hw>:AFIXed:RANGe:LOWer?
:OUTPut<hw>:AFIXed:RANGe:UPPer?
Queries the settable minimum/maximum value in mode :OUTPut:AMODe FIXed, i.e.
when the attenuator is not being adjusted.

See :OUTPut<hw>:AMODe on page 490

Return values: 
<Upper> float

Increment: 0.01
Default unit: dBm

Example: :OUTPut1:AMODe FIXed
:OUTPut1:AFIXed:RANGe:UPPer?
// -27
:OUTPut1:AFIXed:RANGe:LOW?
// -50

Usage: Query only

Manual operation: See "Level Range" on page 215

:OUTPut<hw>:PROTection:CLEar

Resets the protective circuit after it has been tripped.

To define the output state, use the command :OUTPut<hw>[:STATe].

Example: :OUTPut1:PROT:CLE
Resets the protective circuit of the RF output.

Usage: Event
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Manual operation: See "Overload" on page 216

:OUTPut<hw>:PROTection:TRIPped?

Queries the state of the protective circuit.

Return values: 
<Tripped> 1 | ON | 0 | OFF

*RST: 0

Example: :OUTPut1:PROT:TRIP
queries the state of the protective circuit of the RF output.
Response: 0
the protective circuit has not tripped.

Usage: Query only

Manual operation: See "Overload" on page 216

14.14  Power sensor measurement subsystems

The power sensor measurement uses several subsystems:
● The CALCulate subsystem is used to configure the time gated measurements in

power analysis.
● The DISPlay subsystem is used to configure the diagram appearance.
● The INITiate command switches the local state of the continuous power mea-

surement on and off.
● The READ system is used to start and to retrieve the measurement result of the

power viewer measurement.
● The SENSe subsystem contains the commands for configuring the power viewer

and power analysis measurements with power sensors connected to the generator.
Up to four sensors can be connected to the signal generator.

● The TRACe subsystem is used to configure the traces in power analysis and to
retrieve the measurement results.

Power Viewer

The power viewer measurement is started with the READ command, this command
also retrieves the measurement results.

The sensors are distinguished by the suffix under SENSe:
● Power sensor connected to the SENSOR port = SENSe[1]
● First Power sensor connected to the USB interface = SENSe2
● Second Power sensor connected to the USB interface = SENSe3
● Third Power sensor connected to the USB interface = SENSe4
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Power and Pulse Data Analysis, Gated Measurements (option R&S SMA100B-
K28)

The power analysis measurement commands are subsumed under the
SENSe[:POWer]:SWEep:… commands. Three measurement modes are available:
Frequency, Power and Time.

The power analysis measurement is started with the
SENSe[:POWer]:SWEep:INITiate command and the measurement result retrieved
with the TRACe[:POWer]:SWEep:… commands.

The four sensors are distinguished by the suffix at the second key word SENSe.

The time gate settings are performed using the CALCulate[:POWer]:SWEep:… com-
mands.

The measurement diagram and results can be stored in a hardcopy with the
SENSe[:POWer]:SWEep:HCOPy:… commands.

General parameter and measurement settings are valid for all connected sensors,
therefore, no suffix is used in these commands.

14.14.1  CALCulate subsystem

:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:STATe.............................................494
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:SUBTract........................................ 495
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:XVAL.............................................. 495
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:YVAL.............................................. 495
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:STATe....................................................496
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:SUBTract............................................... 496
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:XVAL..................................................... 497
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:YVAL..................................................... 497
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:AVERage?.................................................497
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:FEED........................................................498
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:MAXimum?................................................498
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STARt....................................................... 499
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STOP........................................................499
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STATe....................................................... 499
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:STATe.......................................................499
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:SUBTract.................................................. 500
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:XVAL........................................................500
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:YVAL........................................................500

:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:STATe <State>

Activates the trace mathematics mode for "Frequency" measurement. This feature
enables you to calculate the difference between the measurement values of two
traces. For further calculation, a math result can also be assigned to a trace.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0
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Example: CALC:POW:SWE:FREQ:MATH2:STATe
Switches on math mode in trace 2.

Options: R&S SMAB-K28

Manual operation: See "Mathematics - Trace Power Analysis" on page 251

:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:SUBTract <Subtract>

Subtracts the operands 1 and 2 and assigns the result to the selected trace in "Fre-
quency" measurement mode.

Parameters:
<Subtract> T1T1 | T1T2 | T1T3 | T1T4 | T1REf | T2T1 | T2T2 | T2T3 | T2T4 |

T2REf | T3T1 | T3T2 | T3T3 | T3T4 | T3REf | T4T1 | T4T2 |
T4T3 | T4T4 | T4REf

Example: CALC:POW:SWE:FREQ:MATH4:SUBT T2REF
Subtracts the Reference and Trace 2, and assigns the result to
Trace 4. The resulting curve is shown in the diagram.

Options: R&S SMAB-K28

Manual operation: See "Mathematics - Trace Power Analysis" on page 251

:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:XVAL <XVal>

Sets the x-axis values for calculating the reference curve in frequency measurement
mode.

To determine two points ("Point A"/"Point B"), set suffix 1 and 2 in keyword MATH<ch>.

Parameters:
<XVal> float

Range: 0  to  1E12
Increment: 1
*RST: 1E12

Example: CALCulate:POWer:SWEep:FREQuency:MATH1:XVAL 8000
CALCulate:POWer:SWEep:FREQuency:MATH2:XVAL
1000000000
Sets the frequency points to calculate the reference curve.

Options: R&S SMAB-K28

Manual operation: See "Freq (X)" on page 253

:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:YVAL <YVal>

Sets the y-axis values for calculating the reference curve in frequency measurement
mode.

To determine two points ("Point A"/"Point B"), set suffix 1 and 2 in keyword MATH<ch>.
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Parameters:
<YVal> float

Range: 200  to  100
Increment: 0.0001
*RST: -40

Example: CALCulate:POWer:SWEep:FREQuency:MATH1:YVAL -20
CALCulate:POWer:SWEep:FREQuency:MATH2:YVAL -20
Sets the power values for the two frequency points to calculate
the reference curve.

Options: R&S SMAB-K28

Manual operation: See "POW (Y)" on page 253

:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:STATe <State>

Activates the trace mathematics mode for "Power" measurement. This feature enables
you to calculate the difference between the measurement values of two traces. For fur-
ther calculation, a math result can also be assigned to a trace.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: CALC:POW:SWE:POW:MATH2:STATe
Switches on math mode in trace 2.

Options: R&S SMAB-K28

Manual operation: See "Mathematics - Trace Power Analysis" on page 251

:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:SUBTract <Subtract>

Subtracts the operands 1 and 2 and assigns the result to the selected trace in "Power"
measurement mode.

Parameters:
<Subtract> T1T1 | T1T2 | T1T3 | T1T4 | T1REf | T2T1 | T2T2 | T2T3 | T2T4 |

T2REf | T3T1 | T3T2 | T3T3 | T3T4 | T3REf | T4T1 | T4T2 |
T4T3 | T4T4 | T4REf

Example: CALC:POW:SWE:POW:MATH4:SUBT T2REF
Subtracts the Reference and Trace 2, and assigns the result to
Trace 4. The resulting curve is shown in the diagram.

Options: R&S SMAB-K28

Manual operation: See "Mathematics - Trace Power Analysis" on page 251
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:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:XVAL <XVal>

Sets the x-axis values for calculating the reference curve in power measurement
mode.

To determine two points ("Point A"/"Point B"), set suffix 1 and 2 in keyword MATH<ch>.

Parameters:
<XVal> float

Range: -145  to  20
Increment: 0.01
*RST: 20

Example: CALCulate:POWer:SWEep:POWer:MATH1:XVAL 8000
CALCulate:POWer:SWEep:POWer:MATH2:XVAL
1000000000
Sets the power points of the x-axis to calculate the reference
curve.

Options: R&S SMAB-K28

Manual operation: See "Pow (X)" on page 253

:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:YVAL <YVal>

Sets the y-axis values for calculating the reference curve in power measurement
mode.

To determine two points ("Point A"/"Point B"), set suffix 1 and 2 in keyword MATH<ch>.

Parameters:
<YVal> float

Range: -200  to  100
Increment: 0.0001
*RST: -40

Example: CALCulate:POWer:SWEep:POWer:MATH1:YVAL 20
CALCulate:POWer:SWEep:POWer:MATH2:YVAL -30
Sets the power values on the y-axis for the two values defined
for the x-axis to calculate the reference curve.

Options: R&S SMAB-K28

Manual operation: See "Pow (Y)" on page 254

:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:AVERage?

Queries the average power value of the time gated measurement.

Return values: 
<Average> float

Range: -1000  to  1000
Increment: 1E-12
*RST: 0
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Example: SENS:SWE:MODE TIME
Activates time mode for power analysis.
CALC:SWE:TIME:GATE:STAT ON
Activates time gated measurement.
SENS:SWE:INIT
Activates a single power analysis measurement.
CALC:SWE:TIME:GATE2:AVER?
Queries the average power in time gate 2 for trace 1 (=default).

Usage: Query only

Options: Option R&S SMAB-K28

Manual operation: See "State - Gate" on page 276

:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:FEED <Feed>

Selects the trace for time gated measurement. Both gates are assigned to the same
trace.

Parameters:
<Feed> TRAC1 | TRAC2 | TRAC3 | TRACe1 | TRACe2 | TRACe3 |

TRAC4 | TRACe4
*RST: TRAC1

Example: CALC:SWE:TIME:GATE:FEED TRAC2
Assigns the gates to trace 2.

Options: Option R&S SMAB-K28

Manual operation: See "Trace - Gate" on page 275

:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:MAXimum?

Queries the average power value of the time gated measurement.

Return values: 
<Maximum> float

Range: -1000  to  1000
Increment: 1E-12
*RST: 0

Example: SENS:SWE:MODE TIME
Activates time mode for power analysis.
CALC:SWE:TIME:GATE:STAT ON
Activates time gated measurement.
SENS:SWE:INIT
Activates a single power analysis measurement.
CALC:SWE:TIME:GATE2:MAX?
Queries the peak power in time gate 2 for trace 1 (=default).

Usage: Query only

Options: Option R&S SMAB-K28
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Manual operation: See "State - Gate" on page 276

:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STARt <Start>
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STOP <Stop>
Sets the start time of the selected gate. Insert value and unit.

Parameters:
<Stop> float

Increment: 1E-12
*RST: Start/Stop: 5/15 (Gate1), 25/35 (Gate2)

Example: CALC:SWE:TIME:GATE2:STAR 20us
Sets a start time of 20 us for gate 2.
CALC:SWE:TIME:GATE2:STOP 30us
Sets a stop time of 30us for gate 2.

Options: Option R&S SMAB-K28

Manual operation: See "Start / Stop - Gate" on page 276

:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STATe <State>

Activates the gate settings for the selected trace. The measurement is started with
command SENS:POW:INIT. Both gates are active at one time.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: CALC:SWE:TIME:GATE:STAT ON
Enables time gated measurement.

Options: Option R&S SMAB-K28

Manual operation: See "State - Gate" on page 276

:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:STATe <State>

Activates the trace mathematics mode for "Time" measurement. This feature enables
you to calculate the difference between the measurement values of two traces. For fur-
ther calculation, a math result can also be assigned to a trace.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: CALC:POW:SWE:TIME:MATH1:STATe
Switches on math mode.

Options: R&S SMAB-K28

Manual operation: See "Mathematics - Trace Power Analysis" on page 251
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:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:SUBTract <Subtract>

Subtracts the operands 1 and 2 and assigns the result to the selected trace in "Time"
measurement mode.

Parameters:
<Subtract> T1T1 | T1T2 | T1T3 | T1T4 | T1REf | T2T1 | T2T2 | T2T3 | T2T4 |

T2REf | T3T1 | T3T2 | T3T3 | T3T4 | T3REf | T4T1 | T4T2 |
T4T3 | T4T4 | T4REf

Example: CALC:POW:SWE:TIME:MATH4:SUBT T2REF
Subtracts the Reference and Trace 2, and assigns the result to
Trace 4. The resulting curve is shown in the diagram.

Options: R&S SMAB-K28

Manual operation: See "Mathematics - Trace Power Analysis" on page 251

:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:XVAL <XVal>

Sets the x-axis values for calculating the reference curve in time measurement mode.

To determine two points ("Point A"/"Point B"), set suffix 1 and 2 in keyword MATH<ch>.

Parameters:
<XVal> float

Range: 0  to  2
Increment: 1E-12
*RST: -5E-6

Example: CALCulate:POWer:SWEep:TIME:MATH1:XVAL -0.000005
CALCulate:POWer:SWEep:TIME:MATH2:XVAL 0.000045
Sets the time points to calculate the reference curve.

Options: R&S SMAB-K28

Manual operation: See "Time (X)" on page 254

:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:YVAL <YVal>

Sets the y-axis values for calculating the reference curve in time measurement mode.

To determine two points ("Point A"/"Point B"), set suffix 1 and 2 in keyword MATH<ch>.

Parameters:
<YVal> float

Range: -200  to  100
Increment: 0.0001
*RST: -40

Example: CALCulate:POWer:SWEep:TIME:MATH1:YVAL 20
CALCulate:POWer:SWEep:TIMF:MATH2:YVAL -30
Sets the power values for the two time points to calculate the
reference curve.
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Options: R&S SMAB-K28

Manual operation: See "Pow (Y)" on page 254

14.14.2  DISPlay subsystem

:DISPlay[:WINDow][:POWer]:SWEep:BACKground:COLor.................................................501
:DISPlay[:WINDow][:POWer]:SWEep:GRID:STATe............................................................501

:DISPlay[:WINDow][:POWer]:SWEep:BACKground:COLor <Color>

Defines the background color of the measurement diagram. The selected color applies
also to the hardcopy of the diagram.

Parameters:
<Color> BLACk | WHITe

*RST: BLACk

Example: DISP:SWE:BACK:COL WHIT
The measurement is indicated with a white background.

Manual operation: See "Background Color - Power Analysis" on page 264

:DISPlay[:WINDow][:POWer]:SWEep:GRID:STATe <State>

Indicates a grid in the diagram.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: DISP:SWE:GRID:STAT OFF
Deactivates the indication of a grid in the diagram area.

Manual operation: See "Show Grid - Power Analysis" on page 264

14.14.3  INITiate command

:INITiate<hw>[:POWer]:CONTinuous <Continuous>

Switches the local state of the continuous power measurement by R&S NRP power
sensors on and off. Switching off local state enhances the measurement performance
during remote control.

The remote measurement is triggered with :READ<ch>[:POWer]?). This command
also returns the measurement results. The local state is not affected, measurement
results can be retrieved with local state on or off.

Parameters:
<Continuous> 0 | 1 | OFF | ON

*RST: 0
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Example: :INIT1:CONT ON
Switches local state of continuous power measurement on.

Manual operation: See "State" on page 241

14.14.4  SENSe SWEep subsystem

 

:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:OFFSet........................................... 504
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:OFFSet:STATe................................. 504
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge:STARt................................504
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge:STOP................................ 505
:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge[:STATe].............................. 505
:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:OFFSet.................................................. 506
:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:OFFSet:STATe........................................ 506
:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:SFRequency...........................................506
:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:SFRequency:STATe.................................507
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet..................................................... 507
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet:STATe...........................................507
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:STATe............................................ 508
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:BASE............................508
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:HREFerence...... 508
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:LREFerence.......509
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:REFerence........ 509
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:SFRequency..............................................509
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:SFRequency:STATe....................................510
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:AUTO.......................................... 510
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:DTIMe......................................... 510
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:HYSTeresis.................................. 510
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:LEVel...........................................511
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:SLOPe.........................................511
:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:SOURce.......................................511
:SENSe<ch>[:POWer]:ZERO.......................................................................................... 512
:SENSe[:POWer]:SWEep:ABORt.....................................................................................512
:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:COPY.........................................512
:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:POINts?......................................512
:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:XVALues.....................................513
:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:YVALues.....................................513
:SENSe[:POWer]:SWEep:FREQuency:RMODe................................................................ 513
:SENSe[:POWer]:SWEep:FREQuency:SPACing[:MODE]...................................................513
:SENSe[:POWer]:SWEep:FREQuency:STARt...................................................................514
:SENSe[:POWer]:SWEep:FREQuency:STEPs.................................................................. 514
:SENSe[:POWer]:SWEep:FREQuency:STOP................................................................... 514
:SENSe[:POWer]:SWEep:FREQuency:TIMing[:MODE]......................................................514
:SENSe[:POWer]:SWEep:FREQuency:YSCale:AUTO....................................................... 515
:SENSe[:POWer]:SWEep:FREQuency:YSCale:AUTO:RESet............................................. 515
:SENSe[:POWer]:SWEep:FREQuency:YSCale:MAXimum................................................. 516
:SENSe[:POWer]:SWEep:FREQuency:YSCale:MINimum.................................................. 516
:SENSe[:POWer]:SWEep:HCOPy:DATA?.........................................................................516
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:SENSe[:POWer]:SWEep:HCOPy:DEVice........................................................................ 517
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage....................................................... 518
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:DPOint.................................... 518
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:HEADer...................................518
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:ORIentation..............................519
:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV[:COLumn]:SEParator................ 519
:SENSe[:POWer]:SWEep:HCOPy:DEVice:SIZE................................................................519
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]................................................................520
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:DIRectory.......................................520
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar.............................520
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:FILE?.............................................521
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:STATe............................................521
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY?................................... 521
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe........................... 522
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh?.............................. 522
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe...................... 522
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?............................. 523
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix.................................523
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe.......................523
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR?................................. 523
:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe.........................524
:SENSe[:POWer]:SWEep:HCOPy[:EXECute]....................................................................524
:SENSe[:POWer]:SWEep:INITiate................................................................................... 524
:SENSe[:POWer]:SWEep:MODE.....................................................................................524
:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:COPY................................................525
:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:POINts?.............................................525
:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:XVALues............................................525
:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:YVALues............................................525
:SENSe[:POWer]:SWEep:POWer:RMODe........................................................................526
:SENSe[:POWer]:SWEep:POWer:SPACing[:MODE]..........................................................526
:SENSe[:POWer]:SWEep:POWer:STARt..........................................................................526
:SENSe[:POWer]:SWEep:POWer:STEPs......................................................................... 526
:SENSe[:POWer]:SWEep:POWer:STOP.......................................................................... 527
:SENSe[:POWer]:SWEep:POWer:TIMing[:MODE].............................................................527
:SENSe[:POWer]:SWEep:POWer:YSCale:AUTO.............................................................. 527
:SENSe[:POWer]:SWEep:POWer:YSCale:AUTO:RESet.................................................... 528
:SENSe[:POWer]:SWEep:POWer:YSCale:MAXimum........................................................ 528
:SENSe[:POWer]:SWEep:POWer:YSCale:MINimum......................................................... 529
:SENSe[:POWer]:SWEep:RMODe...................................................................................529
:SENSe[:POWer]:SWEep:TIME:AVERage[:COUNt]...........................................................529
:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:COPY...................................................530
:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:POINts?............................................... 530
:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:XVALues.............................................. 530
:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:YVALues.............................................. 530
:SENSe[:POWer]:SWEep:TIME:RMODe.......................................................................... 531
:SENSe[:POWer]:SWEep:TIME:SPACing[:MODE].............................................................531
:SENSe[:POWer]:SWEep:TIME:STARt.............................................................................531
:SENSe[:POWer]:SWEep:TIME:STEPs............................................................................531
:SENSe[:POWer]:SWEep:TIME:STOP............................................................................. 532
:SENSe[:POWer]:SWEep:TIME:TEVents..........................................................................532
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:SENSe[:POWer]:SWEep:TIME:YSCale:AUTO................................................................. 532
:SENSe[:POWer]:SWEep:TIME:YSCale:AUTO:RESet.......................................................533
:SENSe[:POWer]:SWEep:TIME:YSCale:MAXimum........................................................... 533
:SENSe[:POWer]:SWEep:TIME:YSCale:MINimum............................................................ 534

:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:OFFSet <Offset>

Defines the level offset at the sensor input in dB. Activate the offset with the com-
mand :SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:OFFSet:STATe
on page 504.

Parameters:
<Offset> float

Range: -100  to  100
Increment: 0.01
*RST: 0

Example: SENS2:SWE:FREQ:OFFS -3dB
Defines a level offset of -3 dB.
SENS2:SWE:FREQ:OFFS:STAT ON
Activates the specified level offset.

Options: Option R&S SMAB-K28

Manual operation: See "Level Offset - Power Analysis" on page 261

:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:OFFSet:STATe <State>

Activates a level offset at the sensor input. Define the appropriate value with the com-
mand :SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:OFFSet
on page 504.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SENS2:SWE:FREQ:OFFS:STAT ON
Activates the specified level offset.

Options: Option R&S SMAB-K28

Manual operation: See "Level Offset State- Power Analysis" on page 261

:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge:STARt <Start>

Sets the start frequency for the frequency power analysis with separate frequencies.

Parameters:
<Start> integer

Range: 0  to  1E12
*RST: 1E6
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Example: SENS2:SWE:FREQ:SENS:SRAN:STAT ON
Activates use of a separate frequency range for frequency ver-
sus power measurement for sensor 2.
SENS2:SWE:FREQ:SENS:STAR 2.0GHZ
Sets a sweep start at 2 GHz irrespective of the current signal
generator frequency settings.

Manual operation: See "Min Frequency - Power Analysis" on page 262

:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge:STOP <Stop>

Sets the stop frequency for the frequency power analysis with separate frequencies.

Parameters:
<Stop> integer

Range: 0  to  1E12
*RST: 10E6

Example: SENS:SWE:FREQ:SENS2:SRAN:STAT ON
Activates use of a separate frequency range for frequency ver-
sus power measurement.
SENS:SWE:FREQ:SENS2:STAR 2.0GHZ
Sets a sweep start at 2 GHz irrespective of the current signal
generator frequency settings.
SENS:SWE:FREQ:SENS2:STOP 2.9GHZ
Sets a sweep stop at 2.9 GHz irrespective of the current signal
generator frequency settings.

Manual operation: See "Max Frequency - Power Analysis" on page 262

:SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge[:STATe] <State>

Activates the use of a frequency range for the power measurement that is different to
the set signal generator frequency range. The separate frequency range is entered
with commands :SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:SRANge:
STARt on page 504 and :SENSe<ch>[:POWer]:SWEep:FREQuency[:SENSor]:
SRANge:STOP on page 505.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SENS2:SWE:FREQ:SENS:SRAN ON
Activates use of a separate frequency range for frequency ver-
sus power measurement for sensor 2.
SENS2:SWE:FREQ:SENS:STAR 2.0GHZ
Sets a sweep start at 2 GHz irrespective of the current signal
generator frequency settings.
SENS2:SWE:FREQ:SENS:STOP 2.9GHZ
Sets a sweep stop at 2.9 GHz irrespective of the current signal
generator frequency settings.

Power sensor measurement subsystems



Remote control commandsR&S®SMA100B

506User Manual 1178.3834.02 ─ 09

Manual operation: See "Use Separate Frequency- Power Analysis" on page 261

:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:OFFSet <Offset>

Defines the level offset at the sensor input in dB. Activate the offset with the com-
mand :SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:OFFSet:STATe
on page 506.

Parameters:
<Offset> float

Range: -100  to  100
Increment: 0.01
*RST: 0

Example: SENS2:SWE:POW:OFFS -5dB
Defines a level offset of -5 dB.
SENS2:SWE:POW:OFFS:STAT ON
Activates that the specified level offset is considered.

Options: Option R&S SMAB-K28

Manual operation: See "Level Offset - Power Analysis" on page 261

:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:OFFSet:STATe <State>

Activates a level offset at the sensor input. Define the appropriate value with the com-
mand :SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:OFFSet on page 506.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SENS2:SWE:POW:OFFS:STAT ON
Activates the specified level offset.

Options: Option R&S SMAB-K28

:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:SFRequency <SFRequency>

Defines the separate frequency used for power vs. power measurement.

Parameters:
<SFRequency> float

Range: 0  to  1E12
Increment: 1
*RST: 1E6

Example: SENS1:SWE:POW:SENS:SFR 2GHz
The measurement is performed at 2 GHz

Manual operation: See "Use Separate Frequency- Power Analysis" on page 261
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:SENSe<ch>[:POWer]:SWEep:POWer[:SENSor]:SFRequency:STATe <State>

Activates the use of a different frequency for the power measurement.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SENS1:SWE:POW:SENS:SFR:STAT ON
Activates the use of a separate frequency than the generator fre-
quency for power analysis

Manual operation: See "Use Separate Frequency- Power Analysis" on page 261

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet <Offset>

Defines the level offset at the sensor input in dB. Activate the offset with the com-
mand :SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet:STATe
on page 507.

Parameters:
<Offset> float

Range: -100  to  100
Increment: 0.01
*RST: 0

Example: SENS2:SWE:TIME:OFFS -7dB
Defines a level offset of -7 dB.
SENS2:SWE:TIME:OFFS:STAT ON
The specified level offset is considered.

Options: Option R&S SMAB-K28

Manual operation: See "Level Offset - Power Analysis" on page 261

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet:STATe <State>

Activates a level offset at the sensor input. Define the appropriate value with the com-
mand :SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:OFFSet on page 507.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SENS2:SWE:POW:TIME:STAT ON
Activates the specified level offset.

Options: Option R&S SMAB-K28

Manual operation: See "Level Offset State- Power Analysis" on page 261
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:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:STATe <State>

Enables pulse data analysis. The measurement is started with command INITiate.

Note: The command is only available in time measurement mode and with R&S NRP-
Z81 power sensors.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SENS1:SWE:TIM:PULS:STAT ON
Enables pulse data analysis.

Options: Option R&S SMAB-K28

Manual operation: See "Pulse Analysis" on page 266

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:BASE <Base>

Selects how the threshold parameters for pulse analysis are calculated.

Note: The command is only available in time measurement mode and with R&S
NRPZ81 power sensors.

Parameters:
<Base> VOLTage | POWer

*RST: VOLTage

Example: SENS1:SWE:TIME:PULS:THR:BASE POW
Activates threshold calculation related to power.

Options: Option R&S SMAB-K28

Manual operation: See "Base" on page 266

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:
HREFerence <HReference>

Sets the upper reference level in terms of percentage of the overall pulse level (power
or voltage). The distal power defines the end of the rising edge and the start of the fall-
ing edge of the pulse.

Note: The command is only available in time measurement mode and with R&S
NRPZ81 power sensors.

Parameters:
<HReference> float

Range: 0  to  100
Increment: 0.01
*RST: 90

Options: Option R&S SMAB-K28

Manual operation: See "Distal" on page 266
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:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:
LREFerence <LReference>

Sets the lower reference level in terms of percentage of the overall pulse level. The
proximal power defines the start of the rising edge and the end of the falling edge of
the pulse.

Note: This parameter is only available in time measurement mode and R&S NRP-Z81
power sensors.

Parameters:
<LReference> float

Range: 0.0  to  100.0
Increment: 0.01
*RST: 10.0

Example: SENS:SWE:TIM:PULS:THR:LREF 10
Sets the lower reference level to 10%.

Options: Option R&S SMAB-K28

Manual operation: See "Proximal" on page 267

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:PULSe:THReshold:POWer:
REFerence <Reference>

Sets the medial reference level in terms of percentage of the overall pulse level (power
or voltage related). This level is used to define pulse width and pulse period.

Note: The command is only available in time measurement mode and with R&S
NRPZ81 power sensors.

Parameters:
<Reference> float

Range: 0.0  to  100.0
Increment: 0.01
*RST: 50.0

Example: SENS1:SWE:TIM:PULS:THR:REF 40
Sets the medial reference level to 40% of the overall pulse level.

Options: Option R&S SMAB-K28

Manual operation: See "Mesial" on page 267

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:SFRequency <SFrequency>

Defines the separate frequency used for power vs. time measurement.

Parameters:
<SFrequency> float

Range: 0  to  1E12
Increment: 1
*RST: 1E6

Power sensor measurement subsystems



Remote control commandsR&S®SMA100B

510User Manual 1178.3834.02 ─ 09

Example: SENS1:SWE:TIME:SENS:SFR 2GHz
The measurement is performed at 2 GHz

Manual operation: See "Use Separate Frequency- Power Analysis" on page 261

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:SFRequency:STATe <State>

Activates the use of a different frequency for the power measurement.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: SENS1:SWE:TIME:SENS:SFR:STAT ON
Activates the use of a separate frequency than the generator fre-
quency for power analysis

Manual operation: See "Use Separate Frequency- Power Analysis" on page 261

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:AUTO <Auto>

Sets the trigger level, the hysteresis and the dropout time to default values.

Parameters:
<Auto> ONCE

*RST: ---

Example: SENS1:SWE:TIME:SENS:TRIG:AUTO ONCE
The trigger level is automatically determined

Manual operation: See "Auto Set - Power Analysis" on page 274

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:DTIMe <DTime>

Determines the minimum time for which the signal must be below (above) the power
level defined by level and hysteresis before triggering can occur again.

Parameters:
<DTime> float

Range: 0  to  10
*RST: 200E-9

Example: SENS1:SWE:TIME:SENS:TRIG:DTIM 10 us
The drop out time is 10 us

Manual operation: See "Drop out Time - Power Analysis" on page 273

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:HYSTeresis <Hysteresis>

Sets the hysteresis of the internal trigger threshold. Hysteresis is the magnitude (in dB)
the trigger signal level must drop below the trigger threshold (positive trigger slope)
before triggering can occur again.
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Parameters:
<Hysteresis> float

Range: 0  to  10
Increment: 0.001
*RST: 0.5

Example: SENS1:SWE:TIME:SENS:TRIG:HYST 0.5 dB
The hysteresis is 0.5 dB

Manual operation: See "Hysteresis - Power Analysis" on page 273

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:LEVel <Level>

Sets the trigger threshold.

Parameters:
<Level> float

Range: -200  to  100
Increment: 0.001
*RST: 1

Example: SENS1:SWE:TIME:SENS:TRIG:LEV -20 dBm
Sets the trigger level to -20 dBm.

Manual operation: See "Level - Power Analysis " on page 273

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:SLOPe <TriggerSlope>

Sets the polarity of the active slope for the trigger signals.

Parameters:
<TriggerSlope> POSitive | NEGative

*RST: POSitive

Example: SENS1:SWE:TIME:TRIG:SLOP POS
The positive edge of a trigger signal is active.

Options: Option R&S SMAB-K28

Manual operation: See "Slope - Power Analysis" on page 273

:SENSe<ch>[:POWer]:SWEep:TIME[:SENSor]:TRIGger:SOURce <Source>

Selects if the measurement is free running (FREE) or starts only after a trigger event.
The trigger can be applied internally or externally.

Parameters:
<Source> FREE | AUTO | INTernal | EXTernal

*RST: AUTO

Example: SENS1:SWE:TIME:SENS:TRIG:SOUR FREE
The power versus time measurement is performed free running
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Manual operation: See "Mode - Power Analysis" on page 272

:SENSe<ch>[:POWer]:ZERO

The command activates the autozero function. Zeroing is required in regular interval (at
least once a day) and if the temperature has varied more than about 5 °C, if the sensor
has been replaced or if measurements of signals with very low power are to be per-
formed. The RF power source must be switched off or disconnected from the sensor
before starting the autozero function.

Example: SENS:ZERO
activates autozero function.

Usage: Event

:SENSe[:POWer]:SWEep:ABORt

Aborts the power analysis with NRP power sensors.

Example: SENS:SWE:ABOR;*OPC?
Aborts the current power measurement.

Usage: Setting only

:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:COPY

Generates a reference curve for "Frequency" measurement.

Example: SENS:POW:SWE:FREQ:REF:DATA:COPY
Generates a reference curve in frequency mode.

Usage: Event

Manual operation: See "Save To Ref" on page 254

:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:POINts?

Queries the number of points from the reference curve in "Frequency" measurement.

Return values: 
<Points> integer

Range: 10  to  1000

Example: SENS:POW:SWE:FREQ:REF:DATA:POIN?
Queries the number of points from the reference curve in fre-
quency mode.

Usage: Query only
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:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:XVALues <XValues>

Sets the x values of the two reference points, i.e. "Frequency X (Point A)" and "Fre-
quency X (Point B)" in "Frequency" measurement.

Parameters:
<XValues> string

Example: SENSe:POW:SWE:FREQ:REF:DATA:XVAL 100MHZ,22GHZ
Sets the x value of reference "Point A" to 10 MHz, and the value
of "Point B" to 10 GHz.

Manual operation: See "Freq (X)" on page 253

:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:YVALues <YValues>

Sets or queries the y values of the two reference points, i.e."Pow Y (Point A)" and
"Power Y (Point B)" in "Frequency" measurement.

Parameters:
<YValues> string

Example: SENSe:POW:SWE:FREQ:REF:DATA:YVAL -10,25
Sets the y value of reference "Point A" to -10 dBm, and the
value of "Point B" to -25 dBm.

Manual operation: See "POW (Y)" on page 253

:SENSe[:POWer]:SWEep:FREQuency:RMODe <RMode>

Selects single or continuous mode for measurement mode frequency in power analy-
sis.

Parameters:
<RMode> SINGle | CONTinuous

*RST: CONTinuous

Example: SENS:SWE:FREQ:RMOD SING
Selects single measurement

Manual operation: See "Execution - Power Analysis" on page 258

:SENSe[:POWer]:SWEep:FREQuency:SPACing[:MODE] <Mode>

Selects the spacing for the frequency power analysis.

Parameters:
<Mode> LINear | LOGarithmic

*RST: LINear

Example: SENS:SWE:FREQ:SPAC:MODE LIN
Sets linear spacing of the sweep

Manual operation: See "Spacing - Power Analysis" on page 258
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:SENSe[:POWer]:SWEep:FREQuency:STARt <Start>

Sets the start frequency for the frequency mode.

Parameters:
<Start> float

Range: 0  to  1E12
*RST: 1E6

Example: SENS:SWE:FREQ:STAR 2.0GHZ
Sets a sweep start at 2 GHz.

Manual operation: See "Min - Power Analysis" on page 256

:SENSe[:POWer]:SWEep:FREQuency:STEPs <Steps>

Sets the number of measurement steps for the frequency mode.

Parameters:
<Steps> integer

Range: 10  to  1000
*RST: 200

Example: SENS:SWE:FREQ:STEP 500
Sets 500 steps

Manual operation: See "Steps - Power Analysis" on page 257

:SENSe[:POWer]:SWEep:FREQuency:STOP <Stop>

Sets the stop frequency for the frequency mode.

Parameters:
<Stop> float

Range: 0  to  1E12
*RST: 22GHZ

Example: SENS:SWE:FREQ:STOP 20.0GHZ
Sets the sweep stop to 20 GHz

Manual operation: See "Max - Power Analysis" on page 257

:SENSe[:POWer]:SWEep:FREQuency:TIMing[:MODE] <Mode>

Selects the mode in terms of speed and precision of the response of a measurement.

Parameters:
<Mode> FAST | NORMal | HPRecision | FAST | NORMal

FAST
Selection FAST leads to a fast measurement with a short inte-
gration time for each measurement step.
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NORMal
NORMal leads to a longer but more precise measurement due
to a higher integration time for each step.
*RST: FAST

Example: SENS:SWE:FREQ:TIM:MODE FAST
The fast measurement mode is selected.

Manual operation: See "Timing - Power Analysis" on page 257

:SENSe[:POWer]:SWEep:FREQuency:YSCale:AUTO <Auto>

Activates autoscaling of the Y axis of the diagram.

Parameters:
<Auto> OFF | CEXPanding | FEXPanding | CFLoating | FFLoating

OFF
Auto scaling is deactivated. If switching from activated to deacti-
vated Auto scaling, the scaling is maintained.
CEXPanding | FEXPanding
Auto scale is activated. The scaling of the Y-axis is selected in
such a way, that the trace is always visible. To this end, the
range is expanded if the minimum or maximum values of the
trace move outside the current scale. The step width is 5 dB for
selection course and variable in the range of 0.2 db to 5 dB for
selection fine.
CFLoating | FFLoating
Auto scale is activated. The scaling of the Y-axis is selected in
such a way, that the trace is always visible. To this end, the
range is either expanded if the minimum or maximum values of
the trace move outside the current scale or scaled down if the
trace fits into a reduced scale. The step width is 5 dB for selec-
tion course and variable in the range of 0.2 db to 5 dB for selec-
tion fine.
*RST: CEXPanding

Example: SENS:SWE:FREQ:YSC:AUTO OFF
Deactivates auto scale

Manual operation: See "Auto Scale - Power Analysis" on page 263

:SENSe[:POWer]:SWEep:FREQuency:YSCale:AUTO:RESet

Resets the Y scale to suitable values after the use of auto scaling in the expanding
mode. For this mode, the scale might get expanded because of temporarily high-power
values. The reset function resets the diagram in such a way that it matches smaller
power values again.

Example: SENS:SWE:FREQ:YSC:AUTO:RES
Resets auto scale
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Usage: Event

Manual operation: See "Reset Auto Scale - Power Analysis" on page 264

:SENSe[:POWer]:SWEep:FREQuency:YSCale:MAXimum <Maximum>

Sets the maximum value for the y axis of the measurement diagram.

Parameters:
<Maximum> float

Range: -200  to  100
Increment: 0.01
*RST: 40

Example: SENS:SWE:FREQ:YSC:MAX 10DBM
Sets 10 dBm as the upper limit of the measurement diagram.

Manual operation: See "Min - Max Level - Power Analysis" on page 263

:SENSe[:POWer]:SWEep:FREQuency:YSCale:MINimum <Minimum>

Sets the minimum value for the y axis of the measurement diagram.

Parameters:
<Minimum> float

Range: -200  to  100
Increment: 0.01
*RST: -40

Example: SENS:SWE:FREQ:YSC:MIN -10DB
Sets -10 dBm as the lower limit of the measurement diagram.

Manual operation: See "Min - Max Level - Power Analysis" on page 263

:SENSe[:POWer]:SWEep:HCOPy:DATA?

Queries the measurement data directly. The data is transferred to the remote client as
data stream.

Readable ASCII data is available for hardcopy language CSV. The representation of
the values depends on the selected orientation for the CSV format.

Return values: 
<Data> block data
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Example: SENS:SWE:HCOP:DEV:LANG CSV
selects output format *.csv.
SENS:SWE:HCOP:DEV:LANG:CSV:ORI HOR
selects horizontal orientation
SENS:SWE:HCOP:DEV:LANG:CSV:SEP SEM
selects ";" as the separator between the values
SENS:SWE:HCOP:DEV:LANG:CSV:DPO DOT
selects "." as decimal point
SENS:SWE:HCOP:DATA?
queries the measurement data of the current traces
Response:
#2651009500000;1019000000;1028500000;1038000000
-9.5;-9.7;-6.3;-2.5
The hash symbol # introduces the data block. The next number
indicates how many of the following digits describe the length of
the data block. In the example, the 2 following digit indicates the
length to be 65 characters.
Because horizontal representation is selected, a row with all the
x-values of the active trace (frequency) follows. The second row
contains all the y-values of the active trace (power). The rows
end with a new line (each counts as one character).
Note: if more than one trace is active, the third row contains the
x values of the second active trace, and so on.

Example: SENS:SWE:HCOP:DEV:LANG:CSV:ORI VERT
selects horizontal orientation
SENS:SWE:HCOP:DATA?
queries the measurement data of the current traces
Response:
#2681009500000;-9.5; 1019000000;-9.7; 1028500000;-6.3;
1038000000;-2.5;
for vertical representation the length of the data block is 68
the first power value, the second row contains the second fre-
quency value of the active trace followed by the second power
value, and so on. The rows end with a new line (each counts as
one character).
Note: if more than one trace is active, the first row also contains
the value pairs of the second active trace, and so on.

Usage: Query only

:SENSe[:POWer]:SWEep:HCOPy:DEVice <Device>

Defines the output device. The setting is fixed to FILE, i.e. the hardcopy is stored in a
file.

Parameters:
<Device> FILE | PRINter

*RST: FILE

Power sensor measurement subsystems



Remote control commandsR&S®SMA100B

518User Manual 1178.3834.02 ─ 09

Example: SENS:SWE:HCOP:DEV FIL
Selects output device file.

:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage <Language>

Selects the bitmap graphic format for the screenshot of the power analysis trace.

In addition, ASCII file format *.csv is offered. If file format *.csv is selected, the
trace data is saved as an ASCII file with comma separated values. It is also possible to
directly retrieve the data using command :SENSe[:POWer]:SWEep:HCOPy:DATA?
on page 516

Parameters:
<Language> BMP | JPG | XPM | PNG | CSV

*RST: BMP

Example: SENS:SWE:HCOP:DEV:LANG BMP
Selects output format *.bmp.

Manual operation: See "Format - Power Analysis" on page 281

:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:DPOint <DPoint>

Defines which character is used as the decimal point of the values, either dot or
comma.

Parameters:
<DPoint> DOT | COMMa

*RST: DOT

Example: SENS:SWE:HCOP:DEV:LANG CSV
Selects output format *.csv.
SENS:SWE:HCOP:DEV:LANG:CSV:DPO DOT
Selects character dot for being used as decimal point.

Manual operation: See "Decimal Point" on page 285

:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:HEADer <Header>

Defines whether each row (or column depending on the orientation) should be prece-
ded by a header containing information about the trace (see also :SENSe[:POWer]:
SWEep:HCOPy:DATA? on page 516).

Parameters:
<Header> OFF | STANdard

*RST: OFF

Example: SENS:SWE:HCOP:DEV:LANG CSV
Selects output format *.csv.
SENS:SWE:HCOP:DEV:LANG:CSV:HEAD STAN
Selects the standard header for the *.csv file.
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Manual operation: See "Row Header" on page 285

:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV:ORIentation
<Orientation>

Defines the orientation of the X/Y value pairs.

Parameters:
<Orientation> HORizontal | VERTical

*RST: VERTical

Example: SENS:SWE:HCOP:DEV:LANG CSV
Selects output format *.csv.
SENS:SWE:HCOP:DEV:LANG:CSV:ORI VERT
Selects vertical orientation, the value pairs are written in a col-
umn like structure (separated by the selected separator, e.g. tab)

Manual operation: See "Orientation" on page 284

:SENSe[:POWer]:SWEep:HCOPy:DEVice:LANGuage:CSV[:COLumn]:SEParator
<Separator>

Defines which character is to separate the values, either tabulator, semicolon, comma
or blank.

Parameters:
<Separator> TABulator | SEMicolon | COMMa | BLANk

*RST: COMMa

Example: SENS:SWE:HCOP:DEV:LANG CSV
Selects output format *.csv.
SENS:SWE:HCOP:DEV:LANG:CSV:SEP TAB
A tab separates the values.

Manual operation: See "Separator" on page 285

:SENSe[:POWer]:SWEep:HCOPy:DEVice:SIZE <Size>

Sets the size of the hardcopy in number of pixels. The first value of the size setting
defines the width, the second value the height of the image.

Parameters:
<Size> 320,240 | 640,480 | 800,600 | 1024,768

*RST: 320,240

Example: SENS:SWE:HCOP:DEV:LANG BMP
Selects output format *.bmp.
SENS:SWE:HCOP:DEV:SIZE 320,240
The size of the bitmap is 320 pixels by 240 pixels.
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:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME] <Name>

Creates of selects a file for storing the hardcopy after the :SENSe[:POWer]:SWEep:
HCOPy[:EXECute] on page 524 command is sent. The directory is either defined
with the command MMEMory:CDIR or the path is specified together with the file name.
Access to the file via remote control is possible using the commands of the MMEM-
Subsystem. In contrast, command :SENSe[:POWer]:SWEep:HCOPy:DATA?
on page 516 transfers the hardcopy contents directly to the remote client where they
can be further processed.

Parameters:
<Name> string

Example: SENS:SWE:HCOP:DEV:LANG BMP
Selects output format *,bmp.
SENS:SWE:HCOP:FILE:AUTO:STAT OFF
Switches off automatic naming.
SENS:SWE:HCOP:FILE 'var/trace/nrp_trace1'
creates the file nrp_trace1.bmp in the trace directory.
SENS:SWE:HCOP:EXEC
Triggers the generation of a hardcopy of the current trace. The
hardcopy is stored in the file nrp_trace1.bmp.

Manual operation: See "File name - Power Analysis" on page 280

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:DIRectory <Directory>

Defines the directory into which the hardcopy files are stored if auto naming is activa-
ted (SENS:SWE:HCOP:FILE:AUTO:STAT ON).

Parameters:
<Directory> string

Example: SENS:SWE:HCOP:FILE:AUTO:DIR 'var/nrp'
Hardcopy file are stored in directory var/nrp if automatic nam-
ing is activated.

Manual operation: See "Path" on page 282

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar

Deletes all files with extensions bmp , img, png, xpm and csv in the directory set
for automatic naming.

Example: SENS:SWE:HCOP:FILE:AUTO:DIR 'var/nrp'
Hardcopy filse are stored in directory var/nrp if automatic
naming is activated.
SENS:SWE:HCOP:FILEAUTO:DIR:CLE
Deletes all hardcopy file that are stored in the directory var/
nrp.

Usage: Event
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Manual operation: See "Clear Parth" on page 282

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:FILE?

Queries the file name generated with the automatic naming settings.

Note: As default the automatically generated file name is composed of: >PAth>/
<Prefix><YYYY><MM><DD><Number>.<Format>. Each component can be deacti-
vated/ activated separately to individually design the file name.

Return values: 
<File> string

Example: SENS:SWE:HCOP:DEV:LANG BMP
Selects output format *.bmp.
SENS:SWE:HCOP:FILE:AUTO:DIR 'var/nrp'
Hardcopy files are stored in directory var/nrp if automatic
naming is activated.
SENS:SWE:HCOP:FILE:AUTO:PREF 'sens1'
The file name starts with the prefix sens1. The usage of auto-
matic naming with prefix and date in the file name is preset
(…:STAT ON).
SENS:SWE:HCOP
Triggers the generation of a hardcopy of the current trace.
SENS:SWE:HCOP:FILE:AUTO:FILE?
Queries the file name

Usage: Query only

Manual operation: See "File name - Power Analysis" on page 280

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO:STATe <State>

Activates/deactivates automatic naming of the hardcopy files.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: SENS:SWE:HCOP:FILE:AUTO:STAT OFF
Deactivates automatic naming of the hardcopy files. The file
name and directory is now defined with command.
SENS:SWE:HCOP:FILE:NAME <psth>

Manual operation: See "File name - Power Analysis" on page 280

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY?

Queries the day of the date part in the automatic file name.
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Return values: 
<Day> integer

Range: 1  to  31
*RST: 1

Example: SENS:SWE:HCOP:FILE:AUTO:DAY?
Queries the day of the date part in the automatic file name.

Usage: Query only

Manual operation: See "Prefix, Year, Month, Day, Instrument Name" on page 283

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe <State>

Activates the usage of the day in the automatic file name.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: SENS:SWE:HCOP:FILE:AUTO:DAY:STAT OFF
Deactivates the usage of the day in the automatic file name.

Manual operation: See "Prefix, Year, Month, Day, Instrument Name" on page 283

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh?

Queries the day of the date part in the automatic file name.

Return values: 
<Month> integer

Range: 1  to  12
*RST: 1

Example: SENS:SWE:HCOP:FILE:AUTO:MONT?
Queries the month of the date part in the automatic file name.

Usage: Query only

Manual operation: See "Prefix, Year, Month, Day, Instrument Name" on page 283

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe
<State>

Activates the usage of the month in the automatic file name.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: SENS:SWE:HCOP:FILE:AUTO:MONT:STAT OFF
Deactivates the usage of the month in the automatic file name.

Manual operation: See "Prefix, Year, Month, Day, Instrument Name" on page 283
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:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?

Queries the generated number in the automatic file name.

Return values: 
<Number> integer

Range: 0  to  999999
*RST: 0

Example: SENS:SWE:HCOP:FILE:AUTO:NUMB?
Queries the number in the automatic file name.

Usage: Query only

Manual operation: See "Current Auto Number" on page 283

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix <Prefix>

Sets the prefix part in the automatic file name.

Parameters:
<Prefix> string

Example: SENS:SWE:HCOP:FILE:AUTO:PREF 'sensor'
The prefix sensor is used in the automatically generated file
name of the hardcopy file.

Manual operation: See "Prefix, Year, Month, Day, Instrument Name" on page 283

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe
<State>

Activates the usage of the prefix in the automatic file name.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: SENS:SWE:HCOP:FILE:AUTO:PREF:STAT OFF
Deactivates the usage of the prefix in the automatic file name.

Manual operation: See "Prefix, Year, Month, Day, Instrument Name" on page 283

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR?

Queries the year of the date part in the automatic file name.

Return values: 
<Year> integer

Range: 1784  to  8000
*RST: 0

Example: SENS:SWE:HCOP:FILE:AUTO:YEAR?
Queries the year of the date part in the automatic file name.

Power sensor measurement subsystems



Remote control commandsR&S®SMA100B

524User Manual 1178.3834.02 ─ 09

Usage: Query only

Manual operation: See "Prefix, Year, Month, Day, Instrument Name" on page 283

:SENSe[:POWer]:SWEep:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe <State>

Activates the usage of the year in the automatic file name.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: SENS:SWE:HCOP:FILE:AUTO:YEAR:STAT OFF
Deactivates the usage of the year in the automatic file name.

Manual operation: See "Prefix, Year, Month, Day, Instrument Name" on page 283

:SENSe[:POWer]:SWEep:HCOPy[:EXECute]

Triggers the generation of a hardcopy of the current measurement diagram. The data
is written into the file selected/created with the :SENSe[:POWer]:SWEep:HCOPy:
FILE[:NAME] on page 520 command.

Example: SENS:SWE:HCOP:DEV:LANG BMP
Selects output format *.bmp.
SENS:SWE:HCOP:FILE:AUTO:STAT OFF
Switches off automatic file naming.
SENS:SWE:HCOP:FILE 'var/nrp_trace1'
Creates the file nrp_trace1.bmp in the set path.
SENS:SWE:HCOP
Triggers the generation of a hardcopy of the current measure-
ment diagram. The hardcopy is stored in the file
nrp_trace1.bmp.

Usage: Event

Manual operation: See "File name - Power Analysis" on page 280

:SENSe[:POWer]:SWEep:INITiate

Starts the power analysis with NRP power sensor.

Example: SENS:SWE:INIT
Start the power measurement.

Usage: Setting only

:SENSe[:POWer]:SWEep:MODE <Mode>

Selects power versus frequency measurement (frequency response), power vs power
measurement (power sweep, AM/AM) or power vs. time measurement.
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Parameters:
<Mode> FREQuency | POWer | TIME

*RST: FREQuency

Example: SENS:SWE:MODE FREQ
Selects frequency mode.

Manual operation: See "Mode - Power Analysis" on page 256

:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:COPY

Generates a reference curve for "Power" measurement.

Example: SENS:POW:SWE:POW:REF:DATA:COPY
Generates a reference curve in power mode.

Usage: Event

Manual operation: See "Save To Ref" on page 254

:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:POINts?

Queries the number of points from the reference curve in "Power" measurement.

Return values: 
<Points> integer

Range: 10  to  1000

Example: SENS:POW:SWE:POW:REF:DATA:POIN?
Queries the number of points from the reference curve in power
mode.

Usage: Query only

:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:XVALues <XValues>

Sets or queries the x values of the two reference points, i.e. "Power X (Point A)" and
"Power X (Point B)" in "Power" measurement.

Parameters:
<XValues> string

Example: SENSe:POW:SWE:POW:REF:DATA:XVAL -15DBM,20DBM
Sets the x value of reference "Point A" to -15 dBm, and the
value of "Point B" to 20 dBm.

Manual operation: See "Pow (X)" on page 253

:SENSe[:POWer]:SWEep:POWer:REFerence:DATA:YVALues <YValues>

Sets or queries the y values of the two reference points, i.e. "Power Y (Point A)" and
"Power Y (Point B)" in "Power" measurement.
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Parameters:
<YValues> string

Example: SENSe:POW:SWE:TIME:REF:DATA:YVAL -30,10
Sets the y value of reference "Point A" to -30 dBm, and the
value of "Point B" to 10 dBm.

Manual operation: See "Pow (Y)" on page 254

:SENSe[:POWer]:SWEep:POWer:RMODe <RMode>

Selects single or continuous mode for measurement mode power in power analysis.

Parameters:
<RMode> SINGle | CONTinuous

*RST: CONTinuous

Example: SENS:SWE:POW:RMOD SING
Selects single measurement.

Manual operation: See "Execution - Power Analysis" on page 258

:SENSe[:POWer]:SWEep:POWer:SPACing[:MODE] <Mode>

Selects the spacing for the frequency power analysis.

Parameters:
<Mode> LINear

*RST: LINear

Example: SENS:SWE:FREQ:SPAC:MODE LIN
Sets linear spacing of the sweep.

Manual operation: See "Spacing - Power Analysis" on page 258

:SENSe[:POWer]:SWEep:POWer:STARt <Start>

Sets the start level for the power versus power measurement.

Parameters:
<Start> float

Range: -145  to  20
Increment: 0.01
*RST: 1MHZ

Example: SENS:SWE:POW:STAR -20DBM
Sets the start level to -20 dBm

Manual operation: See "Min - Power Analysis" on page 256

:SENSe[:POWer]:SWEep:POWer:STEPs <Steps>

Sets the number of measurement steps for the power versus power measurement.
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Parameters:
<Steps> integer

Range: 10  to  1000
*RST: 500

Example: SENS:SWE:POW:STEP 500
Sets the 500 measurement steps.

Manual operation: See "Steps - Power Analysis" on page 257

:SENSe[:POWer]:SWEep:POWer:STOP <Stop>

Sets the stop level for the power versus power measurement.

Parameters:
<Stop> float

Range: -145  to  20
Increment: 0.01
*RST: 40

Example: SENS:SWE:POW:STOP 20.0DBM
Sets the stop level to 20 dBm.

:SENSe[:POWer]:SWEep:POWer:TIMing[:MODE] <Mode>

Selects the timing mode of the measurement.

Parameters:
<Mode> FAST | NORMal | HPRecision | FAST | NORMal

FAST
Selection FAST leads to a fast measurement with a short inte-
gration times for each measurement step.
NORMal
NORMal leads to a longer but more precise measurement due
to a higher integration time for each step.
*RST: NORMal

Example: SENS:SWE:POW:TIM:MODE FAST
Selects fast mode.

Manual operation: See "Timing - Power Analysis" on page 257

:SENSe[:POWer]:SWEep:POWer:YSCale:AUTO <Auto>

Activates autoscaling of the Y axis of the diagram.

Parameters:
<Auto> OFF | CEXPanding | FEXPanding | CFLoating | FFLoating
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OFF
Auto scaling is deactivated. When switching from activated to
deactivated Auto scaling, the scaling is maintained. When
switching from deactivated to activated Auto scaling, the scaling
is reset to min = max = 0.
CEXPanding | FEXPanding
Auto scale is activated. The scaling of the Y-axis is selected in
such a way, that the trace is always visible. To this end, the
range is expanded if the minimum or maximum values of the
trace move outside the current scale. The step width is 5 dB for
selection course and variable in the range of 0.2 db to 5 dB for
selection fine.
CFLoating | FFLoating
Auto scale is activated. The scaling of the Y-axis is selected in
such a way, that the trace is always visible. To this end, the
range is either expanded if the minimum or maximum values of
the trace move outside the current scale or scaled down if the
trace fits into a reduced scale. The step width is 5 dB for selec-
tion course and variable in the range of 0.2 db to 5 dB for selec-
tion fine.
*RST: CEXPanding

Example: SENS:SWE:POW:YSC:AUTO OFF
Deactivates auto scale.

Manual operation: See "Auto Scale - Power Analysis" on page 263

:SENSe[:POWer]:SWEep:POWer:YSCale:AUTO:RESet

Resets the Y scale to suitable values after the use of auto scaling in the expanding
mode. For this mode, the scale might get expanded because of temporarily high power
values. The reset function allows resetting the diagram to match smaller power values
again.

Example: SENS:SWE:POW:YSC:AUTO:RES
Resets auto scale.

Usage: Event

Manual operation: See "Reset Auto Scale - Power Analysis" on page 264

:SENSe[:POWer]:SWEep:POWer:YSCale:MAXimum <Maximum>

Sets the maximum value for the y axis of the measurement diagram.

Parameters:
<Maximum> float

Range: -200  to  100
Increment: 0.01
*RST: 30
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Example: SENS:SWE:POW:YSC:MAX 10DBM
Sets 10 dBm as the upper limit of the measurement diagram.

Manual operation: See "Min - Max Level - Power Analysis" on page 263

:SENSe[:POWer]:SWEep:POWer:YSCale:MINimum <Minimum>

Sets the minimum value for the y axis of the measurement diagram.

Parameters:
<Minimum> float

Range: -200  to  100
Increment: 0.01
*RST: -40

Example: SENS:SWE:POW:YSC:MIN -10DBM
Sets -10 dBm as the lower limit of the measurement diagram.

Manual operation: See "Min - Max Level - Power Analysis" on page 263

:SENSe[:POWer]:SWEep:RMODe <RMode>

Selects single or continuous mode for power analysis (all measurement modes).

Parameters:
<RMode> SINGle | CONTinuous

*RST: SINGle

Example: SENS:SWE:RMOD SING
Selects single measurement.

Manual operation: See "Execution - Power Analysis" on page 258

:SENSe[:POWer]:SWEep:TIME:AVERage[:COUNt] <Count>

Selects the averaging factor in time mode. The count number determines how many
measurement cycles are used to form a measurement result. Higher averaging counts
reduce noise but increase the measurement time. Averaging requires a stable trigger
event so that the measurement cycles have the same timing.

Parameters:
<Count> 1 | 2 | 4 | 8 | 16 | 32 | 64 | 128 | 256 | 512 | 1024

*RST: 1

Example: SENS:SWE:MODE TIME
Selects time mode.
SENS:SWE:TIME:AVER 128
Selects averaging factor 128.

Options: Option R&S SMAB-K28

Manual operation: See "Average - Power Analysis" on page 258
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:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:COPY

Generates a reference curve for "Time" measurement.

Example: SENS:POW:SWE:TIME:REF:DATA:COPY
Generates a reference curve in time mode.

Usage: Event

Manual operation: See "Save To Ref" on page 254

:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:POINts?

Queries the number of points from the reference curve in "Time" measurement.

Return values: 
<Points> integer

Range: 10  to  1000
*RST: 0

Example: SENS:POW:SWE:TIME:REF:DATA:POIN?
Queries the number of points from the reference curve in time
mode.

Usage: Query only

:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:XVALues <XValues>

Sets or queries the x values of the two reference points, i.e. "Time X (Point A)" and
"Time X (Point B) "in "Time" measurement.

Parameters:
<XValues> string

Example: SENSe:POW:SWE:TIME:REF:DATA:XVAL 5,45
Sets the x value of reference "Point A" to 5 μs, and the value of
"Point B" to 45 μs.

Manual operation: See "Time (X)" on page 254

:SENSe[:POWer]:SWEep:TIME:REFerence:DATA:YVALues <YValues>

Sets or queries the y values of the two reference points, i.e. "Power Y (Point A)" and
"Power Y (Point B)" in "Time" measurement.

Parameters:
<YValues> string

Example: SENSe:POW:SWE:TIME:REF:DATA:YVAL -30,10
sets the y value of reference "Point A" to -30 dBm, and the value
of "Point B" to 10 dBm.

Manual operation: See "Pow (Y)" on page 254
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:SENSe[:POWer]:SWEep:TIME:RMODe <RMode>

Selects single or continuous mode for measurement mode time in power analysis.

Parameters:
<RMode> SINGle | CONTinuous

*RST: CONTinuous

Example: SENS:SWE:TIME:RMOD SING
Selects single measurement.

Manual operation: See "Execution - Power Analysis" on page 258

:SENSe[:POWer]:SWEep:TIME:SPACing[:MODE] <Mode>

Queries the sweep spacing for the power versus time measurement. The spacing is
fixed to linear.

Parameters:
<Mode> LINear

*RST: LINear

Example: SENS:SWE:TIME:SPAC?
Queries the sweep spacing.

Manual operation: See "Spacing - Power Analysis" on page 258

:SENSe[:POWer]:SWEep:TIME:STARt <Start>

Sets the start time for the power versus time measurement. Value 0 defines the trigger
point. By choosing a negative time value, the trace can be shifted in the diagram. It is
possible, that the measurement cannot be performed over the complete time range
because of limitations due to sensor settings. In this case, an error message is output.

Parameters:
<Start> float

Range: -1  to  1
Increment: 1E-12
*RST: -5E-6

Example: SENS:SWE:TIME:STAR 0s
Sets the start time to 0 s.

Manual operation: See "Min - Power Analysis" on page 256

:SENSe[:POWer]:SWEep:TIME:STEPs <Steps>

Sets the number of measurement steps for the power versus time measurement. Value
0 defines the trigger point.
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Parameters:
<Steps> integer

Range: 10  to  1000
*RST: 500

Example: SENS:SWE:TIME:STEP 500
Sets the 500 measurement steps.

Manual operation: See "Steps - Power Analysis" on page 257

:SENSe[:POWer]:SWEep:TIME:STOP <Stop>

Sets the stop time for the power versus time measurement.

Parameters:
<Stop> float

Range: 0  to  2
Increment: 1E-12
*RST: 1E-3

Example: SENS:SWE:TIME:STOP 1ms
Sets the stop time to 1 ms.

Manual operation: See "Max - Power Analysis" on page 257

:SENSe[:POWer]:SWEep:TIME:TEVents <TriggerTEvents>

Determines, whether the measurement data processing starts with a trigger event in
one of the sensors (Logical OR), or whether all channels have to be triggered (logical
AND). Each sensor evaluates a trigger event according to its setting independently.
This function supports the internal or external trigger modes with multi-channel time
measurements.

Parameters:
<TriggerTEvents> AND | OR

*RST: AND

Example: SENS:POW:SWE:TIME:TEV AND
The measurement data processing starts when all channels are
triggered.

Options: Option R&S SMAB-K28

Manual operation: See "All Trigger Events - Power Analysis" on page 259

:SENSe[:POWer]:SWEep:TIME:YSCale:AUTO <Auto>

Activates autoscaling of the Y axis in the diagram.

Parameters:
<Auto> OFF | CEXPanding | FEXPanding | CFLoating | FFLoating
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OFF
Auto scaling is deactivated. When switching from activated to
deactivated Auto scaling, the scaling is maintained. When
switching from deactivated to activated Auto scaling, the scaling
is reset to min = max = 0.
CEXPanding | FEXPanding
Auto scale is activated. The scaling of the Y-axis is selected in
such a way, that the trace is always visible. To this end, the
range is expanded if the minimum or maximum values of the
trace move outside the current scale. The step width is 5 dB for
selection course and variable in the range of 0.2 db to 5 dB for
selection fine.
CFLoating | FFLoating
Auto scale is activated. The scaling of the Y-axis is selected in
such a way, that the trace is always visible. To this end, the
range is either expanded if the minimum or maximum values of
the trace move outside the current scale or scaled down if the
trace fits into a reduced scale. The step width is 5 dB for selec-
tion course and variable in the range of 0.2 db to 5 dB for selec-
tion fine.
*RST: CEXPanding

Example: SENS:SWE:TIME:YSC:AUTO OFF
Deactivates auto scale

Manual operation: See "Auto Scale - Power Analysis" on page 263

:SENSe[:POWer]:SWEep:TIME:YSCale:AUTO:RESet

Resets the Y scale to suitable values after the use of auto scaling in the expanding
mode. For this mode, the scale might get expanded because of temporarily high power
values. The reset function allows resetting the diagram to match smaller power values
again.

Example: SENS:SWE:TIME:YSC:AUTO:RES
Resets auto scale.

Usage: Event

Manual operation: See "Reset Auto Scale - Power Analysis" on page 264

:SENSe[:POWer]:SWEep:TIME:YSCale:MAXimum <Maximum>

Sets the maximum value for the y axis of the measurement diagram.

Parameters:
<Maximum> float

Range: -200  to  100
Increment: 0.01
*RST: 30.0
Default unit: dBm
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Example: SENS:SWE:TIME:YSC:MAX 10DBM
Sets 10 dBm as the upper limit of the measurement diagram.

Manual operation: See "Min - Max Level - Power Analysis" on page 263

:SENSe[:POWer]:SWEep:TIME:YSCale:MINimum <Minimum>

Sets the minimum value for the y axis of the measurement diagram.

Parameters:
<Minimum> float

Range: -200  to  100
Increment: 0.01
*RST: dBm

Example: SENS:SWE:TIME:YSC:MIN -10DBM
Sets -10 dBm as the lower limit of the measurement diagram.

Manual operation: See "Min - Max Level - Power Analysis" on page 263

14.14.5  TRACe subsystem
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:TRACe<ch>:FREQ:SWEep:SRC <FreqSource>

Determines the source of a trace for display in frequency measurement mode.

Parameters:
<FreqSource> OFF | SEN1 | SEN2 | SEN3 | SEN4 | HOLD | REF | ON

ON|OFF
Activates ofr deactivates the display of a trace.
SEN1|SEN2|SEN3|SEN4
Activates the measurement results display of the sensor that is
assigned to the trace.
REF
Selects a reference trace.
HOLD
Freezes the measurement results display of the sensor that is
assigned to the trace.
*RST: OFF

Example: :TRACe2:FREQ:SWEep:SRC SEN2
Selects sensor2 for display in trace 2.
:TRACe1:FREQ:SWEep:SRC REF
Assigns the reference trace to trace 1.
:TRACe1:FREQ:SWEep:SRC ON
Activates trace 1 i.e. the reference trace.

Manual operation: See "Indication - Trace Power Analysis" on page 251

:TRACe<ch>:POW:SWEep:SRC <PowSource>

Determines the trace source of a trace for display in power measurement mode.

Parameters:
<PowSource> OFF | SEN1 | SEN2 | SEN3 | SEN4 | HOLD | REF | ON

ON|OFF
Activates ofr deactivates the display of a trace.
SEN1|SEN2|SEN3|SEN4
Activates the measurement results display of the sensor that is
assigned to the trace.
REF
Selects a reference trace.
HOLD
Freezes the measurement results display of the sensor that is
assigned to the trace.
*RST: OFF
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Example: :TRACe1:POW:SWEep:SRC SEN1
Selects the connector assigned to the first port for display in
trace 1.
:TRACe2:POW:SWEep:SRC HOLD
Freezes the power sweep measurement results in trace 1.

Manual operation: See "Indication - Trace Power Analysis" on page 251

:TRACe<ch>:TIME:SWEep:SRC <TimeSource>

Determines the trace source of a trace for display in time measurement mode.

Parameters:
<TimeSource> OFF | SEN1 | SEN2 | SEN3 | SEN4 | HOLD | REF | ON

ON|OFF
Activates ofr deactivates the display of a trace.
SEN1|SEN2|SEN3|SEN4
Activates the measurement results display of the sensor that is
assigned to the trace.
REF
Selects a reference trace.
HOLD
Freezes the measurement results display of the sensor that is
assigned to the trace.
*RST: OFF

Example: :TRACe2:TIME:SWEep:SRC SEN2
Selects sensor2 for display in trace 2.
:TRACe1:TIME:SWEep:SRC REF
Assigns the reference trace to trace 1.
:TRACe1:TIME:SWEep:SRC ON
Activates trace 1 i.e. the reference trace.

Manual operation: See "Indication - Trace Power Analysis" on page 251

:TRACe<ch>[:POWer]:SWEep:COLor <Color>

Defines the color of a trace.

Parameters:
<Color> INVers | GRAY | YELLow | BLUE | GREen | RED | MAGenta

*RST: trace 1 = YELLow, trace 2 = GREen, trace 3 =
RED.

Example: TRAC2:SWE:COL GRAY
Trace2 is indicated in gray color.

Manual operation: See "Color - Trace Power Analysis" on page 251
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:TRACe<ch>[:POWer]:SWEep:COPY <Copy>

Stores the selected trace data as reference trace.

Setting parameters: 
<Copy> REFerence

Example: TRAC2:SWE:COPY REF
Stores the current trace2 as reference trace'
TRAC1:SWE:FEED REF
Assigns the reference trace to trace 1.

Usage: Setting only

Manual operation: See "Save to Ref - Trace Power Analysis" on page 251

:TRACe<ch>[:POWer]:SWEep:DATA:POINts?

Queries the number of measurement points of the selected trace of the current power
analysis.

Return values: 
<Points> integer

Range: 10  to  1000
*RST: 0

Example: TRAC1:SWE:DATA:POIN?
Response: 624
Measurement trace 1 contains 624 measurement points

Usage: Query only

:TRACe<ch>[:POWer]:SWEep:DATA:XVALues?

Queries the x-axis values - frequency, power or time values - of the selected trace of
the current power analysis.

Return values: 
<XValues> string

Example: SENS:SWE:MODE FREQ
Sets measurement mode frequency versus power.
SENS:SWE:RMOD SING
Selects single measurement.
SENS:SWE:INIT
Starts the measurement.
*OPC?
Waits until measurement is performed.
TRAC1:SWE:DATA:XVAL?
Queries the x-axis values of trace 1.
TRAC1:SWE:DATA:YVAL?
Queries the y-axis values of trace 1

Usage: Query only
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:TRACe<ch>[:POWer]:SWEep:DATA:YSValue? <XValue>

For a given x-axis value, queries the measurement (y-axis) value of the selected trace
of the current power analysis.

Query parameters: 
<XValue> float

Return values: 
<YSValue> float

Increment: 1E-9

Example: TRACe1:SWE:DATA:YSValue? 2.3
Example: Queries the y-axis values of trace 1 at x-axis value of 2.3.

See :TRACe<ch>[:POWer]:SWEep:DATA:XVALues?
on page 538.

Usage: Query only

:TRACe<ch>[:POWer]:SWEep:DATA:YVALues?

Queries the measurement (y-axis) values of the selected trace of the current power
analysis.

Return values: 
<YValues> string

Example: SENS:SWE:TRAC2:DATA:YVAL?
Queries the power values of trace 2.
See :TRACe<ch>[:POWer]:SWEep:DATA:XVALues?
on page 538.

Usage: Query only

:TRACe<ch>[:POWer]:SWEep:FEED <Feed>

Selects the source for the trace data.

Parameters:
<Feed> SENS1 | SENS2 | SENS3 | REFerence | NONE | SENSor1 |

SENSor2 | SENSor3 | SENS4 | SENSor4
*RST: The preset value for each trace is evaluated during

runtime as follows: If a sensor is plugged into the
generator whose number corresponds to the trace
number, this sensor is used to feed the trace and
the state of the trace is ON; If no sensor is found
with number corresponding to the trace number, the
preset value of the trace is "Off".
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Example: TRAC2:SWE:COPY REF
Stores trace2 as reference trace.
TRAC1:SWE:FEED REF
Assigns the reference trace to trace 1.
TRAC1:SWE:STAT ON
Assigns the reference trace to trace 1.
SENS:SWE:RMOD SING
Selects single measurement
SENS:SWE:INIT
Starts the measurement

Manual operation: See "Indication - Trace Power Analysis" on page 251

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:AVERage?
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:HREFerence?
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:LREFerence?
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:MAXimum?
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:MINimum?
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:PULSe:BASE?
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:PULSe:TOP?
:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:REFerence?
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:DCYCle?
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:DURation?
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:PERiod?
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:SEParation?
:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:STATe?
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:DURation?
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:

OCCurrence?
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:OVERshoot?
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:DURation?
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:OCCurrence?
:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:OVERshoot?
The above listed commands query the measured pulse parameter values.

Note: These commands are only available in time measurement mode and with R&S
NRP-Z81 power sensors.

Return values: 
<Overshoot> float

Range: 0  to  100
Increment: 0.01
*RST: 0

Example: TRAC1:SWE:MEAS:POW:HREF?
Queries the measured mesial threshold level of trace 1.
TRAC3:SWE:MEAS:POW:MAX?
Queries the measured peak power of trace 3.

Usage: Query only
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Options: Option R&S SMAB-K28

Manual operation: See "Overshoot (Rising Edge / Falling Edge)" on page 270

:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:DCYCle:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:DURation:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:PERiod:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:AVERage:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:PULSe:BASE:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:HREFerence:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:LREFerence:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:MAXimum:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:MINimum:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:REFerence:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:POWer:PULSe:TOP:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:SEParation:DISPlay:
ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:DURation:
DISPlay:ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:OCCurrence:
DISPlay:ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:NEGative:OVERshoot:
DISPlay:ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:DURation:
DISPlay:ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:OCCurrence:
DISPlay:ANNotation[:STATe] <State>

:TRACe<ch>[:POWer]:SWEep:MEASurement:TRANsition:POSitive:OVERshoot:
DISPlay:ANNotation[:STATe] <State>

The above listed commands select the pulse parameters which are indicated in the dis-
play and hardcopy file. Only six parameters can be indicated at a time.

Note: These commands are only available in time measurement mode and with R&S
NRP-Z81 power sensors.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0
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Example: TRAC:SWE:MEAS:TRAC2:PULS:PER:DISP:ANN ON
Selects the pulse period to be indicated in the display.
TRAC:SWE:MEAS:PULS:DISP:ANN ON
Activates indication of the selected pulse data in the display.

Options: Option R&S SMAB-K28

Manual operation: See "Overshoot (Rising Edge / Falling Edge)" on page 270

:TRACe<ch>[:POWer]:SWEep:MEASurement:PULSe:ALL:DISPlay:ANNotation[:
STATe] <State>

Deactivates the indication of all pulse data of the selected trace. The parameters to be
indicated can be selected with the TRAC:SWE:MEAS:…. commands. Only six parame-
ters are indicated at a time.

Note: This command is only available in time measurement mode and with R&S NRP-
Z81 power sensors.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: TRAC:SWE:MEAS:PULS:ALL:DISP:ANN OFF
Switches the indication of all pulse data off.

Options: Option R&S SMAB-K28

:TRACe<ch>[:POWer]:SWEep:PULSe:THReshold:BASE?

Queries how the threshold parameters are calculated.

Note: This parameter is only avalaible in time measurement mode and R&S NRP-Z81
power sensors.

Return values: 
<Base> VOLTage | POWer

*RST: VOLTage

Example: TRAC1:SWE:PULS:THR:BAS?
Queries the threshold base of pulse data calculation.

Usage: Query only

Manual operation: See "Base" on page 266

:TRACe<ch>[:POWer]:SWEep:PULSe:THReshold:POWer:HREFerence
<HReference>

Queries the upper threshold level of the overall pulse level. The distal power defines
the end of the rising edge and the start of the falling edge of the pulse.

Note: This parameter is only avalaible in time measurement mode and R&S NRP-Z81
power sensors.
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Parameters:
<HReference> float

Range: 0.0  to  100.0
Increment: 0.01
*RST: 90.0

Example: TRAC2:SWE:PULS:THR:POW:HREF?
Queries the upper reference level of trace 2.

Manual operation: See "Distal" on page 266

:TRACe<ch>[:POWer]:SWEep:PULSe:THReshold:POWer:LREFerence
<LReference>

Queries the lower medial threshold level of the overall pulse level. The proximal power
defines the start of the rising edge and the end of the falling edge of the pulse.

Note: This parameter is only avalaible in time measurement mode and R&S NRP-Z81
power sensors.

Parameters:
<LReference> float

Range: 0.0  to  100.0
Increment: 0.01
*RST: 10.0

Example: TRAC:SWE:PULS:THR:POW:LREF?
Queries the medial threshold level of trace 1.

Manual operation: See "Proximal" on page 267

:TRACe<ch>[:POWer]:SWEep:PULSe:THReshold:POWer:REFerence <Reference>

Queries the medial threshold level of the overall pulse level. This level is used to define
the pulse width and pulse period.

Note: This parameter is only avalaible in time measurement mode and R&S NRP-Z81
power sensors.

Parameters:
<Reference> float

Range: 0.0  to  100.0
Increment: 0.01
*RST: 50.0

Example: TRAC3:SWE:PULS:THR:POW:REF?
Queries the medial threshold level of trace 3.

Manual operation: See "Mesial" on page 267

:TRACe<ch>[:POWer]:SWEep:STATe <State>

Activates the selected trace.
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Parameters:
<State> OFF | ON | HOLD

*RST: The preset value for each trace is evaluated during
runtime as follows: If a sensor is plugged into the
generator whose number corresponds to the trace
number, this sensor is used to feed the trace and
the state of the trace is ON; If no sensor is found
with a number corresponding to the trace number,
the preset value of the trace is "Off".

Example: TRAC2:SWE:COPY REF
Stores trace2 as reference trace.
TRAC1:SWE:FEED REF
Assigns the reference trace to trace 1.
TRAC1:SWE:STAT ON
Assigns the reference trace to trace 1.
SENS:SWE:RMOD SING
Selects single measurement.
SENS:SWE:INIT
Starts the measurement.

Manual operation: See "Indication - Trace Power Analysis" on page 251

:TRACe[:POWer]:SWEep:MEASurement:FULLscreen:DISPlay:ANNotation[:
STATe] <State>

Selects fullscreen display of the measurement diagram on the display and in the hard-
copy file.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: TRAC:SWE:MEAS:FULL:DISP:ANN ON
The display only shows the diagram.

Options: Option R&S SMAB-K28

Manual operation: See "Full Screen" on page 279

:TRACe[:POWer]:SWEep:MEASurement:GATE:DISPlay:ANNotation[:STATe]
<State>

Activates th eindication of the time gate borders and values in the measurement dia-
gram and in the hardcopy file. The gate settings are performed with the
CALC:POW:SWE:TIME:GATE:… commands.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1
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Example: TRAC:SWE:MEAS:GATE:DISP:ANN ON
The diagram also shows the gate information.

Options: Option R&S SMAB-K28

Manual operation: See "State - Gate" on page 276

:TRACe[:POWer]:SWEep:MEASurement:MARKer:DISPlay:ANNotation[:STATe]
<State>

Activates the indication of the markers and the marker list in the measurement diagram
and in the hardcopy file.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: TRAC:SWE:MEAS:MARK:DISP:ANN ON
The diagram also shows the marker information.

Options: Option R&S SMAB-K28

Manual operation: See "Marker View" on page 277

:TRACe[:POWer]:SWEep:MEASurement:PULSe:DISPlay:ANNotation[:STATe]
<State>

Activates the indication of the pulse data below the measurement diagram and storing
the data in the hardcopy file. The parameters to be indicated can be selected with the
following TRAC:SWE:MEAS:…. commands. Only six parameters are indicated at one
time.

Note: This command is only avalaible in time measurement mode and with R&S
NRPZ81 power sensors.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: TRAC:SWE:MEAS:PULS:DISP:ANN ON
Activates indication of the selected pulse data.

Options: Option R&S SMAB-K28

Manual operation: See "Pulse Data View" on page 278

:TRACe[:POWer]:SWEep:MEASurement:STANdard:DISPlay:ANNotation[:STATe]
<State>

Selects the standard view, i.e. diagram and buttons but no lists are displayed and also
stored in the hardcopy file.
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: 1

Example: TRAC:SWE:MEAS:STAN:DISP:ANN ON
Activates indication of the selected pulse data.

Options: Option R&S SMAB-K28

Manual operation: See "Standard View" on page 277

14.15  SENSe, READ, INITiate and SLISt subsystems

These subsystems contain the commands for configuring the power measurements
with R&S NRP power sensor connected to the R&S SMA100B.

The local state is set with the INIT command. Switching off the local state enhances
the measurement performance. Measurements results can be retrieved in local state
on or off.
Sensor parameters are set with the SENSe commands.
To start the measurement and retrieve the result, use the :READ<ch>[:POWer]?
command.

Suffix Value range Description

SENSe<ch> [1] to 4 Indicates the sensor
Sensor mapping:
● SENSe[1] - default mapping for sensors connected to the

[Sensor] connector
● SENSe2 - sensor connected to a [USB] connector
● SENSe3|4 - further connected sensors to [USB] connectors,

in the connection order

Use the :SLISt commands to change the sensor mapping

READ<ch> [1] to 4 Sensor assignment

INIate<hw> [1] to 4 Sensor assignment

ELEMent<ch> [1] to 25 Sensor-mapping list
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Programming examples

Example: Detecting and assigning a power sensor
SLISt:LIST?
// Response: "NRP33SN-V-900007-USB Legacy","NRP-Z211-900001-USB Legacy"
// Lists all automatically detected sensors.

SLISt:SCAN:STATe 1
// Searches for sensors connected in the LAN or via the USBTMC protocol.

SLISt:SCAN:LSENsor 'NRQ6',101624 // sensor name, serial number
SLISt:SCAN:LSENsor 11.123.1.123, 101624 // IP address, serial number
// Adds sensors to the list, that are connected to LAN.

SLISt:SCAN:USENsor 'NRQ6',101624 //sensor name, serial number
SLISt:SCAN:USENsor #H15b,101624  //device ID (hexadecimal), serial number
SLISt:SCAN:USENsor 347,101624    //device ID (decimal), serial number
// Adds a sensor to the list, that is connected to the USB interface.

SLISt:LIST?
// Response: "NRP33SN-V-900007-USB Legacy","NRP-Z211-900001-USB Legacy",
// "NRP33SN-V-900005-USBTMC","NRP33SN-V-900011-LAN"
// Lists all automatically detected sensors.

SLISt:ELEMent3:MAPPing SENS1
// Maps the third sensor from the list to the first sensor channel.

SLISt:SENSor:MAP "NRPS18S-100654-USB Legacy", SENS3
// Maps the sensor to channel 3.

SLISt:CLEar[ALL]
// Remove all sensors from the list.
SLISt:CLEar:LAN 
// Remove all sensors from the list, that are connected over LAN.
SLISt:CLEar:USB 
// Remove all sensors from the list, that are connected over USB.

Example: Performing a simple power measurement
Prerequisite: The sensor is connected to the instrument and mapped to the first sensor
channel.
INITiate1:CONTinuous ON
// Switches the continous power measurement on.

READ1?
// Triggers the measurement and displays the results.
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Example: Performing a power measurement with a fixed filter
Prerequisite: The sensor is connected to the instrument and mapped to the first sensor
channel.
SENSe1:SOURce RF 
// Sensor measures the power of the RF signal.

SENSe1:FILTer:TYPE NSRatio
// Selects fixed noise filter mode.

SENSe1:FILTer:NSRatio 0.02 DB
// Sets the maximum noise component in the result to 0.02 DB.

SENSe1:FILTer:NSRatio:MTIMe 10
//Limits the settling time to 10 seconds.

SENSe1:APERture:DEFault:STATe 0
// Deactivates the default aperture time of the sensor.

SENSe1:APERture:TIMe 10e-6
// Sets the aperture time to 10 us.

SENSe1:UNIT DBM
// Selects unit dBm for the measured value.

INITiate:CONTinuous ON
// Switches the continous power measurement on.

READ?
// Triggers the measurement and displays the results.

:SLISt[:LIST]?................................................................................................................ 549
:SLISt:SCAN[:STATe]......................................................................................................549
:SLISt:SCAN:LSENsor....................................................................................................549
:SLISt:SCAN:USENsor................................................................................................... 550
:SLISt:CLEar:LAN.......................................................................................................... 550
:SLISt:CLEar:USB..........................................................................................................550
:SLISt:CLEar[:ALL].........................................................................................................551
:SLISt:ELEMent<ch>:MAPPing........................................................................................551
:SLISt:SENSor:MAP.......................................................................................................551
:INITiate<hw>[:POWer]:CONTinuous............................................................................... 551
:READ<ch>[:POWer]?.................................................................................................... 552
:SENSe<ch>:UNIT[:POWer]............................................................................................552
:SENSe<ch>[:POWer]:APERture:DEFault:STATe.............................................................. 553
:SENSe<ch>[:POWer]:APERture:TIMe.............................................................................553
:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect.......................................................553
:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe........................................................554
:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?.........................................................554
:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority.........................................................554
:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe........................................................... 554
:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO?.................................................................. 555
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:SENSe<ch>[:POWer]:FILTer:LENGth[:USER].................................................................. 555
:SENSe<ch>[:POWer]:FILTer:NSRatio............................................................................. 556
:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe.................................................................. 556
:SENSe<ch>[:POWer]:FILTer:SONCe.............................................................................. 556
:SENSe<ch>[:POWer]:FILTer:TYPE................................................................................. 557
:SENSe<ch>[:POWer]:FREQuency..................................................................................557
:SENSe<ch>[:POWer]:LOGGing:STATe............................................................................558
:SENSe<ch>[:POWer]:OFFSet........................................................................................ 558
:SENSe<ch>[:POWer]:OFFSet:STATe..............................................................................558
:SENSe<ch>[:POWer]:SNUMber?................................................................................... 558
:SENSe<ch>[:POWer]:SOURce.......................................................................................559
:SENSe<ch>[:POWer]:STATus[:DEVice]?......................................................................... 559
:SENSe<ch>[:POWer]:SVERsion?...................................................................................559
:SENSe<ch>[:POWer]:TYPE?......................................................................................... 560
:SENSe<ch>[:POWer]:ZERO.......................................................................................... 560

:SLISt[:LIST]?

Returns a list of all detected sensors in a comma-separated string.

Return values: 
<SensorList> String of comma-separated entries

Each entry contains information on the sensor type, serial num-
ber and interface.
The order of the entries does not correspond to the order the
sensors are displayed in the "NRP Sensor Mapping" dialog.

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Usage: Query only

Manual operation: See "Sensor Mapping List" on page 235

:SLISt:SCAN[:STATe] <State>

Starts the search for R&S NRP power sensors, connected in the LAN or via the
USBTMC protocol.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Manual operation: See "Scan" on page 236

:SLISt:SCAN:LSENsor <IP>

Scans for R&S NRP power sensors connected in the LAN.
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Setting parameters: 
<IP> string

*RST: 0

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Usage: Setting only

Manual operation: See "Add LAN Sensor settings" on page 236

:SLISt:SCAN:USENsor <DeviceID>, <Serial>

Scans for R&S NRP power sensors connected over a USB interface.

Parameters:
<Serial> integer

Range: 0  to  999999

Setting parameters: 
<DeviceID> String or Integer

Range: 0  to  999999
*RST: 0

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Usage: Setting only

Manual operation: See "Add USB Sensor settings" on page 236

:SLISt:CLEar:LAN

Removes all R&S NRP power sensors connected in the LAN from the list.

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Usage: Event

Manual operation: See "Clear" on page 236

:SLISt:CLEar:USB

Removes all R&S NRP power sensors connected over USB from the list.

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Usage: Event

Manual operation: See "Clear" on page 236
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:SLISt:CLEar[:ALL]

Removes all R&S NRP power sensors from the list.

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Usage: Event

Manual operation: See "Clear" on page 236

:SLISt:ELEMent<ch>:MAPPing <Mapping>

Assigns an entry from the :SLISt[:LIST]? to one of the four sensor channels.

Parameters:
<Mapping> SENS1 | SENSor1 | SENS2 | SENSor2 | SENS3 | SENSor3 |

SENS4 | SENSor4 | UNMapped
Sensor channel.
*RST: UNMapped

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Manual operation: See "Sensor Mapping List" on page 235

:SLISt:SENSor:MAP <SensorId>, <Mapping>

Assigns a sensor directly to one of the sensor channels, using the sensor name and
serial number.

To find out the the sensor name and ID, you can get it from the label of the R&S NRP,
or using the command :SLISt:SCAN[:STATe]. This command detects all R&S NRP
power sensors connected in the LAN or via 'USBTMC protocol.

Setting parameters: 
<SensorId> string

<Mapping> enum

Example: See Example "Detecting and assigning a power sensor"
on page 547.

Usage: Setting only

Manual operation: See "Sensor Mapping List" on page 235

:INITiate<hw>[:POWer]:CONTinuous <Continuous>

Switches the local state of the continuous power measurement by R&S NRP power
sensors on and off. Switching off local state enhances the measurement performance
during remote control.
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The remote measurement is triggered with :READ<ch>[:POWer]?). This command
also returns the measurement results. The local state is not affected, measurement
results can be retrieved with local state on or off.

Parameters:
<Continuous> 0 | 1 | OFF | ON

*RST: 0

Example: :INIT1:CONT ON
Switches local state of continuous power measurement on.

Manual operation: See "State" on page 241

:READ<ch>[:POWer]?

Triggers power measurement and displays the results.

Note: This command does not affect the local state, i.e. you can get results with local
state on or off. For long measurement times, we recommend that you use an SRQ for
command synchronization (MAV bit).

Suffix: 
<ch>

.
1 to 3

Return values: 
<Power> float or float,float

The sensor returns the result in the unit set with command :
SENSe<ch>:UNIT[:POWer]
Certain power sensors, such as the R&S NRP-Z81, return two
values, first the value of the average level and - separated by a
comma - the peak value.

Example: :SENS1:UNIT DBM
Selects unit dBm for presentation of measurement result.
:READ1?
Queries the measurement result of the sensor.
-45.6246576745440230
-45.6 dBm were measured at the given frequency.

Example: R&S NRP-Z81
:READ1?
-55.62403263352178,-22.419472478812476
-55.6 dBm is the measured average level, -22. 4 dBm is the
measured peak level at the given frequency.

Usage: Query only

Manual operation: See "Level (Peak) / Level (Average)" on page 241

:SENSe<ch>:UNIT[:POWer] <Power>

Selects the unit (Watt, dBm or dBμV) of measurement result display, queried with :
READ<ch>[:POWer]?.
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Parameters:
<Power> DBM | DBUV | WATT

*RST: DBM

Example: :SENS2:UNIT DBM
Selects dBm as unit for the measured value returned by com-
mand READ.
:READ2?
Response: 7.34
7.34 dBm are measured by sensor 2.

Manual operation: See "Level (Peak) / Level (Average)" on page 241

:SENSe<ch>[:POWer]:APERture:DEFault:STATe <UseDefAp>

Deactivates the default aperture time of the respective sensor.

To specify a user-defined value, use the command :SENSe<ch>[:POWer]:
APERture:TIMe on page 553.

Parameters:
<UseDefAp> 0 | 1 | OFF | ON

*RST: 1

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 548.

Manual operation: See " Default Aperture Time" on page 244

:SENSe<ch>[:POWer]:APERture:TIMe <ApTime>

Defines the aperture time (size of the acquisition interval) for the corresponding sensor.

Parameters:
<ApTime> float

Range: depends on connected power sensor
Increment: 1E-9
*RST: depends on connected power sensor

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 548.

Manual operation: See "Aperture Time" on page 244

:SENSe<ch>[:POWer]:CORRection:SPDevice:SELect <Select>

Several S-parameter tables can be stored in a sensor. The command selects a loaded
data set for S-parameter correction for the corresponding sensor.

Parameters:
<Select> float

*RST: 0
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Manual operation: See "S-Parameter" on page 244

:SENSe<ch>[:POWer]:CORRection:SPDevice:STATe <State>

Activates the use of the S-parameter correction data.

Note: If you use power sensors with attenuator, the instrument automatically activates
the use of S-parameter data.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: :SENSe1:POWer:CORRection:SPDevice:STATe 1
Activates the use of the S-parameters correction data.

Manual operation: See "S-Parameter" on page 244

:SENSe<ch>[:POWer]:CORRection:SPDevice:LIST?

Queries the list of the S-parameter data sets that have been loaded to the power sen-
sor.

Return values: 
<List> string list

*RST: 0

Usage: Query only

Manual operation: See "S-Parameter" on page 244

:SENSe<ch>[:POWer]:DISPlay:PERManent:PRIority <Priority>

Selects average or peak power for permanent display.

Parameters:
<Priority> AVERage | PEAK

*RST: AVERage

Example: :SENS1:DISP:PERM:STAT ON
Turns on the permanent view.
:SENS1:DISP:PERM:PRI AVER
Sets the average power for display.

Manual operation: See "Display" on page 242

:SENSe<ch>[:POWer]:DISPlay:PERManent:STATe <State>

Activates the permanent display of the measured power level results. The instrument
also indicates the sensor type, the connection, the measurement source and the offset
if set.
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Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: :SENS1:POW:DISP:PERM:STAT ON
Turns on the permanent view.

Manual operation: See "Permanent" on page 242

:SENSe<ch>[:POWer]:FILTer:LENGth:AUTO?

Queries the current filter length in filter mode AUTO (:SENSe<ch>[:POWer]:
FILTer:TYPE)

Return values: 
<Auto> float

Range: 1  to  65536

Example: :SENS1:FILT:TYPE AUTO
Selects auto filter.
:SENS1:FILT:LENG:AUTO?
Queries the automatically set filter length.
Response: 1024

Usage: Query only

Manual operation: See "Filter Length" on page 243

:SENSe<ch>[:POWer]:FILTer:LENGth[:USER] <User>

Selects the filter length for SENS:POW:FILT:TYPE USER. As the filter length works as
a multiplier for the time window, a constant filter length results in a constant measure-
ment time (see also "About the measuring principle, averaging filter, filter length, and
achieving stable results" on page 237).

The R&S NRP power sensors provide different resolutions for setting the filter length,
depending on the used sensor type:
● Resolution = 1 for R&S NRPxx power sensors
● Resolution = 2n for sensors of the R&S NRP-Zxx family, with n = 1 to 16

Parameters:
<User> float

Range: 1  to  65536
*RST: 1

Example: :SENS1:FILT:TYPE USER
Selects user filter mode.
:SENS1:FILT:LENG 16
Sets a filter length of 16. E.g. using a sensor with 20 ms time
window, the resulting measurement time is 640 ms (2x16x20
ms)
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Manual operation: See "Filter Length" on page 243

:SENSe<ch>[:POWer]:FILTer:NSRatio <NSRatio>

Sets an upper limit for the relative noise content in fixed noise filter mode (:
SENSe<ch>[:POWer]:FILTer:TYPE). This value determines the proportion of intrin-
sic noise in the measurement results.

Parameters:
<NSRatio> float

Range: 0.001  to  1
Increment: 0.001
*RST: 0.01

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 548.

Manual operation: See "Noise/Signal Ratio" on page 243

:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe <MTime>

Sets an upper limit for the settling time of the auto-averaging filter in the NSRatio
mode and thus limits the length of the filter. The filter type is set with command :
SENSe<ch>[:POWer]:FILTer:TYPE.

Parameters:
<MTime> float

Range: 1  to  999.99
Increment: 0.01
*RST: 4

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 548.

Manual operation: See "Timeout" on page 244

:SENSe<ch>[:POWer]:FILTer:SONCe

Starts searching the optimum filter length for the current measurement conditions. You
can check the result with command :SENS1:POW:FILT:LENG:USER? in filter mode
USER (:SENSe<ch>[:POWer]:FILTer:TYPE).

Example: SENS1:FILT:TYPE USER
Selects user filter mode.
:SENS1:FILT:SONC
Activates the search for the optimum filter length.
:SENS1:FILT:LENG?
Returns the found optimum filter length.
Response: 128

Usage: Event
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Manual operation: See "Auto Once" on page 243

:SENSe<ch>[:POWer]:FILTer:TYPE <Type>

Selects the filter mode. The filter length is the multiplier for the time window and thus
directly affects the measurement time.

Parameters:
<Type> AUTO | USER | NSRatio

AUTO
Automatically selects the filter length, depending on the mea-
sured value. The higher the power, the shorter the filter length,
and vice versa.
USER
Allows you to set the filter length manually. As the filter-length
takes effect as a multiplier of the measurement time, you can
achieve constant measurement times.
NSRatio
Selects the filter length (averaging factor) according to the crite-
rion that the intrinsic noise of the sensor (2 standard deviations)
does not exceed the specified noise content. You can define the
noise content with command :SENSe<ch>[:POWer]:FILTer:
NSRatio.
Note: To avoid long settling times when the power is low, you
can limit the averaging factor limited with the "timeout" parame-
ter (:SENSe<ch>[:POWer]:FILTer:NSRatio:MTIMe).
*RST: AUTO

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 548.

Manual operation: See "Filter" on page 243

:SENSe<ch>[:POWer]:FREQuency <Frequency>

Sets the RF frequency of the signal, if signal source "USER" is selected (:
SENSe<ch>[:POWer]:SOURce).

Parameters:
<Frequency> float

*RST: 1 GHz

Example: :SENS1:SOUR USER
Selects user-defined source.
:SENS1:FREQ 2.44GHz
Sets the RF frequency of the source which is 2.44 GHz.

Manual operation: See "Frequency" on page 242
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:SENSe<ch>[:POWer]:LOGGing:STATe <State>

Activates the recording of the power values, measured by a connected R&S NRP
power sensor.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: :SENS:LOGG:STAT ON
Activates recording of the power measurement of the first sen-
sor.

Manual operation: See "Enable Logging" on page 244

:SENSe<ch>[:POWer]:OFFSet <Offset>

Sets a level offset which is added to the measured level value after activation with
command :SENSe<ch>[:POWer]:OFFSet:STATe. The level offset allows, e.g. to
consider an attenuator in the signal path.

Parameters:
<Offset> float

Range: -100.0  to  100.0
*RST: 0
Default unit: dB

Example: :SENS1:POW:OFFS 10.0
Sets a level offset of 10 dB

Manual operation: See "Level Offset State,Level Offset" on page 242

:SENSe<ch>[:POWer]:OFFSet:STATe <State>

Activates the addition of the level offset to the measured value. The level offset value is
set with command :SENSe<ch>[:POWer]:OFFSet.

Parameters:
<State> 0 | 1 | OFF | ON

*RST: 0

Example: :SENS1:POW:OFFS 0.4dB
Sets a level offset of 0.4 dB
:SENS1:POW:OFFS:STAT ON
A level offset of 0.4 dB is added to the measured value.

Manual operation: See "Level Offset State,Level Offset" on page 242

:SENSe<ch>[:POWer]:SNUMber?

Queries the serial number of the sensor.
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Return values: 
<SNumber> string

Example: :SENS1:SNUM?
Queries the serial number.

Usage: Query only

Manual operation: See "Sensor type and serial number" on page 241

:SENSe<ch>[:POWer]:SOURce <Source>

Determines the signal to be measured.

Note: When measuring the RF signal, the sensor considers the corresponding correc-
tion factor at that frequency, and uses the level setting of the instrument as reference
level.

Parameters:
<Source> A | USER | RF

*RST: A

Example: See Example "Performing a power measurement with a fixed fil-
ter" on page 548.

Manual operation: See "Use Frequency Of" on page 242

:SENSe<ch>[:POWer]:STATus[:DEVice]?

Queries if a sensor is connected to the instrument.

Return values: 
<Status> 0 | 1 | OFF | ON

*RST: 0

Example: :SENS1:STAT?
Response: 1
A sensor is connected.

Usage: Query only

Manual operation: See "State" on page 241

:SENSe<ch>[:POWer]:SVERsion?

Queries the software version of the connected R&S NRP power sensor.

Return values: 
<SVersion> string

Example: :SENS1:POW:SVER?
Queries the software version of the power sensor.

Usage: Query only
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:SENSe<ch>[:POWer]:TYPE?

Queries the sensor type. The type is automatically detected.

Return values: 
<Type> string

Example: :SENS1:TYPE?
Queries the type of sensor.
Response: NRP-Z21
The R&S NRP-Z21 sensor is used.

Usage: Query only

Manual operation: See "Sensor type and serial number" on page 241

:SENSe<ch>[:POWer]:ZERO

Performs zeroing of the sensor.

Zeroing is required after warm-up, i.e. after connecting the sensor.

Note: Switch off or disconnect the RF power source from the sensor before zeroing.

We recommend that you zero in regular intervals (at least once a day), if:
● The temperature has varied more than about 5 °C.
● The sensor has been replaced.
● You want to measure very low power.

Example: :SENS1:ZERO
Executes zeroing.

Usage: Event

Manual operation: See "Zero" on page 241

14.16  SOURce subsystem

The SOURce subsystem contains the commands for configuring signals.

Common suffixes

The following common suffixes are used in remote commands:

Suffix Value range Description

SOURce<hw> [1] ● SOURce[1] = RF output
(optional keyword)

● LF output = SOURce:LFOutput
(SOURce is optional keyword)
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● Analog modulation subsystems............................................................................ 561
● Avionic standards subsystems..............................................................................592
● SOURce:CORRection subsystem.........................................................................634
● SOURce:FREQuency subsystem......................................................................... 642
● SOURce:INPut subsystem....................................................................................651
● SOURce:LFOutput subsystem..............................................................................652
● SOURce:LIST subsystem..................................................................................... 665
● SOURce:NOISe subsystem..................................................................................677
● SOURce:PGEN subsystem...................................................................................679
● SOURce:PHASe subsystem.................................................................................681
● SOURce:POWer subsystem.................................................................................681
● SOURce:ROSCillator subsystem..........................................................................691
● SOURce:SWEep subsystem.................................................................................697

14.16.1  Analog modulation subsystems

Option: see Chapter 5.1, "Required options", on page 81.

The subsystems in this section describe all commands for analog modulation of the RF
signal. Divided in separate sections, you can configure amplitude modulation (AM), fre-
quency modulation (FM) , phase modulation (PhiM) and pulse modulation (PULM).

You can perform each of the modulations either with an internally generated modula-
tion signal or with an externally applied signal.

To configure the internal signal, use the commands listed in Chapter 14.16.6,
"SOURce:LFOutput subsystem", on page 652.

For more information:

See Chapter 5, "Analog modulations", on page 81.

14.16.1.1  SOURce:MODulation subsystem

The command in this subsytem allows you to disable all active modulations at once,
and, vice versa, to restore the last active ones.

[:SOURce<hw>]:MODulation[:ALL][:STATe] <State>

Activates all modulations that were active before the last switching off.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
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Example: SOURce1:AM1:DEPTh 30
SOURce1:AM1:SOURce LF1
SOURce1:AM1:STATe 1
SOURce1:FM1:DEViation 1000
SOURce1:FM1:STATe 1
// disable both modulation
SOURce1:MODulation:ALL:STATe 0
SOURce1:AM1:STATe?
// 0
SOURce1:FM1:STATe?
// 0
// enable both modulation
SOURce1:MODulation:ALL:STATe 1
SOURce1:AM1:STATe?
// 1
SOURce1:FM1:STATe?
// 1

Manual operation: See "[Mod on/off]" on page 84

14.16.1.2  SOURce:AM subsystem

Option: R&S SMAB-K720

The AM subsystem contains the commands for setting the amplitude modulation and
also the broadband amplitude modulation.

The following examples show some variants for generating AM signals.

Example: Creating an amplitude modulated RF signal
Using the internal LF generator, the following command sequence configures an ampli-
tude modulated signal.

// Reset the instrument to start from a defined state
*RST

// Set RF frequency and amplitude
SOURce1:FREQuency:CW 6000000000
SOURce1:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the modulation signal
SOURce1:LFOutput1:SHAPe SINE
SOURce1:LFOutput1:FREQuency 20000

// Configure the amplitude modulation settings and switch AM on 
SOURce1:AM1:SOURce LF1
SOURce1:AM1:DEPTh 30
SOURce1:AM:RATio 40
SOURce1:AM1:DEViation:MODe UNC
SOURce1:AM1:STATe 1
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Example: Using combined LF signals
Using the internal LF generators of both paths, the following command sequences con-
figure an amplitude modulated signal with determined deviations depths.

// Configure the AM modulation settings with combined LF signal sources
SOURce1:AM1:SOURce LF1
SOURce1:AM1:DEPTh:LINear 32
// Select the modulation signal source for the second path
SOURce1:AM2:SOURce LF2
// Combine the signals of both paths with fixed total deviation depth
SOURce1:AM1:DEViation:MODe TOT
SOURce1:AM1:DEPTh:SUM 60

// Query the deviation depth of modulation signal in the second path
SOURce1:AM2:DEPTh:LINear?
// Response:  28

// Combine the signals of both paths with fixed ratio
SOURce1:AM1:DEViation:MODe RAT
SOURce1:AM1:RATio 100
SOURce1:AM2:DEPTh:LINear 25

// Query the deviation depth of modulation signal in the first path
SOURce1:AM1:DEPTh:LINear?
// Response:  25

SOURce1:AM1:STATe 1
SOURce1:AM2:STATe 1

Example: Using an external signal source
Using an external signal source, you can additionally determine whether you want to
use only the AC component of the external modulation signal.

// Reset the instrument to start from a defined state
*RST

// Set frequency and amplitude
SOURce1:FREQuency:CW 6000000000
SOURce1:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the amplitude modulation settings and turn on AM
SOURce1:AM1:SOURce EXT1
SOURce1:AM1:DEPTh 40

// Query the input sensitivity at the external modulation input
SOURCe1:AM1:SENSitivity?
// Response:  40
// Since the voltage value for full modulation is 1V, 
// the resulting sensitivity is precisely 50%/V. 
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// This value is assigned to the voltage value for full
// modulation of the input.

// Select the coupling mode AC for external amplitude modulation
SOURce1:INPut:MODext:COUPling1 AC

// For external AM signal input, adjust the sensitivity
SOURce1:AM1:TYPE EXP
SOURce1:AM1:SOURce EXT1
SOURce1:AM1:SENSitivity 25
SOURce1:AM1:SENSitivity?
Response: 25

// Alternatively use the scan mode for the level behavior of rotating antennas
// SCAN automatically sets the modulation type to exponential
SOURce1:AM1:MODE SCAN
SOURce1:AM1:SOURce EXT2
SOURce1:AM1:DEPTh:EXPonential 12
SOURce1:AM1:DEPTh:EXPonential?
Response: 12

// Activating the external exponential AM changes the coupling
// in this example for EXT2
INPut:MODext:COUPling2 DC

// Configure the modulation settings

// Switch on AM and RF signal output
SOURce1:AM1:STATe 1
OUTPut1:STATe 1

The following commands are available:

[:SOURce<hw>]:AM<ch>:STATe......................................................................................564
[:SOURce<hw>]:AM<ch>:SOURce.................................................................................. 565
[:SOURce<hw>]:AM<ch>[:DEPTh]...................................................................................565
[:SOURce<hw>]:AM<ch>:DEPTh:LINear..........................................................................565
[:SOURce<hw>]:AM<ch>:DEPTh:EXPonential..................................................................566
[:SOURce<hw>]:AM:MODE............................................................................................ 566
[:SOURce<hw>]:AM:DEPTh:SUM....................................................................................566
[:SOURce<hw>]:AM:DEViation:MODE............................................................................. 567
[:SOURce<hw>]:AM:RATio..............................................................................................567
[:SOURce<hw>]:AM<ch>:SENSitivity:EXPonential............................................................ 567
[:SOURce<hw>]:AM<ch>:SENSitivity[:LINear]...................................................................568
[:SOURce<hw>]:AM:TYPE..............................................................................................568

[:SOURce<hw>]:AM<ch>:STATe <State>

Activates amplitude modulation.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Creating an amplitude modulated RF signal"
on page 562.

Manual operation: See "State" on page 87

[:SOURce<hw>]:AM<ch>:SOURce <Source>

Selects the modulation source for amplitude modulation.

Parameters:
<Source> LF1 | LF2 | NOISe | EXT1 | EXT2 | EXTernal | INTernal

LF1|LF2
Uses an internally generated LF signal.
EXT1|EXT2
Uses an externally supplied LF signal.
NOISe
Uses the internally generated noise signal.
INTernal
Uses the internally generated signal of LF1.
EXTernal
Uses an external LF signal (EXT1).
*RST: LF1 <AM1>; LF2 <AM2>

Example: See Example "Creating an amplitude modulated RF signal"
on page 562.

Manual operation: See "Source" on page 87

[:SOURce<hw>]:AM<ch>[:DEPTh] <Depth>

Sets the depth of the amplitude modulation in percent.

Suffix: 
<ch>

.
1..2
Modulation signal channel

Parameters:
<Depth> float

Range: 0  to  100

Example: See Example "Creating an amplitude modulated RF signal"
on page 562.

[:SOURce<hw>]:AM<ch>:DEPTh:LINear <DepthLin>

Sets the depth of the linear amplitude modulation in percent / volt.
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Parameters:
<DepthLin> float

Range: 0  to  100
Increment: 0.1
*RST: 30

Example: See Example "Creating an amplitude modulated RF signal"
on page 562. Similar to DEPTh.

Manual operation: See "Depth" on page 92

[:SOURce<hw>]:AM<ch>:DEPTh:EXPonential <DepthExp>

Sets the depth of the exponential amplitude modulation in dB/volt.

Parameters:
<DepthExp> float

Range: 0  to  100
Increment: 0.01
*RST: 10

Example: See Example "Creating an amplitude modulated RF signal"
on page 562. Similar to DEPTh.

Manual operation: See "Depth" on page 92

[:SOURce<hw>]:AM:MODE <AmMode>

Selects the mode of the amplitude modulation.

[:SOURce<hw>]:AM:MODE > SCAN sets [:SOURce<hw>]:AM:TYPE > EXPonen 
tial.

For active external exponential AM, automatically sets [:SOURce<hw>]:INPut:
MODext:COUPling<ch> > DC.

Parameters:
<AmMode> SCAN | NORMal

*RST: NORMal

Example: See Example "Using an external signal source" on page 563.

Options: R&S SMAB-K721

Manual operation: See " Mode" on page 91

[:SOURce<hw>]:AM:DEPTh:SUM <AmDepthSum>

Sets the total depth of the LF signal when using combined signal sources in amplitude
modulation.
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Parameters:
<AmDepthSum> float

Range: 0  to  100
Increment: 0.1
*RST: 30

Example: See Example "Using combined LF signals" on page 563.

Manual operation: See " Total Depth" on page 92

[:SOURce<hw>]:AM:DEViation:MODE <AmDevMode>

Selects the coupling mode. The coupling mode parameter also determines the mode
for fixing the total depth.

Parameters:
<AmDevMode> UNCoupled | TOTal | RATio

UNCoupled
Does not couple the LF signals.
The deviation depth values of both paths are independent.
TOTal
Couples the deviation depth of both paths.
RATio
Couples the deviation depth ratio of both paths
*RST: UNCoupled

Example: See Example "Using combined LF signals" on page 563.

Manual operation: See " Deviation Mode" on page 92

[:SOURce<hw>]:AM:RATio <Ratio>

Sets the deviation ratio (path#2 to path#1) in percent.

Parameters:
<Ratio> float

Range: 0  to  100
Increment: 0.1
*RST: 100

Example: See Example "Creating an amplitude modulated RF signal"
on page 562.

Manual operation: See " Ratio Path2/Path1" on page 93

[:SOURce<hw>]:AM<ch>:SENSitivity:EXPonential <Sensitivity>

For [:SOURce<hw>]:AM:TYPEEXP, sets the sensitivity of the external signal source
for amplitude modulation.
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Parameters:
<Sensitivity> float

Range: 0  to  100
Increment: 0.01
*RST: 10

Example: See Example "Using an external signal source" on page 563.

Manual operation: See "Sensitivity" on page 92

[:SOURce<hw>]:AM<ch>:SENSitivity[:LINear] <Sensitivity>

For [:SOURce<hw>]:AM:TYPE LIN, sets the sensitivity of the external signal source
for amplitude modulation.

Parameters:
<Sensitivity> float

Range: 0  to  100
Increment: 0.1
*RST: 30

Example: See Example "Using an external signal source" on page 563.

Manual operation: See "Sensitivity" on page 92

[:SOURce<hw>]:AM:TYPE <AmType>

Selects the type of amplitude modulation.

For [:SOURce<hw>]:AM:MODE SCAN, only EXPonential is available.

For active external exponential AM, automatically sets [:SOURce<hw>]:INPut:
MODext:COUPling<ch>DC.

Parameters:
<AmType> LINear | EXPonential

*RST: LINear

Example: See Example "Using an external signal source" on page 563.

Options: R&S SMAB-K721

Manual operation: See "Type" on page 91

14.16.1.3  SOURce:CHIRp subsystem

Option: see Chapter 5.1, "Required options", on page 81.

With the commands described in this section, you can configure the settings for chirp
modulation, select the trigger mode and determine the parameters for an external
pulse / trigger signal.

The following examples show some variants for generating the modulation chirp.
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Example: Perform chirp modulation
Using the internal pulse generator, the following command sequence configures a chirp
modulated RF signal.
// Reset the instrument to start from an initial state
*RST; *CLS

// Set the RF signal frequency and level
SOURce:FREQuency:CW 4000000000
SOURce:POWer:POWer: -25

// Configure the chirp modulation settings
// set the pulse parameters and the trigger mode
// query the commpression ratio
// activat RF signal output

// Trigger a continuous chirp modulated signal
SOURce:CHIRp:TRIGger:MODE AUTO
SOURce:CHIRp:DIRection UP
SOURce:CHIRp:PULSe:PERiod 0.00001
SOURce:CHIRp:PULSE:WIDTh 0.000008
SOURce:CHIRp:BANDwidth 2000
SOURce:CHIRp:COMPression:RATio?
// Response: 0.01
SOURce:CHIRp:STATe 1
OUTPut1:STATe 1

// Trigger a single chirp modulation signal 
SOURce:CHIRp:TRIGger:MODE SING
SOURce:CHIRp:DIRection DOWN
SOURce:CHIRp:PULSe:PERiod 0.00002
SOURce:CHIRp:PULSE:WIDTh 0.000002
SOURce:CHIRp:BANDwidth 5000 
SOURce:CHIRp:STATe 1
SOURce:CHIRp:TRIGger:IMMediate

// Alternatively configure the chirp modulation settings 
// using an external pulse signal.
// Select the trigger mode, set the polarity of the external signal,
// select the impedance of the external pulse signal input
SOURce:CHIRp:TRIGger:MODE EXT
SOURce:CHIRp:TRIGger:EXTernal:POLarity NORMal
SOURce:CHIRp:TRIGger:EXTernal:IMPEDance G10K
SOURce:CHIRp:STATe 1

The following commands are available:

[:SOURce<hw>]:CHIRp:BANDwidth.................................................................................570
[:SOURce<hw>]:CHIRp:COMPression:RATio?..................................................................570
[:SOURce<hw>]:CHIRp:DIRection................................................................................... 570
[:SOURce<hw>]:CHIRp:PULSe:PERiod........................................................................... 570
[:SOURce<hw>]:CHIRp:PULSe:WIDTh............................................................................ 571
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[:SOURce<hw>]:CHIRp:STATe........................................................................................ 571
[:SOURce<hw>]:CHIRp:TRIGger:IMMediate.....................................................................571
[:SOURce<hw>]:CHIRp:TRIGger:MODE.......................................................................... 571

[:SOURce<hw>]:CHIRp:BANDwidth <Bandwidth>

Sets the modulation bandwidth of the chirp modulated signal.

Parameters:
<Bandwidth> float

Range: 0  to  Depends on hardware variant
Increment: 0.01
*RST: 1E3

Example: See Example "Perform chirp modulation" on page 569.

Manual operation: See "Bandwidth" on page 96

[:SOURce<hw>]:CHIRp:COMPression:RATio?

Queries the pulse compression ratio (= product of pulse width (s) and bandwidth (Hz)).

Return values: 
<Ratio> float

Range: 0  to  80E6
Increment: 0.01

Example: See Example "Perform chirp modulation" on page 569.

Usage: Query only

Manual operation: See "Compression Ratio" on page 97

[:SOURce<hw>]:CHIRp:DIRection <Direction>

Selects the direction of the chirp modulation.

Parameters:
<Direction> DOWN | UP

*RST: UP

Example: See Example "Perform chirp modulation" on page 569.

Manual operation: See "Direction" on page 95

[:SOURce<hw>]:CHIRp:PULSe:PERiod <Period>

Sets the period of the generated modulation chirp. The period determines the repetition
frequency of the internal signal.

SOURce subsystem



Remote control commandsR&S®SMA100B

571User Manual 1178.3834.02 ─ 09

Parameters:
<Period> float

Range: 5E-6 (2E-7 with K23)  to  100
Increment: 1E-6
*RST: 10E-6

Example: See Example "Perform chirp modulation" on page 569.

Manual operation: See "Pulse Period" on page 96

[:SOURce<hw>]:CHIRp:PULSe:WIDTh <Width>

Sets the width of the generated pulse. The pulse width must be at least 1us less than
the set pulse period.

Parameters:
<Width> float

Range: 2E-6 (1E-7 with K23)  to  100
Increment: 1E-6
*RST: 2E-6

Example: See Example "Perform chirp modulation" on page 569.

Manual operation: See "Pulse Width" on page 97

[:SOURce<hw>]:CHIRp:STATe <State>

Activates the generation of a chirp modulation signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Perform chirp modulation" on page 569.

Manual operation: See "State" on page 95

[:SOURce<hw>]:CHIRp:TRIGger:IMMediate

Immediately starts the chirp signal generation.

Example: See Example "Perform chirp modulation" on page 569.

Usage: Event

Manual operation: See "Execute Single Trigger" on page 97

[:SOURce<hw>]:CHIRp:TRIGger:MODE <Mode>

Selects the trigger mode for the chirp modulation signal.
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Parameters:
<Mode> AUTO | EXTernal | EGATe | SINGle | ESINgle

*RST: AUTO

Example: See Example "Perform chirp modulation" on page 569.

Manual operation: See "Trigger Mode" on page 97

14.16.1.4  SOURce:FM subsystem

Option: R&S SMAB-K720

The FM subsystem contains the commands for setting the frequency modulation.

Example: Creating a frequency modulated RF signal
Using the internal LF generator, the following command sequence configures a fre-
quency modulated signal.

// Reset the instrument to start from a defined state
*RST

// Set RF frequency and amplitude
SOURce1:FREQuency:CW 6000000000
SOURce1:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the modulation signal
SOURce1:LFOutput1:SHAPe SINE
SOURce1:LFOutput1:FREQuency 20000

// Configure the frequency modulation settings and switch FM on 
SOURce1:FM1:SOURce LF1
SOURce1:FM1:DEViation 1000
SOURce1:FM:RATio 40
SOURce1:FM:MODe LNOise
SOURce1:FM1:STATe 1

// Switch on LF and RF signal output
SOURce1:LFOutput1:STATe 1
OUTPut1:STATe 1 

Example: Using combined LF signals
Using the internal LF generators of both paths, the following command sequences con-
figure a frequency modulated signal with determined deviations.

// Configure the FM modulation settings with combined LF signal sources
SOURce1:FM1:SOURce LF1
SOURce1:FM1:DEViation 1000
// Select the modulation signal source for the second path
SOURce1:FM2:SOURce LF2
// Combine the signals of both paths with fixed total deviation depth
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SOURce1:FM1:DEViation:MODe TOT
SOURce1:FM1:DEViation:SUM 5000

// Query the deviation depth of modulation signal in the second path
SOURce1:FM2:DEViation?
// Response:  4000

// Combine the signals of both paths with fixed ratio
SOURce1:FM1:DEViation:MODe RAT
SOURce1:FM1:RATio 100
SOURce1:FM2:DEVIation 10000

// Query the deviation depth of modulation signal in the first path
SOURce1:AM1:DEViation?
// Response:  1000

SOURce1:FM1:STATe 1
SOURce1:FM2:STATe 1

Example: Using an external signal source
Alternatively configure the frequency modulation settings with an external modulation
signal.

// Reset the instrument to start from a defined state
*RST

// Set RF frequency and amplitude
SOURce1:FREQuency:CW 6000000000
SOURce1:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the frequency modulation settings and switch FM on 
SOURce1:FM1:SOURce EXT1
SOURce1:FM1:DEViation 5000

// Query the input sensitivity at the external modulation input
:SOURCe1:FM1:SENSitivity?
// Response:  1000
// since the voltage value for full modulation is 1V, 
// the resulting sensitivity is precisely 5000 Hz/V.

// Switch on FM and RF signal output
SOURce1:FM1:STATe 1
OUTPut1:STATe 1

The following commands are available:

[:SOURce<hw>]:FM<ch>:STATe......................................................................................574
[:SOURce<hw>]:FM<ch>[:DEViation]............................................................................... 574
[:SOURce<hw>]:FM<ch>:SOURce.................................................................................. 574
[:SOURce<hw>]:FM:DEViation:MODE............................................................................. 575
[:SOURce<hw>]:FM:DEViation:SUM................................................................................575
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[:SOURce<hw>]:FM:RATio..............................................................................................576
[:SOURce<hw>]:FM:MODE.............................................................................................576
[:SOURce<hw>]:FM:SENSitivity?.....................................................................................576

[:SOURce<hw>]:FM<ch>:STATe <State>

Activates frequency modulation.

Suffix: 
FM<ch>

.
1..2
determines the modulation signal channel.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Creating a frequency modulated RF signal"
on page 572.

Manual operation: See "State" on page 87

[:SOURce<hw>]:FM<ch>[:DEViation] <Deviation>

Sets the modulation deviation of the frequency modulation in Hz.

Suffix: 
FM<ch>

.
1|2
Modulation signal channel

Parameters:
<Deviation> float

The maximum deviation depends on the RF frequency and the
selected modulation mode (see data sheet).
Range: 0  to  max
Increment: 0.01
*RST: 1E3

Example: See Example "Creating a frequency modulated RF signal"
on page 572.

Manual operation: See " Deviation" on page 88

[:SOURce<hw>]:FM<ch>:SOURce <Source>

Selects the modulation source for frequency modulation.

Suffix: 
FM<ch>

.
1|2
Modulation signal channel.

Parameters:
<Source> LF1 | LF2 | NOISe | EXT1 | INTernal | EXTernal | EXT2
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LF1|LF2
Uses an internally generated LF signal.
INTernal = LF1
Works like LF1
EXTernal
Works like EXT1
EXT1|EXT2
Uses an externally supplied LF signal.
NOISe
Uses the internally generated noise signal.
*RST: LF1 <FM1>; LF2 <FM2>

Example: See Example "Creating a frequency modulated RF signal"
on page 572.

Manual operation: See "Source" on page 87

[:SOURce<hw>]:FM:DEViation:MODE <FmDevMode>

Selects the coupling mode. The coupling mode parameter also determines the mode
for fixing the total deviation.

Parameters:
<FmDevMode> UNCoupled | TOTal | RATio

UNCoupled
Does not couple the LF signals.
The deviation values of both paths are independent.
TOTal
Couples the deviation of both paths.
RATio
Couples the deviation ratio of both paths
*RST: UNCoupled

Example: See Example "Using combined LF signals" on page 572.

Manual operation: See " Deviation Mode" on page 88

[:SOURce<hw>]:FM:DEViation:SUM <FmDevSum>

Sets the total deviation of the LF signal when using combined signal sources in fre-
quency modulation.

Parameters:
<FmDevSum> float

Range: 0  to  40E6
Increment: 0.01
*RST: 1E3

Example: See Example "Using combined LF signals" on page 572.
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Manual operation: See " Total Deviation" on page 88

[:SOURce<hw>]:FM:RATio <Ratio>

Sets the deviation ratio (path2 to path1) in percent.

Parameters:
<Ratio> float

Range: 0  to  100
Increment: 0.1
*RST: 100

Example: See Example "Creating a frequency modulated RF signal"
on page 572.

Manual operation: See " Ratio Path2/Path1" on page 88

[:SOURce<hw>]:FM:MODE <Mode>

Selects the mode for the frequency modulation.

Parameters:
<Mode> HBANdwidth | LNOise

HBANdwidth
Selects maximum range for modulation bandwidth.
LNOise
Selects optimized phase noise and spurious characteristics with
reduced modulation bandwidth and FM deviation.
*RST: HBANdwidth

Example: See Example "Creating a frequency modulated RF signal"
on page 572.

Manual operation: See "Mode" on page 89

[:SOURce<hw>]:FM:SENSitivity?

Queries the sensitivity of the externally supplied signal for frequency modulation. The
sensitivity depends on the set modulation deviation.

Return values: 
<Sensitivity> float

Sensitivity in Hz/V.
It is assigned to the voltage value for full modulation of the input.
Range: 0  to  max
Increment: 0.01

Example: See Example "Using an external signal source" on page 573.

Usage: Query only
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14.16.1.5  SOURce:PM subsystem

Option: R&S SMAB-K720

The PM subsystem contains the commands for setting the phase modulation. You can
configure the internal modulation source (LF generator) with the commands listed in
Chapter 14.16.6, "SOURce:LFOutput subsystem", on page 652 .

Example: Performing phase modulation
The following example shows a command sequence to perform phase modulation.

// Reset the instrument to start from an initial state
*RST; *CLS

// Set the RF signal frequency and level
SOURce:FREQuency:CW 4000000000
SOURce:POWer:LEVel:IMMediate:AMPLitude -25

// Configure the phase modulation settings
SOURce1:LFOutput1:SHAPe SINE
SOURce1:LFOutput1:FREQuency 1000

// Select the LF signal generated by the internal modulation generator
// or the internally generated noise signal
SOURce1:PM1:DEViation 1
SOURce1:PM1:SOURce LF1
// SOURce1:PM1:SOURce INTernal
// SOURce1:PM1:SOURce NOISe
SOURce1:PM1:RATio 40
SOURce1:PM1:MODE HBAN

// Alternatively configure the phase modulation settings for an 
// external modulation source and query the input sensitivity.
SOURce1:PM1:SOURce EXT1
// SOURce1:PM1:SOURce EXTernal
SOURce1:PM1:DEViation 1
SOURce1:PM1:SENSitivity?
// Response: 1 
// since the voltage value for full modulation is 1V, 
// the resulting sensitivity is precisely 1RAD/V. 

// Activate the signal output
SOURce1:PM1:STATe 1
OUTPut1:STATe 1

Example: Using combined LF signals
Using the internal LF generators of both paths, the following command sequences con-
figure an phase modulated signal with determined deviations.

SOURce subsystem



Remote control commandsR&S®SMA100B

578User Manual 1178.3834.02 ─ 09

// Configure the Phase modulation settings with combined LF signal sources
SOURce1:PM1:SOURce LF1
SOURce1:PM1:DEViation 1.5
// Select the modulation signal source for the second path
SOURce1:PM2:SOURce LF2
// Combine the signals of both paths with fixed total deviation depth
SOURce1:PM1:DEViation:MODe TOT
SOURce1:PM1:DEViation:SUM 2

// Query the deviation depth of the modulation signal in the second path
SOURce1:PM2:DEViation?
// Response:  0.5

// Combine the signals of both paths with fixed ratio
SOURce1:PM1:DEViation:MODe RAT
SOURce1:PM1:RATio 80
SOURce1:PM2:DEViation?
// Response:  1.2

// Query the deviation depth of modulation signal in the first path
SOURce1:PM1:DEViation?
// Response:  1.5

SOURce1:FM1:STATe 1
SOURce1:FM2:STATe 1

The following commands are available:

[:SOURce<hw>]:PM<ch>:STATe......................................................................................578
[:SOURce<hw>]:PM<ch>:SOURce.................................................................................. 579
[:SOURce<hw>]:PM:MODE............................................................................................ 579
[:SOURce<hw>]:PM:DEViation:MODE............................................................................. 580
[:SOURce<hw>]:PM:DEViation:SUM................................................................................580
[:SOURce<hw>]:PM:RATio..............................................................................................580
[:SOURce<hw>]:PM:SENSitivity?.................................................................................... 580
[:SOURce]:PM<ch>[:DEViation].......................................................................................581

[:SOURce<hw>]:PM<ch>:STATe <State>

Activates phase modulation.

Activation of phase modulation deactivates frequency modulation.

Suffix: 
PM<ch>

.
1|2
Sets the modulation signal channel.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Performing phase modulation" on page 577.
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Manual operation: See "State" on page 87

[:SOURce<hw>]:PM<ch>:SOURce <Source>

Selects the modulation source for phase modulation signal.

Suffix: 
PM<ch>

.
1|2
Sets the modulation signal channel.

Parameters:
<Source> LF1 | LF2 | NOISe | EXT1 | EXT2 | INTernal | EXTernal

LF1|LF2
Uses an internally generated LF signal.
EXT1|EXT2
Uses an externally supplied LF signal.
NOISe
Uses the internally generated noise signal.
INTernal
Uses the internally generated signal of LF1.
EXTernal
Uses an external LF signal (EXT1).
*RST: LF1 <PM1>; LF2 <PM2>

Example: See Example "Performing phase modulation" on page 577.

Manual operation: See "Source" on page 87

[:SOURce<hw>]:PM:MODE <Mode>

Selects the mode for the phase modulation.

Parameters:
<Mode> HBANdwidth | HDEViation | LNOise

HBANdwidth
Sets the maximum available bandwidth.
HDEViation
Sets the maximum range for ΦM deviation.
LNOise
Selects a phase modulation mode with phase noise and spuri-
ous characteristics close to CW mode.
*RST: HBANdwidth

Example: See Example "Performing phase modulation" on page 577.

Manual operation: See "Mode" on page 90
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[:SOURce<hw>]:PM:DEViation:MODE <PmDevMode>

Selects the coupling mode. The coupling mode parameter also determines the mode
for fixing the total deviation.

Parameters:
<PmDevMode> UNCoupled | TOTal | RATio

UNCoupled
Does not couple the LF signals.
The deviation values of both paths are independent.
TOTal
Couples the deviation of both paths.
RATio
Couples the deviation ratio of both paths
*RST: UNCoupled

Example: See Example "Using combined LF signals" on page 577

Manual operation: See " Deviation Mode" on page 89

[:SOURce<hw>]:PM:DEViation:SUM <PmDevSum>

Sets the total deviation of the LF signal when using combined signal sources in phase
modulation.

Parameters:
<PmDevSum> float

Range: 0  to  20
Increment: 1E-6
*RST: 1

Example: See Example "Using combined LF signals" on page 577

Manual operation: See " Total Deviation" on page 90

[:SOURce<hw>]:PM:RATio <Ratio>

Sets the deviation ratio (path2 to path1) in percent.

Parameters:
<Ratio> float

Range: 0  to  100
Increment: 0.01
*RST: 100

Example: See Example "Performing phase modulation" on page 577.

Manual operation: See " Ratio Path2/Path1" on page 90

[:SOURce<hw>]:PM:SENSitivity?

Queries the sensitivity of the externally applied signal for phase modulation.

SOURce subsystem



Remote control commandsR&S®SMA100B

581User Manual 1178.3834.02 ─ 09

The returned value reports the sensitivity in RAD/V. It is assigned to the voltage value
for full modulation of the input.

Return values: 
<Sensitivity> float

Example: See Example "Performing phase modulation" on page 577.

Usage: Query only

[:SOURce]:PM<ch>[:DEViation] <Deviation>

Sets the modulation deviation of the phase modulation in RAD.

Parameters:
<Deviation> float

The maximal deviation depends on the RF frequency and the
selected modulation mode (see data sheet).
Range: 0  to  max
Increment: 1
*RST: 1
Default unit: RAD

Example: See Example "Performing phase modulation" on page 577.

Manual operation: See "Deviation" on page 89

14.16.1.6  SOURce:PULM subsystem

Option: see Chapter 5.1, "Required options", on page 81.

The PULM subsystem contains the commands for setting the pulse modulation.

● Pulse modulation settings..................................................................................... 581
● Pulse train settings................................................................................................587
● Pulse train data exchange.....................................................................................589

Pulse modulation settings

With the commands described in this section, you can configure the settings for pulse
modulation, select the trigger mode and determine delay times for the pulse modula-
tion signal.

Example: Perform pulse modulation
The example shows a command sequence to perform pulse modulation.

// Reset the instrument to start from an initial state
*RST; *CLS

// Set the RF signal frequency and level
SOURce:FREQuency:CW 4000000000
SOURce:POWer:LEVel:IMMediate:AMPLitude -25
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// Configure the pulse modulation settings
// Select the internal modulation generator,
// set trigger mode, select pulse mode, transition type

// Trigger a single pulse

SOURce:PULM:SOURce INT
SOURce:PULM:TRIGger:MODE SING
SOURce:PULM:MODE DOUB 
SOURce:PULM:TTYPe SMO

SOURce:PULM:TRIG:IMM

// Alternatively configure the pulse modulation settings for 
// external modulation source
// Select the source, set the polarity of the external signal,
// select the impedance for the external pulse modulation input/
// for the external pulse modulation trigger input
SOURce:PULM:SOURce EXT
SOURce:PULM:POLarity NORMal
SOURce:PULM:IMPedance G1K

// Configure the pulse generator settings
// Set pulse period, width, and delay
SOURce:PULM:PERiod 10 us
SOURce:PULM:WIDth 8 us
SOURce:PULM:DOUBle:WIDTh 0.0000012
SOURce:PULM:DOUBle:DELay 0.0000045

// Activate the signal output
SOURce:PGENerator:OUTPut:STATe 1
SOURce:PULM:STATe 1
OUTPut1:STATe 1

The following commands are available:

[:SOURce<hw>]:PULM:MODE........................................................................................ 583
[:SOURce<hw>]:PULM:TRIGger:MODE........................................................................... 583
[:SOURce]:PULM[:INTernal][:TRAin]:TRIGger:IMMediate................................................... 583
[:SOURce<hw>]:PULM:PERiod....................................................................................... 583
[:SOURce<hw>]:PULM:WIDTh........................................................................................584
[:SOURce<hw>]:PULM:DELay........................................................................................ 584
[:SOURce<hw>]:PULM:DOUBle:DELay............................................................................584
[:SOURce<hw>]:PULM:DOUBle:WIDTh........................................................................... 585
[:SOURce<hw>]:PULM:DOUBle:STATe............................................................................ 585
[:SOURce<hw>]:PULM:STATe.........................................................................................585
[:SOURce<hw>]:PULM:SOURce..................................................................................... 585
[:SOURce<hw>]:PULM:TTYPe........................................................................................585
[:SOURce<hw>]:PULM:POLarity..................................................................................... 586
[:SOURce<hw>]:PULM:IMPedance..................................................................................586
[:SOURce<hw>]:PULM:THReshold..................................................................................586
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[:SOURce<hw>]:PULM:MODE <Mode>

Selects the mode for the pulse modulation.

Parameters:
<Mode> SINGle | DOUBle | PTRain

SINGle
Generates a single pulse.
DOUBle
Generates two pulses within one pulse period.
PTRain
Generates a user-defined pulse train.
Specify the pulse sequence with the commands:
[:SOURce<hw>]:PULM:TRAin:ONTime
[:SOURce<hw>]:PULM:TRAin:OFFTime
[:SOURce<hw>]:PULM:TRAin:REPetition
*RST: SINGle

Example: See Example "Perform pulse modulation" on page 581.

Options: PTRain requires R&S SMAB-K27

Manual operation: See "Pulse Mode" on page 100

[:SOURce<hw>]:PULM:TRIGger:MODE <Mode>

Selects a trigger mode - auto, single, external, external single or external gated - for
generating the modulation signal.

Parameters:
<Mode> AUTO | EXTernal | EGATe | SINGle | ESINgle

*RST: AUTO

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Trigger Mode" on page 101

[:SOURce]:PULM[:INTernal][:TRAin]:TRIGger:IMMediate

If [:SOURce<hw>]:PULM:TRIGger:MODESINGle, triggers the pulse generator.

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Execute Single Trigger" on page 104

[:SOURce<hw>]:PULM:PERiod <Period>

Sets the period of the generated pulse, that means the repetition frequency of the inter-
nally generated modulation signal.
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Parameters:
<Period> float

The minimum value depends on the installed options
R&S SMAB-K22 or R&S SMAB-K23
Range: 20E-9  to  100
Increment: 5E-9
*RST: 10E-6

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Pulse Period" on page 103

[:SOURce<hw>]:PULM:WIDTh <Width>

Sets the width of the generated pulse, that means the pulse length. It must be at least
20ns less than the set pulse period.

Parameters:
<Width> float

Range: 20E-9  to  100
Increment: 10E-9
*RST: 2E-6

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Pulse Width" on page 103

[:SOURce<hw>]:PULM:DELay <Delay>

Sets the pulse delay.

Parameters:
<Delay> float

*RST: 1ms

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Pulse Delay" on page 104

[:SOURce<hw>]:PULM:DOUBle:DELay <Delay>

Sets the delay from the start of the first pulse to the start of the second pulse.

Parameters:
<Delay> float

*RST: 1E-6

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Double Pulse Delay" on page 104
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[:SOURce<hw>]:PULM:DOUBle:WIDTh <Width>

Sets the width of the second pulse.

Parameters:
<Width> float

Increment: 5E-9

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Double Pulse Width" on page 104

[:SOURce<hw>]:PULM:DOUBle:STATe <State>

Provided for backward compatibility with former Rohde & Schwarz signal generators.

Works like the command [:SOURce<hw>]:PULM:MODEDOUBle.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

[:SOURce<hw>]:PULM:STATe <State>

Activates pulse modulation.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "State" on page 85

[:SOURce<hw>]:PULM:SOURce <Source>

Selects between the internal (pulse generator) or an external pulse signal for the mod-
ulation.

Parameters:
<Source> INTernal | EXTernal

*RST: INTernal

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Source" on page 85

[:SOURce<hw>]:PULM:TTYPe <Source>

Sets the transition mode for the pulse signal.

Parameters:
<Source> SMOothed | FAST
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SMOothed
flattens the slew rate, resulting in longer rise/fall times.
FAST
enables fast transitions with shortest rise and fall times.
*RST: FAST

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Transition Type" on page 86

[:SOURce<hw>]:PULM:POLarity <Polarity>

Sets the polarity of the externally applied modulation signal.

Parameters:
<Polarity> NORMal | INVerted

NORMal
Suppresses the RF signal during the pulse pause.
INVerted
Suppresses the RF signal during the pulse.
*RST: NORMal

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Polarity" on page 112

[:SOURce<hw>]:PULM:IMPedance <Impedance>

Sets the impedance for the external pulse trigger and pulse modulation input.

Parameters:
<Impedance> G50 | G10K

*RST: G10K

Example: See Example "Perform pulse modulation" on page 581.

Manual operation: See "Impedance" on page 112

[:SOURce<hw>]:PULM:THReshold <Threshold>

Sets the threshold for the input signal at the [Pulse Ext] connector.

Parameters:
<Threshold> float

Range: 0  to  2
Increment: 0.1
*RST: 1
Default unit: V

Example: SOURce:PULM:THReshold 1

Manual operation: See "Threshold" on page 112

SOURce subsystem



Remote control commandsR&S®SMA100B

587User Manual 1178.3834.02 ─ 09

Pulse train settings

Option: R&S SMAB-K27

This section describes the commands for the pulse train modulation and the associ-
ated file handling. For background information, see Chapter 5.4.4.2, "Pulse generator >
pulse train settings", on page 104.

Example: Generating a pulse train signal
The following settings are required to perform pulse train modulation.

Always create and select pulse train data list first before you activate the pulse train
mode.
Otherwise, an error is displayed

*RST; *CLS

// Set the RF signal frequency and level
SOURce:FREQuency:CW 4000000000
SOURce:POWer:LEVel:IMMediate:AMPLitude -25

// Create a pulse train data list
// Select the directory
MMEM:CDIR '/var/user/'
SOURce1:PULM:TRAin:CATalog?
// my_pt
// Create and7or select the pulse train data file
SOURce1:PULM:TRAin:SELect "/var/user/pt"
// Enter the pulse train data
SOURCe:PULM:TRAin:ONTime 0.0001,0.00025,0.0001
SOURCe:PULM:TRAin:OFFTime 500us,500us,300us
SOURCe:PULM:TRAin:REPetition 2,0,3
// the second pulse is ignored

// Select pulse train mode
// Select the internal modulation generator and the pulse mode
SOURce1:PULM:SOURce INT
SOURce1:PULM:MODE PTR
SOURce1:PULM:TRIGger:MODE EXT
SOURce1:PGENerator:OUTPut:STATe 1
SOURce1:PGENerator:OUTPut:POLarity NORM
SOURce:PGENerator:OUTPut:STATe 1
SOURce:PULM:STATe 1
OUTPut1:STATe 1

// SOURce1:PULM:TRAin:CATalog?
// my_pt, pt
// SOURce1:PULM:TRAin:DEL "/var/user/my_pt"

The following commands are available:
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[:SOURce<hw>]:PULM:TRAin:CATalog?.......................................................................... 588
[:SOURce<hw>]:PULM:TRAin:DELete............................................................................. 588
[:SOURce<hw>]:PULM:TRAin:ONTime............................................................................ 588
[:SOURce<hw>]:PULM:TRAin:OFFTime...........................................................................588
[:SOURce<hw>]:PULM:TRAin:REPetition:POINts?............................................................589
[:SOURce<hw>]:PULM:TRAin:ONTime:POINts?............................................................... 589
[:SOURce<hw>]:PULM:TRAin:OFFTime:POINts?............................................................. 589
[:SOURce<hw>]:PULM:TRAin:REPetition.........................................................................589
[:SOURce<hw>]:PULM:TRAin:SELect..............................................................................589

[:SOURce<hw>]:PULM:TRAin:CATalog?

Queries the available pulse train files in the specified directory.

Return values: 
<Catalog> string

List of list filenames, separated by commas

Example: See Example "Generating a pulse train signal" on page 587.

Usage: Query only

Manual operation: See "Pulse Train Data" on page 106

[:SOURce<hw>]:PULM:TRAin:DELete <Filename>

Deletes the specified pulse train file.

Setting parameters: 
<Filename> string

Filename or complete file path; file extension is optional.

Example: See Example "Generating a pulse train signal" on page 587.

Usage: Setting only

Manual operation: See "Pulse Train Data" on page 106

[:SOURce<hw>]:PULM:TRAin:ONTime <OnTime>
[:SOURce<hw>]:PULM:TRAin:OFFTime <OffTime>
Enters the pulse on/off times values in the selected list.

Parameters:
<OffTime> Offtime#1{, Offtime#2, ...} | binary block data

List of comma-separated numeric values or binary block data,
where:
The list of numbers can be of any length.
In binary block format, 8 (4) bytes are always interpreted as a
floating-point number with double accuracy.
See :FORMat[:DATA] on page 483 for details.
The maximum length is 2047 values.
Range: 0 ns  to  5 ms
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Example: See Example "Generating a pulse train signal" on page 587.

Manual operation: See "Edit Pulse Train Data" on page 107

[:SOURce<hw>]:PULM:TRAin:REPetition:POINts?
[:SOURce<hw>]:PULM:TRAin:ONTime:POINts?
[:SOURce<hw>]:PULM:TRAin:OFFTime:POINts?
Queries the number of on and off time entries and repetitions in the selected list.

Return values: 
<Points> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Generating a pulse train signal" on page 587.

Usage: Query only

[:SOURce<hw>]:PULM:TRAin:REPetition <Repetition>

Sets the number of repetitions for each pulse on/off time value pair.

Parameters:
<Repetition> Repetition#1{, Repetition#2, ...}

0 = ignore value pair
Set "Repetition = 0" to skip a particular pulse without deleting
the pulse on/off time value pair
Range: 0  to  65535

Example: See Example "Generating a pulse train signal" on page 587.

Manual operation: See "Edit Pulse Train Data" on page 107

[:SOURce<hw>]:PULM:TRAin:SELect <Filename>

Selects or creates a data list in pulse train mode.

If the list with the selected name does not exist, a new list is created.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "Generating a pulse train signal" on page 587.

Manual operation: See "Pulse Train Data" on page 106

Pulse train data exchange

Option: R&S SMAB-K27

With the following commands, you can configure pulse trains in ASCII format and
export or import them accordingly.
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SOURce1:PULM:SOURce INT
SOURce1:PULM:MODE PTR
SOURce1:PULM:TRAin:SELect "/var/user/pt"
SOURce1:PULM:STATe 1

SOURce1:PULM:TRAin:DEXChange:MODE EXP
SOURce1:PULM:TRAin:DEXChange:AFILe:EXTension TXT
SOURce1:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal DOT
SOURce1:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn SEM
SOURce1:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn COMM
SOURce1:PULM:TRAin:DEXChange:SELect "/var/user/pt.pulstrn"
SOURce1:PULM:TRAin:DEXChange:AFILe:SELect "/var/user/pt_script.txt"
SOURce1:PULM:TRAin:DEXChange:EXECute 

The following commands are available:

[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE............................................................590
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension............................................ 590
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal............................... 591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn...............................591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog?..............................................591
[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect................................................. 591
[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect...........................................................592
[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute........................................................592

[:SOURce<hw>]:PULM:TRAin:DEXChange:MODE <Mode>

Determines the import or export of a list.

Specify the source or destination file with the command [:SOURce<hw>]:PULM:
TRAin:DEXChange:SELect.

Parameters:
<Mode> IMPort | EXPort

*RST: IMPort

Example: See "Pulse train data exchange" on page 589.

Manual operation: See "Mode" on page 109

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:EXTension <Extension>

Determines the extension of the ASCII file for import or export, or to query existing
files.

Parameters:
<Extension> TXT | CSV

*RST: TXT

Example: See "Pulse train data exchange" on page 589.

Manual operation: See "ASCII File Settings" on page 109
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[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:DECimal <Decimal>

Sets "." (decimal point) or "," (comma) as the decimal separator used in the ASCII data
with floating-point numerals.

Parameters:
<Decimal> DOT | COMMa

*RST: DOT

Example: See "Pulse train data exchange" on page 589.

Manual operation: See "ASCII File Settings" on page 109

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SEParator:COLumn <Column>

Selects the separator between the frequency and level column of the ASCII table.

Parameters:
<Column> TABulator | SEMicolon | COMMa | SPACe

*RST: COMMa

Example: See "Pulse train data exchange" on page 589.

Manual operation: See "ASCII File Settings" on page 109

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:CATalog?

Queries the available ASCII files in the current or specified directory.

Return values: 
<Catalog> string

List of ASCII files *.txt or *.csv, separated by commas.

Example: See "Pulse train data exchange" on page 589.

Usage: Query only

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 110

[:SOURce<hw>]:PULM:TRAin:DEXChange:AFILe:SELect <Filename>

Selects the ASCII file to be imported or exported.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See "Pulse train data exchange" on page 589.

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 110
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[:SOURce<hw>]:PULM:TRAin:DEXChange:SELect <Filename>

Selects the ASCII file for import or export, containing a pulse train list.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See "Pulse train data exchange" on page 589.

Manual operation: See "Select Source/Select ASCII Destination" on page 110

[:SOURce<hw>]:PULM:TRAin:DEXChange:EXECute

Usage: Event

Manual operation: See "Import / Export" on page 110

Executes the import or export of the selected list file, according to the transfer direction
set with command [:SOURce<hw>]:PULM:TRAin:DEXChange:MODE.

14.16.2  Avionic standards subsystems

Option: see Chapter 6.1, "Required options", on page 127.

The following subsections describe all commands for avionic standard modulation of
the RF signal. Divided into separate avionic subsystem command sections, you can
configure ADF, ILS and VOR modulation.

Programming examples are given for general configuration and avionic standard-spe-
cific configuration tasks.

Placeholder <Subsystem>

To simplify the description of the remote control commands, the placeholder
<Subsystem> is introduced. Depending on the avionic standard used as an entry
standard, replace this placeholder <Subsystem> with for example SOURce:ADF for
ADF.

The replacement of the place holder <Subsystem> is mandatory, i.e. remote control
commands containing this placeholder are not recognized and accepted by the instru-
ment.
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Example: 
SCPI command <subsystem>:STATe:
● Entry Standard = ADF

SOURce:ADF:STATe
● Entry Standard = ILS

SOURce:ILS:STATe
● Entry Standard = VOR

SOURce:VOR:STATe
● Invalid command

<Subsystem>:STAT

Contents

● Programming examples........................................................................................ 593
● General commands...............................................................................................597
● SOURce:ADF subsystem......................................................................................600
● SOURce:ILS subsystem....................................................................................... 603
● SOURce:VOR subsystem.....................................................................................625

14.16.2.1  Programming examples

Example: Save/Recall a configuration
This example shows how to query and load settings files, saved with the save/recall
function for the ADF standard.
For other avionic standards, replace ADF by ILS or VOR.
:SOURce1:ADF:PRESet
// Go to the "settings" directory.
:MMEM:CDIR "/var/user/settings"
// List all files in the directory with extension *.adf.
:SOURce1:ADF:SETTing:CATalog?
// adf_general, adf_comid

// Save the ADF configuration in the file "adf_general_latest.adf".
:SOURce1:ADF:SETTing:STORe "/var/user/settings/adf_general_latest"
// Delete the file "adf_general.adf".
:SOURce1:ADF:SETTing:DELete "/var/user/settings/adf_general"
:SOURce1:ADF:SETTing:CATalog?
// adf_general_latest, adf_comid

// Load the file "adf_general_latest.adf".
:SOURce1:ADF:SETTing:LOAD "/var/user/settings/adf_general_latest"

:SOURce1:ADF:STATe 1
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Example: Configure and generate a ADF signal
:SOURce1:ADF:PRESet

// Configure ADF COM/ID settings.
:SOURce1:ADF:COMid:PERiod 9
:SOURce1:ADF:COMid:FREQuency 1020
:SOURce1:ADF:COMid:DEPTh 11
:SOURce1:ADF:COMid:TSCHema USER
:SOURce1:ADF:COMid:DOT 0.11
:SOURce1:ADF:COMid:DASH 0.29
:SOURce1:ADF:COMid:SYMBol 0.11
:SOURce1:ADF:COMid:LETTer 0.29
:SOURce1:ADF:COMid:STATe 1

:SOURce1:ADF:STATe 1

Example: Configure and generate an ILS glide slope signal
:SOURce1:BB:ILS:PRESet

// Configure ILS localizer general settings.
:SOURce1:ILS:TYPE GS
:SOURce1:ILS:GS:FREQuency:MODE USER
:SOURce1:ILS:GS:FREQuency 334700000
:SOURce1:ILS:GS:FREQuency:MODE ICAO
:SOURce1:ILS:GS:ICAO:CHANnel?
// CH18X
:SOURce1:ILS:GS:FREQuency:SYNChronize 1
:SOURce1:ILS:LOCalizer:ICAO:CHANnel?
// CH18X
:SOURce1:ILS:LOCalizer:FREQuency?
// 108100000
:SOURce1:ILS:GSLope:SOURce?
// INT

// Configure ILS glide slope signal settings.
:SOURce1:ILS:GS:MODE NORM
:SOURce1:ILS:GS:DDM:POLarity P90_150
:SOURce1:ILS:GS:ULOBe:FREQuency 90
:SOURce1:ILS:GS:LLOBe:FREQuency 150
:SOURce1:ILS:GS:PHASe 0

// Configure ILS glide slope amplitude settings.
:SOURce1:ILS:GS:DDM:DIRection UP
:SOURce1:ILS:GS:SDM 80
:SOURce1:ILS:GS:DDM:COUPling FIX
:SOURce1:ILS:GS:DDM:STEP DEC
:SOURce1:ILS:GS:DDM:CURRent 0
:SOURce1:ILS:GS:DDM:DEPTh 0
:SOURce1:ILS:GS:DDM:LOGarithmic 0
:SOURce1:ILS:GS:DDM:PCT 0
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:SOURce1:ILS:STATe 1

Example: Configure and generate an ILS localizer signal
:SOURce1:ILS:PRESet

// Configure ILS localizer general settings.
:SOURce1:ILS:TYPE LOC
:SOURce1:ILS:LOCalizer:FREQuency:MODE USER
:SOURce1:ILS:LOCalizer:FREQuency 108100000
:SOURce1:ILS:LOCalizer:FREQuency:SYNChronize 1
:SOURce1:ILS:GS:FREQuency?
// 108100000
:SOURce1:ILS:LOCalizer:FREQuency:MODE ICAO
:SOURce1:ILS:LOCalizer:ICAO:CHANnel CH26Y
:SOURce1:ILS:GS:ICAO:CHANnel?
// CH26Y
:SOURce1:ILS:GS:FREQuency?
// 108950000
:SOURce1:ILS:LOCalizer:SOURce?
// INT

// Configure ILS localizer signal settings.
:SOURce1:ILS:LOCalizer:MODE NORM
:SOURce1:ILS:LOCalizer:DDM:POLarity P90_150
:SOURce1:ILS:LOCalizer:LLOBe:FREQuency 90
:SOURce1:ILS:LOCalizer:RLOBe:FREQuency 150
:SOURce1:ILS:LOCalizer:PHASe 0

// Configure ILS localizer amplitude settings.
:SOURce1:ILS:LOCalizer:DDM:DIRection LEFT
:SOURce1:ILS:LOCalizer:SDM 40
:SOURce1:ILS:LOCalizer:DDM:COUPling FIX
:SOURce1:ILS:LOCalizer:DDM:STEP DEC
:SOURce1:ILS:LOCalizer:DDM:CURRent 0
:SOURce1:ILS:LOCalizer:DDM:DEPTh 0
:SOURce1:ILS:LOCalizer:DDM:LOGarithmic 0
:SOURce1:ILS:LOCalizer:DDM:PCT 0

// Configure ILS localizer COM/ID settings.
:SOURce1:ILS:LOCalizer:COMid:CODE "MUC"
:SOURce1:ILS:LOCalizer:COMid:PERiod 9
:SOURce1:ILS:LOCalizer:COMid:FREQuency 1020
:SOURce1:ILS:LOCalizer:COMid:DEPTh 10
:SOURce1:ILS:LOCalizer:COMid:TSCHema USER
:SOURce1:ILS:LOCalizer:COMid:DOT 0.11
:SOURce1:ILS:LOCalizer:COMid:DASH 0.29
:SOURce1:ILS:LOCalizer:COMid:SYMBol 0.11
:SOURce1:ILS:LOCalizer:COMid:LETTer 0.29
:SOURce1:ILS:LOCalizer:COMid:STATe 1

SOURce subsystem



Remote control commandsR&S®SMA100B

596User Manual 1178.3834.02 ─ 09

:SOURce1:ILS:STATe 1

Example: Configure and generate an ILS marker beacons signal
SOURce:ILS:PRESet 

// Configure ILS marker beacons general settings.
:SOURce1:ILS:TYPE MBE
:SOURce1:ILS:MBEacon:FREQuency:MODE USER
:SOURce1:ILS:MBEacon:FREQuency 75000000
:SOURce1:ILS:MBEacon:MARKer:FREQuency 400
:SOURce1:ILS:MBEacon:MARKer:DEPTh 95
:SOURce1:ILS:MBEacon:MARKer:PULSed?
// 0

// Configure ILS marker beacons COM/ID settings.
:SOURce1:ILS:MBEacon:COMid:CODE "MUC"
:SOURce1:ILS:MBEacon:COMid:PERiod 9
:SOURce1:ILS:MBEacon:COMid:FREQuency 1020
:SOURce1:ILS:MBEacon:COMid:DEPTh 5
:SOURce1:ILS:MBEacon:COMid:TSCHema USER
:SOURce1:ILS:MBEacon:COMid:DOT 0.11
:SOURce1:ILS:MBEacon:COMid:DASH 0.29
:SOURce1:ILS:MBEacon:COMid:SYMBol 0.11
:SOURce1:ILS:MBEacon:COMid:LETTer 0.29
:SOURce1:ILS:MBEacon:COMid:STATe 1

:SOURce1:BB:ILS:STATe 1

Example: Configure and generate a VOR signal
:SOURce1:VOR:PRESet

// Configure VOR general settings.
:SOURce1:VOR:FREQuency:MODE USER
:SOURce1:VOR:FREQuency 108000000
:SOURce1:VOR:FREQuency:MODE ICAO
:SOURce1:VOR:ICAO:CHANnel?
// CH17X
:SOURce1:VOR:SOURce?
// INT

// Configure VOR signal settings.
:SOURce1:VOR:MODE NORM
:SOURce1:VOR:VAR:FREQuency 30
:SOURce1:VOR:VAR:DEPTh 30
:SOURce1:VOR:SUBCarrier:FREQuency 9960
:SOURce1:VOR:SUBCarrier:DEPTh 30
:SOURce1:VOR:REFerence:DEViation 480
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// Configure VOR position settings.
:SOURce1:VOR:BANGle 1
:SOURce1:VOR:BANGle:DIRection FROM

// Configure VOR COM/ID settings.
:SOURce1:VOR:COMid:PERiod 9
:SOURce1:VOR:COMid:FREQuency 1020
:SOURce1:VOR:COMid:DEPTh 11
:SOURce1:VOR:COMid:TSCHema USER
:SOURce1:VOR:COMid:DOT 0.11
:SOURce1:VOR:COMid:DASH 0.29
:SOURce1:VOR:COMid:SYMBol 0.11
:SOURce1:VOR:COMid:LETTer 0.29
:SOURce1:VOR:COMid:STATe 1

:SOURce1:VOR:STATe 1

14.16.2.2  General commands

<subsystem>:PRESet.....................................................................................................597
[:SOURce<hw>]:ADF:PRESet......................................................................................... 597
[:SOURce<hw>]:ILS:PRESet...........................................................................................598
[:SOURce<hw>]:VOR:PRESet.........................................................................................598
<subsystem>:SETTing:CATalog.......................................................................................598
[:SOURce<hw>]:ADF:SETTing:CATalog........................................................................... 598
[:SOURce<hw>]:ILS:SETTing:CATalog?...........................................................................598
[:SOURce<hw>]:VOR:SETTing:CATalog?.........................................................................598
<subsystem>:SETTing:DELete........................................................................................598
[:SOURce<hw>]:ADF:SETTing:DELete............................................................................ 598
[:SOURce<hw>]:ILS:SETTing:DELete..............................................................................598
[:SOURce<hw>]:VOR:SETTing:DELete............................................................................598
<subsystem>:SETTing:LOAD..........................................................................................598
[:SOURce<hw>]:ADF:SETTing:LOAD.............................................................................. 598
[:SOURce<hw>]:ILS:SETTing:LOAD................................................................................598
[:SOURce<hw>]:VOR:SETTing:LOAD..............................................................................598
<subsystem>:SETTing:STORe........................................................................................599
[:SOURce<hw>]:ADF:SETTing:STORe............................................................................ 599
[:SOURce<hw>]:ILS:SETTing:STORe.............................................................................. 599
[:SOURce<hw>]:VOR:SETTing:STORe............................................................................599
<subsystem>:STATe.......................................................................................................599
[:SOURce<hw>]:ADF:STATe........................................................................................... 599
[:SOURce<hw>]:ILS:STATe.............................................................................................599
[:SOURce<hw>]:VOR:STATe...........................................................................................599
<subsystem>:FREQuency:SYNChronize:STATe................................................................599
[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency:SYNChronize[:STATe]................................599
[:SOURce<hw>]:ILS:LOCalizer:FREQuency:SYNChronize[:STATe].....................................599

<subsystem>:PRESet
[:SOURce<hw>]:ADF:PRESet
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[:SOURce<hw>]:ILS:PRESet
[:SOURce<hw>]:VOR:PRESet
Sets the parameters of the digital standard to their default values (*RST values speci-
fied for the commands).

Not affected is the state set with the command SOURce<hw>:VOR:STATe.

Example: See Example "Save/Recall a configuration" on page 593.

<subsystem>:SETTing:CATalog
[:SOURce<hw>]:ADF:SETTing:CATalog
[:SOURce<hw>]:ILS:SETTing:CATalog?
[:SOURce<hw>]:VOR:SETTing:CATalog?
Queries the files with settings in the default directory. Listed are files with the file exten-
sion *.adf/*.ils/*.vor.

Return values: 
<FileNames> <filename1>,<filename2>,...

Returns a string of filenames separated by commas.

Example: See Example "Save/Recall a configuration" on page 593.

Usage: Query only

<subsystem>:SETTing:DELete
[:SOURce<hw>]:ADF:SETTing:DELete <Filename>
[:SOURce<hw>]:ILS:SETTing:DELete <Filename>
[:SOURce<hw>]:VOR:SETTing:DELete <Filename>
Deletes the selected file from the default or the specified directory. Deleted are files
with extension *.adf/*.ils/*.vor.

Setting parameters: 
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted

Example: See Example "Save/Recall a configuration" on page 593.

Usage: Setting only

<subsystem>:SETTing:LOAD
[:SOURce<hw>]:ADF:SETTing:LOAD <Filename>
[:SOURce<hw>]:ILS:SETTing:LOAD <Filename>
[:SOURce<hw>]:VOR:SETTing:LOAD <Filename>
Loads the selected file from the default or the specified directory. Loaded are files with
extension *.adf/*.ils/*.vor.

Parameters:
<Filename> "<filename>"

Filename or complete file path; file extension can be omitted
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Example: See Example "Save/Recall a configuration" on page 593.

Usage: Setting only

<subsystem>:SETTing:STORe
[:SOURce<hw>]:ADF:SETTing:STORe <Filename>
[:SOURce<hw>]:ILS:SETTing:STORe <Filename>
[:SOURce<hw>]:VOR:SETTing:STORe <Filename>
Saves the current settings into the selected file; the file extension
(*.adf/*.ils/*.vor) is assigned automatically.

Parameters:
<Filename> "<filename>"

Filename or complete file path

Example: See Example "Save/Recall a configuration" on page 593.

Usage: Setting only

<subsystem>:STATe
[:SOURce<hw>]:ADF:STATe <State>
[:SOURce<hw>]:ILS:STATe <State>
[:SOURce<hw>]:VOR:STATe <State>
Activates/deactivates the VOR modulation.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Save/Recall a configuration" on page 593.

<subsystem>:FREQuency:SYNChronize:STATe
[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency:SYNChronize[:STATe] <Mode>
[:SOURce<hw>]:ILS:LOCalizer:FREQuency:SYNChronize[:STATe] <Mode>
Activates synchronization of the ILS localizer ICAO channel with the ILS glide slope
ICAO channel.

The ILS glide slope/localizer frequency of the ICAO channel (Table 6-2) is set automat-
ically.

Parameters:
<Mode> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.
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14.16.2.3  SOURce:ADF subsystem

Option: R&S SMAB-K25

The SOURce:ADF subsystem contains all commands for configuring the ADF signal.

Characteristics which are valid for all modulations and the LF output are configured in
the SOURce:LFOutput subsystem. The signal is output at the LF connector.

Commands

[:SOURce<hw>]:ADF:COMid:CODE................................................................................ 600
[:SOURce<hw>]:ADF:COMid:DASH.................................................................................600
[:SOURce<hw>]:ADF:COMid:DEPTh............................................................................... 601
[:SOURce<hw>]:ADF:COMid:DOT...................................................................................601
[:SOURce<hw>]:ADF:COMid:FREQuency........................................................................601
[:SOURce<hw>]:ADF:COMid:LETTer............................................................................... 601
[:SOURce<hw>]:ADF:COMid:PERiod...............................................................................602
[:SOURce<hw>]:ADF:COMid:SYMBol..............................................................................602
[:SOURce<hw>]:ADF:COMid:TSCHema.......................................................................... 602
[:SOURce<hw>]:ADF:COMid[:STATe]...............................................................................603

[:SOURce<hw>]:ADF:COMid:CODE <Code>

Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).

The COM/ID tone is sent according to the selected code, see Chapter D, "Morse code
settings", on page 784.

If no coding is set, the COM/ID tone is sent uncoded (key down).

Parameters:
<Code> string

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Code" on page 168

[:SOURce<hw>]:ADF:COMid:DASH <Dash>

Sets the length of a Morse code dash.

Parameters:
<Dash> float

Range: 50E-3  to  1
Increment: 1E-4
*RST: 300E-3

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Dash Length" on page 169

SOURce subsystem



Remote control commandsR&S®SMA100B

601User Manual 1178.3834.02 ─ 09

[:SOURce<hw>]:ADF:COMid:DEPTh <Depth>

Sets the AM modulation depth of the COM/ID signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 95

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Depth" on page 169

[:SOURce<hw>]:ADF:COMid:DOT <Dot>

Sets the length of a Morse code dot.

Parameters:
<Dot> float

Range: 50E-3  to  1
Increment: 1E-4
*RST: 100E-3

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Dot Length" on page 169

[:SOURce<hw>]:ADF:COMid:FREQuency <Frequency>

Sets the frequency of the COM/ID signal.

Parameters:
<Frequency> float

Range: 0.1  to  20E3
Increment: 0.01
*RST: 1020

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Frequency" on page 169

[:SOURce<hw>]:ADF:COMid:LETTer <Letter>

Sets the length of a Morse code letter space.
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Parameters:
<Letter> float

Range: 50E-3  to  1
Increment: 1E-4
*RST: 300E-3

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Letter Space" on page 170

[:SOURce<hw>]:ADF:COMid:PERiod <Period>

Sets the period of the COM/ID signal.

Parameters:
<Period> float

Range: 0  to  120
Increment: 1E-3
*RST: 9

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Period" on page 169

[:SOURce<hw>]:ADF:COMid:SYMBol <Symbol>

Sets the length of the Morse code symbol space.

Parameters:
<Symbol> float

Range: 50E-3  to  1
Increment: 1E-4
*RST: 100E-3

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Symbol Space" on page 169

[:SOURce<hw>]:ADF:COMid:TSCHema <TSCHema>

Sets the time schema of the Morse code for the COM/ID signal.

Parameters:
<TSCHema> STD | USER

*RST: STD

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "Time Schema" on page 169

SOURce subsystem



Remote control commandsR&S®SMA100B

603User Manual 1178.3834.02 ─ 09

[:SOURce<hw>]:ADF:COMid[:STATe] <State>

Enables/disables the COM/ID signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configure and generate a ADF signal"
on page 594.

Manual operation: See "COM/ID State" on page 168

14.16.2.4  SOURce:ILS subsystem

Option: R&S SMAB-K25

The SOURce:BB:ILS subsystem contains all commands for configuring the ILS signal.

Characteristics which are valid for all modulations and the LF output are configured in
the SOURce:LFOutput subsystem. The signal is output at the LF connector.

Commands

[:SOURce<hw>]:ILS:TYPE..............................................................................................604
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:COUPling........................................................... 605
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:CURRent............................................................605
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:DIRection............................................................605
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:LOGarithmic........................................................606
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:PCT................................................................... 606
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:POLarity............................................................. 606
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:STEP................................................................. 607
[:SOURce<hw>]:ILS[:GS|GSLope]:DDM[:DEPTh]..............................................................607
[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency................................................................ 607
[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency:MODE......................................................608
[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency:SYNChronize[:STATe]................................608
[:SOURce<hw>]:ILS[:GS|GSLope]:ICAO:CHANnel............................................................608
[:SOURce<hw>]:ILS[:GS|GSLope]:LLOBe[:FREQuency]....................................................609
[:SOURce<hw>]:ILS[:GS|GSLope]:MODE........................................................................ 609
[:SOURce<hw>]:ILS[:GS|GSLope]:PHASe....................................................................... 609
[:SOURce<hw>]:ILS:GS|GSLope:PRESet........................................................................ 610
[:SOURce<hw>]:ILS[:GS|GSLope]:SDM...........................................................................610
[:SOURce<hw>]:ILS[:GS|GSLope]:SOURce..................................................................... 610
[:SOURce<hw>]:ILS[:GS|GSLope]:ULOBe[:FREQuency]................................................... 611
[:SOURce<hw>]:ILS:LOCalizer:COMid:CODE...................................................................611
[:SOURce<hw>]:ILS:LOCalizer:COMid:DASH................................................................... 611
[:SOURce<hw>]:ILS:LOCalizer:COMid:DEPTh................................................................. 612
[:SOURce<hw>]:ILS:LOCalizer:COMid:DOT..................................................................... 612
[:SOURce<hw>]:ILS:LOCalizer:COMid:FREQuency.......................................................... 612
[:SOURce<hw>]:ILS:LOCalizer:COMid:LETTer................................................................. 613
[:SOURce<hw>]:ILS:LOCalizer:COMid:PERiod.................................................................613
[:SOURce<hw>]:ILS:LOCalizer:COMid:SYMBol................................................................ 613

SOURce subsystem



Remote control commandsR&S®SMA100B

604User Manual 1178.3834.02 ─ 09

[:SOURce<hw>]:ILS:LOCalizer:COMid:TSCHema.............................................................613
[:SOURce<hw>]:ILS:LOCalizer:COMid[:STATe].................................................................614
[:SOURce<hw>]:ILS:LOCalizer:DDM:COUPling................................................................ 614
[:SOURce<hw>]:ILS:LOCalizer:DDM:CURRent.................................................................614
[:SOURce<hw>]:ILS:LOCalizer:DDM:DIRection................................................................ 615
[:SOURce<hw>]:ILS:LOCalizer:DDM:LOGarithmic............................................................ 615
[:SOURce<hw>]:ILS:LOCalizer:DDM:PCT........................................................................ 616
[:SOURce<hw>]:ILS:LOCalizer:DDM:POLarity.................................................................. 616
[:SOURce<hw>]:ILS:LOCalizer:DDM:STEP...................................................................... 616
[:SOURce<hw>]:ILS:LOCalizer:DDM[:DEPTh].................................................................. 617
[:SOURce<hw>]:ILS:LOCalizer:FREQuency..................................................................... 617
[:SOURce<hw>]:ILS:LOCalizer:FREQuency:MODE...........................................................617
[:SOURce<hw>]:ILS:LOCalizer:FREQuency:SYNChronize[:STATe].....................................618
[:SOURce<hw>]:ILS:LOCalizer:ICAO:CHANnel.................................................................618
[:SOURce<hw>]:ILS:LOCalizer:LLOBe[:FREQuency]........................................................ 618
[:SOURce<hw>]:ILS:LOCalizer:MODE............................................................................. 619
[:SOURce<hw>]:ILS:LOCalizer:PHASe............................................................................ 619
[:SOURce<hw>]:ILS:LOCalizer:PRESet........................................................................... 619
[:SOURce<hw>]:ILS:LOCalizer:RLOBe[:FREQuency]........................................................620
[:SOURce<hw>]:ILS:LOCalizer:SDM................................................................................620
[:SOURce<hw>]:ILS:LOCalizer:SOURce.......................................................................... 620
[:SOURce<hw>][:ILS]:MBEacon:COMid:CODE................................................................. 621
[:SOURce<hw>][:ILS]:MBEacon:COMid:DASH................................................................. 621
[:SOURce<hw>][:ILS]:MBEacon:COMid:DEPTh................................................................ 621
[:SOURce<hw>][:ILS]:MBEacon:COMid:DOT....................................................................622
[:SOURce<hw>][:ILS]:MBEacon:COMid:FREQuency.........................................................622
[:SOURce<hw>][:ILS]:MBEacon:COMid:LETTer................................................................ 622
[:SOURce<hw>][:ILS]:MBEacon:COMid:PERiod............................................................... 623
[:SOURce<hw>][:ILS]:MBEacon:COMid:SYMBol...............................................................623
[:SOURce<hw>][:ILS]:MBEacon:COMid:TSCHema........................................................... 623
[:SOURce<hw>][:ILS]:MBEacon:COMid[:STATe]............................................................... 624
[:SOURce<hw>][:ILS]:MBEacon:FREQuency....................................................................624
[:SOURce<hw>][:ILS]:MBEacon:FREQuency:MODE......................................................... 624
[:SOURce<hw>][:ILS]:MBEacon:MARKer:FREQuency.......................................................624
[:SOURce<hw>][:ILS]:MBEacon[:MARKer]:DEPTh............................................................ 625
[:SOURce<hw>][:ILS]:MBEacon:PRESet..........................................................................625
[:SOURce<hw>][:ILS]:MBEacon[:MARKer]:PULSed.......................................................... 625

[:SOURce<hw>]:ILS:TYPE <Type>

Selects the ILS modulation type.

Parameters:
<Type> GS | LOCalize | GSLope | MBEacon

*RST: GS

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "ILS Component" on page 144
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[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:COUPling <Coupling>

Selects if the DDM value is fixed or is changed with a change of sum of modulation
depths (SDM, see [:SOURce<hw>]:ILS[:GS|GSLope]:SDM on page 610).

Parameters:
<Coupling> FIXed | SDM

*RST: FIXed

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "DDM - SDM Coupling" on page 151

[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:CURRent <Current>

Sets the DDM value alternatively as a current by means of the ILS indicating instru-
ment. The instrument current is calculated according to:

DDM Current µA = DDM Depth [%] × 857,125 µA

A variation of the instrument current automatically leads to a variation of the DDM
value and the DDM value in dB.

Parameters:
<Current> float

Range: -8.57125E-4  to  8.57125E-4
Increment: 1E-7
*RST: 0

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "DDM Current" on page 150

[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:DIRection <Direction>

Sets the simulation mode for the ILS glide slope modulation signal. A change of the
setting automatically changes the sign of the DDM value.

Parameters:
<Direction> UP | DOWN

UP
The 150-Hz modulation signal is predominant, the DDM value is
negative (the airplane is too low, it must climb).
DOWN
The 90-Hz modulation signal is predominant, the DDM value is
positive (the airplane is too high, it must descend).
*RST: UP

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.
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Manual operation: See "Fly Mode" on page 150

[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:LOGarithmic <Logarithmic>

Sets the depth of modulation value for ILS glide slope modulation in dB.

See also [:SOURce<hw>]:ILS[:GS|GSLope]:DDM[:DEPTh] on page 607.

Parameters:
<Logarithmic> float

Range: -999.9  to  999.9
Increment: 1E-4
*RST: 0

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "DDM Logarithmic" on page 150

[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:PCT <Pct>

Sets the difference in depth of modulation between the signal of the upper lobe (90 Hz)
and the lower lobe (150 Hz). The maximum value equals the sum of the modulation
depths of the 90 Hz and the 150 Hz tone.

See also [:SOURce<hw>]:ILS[:GS|GSLope]:DDM[:DEPTh] on page 607.

Parameters:
<Pct> float

Range: -80.0  to  80.0
Increment: 0.01
*RST: 0

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "DDM Percent" on page 151

[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:POLarity <Polarity>

Sets the polarity for DDM calculation (see [:SOURce<hw>]:ILS[:GS|GSLope]:
DDM[:DEPTh] on page 607).

The DDM depth calculation depends on the selected polarity:

● Polarity 90 Hz - 150 Hz (default setting):
DDM = [ AM(90 Hz) - AM (150 Hz) ] / 100%

● Polarity 150 Hz - 90 Hz:
DDM = [ AM(150 Hz) - AM (90 Hz) ] / 100%

Parameters:
<Polarity> P90_150 | P150_90

*RST: P90_150
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Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "DDM Polarity" on page 148

[:SOURce<hw>]:ILS[:GS|GSLope]:DDM:STEP <DdmStep>

Sets the variation of the difference in depth of modulation via the rotary knob.

Parameters:
<DdmStep> DECimal | PREDefined

*RST: DECimal

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "DDM Step" on page 150

[:SOURce<hw>]:ILS[:GS|GSLope]:DDM[:DEPTh] <Depth>

Sets the difference in depth of modulation between the signal of the upper/left lobe (90
Hz) and the lower/right lobe (150 Hz). The maximum value equals the sum of the mod-
ulation depths of the 90 Hz and the 150 Hz tone. The following is true:

ILS:GS|GSL:DDM:DEPTh = (AM(90Hz) - AM(150Hz))/100%
A variation of the DDM value automatically leads to a variation of the DDM value in dB
and the value of the instrument current.

Parameters:
<Depth> float

Range: -0.8  to  0.8
Increment: 1E-4
*RST: 0

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "DDM Depth" on page 150

[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency <CarrierFreq>

Sets the carrier frequency of the signal.

Parameters:
<CarrierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 334.7E6

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "Carrier Frequency" on page 146
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[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency:MODE <Mode>

Sets the mode for the carrier frequency of the signal.

Parameters:
<Mode> USER | ICAO

DECimal
Activates user-defined variation of the carrier frequency.
ICAO
Activates variation in predefined steps according to standard ILS
transmitting frequencies (see Table 6-2).
*RST: DECimal

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "Carrier Frequency Mode" on page 146

[:SOURce<hw>]:ILS[:GS|GSLope]:FREQuency:SYNChronize[:STATe] <Mode>

Activates synchronization of the ILS glide slope ICAO channel with the ILS localizer
ICAO channel.

The ILS glide slope/localizer frequency of the ICAO channel (Table 6-2) is set automat-
ically.

Parameters:
<Mode> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

[:SOURce<hw>]:ILS[:GS|GSLope]:ICAO:CHANnel <Channel>

Sets the ICAO channel and the corresponding transmitting frequency.

If avionic standard modulation is activated and you change the "RF Frequency", the
frequency value of the closest ICAO channel is applied automatically. The "ICAO
Channel" is also updated.

The ICAO channel settings for ILS glide slope/localizer components are coupled. For
an overview of the ILS ICAO channel frequencies, see Table 6-2.

Parameters:
<Channel> CH18X | CH18Y | CH20X | CH20Y | CH22X | CH22Y | CH24X |

CH24Y | CH26X | CH26Y | CH28X | CH28Y | CH30X | CH30Y |
CH32X | CH32Y | CH34X | CH34Y | CH36X | CH36Y | CH38X |
CH38Y | CH40X | CH40Y | CH42X | CH42Y | CH44X | CH44Y |
CH46X | CH46Y | CH48X | CH48Y | CH50X | CH50Y | CH52X |
CH52Y | CH54X | CH54Y | CH56X | CH56Y
*RST: CH18X
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Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "ICAO Channel" on page 146

[:SOURce<hw>]:ILS[:GS|GSLope]:LLOBe[:FREQuency] <Frequency>

Sets the modulation frequency of the antenna lobe arranged at the bottom viewed from
the air plane for the ILS glide slope modulation signal.

Parameters:
<Frequency> float

Range: 100  to  200
Increment: 0.05
*RST: 150

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "Down Frequency" on page 148

[:SOURce<hw>]:ILS[:GS|GSLope]:MODE <Mode>

Sets the operating mode for the ILS glide slope modulation signal.

Parameters:
<Mode> NORM | ULOBe | LLOBe

NORM
ILS glide slope modulation is active.
ULOBe
Amplitude modulation of the output signal with the upper lobe
(90Hz) signal component of the ILS glide slope signal is active.
LLOBe
Amplitude modulation of the output signal with the lower lobe
(150Hz) signal component of the ILS glide slope signal is active.
*RST: NORM

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "Operating Mode" on page 147

[:SOURce<hw>]:ILS[:GS|GSLope]:PHASe <Phase>

Sets the phase between the modulation signals of the upper and lower antenna lobe of
the ILS glide slope signal.

Zero crossing of the lower lobe (150Hz) signal serves as a reference. The angle refers
to the period of the signal of the right antenna lobe.
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Parameters:
<Phase> float

Range: -60  to  120
Increment: 0.01
*RST: 0.0

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "Up/Down Phase" on page 148

[:SOURce<hw>]:ILS:GS|GSLope:PRESet

Sets the parameters of the ILS glide slope component to their default values (*RST
values specified for the commands).

For other ILS preset commands, see [:SOURce<hw>]:ILS:PRESet on page 598.

Example: SOURce1:ILS:GS:PRESet
Usage: Event

[:SOURce<hw>]:ILS[:GS|GSLope]:SDM <Sdm>

Sets the arithmetic sum of the modulation depths of the upper lobe (90 Hz) and lower
lobe (150 Hz) for the ILS glide slope signal contents.

The RMS modulation depth of the sum signal depends on the phase setting of both
modulation tones.

Parameters:
<Sdm> float

Range: 0  to  100
Increment: 0.1
*RST: 80

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "Sum of Depth" on page 149

[:SOURce<hw>]:ILS[:GS|GSLope]:SOURce <IlsGsSource>

Sets the modulation source for the avionic standard modulation.

If external modulation source is set, the external signal is added to the internal signal.
Switching off the internal modulation source is not possible.

Parameters:
<IlsGsSource> INT | EXT | INT,EXT

INT
Internal modulation source is used.
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EXT|INT,EXT
An external modulation source is used, additional to the internal
modulation source.
The external signal is input at the Ext connector.
*RST: INT

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "EXT AM" on page 146

[:SOURce<hw>]:ILS[:GS|GSLope]:ULOBe[:FREQuency] <Frequency>

Parameters:
<Frequency> float

Range: 60  to  120
Increment: 0.03
*RST: 90

Example: See Example "Configure and generate an ILS glide slope signal"
on page 594.

Manual operation: See "Up Frequency" on page 148

[:SOURce<hw>]:ILS:LOCalizer:COMid:CODE <Code>

Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).

The COM/ID tone is sent according to the selected code, see Chapter D, "Morse code
settings", on page 784.

If no coding is set, the COM/ID tone is sent uncoded (key down).

Parameters:
<Code> string

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Code" on page 159

[:SOURce<hw>]:ILS:LOCalizer:COMid:DASH <Dash>

Sets the length of a Morse code dash.

Parameters:
<Dash> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3
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Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Dash Length" on page 160

[:SOURce<hw>]:ILS:LOCalizer:COMid:DEPTh <Depth>

Sets the AM modulation depth of the COM/ID signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 10

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Depth" on page 159

[:SOURce<hw>]:ILS:LOCalizer:COMid:DOT <Dot>

Sets the length of a Morse code dot.

Parameters:
<Dot> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Dot Length" on page 160

[:SOURce<hw>]:ILS:LOCalizer:COMid:FREQuency <Frequency>

Sets the frequency of the COM/ID signal.

Parameters:
<Frequency> float

Range: 0.1  to  20E3
Increment: 0.01
*RST: 1020

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Frequency" on page 159

SOURce subsystem



Remote control commandsR&S®SMA100B

613User Manual 1178.3834.02 ─ 09

[:SOURce<hw>]:ILS:LOCalizer:COMid:LETTer <Letter>

Sets the length of a Morse code letter space.

Parameters:
<Letter> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Letter Space" on page 160

[:SOURce<hw>]:ILS:LOCalizer:COMid:PERiod <Period>

Sets the period of the COM/ID signal.

Parameters:
<Period> float

Range: 0  to  120
Increment: 1E-3
*RST: 9

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Period" on page 159

[:SOURce<hw>]:ILS:LOCalizer:COMid:SYMBol <Symbol>

Sets the length of the Morse code symbol space.

Parameters:
<Symbol> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Symbol Space" on page 160

[:SOURce<hw>]:ILS:LOCalizer:COMid:TSCHema <TSchema>

Sets the time schema of the Morse code for the COM/ID signal.

Parameters:
<TSchema> STD | USER
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STD
Activates the standard time schema of the Morse code.
The set dot length determines the dash length, which is 3
times the dot length.
USER
Activates the user-defined time schema of the Morse code.
Dot and dash length, as well as symbol and letter space
can be set separately.
*RST: STD

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Time Schema" on page 160

[:SOURce<hw>]:ILS:LOCalizer:COMid[:STATe] <State>

Enables/disables the COM/ID signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "COM/ID State" on page 159

[:SOURce<hw>]:ILS:LOCalizer:DDM:COUPling <Coupling>

Selects if the DDM value is fixed or is changed with a change of sum of modulation
depths (SDM, see [:SOURce<hw>]:ILS:LOCalizer:SDM on page 620).

Parameters:
<Coupling> FIXed | SDM

*RST: FIXed

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "DDM - SDM Coupling" on page 157

[:SOURce<hw>]:ILS:LOCalizer:DDM:CURRent <Current>

Sets the DDM value alternatively as a current by means of the ILS indicating instru-
ment. The instrument current is calculated according to:

DDM µA = DDM × 857,1 µA

A variation of the instrument current automatically leads to a variation of the DDM
value and the DDM value in dB.
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Parameters:
<Current> float

Range: -9.6775E-4  to  9.6775E-4
Increment: 1E-7
*RST: 0

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "DDM Current" on page 157

[:SOURce<hw>]:ILS:LOCalizer:DDM:DIRection <Direction>

Sets the simulation mode for the ILS-LOC modulation signal. A change of the setting
automatically changes the sign of the DDM value.

Parameters:
<Direction> LEFT | RIGHt

LEFT
The 150 Hz modulation signal is predominant, the DDM value is
negative (the airplane is too far to the right, it must turn to the
left).
RIGHT
The 90 Hz modulation signal is predominant, the DDM value is
positive (the airplane is too far to the left, it must turn to the
right).
*RST: LEFT

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Fly Mode" on page 156

[:SOURce<hw>]:ILS:LOCalizer:DDM:LOGarithmic <Logarithmic>

Sets the modulation depth in dB for ILS localizer modulation.

See also [:SOURce<hw>]:ILS:LOCalizer:DDM[:DEPTh] on page 617.

Parameters:
<Logarithmic> float

Range: -999.9  to  999.9
Increment: 1E-4
*RST: 0

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "DDM Logarithmic" on page 158
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[:SOURce<hw>]:ILS:LOCalizer:DDM:PCT <Pct>

Sets the difference in depth of modulation between the signal of the left lobe (90 Hz)
and the right lobe (150 Hz). The maximum value equals the sum of the modulation
depths of the 90 Hz and the 150 Hz tone.

See also [:SOURce<hw>]:ILS:LOCalizer:DDM[:DEPTh] on page 617.

Parameters:
<Pct> float

Range: -80.0  to  80.0
Increment: 0.01
*RST: 0

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "DDM Percent" on page 158

[:SOURce<hw>]:ILS:LOCalizer:DDM:POLarity <Polarity>

Sets the polarity for DDM calculation (see [:SOURce<hw>]:ILS:LOCalizer:DDM[:
DEPTh]).

The DDM depth calculation depends on the selected polarity:

● Polarity 90 Hz - 150 Hz (default setting):
DDM = [ AM (90 Hz) - AM (150 Hz) ] / 100%

● Polarity 150 Hz - 90 Hz:
DDM = [ AM (150 Hz) - AM (90 Hz) ] / 100%

Parameters:
<Polarity> P90_150 | P150_90

*RST: P90_150

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "DDM polarity" on page 155

[:SOURce<hw>]:ILS:LOCalizer:DDM:STEP <DdmStep>

Sets the variation step of the DDM values.

Parameters:
<DdmStep> DECimal | PREDefined

*RST: DECimal

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "DDM Step" on page 157
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[:SOURce<hw>]:ILS:LOCalizer:DDM[:DEPTh] <Depth>

Sets the difference in depth of modulation between the signal of the upper/left lobe (90
Hz) and the lower/right lobe (150 Hz). The maximum value equals the sum of the mod-
ulation depths of the 90 Hz and the 150 Hz tone.The following is true:

ILS:LOC:DDM:DEPTh = (AM(90Hz) - AM(150Hz))/100%
A variation of the DDM value automatically leads to a variation of the DDM value in dB
and the value of the instrument current.

Parameters:
<Depth> float

Range: -0.4  to  0.4
Increment: 1E-4
*RST: 0

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "DDM Depth" on page 157

[:SOURce<hw>]:ILS:LOCalizer:FREQuency <CarrierFreq>

Sets the carrier frequency of the signal.

Parameters:
<CarrierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 108.1E6

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Carrier Frequency" on page 152

[:SOURce<hw>]:ILS:LOCalizer:FREQuency:MODE <IlsLocFreqMode>

Sets the mode for the carrier frequency of the signal.

Parameters:
<Mode> DECimal | ICAO

DECimal
Activates user-defined variation of the carrier frequency.
ICAO
Activates variation in predefined steps according to standard ILS
transmitting frequencies (see Table 6-2).
*RST: DECimal

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.
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Manual operation: See "Carrier Frequency Mode" on page 152

[:SOURce<hw>]:ILS:LOCalizer:FREQuency:SYNChronize[:STATe] <Mode>

Activates synchronization of the ILS localizer ICAO channel with the ILS glide slope
ICAO channel.

The ILS glide slope/localizer frequency of the ICAO channel (Table 6-2) is set automat-
ically.

Parameters:
<Mode> 0 | 1 | OFF | ON

*RST: 0

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

[:SOURce<hw>]:ILS:LOCalizer:ICAO:CHANnel <SelIcaoChan>

Sets the ICAO channel and the corresponding transmitting frequency.

If avionic standard modulation is activated and you change the "RF Frequency", the
frequency value of the closest ICAO channel is applied automatically. The "ICAO
Channel" is also updated.

The ICAO channel settings for ILS glide slope/localizer components are coupled. For
an overview of the ILS ICAO channel frequencies, see Table 6-2.

Parameters:
<SelIcaoChan> CH18X | CH18Y | CH20X | CH20Y | CH22X | CH22Y | CH24X |

CH24Y | CH26X | CH26Y | CH28X | CH28Y | CH30X | CH30Y |
CH32X | CH32Y | CH34X | CH34Y | CH36X | CH36Y | CH38X |
CH38Y | CH40X | CH40Y | CH42X | CH42Y | CH44X | CH44Y |
CH46X | CH46Y | CH48X | CH48Y | CH50X | CH50Y | CH52X |
CH52Y | CH54X | CH54Y | CH56X | CH56Y
*RST: CH18X

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "ICAO Channel" on page 153

[:SOURce<hw>]:ILS:LOCalizer:LLOBe[:FREQuency] <Frequency>

Sets the modulation frequency of the antenna lobe arranged at the bottom viewed from
the air plane for the ILS localizer modulation signal.

Parameters:
<Frequency> float

Range: 60  to  120
Increment: 0.03
*RST: 90
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Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Left Frequency" on page 155

[:SOURce<hw>]:ILS:LOCalizer:MODE <Mode>

Sets the operating mode for the ILS localizer modulation signal.

Parameters:
<Mode> NORM | LLOBe | RLOBe

NORM
ILS localizer modulation is active.
LLOBe
Amplitude modulation of the output signal with the left lobe
(90Hz) signal component of the ILS localizer signal is active.
RLOBe
Amplitude modulation of the output signal with the right lobe
(150Hz) signal component of the ILS localizer signal is active.
*RST: NORM

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Operating Mode" on page 154

[:SOURce<hw>]:ILS:LOCalizer:PHASe <Phase>

Sets the phase between the modulation signals of the left and right antenna lobe of the
ILS localizer signal.

The zero crossing of the right lobe (150Hz) signal serves as a reference. The angle
refers to the period of the signal of the right antenna lobe.

Parameters:
<Phase> float

Range: -60  to  120
Increment: 0.01
*RST: 0

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Left/Right Phase" on page 155

[:SOURce<hw>]:ILS:LOCalizer:PRESet

Sets the parameters of the ILS localizer component to their default values (*RST val-
ues specified for the commands).

For other ILS preset commands, see [:SOURce<hw>]:ILS:PRESet on page 598.
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Example: SOURce1:ILS:LOCalizer:PRESet
Usage: Event

[:SOURce<hw>]:ILS:LOCalizer:RLOBe[:FREQuency] <Frequency>

Sets the modulation frequency of the antenna lobe arranged at the right viewed from
the air plane.

Parameters:
<Frequency> float

Range: 100  to  200
Increment: 0.05
*RST: 150

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Right Frequency" on page 155

[:SOURce<hw>]:ILS:LOCalizer:SDM <Sdm>

Sets the arithmetic sum of the modulation depths of the left lobe (90 Hz) and right lobe
(150 Hz) for the ILS localizer signal contents.

The RMS modulation depth of the sum signal depends on the phase setting of both
modulation tones.

Parameters:
<Sdm> float

Range: 0  to  100
Increment: 0.1
*RST: 40

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "Sum of Depth" on page 156

[:SOURce<hw>]:ILS:LOCalizer:SOURce <IlsLocSource>

Sets the modulation source for the avionic standard modulation.

If external modulation source is set, the external signal is added to the internal signal.
Switching off the internal modulation source is not possible.

Parameters:
<IlsLocSource> INT | EXT | INT,EXT

INT
Internal modulation source is used.
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EXT|INT,EXT
An external modulation source is used, additional to the internal
modulation source.
The external signal is input at the Ext connector.
*RST: INT

Example: See Example "Configure and generate an ILS localizer signal"
on page 595.

Manual operation: See "EXT AM" on page 153

[:SOURce<hw>][:ILS]:MBEacon:COMid:CODE <Code>

Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).

The COM/ID tone is sent according to the selected code, see Chapter D, "Morse code
settings", on page 784.

If no coding is set, the COM/ID tone is sent uncoded (key down).

Parameters:
<Code> string

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Code" on page 164

[:SOURce<hw>][:ILS]:MBEacon:COMid:DASH <Dash>

Sets the length of a Morse code dash.

Parameters:
<Dash> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Dash Length" on page 165

[:SOURce<hw>][:ILS]:MBEacon:COMid:DEPTh <Depth>

Sets the AM modulation depth of the COM/ID signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 5
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Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Depth" on page 164

[:SOURce<hw>][:ILS]:MBEacon:COMid:DOT <Dot>

Sets the length of a Morse code dot.

Parameters:
<Dot> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Dot Length" on page 165

[:SOURce<hw>][:ILS]:MBEacon:COMid:FREQuency <Frequency>

Sets the frequency of the COM/ID signal.

Parameters:
<Frequency> float

Range: 0.1  to  20E3
Increment: 0.01
*RST: 1020

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Frequency" on page 164

[:SOURce<hw>][:ILS]:MBEacon:COMid:LETTer <Letter>

Sets the length of a Morse code letter space.

Parameters:
<Letter> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Letter Space" on page 165
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[:SOURce<hw>][:ILS]:MBEacon:COMid:PERiod <Period>

Sets the period of the COM/ID signal.

Parameters:
<Period> float

Range: 0  to  120
Increment: 1E-3
*RST: 9

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Period" on page 164

[:SOURce<hw>][:ILS]:MBEacon:COMid:SYMBol <Symbol>

Sets the length of the Morse code symbol space.

Parameters:
<Symbol> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Symbol Space" on page 165

[:SOURce<hw>][:ILS]:MBEacon:COMid:TSCHema <Tschema>

Sets the time schema of the Morse code for the COM/ID signal.

Parameters:
<Tschema> STD | USER

STD
Activates the standard time schema of the Morse code.
The set dot length determines the dash length, which is 3
times the dot length.
USER
Activates the user-defined time schema of the Morse code.
Dot and dash length, as well as symbol and letter space
can be set separately.
*RST: STD

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Time Schema" on page 164
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[:SOURce<hw>][:ILS]:MBEacon:COMid[:STATe] <State>

Enables/disables the COM/ID signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "COM/ID State" on page 164

[:SOURce<hw>][:ILS]:MBEacon:FREQuency <CarrierFreq>

Sets the carrier frequency for the ILS marker beacon signal.

Parameters:
<CarrierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 75E6

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Carrier Frequency" on page 161

[:SOURce<hw>][:ILS]:MBEacon:FREQuency:MODE <Mode>

Sets the carrier frequency mode of the ILS marker beacon signal.

Parameters:
<Mode> USER | PREDefined

*RST: USER

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Carrier Frequency Mode" on page 161

[:SOURce<hw>][:ILS]:MBEacon:MARKer:FREQuency <Frequency>

Sets the modulation frequency of the marker signal for the ILS marker beacon modula-
tion signal.

Parameters:
<Frequency> 400 | 1300 | 3000

*RST: 400
Default unit: Hz

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.
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Manual operation: See "Marker Frequency" on page 162

[:SOURce<hw>][:ILS]:MBEacon[:MARKer]:DEPTh <Depth>

Sets the modulation depth of the marker signal for the ILS marker beacon signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 95

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Marker Depth" on page 162

[:SOURce<hw>][:ILS]:MBEacon:PRESet

Sets the parameters of the ILS marker beacons component to their default values
(*RST values specified for the commands).

For other ILS preset commands, see [:SOURce<hw>]:ILS:PRESet on page 598.

Example: SOURce1:ILS:MBEacon:PRESet
Usage: Event

[:SOURce<hw>][:ILS]:MBEacon[:MARKer]:PULSed <Pulsed>

Activates the modulation of a pulsed marker signal (morse coding).

Parameters:
<Pulsed> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configure and generate an ILS marker beacons
signal" on page 596.

Manual operation: See "Pulsed Marker" on page 162

14.16.2.5  SOURce:VOR subsystem

Option: R&S SMAB-K25

The SOURce:VOR subsystem contains all commands for configuring the VOR signal.

Characteristics which are valid for all modulations and the LF output are configured in
the SOURce:LFOutput subsystem. The signal is output at the LF connector.
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Commands

[:SOURce<hw>]:VOR:SOURce....................................................................................... 626
[:SOURce<hw>]:VOR[:BANGle].......................................................................................626
[:SOURce<hw>]:VOR[:BANGle]:DIRection....................................................................... 627
[:SOURce<hw>]:VOR:COMid:CODE................................................................................627
[:SOURce<hw>]:VOR:COMid:DASH................................................................................ 628
[:SOURce<hw>]:VOR:COMid:DEPTh...............................................................................628
[:SOURce<hw>]:VOR:COMid:DOT.................................................................................. 628
[:SOURce<hw>]:VOR:COMid:FREQuency....................................................................... 628
[:SOURce<hw>]:VOR:COMid:LETTer...............................................................................629
[:SOURce<hw>]:VOR:COMid:PERiod.............................................................................. 629
[:SOURce<hw>]:VOR:COMid:SYMBol............................................................................. 629
[:SOURce<hw>]:VOR:COMid:TSCHema..........................................................................630
[:SOURce<hw>]:VOR:COMid[:STATe].............................................................................. 630
[:SOURce<hw>]:VOR:FREQuency.................................................................................. 630
[:SOURce<hw>]:VOR:FREQuency:MODE........................................................................631
[:SOURce<hw>]:VOR:ICAO:CHANnel..............................................................................631
[:SOURce<hw>]:VOR:MODE.......................................................................................... 632
[:SOURce<hw>]:VOR:REFerence[:DEViation]...................................................................633
[:SOURce<hw>]:VOR:SUBCarrier:DEPTh........................................................................ 633
[:SOURce<hw>]:VOR:SUBCarrier[:FREQuency]............................................................... 633
[:SOURce<hw>]:VOR:VAR:FREQuency........................................................................... 634
[:SOURce<hw>]:VOR:VAR[:DEPTh]................................................................................ 634

[:SOURce<hw>]:VOR:SOURce <VorSourceSel>

Sets the modulation source for the avionic standard modulation.

If external modulation source is set, the external signal is added to the internal signal.
Switching off the internal modulation source is not possible.

Parameters:
<VorSourceSel> INT | EXT | INT,EXT

INT
Internal modulation source is used.
EXT|INT,EXT
An external modulation source is used, additional to the internal
modulation source.
The external signal is input at the Ext connector.
*RST: INT

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "EXT AM" on page 136

[:SOURce<hw>]:VOR[:BANGle] <BAngle>

Sets the bearing angle between the VAR signal and the reference signal.
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The orientation of the angle can be set with [:SOURce<hw>]:VOR[:BANGle]:
DIRection.

Parameters:
<BAngle> float

Range: 0  to  360
Increment: 0.01
*RST: 0

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Bearing Angle" on page 139

[:SOURce<hw>]:VOR[:BANGle]:DIRection <Direction>

Sets the reference position of the phase information.

Parameters:
<Direction> FROM | TO

FROM
The bearing angle is measured between the geographic north
and the connection line from beacon to airplane.
TO
The bearing angle is measured between the geographic north
and the connection line from airplane to beacon.
*RST: FROM

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Direction" on page 139

[:SOURce<hw>]:VOR:COMid:CODE <Code>

Sets the coding of the COM/ID signal by the international short name of the airport
(e.g. MUC for the Munich airport).

The COM/ID tone is sent according to the selected code, see Chapter D, "Morse code
settings", on page 784.

If no coding is set, the COM/ID tone is sent uncoded (key down).

Parameters:
<Code> string

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Code" on page 140
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[:SOURce<hw>]:VOR:COMid:DASH <Dash>

Sets the length of a Morse code dash.

Parameters:
<Dash> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Dash Length" on page 141

[:SOURce<hw>]:VOR:COMid:DEPTh <Depth>

Sets the AM modulation depth of the COM/ID signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 10

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Depth" on page 141

[:SOURce<hw>]:VOR:COMid:DOT <Dot>

Sets the length of a Morse code dot.

If the time schema is set to standard, the dash length (= 3 times dot length), symbol
space (= dot length) and letter space (= 3 times dot length) is also determined by this
entry.

Parameters:
<Dot> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Dot Length" on page 141

[:SOURce<hw>]:VOR:COMid:FREQuency <Frequency>

Sets the frequency of the COM/ID signal.
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Parameters:
<Frequency> float

Range: 0.1  to  20E3
Increment: 0.01
*RST: 1020

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Frequency" on page 141

[:SOURce<hw>]:VOR:COMid:LETTer <Letter>

Sets the length of a Morse code letter space.

Parameters:
<Letter> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.3
Default unit: s

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Letter Space" on page 142

[:SOURce<hw>]:VOR:COMid:PERiod <Period>

Sets the period of the COM/ID signal.

Parameters:
<Period> float

Range: 0  to  120
Increment: 1E-3
*RST: 9

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Period" on page 141

[:SOURce<hw>]:VOR:COMid:SYMBol <Symbol>

Sets the length of the Morse code symbol space.

Parameters:
<Symbol> float

Range: 0.05  to  1
Increment: 1E-4
*RST: 0.1
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Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Symbol Space" on page 142

[:SOURce<hw>]:VOR:COMid:TSCHema <Tschema>

Sets the time schema of the Morse code for the COM/ID signal.

Parameters:
<Tschema> STD | USER

STD
Activates the standard time schema of the Morse code.
The set dot length determines the dash length, which is 3
times the dot length.
USER
Activates the user-defined time schema of the Morse code.
Dot and dash length, as well as symbol and letter space
can be set separately.
*RST: STD

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Time Schema" on page 141

[:SOURce<hw>]:VOR:COMid[:STATe] <State>

Enables/disables the COM/ID signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "COM/ID State" on page 140

[:SOURce<hw>]:VOR:FREQuency <CarrierFreq>

Sets the carrier frequency of the signal.

Parameters:
<CarrierFreq> float

Range: 100E3  to  6E9
Increment: 0.01
*RST: 108E6

Example: See Example "Configure and generate a VOR signal"
on page 596.
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Manual operation: See "Carrier Frequency" on page 136

[:SOURce<hw>]:VOR:FREQuency:MODE <Mode>

Sets the mode for the carrier frequency of the signal.

Parameters:
<Mode> DECimal | ICAO

DECimal
Activates user-defined variation of the carrier frequency.
ICAO
Activates variation in predefined steps according to standard
VOR transmitting frequencies (see Table 6-1).
*RST: DECimal

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Carrier Frequency Mode" on page 135

[:SOURce<hw>]:VOR:ICAO:CHANnel <Channel>

Sets the ICAO channel and the corresponding transmitting frequency.

If avionic standard modulation is activated and you change the "RF Frequency", the
frequency value of the closest ICAO channel is applied automatically. The "ICAO
Channel" is also updated.

The carrier frequency is set automatically to the value of the ICAO channel. For an
overview of the VOR ICAO channel frequencies, see Table 6-1.
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Parameters:
<Channel> CH17X | CH17Y | CH19X | CH19Y | CH21X | CH21Y | CH23X |

CH23Y | CH25X | CH25Y | CH27X | CH27Y | CH29X | CH29Y |
CH31X | CH31Y | CH33X | CH33Y | CH35X | CH35Y | CH37X |
CH37Y | CH39X | CH39Y | CH41X | CH41Y | CH43X | CH43Y |
CH45X | CH45Y | CH47X | CH47Y | CH49X | CH49Y | CH51X |
CH51Y | CH53X | CH53Y | CH55X | CH55Y | CH57X | CH57Y |
CH58X | CH58Y | CH59X | CH59Y | CH70X | CH70Y | CH71X |
CH71Y | CH72X | CH72Y | CH73X | CH73Y | CH74X | CH74Y |
CH75X | CH75Y | CH76X | CH76Y | CH77X | CH77Y | CH78X |
CH78Y | CH79X | CH79Y | CH80X | CH80Y | CH81X | CH81Y |
CH82X | CH82Y | CH83X | CH83Y | CH84X | CH84Y | CH85X |
CH85Y | CH86X | CH86Y | CH87X | CH87Y | CH88X | CH88Y |
CH89X | CH89Y | CH90X | CH90Y | CH91X | CH91Y | CH92X |
CH92Y | CH93X | CH93Y | CH94X | CH94Y | CH95X | CH95Y |
CH96X | CH96Y | CH97X | CH97Y | CH98X | CH98Y | CH99X |
CH99Y | CH100X | CH100Y | CH101X | CH101Y | CH102X |
CH102Y | CH103X | CH103Y | CH104X | CH104Y | CH105X |
CH105Y | CH106X | CH106Y | CH107X | CH107Y | CH108X |
CH108Y | CH109X | CH109Y | CH110X | CH110Y | CH111X |
CH111Y | CH112X | CH112Y | CH113X | CH113Y | CH114X |
CH114Y | CH115X | CH115Y | CH116X | CH116Y | CH117X |
CH117Y | CH118X | CH118Y | CH119X | CH119Y | CH120X |
CH120Y | CH121X | CH121Y | CH122X | CH122Y | CH123X |
CH123Y | CH124X | CH124Y | CH125X | CH125Y | CH126X |
CH126Y
*RST: CH17X

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "ICAO Channel" on page 136

[:SOURce<hw>]:VOR:MODE <Mode>

Sets the operating mode for the VOR modulation signal.

Parameters:
<Mode> NORM | VAR | SUBCarrier | FMSubcarrier

NORM
VOR modulation is active.
VAR
Amplitude modulation of the output signal with the variable sig-
nal component (30Hz signal content) of the VOR signal.
The modulation depth of the 30 Hz signal can be set with [:
SOURce<hw>]:VOR:VAR[:DEPTh].
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SUBCarrier
Amplitude modulation of the output signal with the unmodulated
FM carrier (9960Hz) of the VOR signal.
The modulation depth of the 30 Hz signal can be set with [:
SOURce<hw>]:VOR:SUBCarrier:DEPTh.
FMSubcarrier
Amplitude modulation of the output signal with the frequency
modulated FM carrier (9960Hz) of the VOR signal.
The modulation depth of the 30 Hz signal can be set with [:
SOURce<hw>]:VOR:SUBCarrier:DEPTh.
The frequency deviation can be set with [:SOURce<hw>]:
VOR:REFerence[:DEViation].
*RST: NORM

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Mode" on page 137

[:SOURce<hw>]:VOR:REFerence[:DEViation] <Deviation>

Sets the frequency deviation of the reference signal on the FM carrier.

Parameters:
<Deviation> integer

Range: 0  to  960
*RST: 480

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "REF Deviation" on page 138

[:SOURce<hw>]:VOR:SUBCarrier:DEPTh <Depth>

Sets the AM modulation depth of the FM carrier.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 30

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Subcarrier Depth" on page 138

[:SOURce<hw>]:VOR:SUBCarrier[:FREQuency] <Frequency>

Sets the frequency of the FM carrier.
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Parameters:
<Frequency> float

Range: 5E3  to  15E3
Increment: 0.01
*RST: 9.96E3

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "Subcarrier Frequency" on page 138

[:SOURce<hw>]:VOR:VAR:FREQuency <Frequency>

Sets the frequency of the variable and the reference signal. As the two signals must
have the same frequency, the setting is valid for both signals.

Parameters:
<Frequency> float

Range: 10  to  60
Increment: 0.01
*RST: 30

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "VAR/REF Frequency" on page 138

[:SOURce<hw>]:VOR:VAR[:DEPTh] <Depth>

Sets the AM modulation depth of the 30Hz variable signal.

Parameters:
<Depth> float

Range: 0  to  100
Increment: 0.1
*RST: 30

Example: See Example "Configure and generate a VOR signal"
on page 596.

Manual operation: See "VAR Depth" on page 138

14.16.3  SOURce:CORRection subsystem

The SOURce:CORRection subsystem contains the commands for defining correction
values for external test assemblies.

You can acquire the correction values anytime, regardless of the modulation settings of
the generator. The correction is performed by adding the correction values to the out-
put level of the respective RF frequency.
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Determine the correction values in one of the following ways:
● Measure the RF output level at several frequency points and enter the value pairs

manually in a table
● Connect an R&S NRP to the generator output signal and send the command [:

SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe to
fill the table automatically.

Correction values can be stored in files with the predefined file extension *.uco.

Refer to Chapter 14.5.2, "Accessing files in the default or in a specified directory",
on page 458 for general information on file handling in the default and in a specific
directory.

Programming example

The examples in this section assume that:
● The files are stored in the default directory.
● *RST does not affect data lists.

Example: Create a table with user-defined correction values for the RF level
The following example shows a command sequence to create and activate a list for
assigning level correction values to arbitrary RF frequencies. Further hardware settings
are not considered.

// Reset the instrument to start from an initial state
// Query the available user correction list files in the default directory 
// Select a file or create a new one
// ******************************************************************
*RST; *CLS
SOURce1:CORRection:CSET:CATalog?
// Response: shows the name of available user correction files (if applicable)
// Select a file
SOURce1:CORRection:CSET:SELect "/var/user/ucor1"
// Create a new file (if not existing)
SOURce1:CORRection:CSET:SELect "/var/user/ucor2"

// Enter the frequency/level value pairs in the table; 
// existing data is overwritten
// Query the number of frequency/power entries in the selected list
SOURce1:CORRection:CSET:DATA:FREQuency 100MHz,110MHz,120MHz,130MHz,140MHz,150MHz
SOURce1:CORRection:CSET:DATA:POWer -10,-7.5,-5.0,-2.5,0,2.5 
SOURce1:CORRection:CSET:DATA:FREQuency:POINts?
// 6
SOURce1:CORRection:CSET:DATA:POWer:POINTs?
// 6

// Enable user correction mode and RF output
SOURce1:CORRection:STATe 1
OUTPut1:STATe ON
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// Query the currently used correction value
SOURce1:CORRection:VALue?
// -2.5

// Delete a user correction file
SOURce1:CORRection:CSET:DELEte "/var/user/ucor1.uco"

Example: Fill user correction data with sensor
The following example shows a command sequence to fill a user correction list auto-
matically supported by a connected R&S NRP.

// Fill a user correction list with the level values
// measured by an R&S NRP,
// store the data in a file and enable user correction.

*RST; *CLS

SOURce1:CORRection:CSET:SELect "/var/user/Ucor1_AutoFill.uco"
SOURce1:CORRection:CSET:DATA:FREQuency 100MHz,110MHz,120MHz,130MHz,140MHz,150MHz
SOURce1:CORRection:ZERoing:STATe 1
SOURce1:CORRection:CSET:DATA:SENSor1:POWer:SONCe
// Query the number of automatically filled correction level values
SOURce1:CORRection:CSET:DATA:POWer:POINTs?
// 6
SOURce1:CORRection:STATe 1

// Query the correction value at a certain frequency
FREQ 120000000
SOURce1:CORRection:VALue?
// -52.13

Example: User correction data exchange
The following example shows a command sequence to export a user correction list
(here the list created with the example before) into an ASCII file. Further hardware set-
tings are not considered.

// Select a user correction file for exporting to file in ASCII format
// Set ASCII data parameters
// Set the ASCII file extension, the decimal separator
// and the column separator for the ASCII data
SOURce1:CORRection:DEXChange:AFILe:CATalog?
// my_ucor
SOURce1:CORRection:CSET:CATalog?
// ucor1,Ucor1_AutoFill
SOURce1:CORRection:CSET:SELect "/var/user/Ucor1_AutoFill.uco"
SOURce1:CORRection:DEXChange:AFILe:EXTension CSV
SOURce1:CORRection:DEXChange:AFILe:SEParator:DECimal DOT
SOURce1:CORRection:DEXChange:AFILe:SEParator:COLumn COMMa 
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// Select source and destination 
SOURce1:CORRection:DEXChange:AFILe:SELect "/var/user/ucor2ASCII"

// Export the user correction data into the ASCII file
SOURce1:CORRection:DEXChange:MODE EXPort
SOURce1:CORRection:DEXChange:EXECute

// Query the available ASCII files with extension .csv
SOURce1:CORRection:DEXChange:AFILe:CATalog?
// ucor2ASCII,my_ucor

// Import a user correction ASCII file
SOURce1:CORRection:DEXChange:MODE IMPort
SOURce1:CORRection:DEXChange:AFILE:SELect "/var/user/my_ucor" 
SOURce1:CORRection:DEXChange:EXECute

● Correction settings................................................................................................ 637
● Correction data exchange.....................................................................................640

14.16.3.1  Correction settings

[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency <Frequency>

Enters the frequency value in the table selected with [:SOURce<hw>]:CORRection:
CSET[:SELect].

Parameters:
<Frequency> Frequency#1[, Frequency#2, ...]

String of values with default unit Hz.

Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Manual operation: See "Edit List Mode Data" on page 209

[:SOURce<hw>]:CORRection:CSET:DATA:POWer <Power>

Enters the level values to the table selected with [:SOURce<hw>]:CORRection:
CSET[:SELect].

Parameters:
<Power> Power#1[, Power#2, ...]

String of values with default unit dB.
*RST: 0

Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Manual operation: See "Edit List Mode Data" on page 209
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[:SOURce<hw>]:CORRection:CSET:DATA:FREQuency:POINts?
[:SOURce<hw>]:CORRection:CSET:DATA:POWer:POINts?
Queries the number of frequency/level values in the selected table.

Return values: 
<Points> integer

Range: 0  to  10000
*RST: 0

Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Usage: Query only

[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe

Fills the selected user correction table with the level values measured by the power
sensor for the given frequencies.

To select the used power sensor set the suffix in key word SENSe.

Example: See Example "Fill user correction data with sensor"
on page 636.

Usage: Event

Manual operation: See "Fill User Correction Data with Sensor" on page 229

[:SOURce<hw>]:CORRection:CSET[:SELect] <Filename>

Selects or creates a file for the user correction data.

If the file with the selected name does not exist, a new file is created.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Manual operation: See "UCOR Data" on page 225

[:SOURce<hw>]:CORRection:VALue?

Queries the current value for user correction.

Return values: 
<Value> float

Range: -100  to  100
Increment: 0.01
*RST: 0
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Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Usage: Query only

Manual operation: See "User Correction" on page 224

[:SOURce<hw>]:CORRection:ZERoing:STATe <State>

Activates the zeroing procedure before filling the user correction data acquired by a
sensor.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 1

Example: See Example "Fill user correction data with sensor"
on page 636.

Manual operation: See "Fill User Correction Data with Sensor" on page 229

[:SOURce<hw>]:CORRection:CSET:DATA[:SENSor<ch>][:POWer]:SONCe

Fills the selected user correction list with the level values measured by the power sen-
sor for the given frequencies.

Suffix: 
SENSor<ch>

.
Defines the used power sensor, i.e. the sensor whose values are
used.

Example: See Example "Fill user correction data with sensor"
on page 636.

Usage: Event

[:SOURce<hw>]:CORRection[:STATe] <State>

Activates user correction with the currently selected table.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Manual operation: See "State" on page 224

[:SOURce]:CORRection:CSET:CATalog?

Queries a list of available user correction tables.
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Return values: 
<Catalog> string

List of list filenames, separated by commas

Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Usage: Query only

Manual operation: See "UCOR Data" on page 225

[:SOURce]:CORRection:CSET:DELete <Filename>

Deletes the specified user correction list file.

Setting parameters: 
<Filename> string

Filename or complete file path; file extension is optional.

Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Usage: Setting only

Manual operation: See "UCOR Data" on page 225

14.16.3.2  Correction data exchange

With the following commands, you can configure user correction lists and export or
import them accordingly.

[:SOURce<hw>]:CORRection:DEXChange:AFILe:CATalog?

Queries the available ASCII files for export or import of user correction data in the cur-
rent or specified directory.

Return values: 
<Catalog> string

List of ASCII files *.txt or *.csv, separated by commas.

Example: See Example "Create a table with user-defined correction values
for the RF level" on page 635 .

Usage: Query only

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 110

[:SOURce<hw>]:CORRection:DEXChange:AFILe:EXTension <Extension>

Determines the extension of the ASCII files for file import or export, or to query existing
files.
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Parameters:
<Extension> TXT | CSV

*RST: TXT

Example: See Example "User correction data exchange" on page 636 .

Manual operation: See "ASCII File Settings" on page 109

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SELect <Filename>

Selects the ASCII file to be imported or exported.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "User correction data exchange" on page 636 .

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 110

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:COLumn <Column>

Selects the separator between the frequency and level column of the ASCII table.

Parameters:
<Column> TABulator | SEMicolon | COMMa | SPACe

*RST: COMMa

Example: See Example "User correction data exchange" on page 636 .

Manual operation: See "ASCII File Settings" on page 109

[:SOURce<hw>]:CORRection:DEXChange:AFILe:SEParator:DECimal <Decimal>

Sets the decimal separator used in the ASCII data between '.' (decimal point) and ','
(comma) with floating-point numerals.

Parameters:
<Decimal> DOT | COMMa

*RST: DOT

Example: See Example "User correction data exchange" on page 636 .

Manual operation: See "ASCII File Settings" on page 109

[:SOURce<hw>]:CORRection:DEXChange:EXECute

Executes the import or export of the selected correction list, according to the previously
set transfer direction with command [:SOURce<hw>]:CORRection:DEXChange:
MODE.

Example: See Example "User correction data exchange" on page 636 .
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Usage: Event

Manual operation: See "Import / Export" on page 110

[:SOURce<hw>]:CORRection:DEXChange:MODE <Mode>

Determines import or export of a user correction list.

Specify the source or destination file with the command [:SOURce<hw>]:
CORRection:DEXChange:SELect.

Parameters:
<Mode> IMPort | EXPort

*RST: IMPort

Example: See Example "User correction data exchange" on page 636 .

Manual operation: See "Mode" on page 109

[:SOURce<hw>]:CORRection:DEXChange:SELect <Filename>

Selects the ASCII file for import or export, containing a user correction list.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "User correction data exchange" on page 636 .

Manual operation: See "Select Source/Select ASCII Destination" on page 110

14.16.4  SOURce:FREQuency subsystem

The SOURce:FREQuency subsystem contains the commands used to define the fre-
quency settings for the RF sources and sweeps.

Example: Frequency configuration
SOURce1:FREQuency:MODE CW
SOURce1:FREQuency:CW 6000000000
SOURce1:FREQuency:OFFSet 2000000000
SOURce1:FREQuency:MULTiplier 1.5
SOURce1:FREQuency:CW?
// 11000000000

// SOURce1:FREQuency:STEP:MODE USER
// SOURce1:FREQuency:STEP:INCRement 1000000
// SOURce1:FREQuency:CW UP

SOURce1:PHASe 2
SOURce1:PHASe:REFerence

SOURce subsystem



Remote control commandsR&S®SMA100B

643User Manual 1178.3834.02 ─ 09

Example: Setting a phase continuous frequency range

SOURce1:FREQuency:CW 502000000
SOURce1:FREQuency:PHASE:MODE NARR
SOURce1:FREQuency:PHASe:CONTinuous:STATe 1
******************************************
// Query the frequency range
SOURce1:FREQuency:PHASe:CONTinuous:LOW?
// Response:  49370890
SOURce1:FREQuency:PHASe:CONTinuous:HIGh?
// Response:  50421376
******************************************
// Vary the frequency. Within the specified range the signal is phase continuous.
SOURce1:FREQuency:CW 49900000
SOURce1:FREQuency:CW 50000000
SOURce1:FREQuency:CW 50100000
SOURce1:FREQuency:CW 50300000

[:SOURce<hw>]:FREQuency:MODE................................................................................643
[:SOURce<hw>]:FREQuency[:CW|FIXed].........................................................................644
[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL................................................................. 645
[:SOURce<hw>]:FREQuency:MANual..............................................................................645
[:SOURce<hw>]:FREQuency:MULTiplier.......................................................................... 646
[:SOURce<hw>]:FREQuency:OFFSet.............................................................................. 646
[:SOURce<hw>]:FREQuency:CENTer.............................................................................. 647
[:SOURce<hw>]:FREQuency:SPAN.................................................................................647
[:SOURce<hw>]:FREQuency:STARt................................................................................ 647
[:SOURce<hw>]:FREQuency:STOP.................................................................................648
[:SOURce<hw>]:FREQuency:STEP:MODE...................................................................... 648
[:SOURce<hw>]:FREQuency:STEP[:INCRement]............................................................. 648
[:SOURce<hw>]:FREQuency:PLL:MODE......................................................................... 649
[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:HIGH?................................................ 649
[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:LOW?................................................. 649
[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:MODE.................................................650
[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:STATe................................................. 650

[:SOURce<hw>]:FREQuency:MODE <Mode>

Sets the frequency mode for generating the RF output signal. The selected mode
determines the parameters to be used for further frequency settings.

Parameters:
<Mode> CW | FIXed | SWEep | LIST | COMBined

CW|FIXed
Sets the fixed frequency mode. CW and FIXed are synonyms.
The instrument operates at a defined frequency, set with com-
mand [:SOURce<hw>]:FREQuency[:CW|FIXed].
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SWEep
Sets sweep mode.
The instrument processes frequency (and level) settings in
defined sweep steps.
Set the range and current frequency with the commands:
[:SOURce<hw>]:FREQuency:STARt on page 647 and [:
SOURce<hw>]:FREQuency:STOP on page 648,
[:SOURce<hw>]:FREQuency:CENTer on page 647,
[:SOURce<hw>]:FREQuency:SPAN on page 647,
[:SOURce<hw>]:FREQuency:MANual on page 645
LIST
Sets list mode.
The instrument processes frequency and level settings by
means of values loaded from a list.
To configure list mode settings, use the commands of the Chap-
ter 14.16.7, "SOURce:LIST subsystem", on page 665.
COMBined
Sets the combined RF frequency / level sweep mode.
The instrument processes frequency and level settings in
defined sweep steps.
Set the range and current frequency with the commands:
[:SOURce<hw>]:COMBined:FREQuency:STARt
on page 707 and [:SOURce<hw>]:COMBined:FREQuency:
STOP on page 707,
[:SOURce<hw>]:COMBined:POWer:STARt on page 707
and [:SOURce<hw>]:COMBined:POWer:STOP on page 708
*RST: CW

Example: See Example "Frequency configuration" on page 642,
and Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "State (RF frequency sweep)" on page 188

[:SOURce<hw>]:FREQuency[:CW|FIXed] <Fixed>

Sets the frequency of the RF output signal in the selected path.

The effect depends on the selected mode:
● In CW mode (FREQ:MODE CW | FIXed), the instrument operates at a fixed fre-

quency.
● In sweep mode (FREQ:MODE SWE), the value applies to the sweep frequency.

The instrument processes the frequency settings in defined sweep steps.
● In user mode (FREQ:STEP:MODE USER), you can vary the current frequency step

by step.

Parameters:
<Fixed> float
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The following settings influence the value range:
An offset set with the command [:SOURce<hw>]:FREQuency:
OFFSet
Numerical value
Sets the frequency in CW and sweep mode
UP|DOWN
Varies the frequency step by step in user mode.
The frequency is increased or decreased by the value set with
the command [:SOURce<hw>]:FREQuency:STEP[:
INCRement].
Range: (RFmin + OFFSet) to (RFmax + OFFSet)
*RST: 100 MHz

Example: See Example "Frequency configuration" on page 642

Example: See Example "Setup an RF frequency or power sweep"
on page 697

Options: RFmax depends on the installed options, for example 3 GHz
with R&S SMAB-B103

Manual operation: See "Frequency" on page 72

[:SOURce<hw>]:FREQuency[:CW|FIXed]:RCL <Rcl>

Set whether the RF frequency value is retained or taken from a loaded instrument con-
figuration, when you recall instrument settings with command *RCL.

Parameters:
<Rcl> INCLude | EXCLude

INCLude
Takes the frequency value of the loaded settings.
EXCLude
Retains the current frequency when an instrument configuration
is loaded.
*RST: INCLude

Example: SOURce1:FREQuency:CW:RCL INCLude
Manual operation: See "Exclude Frequency" on page 320

[:SOURce<hw>]:FREQuency:MANual <Manual>

Sets the frequency and triggers a sweep step manually if SWEep:MODE MAN.

Parameters:
<Manual> float

You can select any frequency within the setting range, where:
STARt is set with [:SOURce<hw>]:FREQuency:STARt
STOP is set with [:SOURce<hw>]:FREQuency:STOP
OFFSet is set with [:SOURce<hw>]:FREQuency:OFFSet
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Range: (STARt + OFFSet) to (STOP + OFFSet)
Increment: 0.01Hz
*RST: 100 MHz
Default unit: Hz

Example: See Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "Current Frequency" on page 189

[:SOURce<hw>]:FREQuency:MULTiplier <Multiplier>

Sets the multiplication factor NFREQ:MULT of a subsequent downstream instrument.

The parameters offset fFREQ:OFFSer and multiplier NFREQ:MULT affect the frequency value
set with the command FREQ.

The query FREQ? returns the value corresponding to the formula:

fFREQ = fRFout * NFREQ:MULT + fFREQ:OFFSer

See "RF frequency and level display with a downstream instrument" on page 66.

Parameters:
<Multiplier> float

Range: -10000  to  10000
Increment: 0.001
*RST: 1

Example: See Example "Frequency configuration" on page 642

Manual operation: See "Multiplier" on page 73

[:SOURce<hw>]:FREQuency:OFFSet <Offset>

Sets the frequency offset fFREQ:OFFSet of a downstream instrument.

The parameters offset fFREQ:OFFSer and multiplier NFREQ:MULT affect the frequency value
set with the command FREQ.

The query FREQ? returns the value corresponding to the formula:

fFREQ = fRFout * NFREQ:MULT + fFREQ:OFFSer

See "RF frequency and level display with a downstream instrument" on page 66.

Note: The offset also affects RF frequency sweep.

Parameters:
<Offset> float

Increment: 0.01
*RST: 0

Example: See Example "Frequency configuration" on page 642

Manual operation: See "Offset" on page 73
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[:SOURce<hw>]:FREQuency:CENTer <Center>

Sets the center frequency of the sweep.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Parameters:
<Center> float

Range: 300 kHz  to  RFmax
Increment: 0.01 Hz
*RST: 300E6
Default unit: Hz

Example: See Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "Center Frequency" on page 194

[:SOURce<hw>]:FREQuency:SPAN <Span>

Sets the sapn of the frequency sweep range.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Parameters:
<Span> float

Full freqeuncy range
Increment: 0.01
*RST: 400E6

Example: See Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "Span" on page 195

[:SOURce<hw>]:FREQuency:STARt <Start>

Sets the start frequency for the RF sweep.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Parameters:
<Start> float

Range: 300kHz  to  RFmax
Increment: 0.01Hz
*RST: 100 MHz

Example: See Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "Start Frequency/Stop Frequency" on page 194
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[:SOURce<hw>]:FREQuency:STOP <Stop>

Sets the stop frequency range for the RF sweep.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Parameters:
<Stop> float

Range: 300kHz  to  RFmax
Increment: 0.01Hz
*RST: 500 MHz
Default unit: Hz

Example: See Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "Start Frequency/Stop Frequency" on page 194

[:SOURce<hw>]:FREQuency:STEP:MODE <Mode>

Defines the type of step size to vary the RF frequency at discrete steps with the com-
mands FREQ UP or FREQ DOWN.

Parameters:
<Mode> DECimal | USER

DECimal
Increases or decreases the level in steps of ten.
USER
Increases or decreases the level in increments, set with the
command FREQ:STEP[:INCR].
*RST: DECimal

Example: // increasing the RF frequency with a step size of 50 KHz
SOURce1:FREQuency:STEP 50E3
SOURce1:FREQuency:STEP:MODE USER
SOURce1:FREQuency:CW UP

Manual operation: See "Variation Active" on page 73

[:SOURce<hw>]:FREQuency:STEP[:INCRement] <Increment>

Sets the step width.

You can use this value to vary the RF frequency with command FREQ UP or FREQ
DOWN, if you have activated FREQ:STEP:MODE USER.

Note: This value also applies to the step width of the rotary knob on the instrument
and, in user-defined step mode, increases or decreases the frequency.
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Parameters:
<Increment> float

Range: 0 Hz  to  RFmax - 100 kHz
Increment: 0.01 Hz
*RST: 1E6

Example: See Example "Frequency configuration" on page 642

Manual operation: See "Variation Step" on page 73

[:SOURce<hw>]:FREQuency:PLL:MODE <Mode>

Selects the PLL (Phase Locked Loop) bandwidth of the main synthesizer.

Parameters:
<Mode> NORMal | NARRow

NORMal
Maximum modulation bandwidth and FM/PhiM deviation.
NARRow
Narrow PLL bandwidth
*RST: NORMal

Example: SOURce:FREQuency:PLL:MODE NORMal

Manual operation: See "Main PLL Bandwidth" on page 73

[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:HIGH?

Queries the maximum frequency of the frequency range for phase continuous settings.

The maximum frequency of the frequency range depends on the mode selected with
the command [:SOURce<hw>]:FREQuency:PHASe:CONTinuous:MODE.

Return values: 
<High> float

Range: 1E5  to  6E9
Increment: 0.01
*RST: 1E9
Default unit: Hz

Example: See Example "Setting a phase continuous frequency range"
on page 643.

Usage: Query only

Manual operation: See "Frequency Range From / To" on page 80

[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:LOW?

Queries the minimum frequency of the frequency range for phase continuous settings.

The minimum frequency of the frequency range depends on the mode selected with
the command [:SOURce<hw>]:FREQuency:PHASe:CONTinuous:MODE.
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Return values: 
<Low> float

Range: 1E5  to  6E9
Increment: 0.01
*RST: 1E9
Default unit: Hz

Example: See Example "Setting a phase continuous frequency range"
on page 643.

Usage: Query only

Manual operation: See "Frequency Range From / To" on page 80

[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:MODE <Mode>

Selects the mode that determines the frequency range for the phase continuity.

To query the frequency range, use the commands [:SOURce<hw>]:FREQuency:
PHASe:CONTinuous:HIGH? and [:SOURce<hw>]:FREQuency:PHASe:
CONTinuous:LOW?
Parameters:
<Mode> NARRow | WIDE

NARRow
Small frequency range, asymmetrically around the RF fre-
quency.
WIDE
Large frequency range, symmetrically around the RF frequency.
*RST: NARRow

Example: See [:SOURce<hw>]:FREQuency:PHASe:CONTinuous:
LOW? on page 649

Options: R&S SMAB-B711 (required for frequency range WIDE)

Manual operation: See "Frequency Range" on page 80

[:SOURce<hw>]:FREQuency:PHASe:CONTinuous:STATe <State>

Activates phase continuity of the RF frequency.

The frequency range is limited and varies depending on the set RF frequency. You can
query the range with the commands [:SOURce<hw>]:FREQuency:PHASe:
CONTinuous:HIGH? on page 649 and [:SOURce<hw>]:FREQuency:PHASe:
CONTinuous:LOW? on page 649.

Note: Restricted structure of command line.

In phase continuous mode, the R&S SMA100B only processes the first command of a
command line and ignores further commands if they are on the same line.
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Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Setting a phase continuous frequency range"
on page 643.

Manual operation: See "Phase Continuous Active" on page 79

14.16.5  SOURce:INPut subsystem

The SOURce:INPut subsystem contains the commands for configuring the inputs for
external modulation signals. The instrument trigger setting influences all sweeps and is
effective in the List mode (Instrument Trigger).

[:SOURce<hw>]:INPut:MODext:COUPling<ch>.................................................................651
[:SOURce<hw>]:INPut:MODext:IMPedance<ch>...............................................................651
[:SOURce]:INPut:TRIGger:SLOPe................................................................................... 652

[:SOURce<hw>]:INPut:MODext:COUPling<ch> <Coupling>

Selects the coupling mode for an externally applied modulation signal.

Parameters:
<Coupling> AC | DC

AC
Passes the AC signal component of the modulation signal.
DC
Passes the modulation signal with both components, AC and
DC.
For active external exponential AM, automatically sets [:
SOURce<hw>]:INPut:MODext:COUPling<ch>DC.
*RST: AC

Example: INP:MOD:COUP AC
Selects the coupling mode AC for an externally applied modula-
tion signal.

Manual operation: See "Coupling (AC/DC)" on page 118

[:SOURce<hw>]:INPut:MODext:IMPedance<ch> <Impedance>

Sets the impedance for the externally supplied modulation signal.

Parameters:
<Impedance> G50 | G600 | HIGH

G50 = 50 Ohm to ground
G600 = 600 Ohm to ground
HIGH = 100 kOhm to ground
*RST: HIGH
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Example: See [:SOURce<hw>]:INPut:MODext:COUPling<ch>
on page 651.

Manual operation: See "Impedance" on page 118

[:SOURce]:INPut:TRIGger:SLOPe <Slope>

Sets the polarity of the active slope of an applied instrument trigger.

Parameters:
<Slope> NEGative | POSitive

*RST: POSitive

Example: INP:TRIG:SLOP NEG
Activates the falling slope of the external trigger signal at the
trigger input.

Manual operation: See " Trigger Slope" on page 193

14.16.6  SOURce:LFOutput subsystem

The SOURce:LFOutput subsystem contains the commands for setting the LF signal
source in CW and Sweep mode and for analog modulation.

Example: Setup an LF sweep
The following example shows a command sequence to set up an LF sweep.

// Reset the instrument to start from an initial state
*RST; *CLS

// Set the trigger mode, the sweep mode and the sweep range
TRIGger1:LFFSweep:SOURce SINGle
SOURce1:LFOutput1:SWEep:FREQuency:MODE AUTO
SOURce1:LFOutput1:FREQuency:STARt 1 kHz
SOURce1:LFOutput1:FREQuency:STOP 7 kHz

// Select linear spacing
// Select the waveform shape for the frequency sweep cycle
// Set the step width and the dwell time.
SOURce1:LFOutput1:SWEep:FREQuency:SPACing LINear
SOURce1:LFOutput1:SWEep:FREQuency:SHAPe SAWtooth
SOURce1:LFOutput1:SWEep:FREQuency:STEP:LINear 100 Hz
SOURce1:LFOutput1:SWEep:FREQuency:DWELl 150 ms
// Alternatively to the step width set the number of steps
SOURce1:LFOutput1:SWEep:FREQuency:POINts 61

// Activate change to start frequency while waiting for next trigger
// Prerequisites: sweep mode single and sweep waveform sawtooth
SOURce1:LFOutput:SWEep:FREQuency:RETRace 1
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// Activate the LF frequency sweep
SOURce1:LFOutput:FREQuency:MODE SWE

// Trigger the sweep(depending on the set mode) and query the status
// Perform a one-off LF sweep
SOURce1:LFOutput1:SWEep:FREQuency:EXECute
SOURce1:LFOutput1:SWEep:FREQuency:RUNNing?
// 1
// the sweep is running

// ***************************************************
// For manual step LF sweep use the following commands 
*RST; *CLS
SOURce1:LFOutput:SWEep:FREQuency:MODE MANual
// Activate the LF frequency sweep
SOURce1:LFOutput:FREQuency:MODE SWEep
// Activate LF Output1.
SOURce1:LFOutput1:STATe 1
// Input the frequency manually for each step
SOURce1:LFOutput1:FREQuency:MANual 2 kHz
SOURce1:LFOutput1:FREQuency:MANual 2.1 kHz
// Alternatively use UP or DOWN parameter with set step width.
SOURce1:LFOutput1:SWEep:FREQuency:STEP:LINear 500 Hz
SOURce1:LFOutput1:FREQuency:MANual UP

Example: Configuring the LF generator
The following is a simple example on how to configure the LF generator and output the
generated signal.

// configure the signal of the LF1 generator
SOURce1:LFOutput1:SHAPe SQU
SOURce1:LFOutput1:SHAPe:PULSe:PERiod 0.001
SOURce1:LFOutput1:SHAPe:PULSe:WIDTh 0.0005
SOURce1:LFOutput1:SHAPe:PULSe:DCYCle 0.5
// configure the signal of the LF1 generator
SOURce1:LFOutput2:SHAPe SINE
SOURce1:LFOutput2:FREQuency 1000000
SOURce1:LFOutput2:PERiod?
// 0.000001

// changing the LF signal shape
// SOURce1:LFOutput2:SHAPe TRAP
// SOURce1:LFOutput2:SHAPe:PULSe:PERiod 0.2
// SOURce1:LFOutput2:SHAPe:TRAPeze:RISE 0.0001
// SOURce1:LFOutput2:SHAPe:TRAPeze:FALL 0.001 
// SOURce1:LFOutput2:SHAPe:TRAPeze:FALL 0.0001
// SOURce1:LFOutput2:SHAPe:TRAPeze:HIGH 0.0005
// SOURce1:LFOutput2:SHAPe TRI
// SOURce1:LFOutput2:SHAPe:PULSe:PERiod 0.1
// SOURce1:LFOutput2:SHAPe:TRIangle:RISE 0.0001
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// activate the LF output and select the LF1 as signal source
// configure the LF output signal
SOURce1:LFOutput1:FREQuency:MODE CW
SOURce1:LFOutput1:STATe 1
SOURce1:LFOutput1:SOURce LF1
SOURce1:LFOutput1:INTernal:VOLTage 1
SOURce1:LFOutput1:OFFSet 0.001

● LF generator settings............................................................................................ 654
● LF sweep settings................................................................................................. 661

14.16.6.1  LF generator settings

With the commands described in this section, you can configure the LF signal source.

[:SOURce]:LFOutput<ch>:BANDwidth?............................................................................654
[:SOURce]:LFOutput<ch>:FREQuency.............................................................................655
[:SOURce<hw>]:LFOutput<ch>:PERiod?..........................................................................655
[:SOURce<hw>]:LFOutput:FREQuency:MANual............................................................... 655
[:SOURce<hw>]:LFOutput:FREQuency:MODE................................................................. 656
[:SOURce<hw>]:LFOutput:FREQuency:STOP.................................................................. 656
[:SOURce<hw>]:LFOutput:FREQuency:STARt..................................................................656
[:SOURce]:LFOutput<ch>[:STATe]................................................................................... 657
[:SOURce]:LFOutput<ch>:INTernal:VOLTage.................................................................... 657
[:SOURce]:LFOutput:OFFSet.......................................................................................... 657
[:SOURce]:LFOutput<ch>:SOURce................................................................................. 658
[:SOURce]:LFOutput<ch>:SOURce:PATH........................................................................ 658
[:SOURce]:LFOutput:VOLTage........................................................................................ 658
[:SOURce<hw>]:LFOutput<ch>:SHAPe............................................................................658
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:DCYCle....................................................659
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:PERiod.....................................................659
[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:WIDTh......................................................659
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:FALL.................................................... 660
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:HIGH....................................................660
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:PERiod................................................. 660
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:RISE.................................................... 660
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:PERiod..................................................661
[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:RISE..................................................... 661

[:SOURce]:LFOutput<ch>:BANDwidth?

Queries the bandwidth of the external LF signal.

Return values: 
<Bandwidth> BW0M2 | BW10m

*RST: BW10m

Example: LFO:BAND?
// BW10m
// the bandwidth of the externally supplied LF signal is 10 MHz
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Usage: Query only

Manual operation: See "Bandwidth" on page 118

[:SOURce]:LFOutput<ch>:FREQuency <Frequency>

Sets the frequency of the LF signal in [:SOURce<hw>]:LFOutput:FREQuency:
MODE CW|FIXed mode.

Note
● If signal source "Internal" is set, the instrument performs the analog modulations

(AM/FM/PhiM/PM) with this frequency.
● In sweep mode ([:SOURce<hw>]:LFOutput:FREQuency:MODE SWE), the fre-

quency is coupled with the sweep frequency.

Parameters:
<Frequency> float

Range: depends on the installed options
Increment: 0.01
*RST: 1000
Default unit: Hz

Example: SOURce1:LFOutput1:FREQuency 5 kHz
// sets the LF frequency

Manual operation: See "Frequency" on page 116

[:SOURce<hw>]:LFOutput<ch>:PERiod?

Queries the repetition frequency of the sine signal.

Return values: 
<LfSinePeriod> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 0.001
Default unit: s

Example: See Example "Configuring the LF generator" on page 653.

Usage: Query only

[:SOURce<hw>]:LFOutput:FREQuency:MANual <Manual>

Sets the frequency of the subsequent sweep step if LFO:SWE:MODE MAN.

Use a separate command for each sweep step.
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Parameters:
<Manual> float

You can select any value within the setting range, where:
STARt is set with [:SOURce<hw>]:LFOutput:FREQuency:
STARt
STOP is set with [:SOURce<hw>]:LFOutput:FREQuency:
STOP
Range: STARt to STOP
Increment: 0.1
*RST: 1000

Example: See Example "Setup an LF sweep" on page 652.

Manual operation: See "Current Frequency" on page 189

[:SOURce<hw>]:LFOutput:FREQuency:MODE <Mode>

Sets the mode for the output of the LF generator frequency, and determines the com-
mands to be used for frequency settings.

Parameters:
<Mode> CW | FIXed | SWEep

CW|FIXed
Sets the fixed-frequency mode. CW and FIXed are synonyms.
To set the output frequency, use command [:SOURce]:
LFOutput<ch>:FREQuency
SWEep
Sets sweep mode.
To set the frequency, use the commands:
[:SOURce<hw>]:LFOutput:FREQuency:STARt and [:
SOURce<hw>]:LFOutput:FREQuency:STOP
Or [:SOURce<hw>]:LFOutput:FREQuency:MANual
*RST: CW

Example: See Example "Setup an LF sweep" on page 652.

Manual operation: See "State (LF frequency sweep)" on page 114

[:SOURce<hw>]:LFOutput:FREQuency:STOP <Stop>
[:SOURce<hw>]:LFOutput:FREQuency:STARt <Start>
Sets the start/stop frequency for [:SOURce<hw>]:LFOutput:FREQuency:MODE
 SWEep.

Parameters:
<Start> float

Range: 0.1 Hz  to  1 MHz
Increment: 0.1
*RST: 1 KHz
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Example: See Example "Setup an LF sweep" on page 652.

Manual operation: See "Start Frequency/Stop Frequency" on page 194

[:SOURce]:LFOutput<ch>[:STATe] <State>

Activates LF signal output.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "State" on page 120

[:SOURce]:LFOutput<ch>:INTernal:VOLTage <Voltage>

Sets the output voltage for the LF generators.

The sum of both values must not exceed the overall output voltage, set with command
[:SOURce]:LFOutput:VOLTage.

Suffix: 
<ch>

.
[1]|2
LF1 and LF2

Parameters:
<Voltage> float

Range: 0  to  4
Increment: 0.001
*RST: 1

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Output Voltage" on page 121

[:SOURce]:LFOutput:OFFSet <Offset>

Sets a DC offset at the LF Output.

Parameters:
<Offset> float

Range: depends on lfo voltage
Increment: 0.001
*RST: 0

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "DC-Offset" on page 121
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[:SOURce]:LFOutput<ch>:SOURce <Source>

Determines the LF signal to be synchronized, when monitoring is enabled.

Parameters:
<Source> LF1 | LF2 | NOISe | AM | FMPM | EXT1 | | EXT2

LF1|LF2
Selects an internally generated LF signal.
NOISe
Selects an internally generated noise signal.
EXT1|EXT2
Selects an externally supplied LF signal
AM
Selects the AM signal.
FMPM
Selects the signal also used by the frequency or phase modula-
tions.
*RST: LF1

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Source" on page 121

[:SOURce]:LFOutput<ch>:SOURce:PATH <SourPath>

Determines the path of the LF output source.

Parameters:
<SourPath> A | B

*RST: A

Example: LFO:SOUR:PATH?
Queries the currently set path for the LF output signal source.

[:SOURce]:LFOutput:VOLTage <Voltage>

Sets the voltage of the LF output.

Parameters:
<Voltage> float

Range: dynamic (see data sheet)
Increment: 0.001
*RST: 1

Example: SOURce:LFOutput:VOLTage 1.5

[:SOURce<hw>]:LFOutput<ch>:SHAPe <Shape>

Selects the waveform shape of the LF signal.
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Parameters:
<Shape> SINE | SQUare | PULSe | TRIangle | TRAPeze

*RST: SINE

Example: See Example "Configuring the LF generator" on page 653.

Options: TRIangle|TRAPeze require R&S SMAB-K24

Manual operation: See "Shape" on page 114

[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:DCYCle <DCycle>

Sets the duty cycle for the shape pulse.

Parameters:
<DCycle> float

Range: 1E-6  to  100
Increment: 1E-6
*RST: 50
Default unit: PCT

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Pulse Duty Cycle" on page 116

[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:PERiod <Period>

Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

Parameters:
<Period> float

Range: 1E-6  to  100
Increment: 1E-8
*RST: 1E-3

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Period" on page 116

[:SOURce<hw>]:LFOutput<ch>:SHAPe:PULSe:WIDTh <Width>

Sets the pulse width of the generated pulse.

Parameters:
<Width> float

Range: 1E-6  to  100
Increment: 1E-8
*RST: 5E-4

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Pulse Width" on page 116
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[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:FALL <Fall>

Selects the fall time for the trapezoid shape of the LF generator.

Parameters:
<Fall> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 250E-6

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Trapezoid Rise / Fall" on page 117

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:HIGH <High>

Sets the high time for the trapezoid signal of the LF generator.

Parameters:
<High> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 250E-6

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Trapezoid High" on page 117

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:PERiod <Period>

Sets the period of the generated trapezoid shape. The period determines the repetition
frequency of the internal signal.

Parameters:
<Period> float

Range: 1E-6  to  100
Increment: 1E-8
*RST: 1E-3

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Period" on page 116

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRAPeze:RISE <Rise>

Selects the rise time for the trapezoid shape of the LF generator.

Parameters:
<Rise> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 250E-6
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Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Trapezoid Rise / Fall" on page 117

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:PERiod <Period>

Sets the period of the generated pulse. The period determines the repetition frequency
of the internal signal.

Parameters:
<Period> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 0.001

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Period" on page 116

[:SOURce<hw>]:LFOutput<ch>:SHAPe:TRIangle:RISE <Rise>

Selects the rise time for the triangle single of the LF generator.

Parameters:
<Rise> float

Range: 1E-6  to  100
Increment: 10E-9
*RST: 0.5E-3

Example: See Example "Configuring the LF generator" on page 653.

Manual operation: See "Triangle Rise" on page 117

14.16.6.2  LF sweep settings

With the commands described in this section, you can configure the sweep of the LF
signal.

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:DWELl................................................... 661
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:EXECute................................................ 662
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE....................................................662
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:POINts...................................................663
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RETRace............................................... 663
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RUNNing?..............................................663
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SHAPe...................................................663
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SPACing................................................ 664
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP:LOGarithmic..................................664
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP[:LINear]........................................ 664

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:DWELl <Dwell>

Sets the dwell time for each frequency step of the sweep.
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Parameters:
<Dwell> float

Range: 0.001  to  100
Increment: 100E-6
*RST: 0.01
Default unit: s

Example: See Example "Setup an LF sweep" on page 652.

Manual operation: See "Dwell Time" on page 192

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:EXECute

Immediately starts an LF sweep.

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE determines which sweep
is executed, e.g. SOURce:LFOutput:SWEep:FREQuency:MODE STEP.

Example: See Example "Setup an LF sweep" on page 652.

Usage: Event

Manual operation: See "Execute Single Sweep" on page 193

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE <Mode>

Sets the cycle mode of the LF sweep.

Parameters:
<Mode> AUTO | MANual | STEP

AUTO
Performs a complete sweep cycle from the start to the end value
when a trigger event occurs.
The dwell time determines the time period until the signal
switches to the next step.
MANual
Performs a single sweep step when a manual trigger event
occurs.
The trigger system is not active. To trigger each frequency step
of the sweep individually, use the command [:SOURce<hw>]:
LFOutput:FREQuency:MANual on page 655.
STEP
Each trigger command triggers one sweep step only.
The frequency increases by the value set with the coammnds:
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP[:
LINear] (linear spacing)
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP:
LOGarithmic(logarithmic spacing)
*RST: AUTO

Example: See Example "Setup an LF sweep" on page 652.
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Manual operation: See "Mode" on page 189

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:POINts <Points>

Sets the number of steps in an LF sweep.

For information on how the value is calculated and the interdependency with other
parameters, see Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181

Parameters:
<Points> integer

Range: 2  to  POINts
*RST: 50

Example: See Example "Setup an LF sweep" on page 652.

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RETRace <State>

Activates that the signal changes to the start frequency value while it is waiting for the
next trigger event.

You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single".

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Manual operation: See "Retrace" on page 190

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:RUNNing?

Queries the current status of the LF frequency sweep mode.

Return values: 
<State> 1 | ON | 0 | OFF

Example: See Example "Setup an LF sweep" on page 652.

Usage: Query only

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SHAPe <Shape>

Sets the cycle mode for a sweep sequence (shape).

Parameters:
<Shape> SAWTooth | TRIangle

*RST: SAWTooth

Example: See Example "Setup an LF sweep" on page 652.

Manual operation: See "Shape" on page 191
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[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:SPACing <Spacing>

Selects linear or logarithmic sweep spacing.

Parameters:
<Spacing> LINear | LOGarithmic

*RST: LINear

Example: See Example "Setup an LF sweep" on page 652.

Manual operation: See "Spacing" on page 192

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP:LOGarithmic
<Logarithmic>

Sets the step width factor for logarithmic sweeps to calculate the frequencies of the
steps.

For information on how the value is calculated and the interdependency with other
parameters, see Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181

Parameters:
<Logarithmic> float

The unit is mandatory
Range: 0.01  to  100
Increment: 0.01
*RST: 1
Default unit: PCT

Example: See Example "Setup an LF sweep" on page 652.

Manual operation: See "Step Linear/Step Logarithmic" on page 195

[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:STEP[:LINear] <Linear>

Sets the step width for the linear sweep.

For information on how the value is calculated and the interdependency with other
parameters, see Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181

Parameters:
<Linear> float

Range: 0.1  to  STOP-STARt
Increment: 0.1
*RST: 1000

Example: See Example "Setup an LF sweep" on page 652.

Manual operation: See "Step Linear/Step Logarithmic" on page 195
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14.16.7  SOURce:LIST subsystem

The SOURce:LIST subsystem contains all commands for defining lists and for han-
dling of list files.

List files have the predefined file extension *.lsw.

Refer to Chapter 14.5.2, "Accessing files in the default or in a specified directory",
on page 458 for general information on file handling in the default and in a specific
directory.

● *RST does not affect data lists.
● SCPI refers to the individual lists as segments.

Example: Create an RF list and activate the list mode
The following example shows a command sequence to create an RF list and to acti-
vate the list mode. Further hardware settings are not considered.

// Reset the instrument to start from an initial state
// Query the available list files in the default 
// directory /var/user
// Select the list file or create it (if not existing)
*RST; *CLS
SOUR1:LIST:CAT?
// Response:- shows the name of available list files (if applicable)
SOUR1:LIST:SEL "/var/user/list1.lsw"

// Write the frequency/level/dwell time values in the selected list file
// existing data is overwritten
// Query the number of frequency/power/dwell time entries in the selected list
// Query the amount of free memory (in bytes) for list mode lists
SOUR1:LIST:FREQ 58 MHz, 61 MHz, 73 MHz, 86 MHz, 91 MHz, 92 MHz, 98 MHz
SOUR1:LIST:POW 13 dBm, 12 dBm, 5 dBm, 3 dBm, 0 dBm, 4 dBm, 6 dBm 
SOUR1:LIST:DWEL:LIST 10000, 100000, 200000, 19000, 10000, 150000, 220000 
SOUR1:LIST:FREQ:POIN?
// 7 
SOUR1:LIST:POW:POINT?
// 7
SOUR1:LIST:DWEL:LIST:POIN?
// 7 
SOUR1:LIST:FREE?
// 2147483647 (bytes of free memory)

// Use dwell times from list
// Configure the list mode parameters
// Enable RF output
SOUR1:LIST:MODE AUTO
SOUR1:LIST:TRIG:SOUR AUTO
SOUR1:LIST:DWEL:MODE "LIST"
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OUTP1:STAT ON

// Use global dwell time
// Set only a part of the list (value pairs 3 to 5) to be processed
// Configure the list mode parameters using global dwell time
// Enable RF output
SOUR1:LIST:IND:START 2
SOUR1:LIST:IND:STOP 4
SOUR1:LIST:MODE AUTO
SOUR1:LIST:TRIG:SOUR AUTO
SOUR1:LIST:DWEL:LIST 500 ms
OUTP1:STAT ON

// Enable the list mode
// Trigger the list (depending on the mode, not needed with trigger 
// mode AUTO); query the current index 
// Reset the list to the starting point
SOUR1:FREQ:MODE LIST
SOUR1:LIST:TRIG:EXEC
SOUR1:LIST:RUNN?
SOUR1:LIST:IND?
// 3
// value changes when the value is queried again
SOUR1:LIST:RES

// For list mode STEP use the following commands 
*RST; *CLS
// Change list mode to STEP
SOUR1:LIST:MODE STEP
// Activate RF Output1
OUTP1:STAT 1
// Activate the list mode
SOUR1:FREQ:MODE LIST
// For each step: select frequency/powerlevel pair as index from the list 
SOUR1:LIST:IND 2
SOUR1:LIST:IND 3
SOUR1:LIST:IND 4

// Use the selected list for path B (with List Mode B default settings)
SOUR2:LIST:SEL "/var/user/list1.lsw"
OUTP2:STAT ON
SOUR2:FREQ:MODE LIST
SOUR2:LIST:IND?
// 2 
// value canges when the value is queried again

// Deactivate the list mode
SOUR1:FREQ:MODE CW
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Example: List mode data exchange
The following example shows a command sequence to export a list (here the RF list
created with the example before) into an ASCII file. Further hardware settings are not
considered.

*RST; *CLS
LIST:DEXC:MODE EXP

// Set ASCII data parameters
// Set the ASCII file extension, the decimal separator
// and the column separator for the ASCII data
SOUR1:LIST:DEXC:AFIL:EXT CSV
SOUR1:LIST:DEXC:AFIL:SEP:DEC DOT
SOUR1:LIST:DEXC:AFIL:SEP:COL COMM 

// Select source and destination path/directory 
// Query available listfiles in default directory "/var/user"
SOUR1:LIST:CAT?
// list1
SOUR1:LIST:DEXC:AFIL:SEL "/var/user/list1ASCII"
SOUR1:LIST:DEXC:SEL "/var/user/list1" 

// Export the list file data into the ASCII file
SOUR1:LIST:DEXC:EXEC

// Query the available ASCII files with extension .csv
SOUR1:LIST:DEXC:AFIL:CAT?
// Response: "list1ASCII"

// Deactivate the list mode
SOUR1:FREQ:MODE CW

● List mode settings................................................................................................. 667
● List mode file operation.........................................................................................673
● List mode data exchange......................................................................................675

14.16.7.1  List mode settings

With the following commands, you can create list mode data, select the trigger mode
and determine the dwell time.

[:SOURce<hw>]:LIST:DWELl.......................................................................................... 668
[:SOURce<hw>]:LIST:DWELl:MODE................................................................................668
[:SOURce<hw>]:LIST:DWELl:LIST...................................................................................668
[:SOURce<hw>]:LIST:DWELl:LIST:POINts?......................................................................669
[:SOURce<hw>]:LIST:FREQuency...................................................................................669
[:SOURce<hw>]:LIST:FREQuency:POINts?......................................................................670
[:SOURce<hw>]:LIST:INDex............................................................................................670
[:SOURce<hw>]:LIST:INDex:STARt................................................................................. 670
[:SOURce<hw>]:LIST:INDex:STOP..................................................................................670
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[:SOURce<hw>]:LIST:MODE...........................................................................................670
[:SOURce<hw>]:LIST:POWer.......................................................................................... 671
[:SOURce<hw>]:LIST:POWer:POINts?.............................................................................671
[:SOURce<hw>]:LIST:TRIGger:EXECute..........................................................................672
[:SOURce<hw>]:LIST:TRIGger:SOURce.......................................................................... 672
[:SOURce<hw>]:LIST:RUNNing?..................................................................................... 673

[:SOURce<hw>]:LIST:DWELl <Dwell>

Sets the global dwell time. The instrument generates the signal with the frequency /
power value pairs of each list entry for that particular period.

See also Significant parameters and functions.

Parameters:
<Dwell> float

Range: 1E-3  to  100
Increment: 1E-6
*RST: 0.01

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "Global Dwell Time" on page 203

[:SOURce<hw>]:LIST:DWELl:MODE <DwelMode>

Selects the dwell time mode.

Parameters:
<DwelMode> LIST | GLOBal

LIST
Uses the dwell time, specified in the data table for each value
pair individually.
GLOBal
Uses a constant dwell time, set with command [:
SOURce<hw>]:LIST:DWELl.
*RST: GLOBal

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "Dwell Time Mode" on page 203

[:SOURce<hw>]:LIST:DWELl:LIST <Dwell>

Enters the dwell time values in the selected list in µs.
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Parameters:
<Dwell> <Dwell#1>{, <Dwell#2>, ...} | block data

You can either enter the data as a list of numbers, or as binary
block data. The list of numbers can be of any length, with the list
entries separated by commas.
In binary block format, 8 (4) bytes are always interpreted as a
floating-point number with double accuracy. See also :
FORMat[:DATA] on page 483 for more details.

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "Edit List Mode Data" on page 209

[:SOURce<hw>]:LIST:DWELl:LIST:POINts?

Queries the number (points) of dwell time entries in the selected list.

Return values: 
<Points> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Usage: Query only

[:SOURce<hw>]:LIST:FREQuency <Frequency>

Enters the frequency values in the selected list.

Parameters:
<Frequency> <Frequency#1>{, <Frequency#2>, ...} | block data

You can either enter the data as a list of numbers, or as binary
block data.
The list of numbers can be of any length, with the list entries
separated by commas.
In binary block format, 8 (4) bytes are always interpreted as a
floating-point number with double accuracy.
See also :FORMat[:DATA].
Range: 300 kHz  to  RFmax (depends on the installed

options)

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "Edit List Mode Data" on page 209
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[:SOURce<hw>]:LIST:FREQuency:POINts?

Queries the number (points) of frequency entries in the seleced list.

Return values: 
<Points> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Usage: Query only

[:SOURce<hw>]:LIST:INDex <Index>

Sets the list index in LIST:MODE STEP.

After the trigger signal, the instrument processes the frequency and level settings of
the selected index.

Parameters:
<Index> integer

*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "Current Index" on page 202

[:SOURce<hw>]:LIST:INDex:STARt <Start>
[:SOURce<hw>]:LIST:INDex:STOP <Stop>
Sets the start and stop index of the index range which defines a subgroup of fre-
quency/level value pairs in the current list.

Parameters:
<Stop> integer

Index range
Only values inside this range are processed in list mode
Range: 0  to  list length
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "List Range from/to" on page 205

[:SOURce<hw>]:LIST:MODE <Mode>

Sets the list mode.
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The instrument processes the list according to the selected mode and trigger source.
See LIST:TRIG:SOUR AUTO, SING or EXT for the description of the trigger
source settings.

Parameters:
<Mode> AUTO | STEP

AUTO
Each trigger event triggers a complete list cycle.
STEP
Each trigger event triggers only one step in the list processing
cycle. The list is processed in ascending order.
*RST: AUTO

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "Mode" on page 203

[:SOURce<hw>]:LIST:POWer <Power>

Enters the level values in the selected list. The number of level values must corre-
spond to the number of frequency values. Existing data is overwritten.

Parameters:
<Power> <Power#1>{, <Power#2>, ...} | block data

You can either enter the data as a list of numbers, or as binary
block data.
The list of numbers can be of any length, with the list entries
separated by commas.
In binary block format, 8 (4) bytes are always interpreted as a
floating-point number with double accuracy.
See also :FORMat[:DATA].
Range: depends on the installed options
Default unit: dBm

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "Edit List Mode Data" on page 209

[:SOURce<hw>]:LIST:POWer:POINts?

Queries the number (points) of level entries in the selected list.

Return values: 
<Points> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 665.
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Usage: Query only

[:SOURce<hw>]:LIST:TRIGger:EXECute

Starts the processing of a list in list mode.

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Usage: Event

Manual operation: See "Execute Single" on page 204

[:SOURce<hw>]:LIST:TRIGger:SOURce <Source>

Selects the trigger source for processing lists.

The designation of the parameters correspond to those in sweep mode. SCPI standard
uses other designations for the parameters, which are also accepted by the instrument.
The SCPI designation should be used if compatibility is an important consideration. For
an overview, see the following table:

Rohde & Schwarz parameter SCPI parameter Applies to the list mode parameters:

AUTO IMMediate [:SOURce<hw>]:LIST:MODE AUTO

SINGle BUS [:SOURce<hw>]:LIST:MODE AUTO or

[:SOURce<hw>]:LIST:MODE STEP

EXTernal EXTernal [:SOURce<hw>]:LIST:MODE AUTO or

[:SOURce<hw>]:LIST:MODE STEP

Parameters:
<Source> AUTO | IMMediate | SINGle | BUS | EXTernal

AUTO|IMMediate
The trigger is free-running, i.e. the trigger condition is fulfilled
continuously. The selected list is restarted as soon as it is fin-
ished.
SINGle|BUS
The list is triggered by the command [:SOURce<hw>]:LIST:
TRIGger:EXECute. The list is executed once.
EXTernal
The list is triggered externally and executed once.
*RST: AUTO

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "Mode" on page 203
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[:SOURce<hw>]:LIST:RUNNing?

Queries the current state of the list mode.

Return values: 
<State> 1 | ON | 0 | OFF

1
Signal generation based on the list mode is active.

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Usage: Query only

14.16.7.2  List mode file operation

The following section covers basic commands to file handling in list mode.

[:SOURce<hw>]:LIST:CATalog?.......................................................................................673
[:SOURce<hw>]:LIST:DELete..........................................................................................673
[:SOURce<hw>]:LIST:DELete:ALL................................................................................... 674
[:SOURce<hw>]:LIST:FREE?.......................................................................................... 674
[:SOURce<hw>]:LIST:RESet........................................................................................... 674
[:SOURce<hw>]:LIST:SELect.......................................................................................... 675

[:SOURce<hw>]:LIST:CATalog?

Queries the available list files in the specified directory.

Return values: 
<Catalog> string

List of list filenames, separated by commas

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Usage: Query only

Manual operation: See "List Mode Data" on page 204

[:SOURce<hw>]:LIST:DELete <Filename>

Deletes the specified list.

Setting parameters: 
<Filename> string

Filename or complete file path; file extension is optional.

Example: See [:SOURce<hw>]:LIST:DELete:ALL on page 674.

Usage: Setting only

Manual operation: See "List Mode Data" on page 204
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[:SOURce<hw>]:LIST:DELete:ALL

Deletes all lists in the set directory.

This command can only be executed, if:
● No list file is selected.
● List mode is disabled.

Example: SOUR1:LIST:CAT?
// list,my_list
SOUR1:LIST:DEL "/var/user/list1"
SOUR1:LIST:CAT?
// my_list
SOUR1:FREQ:MODE?
// LIST
SOUR1:LIST:SEL?
// /var/user/my_list.lsw
//deactivate list mode
SOUR1:FREQ:MODE CW
SOUR1:LIST:DELete:ALL
SOUR1:LIST:CAT?
// -
// all list files are deleted

Usage: Event

Manual operation: See "List Mode Data" on page 204

[:SOURce<hw>]:LIST:FREE?

Queries the amount of free memory (in bytes) for list mode lists.

Return values: 
<Free> integer

Range: 0  to  INT_MAX
*RST: 0

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Usage: Query only

[:SOURce<hw>]:LIST:RESet

Jumps to the beginning of the list.

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Usage: Event

Manual operation: See "Reset" on page 204
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[:SOURce<hw>]:LIST:SELect <Filename>

Selects or creates a data list in list mode.

If the list with the selected name does not exist, a new list is created.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "Create an RF list and activate the list mode"
on page 665.

Manual operation: See "List Mode Data" on page 204

14.16.7.3  List mode data exchange

With the following commands, you can configure lists in ASCII format and export or
import them accordingly.

[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog?.......................................................... 675
[:SOURce<hw>]:LIST:DEXChange:EXECute.................................................................... 675
[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension.........................................................676
[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect..............................................................676
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn........................................... 676
[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal........................................... 676
[:SOURce<hw>]:LIST:DEXChange:MODE........................................................................677
[:SOURce<hw>]:LIST:DEXChange:SELect....................................................................... 677

[:SOURce<hw>]:LIST:DEXChange:AFILe:CATalog?

Queries the available ASCII files for export or import of list mode data in the current or
specified directory.

Return values: 
<Catalog> string

List of ASCII files *.txt or *.csv, separated by commas.

Example: See Example "List mode data exchange" on page 667.

Usage: Query only

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 110

[:SOURce<hw>]:LIST:DEXChange:EXECute

Executes the import or export of the selected list file, according to the previously set
transfer direction with command [:SOURce<hw>]:LIST:DEXChange:MODE
Example: See Example "List mode data exchange" on page 667.

Usage: Event
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Manual operation: See "Import / Export" on page 110

[:SOURce<hw>]:LIST:DEXChange:AFILe:EXTension <Extension>

Determines the extension of the ASCII file for import or export, or to query existing
files.

Parameters:
<Extension> TXT | CSV

*RST: TXT

Example: See Example "List mode data exchange" on page 667.

Manual operation: See "ASCII File Settings" on page 109

[:SOURce<hw>]:LIST:DEXChange:AFILe:SELect <Filename>

Selects the ASCII file to be imported or exported.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "List mode data exchange" on page 667.

Manual operation: See "Select (ASCII) Source/Select (ASCII) Destination"
on page 110

[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:COLumn <Column>

Selects the separator between the frequency and level column of the ASCII table.

Parameters:
<Column> TABulator | SEMicolon | COMMa | SPACe

*RST: COMMa

Example: See Example "List mode data exchange" on page 667.

Manual operation: See "ASCII File Settings" on page 109

[:SOURce<hw>]:LIST:DEXChange:AFILe:SEParator:DECimal <Decimal>

Sets "." (decimal point) or "," (comma) as the decimal separator used in the ASCII data
with floating-point numerals.

Parameters:
<Decimal> DOT | COMMa

*RST: DOT

Example: See Example "List mode data exchange" on page 667.

Manual operation: See "ASCII File Settings" on page 109
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[:SOURce<hw>]:LIST:DEXChange:MODE <Mode>

Determines the import or export of a list.

Specify the source or destination file with the command [:SOURce<hw>]:LIST:
DEXChange:SELect.

Parameters:
<Mode> IMPort | EXPort

*RST: IMPort

Example: See Example "List mode data exchange" on page 667.

Manual operation: See "Mode" on page 109

[:SOURce<hw>]:LIST:DEXChange:SELect <Filename>

Selects the ASCII file for import or export, containing a list.

Parameters:
<Filename> string

Filename or complete file path; file extension can be omitted.

Example: See Example "List mode data exchange" on page 667.

Manual operation: See "Select Source/Select ASCII Destination" on page 110

14.16.8  SOURce:NOISe subsystem

The SOURce:NOISe subsystem contains the commands for:
● Setting the noise modulation signal. The noise generator is optional.

Example: Configuring the noise generator
SOURce1:NOISe:DISTribution GAUSs
SOURce1:NOISe:BANDwidth 10000000
SOURce1:NOISe:BANDwidth:STATe 1

SOURce1:LFOutput1:SOURce NOIS
SOURce1:LFOutput1:STATe 1

SOURce1:NOISe:LEVel:RELative?
// -83.86
SOURce1:NOISe:LEVel:ABSolute?
// -13.86

● Noise generator.....................................................................................................678
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14.16.8.1  Noise generator

[:SOURce<hw>]:NOISe:BANDwidth|BWIDth.....................................................................678
[:SOURce<hw>]:NOISe:BWIDth:STATe............................................................................ 678
[:SOURce<hw>]:NOISe:DISTribution............................................................................... 678
[:SOURce<hw>]:NOISe:LEVel:RELative?......................................................................... 678
[:SOURce<hw>]:NOISe:LEVel[:ABSolute]?.......................................................................679

[:SOURce<hw>]:NOISe:BANDwidth|BWIDth <BWidth>

Sets the noise level in the system bandwidth when bandwidth limitation is enabled.

Parameters:
<BWidth> float

Range: 100E3  to  10E6
Increment: 100E3
*RST: 100E3

Example: See Example "Configuring the noise generator" on page 677.

Manual operation: See "Bandwidth" on page 119

[:SOURce<hw>]:NOISe:BWIDth:STATe <State>

Activates noise bandwidth limitation.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Configuring the noise generator" on page 677.

Manual operation: See "Bandwidth" on page 119

[:SOURce<hw>]:NOISe:DISTribution <Distribution>

Sets the distribution of the noise power density.

Parameters:
<Distribution> GAUSs | EQUal

*RST: GAUSs

Example: See Example "Configuring the noise generator" on page 677.

Manual operation: See "Distribution" on page 119

[:SOURce<hw>]:NOISe:LEVel:RELative?

Queries the level of the noise signal per Hz in the total bandwidth.
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Return values: 
<Relative> float

Range: -149.18  to  -52.67
Increment: 0.1
*RST: -69.84

Example: See Example "Configuring the noise generator" on page 677.

Usage: Query only

Manual operation: See "Noise Density" on page 122

[:SOURce<hw>]:NOISe:LEVel[:ABSolute]?

Queries the level of the noise signal in the system bandwidth within the enabled band-
width limitation.

Return values: 
<Absolute> float

Noise level within the bandwidth limitation
*RST: 3.84 MHz

Example: See Example "Configuring the noise generator" on page 677.

Usage: Query only

Manual operation: See "Noise Level" on page 122

14.16.9  SOURce:PGEN subsystem

The PGEN subsystem contains the commands for setting output of the pulse modula-
tion signal.

Example: Using pulse generator as source for pulse modulation
// select pulse generator as source for pulse modulation
// enable pulse modulation
SOURce1:PULM:SOURce INT
SOURce1:PULM:STATe 1
// pulse generator and signal output are also activated
SOURce1:PGENerator:STATe?
// 1
SOURce1:PGENerator:OUTPut:STATe?
// 1
PGENerator:OUTPut:POLarity NORMal
// to disable pulse generator
SOURce1:PGENerator:STATe 0
// activate the pulse modulation of the RF carrier
SOURce1:PULM:STATe 1
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[:SOURce<hw>]:PGENerator:OUTPut:POLarity................................................................ 680
[:SOURce<hw>]:PGENerator:OUTPut[:STATe]..................................................................680
[:SOURce<hw>]:PGENerator:STATe................................................................................ 680

[:SOURce<hw>]:PGENerator:OUTPut:POLarity <Polarity>

Sets the polarity of the pulse output signal.

Parameters:
<Polarity> NORMal | INVerted

NORMal
Outputs the pulse signal during the pulse width, that means dur-
ing the high state.
INVerted
Inverts the pulse output signal polarity. The pulse output signal is
suppressed during the pulse width, but provided during the low
state.
*RST: NORMal

Example: See Example "Using pulse generator as source for pulse modu-
lation" on page 679.

Manual operation: See "Pulse Output Polarity" on page 104

[:SOURce<hw>]:PGENerator:OUTPut[:STATe] <State>

Activates the output of the pulse modulation signal.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Using pulse generator as source for pulse modu-
lation" on page 679.

Manual operation: See "Pulse Output State" on page 104

[:SOURce<hw>]:PGENerator:STATe <State>

Enables the output of the video/sync signal.

If the pulse generator is the current modulation source, activating the pulse modulation
automatically activates the signal output and the pulse generator.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Using pulse generator as source for pulse modu-
lation" on page 679.
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14.16.10  SOURce:PHASe subsystem

This subsystem contains the commands for adjusting the phase of the RF output signal
relative to a reference signal of the same frequency.

Example: Programming Example
// change the phase relative to the current phase
SOURce1:PHASe 2 DEG
// adopt the setting as the current phase
SOURce1:PHASe:REFerence

The following commands are available:

[:SOURce<hw>]:PHASe................................................................................................. 681
[:SOURce<hw>]:PHASe:REFerence................................................................................ 681

[:SOURce<hw>]:PHASe <Phase>

Sets the phase variation relative to the current phase.

Parameters:
<Phase> float

Range: -36000 to 36000
Increment: 0.001
*RST: 0
Default unit: DEG

Example: See Example "Programming Example" on page 681.

Manual operation: See "Delta Phase" on page 80

[:SOURce<hw>]:PHASe:REFerence

Assigns the value set with command [:SOURce<hw>]:PHASe as the reference
phase.

Example: See Example "Programming Example" on page 681.

Usage: Event

Manual operation: See "Reset Delta Phase Display" on page 80

14.16.11  SOURce:POWer subsystem

The SOURce:POWer subsystem contains the commands for setting the output level,
level control and level correction of the RF signal.

The default units are dBm. To change the units, perform one of the following:
● Enter the unit after the numerical value

Example: :POW 0.5V
● Set the unit with the command :UNIT:POWer.
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Example: Configure the settings for external ALC
The example shows a command sequence to set the parameters of the external ALC
mode. It is assumed that you have set up the measurement with the external coupler,
detector diode and the R&S SMA100B as described in Chapter 8.2.2, "How to set up
an external ALC", on page 220.

// Reset the instrument to start from an initial state
*RST; *CLS

// Select the external ALC mode
// configure the detector coupling factor
// and required RF generator level

SOURce:POWer:ALC[:STATe] EALC
SOURce:POWer:ALC:EDETector:FACTor 16
SOURce:POWer:ALC:EDETector:LEVel 20

// Execute the instrument detector offset compensation.
SOURce:POWer:ALC:SONCe
// This function recalculates and compensates internally detected offset voltages

// Activate RF Output1.
Output1:STATe 1

[:SOURce<hw>]:POWer:ALC:MODE?..............................................................................683
[:SOURce<hw>]:POWer:ALC[:STATe].............................................................................. 683
[:SOURce<hw>]:POWer:ALC:DSENsitivity....................................................................... 683
[:SOURce<hw>]:POWer:ALC:EDETector:FACTor.............................................................. 684
[:SOURce<hw>]:POWer:ALC:EDETector:LEVel................................................................ 684
[:SOURce<hw>]:POWer:ALC:SONCe.............................................................................. 684
[:SOURce<hw>]:POWer:ATTenuation:PATTenuator........................................................... 685
[:SOURce<hw>]:POWer:ATTenuation:RFOFf:MODE......................................................... 685
[:SOURce<hw>]:POWer:EMF:STATe................................................................................685
[:SOURce<hw>]:POWer:LBEHaviour............................................................................... 686
[:SOURce<hw>]:POWer:LIMit[:AMPLitude].......................................................................686
[:SOURce<hw>]:POWer:MANual.....................................................................................686
[:SOURce<hw>]:POWer:MODE.......................................................................................687
[:SOURce<hw>]:POWer:POWer......................................................................................687
[:SOURce<hw>]:POWer:STARt....................................................................................... 688
[:SOURce<hw>]:POWer:STOP........................................................................................688
[:SOURce<hw>]:POWer:STEP:MODE............................................................................. 688
[:SOURce<hw>]:POWer:STEP[:INCRement].................................................................... 688
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet........................................................ 689
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:RCL............................................................. 689
[:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude]..................................................690
[:SOURce<hw>]:POWer:RANGe:LOWer?........................................................................ 690
[:SOURce<hw>]:POWer:RANGe:UPPer?......................................................................... 690
[:SOURce<hw>]:POWer:RANGe:MIN?.............................................................................691
[:SOURce<hw>]:POWer:RANGe:MAX?............................................................................691
[:SOURce]:POWer:WIGNore...........................................................................................691
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[:SOURce<hw>]:POWer:ALC:MODE?

Queries the currently set ALC mode.

See [:SOURce<hw>]:POWer:ALC[:STATe] on page 683.

Return values: 
<PowAlcMode> 0 | AUTO | 1 | PRESet | OFFTable | ON | OFF | ONSample |

ONTable

Example: POW:ALC:MODE?
Response: ONTable "Table and On" is set automatically.

Usage: Query only

[:SOURce<hw>]:POWer:ALC[:STATe] <State>

Parameters:
<State> 0 | OFF | AUTO | 1 | ON | ONTable | PRESet | OFFTable | EALC

AUTO
Adjusts the output level to the operating conditions automati-
cally.
1|ON
Activates internal level control permanently.
OFFTable
Controls the level using attenuation values of the internal ALC
table.
0|OFF
Provided only for backward compatibility with other
Rohde & Schwarz signal generators.
The R&S SMA100B accepts these values and maps them auto-
matically as follows:
0|OFF = OFFTable
ONTable
Starts with the attenuation setting from the table and continues
with automatic level control.
EALC
Activates external ALC mode.
*RST: AUTO

Example: See Example "Configure the settings for external ALC"
on page 682

Manual operation: See "State" on page 219

[:SOURce<hw>]:POWer:ALC:DSENsitivity <Sensitivity>

Sets the sensitivity of the ALC detector.

Parameters:
<Sensitivity> AUTO | FIXed
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AUTO
Selects the optimum sensitivity automatically.
FIXed
Fixes the internal level detector.
*RST: AUTO

Example: POW:ALC:DSEN FIX
Manual operation: See "Detector Sensitivity" on page 219

[:SOURce<hw>]:POWer:ALC:EDETector:FACTor <DetectorFact>

Sets the attenuation value of the RF coupler.

Parameters:
<DetectorFact> float

Range: -200  to  200
Increment: 0.01
*RST: 16

Example: See Example "Configure the settings for external ALC"
on page 682

Options: R&S SMAB-K726

Manual operation: See "Detector Coupling Factor" on page 219

[:SOURce<hw>]:POWer:ALC:EDETector:LEVel <ReqGenLev>

Sets the maximum power level at the RF output required for compensating the external
ALC coupler and cable losses.

Parameters:
<ReqGenLev> float

Range: -145  to  40
Increment: 0.01
*RST: 20

Example: See Example "Configure the settings for external ALC"
on page 682

Options: R&S SMAB-K726

Manual operation: See "Required Generator Level" on page 219

[:SOURce<hw>]:POWer:ALC:SONCe

Activates level control for correction purposes temporarily.

Example: POW:ALC OFF
Deactivates automatic level control at the RF output.
POW:ALC:SONC
Executes level control (once).
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Usage: Event

Manual operation: See "Readjust" on page 78

[:SOURce<hw>]:POWer:ATTenuation:PATTenuator <StepAttSel>

Selects the type of step attenuator used below 20 GHz.

Parameters:
<StepAttSel> MECHanical | ELECtronic

MECHanical
Uses the mechanical step attenuator at all frequencies.
ELECtronic
Uses the electronic step attenuator up to 20 GHz.

Options: R&S SMAB-B35/-B37/-B39, not available for R&S SMAB-B36S

Manual operation: See "Step Attenuator below 20 GHz" on page 215

[:SOURce<hw>]:POWer:ATTenuation:RFOFf:MODE <Mode>

Selects the state the attenuator is to assume if the RF signal is switched off.

Parameters:
<Mode> UNCHanged | FATTenuation

FATTenuation
The step attenuator switches to maximum attenuation
UNCHanged
Retains the current setting and keeps the output impedance
constant during RF off.
*RST: n.a. (factory preset: FATTenuation)

Example: SOURce1:POWer:ATTenuation:RFOFf:MODE
FATTenuation
uses maximum attenuation when the RF output is turned off.

Manual operation: See "RF OFF Mode" on page 215

[:SOURce<hw>]:POWer:EMF:STATe <State>

Displays the signal level as voltage of the EMF. The displayed value represents the
voltage over a 50 Ohm load.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: POW:EMF:STAT 1
Activates voltage level display.

Manual operation: See "Display Level as Voltage of EMF" on page 345
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[:SOURce<hw>]:POWer:LBEHaviour <Behaviour>

Parameters:
<Behaviour> AUTO | UNINterrupted | MONotone | CVSWr | HDUN

UNINterrupted|MONotone
Uninterrupted level settings and strictly monotone modes.
CVSWr
Constant VSWR
HDUN
High dynamic uninterrupted level settings.
*RST: AUTO

Example: SOURce1:POWer:LBEHaviour AUTO
Options: R&S SMAB-K724

Manual operation: See "Setting Characteristics" on page 76

[:SOURce<hw>]:POWer:LIMit[:AMPLitude] <Amplitude>

Limits the maximum RF output level in CW and sweep mode.

It does not influence the "Level" display or the response to the query [:
SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude].

Parameters:
<Amplitude> float

Range: depends on the installed options
Increment: 0.01
*RST: n.a. (factory preset: 30)

Example: SOURce1:POWer:LIMit:AMPLitude 10

Manual operation: See "Limit" on page 76

[:SOURce<hw>]:POWer:MANual <Manual>

Sets the level for the subsequent sweep step if SWE:POW:MODE MAN.

Use a separate command for each sweep step.

Parameters:
<Manual> float

You can select any level within the setting range, where:
STARt is set with [:SOURce<hw>]:POWer:STARt
STOP is set with [:SOURce<hw>]:POWer:STOP
OFFSet is set with [:SOURce<hw>]:POWer[:LEVel][:
IMMediate]:OFFSet
Range: (STARt + OFFSet) to (STOP + OFFSet)
Increment: 0.01
Default unit: dBm
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Example: See Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "Current Level" on page 189

[:SOURce<hw>]:POWer:MODE <Mode>

Selects the operating mode of the instrument to set the output level.

Parameters:
<Mode> CW | FIXed | SWEep

CW|FIXed
Operates at a constant level.
CW and FIXed are synonyms.
To set the output level value, use the command [:
SOURce<hw>]:POWer[:LEVel][:IMMediate][:
AMPLitude].
SWEep
Sets sweep mode.
Set the range and current level with the commands:
[:SOURce<hw>]:POWer:STARt and [:SOURce<hw>]:
POWer:STOP,
[:SOURce<hw>]:POWer:MANual.
*RST: CW

Example: See Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "State (RF level sweep)" on page 189

[:SOURce<hw>]:POWer:POWer <Power>

Sets the level at the RF output connector.

This value does not consider a specified offset.

The command [:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude]
sets the level of the "Level" display, that means the level containing offset.

See "RF frequency and level display with a downstream instrument" on page 66.

Parameters:
<Power> float

Level at the RF output, without level offset
Range: See data sheet
Increment: 0.01
Default unit: dBm

Example: SOURce1:POWer:POWer 15
Sets the level at RF output

Manual operation: See "Amplitude" on page 75
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[:SOURce<hw>]:POWer:STARt <Start>
[:SOURce<hw>]:POWer:STOP <Stop>
Sets the RF start/stop level in sweep mode.

Parameters:
<Stop> float

Sets the setting range calculated as follows:
(Level_min + OFFSet) to (Level_max + OFFSet)
Where the values are set with the commands:
[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet
[:SOURce<hw>]:POWer:STARt
[:SOURce<hw>]:POWer:STOP
Range: Minimum level to maximum level
*RST: -30 (Start)/ -10 (Stop)
Default unit: dBm

Example: See Example "Setup an RF frequency or power sweep"
on page 697

Manual operation: See "Start Level / Stop Level" on page 196

[:SOURce<hw>]:POWer:STEP:MODE <Mode>

Defines the type of step width to vary the RF output power step-by-step with the com-
mands POW UP or POW DOWN.

Parameters:
<Mode> DECimal | USER

DECimal
Increases or decreases the level in steps of ten.
USER
Increases or decreases the level in increments, determined with
the command [:SOURce<hw>]:POWer:STEP[:INCRement].
*RST: DECimal

Example: SOURce1:POWer:STEP:INCRement 2
SOURce1:POWer:STEP:MODE USER
SOURce1:POWer:LEVel:IMMediate:AMPLitude UP
Increasing the RF level with a step size of 2 dB

Manual operation: See "Variation Active" on page 73

[:SOURce<hw>]:POWer:STEP[:INCRement] <Increment>

Specifies the step width in the appropriate path for POW:STEP:MODE USER.

To adjust the level step-by-step with this increment value, use the command POW UP,
or POW DOWN.
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Note: The command also sets "Variation Step" in the manual control, that means the
user-defined step width for setting the level with the rotary knob or the [Up/Down]
arrow keys.

Parameters:
<Increment> float

Range: 0  to  200
Increment: 0.01
*RST: 1
Default unit: dB

Example: See [:SOURce<hw>]:POWer:STEP:MODE on page 688.

Manual operation: See "Variation Step" on page 73

[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet <Offset>

Sets the level offset of a downstream instrument.

The level at the RF output is not changed.

To query the resulting level, as it is at the output of the downstream instrument, use the
command [:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude].

See "RF frequency and level display with a downstream instrument" on page 66.

Note: The level offset also affects the RF level sweep.

Parameters:
<Offset> float

Range: -100 to 100
Increment: 0.01
*RST: 0
Default unit: dB
Level offset is always expreced in dB; linear units (V, W, etc.) are
not supported

Example: POWer:OFFSet 10
Sets the RF level offset to 10 dB

Manual operation: See "Offset" on page 76

[:SOURce<hw>]:POWer[:LEVel][:IMMediate]:RCL <Rcl>

Determines whether the current level is retained or if the stored level setting is adopted
when an instrument configuration is loaded.

Parameters:
<Rcl> INCLude | EXCLude

INCLude
Takes the current level when an instrument configuration is loa-
ded.
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EXCLude
Retains the current level when an instrument configuration is
loaded.
*RST: INCLude

Example: POW:RCL INCL
Takes the level value from an instrument configuration loaded
with command *RCL.

Manual operation: See "Exclude Level" on page 320

[:SOURce<hw>]:POWer[:LEVel][:IMMediate][:AMPLitude] <Amplitude>

Sets the RF level applied to the DUT.

To activate the RF output use command :OUTPut<hw>[:STATe] ("RF On"/"RF Off").

The following applies POWer = RF output level + OFFSet, where:
● POWer is the values set with [:SOURce<hw>]:POWer[:LEVel][:

IMMediate][:AMPLitude]
● RF output level is set with [:SOURce<hw>]:POWer:POWer
● OFFSet is set with [:SOURce<hw>]:POWer[:LEVel][:IMMediate]:OFFSet
Parameters:
<Amplitude> float

The following settings influence the value range:
OFFSet set with the command [:SOURce<hw>]:POWer[:
LEVel][:IMMediate]:OFFSet
Numerical value
Sets the level
UP|DOWN
Varies the level step by step.
The level is increased or decreased by the value set with the
command [:SOURce<hw>]:POWer:STEP[:INCRement].
Range: (Level_min + OFFSet) to (Level_max + OFFStet)
*RST: -30
Default unit: dBm

Example: POWer -30
Sets the RF level

Example: See also [:SOURce<hw>]:POWer:STEP:MODE on page 688.

Manual operation: See "Amplitude" on page 75

[:SOURce<hw>]:POWer:RANGe:LOWer?
[:SOURce<hw>]:POWer:RANGe:UPPer?
Queries the current interruption-free range of the level.
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Return values: 
<Upper> float

Increment: 0.01
Default unit: dBm

Example: SOURce1:POWer:RANGe:UPPer?
// -15
SOURce1:POWer:RANGe:LOW?
// -50

Usage: Query only

Manual operation: See "Level Range" on page 77

[:SOURce<hw>]:POWer:RANGe:MIN?
[:SOURce<hw>]:POWer:RANGe:MAX?
Queries the current power range of the level sweep.

Return values: 
<PowRangeMax> float

Range: depends on settings
Increment: 0.01
*RST: -10
Default unit: dBm

Example: SOURce1:POWer:RANGe:MIN?
// -90
SOURce1:POWer:RANGe:MAX?
// 8

Usage: Query only

Manual operation: See "Sweep Level Range" on page 198

[:SOURce]:POWer:WIGNore <State>

Ignores level range warnings.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: SOURce:POWer:WIGNore 1

14.16.12  SOURce:ROSCillator subsystem

The SOURce:ROSCillator subsystem contains the commands for setting the exter-
nal and internal reference frequency.
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The commands of this subsystem are not affected by an instrument reset (*RST
on page 453).

Example: Configuring the reference oscillator
// Using 100 MHz external reference source
SOURce:ROSCillator:PRESet 
SOURce:ROSCillator:SOURce EXT
SOURce:ROSCillator:EXTernal:RFOFf:STATe 1
SOURce:ROSCillator:EXTernal:FREQuency 100MHZ
SOURce:ROSCillator:EXTernal:SBANdwidth WIDE
// 100 MHz (loop through) and 1 GHz output
SOURce:ROSCillator:OUTPut:FREQuency:MODE LOOP
SOURce:ROSCillator:OUTPut:ALTernate:FREQuency:MODE DER1G
SOURce:ROSCillator:INTernal:ADJust:STATe 0

// Variable external reference frequency
// SOURce:ROSCillator:EXTernal:FREQuency VAR
// SOURce:ROSCillator:EXTernal:FREQuency:VARiable 100000000

// Using the internal reference frequency
SOURce:ROSCillator:SOURce INT
SOURce:ROSCillator:INTernal:TUNing:STATe 1
SOURce:ROSCillator:INTernal:TUNing:SLOPe LOW
// 10 MHz and 1 GHz output
SOURce:ROSCillator:OUTPut:FREQuency:MODE DER10M
SOURce:ROSCillator:OUTPut:ALTernate:FREQuency:MODE DER1G

// Query calibration value
CALibration:ROSCillator?
// 32767
// Set an internal source 
// Activate user-defined adjustment value of 1000
SOURce:ROSCillator:SOURce INT
SOURce:ROSCillator:INTernal:ADJust:STATe 1
SOURce:ROSCillator:INTernal:ADJust:VALue 1000

// to resume calibrated state
SOURce:ROSCillator:INTernal:ADJust:VALue 0
SOURce:ROSCillator:INTernal:ADJust:STATe 0
// or 
// SYSTem:FPRest

[:SOURce]:ROSCillator:PRESet...................................................................................... 693
[:SOURce]:ROSCillator:SOURce..................................................................................... 693
[:SOURce]:ROSCillator:INTernal:TUNing[:STATe].............................................................. 693
[:SOURce]:ROSCillator:INTernal:TUNing:SLOPe...............................................................693
[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe].............................................................. 694
[:SOURce]:ROSCillator:EXTernal:FREQuency.................................................................. 694
[:SOURce]:ROSCillator:EXTernal:FREQuency:VARiable.................................................... 694
[:SOURce]:ROSCillator:EXTernal:SBANdwidth..................................................................694
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[:SOURce]:ROSCillator:EXTernal:MLRange?....................................................................695
[:SOURce]:ROSCillator:EXTernal:NSBandwidth?.............................................................. 695
[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE......................................................... 695
[:SOURce]:ROSCillator:OUTPut:ALTernate:FREQuency:MODE..........................................696
[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue.............................................................. 696
[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe].............................................................697

[:SOURce]:ROSCillator:PRESet

Resets the reference oscillator settings.

Example: See Example "Configuring the reference oscillator" on page 692.

Usage: Event

Manual operation: See "Set to Default" on page 296

[:SOURce]:ROSCillator:SOURce <Source>

Selects between internal or external reference frequency.

Parameters:
<Source> INTernal | EXTernal

*RST: n.a. (factory preset: INTernal)

Example: See Example "Configuring the reference oscillator" on page 692.

Manual operation: See "Source" on page 296

[:SOURce]:ROSCillator:INTernal:TUNing[:STATe] <State>

Activates the EFC (external frequency control).

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Example: See Example "Configuring the reference oscillator" on page 692.

Manual operation: See "External Tuning Active" on page 298

[:SOURce]:ROSCillator:INTernal:TUNing:SLOPe <State>

Sets the sensitivity of the external tuning volatge.

Parameters:
<State> LOW | HIGH

*RST: n.a. (factory preset: LOW)

Example: See Example "Configuring the reference oscillator" on page 692.

Manual operation: See "External Tuning Slope" on page 298
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[:SOURce]:ROSCillator:EXTernal:RFOFf[:STATe] <State>

Determines that the RF output is turned off when the external reference signal is
selected, but missing.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: See Example "Configuring the reference oscillator" on page 692.

Manual operation: See "Deactivate RF Output (if external reference is missing)"
on page 296

[:SOURce]:ROSCillator:EXTernal:FREQuency <Frequency>

Sets the frequency of the external reference.

Parameters:
<Frequency> 100MHZ | 1GHZ | VARiable | 10MHZ

*RST: n.a. (factory preset: 10MHZ)

Example: See Example "Configuring the reference oscillator" on page 692.

Options: VARiable requires R&S SMAB-K704
100MHZ|1GHZ require R&S SMAB-K703

Manual operation: See "External Reference Frequency" on page 296

[:SOURce]:ROSCillator:EXTernal:FREQuency:VARiable <Frequency>

Specifies the user-defined external reference frequency.

Parameters:
<Frequency> float

Range: 1E6  to  100E6
Increment: 0.1
*RST: n.a. (factory preset: 1E7)
Default unit: Hz

Example: See Example "Configuring the reference oscillator" on page 692.

Options: R&S SMAB-K704

Manual operation: See "Variable Reference Frequency" on page 297

[:SOURce]:ROSCillator:EXTernal:SBANdwidth <SBandwidth>

Selects the synchronization bandwidth for the external reference signal.

Depending on the RF hardware version, and the installed options, the synchronizsation
bandwidth varies.
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For more information, see data sheet.

Parameters:
<SBandwidth> WIDE | NARRow

NARRow
The synchronization bandwidth is a few Hz.
WIDE
Uses the widest possible synchronization bandwidth.
*RST: n.a. (factory preset)

Example: See Example "Configuring the reference oscillator" on page 692.

Manual operation: See "Synchronization Bandwidth" on page 297

[:SOURce]:ROSCillator:EXTernal:MLRange?

Queries the minimum locking range for the selected external reference frequency.

Depending on the RF hardware version, and the installed options, the minimum locking
range vaies.

For more information, see data sheet.

Return values: 
<MinLockRange> string

Example: SOUR:ROSC:EXT:MLR?
Usage: Query only

Manual operation: See "Minimum Locking Range" on page 297

[:SOURce]:ROSCillator:EXTernal:NSBandwidth?

Queries the nominal synchronization bandwidth for the selected external reference fre-
quency and synchronization bandwidth.

Return values: 
<NomBandwidth> string

Example: SOUR:ROSC:EXT:NSB?
Usage: Query only

Manual operation: See "Nominal Synchronization Bandwidth" on page 297

[:SOURce]:ROSCillator:OUTPut:FREQuency:MODE <OutpFreqMode>

Sets the output reference frequency.

Parameters:
<OutpFreqMode> DER10M | DER100M | OFF | LOOPthrough

OFF
Disables the output.
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DER10M|DER100M
Sets the output reference frequency to 10 MHz or 100 MHz.
The reference frequency is derived from the internal reference
frequency.
LOOPthrough
This option is unavailable for
ROSCillator:EXTernal:FREQuency 1GHZ. Forwards the
input reference frequency to the reference frequency output.
*RST: n.a. (factory preset: DER10M)

Example: See Example "Configuring the reference oscillator" on page 692.

Manual operation: See "Reference Output/1 GHz Reference Output" on page 298

[:SOURce]:ROSCillator:OUTPut:ALTernate:FREQuency:MODE <OutpFreqMode>

Sets the output reference frequency.

Parameters:
<OutpFreqMode> LOOPthrough | DER1G | OFF

OFF
Disables the output.
DER1G
Sets the output reference frequency to 1 GHz.
The reference frequency is derived from the internal reference
frequency.
LOOPthrough
If [:SOURce]:ROSCillator:EXTernal:FREQuency 1GHZ,
forwards the input reference frequency to the reference fre-
quency output.
*RST: n.a. (factory preset: OFF)

Example: See Example "Configuring the reference oscillator" on page 692.

Manual operation: See "Reference Output/1 GHz Reference Output" on page 298

[:SOURce]:ROSCillator[:INTernal]:ADJust:VALue <Value>

Specifies the frequency correction value (adjustment value).

Parameters:
<Value> integer

*RST: 0

Example: See [:SOURce]:ROSCillator[:INTernal]:ADJust[:
STATe] on page 697

Manual operation: See "Adjustment Value" on page 300
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[:SOURce]:ROSCillator[:INTernal]:ADJust[:STATe] <State>

Determines whether the calibrated (off) or a user-defined (on) adjustment value is
used for fine adjustment of the frequency.

Parameters:
<State> 1 | ON | 0 | OFF

0
Fine adjustment with the calibrated frequency value
1
User-defined adjustment value.
The instrument is no longer in the calibrated state.
The calibration value is, however, not changed. The instrument
resumes the calibrated state if you send
SOURce:ROSCillator:INTernal:ADJust:STATe 0.
*RST: n.a. (factory preset: 0)

Example: See Example "Configuring the reference oscillator" on page 692.

Manual operation: See "Adjustment Active" on page 299

14.16.13  SOURce:SWEep subsystem

The SOURce:SWEep subsystem contains the commands for configuring RF sweep sig-
nals.

● The keyword [:FREQuency] can be omitted, then the commands are SCPI-com-
pliant.

● To activate an RF sweep mode, use the following commands:
– RF frequency sweep: SOURce:FREQuency:MODE SWEep

(SOURce:FREQuency:MODE CW (off))
– RF level sweep:SOURce:POWer:MODE SWEep (SOURce:POWer:MODE CW

(off))
– RF combined sweep: SOURce:FREQuency:MODE SWEep

(SOURce:FREQuency:MODE CW (off)
● All sweeps, including the LF sweep, can be set independently of each other.
● All sweeps can be set independently of each other.

See Chapter 7.1, "Signal generation and triggering in the sweep and list modes",
on page 173.

Example: Setup an RF frequency or power sweep
The following example shows a command sequence to set up an RF frequency sweep,
triggered by the execute command. For an RF power sweep, replace FREQuency in
the SWEep commands with POWer.
Exceptions are the power spacing (defined with LINear only) and the power step
width (defined with LOGarithmic only).
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// Reset the instrument to start from an initial state
// Switch off display update to improve performance
// (especially with short dwell times)
// Set the sweep mode (first two commands) and the sweep range
// Select linear spacing
// Select the waveform shape for the frequency sweep
*RST; *CLS
SYSTem:DISPlay:UPDate OFF
TRIGger1:FSWeep:SOURce SINGle
SOURce1:SWEep:FREQuency:MODE AUTO  
SOURce1:FREQuency:SPAN 300 MHz
SOURce1:FREQuency:CENTer 200 MHz
// Alternatively use 
// SOURce1:FREQuency:STARt 50 MHz
// SOURce1:FREQuency:STOP 350 MHz
SOURce1:SWEep:FREQuency:SPACing LINear
SOURce1:SWEep:FREQuency:SHAPe SAWTooth

// Activate change to start frequency while waiting for next trigger
// Prerequisites: sweep mode single and sweep waveform sawtooth
SOURce1:SWEep:FREQuency:RETRace 1
// Alternatively reset all sweeps to their initial value 
SOURce1:SWEep:RESet:ALL

// Set the step width and dwell time
SOURce1:SWEep:FREQuency:STEP:LINear 1 MHz
// Alternatively set the number of steps, then the sweep step width is 
// set automatically
SOURce1:SWEep:FREQuency:POINts 301
SOURce1:SWEep:FREQuency:DWELl 500 ms
// With logarithmic spacing select the step width as follows
// (steps of 10 percent of the previous frequency in each instance)  
SOURce1:SWEep:FREQuency:SPACing LOG 
SOURce1:SWEep:FREQuency:STEP:LOGarithmic 10PCT

// Activate the sweep
// Trigger the sweep (depending on the set mode) and query the status
SOURce1:FREQuency:MODE SWEep
// Perform a one-off RF frequency sweep 
SOURce1:SWEep:FREQuency:EXECute
SOURce1:SWEep:FREQuency:RUNNing?
// 1
// the frequency sweep is running

// For manual step RF sweep use the following commands 
*RST; *CLS
// Activate manual step RF sweep
SOURce1:SWEep:FREQuency:MODE MANual
// Activate the RF frequency sweep.
SOURce1:FREQuency:MODE SWEep
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// Activate RF Output1.
Output1:STATe 1
// Input the frequency manually for each step
SOURce1:FREQuency:MANual 200 MHz
SOURce1:FREQuency:MANual 201 MHz
// Alternatively use the UP or DOWN commands with the set step width.
SOURce1:SWEep:FREQuency:STEP:LINear 1 MHz
SOURce1:FREQuency:MANual UP

// Activate a combined RF frequency / level sweep 
*RST; *CLS
*RST; *CLS
SYSTem:DISPlay:UPDate OFF
TRIGger1:FSWeep:SOURce SINGle
SOURce1:SWEep:COMBined:MODE AUTO
SOURce1:SWEep:COMBined:COUNt 200
SOURce1:FREQuency:STARt 1000000000 Hz
SOURce1:FREQuency:STOP 5000000000 Hz
SOURce1:POWer:STARt -30 dBm
SOURce1:POWer:STOP -10 dBm
SOURce1:SWEep:COMBined:RETRace 1
SOURce1:SWEep:COMBined:SHAPe SAWT
SOURce1:SWEep:COMBined:DWELl 0.01
// Activate combined RF frequency/level sweep
SOURce1:FREQuency:MODe COMB
// Activate RF Output1.
Output1:STATe 1
// Execute combined frequency / level sweep 
SOURce1:SWEep:COMBined:EXECute

// Configure an RF frequency ramp sweep
// Select a continuous analog frequncy sweep, 
// synchronized with the sweep time, repeating automatically
// set start and stop frequency
SOURce1:SWEep:GENeration ANAL
// TRIGger1:FSWeep:SOURce AUTO
SOURce1:SWEep:FREQuency:MODE AUTO
SOURce1:SWEep:FREQuency:MODE:ADVanced AUTO
INITiate1:FSWeep:CONTinuous 1
SOURce1:FSWeep:TRIGger:SOURce:ADVanced IMM
// TRIGger1:FSWeep:SOURce:ADVanced IMM
SOURce1:SWEep:FREQuency:STARt 100000000
SOURce1:SWEep:FREQuency:STOP 500000000
SOURce1:SWEep:FREQuency:CENter 300000000
SOURce1:SWEep:FREQuency:SPAN 400000000
SOURce1:SWEep:FREQuency:TIMe 0.015
SOURce1:SWEep:FREQuency:SHAPe SAWT
SOURce1:FREQuency:MODE SWE
// Activate RF Output1.
Output1:STATe 1
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// Query blanked frequency points
SOURce1:SWEep:FREQuency:ANALog:SWPoints?
// 8500,10000,12000,17000,100000,1000000,8000000,12500000,
// ...,75000000000,80000000000,150000000000,300000000000

:SWEep:TYPE...............................................................................................................700
[:SOURce<hw>]:SWEep:POWer:DWELl...........................................................................701
[:SOURce<hw>]:SWEep:GENeration............................................................................... 701
[:SOURce<hw>]:SWEep:POWer:MODE...........................................................................701
[:SOURce<hw>]:SWEep:POWer:POINts.......................................................................... 702
[:SOURce<hw>]:SWEep:POWer:SPACing:MODE?........................................................... 702
[:SOURce<hw>]:SWEep:POWer:STEP[:LOGarithmic]....................................................... 702
[:SOURce<hw>]:SWEep[:FREQuency]:ANALog:SWPoints?...............................................703
[:SOURce<hw>]:SWEep[:FREQuency]:DWELl..................................................................703
[:SOURce<hw>]:SWEep[:FREQuency]:MODE.................................................................. 703
[:SOURce<hw>]:SWEep[:FREQuency]:POINts................................................................. 704
[:SOURce<hw>]:SWEep[:FREQuency]:SPACing...............................................................704
[:SOURce<hw>]:SWEep:POWer:SHAPe..........................................................................705
[:SOURce<hw>]:SWEep[:FREQuency]:SHAPe................................................................. 705
[:SOURce<hw>]:SWEep:POWer:EXECute....................................................................... 705
[:SOURce<hw>]:SWEep[:FREQuency]:EXECute.............................................................. 705
[:SOURce<hw>]:SWEep:POWer:RETRace.......................................................................705
[:SOURce<hw>]:SWEep[:FREQuency]:RETRace..............................................................705
[:SOURce<hw>]:SWEep:POWer:RUNNing?..................................................................... 706
[:SOURce<hw>]:SWEep[:FREQuency]:RUNNing?............................................................ 706
[:SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic................................................ 706
[:SOURce<hw>]:SWEep[:FREQuency]:STEP[:LINear].......................................................706
[:SOURce<hw>]:COMBined:FREQuency:STARt............................................................... 707
[:SOURce<hw>]:COMBined:FREQuency:STOP................................................................707
[:SOURce<hw>]:COMBined:POWer:STARt...................................................................... 707
[:SOURce<hw>]:COMBined:POWer:STOP.......................................................................708
[:SOURce<hw>]:SWEep:COMBined:COUNt.....................................................................708
[:SOURce<hw>]:SWEep:COMBined:DWELl..................................................................... 708
[:SOURce<hw>]:SWEep:COMBined:EXECute.................................................................. 708
[:SOURce<hw>]:SWEep:COMBined:MODE......................................................................709
[:SOURce<hw>]:SWEep:COMBined:RETRace................................................................. 709
[:SOURce<hw>]:SWEep:COMBined:SHAPe.....................................................................710
[:SOURce<hw>]:SWEep:RESet[:ALL].............................................................................. 710
[:SOURce<hw>]:SWEep[:FREQuency]:TIME....................................................................710
[:SOURce<hw>]:SWEep:MARKer:OUTPut:POLarity..........................................................710
[:SOURce<hw>]:SWEep[:FREQuency]:MARKer:ACTive.................................................... 711
[:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:FREQuency...................................... 711
[:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:FSTate............................................. 711

:SWEep:TYPE <SweepType>

Provided for compatibility between SCPI and Rohde & Schwarz commands.

Parameters:
<SweepType> ADVanced | STANdard

*RST: n.a. (factory preset: STANdard)
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[:SOURce<hw>]:SWEep:POWer:DWELl <Dwell>

Sets the dwell time for a level sweep step.

Parameters:
<Dwell> float

Range: 0.001  to  100
Increment: 100E-6
*RST: 0.01

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Dwell Time" on page 192

[:SOURce<hw>]:SWEep:GENeration <SweepType>

Selects frequency sweep type.

Parameters:
<SweepType> STEPped | ANALog

STEPped
Performs a frequency sweep.
ANALog
Performs a continuous analog frequency sweep (ramp),
synchronized with the sweep time [:SOURce<hw>]:SWEep[:
FREQuency]:TIME.
*RST: STEPped

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Sweep Type" on page 188

[:SOURce<hw>]:SWEep:POWer:MODE <Mode>

Sets the cycle mode for the level sweep.

Parameters:
<Mode> AUTO | MANual | STEP

AUTO
Each trigger triggers exactly one complete sweep.
MANual
The trigger system is not active. You can trigger every step indi-
vidually with the command [:SOURce<hw>]:POWer:MANual.
The level value increases at each step by the value that you
define with [:SOURce<hw>]:POWer:STEP[:INCRement].
Values directly entered with the command [:SOURce<hw>]:
POWer:MANual are not taken into account.
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STEP
Each trigger triggers one sweep step only. The level increases
by the value entered with [:SOURce<hw>]:POWer:STEP[:
INCRement].
*RST: AUTO

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Mode" on page 189

[:SOURce<hw>]:SWEep:POWer:POINts <Points>

Sets the number of steps within the RF level sweep range.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Parameters:
<Points> integer

Range: 2  to  Max

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

[:SOURce<hw>]:SWEep:POWer:SPACing:MODE?

Queries the level sweep spacing. The sweep spacing for level sweeps is always linear.

Return values: 
<Mode> LINear

*RST: LINear

Example: SWE:POW:SPAC:MODE?
queries the sweep spacing for a level sweep at RF output.
Result: "LIN"
linear spacing

Usage: Query only

[:SOURce<hw>]:SWEep:POWer:STEP[:LOGarithmic] <Logarithmic>

Sets a logarithmically determined step size for the RF level sweep. The level is
increased by a logarithmically calculated fraction of the current level.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.
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Parameters:
<Logarithmic> float

The unit dB is mandatory.
Range: 0.01  to  139 dB
Increment: 0.01
*RST: 1
Default unit: dB

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Step" on page 197

[:SOURce<hw>]:SWEep[:FREQuency]:ANALog:SWPoints?

Queries blank points during the RF frequency sweep in ramp sweep mode.

At certain switchover frequency points, the R&S SMA100B shortly blanks the RF signal
to adjust the settings accordingly.

This query returns all blanked frequency points within the entire frequency range,
regardless of the set frequency sweep range.

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Usage: Query only

[:SOURce<hw>]:SWEep[:FREQuency]:DWELl <Dwell>

Sets the dwell time for a frequency sweep step.

Parameters:
<Dwell> float

Range: 0.001  to  100
Increment: 100E-6
*RST: 0.01

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Dwell Time" on page 192

[:SOURce<hw>]:SWEep[:FREQuency]:MODE <Mode>

Sets the cycle mode for the frequency sweep.

Parameters:
<Mode> AUTO | MANual | STEP

AUTO
Each trigger event triggers exactly one complete sweep.
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MANual
The trigger system is not active. You can trigger every step indi-
vidually by input of the frequencies with the command [:
SOURce<hw>]:FREQuency:MANual.
STEP
Each trigger event triggers one sweep step. The frequency
increases by the value entered with [:SOURce<hw>]:SWEep[:
FREQuency]:STEP[:LINear] (linear spacing) or [:
SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic
(logarithmic spacing).
*RST: AUTO

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Mode" on page 189

[:SOURce<hw>]:SWEep[:FREQuency]:POINts <Points>

Sets the number of steps within the RF frequency sweep range.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Two separate POINts values are used for linear or logarithmic sweep spacing ([:
SOURce<hw>]:SWEep[:FREQuency]:SPACing LIN | LOG). The command
always affects the currently set sweep spacing.

Parameters:
<Points> integer

Range: 2  to  Max

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

[:SOURce<hw>]:SWEep[:FREQuency]:SPACing <Spacing>

Selects the mode for the calculation of the frequency intervals, with which the current
frequency at each step is increased or decreased.

The keyword [:FREQuency] can be omitted; then the command is SCPI-compliant.

Parameters:
<Spacing> LINear | LOGarithmic

LINear
Sets a fixed frequency value as step width and adds it to the cur-
rent frequency.
The linear step width is entered in Hz, see [:SOURce<hw>]:
SWEep[:FREQuency]:STEP[:LINear].
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LOGarithmic
Sets a constant fraction of the current frequency as step width
and adds it to the current frequency.
The logarithmic step width is entered in %, see [:
SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic.
*RST: LINear

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Spacing" on page 192

[:SOURce<hw>]:SWEep:POWer:SHAPe <Shape>
[:SOURce<hw>]:SWEep[:FREQuency]:SHAPe <Shape>
Determines the waveform shape for a frequency sweep sequence.

Parameters:
<Shape> SAWTooth | TRIangle

*RST: SAWTooth

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Shape" on page 191

[:SOURce<hw>]:SWEep:POWer:EXECute
[:SOURce<hw>]:SWEep[:FREQuency]:EXECute
Executes an RF frequency sweep.

The command performs a single sweep and is therefore only effective in manual
sweep mode.

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Usage: Event

Manual operation: See "Execute Single Sweep" on page 193

[:SOURce<hw>]:SWEep:POWer:RETRace <State>
[:SOURce<hw>]:SWEep[:FREQuency]:RETRace <State>
Activates that the signal changes to the start frequency value while it is waiting for the
next trigger event.

You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single".

Parameters:
<State> 1 | ON | 0 | OFF

*RST: 0
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Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Retrace" on page 190

[:SOURce<hw>]:SWEep:POWer:RUNNing?
[:SOURce<hw>]:SWEep[:FREQuency]:RUNNing?
Queries the current sweep state.

Return values: 
<State> 1 | ON | 0 | OFF

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Usage: Query only

[:SOURce<hw>]:SWEep[:FREQuency]:STEP:LOGarithmic <Logarithmic>

Sets a logarithmically determined step width for the RF frequency sweep. The value is
added at each sweep step to the current frequency.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Parameters:
<Logarithmic> float

The unit is mandatory.
Range: 0.01  to  100
Increment: 1E-3
*RST: 1
Default unit: PCT

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Step Linear/Step Logarithmic" on page 195

[:SOURce<hw>]:SWEep[:FREQuency]:STEP[:LINear] <Linear>

Sets the step width for linear sweeps.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Omit the optional keywords so that the command is SCPI-compliant.

Parameters:
<Linear> float

Range: 0.001 Hz  to  (STOP - STARt)
Increment: 0.01

Example: See Example "Setup an RF frequency or power sweep"
on page 697.
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Manual operation: See "Step Linear/Step Logarithmic" on page 195

[:SOURce<hw>]:COMBined:FREQuency:STARt <CombFreqStart>

Sets the start frequency of the combined RF frequency / level sweep.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Parameters:
<CombFreqStart> float

Range: -59999E5  to  12E9
Increment: 0.01
*RST: 100E6

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Start Frequency/Stop Frequency" on page 194

[:SOURce<hw>]:COMBined:FREQuency:STOP <CombFreqStop>

Sets the end frequency of the combined RF frequency / level sweep.

Parameters:
<CombFreqStop> float

Range: -59999E5  to  12E9
Increment: 0.01
*RST: 500E6

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Start Frequency/Stop Frequency" on page 194

[:SOURce<hw>]:COMBined:POWer:STARt <CombPowStart>

Sets the start level value of the combined RF frequency / level sweep.

See Chapter 7.2.1, "Correlating parameters in sweep mode", on page 181.

Parameters:
<CombPowStart> float

Range: -245  to  120
Increment: 0.01
*RST: -30

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Start Level / Stop Level" on page 196
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[:SOURce<hw>]:COMBined:POWer:STOP <CombPowStop>

Sets the stop level value of the combined RF frequency / level sweep.

Parameters:
<CombPowStop> float

Range: -245  to  120
Increment: 0.01
*RST: -10

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Start Level / Stop Level" on page 196

[:SOURce<hw>]:SWEep:COMBined:COUNt <StepCount>

Defines the number of sweeps you want to execute.

This parameter applies to [:SOURce<hw>]:SWEep:COMBined:MODE > SINGle. To
start the sweep signal generation, use the command [:SOURce<hw>]:SWEep:
COMBined:EXECute on page 708.

Parameters:
<StepCount> integer

Range: 1  to  SeMAX_INT_STEP-1
*RST: 501

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Step Count" on page 197

[:SOURce<hw>]:SWEep:COMBined:DWELl <Dwell>

Sets the dwell time for the combined frequency / level sweep.

Parameters:
<Dwell> float

Range: 0.01  to  100
Increment: 100E-6
*RST: 0.01

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Dwell Time" on page 192

[:SOURce<hw>]:SWEep:COMBined:EXECute

Executes an RF frequency / level sweep cycle.
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The command triggers one single sweep manually. Therefore, you can use it in manual
sweep mode, selected with the command [:SOURce<hw>]:SWEep:COMBined:MODE
> MANual.

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Usage: Event

Manual operation: See "Execute Single Sweep" on page 193

[:SOURce<hw>]:SWEep:COMBined:MODE <SweepCombMode>

Sets the cycle mode for the combined frequency / level sweep.

Parameters:
<SweepCombMode> AUTO | MANual | STEP

AUTO
Each trigger event triggers exactly one complete sweep.
MANual
The trigger system is not active. You can trigger every step indi-
vidually by input of the frequencies with the commands [:
SOURce<hw>]:FREQuency:MANual and [:SOURce<hw>]:
POWer:MANual.
STEP
Each trigger event triggers one sweep step.
*RST: AUTO

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Mode" on page 189

[:SOURce<hw>]:SWEep:COMBined:RETRace <RetraceState>

Activates that the signal changes to the start level value while it is waiting for the next
trigger event.

You can enable this feature, when you are working with sawtooth shapes in sweep
mode "Single" or "External Single".

Parameters:
<RetraceState> 1 | ON | 0 | OFF

*RST: 0

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Retrace" on page 190
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[:SOURce<hw>]:SWEep:COMBined:SHAPe <Shape>

Selects the waveform shape for the combined frequency / level sweep sequence.

Parameters:
<Shape> SAWTooth | TRIangle

*RST: SAWTooth

Example: See Example "Setup an RF frequency or power sweep"
on page 697.

Manual operation: See "Shape" on page 191

[:SOURce<hw>]:SWEep:RESet[:ALL]

Resets all active sweeps to the starting point.

Usage: Event

Manual operation: See "Reset Sweep" on page 193

[:SOURce<hw>]:SWEep[:FREQuency]:TIME <Time>

Sets the duration of a frequency ramp sweep step.

Parameters:
<Time> float

Range: 0.01  to  100
Increment: 1E-4
*RST: 0.015
Default unit: s

Example: SOURce1:SWEep:FREQuency:SPACing RAMP
SOURce1:SWEep:FREQuency:TIME 0.020

Options: R&S SMAB-B28

Manual operation: See "Sweep Time" on page 192

[:SOURce<hw>]:SWEep:MARKer:OUTPut:POLarity <Polarity>

Selects the polarity of the marker signal.

Parameters:
<Polarity> NORMal | INVerted

NORMal
Marker level is high when after reaching the mark.
INVerted
Marker level is low after reaching the mark.
*RST: NORMal

Example: See [:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:
FREQuency on page 711.
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Options: R&S SMAB-B28

Manual operation: See "Marker Polarity" on page 201

[:SOURce<hw>]:SWEep[:FREQuency]:MARKer:ACTive <Active>

Defines the marker signal to be output with a higher voltage than all other markers.

Parameters:
<Active> NONE | M01 | M02 | M03 | M04 | M05 | M06 | M07 | M08 | M09 |

M10
*RST: NONE

Example: See [:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:
FREQuency on page 711.

Options: R&S SMAB-B28

Manual operation: See "Active Marker" on page 201

[:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:FREQuency <Frequency>

Sets the frequency of the selected marker.

Suffix: 
<ch>

.
1 to 10
Marker

Parameters:
<Frequency> float

Increment: 0.01
*RST: 100 + n* 100

Example: SOURce1:SWEep:MARKer:OUTPut:POLarity NORMal
three markers at 1 GHz, 2 GHz and 3 GHz
SOURce1:SWEep:FREQuency:MARKer1:FREQuency
1000000000
SOURce1:SWEep:FREQuency:MARKer2:FREQuency
2000000000
SOURce1:SWEep:FREQuency:MARKer3:FREQuency
3000000000
SOURce1:SWEep:FREQuency:MARKer1:FSTate 1
SOURce1:SWEep:FREQuency:MARKer2:FSTate 1
SOURce1:SWEep:FREQuency:MARKer3:FSTate 1
SOURce1:SWEep:FREQuency:MARKer:ACTive M03

Options: R&S SMAB-B28

Manual operation: See "Frequency x" on page 200

[:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:FSTate <FState>

Activates the selected marker.
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Suffix: 
<ch>

.
1 to 10
Marker

Parameters:
<FState> 1 | ON | 0 | OFF

*RST: 0

Example: See [:SOURce<hw>]:SWEep[:FREQuency]:MARKer<ch>:
FREQuency on page 711.

Options: R&S SMAB-B28

Manual operation: See "State" on page 200

14.17  SYSTem subsystem

The SYSTem subsystem contains a series of commands for general functions which do
not directly affect signal generation.

Example: Retrieving instrument specification
Note: The following values are merely an example.
// Retrieving information on the data sheet versions
// query all data sheet versions stored in the instrument:
:SYSTem:SPECification:VERSion:CATalog?
"04.03,04.02,04.01,04.00,03.04,03.03,03.02,03.01,03.00,02.96,02.95,02.94,
02.02,02.01,02.00,01.03,01.02,01.01,01.00"

// query the initial data sheet version on delivery
:SYSTem:SPECification:VERSion:FACTory?
"04.00"

// select a specific data sheet version:
:SYSTem:SPECification:VERSion "04.01"

// Retrieving information on the data sheet parameters
// with respect to a poarticular data sheet
// query the IDs of all parameters listed in the selected version:
:SYSTem:SPECification:VERSion "04.03"
:SYSTem:SPECification:IDENtification:CATalog?
"ID_RF_FREQ_SETTING_TIME_ALC_ON_MS,ID_RF_FREQ_SETTING_TIME_MS,..."

// query the data sheet information on a specific parameter,
// defined by its ID
:SYSTem:SPECification? "ID_RF_FREQ_SETTING_TIME_ALC_ON_MS"
// returns the specified and, if available,
// the typical value of the parameter.
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Example: Retrieving information on network-related settings
SYSTem:COMMunicate:NETWork:STATus?
// 1
SYSTem:PROTection1:STATe 0,123456

SYSTem:COMMunicate:NETWork:IPADdress:MODE STAT
SYSTem:COMMunicate:NETWork:IPADdress "10.113.0.104"
SYSTem:COMMunicate:NETWork:IPADdress:DNS "10.0.2.166"
SYSTem:COMMunicate:NETWork:COMMon:HOSTname?
// "SMA100B-102030"
SYSTem:COMMunicate:NETWork:COMMon:WORKgroup "instrument"
SYSTem:COMMunicate:NETWork:COMMon:DOMain "rsint.net"
SYSTem:COMMunicate:NETWork:IPADdress:GATeway "10.113.0.1"
SYSTem:COMMunicate:NETWork:IPADdress:SUBNet:MASK "255.255.252.0"
SYSTem:COMMunicate:NETWork:MACaddress "08 00 27 a3 a1 70"
SYSTem:PROTection1:STATe 1

Example: Restart network
SYSTem:COMMunicate:NETWork:RESTart
// terminates the network connection and sets it up again

Example: Finding out the used VISA resource strings
SYSTem:COMMunicate:NETWork:RESource?
// "TCPIP::10.113.0.104::inst0::INSTR"

SYSTem:COMMunicate:HISLip:RESource?
// "TCPIP::10.113.0.104::hislip0::INSTR"

SYSTem:COMMunicate:SOCKet:RESource?
// "TCPIP::10.113.0.104::5025::SOCKET"
SYSTem:COMMunicate:USB:RESource?
// "USB::0x0AAD::0x01DD::100001::INSTR"

SYSTem:COMMunicate:GPIB:RESource?
// "GPIB::28::INSTR"
SYSTem:COMMunicate:GPIB:SELF:ADDRess?
// 28
SYSTem:COMMunicate:GPIB:LTERminator?
// STAN

SYSTem:COMMunicate:SERial:RESource?
// "ASRL1::INSTR"
SYSTem:COMMunicate:SERial:SBITs?
// 1
SYSTem:COMMunicate:SERial:BAUD?
// 115200
SYSTem:COMMunicate:SERial:PARity?
// NONE
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Example: Querying the error queue
SYSTem:ERRor:STATic?
// -221,"Settings conflict", 153,"Input voltage out of range", ...
// returns all static errors that are collected in the error queue

SYSTem:ERRor:HISTory:ClEar
// deletes the history entries

:SYSTem:ERRor:ALL?....................................................................................................715
:SYSTem:ERRor:CODE:ALL?......................................................................................... 716
:SYSTem:ERRor:CODE[:NEXT]?.....................................................................................716
:SYSTem:ERRor:COUNt?...............................................................................................717
:SYSTem:ERRor[:NEXT]?...............................................................................................717
:SYSTem:ERRor:GNEXt?............................................................................................... 718
:SYSTem:ERRor:HISTory:CLEar......................................................................................718
:SYSTem:ERRor:STATic?............................................................................................... 718
:SYSTem:DLOCk........................................................................................................... 718
:SYSTem:KLOCk........................................................................................................... 719
:SYSTem:NINFormation?................................................................................................719
:SYSTem:ULOCk........................................................................................................... 719
:SYSTem:LOCK:OWNer?................................................................................................720
:SYSTem:LOCK:RELease:ALL........................................................................................ 720
:SYSTem:LOCK:REQuest[:EXCLusive]?.......................................................................... 720
:SYSTem:SAV................................................................................................................721
:SYSTem:RCL............................................................................................................... 721
:SYSTem:PROTect<ch>[:STATe]......................................................................................721
:SYSTem:SECurity:VOLMode[:STATe]..............................................................................722
:SYSTem:COMMunicate:GPIB:LTERminator.....................................................................722
:SYSTem:COMMunicate:GPIB:RESource?....................................................................... 723
:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess...............................................................723
:SYSTem:COMMunicate:HISLip:RESource?..................................................................... 723
:SYSTem:COMMunicate:NETWork:IPADdress.................................................................. 723
:SYSTem:COMMunicate:NETWork:IPADdress:MODE........................................................724
:SYSTem:COMMunicate:NETWork:MACaddress...............................................................724
:SYSTem:COMMunicate:NETWork:RESource?.................................................................724
:SYSTem:COMMunicate:NETWork:RESTart..................................................................... 724
:SYSTem:COMMunicate:NETWork:STATus?.................................................................... 725
:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain.....................................................725
:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname................................................725
:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup.............................................. 725
:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS.........................................................726
:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway..................................................726
:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK..........................................726
:SYSTem:COMMunicate:SERial:BAUD............................................................................ 726
:SYSTem:COMMunicate:SERial:PARity............................................................................726
:SYSTem:COMMunicate:SERial:RESource?.....................................................................727
:SYSTem:COMMunicate:SERial:SBITs.............................................................................727
:SYSTem:COMMunicate:SOCKet:RESource?...................................................................727
:SYSTem:COMMunicate:USB:RESource?........................................................................ 728
:SYSTem:HELP:EXPort.................................................................................................. 728
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:SYSTem:IDENtification.................................................................................................. 728
:SYSTem:IDENtification:PRESet......................................................................................729
:SYSTem:IRESponse..................................................................................................... 729
:SYSTem:ORESponse....................................................................................................729
:SYSTem:LANGuage......................................................................................................729
:SYSTem:INFormation:SCPI............................................................................................730
:SYSTem:SECurity:SANitize[:STATe]................................................................................730
:SYSTem:SECurity:SUPolicy........................................................................................... 730
:SYSTem:SPECification?................................................................................................ 730
:SYSTem:SPECification:VERSion.................................................................................... 731
:SYSTem:SPECification:IDENtification:CATalog?...............................................................731
:SYSTem:SPECification:PARameter?...............................................................................731
:SYSTem:SPECification:VERSion:CATalog?..................................................................... 732
:SYSTem:SPECification:VERSion:FACTory?.....................................................................732
:SYSTem:SRData?.........................................................................................................732
:SYSTem:STARtup:COMPlete?....................................................................................... 733
:SYSTem:DATE............................................................................................................. 733
:SYSTem:NTP:HOSTname............................................................................................. 733
:SYSTem:NTP:STATe..................................................................................................... 734
:SYSTem:TIME.............................................................................................................. 734
:SYSTem:TIME:ZONE.................................................................................................... 734
:SYSTem:TIME:ZONE:CATalog?......................................................................................734
:SYSTem:UPTime?........................................................................................................ 735
:SYSTem:BIOS:VERSion?.............................................................................................. 735
:SYSTem:VERSion?.......................................................................................................735
:SYSTem:OSYStem?......................................................................................................735
:SYSTem:MMEMory:PATH:USER?.................................................................................. 736
:SYSTem:DFPR?........................................................................................................... 736
:SYSTem:REBoot...........................................................................................................736
:SYSTem:RESTart..........................................................................................................736
:SYSTem:SHUTdown..................................................................................................... 736
:SYSTem:WAIT..............................................................................................................736
:SYSTem:FILes:TEMPorary:DELete.................................................................................737

:SYSTem:ERRor:ALL?

Queries the error/event queue for all unread items and removes them from the queue.

Return values: 
<All> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
A comma separated list of error number and a short description
of the error in FIFO order.
If the queue is empty, the response is 0,"No error"
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
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Volatile errors are reported once, at the time they appear. Identi-
cal errors are reported repeatedly only if the original error has
already been retrieved from (and hence not any more present in)
the error queue.

Example: SYST:ERR:ALL?
Queries all entries in the error queue.
Response: 0, 'no error'
No errors have occurred since the error queue was last read out.

Usage: Query only

Manual operation: See "Clear History" on page 750

:SYSTem:ERRor:CODE:ALL?

Queries the error numbers of all entries in the error queue and then deletes them.

Return values: 
<All> string

Returns the error numbers. To retrieve the entire error text, send
the command :SYSTem:ERRor:ALL?.
0
"No error", i.e. the error queue is empty
Positive value
Positive error numbers denote device-specific errors
Negative value
Negative error numbers denote error messages defined by
SCPI.

Example: SYST:ERR:CODE:ALL
Queries all entries in the error queue.
Response: 0
No errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor:CODE[:NEXT]?

Queries the error number of the oldest entry in the error queue and then deletes it.

Return values: 
<Next> string

Returns the error number. To retrieve the entire error text, send
the command :SYSTem:ERRor:ALL?.
0
"No error", i.e. the error queue is empty
Positive value
Positive error numbers denote device-specific errors
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Negative value
Negative error numbers denote error messages defined by
SCPI.

Example: SYST:ERR:CODE
Queries the oldest entry in the error queue.
Response: 0
No errors have occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor:COUNt?

Queries the number of entries in the error queue.

Return values: 
<Count> integer

0
The error queue is empty.

Example: SYST:ERR:COUN
Queries the number of entries in the error queue.
Response: 1
One error has occurred since the error queue was last read out.

Usage: Query only

:SYSTem:ERRor[:NEXT]?

Queries the error/event queue for the oldest item and removes it from the queue.

Return values: 
<Next> string

Error/event_number,"Error/event_description>[;Device-depend-
ent info]"
Error number and a short description of the error.
If the queue is empty, the response is 0,"No error"
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.
Volatile errors are reported once, at the time they appear. Identi-
cal errors are reported repeatedly only if the original error has
already been retrieved from (and hence not any more present in)
the error queue.

Example: SYST:ERR?
Queries the oldest entry in the error queue.
Response: 0, 'no error'
No errors have occurred since the error queue was last read out.

Usage: Query only

Manual operation: See "Static Notifications/History" on page 750
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:SYSTem:ERRor:GNEXt?

Similar to :SYSTem:ERRor[:NEXT]?, but queries the next entry from the global per-
sistant error/event queue.

Return values: 
<NextGlobalError> string

Error/event number, "Error/event description> [;Device depend-
ent info]"
An error number and a short description of the error.
Positive error numbers are instrument-dependent. Negative
error numbers are reserved by the SCPI standard.

Example: SYST:ERR:GNEX?
Returns the next error message from the global error queue.

Usage: Query only

:SYSTem:ERRor:HISTory:CLEar

Clears the error history.

Example: See Example "Querying the error queue" on page 714

Usage: Event

Manual operation: See "Clear History" on page 750

:SYSTem:ERRor:STATic?

Returns a list of all errors existing at the time when the query is started. This list corre-
sponds to the display on the info page under manual control.

Return values: 
<StaticErrors> string

Example: See Example "Querying the error queue" on page 714

Usage: Query only

Manual operation: See "Static Notifications/History" on page 750

:SYSTem:DLOCk <DispLockStat>

Disables the manual operation via the display, including the front panel keyboard of the
instrument and the Local key.

Parameters:
<DispLockStat> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: SYST:DLOC ON
Activates the display lock. The instrument cannot be operated
via the display until it has been enabled with SYST:DLOC OFF.
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Manual operation: See "User Interface" on page 366

:SYSTem:KLOCk <State>

Disables the front panel keyboard of the instrument including the Local key.

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: SYST:KLOC ON
Locks the front panel and external controls.
To enable the controls, send SYST:KLOC OFF.

Manual operation: See "User Interface" on page 366

:SYSTem:NINFormation?

Queries the oldest information message ("Error History > Level > Info") in the error/
event queue.

Return values: 
<NextInfo> string

Example: :SYSTem:NINFormation?
Queries the oldest entry in the info message queue.
Response: 90,"Info;=== Instrument startup...
==="
Information message containing error number 90, that states,
that the instrument startup is complete.

Usage: Query only

:SYSTem:ULOCk <Mode>

Locks or unlocks the user interface of the instrument.

Parameters:
<Mode> ENABled | DONLy | DISabled | TOFF | VNConly

ENABled
Unlocks the display, the touchscreen and all controls for the
manual operation.
DONLy
Locks the touchscreen and controls for the manual operation of
the instrument. The display shows the current settings.
VNConly
Locks the touchscreen and controls for the manual operation,
and enables remote operation over VNC. The display shows the
current settings.
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TOFF
Locks the touchscreen for the manual operation of the instru-
ment. The display shows the current settings.
DISabled
Locks the display, the touchscreen and all controls for the man-
ual operation.
*RST: n.a. (factory preset: ENABled)

Example: :SYST:ULOC DIS
Activates the user interface lock, including display and controls.

Manual operation: See "User Interface" on page 366

:SYSTem:LOCK:OWNer?

Queries the sessions that have locked the instrument currently.

If an exclusive lock is set, the query returns the owner of this exclusive lock, otherwise
it returns NONE.

Return values: 
<Owner> string

Example: SYST:LOCK:OWN?
Returns the owner of locking.
Response: NONE
The instrument is not locked.

Usage: Query only

:SYSTem:LOCK:RELease:ALL

Revokes the exclusive access to the instrument.

Usage: Setting only

:SYSTem:LOCK:REQuest[:EXCLusive]?

Queries whether a lock for exclusive access to the instrument via ethernet exists. If
successful, the query returns a 1, otherwise 0.

Return values: 
<Success> integer

Example: SYST:LOCK:REQ?
Queries the state of exclusive locking.
Response: 1
The exclusive locking is active.

Usage: Query only
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:SYSTem:SAV <Pathname>

Saves the current R&S SMA100B settings into a file with defined filename and into a
specified directory. The file extension (*.savrcltxt) is assigned automatically.

Setting parameters: 
<Pathname> string

Example: SYSTem:SAV "/var/user/temp/Test"
Saves the file Test.savrcltxt into the direc-
tory /var/user/temp/.

Usage: Setting only

:SYSTem:RCL <Pathname>

Loads a file with previously saved R&S SMA100B settings.

Loads the selected file with previously saved R&S SMA100B settings from the default
or the specified directory. Loaded are files with extension *.savrcltxt.

Setting parameters: 
<Pathname> string

Example: SYSTem:RCL "/var/user/temp/Test"
Loads the file Test.savrcltxt from the direc-
tory /var/user/temp/.

Usage: Setting only

:SYSTem:PROTect<ch>[:STATe] <State>[, <Key>]

Activates and deactivates the specified protection level.

Suffix: 
<ch>

.
Indicates the protection level.
See also "Protection" on page 361

Parameters:
<State> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 1)

Setting parameters: 
<Key> integer

The respective functions are disabled when the protection level
is activated. No password is required for activation of a level.
A password must be entered to deactivate the protection level.
The default password for the first level is 123456.
This protection level is required to unlock internal adjustments
for example.
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Example: To activate protection level:
SYSTem:PROTect1:STATe 1
Internal adjustments or hostname cannot be changed.
To unlock protection level 1:
SYSTem:PROTect1:STATe 0,123456
Internal adjustments are accessible.

Manual operation: See "Protection Level/Password" on page 362

:SYSTem:SECurity:VOLMode[:STATe] <SecPassWord>, <MmemProtState>

Activates volatile mode, so that no user data can be written to the internal memory per-
manently.

To enable volatile mode, reboot the instrument. Otherwise the change has no effect.

Parameters:
<MmemProtState> 0 | 1 | OFF | ON

*RST: 0

Setting parameters: 
<SecPassWord> string

Current security password
The default password is 123456.

Example: SYSTem:SECurity:VOLMode:STATe "123456", 1
SYSTem:REBoot

Manual operation: See "Volatile Mode" on page 365

:SYSTem:COMMunicate:GPIB:LTERminator <LTerminator>

Sets the terminator recognition for remote control via GPIB interface.

Parameters:
<LTerminator> STANdard | EOI

EOI
Recognizes an LF (Line Feed) as the terminator only when it is
sent with the line message EOI (End of Line). This setting is rec-
ommended particularly for binary block transmissions, as binary
blocks may coincidentally contain a characater with value LF
(Line Feed), although it is not determined as a terminator.
STANdard
Recognizes an LF (Line Feed) as the terminator regardless of
whether it is sent with or without EOI.
*RST: n.a. (factory preset: STANdard)

Example: See Example "Finding out the used VISA resource strings"
on page 713.
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:SYSTem:COMMunicate:GPIB:RESource?

Queries the visa resource string for remote control via the GPIB interface.

To change the GPIB address, use the command :SYSTem:COMMunicate:GPIB[:
SELF]:ADDRess.

Return values: 
<Resource> string

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Usage: Query only

:SYSTem:COMMunicate:GPIB[:SELF]:ADDRess <Address>

Sets the GPIB address.

Parameters:
<Address> integer

Range: 0  to  30
*RST: n.a. (factory preset: 28)

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Manual operation: See "GPIB Channel Address" on page 402

:SYSTem:COMMunicate:HISLip:RESource?

Queries the VISA resource string. This string is used for remote control of the instru-
ment with HiSLIP protocol.

Return values: 
<Resource> string

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Usage: Query only

Manual operation: See "HISLIP" on page 401

:SYSTem:COMMunicate:NETWork:IPADdress <IpAddress>

Sets the IP address.

Parameters:
<IpAddress> string

Range: 0.0.0.0.  to  ff.ff.ff.ff

Example: See Example "Retrieving information on network-related set-
tings" on page 713.
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Manual operation: See "IP Address" on page 399

:SYSTem:COMMunicate:NETWork:IPADdress:MODE <Mode>

Selects manual or automatic setting of the IP address.

Parameters:
<Mode> AUTO | STATic

*RST: n.a. (factory preset: AUTO)

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Manual operation: See "Address Mode" on page 398

:SYSTem:COMMunicate:NETWork:MACaddress <MacAddress>

Queries the MAC address of the network adapter.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<MacAddress> string

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Manual operation: See "MAC Address" on page 400

:SYSTem:COMMunicate:NETWork:RESource?

Queries the visa resource string for Ethernet instruments.

Return values: 
<Resource> string

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Usage: Query only

Manual operation: See "VXI11" on page 401

:SYSTem:COMMunicate:NETWork:RESTart

Restarts the network.

Example: See Example "Restart network" on page 713.

Usage: Event

Manual operation: See "Restart Network" on page 398
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:SYSTem:COMMunicate:NETWork:STATus?

Queries the network configuration state.

Return values: 
<State> 1 | ON | 0 | OFF

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Usage: Query only

Manual operation: See "Network Status" on page 398

:SYSTem:COMMunicate:NETWork[:COMMon]:DOMain <Domain>

Determines the primary suffix of the network domain.

Parameters:
<Domain> string

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Manual operation: See "DNS Suffix" on page 399

:SYSTem:COMMunicate:NETWork[:COMMon]:HOSTname <Hostname>

Sets an individual hostname for the Signal Generator.

Note: We recommend that you do not change the hostname to avoid problems with
the network connection. If you change the hostname, be sure to use a unique name.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Hostname> string

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Manual operation: See "Hostname" on page 398

:SYSTem:COMMunicate:NETWork[:COMMon]:WORKgroup <Workgroup>

Sets an individual workgroup name for the instrument.

Parameters:
<Workgroup> string

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Manual operation: See "Workgroup" on page 398
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:SYSTem:COMMunicate:NETWork[:IPADdress]:DNS <DNS>

Determines or queries the network DNS server to resolve the name.

Parameters:
<DNS> string

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Manual operation: See "DNS Server" on page 400

:SYSTem:COMMunicate:NETWork[:IPADdress]:GATeway <Gateway>

Sets the IP address of the default gateway.

Parameters:
<Gateway> string

Range: 0.0.0.0  to  ff.ff.ff.ff

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Manual operation: See "Default Gateway" on page 399

:SYSTem:COMMunicate:NETWork[:IPADdress]:SUBNet:MASK <Mask>

Sets the subnet mask.

Parameters:
<Mask> string

Example: See Example "Retrieving information on network-related set-
tings" on page 713.

Manual operation: See "Subnet Mask" on page 399

:SYSTem:COMMunicate:SERial:BAUD <Baud>

Defines the baudrate for the serial remote control interface.

Parameters:
<Baud> 2400 | 4800 | 9600 | 19200 | 38400 | 57600 | 115200

*RST: n.a. (factory preset: 115200)

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Manual operation: See "Baud Rate" on page 403

:SYSTem:COMMunicate:SERial:PARity <Parity>

Enters the parity for the serial remote control interface.
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Parameters:
<Parity> NONE | ODD | EVEN

*RST: n.a. (factory preset: NONE)

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Manual operation: See "Parity" on page 403

:SYSTem:COMMunicate:SERial:RESource?

Queries the visa resource string for the serial remote control interface. This string is
used for remote control of the instrument.

Return values: 
<Resource> string

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Usage: Query only

Manual operation: See "SERIAL" on page 401

:SYSTem:COMMunicate:SERial:SBITs <SBits>

Defines the number of stop bits for the serial remote control interface.

Parameters:
<SBits> 1 | 2

*RST: n.a. (factory preset: 1)

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Manual operation: See "Stop Bits" on page 403

:SYSTem:COMMunicate:SOCKet:RESource?

Queries the visa resource string for remote control via LAN interface, using TCP/IP
socket protocol.

Return values: 
<Resource> string

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Usage: Query only

Manual operation: See "Socket" on page 401
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:SYSTem:COMMunicate:USB:RESource?

Queries the visa resource string for remote control via the USB interface.

Return values: 
<Resource> string

Example: See Example "Finding out the used VISA resource strings"
on page 713.

Usage: Query only

Manual operation: See "USB" on page 401

:SYSTem:HELP:EXPort

Saves the online help as zip archive in the user directory.

Example: :SYSTem:HELP:EXPort
MMEM:CDIR?
// "/var/user"
MMEM:CAT?
// ..,"Log,DIR,4096","help.tgz,BIN,69836600"
// confirms that help zip archive is saved.

Usage: Event

Manual operation:: "Setup > Help > Export Help to User Path"

:SYSTem:IDENtification <Identification>

Selects the mode to determine the "IDN String" and the "OPT String" for the instru-
ment, selected with command :SYSTem:LANGuage.

Note: While working in an emulation mode, the R&S SMA100B specific command set
is disabled, that is, the SCPI command SYST:IDEN is discarded.

Parameters:
<Identification> AUTO | USER

AUTO
Automatically determines the strings.
USER
User-defined strings can be selected.
*RST: n.a. (factory preset: AUTO)

Example: SYST:IDEN AUTO
Automatically assigns the OPT and IDN strings according to the
selected instrument language.

Manual operation: See "Mode" on page 404
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:SYSTem:IDENtification:PRESet

Sets the *IDN and *OPT strings in user defined mode to default values.

Example: SYST:IDEN USER
SYST:IDEN:PRES

Usage: Event

Manual operation: See "Set to Default" on page 404

:SYSTem:IRESponse <IdnResponse>

Defines the user defined identification string for *IDN.

Note: While working in an emulation mode, the instrument's specific command set is
disabled, i.e. the SCPI command SYST:IRES is discarded.

Parameters:
<IdnResponse> string

Example: SYST:IDEN USER
// Selects a user-defined identification
SYST:IRES "Test Device"
// Defines identification string 'test device'
*IDN?
// Response: 'test device'

Manual operation: See "IDN String" on page 404

:SYSTem:ORESponse <OResponse>

Defines the user defined response string for *OPT.

Note: While working in an emulation mode, the instrument's specific command set is
disabled, i.e. the SCPI command SYST:ORES is discarded.

Parameters:
<OResponse> string

Example: SYST:IDEN USER
// Selects a user-defined identification
SYST:ORES "Test Option"
// Defines the OPT string 'test option'
*OPT?
// Response: 'test option'

Manual operation: See "OPT String" on page 404

:SYSTem:LANGuage <Language>

Sets the remote control command set.
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Parameters:
<Language> string

Example: SYSTem:LANGuage "SCPI"
// selects SCPI command set

Manual operation: See "Language" on page 404

:SYSTem:INFormation:SCPI <InfoString>

Inserts system information in recorded SCPI command lists, for example information
on a missing command.

Parameters:
<InfoString> string

Example: SYST:INF:SCPI "missing command"
enters the information into a recorded SCPI command list.

:SYSTem:SECurity:SANitize[:STATe] <SecPassWord>, <MmemProtState>

Sanitizes the internal memory.

Parameters:
<MmemProtState> 0 | 1 | OFF | ON

*RST: 0

Setting parameters: 
<SecPassWord> string

Example: SYSTem:SECurity:SANitize[:STATe] 1

Manual operation: See "Sanitize" on page 365

:SYSTem:SECurity:SUPolicy <SecPassWord>, <UpdatePolicy>

Configures the automatic signature verification for firmware installation.

Parameters:
<UpdatePolicy> STRict | CONFirm | IGNore

*RST: n.a. (factory preset: CONFirm)

Setting parameters: 
<SecPassWord> string

Manual operation: See "Secure Update Policy" on page 364

:SYSTem:SPECification? <Id>

Retrieves data sheet information for a specific parameter.
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Setting parameters: 
<Id> string

Identifies the name of the entry in the data sheet, as queried
with the command :SYSTem:SPECification:
IDENtification:CATalog? on page 731

Return values: 
<ValList> float

Comma-separated list with the specified and, if available, the
typical value of the parameter, as specified in the data sheet.
See also Chapter 13.6.2.3, "Datasheet", on page 414.

Example: See Example "Retrieving instrument specification" on page 712.

Usage: Query only

:SYSTem:SPECification:VERSion <Version>

Selects a data sheet version from the data sheets saved on the instrument.

Further queries regarding the data sheet parameters (<Id>) and their values refer to
the selected data sheet.

To query the list of data sheet versions, use the command :SYSTem:
SPECification:VERSion:CATalog? on page 732.

Parameters:
<Version> string

Example: See :SYSTem:SPECification? on page 730.

:SYSTem:SPECification:IDENtification:CATalog?

Queries the parameter identifiers (<Id>) available in the data sheet.

Return values: 
<IdList> string

Comma-separated string of the parameter identifiers (<Id>)

Example: See :SYSTem:SPECification? on page 730.

Usage: Query only

:SYSTem:SPECification:PARameter? <Id>[, <Parameter>]

Retrieves data sheet information for a specific parameter.

Setting parameters: 
<Id> string

Identifies the name of the entry in the data sheet.
Query the data sheet parameters with the command :SYSTem:
SPECification:IDENtification:CATalog?.
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<Parameter> float
An additional value the result (ValList) depends on.

Return values: 
<ValList> float

Comma-separated list with the specified and, if available, the
typical value of the parameter, as specified in the data sheet.

Example: Note: The following values are merely an example. Your instru-
ment may not support the same parameters.
SYST:SPEC:PAR? "ID_RF_FREQ_SETTING_TIME_MS",0.1
SYST:SPEC:PAR? "ID_RF_LEVEL_MAX_GENERAL_DBM",
0.1

Usage: Query only

:SYSTem:SPECification:VERSion:CATalog?

Queries all data sheet versions stored in the instrument.

Return values: 
<VersCatalog> string

Example: See :SYSTem:SPECification? on page 730.

Usage: Query only

:SYSTem:SPECification:VERSion:FACTory?

Queries the data sheet version of the factory setting.

Return values: 
<Version> string

Example: See :SYSTem:SPECification? on page 730.

Usage: Query only

Manual operation: See "Versions" on page 755

:SYSTem:SRData?

Queris the SCPI recording data from the internal file.

This feature enables you to transfer an instrument configuration to other test environ-
ments, as e.g. laboratory virtual instruments.

Return values: 
<FileData> block data
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Example: SYSTem:SRData? 
// #3118:SOURce1:ROSCillator:SOURce EXT
// :SOURce1:FREQuency:CW 4000000000
// :SOURce1:FREQuency:OFFSet 1000000
// :SOURce1:AM1:STATe 1
// :OUTPut1:STATe 1

Usage: Query only

:SYSTem:STARtup:COMPlete?

Queries if the startup of the instrument is completed.

Return values: 
<Complete> 1 | ON | 0 | OFF

*RST: 0

Example: SYST:STAR:COMP?
Response: 1
the startup of the instrument is completed.

Usage: Query only

:SYSTem:DATE <Year>, <Month>, <Day>

Queries or sets the date for the instrument-internal calendar.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Year> integer

<Month> integer
Range: 1  to  12

<Day> integer
Range: 1  to  31

Example: :SYSTem:DATE?
// 2016,05,01

Manual operation: See "Date" on page 766

:SYSTem:NTP:HOSTname <NTPName>

Sets the address of the NTP server. You can enter the IP address, or the hostname of
the time server, or even set up an own vendor zone. See the Internet for more informa-
tion on NTP.

Parameters:
<NTPName> string

Manual operation: See "NTP Address" on page 767
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:SYSTem:NTP:STATe <UseNtpState>

Activates clock synchronization via NTP.

Parameters:
<UseNtpState> 1 | ON | 0 | OFF

*RST: n.a. (factory preset: 0)

Example: SYSTem:NTP:STATe 1

Manual operation: See "Use Time from NTP Server" on page 767

:SYSTem:TIME <Hour>, <Minute>, <Second>

Queries or sets the time for the instrument-internal clock.

This is a password-protected function. Unlock the protection level 1 to access it.

Parameters:
<Hour> integer

Range: 0  to  23

<Minute> integer
Range: 0  to  59

<Second> integer
Range: 0  to  59

Example: SYSTem:TIME?
// 10,27,14

Manual operation: See "Time" on page 767

:SYSTem:TIME:ZONE <TimeZone>

Sets the timezone. You can query the list of the available timezones with :SYSTem:
TIME:ZONE:CATalog?.

Parameters:
<TimeZone> string

Manual operation: See "Timezone" on page 767

:SYSTem:TIME:ZONE:CATalog?

Querys the list of available timezones.

Return values: 
<Catalog>

Usage: Query only

Manual operation: See "Timezone" on page 767
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:SYSTem:UPTime?

Queries the up time of the operating system.

Return values: 
<UpTime> "<ddd.hh:mm:ss>"

Example: SYSTem:UPTime?
Response: "0.08:11:00"

Usage: Query only

:SYSTem:BIOS:VERSion?

Queries the BIOS version of the instrument.

Return values: 
<Version> string

Example: SYST:BIOS:VERS?
queries the BIOS version.
Response: 123456

Usage: Query only

:SYSTem:VERSion?

Queries the SCPI version the instrument's command set complies with.

Return values: 
<Version> string

Example: SYST:VERS
queries the SCPI version.
Response: "1996"
The instrument complies with the SCPI version from 1996.

Usage: Query only

:SYSTem:OSYStem?

Queries the operating system of the instrument.

Return values: 
<OperSystem> string

Example: SYSTem:OSYStem?
Response: "Linux"

Usage: Query only
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:SYSTem:MMEMory:PATH:USER?

Queries the user directory, that means the directory the R&S SMA100B stores user
files on.

Return values: 
<PathUser> string

Example: SYSTem:MMEMory:PATH:USER?
Response: "'/var/user/"

Usage: Query only

:SYSTem:DFPR?

Queries the device footprint of the instrument. The retrieved information is in machine-
readable form suitable for automatic further processing.

Return values: 
<DeviceFootprint> string

Information on the instrument type, device identification and
details on the installed FW version, hardware and software
options.

Example: :SYSTem:DFPR?
Usage: Query only

:SYSTem:REBoot

Reboots the instrument including the operating system.

Usage: Event

:SYSTem:RESTart

Restarts the instrument without restarting the operating system.

Usage: Event

:SYSTem:SHUTdown

Shuts down the instrument.

Usage: Event

Manual operation: See "Shut down" on page 772

:SYSTem:WAIT <TimeMs>

Delays the execution of the subsequent remote command by the specified time.
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This function is useful, for example to execute an SCPI sequence automatically but
with a defined time delay between some commands.

See Chapter 12.2.4, "How to assign actions to the [★ (User)] key", on page 353.

Setting parameters: 
<TimeMs> integer

Wait time in ms
Range: 0  to  10000
*RST: 0

Example: SYSTem:WAIT 10000
// Waits 10s before resetting the instrument.
*RST

Usage: Setting only

:SYSTem:FILes:TEMPorary:DELete

Deletes the temporary files from the internal memory or, if installed, from the SD card
slot.

Example: :SYSTem:FILes:TEMPorary:DELete
// temporary files are removed

Usage: Event

14.18  STATus subsystem

This system contains the commands for the status reporting system. See also Chap-
ter 13.4, "Status reporting system", on page 388 for detailed information.

*RST on page 453 has no effect on the status registers.

Value ranges

● Queries return the current value of the respective register, which permits a check of
the device status.
Return values: A decimal value in the range 0 to 32767 (=215-1)

● The configuration commands set the respective register thus determining which
status changes of the R&S SMA100B cause the status registers to be changed.
Setting values: A decimal value in the range 0 to 32767 (=215-1)

:STATus:OPERation:CONDition?.....................................................................................738
:STATus:OPERation:ENABle...........................................................................................738
:STATus:OPERation[:EVENt]...........................................................................................738
:STATus:OPERation:NTRansition.................................................................................... 738
:STATus:OPERation:PTRansition.....................................................................................739
:STATus:PRESet............................................................................................................739
:STATus:QUEStionable:CONDition.................................................................................. 739
:STATus:QUEStionable:ENABle.......................................................................................739
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:STATus:QUEStionable[:EVENt]...................................................................................... 740
:STATus:QUEStionable:NTRansition................................................................................ 740
:STATus:QUEStionable:PTRansition................................................................................ 740
:STATus:QUEue[:NEXT]?................................................................................................741

:STATus:OPERation:CONDition?

Quieries the content of the CONDition part of the STATus:OPERation register.

This part contains information on the action currently being performed in the instru-
ment. The content is not deleted after being read out because it indicates the current
hardware status.

Return values: 
<Condition> string

Example: :STATus:OPERation:CONDition?

Usage: Query only

:STATus:OPERation:ENABle <Enable>

Sets the bits of the ENABle part of the STATus:OPERation register. This setting deter-
mines which events of the Status-Event part are forwarded to the sum bit in the status
byte. These events can be used for a service request.

Parameters:
<Enable> string

Example: :STAT:OPER:ENAB 32767
all events are forwarded to the sum bit of the status byte.

:STATus:OPERation[:EVENt] <Event>

Queries the content of the EVENt part of the STATus:OPERation register. This part
contains information on the actions performed in the instrument since the last readout.
The content of the EVENt part is deleted after being read out.

Parameters:
<Event> string

Example: :STAT:OPER:EVEN?
queries the STATus:OPERation:EVENt register.

:STATus:OPERation:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:OPERation register. If a bit is set, a
transition from 1 to 0 in the condition part causes an entry to be made in the EVENt
part of the register. The disappearance of an event in the hardware is thus registered,
for example the end of an adjustment.

Parameters:
<Ntransition> string

STATus subsystem
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Example: :STAT:OPER:NTR 0
a transition from 1 to 0 in the condition part of the Status:Opera-
tion register does not cause an entry to be made in the EVENt
part.

:STATus:OPERation:PTRansition <Ptransition>

Sets the bits of the PTRansition part of the STATus:OPERation register. If a bit is set, a
transition from 0 to 1 in the condition part causes an entry to be made in the EVENt
part of the register. A new event in the hardware is thus registered, for example the
start of an adjustment.

Parameters:
<Ptransition> string

Example: :STAT:OPER:PTR 32767
all transitions from 0 to 1 in the condition part of the Status:Oper-
ation register cause an entry to be made in the EVENt part.

:STATus:PRESet <Preset>

Resets the status registers. All PTRansition parts are set to FFFFh (32767), i.e. all
transitions from 0 to 1 are detected. All NTRansition parts are set to 0, i.e. a transition
from 1 to 0 in a CONDition bit is not detected. The ENABle parts of STATus:OPERation
and STATus:QUEStionable are set to 0, i.e. all events in these registers are not passed
on.

Parameters:
<Preset> string

Example: STAT:PRES
resets the status registers.

:STATus:QUEStionable:CONDition <Condition>

Queries the content of the CONDition part of the STATus:QUEStionable register. This
part contains information on the action currently being performed in the instrument.
The content is not deleted after being read out since it indicates the current hardware
status.

Parameters:
<Condition> string

Example: :STATus:QUEStionable:CONDition?
queries the Status:Questionable:Condition register.

:STATus:QUEStionable:ENABle <Enable>

Sets the bits of the ENABle part of the STATus:QUEStionable register. The enable part
determines which events of the STATus:EVENt part are enabled for the summary bit in
the status byte. These events can be used for a service request.

STATus subsystem
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If a bit in the ENABle part is 1, and the correesponding EVENt bit is true, a positive
transition occurs in the summary bit. This transition is reportet to the next higher level.

Parameters:
<Enable> string

Example: STAT:QUES:ENAB 1
Problems when performing an adjustment cause an entry to be
made in the sum bit.

:STATus:QUEStionable[:EVENt] <Event>

Queries the content of the EVENt part of the STATus:QUEStionable register. This
part contains information on the actions performed in the instrument since the last
readout. The content of the EVENt part is deleted after being read out.

Parameters:
<Event> string

Example: STAT:QUES:EVEN?
queries the Status:Questionable:Event register.

:STATus:QUEStionable:NTRansition <Ntransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENt part of the register.

Parameters:
<Ntransition> string

Example: STAT:QUES:NTR 0
a transition from 1 to 0 in the condition part of the STA-
Tus:QUEStionable register does not cause an entry to be made
in the EVENt part

:STATus:QUEStionable:PTRansition <PTransition>

Sets the bits of the NTRansition part of the STATus:QUEStionable register. If a bit is
set, a transition from 1 to 0 in the condition part causes an entry to be made in the
EVENt part of the register.

Parameters:
<PTransition> string

Example: STAT:QUES:PTR 32767
all transitions from 0 to 1 in the condition part of the STA-
Tus:QUEStionable register cause an entry to be made in the
EVENt part

STATus subsystem
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:STATus:QUEue[:NEXT]?

Queries the oldest entry in the error queue and then deletes it. Positive error numbers
denote device-specific errors, and negative error numbers denote error messages
defined by SCPI. If the error queue is empty, 0 ("No error") is returned.

The command is identical to :SYSTem:ERRor[:NEXT]? on page 717.

Return values: 
<Next> string

Example: :STATus:QUEue?
queries the oldest entry in the error queue.
Response: 0, 'no error'
no errors have occurred since the error queue was last read out

Usage: Query only

14.19  TEST subsystem

The TEST subsystem contains the commands for performing test routines directly at
the hardware assemblies.

The selftetst responses with a 0 if the test is performed successfully, otherwise a value
other than 0 is returned. None of the commands of this system has a *RST value.

:TEST<hw>:ALL:STARt.................................................................................................. 741
:TEST<hw>:ALL:RESult?................................................................................................741

:TEST<hw>:ALL:STARt

Usage: Event

Starts the selftest. Use the command :TEST<hw>:ALL:RESult? to query the result.

:TEST<hw>:ALL:RESult?

Queries the result of the performed selftest. Start the selftest with :TEST<hw>:ALL:
STARt.

Return values: 
<Result> 0 | 1 | RUNning | STOPped

*RST: STOPped

Usage: Query only

TEST subsystem
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14.20  TRIGger subsystem

The TRIGger system contains the commands for selecting the trigger source for the
RF and LF sweep.

You can work with an internal or with an externally applied trigger signal. In this case,
use the commands in the SOURce:INPut subsystem to configure the signal.

The trigger system of the R&S SMA100B is a simplified implementation of the SCPI
trigger system. The TRIGger system differs from the SCPI system as follows:
● No INITiate command; the instrument behaves as if INITiate:CONTinuous

ON were set.
● Under TRIGger several sweep subsystems exist.
● The trigger source names correspond directly to the various settings of manual

control. SCPI uses different names which are also accepted by the instrument. The
SCPI names should be used if compatibility is an important consideration.

In addition to these commands, see more trigger-related commands in the modulation
and RF signal subsystems.
Table 14-1: Cross-reference between the manual and remote control

R&S proprietary value name SCPI conform value name Parameter in manual control

AUTO IMMediate "Auto" mode

SINGle BUS "Single" mode.

EXTernal EXTernal "Ext Single" and "Ext Step" mode.

Use command LFO:SWEep:MODE
to select between the two sweep
modes.

EAUTo - "Ext Start/Stop" mode.

:TRIGger<hw>:FSWeep:SOURce....................................................................................742
:TRIGger<hw>:LFFSweep:SOURce.................................................................................742
:TRIGger<hw>:PSWeep:SOURce....................................................................................742
:TRIGger<hw>[:SWEep]:SOURce....................................................................................742
:TRIGger<hw>:FPSWeep:SOURce..................................................................................744
:TRIGger<hw>:FSWeep[:IMMediate]................................................................................744
:TRIGger<hw>:LFFSweep:IMMediate.............................................................................. 744
:TRIGger<hw>:PSWeep[:IMMediate]................................................................................744
:TRIGger<hw>[:SWEep][:IMMediate]................................................................................744
:TRIGger<hw>:LFFSweep.............................................................................................. 745

:TRIGger<hw>:FSWeep:SOURce <Source>
:TRIGger<hw>:LFFSweep:SOURce <Source>
:TRIGger<hw>:PSWeep:SOURce <Source>
:TRIGger<hw>[:SWEep]:SOURce <Source>
Selects the trigger source for the corresponding sweeps:
● FSWeep - RF frequency

TRIGger subsystem
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● LFFSweep - LF frequency
● PSWeep - RF level
● SWEep - all sweeps

The source names of the parameters correspond to the values provided in manual
control of the instrument. They differ from the SCPI-compliant names, but the instru-
ment accepts both variants.

Use the SCPI name, if compatibility is an important issue. Find the corresponding
SCPI-compliant commands in Cross-reference between the manual and remote con-
trol.

Setting parameters: 
<Source> AUTO | IMMediate | SINGle | BUS | EXTernal | EAUTo

AUTO [IMMediate]
Executes a sweep automatically.
In this free-running mode, the trigger condition is met continu-
ously. I.e. when a sweep is completed, the next one starts imme-
diately.
SINGle [BUS]
Executes one complete sweep cycle.
The following commands initiate a trigger event:
*TRG on page 454
[:SOURce<hw>]:SWEep:POWer:EXECute
[:SOURce<hw>]:SWEep[:FREQuency]:EXECute
:TRIGger<hw>[:SWEep][:IMMediate], :TRIGger<hw>:
PSWeep[:IMMediate] and :TRIGger<hw>:FSWeep[:
IMMediate].
Set the sweep mode with the commands:
[:SOURce<hw>]:SWEep:POWer:MODEAUTO|STEP
[:SOURce<hw>]:SWEep[:FREQuency]:MODEAUTO|STEP
[:SOURce<hw>]:LFOutput:SWEep[:FREQuency]:MODE
AUTO|STEP
In step mode (STEP), the instrument executes only one step.
EXTernal
An external signal triggers the sweep.
EAUTo
An external signal triggers the sweep. When one sweep is fin-
ished, the next sweep starts.
A second trigger event stops the sweep at the current frequency,
a third trigger event starts the trigger at the start frequency, and
so on.
*RST: AUTO

Example: See Example "Setup an LF sweep" on page 652

Usage: Setting only

TRIGger subsystem
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:TRIGger<hw>:FPSWeep:SOURce <FpTrigSource>

Selects the trigger source for the combined RF frequency / level sweep.

The parameter names correspond to the manual control. If needed, see table
Table 14-1 for selecting the trigger source with SCPI compliant parameter names.

Parameters:
<FpTrigSource> AUTO | IMMediate | SINGle | BUS | EXTernal | EAUTo

AUTO|IMMediate
Executes the combined RF sweep automatically. In this free-run-
ning mode, the trigger condition is met continuously. I.e. as soon
as a sweep is completed, the next one starts immediately.
SINGle|BUS
Executes one complete sweep cycle triggered by the GPIB com-
mands [:SOURce<hw>]:SWEep:COMBined:EXECute or
*TRG. The mode has to be set to [:SOURce<hw>]:SWEep:
COMBined:MODE > AUTO.
EXTernal
An external signal triggers the sweep.
EAUTo
An external signal triggers the sweep. As soon as one sweep is
finished, the next sweep starts. A second trigger event stops the
sweep at the current frequency and level value pairs, a third trig-
ger event starts the trigger at the start values, and so on.
*RST: No enum range assigned!

Manual operation: See "Mode" on page 189

:TRIGger<hw>:FSWeep[:IMMediate]
:TRIGger<hw>:LFFSweep:IMMediate
:TRIGger<hw>:PSWeep[:IMMediate]
:TRIGger<hw>[:SWEep][:IMMediate]
Performs a single sweep and immediately starts the activated, corresponding sweep:
● FSWeep - RF frequency
● PSWeep - RF level
● LFFSweep - LF frequency
● SWEep - all sweeps

Effective in the following configuration:
● TRIG:FSW|LFFS|PSW|[:SWE]:SOUR SING
● SOUR:SWE:FREQ|POW:MODE AUTO or SOUR:LFO:SWE:[FREQ:]MODE AUTO
Alternatively, you can use the IMMediate command instead of the respective SWEep:
[FREQ:]|POW:EXECute command.

Example: TRIG
Starts all active sweeps.

TRIGger subsystem
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Usage: Event

Manual operation: See "Execute Single Sweep" on page 193

:TRIGger<hw>:LFFSweep

Executes an LF frequency sweep in the following configuration:
● TRIG:LFFS:SOUR SING
● LFO:SWE:MODE  AUTO
Example: LFO:SWE:MODE AUTO

TRIG:LFFS:SOUR SING
TRIG:LFFSweep

Usage: Event

14.21  UNIT subsystem

The UNIT subsystem is used to set default units for parameters if no unit is indicated in
a command. These settings are valid for the entire instrument.

Example: Setting default units for remote control
UNIT:POW V
UNIT:ANGL DEG

Sets V (volts) as unit of all power parameters, DEG (degrees) for the phase modulation
angle and KMH for the speed.

:UNIT:ANGLe.................................................................................................................745
:UNIT:POWer.................................................................................................................745

:UNIT:ANGLe <Angle>

Sets the default unit for phase modulation angle. The command affects no other
parameters, such as RF phase, or the manual control or display.

Parameters:
<Angle> DEGree | DEGRee | RADian

*RST: RADian

:UNIT:POWer <Power>

Sets the default unit for all power parameters. This setting affects the GUI, as well as
all remote control commands that determine power values.

Parameters:
<Power> V | DBUV | DBM

*RST: DBM

UNIT subsystem
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15  Troubleshooting and notifications
The R&S SMA100B distinguishes between various notifications caused by events or
functions. It displays a notification in the "Info" line on the screen temporarily, and
saves all notifications in a history list. In addition, an event initiates an entry in the
event/error queue of the status reporting system.

See:
● Chapter 13.4, "Status reporting system", on page 388
● Chapter 15.4, "Querying notifications", on page 749

15.1  Notifications

Notifications inform about operation states of the instrument, and point out deviations,
deficiencies or imperfection of functions that initiate an event in the instrument. The
instrument distinguishes the notifications according to the significance of the events by
different icons.

Some events require that you eliminate the deviation to make sure that the instrument
operates correctly.

To access the notifications and history list dialog, see Chapter 15.4, "Querying notifica-
tions", on page 749. In remote control mode, you can query the notifications using the
command :SYSTem:ERRor:ALL? on page 715.

15.1.1  Volatile notifications

Volatile notifications report automatic settings in the instrument (e.g. switching off
incompatible types of modulation) or on entries that are not accepted by the instrument
(e.g. range violations).

Volatile notifications do not normally demand user actions and disappear automatically
after a short period of time. They are saved in the history list, however.

Remote command:

:SYSTem:ERRor:ALL? or

:SYSTem:ERRor:CODE[:NEXT]?

15.1.2  Permanent notifications

Permanent notifications are displayed if an error occurs that impairs further instrument
operation, e.g. a hardware fault. The error signaled by a permanent notification must
be eliminated before correct instrument operation can be continued.

Notifications
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The message is displayed until the error is eliminated. It covers the status display in
the info line. After error elimination, the message automatically disappears and is also
recorded in the history.

Remote command:

:SYSTem:ERRor:STATic?

15.2  SCPI notifications

The SCPI notifications are similar for all SCPI instruments. Detailed information and an
overview of all notifications as defined in SCPI standard can be found in the corre-
sponding documentation.

SCPI notifications have negative codes (numbers). The error text being entered into
the error/event queue or being displayed is printed in bold face on the left together with
the error code. Below the error text, there is an explanation to the respective error.

15.3  Device-specific notifications

Start-up error

If device-specific notifications occur during operation, the R&S SMA100B issues corre-
sponding error messages, as listed under Errors during operation. However, problems
can also occur during start-up.

If your instrument prompts this notification when starting up, some information during
initialization is missing. This error can occur when the power supply was interrupted
during the last boot-up, e.g. due to power failure.

Remedy

► Select "Reset this error".

● If the operating system and the firmware boot successfully, the functionality is
restored.

● If the notification reappears, a hardware error has occurred.
We recommend that you contact the Rohde & Schwarz customer support
(https://www.rohde-schwarz.com/support), or ship your R&S SMA100B directly
to the service center experts for troubleshooting (http://www.services.rohdesch-
warz.com).

Device-specific notifications
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Errors during operation

The following table contains all error messages specific for the instrument in alphabeti-
cal order and an explanation of the error situation. The positive error codes mark the
errors specific to the instrument.

The device-specific error messages set bit 3 in the ESR register.

The index provides a list of the error messages sorted according to their error codes.

Error
code

Error Description Remedy

50 Extern reference out of
range or disconnected

External reference is selected but no external sig-
nal is applied or the signal is out of range.

● Check the selected reference signal
source (internal or external) in the
"Setup > Reference Oscillator" dia-
log.

● Change setting to 'internal' if no
appropriate external source is avail-
able.

140 This modulation forces
other modulations off

A modulation has been switched on which cannot
be used at the same time as an already active
modulation. The previous modulation has been
switched off.

 

180 Adjustment failed Adjustment could not be executed. Generate the adjustment data and load
it into the device

182 Adjustment data missing Adjustment data is missing. Generate the adjustment data and load
it into the device

183 Adjustment data invalid Adjustment data is invalid and must be restored. Generate the adjustment data and load
it into the device

200 Cannot access hardware The data transmission to a module was unsuc-
cessful.

The module is not installed, not properly
installed or missing.

201 Hardware revision out of
date

A later version of certain parts of the instrument is
necessary to execute the function selected.

The driver does not support the installed
version of a module.

202 Cannot access the
EEPROM

An error occurs when writing or reading a
EEPROM.

The EEPROM is possibly defect.
Replace it.

203 Invalid EEPROM data Reading a EEPROM is possible, however the
data are inconsistent.

 

204 Driver initialization failed Initialization of a driver fails when booting the
instrument firmware.

The driver is not compatible with the
hardware or software configuration of
the instrument.

241 No current list There is no list selected. To execute the required
operation, a list has to be selected in the related
dialog. If no list is available, a new list must be
created.

 

242 Unknown list type speci-
fied

The list type selected is not valid for the required
operation.

Check the selected list type.

460 Cannot open the file The selected file cannot be opened. Check the path and file name.

Device-specific notifications
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Error
code

Error Description Remedy

461 Cannot write file The file cannot be written. Check if the file is read-only.

462 Cannot read file The file cannot be read. Check if the file contents are compatible
with the file type.

463 Filename missing The required operation cannot be executed
because the file name is not specified.

Enter file name when creating list.

464 Invalid filename extension The file extension is not valid for the required
operation.

Check the file extension.

465 File contains invalid data The selected file contains data that is not valid for
the file type.

The file extension determines the data that is
valid for this file type. If the file extension is
changed, the lists are no longer recognized and
the data is therefore invalid.

Check the file extension.

15.4  Querying notifications

The R&S SMA100B monitors the functions performed and automatically detects irregu-
larities. The instrument displays corresponding notifications in the "Info" line and col-
lects all notifications in a history with a detailed description.

Find details to the system notifications in Chapter 15, "Troubleshooting and notifica-
tions", on page 746.

To display information on static notifications and history

1. In the taskbar, select the "Info" icon.

2. For some notifications, the information line appears briefly on the home screen.

Querying notifications
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Selecting the info line also opens the dialog.

● The "Static Notifications" dialog lists the recently monitored notifications chro-
nologically and displays additional information on the highlighted message.

● The "History" dialog lists the accumulated messages with a short description.
Volatile notifications are reported once. If identical errors occur subsequently,
they are not reported repeatedly.
In the "Info" line, identical errors are displayed repeatedly only if the original
error has already disappeared from the display. If queried by SCPI command,
identical errors are only reported if the original error has already been retrieved
from (and hence not any more present in) the error queue.

Indication and handling of permanent notifications
If any critical error occurs, the R&S SMA100B automatically shows the  icon in the
taskbar. Select the icon to obtain information on the error and the number of occurren-
ces.
The icon is assigned to permanent notifications. The notification and icon are displayed
until the error is eliminated.

Static Notifications/History
Toggles between "Static Notifications" and the "History" tab in the info dialog.
Remote command: 
:SYSTem:ERRor[:NEXT]? on page 717
Each time a SYST:ERR:NEXT? query is sent, the eldest entry in the error queue is
returned and at the same time cleared in the list.
:SYSTem:ERRor:STATic? on page 718
Queries the list of all errors.

Clear History
Clears all messages in the "History" tab.

Querying notifications
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Remote command: 
:SYSTem:ERRor:ALL? on page 715
Each time a SYST:ERR:ALL? query is sent, the error queue is returned and at the
same time cleared.
:SYSTem:ERRor:HISTory:CLEar on page 718
Clears the messages in the "History" view.

15.5  Resolving network connection failures

Several issues may cause failures in the network connection to the instrument. This
section lists the most likely reasons and the recommended solutions.

Common reasons for network connection failures

● Network connecting cables and cable connectors of poor quality
● Incompatibility between the network interface of the R&S SMA100B and certain

switches or routers available on the market
● An invalid IP address assigned to the instrument

Possible solutions to network connection failures

1. NOTICE! Connecting to the network can cause network failure. Errors can affect
the entire network.
Consult your network administrator before performing the following tasks:
● Connecting the instrument to the network
● Configuring the network
● Changing IP addresses

2. Try out the following to resolve network connection failures:

● Check the network infrastructure. Exchange connecting cables, if obvious dam-
age is visible.
See also "Cable selection and electromagnetic interference (EMI)" on page 29.

● Observe the link status LED on the R&S SMA100B or the connected network
device. The link status LED is located next to the LAN connector.
If a link failure is detected, connect the instrument to a different device port or
to a different network device.

● Check whether the LAN interface and the required LAN services are enabled.
See Chapter 12.4.3, "Configuring LAN services", on page 368.

● If the IP address is set manually (no DHCP) or obtained via the Zeroconf
(APIPA) protocol:
– Check whether the IP address of the instrument is within the network's

address range.
– Check whether the IP address is valid.
See also "IP Address" on page 399.

Resolving network connection failures
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15.6  Measuring USB cable quality

To check the quality of the USB cable, see the service manual of the R&S SMA100B.

15.7  Requesting instrument configuration and specifica-
tions

The R&S SMA100B is equipped with various hardware and software components. To
get an overview of what your instrument is equipped with, you can request the assem-
blies, hardware and software options, and the firmware version. The components are
structured according to the hardware configuration, software options, including the
license management, and externally used Rohde & Schwarz equipment, like R&S NRP
power sensors.

Software options purchased at a later stage can be activated with a keycode. The acti-
vation code is supplied with the software option. How to install options is described in
chapter 4 of the R&S SMA100B service manual.
The installation of hardware options purchased at a later stage is also described in
chapter 4 of the service manual. Most of the hardware options have to be installed at
an authorized Rohde & Schwarz service center.

15.7.1  Hardware configuration settings

Access:

► Select "System Config > Setup > Instrument Assembly > Hardware Config".

Requesting instrument configuration and specifications
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The "Hardware Config" dialog lists all installed assemblies and externally connec-
ted instruments with information on their part and serial numbers, and revision
states. The BIOS version is also listed; firmware updates do not update the BIOS
version.
The dialog is divided in tabs, according to the hardware components of the signal
domains. The "Counter" tab provides information on the operation time and number
of times the instrument was powered on.

The remote commands required to query the hardware configuration are described in
Chapter 14.8, "DIAGnostic subsystem", on page 474.

Assembly
The tables in the tabs show characteristics of the installed assemblies.
"Assembly" Assembly designation.
"Part Number" Part number of the assembly.
"Serial Number"

Serial number of the assembly.
"Revision" Revision state of the assembly.
"Slot" Indicates whether the assembly is connected to the serial bus or PCI

bus.
Remote command: 
:DIAGnostic<hw>:BGINfo? on page 475

Counter
Displays information on the operation times of the R&S SMA100B.

Operation Time / h ← Counter
Displays the operation time in hours so far.
Remote command: 
:DIAGnostic:INFO:OTIMe? on page 476

Power On Count ← Counter
Displays the number the instrument has been turned on.
Remote command: 
:DIAGnostic:INFO:POCount? on page 476

Last Factory Calibration ← Counter
Displays the date of the last factory calibration.
Remote command: 
:CALibration:DATA:FACTory:DATE? on page 469

Requesting instrument configuration and specifications
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15.7.2  Versions/options settings

Access:

► Select "System Config > Setup > Instrument Assembly > Versions / Options".

The "Versions/Options" dialog shows the version of the installed instrument firm-
ware, the hardware and software options, the data sheet and the software compo-
nents of the firmware. The BIOS version is also listed; firmware updates do not
update the BIOS version.

The remote commands required to query the hardware configuration are described in
Chapter 14.8, "DIAGnostic subsystem", on page 474.

Firmware
Shows the firmware version and the version of the software platform.
Note: Your instrument is delivered with the latest firmware version available.
You can download firmware updates and the "Release Notes" that describe the modifi-
cations and the firmware update procedure.
See www.rohde-schwarz.com/firmware/sma100b
Remote command: 
n.a.

Downgrade Info
Shows downgrade information, like factory firmware version and minimum firmware
version to that the instrument can be downgraded.
Remote command: 
n.a.

Show Open Source Acknowledgments
Accesses the list of the used open-source software packages and the corresponding
verbatim license texts.

Requesting instrument configuration and specifications
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LucasFonts RSCorpid EULA
Accesses copyright information on LucasFonts font type RSCorpid EULA.

Hardware Options/Software Options
The tables in the "Hardware" and "Software" tabs list the installed hardware and soft-
ware options.
"Option" Short name of option
"Designation" Name of option
"Expiration Date"

For regular options, "Permanent" is indicated in this column. Some
options are available as trial versions. This column shows their expi-
ration date. After this date, the option is no longer available on the
instrument.

Remote command: 
*OPT? on page 452
*IDN? on page 451

Versions
The "Versions" tab shows the versions of the technical specification of the
R&S SMA100B and of the software components that comprise the firmware.

"Package" Name of the component.
"Version" Current issue of the component.

E.g. the data sheet covers the technical data of the hardware compo-
nents of the factory settings.
See also Chapter 13.6.2.3, "Datasheet", on page 414.

Remote command: 
:SYSTem:SPECification:VERSion:FACTory? on page 732

15.7.3  How to query instrument configuration

To get information on the components and installed options of the R&S SMA100B, pro-
ceed as described in the following examples.

Checking the installed hardware options

To find out the installed options:

1. Select "System Config > Setup > Instrument Assembly > Versions/Options".

Requesting instrument configuration and specifications
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2. Select "Hardware Options".

The dialog lists all hardware options that are installed on the R&S SMA100B.

Proceed the same way to get information for instance on the firmware, or the installed
software options in the corresponding tab.

Checking the RF hardware assembly

To find out the installed RF hardware:

1. Select "System Config > Setup > Instrument Assembly > Hardware Config".

2. Select "RF Assembly".

The dialog lists the RF hardware components that are installed on the
R&S SMA100B.

Requesting instrument configuration and specifications
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Proceed the same way to get information for instance on general or baseband hard-
ware modules, or on the operating times of the R&S SMA100B in the corresponding
tab.

15.7.4  How to request the data sheet

You can access data sheet-related information vie the LXI web browser, see Chap-
ter 13.6.2.3, "Datasheet", on page 414.

15.8  Collecting information for technical support

If you encounter problems that you cannot solve yourself, contact your
Rohde & Schwarz support center at www.rohde-schwarz.com/support. Our support
center staff is optimally trained to assist you in solving problems.

The support center finds solutions more quickly and efficiently if you provide them with
information on the instrument and an error description.
● The following dialog boxes in the "Setup > Instrument Assembly" menu provide

useful information:
– Hardware Configuration: hardware assemblies
– Software and Options: the status of all software and hardware options instal-

led on your instrument
● System Messages: displayed in the "Info" line and provide information on any

errors that have occurred
● Support file: a special file (*.tar.gz file) with important support information that

can be created automatically.
The support *.tar.gz file has a user-definable name and contains the following
files and information:
– SgErrors.txt: chronological record of errors
– SystemRestaurationSMAB.savrcltxt: instrument settings at the last cor-

rect shutdown of the instrument
– UndoHistSuppInfo.xml: list of the last user interactions
– DeviceFootprint_<SerialNumber>_<Date>_<Time>.xml: service-rela-

ted information on the instrument's configuration.
– crashlog.txt, coredump: Postmortem debug info
– Several files with information on the last performed adjustment and self-test.

See also the description of error messages Chapter 15.1, "Notifications", on page 746.

To collect error information in a support file

1. Connect a USB device to the R&S SMA100B.

2. Select "System Config > Setup > Maintenance > Create R&S Support Information".

3. In the "Create R&S Support Information" dialog, navigate to the /usb directory.

Collecting information for technical support
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Enter the support filename, for example RSSupport_DeviceInfo.

The error information and further required data are collected automatically.
The support file RSSupport_DeviceInfo.tar.gz is created and stored in the /
usb directory.
Collect the error information and attach it to an email in which you describe the
problem. Send the email to the customer support address as listed on the Internet
(www.rohde-schwarz.com/support).

To remove sensitive data

► For information on how to handle or remove the sensitive data from your instru-
ment, refer to the description "R&S SMA100B Instrument Security Procedures".

Packing and transporting the instrument

► If the instrument has to be transported or shipped, see Chapter 16, "Transporting",
on page 760.

15.9  Contacting customer support

Technical support – where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer sup-
port center. A team of highly qualified engineers provides support and works with you
to find a solution to your query on any aspect of the operation, programming or applica-
tions of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or follow this
QR code:

Contacting customer support

https://www.rohde-schwarz.com/support
https://www.rohde-schwarz.com/support
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Figure 15-1: QR code to the Rohde & Schwarz support page

Contacting customer support
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16  Transporting
Lifting and carrying

See:
● "Lifting and carrying the product" on page 19
● Chapter 3.1.1, "Lifting and carrying", on page 26.

Packing

Use the original packaging material. It consists of antistatic wrap for electrostatic pro-
tection and packing material designed for the product.

If you do not have the original packaging, use similar materials that provide the same
level of protection.

Securing

When moving the R&S SMA100B in a vehicle or using transporting equipment, make
sure that the R&S SMA100B is properly secured. Only use items intended for securing
objects.

Transport altitude

The maximum transport altitude without pressure compensation is specified in the data
sheet.
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17  Maintenance, storage and disposal
The product does not require regular maintenance. It only requires occasional clean-
ing. It is however advisable to check the nominal data from time to time.

17.1  Cleaning

How to clean the product is described in "Cleaning the product" on page 21.

Do not use any liquids for cleaning. Cleaning agents, solvents, acids and bases can
damage the front panel labeling, plastic parts and display.

17.2  Storage

Protect the product against dust. Ensure that the environmental conditions, e.g. tem-
perature range and climatic load, meet the values specified in the data sheet.

17.3  Performing maintenance tasks

The R&S SMA100B is accurate due to integrated adjustment procedures. Internal
adjustments are integrated self-calibration routines, which you can execute directly on
the instrument.

Self-calibration routines that require additional equipment are performed at an author-
ized Rohde & Schwarz service center. For description, see R&S SMA100B service
manual.

When to start internal adjustments?

We recommend that you run internal adjustments in the following cases:
● Before starting any application, that requires a maximum of level accuracy
● When a long period of time has passed since the last adjustments
● If the ambient temperature of the instrument significantly differs from the one of the

last adjustments

How to: See Chapter 17.3.1.2, "How to use the internal adjustments", on page 764.

17.3.1  Internal adjustments

Internal adjustments are integrated adjustment procedures, which you can execute
directly on the instrument.

Performing maintenance tasks
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Minimum power rating required for internal adjustments

The following tables list the minimum power rating of external 50 Ω termination that is
required to execute internal adjustments. The minimum power rating depends on the
output power options, the instrument is equipped with.
Table 17-1: Standard (no option) or high output power (R&S SMAB-B35/-B37/-B39/-K31/-K33/)

Frequency option R&S SMAB-B103/../-B120 R&S SMAB-B131/../-B167 R&S SMAB-B131/../-B167

Firmware version not relevant <4.60.112.29SP5 ≥4.60.112.29SP5

Min. power rating 1 W (30  dBm) 1 W (30  dBm) no termination required

Table 17-2: Ultra high output power (R&S SMAB-B32/-B34/-K36/-K38/-K40)

Frequency option R&S SMAB-B103/../-B120 R&S SMAB-B131/../-B167 R&S SMAB-B131/../-B167

Firmware version not relevant <4.60.112.29SP5 ≥4.60.112.29SP5

Min. power rating 2 W (33  dBm) 2 W (33  dBm) no termination required

Table 17-3: Super ultra high output power (R&S SMAB-B36S)

Frequency option not relevant   

Firmware version not relevant   

Min. power rating 2 W (33  dBm)   

17.3.1.1  Internal adjustments settings

Access:

► Select "System Config > Setup > General > Internal Adjustments".

In this dialog, you can perform internal calibration routines and get information on
the last performed calibration.

Performing maintenance tasks
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The "Temperature Offset" indicates the deviation of the current temperature of the
instrument, compared to the temperature of the last adjustment.

The remote commands required to define these settings are described in Chapter 14.6,
"CALibration subsystem", on page 467.

How to: See Chapter 17.3.1.2, "How to use the internal adjustments", on page 764.

Adjust All
Performs all available internal calibration routines of the instrument.
How to: See Chapter 17.3.1.2, "How to use the internal adjustments", on page 764.
Remote command: 
:CALibration:ALL[:MEASure]? on page 467

Last Full Adjustment
Displays the date of the last fully performed adjustment.
Remote command: 
:CALibration<hw>:ALL:DATE? on page 467

Time
Displays the elapsed time since the last full adjustment.
Remote command: 
:CALibration<hw>:ALL:TIME? on page 468

Temperature Offset
Displays the temperature difference, comparing the temperature of the last adjustment
to the current instrument temperature.
A green checkmark indícates that the offset is within the permitted range. If the temper-
ature deviates more than ±5 K, the instrument indicates a warning icon.
Remote command: 
:CALibration<hw>:ALL:TEMP? on page 468

Information
Displays information to the current adjustment state.
Remote command: 
:CALibration<hw>:ALL:INFormation? on page 468

Continue Adjustment on Error
Continues the calibration even though an error was detected. By default adjustments
are aborted on error.
This function is password-protected. Unlock the protection level 1 to access it.
Remote command: 
:CALibration<hw>:CONTinueonerror on page 469

Performing maintenance tasks
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17.3.1.2  How to use the internal adjustments

Deciding whether to run internal adjustments

1. Select "System Config > Setup > Internal Adjustment".

2. Observe the status and color indication in the section "Since Last Full Adjustment".

Green: internal adjustments are not required.
Red: internal adjustments are required. Observe also the indication in the "Informa-
tion" field.

3. We recommend that you run internal adjustments in the following cases:
● Before starting any application, that requires a maximum of level accuracy
● When a long period of time has passed since the last adjustments
● If the ambient temperature of the instrument significantly differs from the one of

the last adjustments

4. Proceed as described in "Running internal adjustments" on page 764.

Running internal adjustments

1. NOTICE! Adjustments can be invalid if performed when the instrument is not
warmed-up.
Wait until the instrument has reached its operating temperature before you start the
adjustment procedure.
The warm-up time is up to 30 minutes.

2. NOTICE! High power at the RF output applied during internal adjustment can
destroy a connected DUT (device under test).
Disconnect the DUT.

3. Replace the DUT by a terminating resistor with adequate power rating.

The required power of the resistor varies depending on whether the instrument is
equipped with a high-power option, see "Minimum power rating required for internal
adjustments" on page 762.

4. Select "System Config > Setup > Internal Adjustment > Adjust All".

If a terminating resistor is required, a warning message prompts you to make sure
that you have terminated the RF output.

Performing maintenance tasks
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5. Confirm with "Ok".

If the terminating resistor is missing, or you have not terminated the RF output with
50 Ω, a second warning message appears.

The adjustment process aborts.

If the internal adjustment has started, do not interrupt the process.
A progress indicator shows the status of the adjustment process. The extent of the
adjustments depends on the installed options.
If any error occurs, the process aborts, and an error message appears in the "Info"
line.
If there is an error:
● Select "Info".

Observe the error message.
● Continue the process.

See "Continuing the adjustment process if error appears" on page 765.

Continuing the adjustment process if error appears

Per default, if any error occurs during the adjustment process, the process aborts. An
error message appears in the "Info" line.

If you prefer to finish the adjustments also if there is an error, proceed as follows:

1. Select "System Config > Setup > Security > Protection" an unlock the protection
level 1.
See "Protection Level/Password" on page 362.

2. Select "System Config > Setup > Internal Adjustment > Configuration > Continue
Adjustment on Error > On".

3. Proceed as described in "Running internal adjustments" on page 764.

Performing maintenance tasks
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17.3.2  Date and time

The R&S SMA100B uses an internal real-time clock to determine the date and time. It
adjusts the time and date to the timezone of your location automatically, by providing a
selection list of continents and cities.

The instrument records the time whenever you create or modify files on your instru-
ment or you use timed licenses. By default, the instrument is set to the UTC timezone,
but you can select the timezone according to your location.

Moreover, the instrument supports NTP protocol for synchronizing all connected instru-
ments and computer systems to minimize time delays in the network.

17.3.2.1  Date and time settings

Access:

► Select "System Config > Setup > Maintenance > Date / Time".

The "Date / Time" dialog contains the time and data settings of the operating sys-
tem.
This function is password-protected. Unlock the protection level 1 to access it.

The required remote commands are described in Chapter 14.17, "SYSTem subsys-
tem", on page 712.

Settings:

Date.............................................................................................................................766
Time............................................................................................................................ 767
Timezone.....................................................................................................................767
NTP Address...............................................................................................................767
Use Time from NTP Server.........................................................................................767

Date
Displays the date set in the operating system in the format [yyyy.mm.dd].
Remote command: 
:SYSTem:DATE on page 733
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Time
Displays the time set in the operating system in the format [hh.mm.ss].
The time setting corresponds to the selected Use Time from NTP Server.
Remote command: 
:SYSTem:TIME on page 734

Timezone
Selects the timezone.
You can select the timezone according to the major cities on the respective continents.
Note: By typing the first letter, you can quickly navigate through the lists to find the
desired destination.
Remote command: 
:SYSTem:TIME:ZONE on page 734
:SYSTem:TIME:ZONE:CATalog? on page 734

NTP Address
Sets the IP address or host name of the NTP server.
NTP is a network time protocol used for synchronizing all participating devices in a
data network.
You can select a high-precision time server to reduce the impact of varying network
delays.
Remote command: 
:SYSTem:NTP:HOSTname on page 733

Use Time from NTP Server
Activates clock synchronization of the network via the NTP protocol.
Remote command: 
:SYSTem:NTP:STATe on page 734

17.3.2.2  How to set data and time

To select the timezone

1. Press the [Setup] key.

2. Select "Maintenance > Date /Time > Timezone".

3. Select continent and city of your location.
Tip: By typing the first letter, you can quickly navigate through the lists to find the
desired destination.

4. Close the dialogs.

The instrument adjusts the time according to the selected location.

To set the date and time

1. Press the [Setup] key.

Performing maintenance tasks
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2. Select "Security > Protection".

3. Enable the "Protection Level 1".
The default password is 123456.

4. Select "Setup > Maintenance > Date / Time".

5. Adjust the settings.

6. Close the dialogs.

The instrument adopts the new date and time.

17.3.3  Check front panel

Within this dialog, you can verify the functionality of the control keys.

How To: See Chapter 17.3.3.2, "How to test the front panel", on page 769

17.3.3.1  Check front panel settings

Access:

► Select "System Config > Setup > Maintenance > Check Front Panel".

Reflecting the front panel, the "Check Front Panel" dialog contains all functions to
test the operating elements of the instrument.

Performing maintenance tasks
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17.3.3.2  How to test the front panel

See:
● "Testing the key panel" on page 769
● "Testing the touchscreen" on page 769
● "Terminating the test" on page 770
● "Debugging" on page 771

Testing the key panel

To perform the key panel test, you operate the keys at the front panel, and check the
response of the instrument in the "Check Front Panel" dialog. To perform this test prop-
erly, check each key of the front panel. The test is only completed, when you have veri-
fied all keys.

During the test, the actual functions of the keys are disabled.

1. Press the [Setup] key.

2. Select "Maintenance > Check Front Panel"
The "Check Front Panel" dialog opens.

3. Press a key on the front panel.
Check if the corresponding key in the "Check Front Panel" dialog turns green.

4. Press the same key a second time.
Check that the key in the dialog turns red.
Note: Pressing the same key again has no further effect, except for the [Esc] key.
Pressing this key a third time, terminates the test procedure.

5. Continue with the next key on the front panel and repeat step 3 to  step 5 until all
keys are tested.

The test is completed, when each key is verified successfully, confirmed by a "Test
passed" message.

Testing the touchscreen

1. Press the [Setup] key.

2. Select "Maintenance > Check Touch Panel"
The "Finger Paint" test window opens.
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3. Drag with your finger one or more lines, for example diagonally across the screen.
The test traces the movements of your finger on the screen.

The following results are expected:
● If the lines are uninterrupted, the touchscreen works properly.

● If there are any gaps, the touch-sensitive functionality is damaged.

● To return to the "Check Front Panel" dialog, press [Esc].

Terminating the test

► Press the [Esc] key.

Exits the "Check Front Panel" dialog.

Performing maintenance tasks
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Debugging

1. If you detect a malfunction, for example, when you press the front panel key for the
first time, and the color of the button in the dialog turns red (instead of green), the
front panel key has probably stuck.

2. Contact the Rohde & Schwarz customer support, see Chapter 15.8, "Collecting
information for technical support", on page 757.

17.3.4  FPGA/uC update settings

Access:

► Select "System Config > Setup > Maintenance > FPGA/µC Update".

This dialog enables you to check for internal assembly updates and perform
updates.

Settings:

Check For Updates..................................................................................................... 772
Assembly.....................................................................................................................772
Install...........................................................................................................................772
Shut down................................................................................................................... 772
Update External Devices.............................................................................................772

└ Check For Updates.......................................................................................772
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Check For Updates
Check for updates of the FPGA/µC.
Remote command: 
n.a.

Assembly
The table shows the installed assemblies and their states.
"Assembly" Assembly designation.
"State" Indicates the current state of installed assemblies.

Install
Install all available updates for the FPGA/µC.
Remote command: 
n.a.

Shut down
For at least one assembly "State = Done" and no pending assemblies, shuts the instru-
ment down to applies installed updates.
Remote command: 
:SYSTem:SHUTdown on page 736

Update External Devices
This dialog shows the update options of external devices connected to the instrument.

Check For Updates ← Update External Devices
Check for updates of external devices.
Remote command: 
n.a.

17.3.5  Exchanging the RF adapter port

It is important, that you take care that the RF connectors applied to the port are clean,
mechanically compatible and not damaged. Although the 1.85 mm adapter is designed
to withstand several hundred mating cycles, it can reach the end of life or be damaged.
Thererfore, the adapter port is exchangeable, and you can replace it.

For the corresponding instructions on how to proceed, see the R&S SMA100B Service
Manual provided on the global Rohde & Schwarz information system under https://
gloris.rohde-schwarz.com.

17.4  Disposal

Rohde & Schwarz is committed to making careful, ecologically sound use of natural
resources and minimizing the environmental footprint of our products. Help us by dis-
posing of waste in a way that causes minimum environmental impact.

Disposal

https://gloris.rohde-schwarz.com
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Disposing electrical and electronic equipment

A product that is labeled as follows cannot be disposed of in normal household waste
after it has come to the end of its service life. Even disposal via the municipal collection
points for waste electrical and electronic equipment is not permitted.

Figure 17-1: Labeling in line with EU directive WEEE

Rohde & Schwarz has developed a disposal concept for the eco-friendly disposal or
recycling of waste material. As a manufacturer, Rohde & Schwarz completely fulfills its
obligation to take back and dispose of electrical and electronic waste. Contact your
local service representative to dispose of the product.

Disposal
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Annex
A  Reference information for remote control

A.1  Telnet program examples

The following program example shows a simple TcpClient class that is intended to
explain on how to get started with programming of sockets.

The example sets up a socket communication to R&S SMA100B and opens a simple
user interface, very similar to the telnet, which allows input of commands. To enable
real automation, further development of the program is required.

TcpClient.h

#include <string>
//defines structs for socket handling
#include <netinet/in.h>
using namespace std;
typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent     HostInfoStruct;
class TcpClient
{
  public:
    TcpClient();
    ~TcpClient();
    void connectToServer( string &hostname, int port );
    void disconnect( );
    void transmit( string &txString );
    void receive( string &rxString );
    string getCurrentHostName( ) const;
    int    getCurrentPort( ) const;
  private:
    string           currentHostName;
    int              currentPort;
    int              currentSocketDescr;
    SockAddrStruct   serverAddress;
    HostInfoStruct * currentHostInfo;
    bool             clientIsConnected;
    int              receiveBufferSize;
};

TcpClient.cpp

#include <string>
//defines structs for socket handling
#include <netinet/in.h>

Telnet program examples
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using namespace std;
typedef struct sockaddr_in SockAddrStruct;
typedef struct hostent     HostInfoStruct;
class TcpClient
{
  public:
    TcpClient();
    ~TcpClient();
    void connectToServer( string &hostname, int port );
    void disconnect( );
    void transmit( string &txString );
    void receive( string &rxString );
    string getCurrentHostName( ) const;
    int    getCurrentPort( ) const;
  private:
    string           currentHostName;
    int              currentPort;
    int              currentSocketDescr;
    SockAddrStruct   serverAddress;
    HostInfoStruct * currentHostInfo;
    bool             clientIsConnected;
    int              receiveBufferSize;
};

#include <netdb.h>
#include <netinet/in.h>
#include <unistd.h>
#include "TcpClient.h"
TcpClient::TcpClient()
: currentHostName( "" )
, currentPort( 0 )
, currentSocketDescr( 0 )
, serverAddress ( )
, currentHostInfo( NULL )
, clientIsConnected( false )
, receiveBufferSize( 1024 )
{
}
TcpClient::~TcpClient()
{
  currentHostInfo = NULL;
}

void TcpClient::connectToServer( string &hostname, int port )
{
  currentHostInfo = gethostbyname( hostname.c_str( ) );
  if( currentHostInfo == NULL )
  {
    currentHostName   = "";
    currentPort       = 0;

Telnet program examples
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    currentHostInfo   = NULL;
    clientIsConnected = false;
    printf("error connecting host\n" );
  }
  currentHostName = hostname;
  currentPort     = port;
  currentSocketDescr = socket(AF_INET, SOCK_STREAM, 0);
  if( currentSocketDescr == 0 )
  {
    currentHostName   = "";
    currentPort       = 0;
    currentHostInfo   = NULL;
    clientIsConnected = false;
    printf("can't create socket\n" );
  }
  serverAddress.sin_family = currentHostInfo->h_addrtype;
  serverAddress.sin_port   = htons( currentPort );
  memcpy( (char *) &serverAddress.sin_addr.s_addr, 
  currentHostInfo->h_addr_list[0], currentHostInfo->h_length );
  if( connect( currentSocketDescr, ( struct sockaddr *) &serverAddress, 
  sizeof( serverAddress ) ) < 0 )
  {
   throw string("can't connect server\n" );
  }
  clientIsConnected = true;
}
void TcpClient::disconnect( )
{
  if( clientIsConnected )
  {
    close( currentSocketDescr );
  }
  currentSocketDescr = 0;
  currentHostName    = "";
  currentPort        = 0;
  currentHostInfo    = NULL;
  clientIsConnected  = false;
}
void TcpClient::transmit( string &txString )
{
  if( !clientIsConnected )
  {
  throw string("connection must be established before any data can be sent\n");
  }
  char * transmitBuffer = new char[txString.length() +1];
  memcpy( transmitBuffer, txString.c_str(), txString.length() );
  transmitBuffer[txString.length()] = '\n'; //newline is needed!
  if( send( currentSocketDescr, transmitBuffer, txString.length() + 1, 0 ) < 0 )
  {
    throw string("can't transmit data\n");
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  }
  delete [] transmitBuffer;
}
void TcpClient::receive( string &rxString )
{
  if( !clientIsConnected )
  {
  throw string("connection must be established before any data can be received\n");
  }
  char * receiveBuffer = new char[receiveBufferSize];
  memset( receiveBuffer, 0, receiveBufferSize );
  bool receiving = true;
  while( receiving )
  {
    int receivedByteCount = recv( currentSocketDescr, 
    receiveBuffer, receiveBufferSize, 0 );
    if( receivedByteCount < 0 )
    {
      throw string("error while receiving data\n");
    }
    rxString += string( receiveBuffer );
    receiving = ( receivedByteCount == receiveBufferSize );
  }
  delete [] receiveBuffer;
}
string TcpClient::getCurrentHostName( ) const
{
  return currentHostName;
}
int TcpClient::getCurrentPort( ) const
{
  return currentPort;
}

TelnetClient.cpp

#include <iostream>
#include "TcpClient.h"
void printUsage()
{
  cout<<"usage: EthernetRawCommand <server-ip> [scpi-command]"<<endl;
}
int main( int argc, char *argv[] )
{
  int errorCode         = 0; //no error
  bool useSingleCommand = false;
  string singleCommand  = "";
  string hostname       = "";
  int    port           = 5025;
  string input          = "";

Telnet program examples
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  TcpClient client;
  switch( argc )
  {
    case 3:
      useSingleCommand = true;
      singleCommand    = argv[2];
    case 2:
      hostname         = argv[1];
      break;
    default:
        printUsage();
        return(-1);
  }
  try
  {
    client.connectToServer( hostname, port );
    bool terminate = false;
    while( !terminate )
    {
      char buffer[1024];
      if( useSingleCommand )
      {
        input =  singleCommand; //send string
      }
      else
      {
        cin.getline( buffer, 1024 );
        input = buffer;
        if( input == "end" )
        {
          terminate = true;
        }
      }
      if( !terminate)
      {
        client.transmit( input ); //send string
        int qPos = input.find( "?", 0 );
        //receive string only when needed
        if( qPos > 0 )
        {
          string rcStr = "";
          client.receive( rcStr );
          cout << rcStr << endl;
        }
      }
      if( useSingleCommand )
      {
        terminate = true;
      }
    }

Telnet program examples
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  }catch( const string errorString )
  {
    cout<<errorString<<endl;
  }
  client.disconnect( );
  return errorCode;
}

A.2  Hardware interfaces

This section covers hardware-related topics, like pin assignment of the IEC 625/IEEE
488 interface.

The remote control interfaces are described in details in Chapter 13, "Network opera-
tion and remote control", on page 378.

All other interfaces are described in Chapter 3.2, "Instrument tour", on page 35.

For more information, see data sheet.

A.2.1  GPIB-Bus interface

Option: R&S SMAB-B86.

Pin assignment

Figure A-1: Pin assignment of GPIB-bus (IEEE 488) interface

Hardware interfaces



Reference information for remote controlR&S®SMA100B

780User Manual 1178.3834.02 ─ 09

Bus lines

● Data bus with 8 lines D0 to D7:
The transmission is bit-parallel and byte-serial in the ASCII/ISO code. D0 is the
least significant bit, D7 the most significant bit.

● Control bus with five lines:
IFC (Interface Clear): active LOW resets the interfaces of the instruments connec-
ted to the default setting.
ATN (Attention): active LOW signals the transmission of interface messages, inac-
tive HIGH signals the transmission of device messages.
SRQ (Service Request): active LOW enables the connected device to send a ser-
vice request to the controller.
REN (Remote Enable): active LOW permits switchover to remote control.
EOI (End or Identify): has two functions in connection with ATN:
– ATN=HIGH active LOW marks the end of data transmission.
– ATN=LOW active LOW triggers a parallel poll.

● Handshake bus with three lines:
DAV (Data Valid): active LOW signals a valid data byte on the data bus.
NRFD (Not Ready For Data): active LOW signals that one of the connected devi-
ces is not ready for data transfer.
NDAC (Not Data Accepted): active LOW signals that the instrument connected is
accepting the data on the data bus.

Interface functions

Instruments which can be controlled via GPIB-bus interface can be equipped with dif-
ferent interface functions. Table A-1 lists the interface functions for the R&S SMA100B.

Table A-1: GPIB-bus interface functions

Control character Interface function

SH1 Handshake source function (source handshake), full capability

AH1 Handshake sink function (acceptor handshake), full capability

L4 Listener function, full capability, de-addressed by MTA.

T6 Talker function, full capability, ability to respond to serial poll, deaddressed
by MLA

SR1 Service request function (Service Request), full capability

PP1 Parallel poll function, full capability

RL1 Remote/Local switch over function, full capability

DC1 Reset function (Device Clear), full capability

DT1 Trigger function (Device Trigger), full capability

Hardware interfaces
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B  Extensions for user files
The Table B-1 lists all available file extensions for user files. The currently available
files on the instrument depend on the installed options.
Table B-1: List of the automatically assigned file extensions in the instrument

Function List type Contents File suffix

Instrument State Settings Instrument settings *.savrcltxt

User Menu Settings User-defined favorite settings *.user_menu

License Key  License Key *.xml

"User Correction" List User-defined level correction values *.uco

"List Mode" List User-defined frequency/level value pairs *.lsw

 Settings Response file *.txt

"Pulse Train" Settings Pulse train data *.pulstrn

"NRP Settings" Settings R&S NRP Settings *.nrp, *.rsu

SCPI command list List Export file containing list of SCPIs *.iec

SCPI command
script

 SCPI script file formats: Plain SCPI, MATLAB,
NICVI, Python3

*.txt , *.m,
*.c, *.py

R&S Support Info
Archive

Support File Automatically collected support information *.tar.gz

Tutorials Tutorial files Lists containing SCPIs and explanations *.tut
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C  Unit shortcuts
When specifying units or quantities during data entry, the R&S SMA100B provides the
following shortcuts for simplified input.

Shortcut Designation Context Unit

a, A ampere Current A

 atto- Area, surface am2

c, C centi- Distance, length cm

d, D deci- Distance, length dm

  Level, power dB, dBFS, dBm, dBU, dBW

 degree Phase, polar/spherical coordinates deg

e, E exa- Area, surface em2

f, F femto- Area, surface fm2

g, G giga- Area, surface Gm2

  Data rate, sample rate, symbol rate Gbit/s, Gsample/s, Gsymbol/s, Gchip/s

  Frequency GHz

  Impedance, resistance GΩ

h, H hertz Frequency Hz

k, K kilo- Area, surface km2

  Data rate, sample rate, symbol rate kbit/s, ksample/s, ksymbol/s, kchip/s

  Distance, length km

  Frequency kHz

  Impedance, resistance kΩ

  Velocity km/h

m, M milli- Area, surface mm2

  Current mA

  Distance, length mm

  Electromagnetic force, level mV

  Power mW

  Time, period, etc. ms

 mega- Area, surface Mm2

  Data rate, sample rate, symbol rate Mbit/s, Msample/s, Msym/s, Mchip/s

  Frequency MHz

  Impedance, resistance MΩ
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Shortcut Designation Context Unit

n, N nano- Area, surface nm2

  Current nA

  Distance, length nm

  Electromagnetic force, level nV

  Power nW

  Time, period, etc. ns

o, O ohm Impedance, resistance Ω

p, P peta- Area, surface pm2

 percent Level, ratio %

 pico- Area, surface pm2

  Current pA

  Electromagnetic force, level pV

  Power pW

  Time, period, etc. ps

r, R radiant Phase, polar/spherical coordinates rad

s, S second Time, period, etc. s

t, T terra- Area, surface Tm2

  Data rate, sample rate, symbol rate Tbit/s, Tsample/s, Tsym/s, Tchip/s

  Frequency THz

  Impedance, resistance TΩ

u, U micro- Current µA

  Distance, length µm

  Electromagnetic force, level µV

  Power µW

  Time, period, etc. µs

v, V volt Level, voltage V

w, W watt Level, power W
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D  Morse code settings
The COM/ID tone is sent according to the selected code (see Table D-1). The length of
the Morse code can be varied. For selected standard time scheme, the selected dot
length determines the setting of all other length parameters of the Morse code (dash
length, symbol space and letter space) . For selected user time scheme, all length
parameters of the code can be set independently. If no coding is entered, the COM/ID
tone is sent uncoded (key down).

The following values are default values:
● A dot (.) has a tone duration of 100 ms
● A dash (-) has a tone duration of 300ms
● The time between two tones is 100ms
● The time between two letters is 300ms

After each word, a word space is entered. The word repetition rate is 7 words per
minute. Since the word length can vary between 900 ms and 4500 ms, the word space
between the words varies accordingly.

Example: 
ID code = MUC
The word length =
(300+100+300)+300+(100+100+100+100+300)+300+(300+100+100+100+300+100+1
00) = 3100 ms

Table D-1: Morse code

Letter Morse code Letter Morse code

A . - N - .

B - . . . O - - -

C - . - . P . - - .

D - . . Q - - . -

E . R . - .

F . . - . S . . .

G - - . T -

H . . . . U . . -

I . . V . . . -

J . - - - W . - -

K - . - X - . . -

L . - . . Y - . - -

M - - Z - - . .
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Glossary: List of the often used terms and
abbreviations

Symbols
1MA193: 1MA193_0e Application Note, "Aeronautical radio navigation measurement
solutions"

B
Base unit: This term describes a R&S SMA100B equipped with the option
R&S SMAB-B103.

C
Clock: A mandatory internal or an external reference clock signal for generating the
timing pulse in the instrument.

Complete file path: The complete file path specifies the root directory and all subdir-
ectories that contain a file or folder.
Synonyms to this expression are "full file path" and "absolute file path".
See also Chapter 14.5.2, "Accessing files in the default or in a specified directory",
on page 458.

Computer name: An unambiguous indication of the instrument in a LAN that uses a
DNS server.
The default computer name follows the syntax SMAB-<serial number>, e.g.
SMA100B-102030.
Synonym: Hostname
See Serial number.

D
daisy chain: A connection scheme in which instruments are connected together in
sequence, i.e. an output of the first one is connected to an input of the second one, etc.

DHCP: Dynamic host configuration protocol

DNS: Domain name system server

E
e.g.: For example

External mass memory: External memory, connected to the instrument via USB con-
nector (Type A female). It can hold stored files with user data.
See also System drive and SD card

F
File transfer: The transmission of files from or to the instrument by a remote client.
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The instrument supports the standard methods FTP and file sharing according to
SAMBA/SMB.

FTP: File transfer protocol

G
Glossary: List of the often used terms and abbreviations

GUI: Graphical user interface

H
HDD: Hard disk drive, see System drive

Hostname: Computer name

I
i.e.: That is

L
LF: Low frequency

LSB: Least significant bit

M
MIMO: Multiple input multiple output

MSB: Most significant bit

P
PC: Personal computer

Power: A term describing the signal level of the RF signal

product page: A designation of the R&S SMA100B product page http://www.rohde-
schwarz.com/product/SMA100B.html

R
Remote access: Remote operation

Remote control: The operation of the R&S SMA100B by remote control commands or
programs to perform automated tests.
The instrument is connected to a system controller via LAN/VXI-11, GPIB or USB using
VISA. The instrument is controlled directly or supported by instrument drivers.

http://www.rohde-schwarz.com/product/SMA100B.html
http://www.rohde-schwarz.com/product/SMA100B.html
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Remote device: External device controls the R&S SMA100B in remote operation
mode, see Remote operation.
Synonyms: External controller, client device

Remote operation: Allows you to operate the R&S SMA100B from a remote device
via VNC.
Both the R&S SMA100B and the remote device are connected in a LAN.
Synonym: Remote access

Removable memory: General term describing mass memory that can be unmounted
from the instrument.
See also SD card

RF: Radio frequency

S
SAMBA/SMB: Server message protocol

SD card: Secure digital card is a type of removable memory storage, that can hold
files with user data.
Support of this memory type is optional and requires option R&S SMAB-B85.
Throughout this description, the SD card is referred as a removable memory.
See also System drive.

Serial number: Unique instrument identification, provided on the rear panel of the
instrument and required to build the Computer name.
The serial number are the last 6 digits in the string <stock no.>-<serial
number>, e.g. SMA100B-102030

Smart device: A mobile, cordless device, such as a smartphone or tablet, capable of
Internet browsing.
Synonyms: Smartphone, tablet

System drive: The system drive is a built-in internal memory that holds the operating
system, the firmware, and the stored user data.
Throughout this description, the system drive is referred as an internal memory.
See also SD card and Removable memory

T
Trigger: Internally generated or externally supplied signal which starts signal genera-
tion at a particular point in time

Trigger event: A trigger event is caused by the received trigger signal or executed
manual trigger.

U
UE: User equipment
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USBTMC: (USB test & measurement class)
A protocol built on top of USB for communication with USB devices. Using VISA library,
it supports service request, triggers, and other specific operations, similar to GPIB.

User directory: Describes the default file storage location for user data.
Depending on the installed options, the user directory is physically located on the Sys-
tem drive or on the Removable memory
In the file system, user directory is always indicated as /var/user

V
VISA: Virtual instrument software architecture
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List of Commands
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:STATe......................................................................494
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:SUBTract.................................................................495
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:XVAL....................................................................... 495
:CALCulate[:POWer]:SWEep:FREQuency:MATH<ch>:YVAL....................................................................... 495
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:STATe..............................................................................496
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:SUBTract........................................................................ 496
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:XVAL...............................................................................497
:CALCulate[:POWer]:SWEep:POWer:MATH<ch>:YVAL...............................................................................497
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:AVERage?..........................................................................497
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:FEED..................................................................................498
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:MAXimum?.........................................................................498
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STARt................................................................................. 499
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STATe................................................................................. 499
:CALCulate[:POWer]:SWEep:TIME:GATE<ch>:STOP..................................................................................499
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:STATe.................................................................................499
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:SUBTract............................................................................500
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:XVAL.................................................................................. 500
:CALCulate[:POWer]:SWEep:TIME:MATH<ch>:YVAL.................................................................................. 500
:CALibration:ALL[:MEASure]?....................................................................................................................... 467
:CALibration:DATA:FACTory:DATE?..............................................................................................................469
:CALibration<hw>:ALL:DATE?.......................................................................................................................467
:CALibration<hw>:ALL:INFormation?............................................................................................................ 468
:CALibration<hw>:ALL:TEMP?......................................................................................................................468
:CALibration<hw>:ALL:TIME?....................................................................................................................... 468
:CALibration<hw>:CONTinueonerror.............................................................................................................469
:CSYNthesis:FREQuency..............................................................................................................................471
:CSYNthesis:FREQuency:STEP....................................................................................................................474
:CSYNthesis:FREQuency:STEP:MODE........................................................................................................473
:CSYNthesis:OFFSet.....................................................................................................................................472
:CSYNthesis:OFFSet:STATe..........................................................................................................................472
:CSYNthesis:OTYPe......................................................................................................................................471
:CSYNthesis:PHASe......................................................................................................................................472
:CSYNthesis:PHASe:REFerence...................................................................................................................473
:CSYNthesis:POWer......................................................................................................................................471
:CSYNthesis:POWer:STEP:MODE................................................................................................................473
:CSYNthesis:POWer:STEP[:INCRement]......................................................................................................473
:CSYNthesis:STATe....................................................................................................................................... 470
:CSYNthesis:VOLTage...................................................................................................................................472
:DEVice:PRESet............................................................................................................................................ 455
:DIAGnostic:INFO:OTIMe?............................................................................................................................ 476
:DIAGnostic:INFO:POCount?........................................................................................................................ 476
:DIAGnostic<hw>:BGINfo:CATalog?..............................................................................................................475
:DIAGnostic<hw>:BGINfo?............................................................................................................................ 475
:DIAGnostic<hw>:POINt:CATalog?................................................................................................................477
:DIAGnostic<hw>[:MEASure]:POINt?............................................................................................................477
:DISPlay:ANNotation:AMPLitude...................................................................................................................480
:DISPlay:ANNotation:FREQuency.................................................................................................................480

 



List of CommandsR&S®SMA100B

790User Manual 1178.3834.02 ─ 09

:DISPlay:ANNotation[:ALL]............................................................................................................................ 480
:DISPlay:BRIGhtness.....................................................................................................................................479
:DISPlay:BUTTon:BRIGhtness.......................................................................................................................479
:DISPlay:DIALog:CLOSe............................................................................................................................... 481
:DISPlay:DIALog:CLOSe:ALL........................................................................................................................482
:DISPlay:DIALog:ID?..................................................................................................................................... 480
:DISPlay:DIALog:OPEN.................................................................................................................................481
:DISPlay:PSAVe:HOLDoff..............................................................................................................................478
:DISPlay:PSAVe[:STATe]................................................................................................................................479
:DISPlay:UPDate[:STATe].............................................................................................................................. 479
:DISPlay[:WINDow][:POWer]:SWEep:BACKground:COLor.......................................................................... 501
:DISPlay[:WINDow][:POWer]:SWEep:GRID:STATe.......................................................................................501
:FORMat:BORDer..........................................................................................................................................482
:FORMat:SREGister...................................................................................................................................... 483
:FORMat[:DATA]............................................................................................................................................ 483
:HCOPy:DATA?..............................................................................................................................................485
:HCOPy:DEVice:LANGuage..........................................................................................................................485
:HCOPy:FILE[:NAME]....................................................................................................................................485
:HCOPy:FILE[:NAME]:AUTO:DIRectory........................................................................................................486
:HCOPy:FILE[:NAME]:AUTO:DIRectory:CLEar.............................................................................................487
:HCOPy:FILE[:NAME]:AUTO:FILE?.............................................................................................................. 487
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:HCOPy:FILE[:NAME]:AUTO[:FILE]:DAY:STATe........................................................................................... 487
:HCOPy:FILE[:NAME]:AUTO[:FILE]:MONTh:STATe..................................................................................... 487
:HCOPy:FILE[:NAME]:AUTO[:FILE]:NUMBer?............................................................................................. 488
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix................................................................................................. 488
:HCOPy:FILE[:NAME]:AUTO[:FILE]:PREFix:STATe......................................................................................488
:HCOPy:FILE[:NAME]:AUTO[:FILE]:YEAR:STATe........................................................................................ 487
:HCOPy:IMAGe:FORMat...............................................................................................................................485
:HCOPy:REGion............................................................................................................................................ 485
:HCOPy[:EXECute]........................................................................................................................................486
:INITiate<hw>[:POWer]:CONTinuous............................................................................................................ 501
:INITiate<hw>[:POWer]:CONTinuous............................................................................................................ 551
:KBOard:LAYout.............................................................................................................................................489
:MEMory:HFRee?.......................................................................................................................................... 466
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:MMEMory:COPY.......................................................................................................................................... 462
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:OUTPut:ALL[:STATe].................................................................................................................................... 489
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:OUTPut<hw>[:STATe]:PON.......................................................................................................................... 490
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:SENSe[:POWer]:SWEep:FREQuency:REFerence:DATA:COPY................................................................. 512
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